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ટ્્રરેડ પ્રૈક્ટિકલ
(TRADE  PRACTICAL)

સકે્ટર : IT અને ITES
SECTOR : IT & ITES

(જુલાઈ 2022 - 1200 કલાકના સશંોધિત અભ્્યયાસક્રમ મુજબ)
(As per revised syllabus July 2022 - 1200 hrs)

ડાયરેક્ટોરેટ જનરલ ઓફ ટ્્રરે નિિંગ
કૌશલ્ય વિકાસ અને ઉદ્યોગ સાહસિકતા મતં્રાલય 

ભારત સરકાર

નશેનલ ઇન્સસ્ટટ્રકશનલ 
મીડિયા ઇન્સ્ટિટ્યુટ, ચેન્નઇ

પોસ્ટ બોક્સ નં. 3142, સીટીઆઈ કેમ્્પસ, ગિન્્ડડી, ચેન્નઈ - 600 032
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(ii)

 
સકે્ટર	 :	 IT અને ITES
અવધિ 	 :	 1 વર્્ષ	
વ્યવસાાય	 : 	 COPA  - વર્ષષ Volume I of II  - ટ્રેે�ડ પે્રેક્ટિ�કલ - NSQF લેેવલ - 3 (સંશંોોધિ�ત 2022)

Developed & Published by  

નશેનલ ઇન્સસ્ટટ્રકશનલ મીડિયા ઇન્સ્ટિટ્યુટ,

પોસ્ટ બોક્સ નં. 3142 ગિન્્ડડી, ચને્નાઈ - 600 032 ભારત

ઈમેલ : chennai-nimi@nic.in 

વેબસાઇટ : www.nimi.gov.in

કોપીરાઈટ © 2023 નશેનલ ઈન્સસ્ટટ્રક્શનલ મીડિયા ઈન્સ્ટિટ્યૂટ, ચેન્નાઈ 

પ્રથમ આવૃૃત્તિ� :ફેેબુ્રુઆરીી�ી, 2024		  નકલોો: 250 

રૂ. 450/-

બધા હકો અમારી પાસે રાખેલા છે.

આ પ્રકાશનના કોઈપણ ભાગને નશેનલ ઈન્સસ્ટટ્રક્શનલ મીડિયા ઈન્સ્ટિટ્યૂટ, ચેન્નાઈની લેખિતમાાં પરવાનગી વિના કોઈપણ સ્્વરૂપમાાં 

અથવા કોઈપણ માધ્્યમથી, ફોટોકોપી, રેકોર્ડડિંગ અથવા કોઈપણ માહિતી સંગ્રહ અને પુનઃપ્રાપ્્તતિ પ્રણાલી સહિત ઇલેક્ટ્રો નિક અથવા 

મિકેનિકલ દ્વારા પુનઃઉત્્પપાદિત અથવા પ્રસારિત કરી શકાશે નહીીં. 
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(iii)

આમુખ

ભારત સરકારે રાષ્્ટ્ર રીય કૌશલ્ય વિકાસ નીતિના ભાગ રૂપે નોકરીઓ સુરક્ષિત કરવામાાં મદદ કરવા માટે 2020 સુધીમાાં 

30 કરોડ લોકોને, દર ચારમાાંથી એક ભારતીયને કૌશલ્ય પ્રદાન કરવાનો મહત્્વવાકાાંક્ષી લક્ષ્્યાંક નક્કી કર્યો છે.  ઔદ્યોગિક 

તાલીમ સંસ્થાઓ (ITIs) આ પ્રક્રિયામાાં ખાસ કરીને કુશળ માનવશક્્તતિ પૂરી પાડવાના સદંર્્ભમાાં મહત્્વપૂર્્ણ ભૂમિકા 

ભજવે છે. આને ધ્્યયાનમાાં રાખીને, અને પ્રશિક્ષણાર્થીઓને વર્્તમાન ઉદ્યોગ સંબંધિત કૌશલ્ય પ્રશિક્ષણ આપવા માટે, ITI 

અભ્્યયાસક્રમ તાજતેરમાાં વિવિધ હિતધારકોની જમે કે મેન્ટર કાઉન્્સસિલની મદદથી અપડેટ કરવામાાં આવ્્યયો છે. ઉદ્યોગો, 

સાહસિકો, શિક્ષણવિદો અને ITIs ના પ્રતિનિધિઓ.

નશેનલ ઈન્સસ્ટટ્રક્શનલ મીડિયા ઈન્સ્ટિટ્યૂટ (NIMI), ચેન્નાઈ, કૌશલ્ય વિકાસ અને સાહસિકતા મંત્રાલય હેઠળની એક 

સ્્વવાયત્ત સંસ્થાને ITIs અને અન્ય સંબંધિત સંસ્થાઓ માટે જરૂરી સૂચનાત્મક મીડિયા પેકેજો (IMPs) વિકસાવવા અને 

પ્રસારિત કરવાની જવાબદારી સોોંપવામાાં આવી છે.

સંસ્થા હવે સુધારેલા અભ્્યયાસક્રમને અનુરૂપ સૂચનાત્મક સામગ્રી લઈને આવી કોમ્્પ્યયુટર ઓપરેટર અને પ્રોગ્રામિિંગ 
આસિસ્ટન્ટ -  વાર્ષિક પેટર્્ન હેઠળ IT અને ITES સકે્ટરમાાં II નું વોલ્યુમ I - ટ્્ર રેડ પ્રેક્ટિકલ NSQF સ્્તર - 3 

(સશંોધિત 2022). NSQF લેવલ - 3 (સશંોધિત 2022) ટ્્રરેડ  પ્રેક્ટિકલ તાલીમાર્થીઓને અતંરરાષ્્ટ્ર રીય સમકક્ષતા ધોરણ 

મેળવવામાાં મદદ કરશે જ્યયાં તેમની કૌશલ્ય પ્રાવીણ્્ય અને યોગ્્યતાને વિશ્વભરમાાં યોગ્્ય રીતે માન્યતા આપવામાાં આવશે 

અને આ અગાઉના શિક્ષણની માન્યતાના અવકાશને પણ વધારશે. NSQF સ્્તર - 3 (સશંોધિત 2022) તાલીમાર્થીઓને 

આજીવન શિક્ષણ અને કૌશલ્ય વિકાસને પ્રોત્સાહન આપવાની તકો પણ મળશે. મને કોઈ શંકા નથી કે NSQF લેવલ -3 

(સશંોધિત 2022) સાથે ITI ના પ્રશિક્ષકો અને તાલીમાર્થીઓ અને તમામ હિતધારકો આ IMP નો મહત્તમ લાભ મેળવશે 

અને NIMI નો પ્રયાસ દેશમાાં વ્્યયાવસાયિક તાલીમની ગુણવત્તા સુધારવામાાં ઘણો આગળ વધશે. .

NIMI ના એક્્ઝઝિક્યુટિવ ડિરેક્ટર અને સ્ટાફ અને મીડિયા ડેવલપમેન્ટ કમિટીના સભ્્યયો આ પ્રકાશન બહાર લાવવામાાં 

તેમના યોગદાન માટે પ્રશંસાને પાત્ર છે.

જય હિન્્દ

	 શ્રીી. અતુુલ કુુમાાર તિ�વાારીી., I.A.S.,
	 સચિવ
	 કૌશલ્ય વિકાસ અને ઉદ્યોગ સાહસિકતા મંત્રાલય, 	
	 ભારત સરકાર.

ફેેબુ્રુઆરીી�ી 2024 

નવીી દિ�લ્હીી - 110 001
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(iv)

પ્રસ્્તતાવના

નેશનલ ઈન્સસ્ટટ્ર ક્શનલ મીડિયા ઈન્સ્ટિટ્યૂટ (NIMI) ની સ્થાપના 1986 માાં ચેન્નઈ ખાતે તત્કાલીન રોજગાર અને તાલીમ 

મહાનિર્દેશાલય (D.G.E & T), શ્રમ અને રોજગાર મંત્રાલય, (હવે કૌશલ્ય વિકાસ અને ઉદ્યોગ સાહસિકતા મંત્રાલય હેઠળ) ભારત 

સરકાર દ્વારા કરવામાાં આવી હતી, જમેાાં ટેકનિકલ છે. સરકાર તરફથી સહાય ફેડરલ રિપબ્્લલિક ઓફ જર્્મની. આ સંસ્થાનો મુખ્ય 

ઉદ્દેશ્્ય કારીગરો અને એપ્રેન્ટિસશીપ તાલીમ યોજનાઓ હેઠળ નિયત અભ્્યયાસક્રમ (NSQF સ્્તર - 3) મુજબ વિવિધ વેપારો માટે 

સૂચનાત્મક સામગ્રી વિકસાવવા અને પ્રદાન કરવાનો છે.

ભારતમાાં NCVT/NAC હેઠળ વ્્યયાવસાયિક તાલીમનો મુખ્ય ઉદ્દેશ્્યને ધ્્યયાનમાાં રાખીને સૂચનાત્મક સામગ્રી બનાવવામાાં આવી 

છે, જ ેવ્્યક્્તતિને નોકરી કરવા માટે કૌશલ્યમાાં નિપુણતા પ્રાપ્્ત કરવામાાં મદદ કરવાનો છે. સૂચનાત્મક સામગ્રી સૂચનાત્મક મીડિયા 

પેકેજો (IMPs) ના સ્્વરૂપમાાં બનાવવામાાં આવે છે. IMP માાં થિયરી બુક, પ્રેક્ટિકલ બુક, ટેસ્ટ અને એસાઈનમેન્ટ બુક, ઈન્સસ્ટટ્રક્ટર 

ગાઈડ, ઓડિયો વિઝ્યુઅલ એઈડ (વોલ ચાર્્ટ  અને ટ્્રરાન્્સ પરન્્સસી) અને અન્ય સપોર્્ટ  મટિરિયલનો સમાવશે થાય છે.

વર્્ક શોપમાાં તાલીમાર્થીઓ દ્વારા પૂર્્ણ કરવામાાં આવનારી વ્્યયાયામની શ્રેણીબદ્ધ વ્્યયાવહારિક પસુ્્તકમાાં સમાવશે થાય છે. આ કસરતો 

એ સુનિશ્ચિત કરવા માટે બનાવવામાાં આવી છે કે નિયત અભ્્યયાસક્રમમાાં તમામ કૌશલ્યો આવરી લેવામાાં આવે છે. વેપાર સિદ્ધધાંત 

પુસ્્તક તાલીમાર્થીને નોકરી કરવા સક્ષમ બનાવવા માટે જરૂરી સંબંધિત સદૈ્ધધાંતિક જ્ઞાન પ્રદાન કરે છે. પરીક્ષણ અને સોોંપણીઓ 

પ્રશિક્ષકને તાલીમાર્થીની કામગીરીના મૂલ્યયાંકન માટે સોોંપણીઓ આપવા સક્ષમ બનાવશે. વોલ ચાર્્ટ  અને પારદર્શિતા અનન્ય છે, 

કારણ કે ત ેમાત્ર પ્રશિક્ષકન ેવિષયન ેઅસરકારક રીત ેરજૂ કરવામાાં મદદ કરે છે પરંત ુતનેે તાલીમાર્થીની સમજનુ ંમલૂ્યયાંકન કરવામાાં 

પણ મદદ કરે છે. પ્રશિક્ષક માર્્ગદર્શિકા પ્રશિક્ષકને તેના સૂચનાના સમયપત્રકની યોજના બનાવવા, કાચા માલની જરૂરિયાતો, 

રોજિિંદા પાઠ અને પ્રદર્્શનોની યોજના બનાવવા માટે સક્ષમ બનાવે છે.

કૌશલ્યોને ઉત્્પપાદક રીતે કરવા માટે આ સૂચનાત્મક સામગ્રીમાાં કવાયતના QR કોડમાાં સૂચનાત્મક વિડિયોઝ એમ્્બબેડ કરવામાાં 

આવ્્યયા છે જથેી કૌશલ્ય શિક્ષણને કવાયતમાાં આપવામાાં આવેલા પ્રક્રિયાગત વ્્યવહારુ પગલાાં સાથે સાાંકળી શકાય. સૂચનાત્મક 

વિડીયો પ્રાયોગિક તાલીમના ધોરણની ગુણવત્તામાાં સુધારો કરશે અને તાલીમાર્થીઓને ધ્્યયાન કેન્દ્રિત કરવા અને કુશળતાને 

એકીકૃત કરવા માટે પ્રેરિત કરશે.

IMP અસરકારક ટીમ વર્્ક  માટે વિકસાવવા માટે જરૂરી જટિલ કૌશલ્યો સાથ ેપણ વ્્યવહાર કરે છે. અભ્્યયાસક્રમમાાં સૂચવ્્યયા મુજબ 

સંલગ્ન વેપારના મહત્્વના કૌશલ્ય વિસ્્તતારોને સમાવવા માટે પણ જરૂરી કાળજી લેવામાાં આવી છે.

સંસ્થામાાં સંપૂર્્ણ સૂચનાત્મક મીડિયા પેકેજની ઉપલબ્ધતા ટ્્રરેનર અને મેનેજમેન્ટ બંનેને અસરકારક તાલીમ આપવામાાં મદદ કરે છે.

IMP એ NIMI ના સ્ટાફ મેમ્્બરો અને મીડિયા ડેવલપમેન્ટ કમિટીના સભ્્યયોના સામૂહિક પ્રયાસોનું પરિણામ છે જ ેખાસ કરીને 

જાહેર અને ખાનગી ક્ષેત્રના ઉદ્યોગો, ડિરેક્ટોરેટ જનરલ ઓફ ટ્્રરે નિિંગ (DGT), સરકારી અને ખાનગી ITIs હેઠળની વિવિધ તાલીમ 

સંસ્થાઓમાાંથી લેવામાાં આવે છે.

NIMI વિવિધ રાજ્ય સરકારોના રોજગાર અને તાલીમ નિયામક, જાહેર અને ખાનગી ક્ષેત્રના ઉદ્યોગોના પ્રશિક્ષણ વિભાગો, DGT 

અન ેDGT ક્ષેત્ર સસં્થાઓના અધિકારીઓ, પ્રૂફ રીડર્્સ, વ્્યક્્તતિગત મીડિયા વિકાસકર્તાઓ અન ેતમામનો નિષ્્ઠઠાપૂર્્વક આભાર વ્્યક્્ત 

કરવા આ તક લેવા માાંગે છે. સંયોજકો, પરંતુ જમેના સક્રિય સમર્્થન માટે NIMI આ સામગ્રીને બહાર લાવવામાાં સક્ષમ ન હોત.

ચેન્નાઈ - 600 032	 કરોબારી સંચાલક 
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આભાર

નશેનલ ઇન્સસ્ટટ્રક્શનલ મીડિયા ઇન્સ્ટિટ્યૂટ (NIMI) આ સૂચનાત્મક સામગ્રીને બહાર લાવવા માટે નીચેના મીડિયા ડેવલપર્્સ 

અને તેમની પ્રાયોજક સંસ્થાઓ દ્વારા આપવામાાં આવેલા સહકાર અને યોગદાન માટે નિષ્્ઠઠાપૂર્્વક આભાર સાથે સ્્વવીકારે છે.  (ટ્્રરેડ 

પ્રૈક્ટિકલ) ના વેપાર માટે કોમ્્પ્યયુટર ઓપરેટર અને પ્રોગ્રામિિંગ આસિસ્ટન્ટ - NSQF સ્્તર - 3 (સશંોધિત 2022) IT 
અને ITES ક્ષેત્ર ITIs માટે.

મીડિયા ડેવલપમેન્ટ કમિટીના સભ્્યયો

શ્રી. ઇ. અગિલન 	 - 	 જુનિયર તાલીમ અધિકારી, સરકારી આઈટીઆઈ,
		  પેરુમ્્બક્કમ, ચેન્નાઈ - 131.

શ્રી. સરબોજિત નિઓગી 	 - 	 વોકેશનલ ઇન્સસ્ટટ્રક્ટર (COPA), IT- નોડલ ઓફિસર,
		  મહિલાઓ માટે NSTI, કોલકાતા - 700091.

શ્રીમતી. એમ. ભાનુમતિ 	 - 	 મદદનીશ તાલીમ અધિકારી,
		  સરકારી ITI, અંબત્તુર.

શ્રીમતી. વી. રેવતી 	 - 	 મદદનીશ તાલીમ અધિકારી,
		  સરકારી ITI, કોઈમ્્બતુર.

નિમી કો-ઓર્ડીનેટર્્સ

શ્રી. નિર્માલ્યનાથ	 -	 નાયબ નિયામક,
		  NIMI,  ચેન્નાઈ - 32.

શ્રી જી. માઈકલ જોની	 -	 મેનેજર 
		  NIMI, ચેન્નાઈ - 32.

શ્રી. એસ. ગોપાલકૃષ્્ણનન્	 -	 આસિસ્ટન્ટ મેનેજર 
			   NIMI, ચેન્નાઈ - 32.

NIMI ડેટા એન્ટ્ રી, CAD, DTP ઓપરેટરો માટે આ સૂચનાત્મક સામગ્રીના વિકાસની પ્રક્રિયામાાં તેમની ઉત્તમ અને સમર્પિત 
સેવાઓ માટે તેની પ્રશંસા નોોંધે છે.

આ સૂચનાત્મક સામગ્રીના વિકાસમાાં યોગદાન આપનાર અન્ય તમામ NIMI સ્ટાફ દ્વારા કરવામાાં આવેલા અમૂલ્ય પ્રયત્નોને 
પણ NIMI આભાર સાથે સ્્વવીકારે છે.

NIMI એ દરેક વ્્યક્્તતિનો પણ આભારી છે જમેણે આ સૂચનાત્મક સામગ્રી વિકસાવવામાાં પ્રત્યક્ષ કે પરોક્ષ રીતે મદદ કરી છે.
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પરિચય
વેપાર પ્રેક્ટિકલ માટેની આ માર્્ગદર્શિકા ITI વર્્ક શોપમાાં ઉપયોગ માટે બનાવાયેલ છે. તમેાાં પ્રાયોગિક કસરતોની શ્રેણીનો સમાવશે થાય છે જ ેકોર્્સના 
પ્રથમ વર્્ષ દરમિયાન તાલીમાર્થીઓ દ્વારા પૂર્્ણ કરવાની હોય છે. પાવર સેક્ટર હેઠળ કોમ્્પ્યયુટર ઓપરેટર અને પ્રોગ્રામિિંગ આસિસ્ટન્ટ વેપાર. તે છે 
રાષ્્ટ્ર રીય કૌશલ્ય લાયકાત ફ્રેમ વર્્ક  NSQF સ્્તર - 3 (સશંોધિત 2022).

મોોડ્યુુલ 1	 સલાામત કાામ કરવાાનીી પદ્ધતિ�ઓ
મોોડ્યુુલ 2	ડે સ્કટોોપ પીીસીી એસેેમ્બલ કરોો
મોોડ્યુુલ 3	વિ� ન્ડોોઝ ઓપરેેટિં�ગ સિ�સ્ટમનોો ઉપયોોગ
મોોડ્યુુલ 4	 કમ્પ્યુુટર બેેઝિ�ક્સ અનેે સોોફ્ટવેેર ઇન્સ્ટોોલેશેન
મોોડ્યુુલ 5	 DOS કમાાન્ડ લાાઇન ઇન્ટરફેેસ
મોોડ્યુુલ 6	 ઉબુુનુ્ટુ લિ�નક્સ ઓપરેેટિં�ગ સિ�સ્ટમ       	
	 ઇન્સ્ટોોલ કરોો અનેે મૂૂળભૂૂત લિ�નક્સ કમાાન્ડ ચલાાવોો
મોોડ્યુુલ 7	 વર્ડડ  પ્રોોસેેસિં�ગ સોોફ્ટવેેર
મોોડ્યુુલ 8	ફો ોર્મેેટ દસ્તાાવેેજો
મોોડ્યુુલ 9	કો ોષ્ટકોો અનેે સૂૂચિ�ઓનુંં� સંંચાાલન કરોો
મોોડ્યુુલ 10	સં ંદર્ભોો બનાાવોો અનેે મેેનેેજ કરોો
મોોડ્યુુલ 11	ગ્રા ાફિ�ક તત્વોોનુંં� સંંચાાલન કરોો
મોોડ્યુુલ 12	દ સ્તાાવેેજ સહયોોગ મેેનેેજ કરોો
મોોડ્યુુલ 13	મે ેઇલિં�ગ્સ મેેનેેજ કરોો
મોોડ્યુુલ 14	 સ્પ્રેેડ શીીટ એપ્લિ��કેશન, વર્કકશી ીટ્્સ અનેે 	
	 વર્કકબુ ુકનુંં� સંંચાાલન કરોો

મોોડ્યુુલ 15	ડે ટાા સેેલ અનેે રેેન્જ મેેનેેજ કરોો
મોોડ્યુુલ 16	કો ોષ્ટકોો અનેે કોોષ્ટક ડેેટાાનુંં� સંંચાાલન કરોો
મોોડ્યુુલ 17	સૂૂત્રો ો અનેે કાાર્યોોનોો ઉપયોોગ કરીીનેે કાામગીીરીી કર
મોોડ્યુુલ 18	ચા ાર્ટટ  મેેનેેજ કરોો
મોોડ્યુુલ 19	પિ� વટ કોોષ્ટકોોનુંં� સંંચાાલન કરોો
મોોડ્યુુલ 20	પા ાવર પોોઈન્ટ પ્રેેઝન્ટેશન
મોોડ્યુુલ 21	 સ્તુુતિ�ઓ ફોોર્મેેટ કરોો
મોોડ્યુુલ 22	કો ોષ્ટકોો અનેે બુુલેેટેેડ ટેેક્સ્ટ મેેનેેજ કરોો
મોોડ્યુુલ 23	ગ્રા ાફિ�ક તત્વોોનુંં� સંંચાાલન કરોો
મોોડ્યુુલ 24	 ઑડિ�ઓ અનેે વિ�ડિ�યોો ઘટકોોનુંં� સંંચાાલન કરોો
મોોડ્યુુલ 25	સં ંક્રમણોો અનેે એનિ�મેશેન મેેનેેજ કરોો
મોોડ્યુુલ 26	 સહયોોગ મેેનેેજ કરોો
મોોડ્યુુલ 27	 MySQL પર પ્રદર્શશન કરોો
મોોડ્યુુલ 28	 પ્રશ્નોો પર પ્રદર્શશન
મોોડ્યુુલ 29	કા ાર્યોો પર પ્રદર્શશન કરોો

શોોપ ફ્લોોરમાંં કૌૌશલ્ય પ્રશિ�ક્ષણનીી યોોજનાા કેેટલાાક વ્યવહાારુ પ્રોોજેકે્ટનીી આસપાાસ કેેન્દ્રિ��ત પ્રાાયોોગિ�ક અભ્યાાસનીી શ્રેેણીી દ્વાારાા કરવાામાંં આવીી છેે. જો 
કેે, એવાા થોોડાા કિ�સ્સાાઓ છેે કેે જ્યાંં વ્યક્તિ�િગત અભ્યાાસ પ્રોોજેકે્ટનોો ભાાગ ન બનેે.

પ્રાાયોોગિ�ક માાર્ગગદર્શિ�કાા વિ�કસાાવતીી વખતેે, દરેક અભ્યાાસ તૈૈયાાર કરવાાનોો નિ�ષ્ઠાાવાાન પ્રયાાસ કરવાામાંં આવ્યોો હતોો જે ેસરેેરાાશથીી ઓછાા તાાલીીમાાર્થીી 
દ્વાારાા પણ સમજવાા અનેે હાાથ ધરવાા માાટેે સરળ હશેે. જો કેે વિ�કાાસ ટીીમ સ્વીીકાારેે છેે કેે વધુુ સુુધાારાા માાટેે અવકાાશ છેે. NIMI અનુુભવીી તાાલીીમ ફેેકલ્ટીી 
તરફથીી સૂૂચનોોનીી રાાહ જુુએ છેે માાર્ગગદર્શિ�કાામાંં સુુધાારોો.

ટ્રેે�ડ સિ�દ્ધાંંત

ટ્રેે�ડ થિ�યરીીનાા મેેન્યુુઅલમાંં બાંંધકાામમાંં વેેલ્ડર - 1લીી ટ્રેે�ડ  સિ�દ્ધાંંત NSQF લેેવલ - 3 (સુુધાારેેલ 2022)નાા કોોર્સસ માાટેેનીી સૈદૈ્ધાંંતિ�ક માાહિ�તીીનોો સમાાવેશે 
થાાય છેે. NSQF સ્તર - 3 (સંશંોોધિ�ત 2022) અભ્યાાસક્રમમાંં સમાાવિ�ષ્ટ પ્રાાયોોગિ�ક કવાાયત અનુુસાાર સમાાવિ�ષ્ટોો ક્રમબદ્ધ છેે, દરેક કવાાયતમાંં શક્ય હોોય 
ત્યાંં સુુધીી સૈૈદ્ધાંંતિ�ક પાાસાાઓનેે આવરીી લેેવાામાંં આવેેલ કૌૌશલ્ય સાાથેે સંંબંંધિ�ત કરવાાનોો પ્રયાાસ કરવાામાંં આવ્યોો છેે. આ સહસંંબંંધ તાાલીીમાાર્થીીઓનેે 
કૌૌશલ્ય કરવાા માાટેેનીી ધાારણાા ક્ષમતાાઓ વિ�કસાાવવાામાંં મદદ કરવાા માાટેે જાળવવાામાંં આવેે છેે.

ટ્રેે�ડ  પ્રેેક્ટિ�કલનાા માાર્ગગદર્શિ�કાામાંં સમાાવિ�ષ્ટ અનુુરૂપ કવાાયત સાાથેે ટ્રેે�ડ  થિ�યરીી શીીખવવીી અનેે શીીખવીી પડશેે. આ માાર્ગગદર્શિ�કાાનીી દરેક શીીટમાંં અનુુરૂપ 
વ્યવહાારિ�ક અભ્યાાસ વિ�શેેનાા સૂૂચનોો આપવાામાંં આવ્યાા છેે.

શોોપ ફ્લોોરમાંં સંંબંંધિ�ત કૌૌશલ્યોો કરતાા પહેેલાા ઓછાામાંં ઓછાા એક વર્ગગમાંં દરેક અભ્યાાસ સાાથેે જોડાાયેેલ ટ્રેે�ડ થિ�યરીી શીીખવવીી/શીીખવીી એ બહેેતર 
રહેેશેે. ટ્રેે�ડ  સિ�દ્ધાંંતનેે દરેક એક્ષરસાાઈઝનાા સંંકલિ�ત ભાાગ તરીીકે ગણવાામાંં આવેે છેે.

સાામગ્રીી સ્વ-શિ�ક્ષણનાા હેેતુુ માાટેે નથીી અનેે તેેનેે વર્ગગખંડનીી સૂૂચનાાનાા પૂૂરક તરીીકે ગણવાામાંં આવવીી જોઈએ.
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(vii)

		મો  ોડ્યુુલ 1 :  સલાામત કાામ કરવાાનીી પદ્ધતિ�ઓ

	 1.1.01	 કમ્પ્યુુટર સિ�સ્ટમ સેેટઅપ સાાથેે વિ�દ્યુતુ જોડાાણોો શોોધોો (Locate the electrical connections 				  
		  with computer system setup)		  1

	 1.1.02	 સલાામતીી ચિ�હ્નોો અનેે જોખમનીી ઓળખ (Identifying Safety symbols and Hazard 				  
		  identification)	 1	 2

	 1.1.03	વિ� દ્યુતુ આગનાા કિ�સ્સાામાંં આગથીી લડવાાનીી સલાામત પદ્ધતિ�ઓનોો અભ્યાાસ કરોો (Practice safe 				  
		  methods of fire fighting in case of electrical fire)		  3

	 1.1.04	 અગ્નિ�શાામક સાાધનોોનોો ઉપયોોગ (Use of fire extinguishers)		  4

		મો  ોડ્યુુલ 2 :ડેેસ્કટોોપ પીીસીી એસેેમ્બલ કરોો

	 1.2.05	 કમ્પ્યુુટર પેેરિ�ફેેરલ્સ અનેે ડેેસ્કટોોપ કમ્પ્યુુટરનાા આંતંરિ�ક ઘટકોોનેે ઓળખોો (Identify computer 				  
		  peripherals and internal components of a desktop computer)	 1	 6

	 1.2.06	ડે સ્કટોોપ કમ્પ્યુુટરનાા ઘટકોોનેે એસેેમ્બલ કરોો (Assemble components of desktop computer)		  9

		  મોોડ્યુુલ 3 :વિ�ન્ડોોઝ ઓપરેેટિં�ગ સિ�સ્ટમનોો ઉપયોોગ	

	 1.3.07	વિ� ન્ડોોઝ ઈન્ટરફેેસ પર પ્રેેક્ટિ�સ કરોો અનેે વિ�ન્ડોોઝ નેેવિ�ગેેટ કરોો (Practice on Windows interface 				  
		  and navigation Windows)		  12

	 1.3.08	દૂૂ ર કરીી શકાાય તેેવીી ડ્રાા� ઇવનોો ઉપયોોગ કરીીનેે ફાાઇલોો અનેે ફોોલ્ડર્સસનુંં� સંંચાાલન કરવાાનીી પ્રેેક્ટિ�સ કરોો 				  
		  (Practice on managing files and folders using removable drives)		  15

	 1.3.09	ડે સ્કટોોપ કસ્ટમાાઇઝ કરોો (Customize the desktop)		  17

	 1.3.10	સે ટિં�ગ્સ અનેે વપરાાશકર્તાા એકાાઉન્્ટ્સ મેેનેેજ કરોો (Settings and manage user accounts)	 1	 19

	 1.3.11	સિ� સ્ટમ ગુુણધર્મોો અનેે નિ�યંંત્રણ પેેનલ વિ�ગતોો જુુઓ (View System properties and control 				  
		  panel details)		  21

	 1.3.12	કીીબો ોર્ડડ  શોોર્ટટકટ આદેેશોો સાાથેે કાામ કરોો (Work with keyboard shortcut commands)		  24

	 1.3.13	વિ�વિ� ધ આદેેશોોનોો ઉપયોોગ કરીીનેે દસ્તાાવેેજો છાાપોો અનેે સે્કેન કરોો (Print and scan documents 				  
		  using different commands)		  26

		  મોોડ્યુુલ 4 :કમ્પ્યુુટર બેેઝિ�ક્સ અનેે સોોફ્ટવેેર ઇન્સ્ટોોલેશેન

	 1.4.14	 BIOS સેેટિં�ગ્સ અનેે તેેમનાા ફેેરફાારોો જુુઓ (View the BIOS settings and their modifications)		  28

	 1.4.15	વિ� ન્ડોોઝ ઓપરેેટિં�ગ સિ�સ્ટમ ઇન્સ્ટોોલ કરોો (Install Windows operating system)		  31

	 1.4.16	હા ાર્ડડ  ડિ�સ્કનેે ફોોર્મેેટ કરોો અનેે પાાર્ટીીશન બનાાવોો (Format hard disk and create partition)		  36

	 1.4.17	 OS ઇન્સ્ટોોલેશેન દરમિ�યાાન સાામાાન્ય હાાર્ડડવે ેર અનેે સોોફ્ટવેેર સમસ્યાાઓનેે ઓળખોો અનેે સુુધાારોો 				  
		  (Identify and rectify common hardware and software issues during OS	 1			 
		  installation)			  37

	 1.4.18	વિ� ન્ડોોઝ માાટેે જરૂરીી એપ્લિ��કેશન સોોફ્ટવેેર ઇન્સ્ટોોલ કરોો (Install necessary application 				  
		  software for Windows)		  38

	 1.4.19	બ્ લૂૂટૂૂથ / Wi-Fi સેેટિં�ગ્સ ગોોઠવોો (Configure bluetooth / Wi-Fi settings)		  45

સમાાવિ�ષ્ટીી
	 અભ્યાાસ સંં.		  અભ્યાાસનુંં�  શીીર્ષષક                         	શિ� ક્ષણ 	 પૃૃષ્ઠ સંં.		
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(viii)

	 1.4.20	પ્રિ� ન્ટર, સે્કેનર, વેેબ કેેમેેરાા અનેે DVD ડ્રાા� ઇવ્સ ઇન્સ્ટોોલ કરોો (Install printer, scanner, Web 				  
		  camera & DVD drives)		  49

	 1.4.21	 એપ્લિ��કેશન સોોફ્ટવેેરનોો ઉપયોોગ કરીીનેે સીીડીી/ડીીવીીડીી પર ડેેટાા, વિ�ડિ�યોો અનેે ઑડિ�યોો ફાાઇલોો બર્નન કરોો 	 1			 
		  (Burn data, video and audio files on CD/DVD using application software)		  53

		  મોોડ્યુુલ 5 :DOS કમાાન્ડ લાાઇન ઇન્ટરફેેસ

	 1.5.22	મૂૂ ળભૂૂત DOS આદેેશોો (Basic DOS Commands)		  54

	 1.5.23	ડો ોસ આદેેશોોનોો ઉપયોોગ કરીીનેે ફાાઇલોો અનેે ફોોલ્ડર્સસનુંં� સંંચાાલન કરવુંં� (Managing files and	 1			 
		   folders using dos commands)		  57

		મો  ોડ્યુુલ 6 :  ઉબુુન્ટુુ લિ�નક્સ ઓપરેેટિં�ગ સિ�સ્ટમ ઇન્સ્ટોોલ કરોો અનેે મૂૂળભૂતૂ લિ�નક્સ કમાાન્ડ 				  
		                         ચલાાવોો

	 1.6.24	 ઉબુુનુ્ટુ લિ�નક્સ ઑપરેેટિં�ગ સિ�સ્ટમનુંં� ઇન્સ્ટોોલેશેન (Installation of ubuntu linux operating 				  
		  system)			   61

	 1.6.25	લિ� નક્સમાંં જરૂરીી એપ્લિ��કેશન સોોફ્ટવેેર ઇન્સ્ટોોલ કરોો (Install necessary application software 				  
		  in Linux)			   65

	 1.6.26	ડિ�રે ક્ટરીી લિ�સ્ટિં�ગ ફાાઇલ, ફોોલ્ડર મેેનેેજમેેન્ટ, માાટેે મૂૂળભૂૂત Linux આદેેશોોનોો ઉપયોોગ કરોો (Use				  
		  basic Linux commands for directory listing File, Folder management, Password 				  
		  etc.,)			   67

	 1.6.27	ફા ાઈલ અનેે ફોોલ્ડર મેેનેેજમેેન્ટ માાટેે Linux ગ્રાાફિ�કલ યુુઝર ઈન્ટરફેેસનોો ઉપયોોગ કરોો, સિ�સ્ટમ વગેેરેેનીી 	 1			 
		શો  ોધખોોળ (Use the Linux graphical user interface for file and folder management, 				  
		  exploring the system etc.)		  74

	 1.6.28	ડે સ્કટોોપ સેેટિં�ગ્સનેે કસ્ટમાાઇઝ કરોો અનેે Linux માંં વપરાાશકર્તાા એકાાઉન્્ટ્સનુંં� સંંચાાલન કરોો 				  
		  (Customize desktop settings and manage user accounts in Linux)		  77

	 1.6.29	 Linux માંં સિ�સ્ટમ ગુુણધર્મોો જુુઓ અનેે સિ�સ્ટમ સેેટિં�ગ્સ મેેનેેજ કરોો (View system properties 				  
		  and manage system setting in Linux)		  80

		  મોોડ્યુુલ 7 : વર્ડડ  પ્રોોસેેસિં�ગ સોોફ્ટવેેર

	 1.7.30	દ સ્તાાવેેજોમાંં નેેવિ�ગેેટ કરોો (Navigate within documents)		  81

	 1.7.31	ફો ોર્મેેટ દસ્તાાવેેજો (Format documents)	 2	 86

	 1.7.32	દ સ્તાાવેેજો સાાચવોો અનેે શેેર કરોો (Save and share documents)		  95

	 1.7.33	મુ ુદ્દાાઓ માાટેે દસ્તાાવેેજોનુંં� નિ�રીીક્ષણ કરોો (Inspect documents for issues)		  98

		  મોોડ્યુુલ 8 : ફોોર્મેેટ દસ્તાાવેેજો

	 1.8.34	ટે ક્સ્ટ અનેે ફકરાા દાાખલ કરોો (Insert text and paragraphs)	 2	 103

	 1.8.35	ટે ક્સ્ટ અનેે ફકરાાઓનેે ફોોર્મેેટ કરોો (Format text and paragraphs)		  105

	 1.8.36	 દસ્તાાવેેજ વિ�ભાાગોો બનાાવોો અનેે ગોોઠવોો (Create and configure document sections)		  110

		  મોોડ્યુુલ 9 :કોોષ્ટકોો અનેે સૂૂચિ�ઓનુંં� સંંચાાલન કરોો

	 1.9.37	કો ોષ્ટકોો બનાાવોો (Create tables)		  113

	 1.9.38	કો ોષ્ટકોો સંશંોોધિ�ત કરોો (Modify tables)	 2	 115

	 1.9.39	યા ાદીીઓ બનાાવોો અનેે સંશંોોધિ�ત કરોો (Create and modify lists)		  119

	 અભ્યાાસ સંં.		  અભ્યાાસનુંં�  શીીર્ષષક                         	શિ� ક્ષણ 	 પૃૃષ્ઠ સંં.		
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(ix)

		  મોોડ્યુુલ 10 :સંંદર્ભોો બનાાવોો અનેે મેેનેેજ કરોો

	 1.10.40	સં ંદર્ભભ તત્વોો બનાાવોો અનેે મેેનેેજ કરોો (Create and manage reference elements)	 2	 125

	 1.10.41	સં ંદર્ભભ કોોષ્ટકોો બનાાવોો અનેે મેેનેેજ કરોો (Create and manage reference tables)		  129

		  મોોડ્યુુલ 11 : ગ્રાાફિ�ક તત્વોોનુંં� સંંચાાલન કરોો

	 1.11.42	ચિ�ત્રો ો અનેે ટેેક્સ્ટ બોોક્સ દાાખલ કરોો (Insert illustrations and text boxes)		  133

	 1.11.43	ફો ોર્મેેટ ચિ�ત્રોો અનેે ટેેક્સ્ટ બોોક્સ (Format illustrations and text boxes)	 2	 147

	 1.11.44	ગ્રા ાફિ�ક ઘટકોોમાંં ટેેક્સ્ટ ઉમેેરોો (Add text to graphic elements)		  151

	 1.11.45	ગ્રા ાફિ�ક ઘટકોોમાંં ફેેરફાાર કરોો (Modify graphic elements)		  152

		  મોોડ્યુુલ 12 : દસ્તાાવેેજ સહયોોગ મેેનેેજ કરોો

	 1.12.46	ટિ� પ્પણીીઓ ઉમેેરોો અનેે મેેનેેજ કરોો (Add and manage comments)	 2	 160

	 1.12.47	 ફેેરફાાર ટ્રેે�  કિં�ગ મેેનેેજ કરોો (Manage change tracking)		  162

		મો  ોડ્યુુલ 13 : મેેઇલિં�ગ્સ મેેનેેજ કરોો

	 1.13.48	મે ેઇલ મર્જજ  કરોો (Perform mail merge)	 2	 166

		  મોોડ્યુુલ 14 : સ્પ્રેેડ શીીટ એપ્લિ��કેશન, વર્કકશી ીટ્્સ અનેે વર્કક બુકુનુંં� સંંચાાલન કરોો

	 1.14.49	 MS Excel માંં ફાાઇલોો ખોોલોો (Open files in MS Excel)		  173

	 1.14.50	ડે ટાા આયાાત કરોો (Import data)		  177

	 1.14.51	 વર્કકબુ ુકમાંં નેેવિ�ગેેટ કરોો (Navigate within workbooks)	 3	 178

	 1.14.52	 વર્કકશી ીટ્્સ અનેે વર્કકબુ કનેે ફોોર્મેેટ કરોો (Format worksheets and workbooks)		  184

	 1.14.53	વિ� કલ્પોો અનેે દૃશ્યોોનેે કસ્ટમાાઇઝ કરોો (Customize options and views)		  187

	 1.14.54	 સહયોોગ માાટેે સાામગ્રીીનેે ગોોઠવોો (Configure content for collaboration)		  196

		  મોોડ્યુુલ 15 : ડેેટાા સેેલ અનેે રેેન્જ મેેનેેજ કરોો

	 1.15.55	ડે ટાાનીી હેેરફેેર કરોો (Manipulate data)		  205

	 1.15.56	કો ોષોો અનેે શ્રેેણીીઓ ફોોર્મેેટ કરોો ( Format cells and ranges)	 3	 209

	 1.15.57	ના ામવાાળીી રેેન્જનેે વ્યાાખ્યાાયિ�ત કરોો અનેે સંંદર્ભભ આપોો (Define and reference named ranges)		  213

	 	મો ોડ્યુુલ 16 : કોોષ્ટકોો અનેે કોોષ્ટક ડેેટાાનુંં� સંંચાાલન કરોો

	 1.16.58	કો ોષ્ટકોો બનાાવોો અનેે ફોોર્મેેટ કરોો (Create and format tables)		  217

	 1.16.59	કો ોષ્ટકોો અનેે તેેનાા ડેેટાાનુંં� સંંચાાલન (Managing tables and its data)	 3	 219

	 1.16.60	કો ોષ્ટક ડેેટાા ફિ�લ્ટર અનેે સૉૉર્ટટ  કરોો (Filter and sort table data)		  221

		મો  ોડ્યુુલ 17 : સૂતૂ્રોો અનેે કાાર્યોોનોો ઉપયોોગ કરીીનેે કાામગીીરીી કરોો

	 1.17.61	સં ંદર્ભોો દાાખલ કરોો (Insert references)		  224

	 1.17.62	ડે ટાાનીી ગણતરીી અનેે રૂપાંંતર કરોો (Calculate and transform data)	 3	 230

	 1.17.63	ટે ક્સ્ટનેે ફોોર્મેેટ કરોો અનેે સંશંોોધિ�ત કરોો (Format and modify text)		  232

	 અભ્યાાસ સંં.		  અભ્યાાસનુંં�  શીીર્ષષક                         	શિ� ક્ષણ 	 પૃૃષ્ઠ સંં.		
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(x)

		મો  ોડ્યુુલ 18 : ચાાર્ટટ  મેેનેેજ કરોો

	 1.18.64	ચા ાર્ટટ  બનાાવોો (Create Charts)		  234

	 1.18.65	ચા ાર્ટટમાંં ફેેરફાાર કરોો (Modify charts)	 3	 238

	 1.18.66	ચા ાર્ટટમાંં ફેેરફાાર કરોો (Format charts)		  241

		મો  ોડ્યુુલ 19 : પિ�વટ કોોષ્ટકોોનુંં� સંંચાાલન કરોો

	 1.19.67	પી ીવટ કોોષ્ટકોો બનાાવોો (Create Pivot Tables)	 3	 243

		  મોોડ્યુુલ 20 : પાાવર પોોઈન્ટ પ્રેેઝને્ટેશન

	 1.20.68	 MS PowerPoint માંં ફાાઇલોો ખોોલોો (Open files in MS PowerPoint)		  254

	 1.20.69	પા ાવરપોોઈન્ટ પ્રસ્તુુતિ�ઓ ફોોર્મેેટ કરોો (Format Power Point Presentations)		  258

	 1.20.70	 સ્લાાઇડ માાસ્ટર્સસ, હેેન્ડઆઉટ માાસ્ટર્સસ અનેે નોોટ માાસ્ટર્સસમાંં ફેેરફાાર કરોો (Modify slide masters, 				  
		  handout masters, and note masters)	 4	 260

	 1.20.71	 પ્રસ્તુુતિ� વિ�કલ્પોો અનેે દૃશ્યોો બદલોો (Change presentation options and views)		  262

	 1.20.72	પા ાવરપોોઈન્ટ પ્રસ્તુુતિ�ઓ સાાચવોો અનેે શેેર કરોો (Save and share PowerPoint Presentations)		  266

	 1.20.73	 સ્લાાઇડ શોો ગોોઠવોો અનેે પ્રસ્તુતુ કરોો (Configure and present slide shows)		  268

	 1.20.74	 સહયોોગ માાટેે પ્રસ્તુુતિ�ઓ તૈૈયાાર કરોો (Prepare presentations for collaboration)		  270

		મો  ોડ્યુુલ 21 : સ્તુુતિ�ઓ ફોોર્મેેટ કરોો

	 1.21.75	ટે ક્સ્ટ અનેે ફકરાા દાાખલ કરોો (Insert text and paragraphs)		  271

	 1.21.76	ટે ક્સ્ટ અનેે ફકરાાઓનેે ફોોર્મેેટ કરોો (Format text and paragraphs)	 4	 274

	 1.21.77	વિ�ભા ાગોો બનાાવોો અનેે ગોોઠવોો (Create and configure sections)		  279

		મો  ોડ્યુુલ 22 : કોોષ્ટકોો અનેે બુુલેેટેેડ ટેેક્સ્ટ મેેનેેજ કરોો

	 1.22.78	કો ોષ્ટકોો બનાાવોો (Create tables)		  281

	 1.22.79	કો ોષ્ટકોો સંંશોોધિ�ત કરોો (Modify tables)		  284

	 1.22.80	બુ ુલેેટેેડ ટેેક્સ્ટ બનાાવોો અનેે સંંશોોધિ�ત કરોો (Create and modify bulleted text)	 4	 289

	 1.22.80A	સં દર્ભભ તત્વોો (હાાયપરલિં�ક્સ) બનાાવોો અનેે મેેનેેજ કરોો (Create and manage reference 				  
		  elements (hyperlinks))		  290

		મો  ોડ્યુુલ 23 : ગ્રાાફિ�ક તત્વોોનુંં� સંંચાાલન કરોો

	 1.23.81	ચિ�ત્રો ો અનેે ટેેક્સ્ટ બોોક્સ દાાખલ કરોો (Insert illustrations and text boxes)		  293

	 1.23.82	ફો ોર્મેેટ ચિ�ત્રોો  અનેે ટેેક્સ્ટ બોોક્સ (Format illustrations and text boxes)	 4	 296

	 1.23.83	ગ્રા ાફિ�ક ઘટકોોમાંં ટેેક્સ્ટ ઉમેેરોો અનેે સંશંોોધિ�તકરોો (Add and modify text in graphic elements)		  304

		મો  ોડ્યુુલ 24 : ઑડિ�ઓ અનેે વિ�ડિ�યોો ઘટકોોનુંં� સંંચાાલન કરોો

	 1.24.84	 ઑડિ�ઓ ઘટકોો ઉમેેરોો (Add Audio elements)		  309

	 1.24.85	વિ�ડિ� ઓ ઘટકોો ઉમેેરોો (Add video elements)	 4	 311
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(xi)

		મો  ોડ્યુુલ 25 : સંકં્રમણોો અનેે એનિ�મેશેન મેેનેેજ કરોો

	 1.25.86	 સ્લાાઇડ સંંક્રમણોો ઉમેેરોો (Add slide transitions)		  314

	 1.25.87	 એનિ�મેશેન ઉમેેરોો (Add Animations)	 4	 319

		  મોોડ્યુુલ 26 : સહયોોગ મેેનેેજ કરોો

	 1.26.88	ટિ� પ્પણીીઓ ઉમેેરોો અનેે મેેનેેજ કરોો (Add and manage comments)	 4	 337

		મો  ોડ્યુુલ 27 : MySQL પર પ્રદર્શશન કરોો

	 1.27.89	 MySQL નીી સ્થાાપનાા (Installation of MySQL)		  339

	 1.27.90	મૂૂ ળભૂૂત ઇન્સ્ટોોલેશેન સમસ્યાાઓનુંં� મુશુ્કેેલીીનિ�વાારણ (Troubleshooting basic installation 				  
		  issues)			   344

	 1.27.91	 MySQL નીી રચનાા અનેે ઉપયોોગોો (Creation and uses of MySQL)		  348

	 1.27.92	કો ોષ્ટકોોનીી ડિ�ઝાાઇન (Designing of tables)	 5	 349

	 1.27.93	ડે ટાા અખંંડિ�તતાા નિ�યમોો લાાગુુ કરીી રહ્યાા છીીએ (Applying data integrity rules)		  350

	 1.27.94	 DDL, DCL અનેે DML સે્ટેટમેેન્ટનોો ઉપયોોગ કરવોો (Using DDL, DCL and DML statements)		  352

	 1.27.95	 પ્રતિ�બંંધોો, પ્રાાથમિ�ક કીી અનેે વિ�દેશીી કીી લાાગુુ કરવીી (Enforcing constraints, primary key and 				  
		  foreign key)			  355

	 1.27.96	કો ોષ્ટકોોમાંં સૂૂચકાંંકોો ઉમેેરીી રહ્યાા છીીએ (Adding indices to tables)		  357

		મો  ોડ્યુુલ 28 :પ્રશ્નોો પર પ્રદર્શશન

	 1.28.97	 સરળ પસંંદગીીનાા પ્રશ્નોો (Simple select queries)		  358

	 1.28.98	ક્વે ેરીીઝ અપડેેટ ક્વેેરીીઝ દાાખલ કરોો અનેે કાાઢીી નાાખોો (Insert and delete queries update 	 5			 
		  queries)			   359

		મો  ોડ્યુુલ 29 :કાાર્યોો પર પ્રદર્શશન કરોો

	 1.29.99	સં ખં્યાા, તાારીીખ અનેે અક્ષરનાા કાાર્યોો, જોડાાઓ અનેે કાાર્યોોનોો ઉપયોોગ કરીીનેે (Using the Number, 				  
		  Date and Character functions, Joins and Functions)	 5	 361

	 1.29.100	 જોડાાઓ, જૂૂથ દ્વાારાા, હોોવાા, સબ ક્વેેરીી (Joins, Group by, Having, Sub query)		  363
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શીીખવાાનીી / આકાારણીી કરીી શકાાય તેેવુંં� પરિ�ણાામ

આ પુુસ્તક પૂૂર્ણણ થવાા પર તમેે સમર્થથ હશોો

	 ક્ર. સંં. 	શિ� ક્ષણ પરિ�ણાામોો	 અભ્યાાસ સંં.

	 1	 Install and setup operating system and related software in a computer 					  
		  following safety precautions. (Mapped NOS: SSC/N3022)	 1.1.01 - 1.6.29

	 2	 Create, format, and edit document using word processing application 					  
		  software. (Mapped NOS: SSC/N3022)	 1.7.30 - 1.13.48

	 3	 Create, format, edit and develop a workbook by using spreadsheet 					  
		  application software. (Mapped NOS: SSC/N3022)	 1.14.49 - 1.19.67

	 4	 Create and customize slides for presentation. (Mapped NOS: SSC/N3022)	 1.20.68 - 1.26.88

	 5	 Create and manage database file by using MySQL. (NOS: SSC/N9401)	 1.27.89 - 1.29.100
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(xii)

Professional 
S k i l l -  9 4 
Hrs;

Professional 
Knowledge - 
32 Hrs

I n s t a l l  a n d  s e t u p 
operating system and 
related software in a 
computer following safety 
precautions. (Mapped 
NOS: SSC/N3022)

Safe working practices (10 Hrs)
1.	 Visit COPA Lab. of the institutes 

and locate the electr ical 
connections with computer 
system setup. (3 Hrs)

2.	 Identifying safety symbols and 
hazard identification. (3 Hrs)

3.	 Practice safe methods of fire 
fighting in case of electrical fire. 
(2 Hrs)

4.	 Use of f ire extinguishers. 
(2Hrs)

Assemble a Desktop PC (8 hrs)
5.	 Identify computer peripherals 

and internal components of a 
desktop computer. (4 Hrs)

6.	 Assemble components of 
desktop computer. (4 Hrs)

Using Windows Operating 
Systems (20 hrs)
7.	 Practice on Windows interface 

and navigating windows. (3 Hrs)
8.	 Practice on managing files and 

folders using removable drives. 
(4 Hrs)

9.	 Customize the desktop (2 hrs)
10.	Settings	 and	 manage	

user accounts. (1 Hr)
11.	View system properties and 

control panel details. (3 Hrs)
12.	Work with keyboard shortcut 

commands. (4 Hrs)
13.	Print and scan document using 

different commands. (3 Hrs)
Computer	 basics	 a n d 
Software Installation (20 Hrs)
14.	View the BIOS settings and their 

modifications. (3 Hrs)
15.	Install Windows operating 

system. (4 Hrs)
16.	Format hard disk and create 

partition. (3 Hrs)
17.	Identify and rectify common 

hardware and software issues 
during OS installation. (3 Hrs)

18.	Install necessary application 
software for Windows i.e. Office 
Package, PDF Reader, Media 
Player etc. (2 Hrs)

19.	Configure Bluetooth and Wi-Fi 
settings. (1 Hr)

20.	Install Drivers for printer, 
scanner, webcam and DVD 
etc. (2 Hrs)

Introduction to Computers (3 
Hrs)

•	 Safe	working practices
•	 Scope of the COPA trade.
•	 Safety	 rules	 and safety 

signs.
•	 Types and working of	

fire
	 extinguishers. Introduction	 t o 

Computer components
Introduction	 t o  c o m p u t e r 
system (4 Hrs)
•	 Concepts	 o f  Hardware	

and Software.
•	 Function		  of mother 

board components and various 
processors.

•	 Various	 I n p u t /  O u t p u t 
devices in use and their features

	 Introduction Windows Operating 
System (9 Hrs)

•	 Introduction to operating System
•	 Main features of Windows OS
•	 Concept of various shortcut 

commands.
Introduction	 to	 t h e 
booting process (6 Hrs)
•	 Introduction to various types of 

memories and their features.
•	 Basic Hardware and software 

issues and their solutions.
•	 Usage	 o f  A p p l i c a t i o n 

software	 and Antivirus.
Introduction to DOS Command 
Line Interface & Linux Operating 
Systems (10 Hrs)
•	 Introduction to basic DOS Internal 

and	 External Commands.
•	 Introduction to Open	S o u r c e 

Software
•	 Introduction to Linux Operating 

System features, structure, files 
and processes

•	 Basic	 Linux commands.

SYLLABUS

Duration Reference Learning
Outcome

Professional Skills
(Trade Practical)

with Indicative hours

Professional Knowledge
(Trade Theory)
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(xiii)

21.	Burn data, video and audio files 
on CD/DVD using application 
software. (2 Hrs)

DOS Command Line Interface 
(9Hrs)

22.	Use basic DOS commands for 
directory listing. (5 Hrs)

23.	Manage files and folders using 
DOS commands. (4 Hrs)

Install Ubuntu Linux operating 
system and execute basic Linux 
commands (27 Hrs)
24.	Installation of Ubuntu Linux 

operating system (6 Hrs)
25.	Install necessary application 

software for Linux i.e. Office 
Package, PDF Reader, Media 
Player etc. (4 Hrs)

26.	Use Basic Linux commands for 
directory listing, file and folder 
management, password etc. (6 
Hrs)

27.	Use the Linux graphical user 
interface for file and folder 
management, exploring the 
system etc. (6 Hrs)

28.	Customize desktop settings and 
manage user accounts in Linux.  
(3 Hrs)

29. View system   properties   and 
manage system setting in Linux.  
(2 Hrs)

Professional 
S k i l l  -  
47 Hrs.;

Professional 
Knowledge - 
14 Hrs

Create, format, and edit 
document using word 
processing application 
software. (Mapped NOS: 
SSC/N3022)

Using Word Processing Software 
(47 hrs)
Manage documents (11 Hrs.)
30.	Navigate within documents (2 

Hrs)
•	 Search for text
•	 Link	to	 locat ions	

within documents
•	 Move to specific locations and 

objects in documents
•	 Show and hide formatting 

symbols and hidden text
31.	Format documents (4.6 Hrs)
•	 Set up document pages
•	 Apply style sets
•	 Insert and modify headers and 

footers
•	 Configure page background 

elements
32.	Save and share documents (2 

Hrs)
•	 Save	 documents	 in 

alternative file formats
•	 Modify	 basic	 document 

properties
•	 Modify print settings
•	 Share	 d o c u m e n t s 

electronically

Using Word Processing Software 
(14 Hrs)
•	 Introduction to the various 

applications in MS office.
•	 Introduction to Word         features, 

Office	 button, toolbars.
•	 Creating, saving and formatting 

and printing documents using 
Word.

•	 Working	 w i t h  o b j e c t s , 
macro, mail merge, templates 
and other tools in Word.
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(xiv)

33.	Inspect documents for issues  
(2.4 Hrs)

•	 Locate and remove hidden properties 
and personal information

•	 Locate	 and	 c o r r e c t 
accessibility issues

•	 Locate	 and	 c o r r e c t 
compatibility issues

Format documents (8 Hrs.)
34.	Insert text and paragraphs (2 Hrs)
•	 Find and replace text
•	 Insert symbols and special characters
35.	Format text and paragraphs (3 

Hrs)
•	 Apply text effects
•	 Apply formatting by using Format 

Painter
•	 Set	 line	 and	 p a r a g r a p h 

spacing and indentation
•	 Apply built-in styles to text
•	 Clear formatting
36.	Create and configure document 

sections (3 Hrs)
•	 Format	 text	 i n 	

multiple columns
•	 Insert	 page,	 section,	a n d 

column breaks
•	 Change page setup options for a 

section
Manage tables and lists (9.5 Hrs)
37.	Create tables (3 Hrs)
•	 Convert text to tables
•	 Convert tables to text
•	 Create tables by specifying rows and 

columns
38.	Modify tables (3 Hrs)
•	 Sort table data
•	 Configure cell margins and spacing
•	 Merge and split cells
•	 Resize	 tables,	 rows,	 a n d 

columns
•	 Split tables
•	 Configure a repeating row header
39.	Create and modify lists (3.5 Hrs)
•	 Format paragraphs as numbered and 

bulleted lists
•	 Change bullet characters and 

number formats
•	 Define custom bullet characters and 

number formats
•	 Increase and decrease list levels
•	 Restart and continue list numbering
•	 Set starting number values Create 

and manage references (3 Hrs.)
40.	Create and manage reference 

elements (1.4 Hrs)
•	 Insert	 footnotes	 and 

endnotes
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(xv)

•	 Modi fy footnote and endnote 
properties

•	 Create	 and	 m o d i f y 
bibliography citation sources

•	 Insert	 citations	 f o r 
bibliographies

41.	Create and manage reference 
tables (1.6 Hrs)

•	 Insert tables of contents
•	 Customize tables of contents
•	 Insert bibliographies
Manage graphic elements (8.5 Hrs.)
42.	Insert illustrations and text boxes  

(3 Hrs)
•	 Insert shapes
•	 Insert pictures
•	 Insert 3D models
•	 Insert Smart Art graphics
•	 Insert screenshots and screen 

clippings
•	 Insert text boxes
43.	Format illustrations and text boxes  

(3 Hrs)
•	 Apply artistic effects
•	 Apply	 picture	 effects	 a n d 

picture styles
•	 Remove picture backgrounds
•	 Format graphic elements
•	 Format SmartArt graphics
•	 Format 3D models
44.	Add text to graphic elements (1 Hr)
•	 Add and modify text in text boxes
•	 Add and modify text in shapes
“	 Add and modify SmartArt graphic 

content
45.	Modify graphic elements (1.5 Hrs)
•	 Position objects
•	 Wrap text around objects
•	 Add	alternative	 text	 t o 

objects for accessibility
Manage document collaboration  
(3.5 Hrs.)
46.	Add and manage comments (1 Hrs)
•	 Add comments
•	 Review	 and	 reply	 t o 

comments
•	 Resolve comments
•	 Delete comments
47.	Manage change tracking (2.5 Hrs)
•	 Track changes
•	 Review tracked changes
•	 Accept and reject tracked changes
•	 Lock	and	 unlock	 change tracking
Manage Mailings (3.5 Hrs)
48.	Perform mail merge (3.5 Hrs)
•	 Create envelopes
•	 Create labels
•	 Create a new mailing list
•	 Perform mail merge using an existing 

list
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Create,  format , 
edit and develop 
a  workbook  by 
using spreadsheet 
a p p l i c a t i o n 
software. (Mapped 
NOS: SSC/N3022)

Spread Sheet Application (72 Hrs) 
Manage Worksheets and Workbooks 
(12 Hrs.)
49.	Open files in MS Excel (1.5 Hrs)
•	 Open MS Excel
•	 Create a new Excel file
•	 Create a new Excel file from a 

template
•	 Open an existing Excel file
50.	Import data (1.5 Hrs)
•	 Import data from txt files
•	 Import data from csv files
51.	Navigate within workbooks (2 

Hrs)
•	 Search data
•	 Navigate	 to	 named	 cells, 

ranges or workbook elements
•	 Insert and remove hyperlinks
52.	Format	 worksheets	 a n d 

workbooks (2 Hrs)
•	 Modify page setup
•	 Adjust row height and column width
•	 Customize	 headers	 a n d 

footers
53.	Customize options and views  

(3 Hrs)
•	 Display and modify content in 

different views
•	 Freeze rows and columns
•	 Change window views
•	 Modify	 basic	 w o r k b o o k 

properties
•	 Display formulas
54.	Configure	 content	 f o r 

collaboration (2 Hrs)
•	 Set a print area
•	 Save workbooks in alternative file 

formats
•	 Configure print settings Manage 

data cells and ranges (12 Hrs.)
55.	Manipulate data (3 Hrs)
•	 Paste data by using special paste 

options
•	 Fill cells by using Auto Fill
•	 Insert and delete multiple columns 

or rows
•	 Insert and delete cells
56.	Format cells and ranges (5 Hrs)
•	 Merge and Unmerge cells
•	 Modify	 cell	 a l i g n m e n t , 

orientation and indentation
•	 Format cells using Format Painter
•	 Wrap text within cells
•	 Apply number formats
•	 Apply cell formats from the Format 

cells dialog box
•	 Apply cell styles
•	 Clear cell formatting

Spread	Sheet Application (18 Hrs)
•	 Introduction to Excel features and Data 

Types.
•	 Cell referencing and linking Sheets.
•	 Introduction to various functions in all 

categories of Excel.
•	 Concepts of sorting, filtering	 a n d 

validating data.
•	 Analyzing data using charts, data 

tables, pivot tables, goal seek and 
scenarios

Professional 
Sk i l l  -  72 
Hrs.;

Professional 
Knowledge - 
18 Hrs
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57.	Define and reference named 
ranges (4 Hrs)

•	 Define a named range
•	 Name a table
•	 Summarize	 data	 visually Insert 

spark lines
•	 Apply	 built	 i n 	

conditional formatting
•	 Remove	 conditional formatting
Manage tables and table data (12 Hrs.)
58.	Create and format tables (4 hrs)
•	 Create excel tables from cell ranges
•	 Apply table styles
•	 Convert tables to cell ranges
59.	Manage tables and table data (5 Hrs)
•	 Add or remove table rows and 

columns
•	 Configure table style options
•	 Insert and configure total rows
60.	Filter and sort table data (3 Hrs)
•	 Filter records
•	 Sort data by multiple columns 

Perform operations using formulas 
and functions (12 Hrs.)

61. Insert references (3 Hrs)
•	 Insert relative, absolute and mixed 

references
•	 Reference named ranges and named 

tables in formulas
62.	Calculate and transform data (5 

Hrs)
•	 P e r f o r m  c a l c u l a t i o n s  u s i n g 

AVERAGE(), MIN(), MAX() and 
SUM()

•	 Count cells by using COUNT(), 
COUNTIF()	 and COUNTBLANK()

•	 Perform	 conditional operations 
by using the IF() function

63.	Format and modify text(4 Hrs)
•	 Format	 text	 u s i n g 

RIGHT(),LEFT() and MID() functions
•	 Format  tex t  us ing UPPER() , 

LOWER() and LEN() functions
•	 Format text using CONCAT() and 

TEXTJOIN() functions
Manage Charts (12 Hrs.)
64.	Create Charts (3 Hrs)
•	 Create charts
•	 Create chart sheets
65.	Modify charts (4 Hrs)
•	 Add data series to charts
•	 Switch between rows and columns in 

source data
•	 Add	and	 modify	 chart elements
•	 Add trend lines to chart
66.	Format charts (5 Hrs)
•	 Apply chart layouts
•	 Apply chart styles
•	 Add alternative text to charts for 

accessibility
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Manage Pivot Tables (12 Hrs.)
67.	Create Pivot Tables(12 Hrs)
•	 Create Pivot tables from cell ranges
•	 Manipulate fields (columns) to get 

desired analysis
•	 Use Filters for pivot tables
•	 Represent data as Count, Sum, 

Average & % of row / column
•	 Group data in Columns & rows for 

aggregate reports

Power point Presentations (9.5 Hrs.)
68. Open files in MS PowerPoint  

(1 Hr)
•	 Open MS PowerPoint
•	 Create a new PowerPoint file
•	 Create a new PowerPoint file from a 

template
•	 Open an existing PowerPoint file
69.	Format	 P o w e r P o i n t 

Presentations (1.5 Hrs)
•	 Add slides
•	 Add titles and text
•	 Select slide layouts
•	 Add PowerPoint templates
•	 Duplicate slides
70.	Modify slide masters, handout 

masters, and note masters (2 Hrs)
•	 Change	 the	 slide	 master 

theme or background
•	 Modify slide master content
•	 Modify slide layouts
71.	Change presentation options and 

views (1.5 Hrs)
•	 Change slide size
•	 Display	 presentations	 i n 

different views
72.	Save and share PowerPoint 

Presentations (1.5 Hrs)
•	 Save	 presentations	 i n 

alternative file formats
•	 Configure	 different	 P r i n t 

settings
•	 Share	 p r e s e n t a t i o n s 

electronically
73.	Configure and present slide shows  

(1 Hr)
•	 H ide  unwanted  s l ides  wh i le 

presenting
•	 Configure slide show options
•	 Present sl ide shows by using 

Presenter View
74.	Prepare	 presentations	 f o r 

collaboration (1 Hrs)
•	 Protect	 presentations	 b y 

using passwords
•	 Export presentations to other formats
Format presentations (6.5 Hrs.)
75.	Insert text and paragraphs (2 Hrs)
•	 Find and replace text

C r e a t e  a n d 
customize slides 
for presentation. 
(Mapped  NOS: 
SSC/N3022)

Professional 
Sk i l l  -  53 
Hrs;

Professional 
Knowledge - 
13 Hrs

Power	 point Presentations (13 Hrs.)
•	 Image	 editing, Presentations
•	 Introduction to Open Office.
•	 Introduction to the properties	a n d 

editing of images.
•	 Introduction to different formats of 

images and their uses.
•	 Introduction to Power Point and its 

advantages.
•	 Creating	 Slide Shows.
Fine tuning the presentation and good 
presentation technique
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•	 Inser t  symbo ls  and  spec ia l 
characters

76.	Format text and paragraphs (2 
Hrs)

•	 Apply text effects
•	 Apply formatting by using Format 

Painter
•	 Set	 line	 and	 p a r a g r a p h 

spacing and indentation
•	 Apply built-in styles to text
77.	Create and configure sections  

(2.5 Hrs)
•	 Format	 text	 i n 	

multiple columns
•	 Text and image presentation styles
•	 Clear formatting
Manage tables and bulleted text  
(8 Hrs)
78.	Create tables (3 Hrs)
•	 Insert tables in PowerPoint
•	 Apply built-in table styles
•	 Create tables by specifying rows and 

columns
79.	Modify tables (3 Hrs)
•	 Insert and delete table rows and 

columns
•	 Configure cell margins and spacing
•	 Merge and split cells
•	 Resize	 tables,	 rows,	 a n d 

columns
80.	Create and modify bulleted text (2 

Hrs)
•	 Format	 paragraphs	 a s 

numbered and bulleted lists
•	 Change bullet characters and 

number formats
•	 Increase and decrease list indents
•	 Set starting number values
•	 Restart and continue list numbering 

on different slides
Create and manage reference 
elements (hyperlinks) (1.25 Hrs)
•	 C r e a t e  h y p e r l i n k s  w i t h i n 

presentations
•	 Create hyperlinks in presentations 

for files and other sources
Manage graphic elements (11.5 Hrs)
81.	Insert illustrations and text boxes 

(3.5 Hrs)
•	 Insert shapes
•	 Insert pictures
•	 Insert SmartArt graphics
•	 Insert screenshots and screen 

clippings
82.	Format illustrations and text 

boxes (4 Hrs)
•	 Apply artistic effects
•	 Apply	 picture	 effects	 a n d 

picture styles
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•	 Remove picture backgrounds
•	 Crop images
•	 Format graphic elements
•	 Format SmartArt graphics
83.	Add and modify text in graphic 

elements (4 Hrs)
•	 Add and modify text in text boxes
•	 Add and modify text in shapes
•	 Add and modify SmartArt graphic 

text
•	 Create, insert and modify charts
Manage Audio & Video elements  
(6.5 Hrs)
84.	Add Audio elements (2 Hrs)
•	 Import	 audio	 files	 i n 

presentations
•	 Configure	 audio	 p l a y b a c k 

options
85.	Add Video elements (4.5 Hrs)
•	 Import	 video	 files	 i n 

presentations
•	 Resize video to fit slide
•	 Configure	 video	 p l a y b a c k 

options
Manage transitions and animations 
(9 Hrs)
86.	Add slide transitions (5 Hrs)
•	 Add same slide transition for all 

slides
•	 Set transition effect duration
•	 Configure transition start and finish 

options
•	 Customise	 select	 slide transitions
87.	Add animations (4 Hrs)
•	 Animate text and graphic elements
•	 Order shapes, images, and text 

boxes
•	 Group shapes, images, and text 

boxes
•	 Configure animation effects
•	 Configure animation paths
•	 Reorder animations on a slide
Manage collaboration (0.75 Hrs)
88.	Add and manage comments (0.75 

Hrs)
•	 Add comments
•	 Review	 and	 reply	 t o 

comments

Professional 
Sk i l l  -  53 
Hrs.;

Professional 
Knowledge - 
13 Hrs

Create and manage

database fi le by 
u s i n g  M ySQL . 
(NOS: SSC/N9401)

Database Concepts (4 Hrs.)
•	 Concept of DBMS, RDBMS.
•	 Data Models, Concept of DBA, Database 

Users.
•	 Database Schema.
•	 Designing Database using Normalization 

Rules.
•	 Various data types Data integrity, DDL 

DML and DCL statements.
•	 Enforcing Primary key and foreign key.
•	 Adding Indices.

Demonstrate on (15 Hrs.)
89.	Installation of MySQL. (1 Hr)
90.	Troubleshooting basic installation 

issues. (1 Hr)
91.	Creation and use of database. (3 Hr)
92.	Designing of tables. (3 Hr)
93.	Applying data integrity rules. (2 Hr)
94.	Using the DDL, DCL and DML 

statements. (2 Hrs)
95. Enforcing constraints,
primary key and foreign key. (2 Hrs)
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Professional 
Sk i l l  -  68 
Hrs;

Professional 
Knowledge - 
16 Hrs

I n s t a l l ,  s e t u p / 
c o n f i g u r e , 
troubleshoot, and 
secure computer 
network including 
Internet. (Mapped 
NOS: SSC/N3022)

Computer Network (68 Hrs.) Set-up 
& configure a Computer Network  
(48 Hrs.)
101.	 View Network connections. (2 

Hrs)
102.	 Connect a computer to a network 

and share Devices i.e. Printers, files, 
folders and drives. (4 Hrs)

103.	 Work with various Network 
devices, connectors and cables. 
Create straight and cross cable 
and punch a UTP cable in the patch 
socket and test the connectivity.  
(4 Hrs)

104.	 Practice IP Addressing and 
Subnet masking for IPV4/ IPV6 and 
pinging to test networks. (4 Hrs)

105.	 Configure Hub and Switch. (4 
Hrs)

106.	 Set up and configure wired and 
wireless LAN in a Computer Lab 
within at least three computers. (6 
Hrs)

107.	 Use patch panel & I/O Box 
for wired LAN and installing & 
configuring	 Internet connection in 
a single PC and in a LAN. (6 Hrs)

108.	 Set up a proxy server/ DHCP 
Server with firewall. (8 Hrs)

109.	 Set up video conferencing using 
open-source software. (4 Hrs)

110.	 Use various tools (by open source 
/free) for network troubleshooting, 
maintenance and security for both 
Wired and Wireless (6 Hrs)

111.	 Set  up Internet  access & 
communication (10 Hrs)

•	 Set-up internet connectivity
•	 Set-up digital communication
112. Use the Internet (10 Hrs)
•	 Browse the Internet
•	 Use e-mail
•	 Use Social Media
•	 Use the phone for online activities

Communicating in a Connected World 
(12 Hrs.)
•	 Local Networks,
•	 Communicating on a Local Network, 

Principles	 of Communications,
•	 How do Ethernet Networks Work?,
•	 How are Networks Built?,
•	 Routing Across Networks
•	 Explain how end- user devices and 

local	networks interact with the global 
Internet.

•	 Communicating in a Connected World 
Explain the concept of	 network 
communication.

•	 Local Networks Explain the roles of 
devices in a network.

•	 What Does a Home Network Look 
Like?

•	 How	Does	 Wi-Fi Work?
•	 I n t roduc t i on  t o  LAN Dev i ces , 

Internetworking Devices,
Internet	 Concepts	 (4 Hrs)
•	 Introduction to www, Concept of 

Internet,	 Web Browsers, internet 
servers and search engines.

•	 Concepts of Domain naming Systems 
and E mail communication.

•	 Introduction to video chatting tools 
and	 Social Networking concepts.

96. Adding indices to Tables. (1 Hr)
Demonstrate on (15 Hrs)
97.	Simple select queries. (5 Hrs)
98.	Insert and delete queries Update 

queries. (10 Hrs)
Demonstrate on (23 Hrs)
99. Using the Number, Date and
Character functions. Joins
and Functions (11.5 Hrs)
100.	 Joins, Group by, Having, Sub 

query. (11.5 Hrs)

Queries (4 Hrs)
•	 Concepts of Transactions
•	 ACID Property of  Transact ion 

Constraints.
Joins and Functions (5 Hrs)
•	 Joining of tables
•	 Sub Queries “	 Functions used 

in query like sum,   average,   max, 
min, count etc.
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Professional 
Sk i l l  -  67 
Hrs;

Professional 
Knowledge - 
17 Hrs

Develop web pages 
using HTML and 
CSS. (Mapped	
NOS: SSC/N0503, 
SSC/N0501)

Web Design Concepts (17 Hrs)
•	 Concepts of Static and Dynamic Web 

pages.
•	 Introduction to HTML and various tags 

in HTML.
•	 Concepts	 of different controls used 

in Web Pages.
•	 Concepts of CSS and applying CSS to 

HTML.
•	 Introduction to open source CMS 

viz, Joomla,   Word press etc. and 
Web authoring tools viz. Kompozer, 
WordPress,	 Front Page etc.

Create simple static web pages using 
HTML tags (67 Hrs.)
113. Practice HTML (46 Hrs)
•	 Practice with basic HTML elements 

(e.g. head, title, body), tag and 
attributes.

•	 Design simple web page with text, 
paragraph and line break using 
HTML tags

•	 Format text, change background 
colour and insert pictures in web 
page

•	 Design simple web page with tables 
and lists.

•	 Use marquees, hyperlinks and mail 
to link in designing web pages

•	 Create frames, add style and design 
layout.

•	 Display a web page within a web 
page using iframes.

•	 Insert text, check and combo box in 
web page.

•	 Design web page using password 
field, submit button

•	 Reset button and radio button etc.
•	 Design a web page adding flash file, 

audio and video files.
•	 Design web page with forms and 

form controls using HTML tags
114. Create simple static web pages 

using CSS (21 Hrs )
•	 CSS syntax, Adding colors, fonts, 

backgrounds, images borders, text 
alignment, text transformation, Lists 
etc.

•	 3 types of CSS
•	 Adding a Navigation Bars(vertical/

horizontal bars)
•	 CSS drop downs & Forms
•	 CSS counters and website layout, 

Multiple backgrounds & Putting the 
stylesheet in a separate file

•	 CSS Animations & CSS Buttons 
Professional 
Skill - 173 
Hrs;

Professional 
Knowledge - 
35 Hrs

Develop web pages 
using JavaScript. 
(Mapped NOS: 
SSC/N0503, SSC/
N0501)

Introduction	 to JavaScript (35 Hrs)
•	 Introduction		  to Programming	

and Scripting Languages.
•	 Introduction to JavaScript and its 

application for the web.
•	 Introduction to Web Servers and their 

features.
•	 JavaScript Basics - Data	 t y p e s , 

Variables, Constants			
and Conversion between		
data types.

•	 Arithmetic, Comparison, Logical 
Operators	 in JavaScript. Operator 
precedence.

JavaScript (173 Hrs)
Embed JavaScript in HTML Pages  
(127 Hrs)
115.	 Practicing the JavaScript in 

creating dynamic HTML pages. (53 
Hrs)

116.	 Embed JavaScript in HTML to 
Display Information in Web pages. 
(31 Hrs)

117.	 Use error handling techniques in 
JavaScript. (11 Hrs)

118.	 Use objects and classes in 
JavaScript. (31 Hrs)

119.	 D e s c r i b e  A n i m a t i o n  a n d 
Multimedia using JavaScript. (1 Hr)
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Create a dynamic website using an 
open-source tool (40 Hrs)

120.	 Develop dynamic HTML pages 
using JavaScript.

Deploy a simple web project (6 Hrs)
121.	 Deploy web project using IIS.

•	 Program Control Statements and loops 
in JavaScript.

•	 Arrays in JavaScript - concepts, types 
and usage.

•	 T h e  S t r i n g  d a t a  t y p e  i n 	
JavaScript. Introduction to String, 
Math and Date.

•	 Introduction to Functions	 i n 
JavaScript.

•	 Built in JavaScript functions overview.
•	 Concepts of  Pop Up boxes in 

JavaScript.
•	 Introduction to the Document Object 

Model.
•	 Concepts of using Animation	a n d 

multimedia files in Java Script.

Professional 
Skill - 73 Hrs

Professional 
Knowledge - 
17 Hrs

Create workbooks 
w i t h  a d v a n c e d 
formulas, macros, 
charts, pivot tables 
and demonstrate 
ability to use Power 
tools. (NOS: SSC/
N9402)

Advanced Excel Concepts - Theory-  
(17 Hrs)
•	 MS excel revision (row, columns, basic 

formatting, insert menu, Print setup, 
etc. ) and Look up introduction and 
functions

•	 Types of references and cell naming
•	 Excel Linkage Custom Format and 

Excel Protection
•	 Tips and tricks
•	 Pivot table and Pivot chart
•	 Conditional formatting
•	 Advanced Graphs
•	 Power Queries

Data Visualization or analysis using 
Excel - (73  Hrs)
Create advanced formulas and 
macros (24 Hrs)
122.	 Create and modify simple macros 

(6 Hrs)
123.	 Perform form controls and create 

simple data entry form with macros. 
(6 Hrs)

124.	 Look up data by using functions. 
(6 Hrs)

125.	 Use	 advanced	 d a t e 
functions.(6 Hrs)

Manage advanced charts and tables  
(21 hrs)
126.	 Create and modify advanced 

charts. (10 Hrs)
127.	 Create	 and	 m o d i f y 

PivotTables. (11 Hrs)
Use Power Query and Power BI  
(24 Hrs)
128.	 Create a Power Query, Power 

Query Function. Invoking the Power 
Query function and combining 
queries. Organize the workbook 
queries (12 Hrs)

129.	 Use Power BI for simple data 
visualizations. (12 Hrs)

Make a dashboard in Excel (4 Hrs)

Professional 
Skill - 25hrs;

Professional 
Knowledge - 
10 Hrs.

Browse, select , 
and transact using 
E -  c o m m e r c e 
w e b s i t e s ( N O S : 
SSC/N9403)

e-Commerce (10 Hrs)
•	 Introduction to E Commerce and 

advantages.
•	 Building business on the net.
•	 Payment and Order Processing, 

Authorization, Chargeback	 a n d 
other	 payment methods.

•	 Security issues and payment gateways.

Browse e-Commerce sites to identify 
products & services (6.5 Hrs)
130.	 Demonstrate	 e-Commerce 

sites. (1.5 Hrs)
131.	 List features of e-commerce 

sites. (2 Hrs)
132.	 Use	 e-commerce	 sites	

to source an item. (3 Hrs)
Shop online (4.5 Hrs)
133.	 Undertake transactions on an 

e-commerce site. (4.5 Hrs)
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138. Protect	 i n f o r m a t i o n , 
computers and networks from 
viruses, spyware and other 
malicious code (19 Hrs)

•	 Explain Cyber security (2 Hrs)
•	 Secure	 computers	 &	

the network (5.5 Hrs)
•	 Reduce cyber security threats (2 Hrs)
•	 Secure a Wi-Fi Network (4 Hrs)
•	 Use Anti-Virus software (3 Hrs)
•	 Perform back-ups of files, data & 

information (2.5 Hrs)
139. Explain compliance with IT Act 

(1 Hr)
•	 Identify steps for information privacy. 

(0.5 Hrs)
•	 Identi fy common cybercrimes 

and penalties applicable. (0.5 
Hrs)	

Cyber Security (10 Hrs)
•	 Overview		  of Information 

Security,	 S S L ,  H T T P S , 	
Security threats, information Security 
vulnerability	 and Risk management.

•	 Introduction to Directory Services, 
Access Control, Security, Privacy 
protection, Audit and Security.

•	 Introduction to IT Act and penalties for 
cybercrimes.

Professional 
Skill - 20 Hrs

Professional 
Knowledge - 
10 Hrs.

Secure information 
from Internet by 
using cyber security 
concept .  (NOS: 
SSC/N9404)

Professional 
Skill -25 Hrs;

Professional 
Knowledge 
15 Hrs.

E x p l a i n  C l o u d 
concepts &services 
a n d  D e s c r i b e 
A p p l i c a t i o n 
Development Life 
Cycle. (NOS: SSC/
N9405)

Introduction to Cloud Computing (12 
Hrs)
•	 Benefits of cloud services, different 

categories.
•	 Resources available in cloud.
Explain the Application Development 
Life Cycle (3 Hrs)
•	 Identify Phases of the Application 

Development Life Cycle.
•	 Describe Roles in each of phases of the 

Application Development Life Cycle.

Cloud Computing (15 Hrs) Working 
with Cloud Services (12 Hrs)
140.	 Practice with IaaS using free 

cloud services. (4 Hrs)
141.	 Practice with PaaS using free 

cloud services. (4 Hrs)
142.	 Practice with SaaS using free 

cloud services. (4 Hrs)
Web hosting in Cloud (3 Hrs)
143.	 Host a website in a free cloud.  

(3 Hrs)
Develop an application and perform 
the Application Development Life 
Cycle (10 Hrs)
144.	 Identify Phases of the Application 

Development Life Cycle. (5 Hrs)
145.	 Describe Roles in each of the 

phases       of        Application 
Development Life   Cycle.   (5 Hrs)

Manage e-commerce operations  
(14 Hrs)
134.	 Add	 products	 to	

an ecommerce website. (4 Hrs)
135.	 Practice order processing. (3 Hrs)
136.	 Practice payment processing.  

(4.5 Hrs)
137. Identify	 c o m m o n  s e c u r i t y 

issues. (3.5 Hrs )
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To be selected either “Programming in Python” or “Programming in Java” as Elective Module for COPA.

COPA - Elective Module - I Programming in Python

Programming language (Python) Use 
Python from command line (7 Hrs)
1.	 Install, set up the environment & run 

Python. (3 Hrs)
2.	 Use Command Line and IDE to create 

and execute a python program. (4 
Hrs)

Perform Operations using Data Types 
and Operators (15 Hrs)
3.	 Write and test a python program 

to demonstrate print statement,	
comments, different types of variables. 
(5 Hrs)

4.	 Write and test a python program 
to perform data and data type 
operations, string operations, date, 
input and output, output formatting 
and operators. (5 Hrs)

5.	 Determine the sequence of execution 
based on operator precedence. (5 
Hrs)

Control Flow with Decisions and 
Loops (20hrs)
6.	 Construct and analyze code segments 

that use branching statements. (10 
Hrs)

7.	 Construct and analyze code segments 
that perform iteration. (10 Hrs)

Document and Structure Code  
(18 Hrs)
8.	 Document code segments using 

comments and documentat ion 
strings. (3 Hrs)

9.	 Const ruc t  and ana lyze  code 
segmen t s  t ha t  i n c l ude  L i s t 
comprehensions, tuple, set and 
Dictionary comprehensions. (16 Hrs)

Perform Operations Using Modules 
and Tools (10 Hrs)
10.	Perform basic operations using built-

in modules. (5 Hrs)
11.	Solve complex computing problems 

by using built-in modules. (5 Hrs)

Professional 
Sk i l l  -  70 
Hrs;

Professional 
Knowledge - 
30 Hrs.

Write programs 
u s i n g  P y t h o n 
language. ( NOS: 
SSC/N9406)

Programming language (Python) (30 Hrs)
•	 Introduction to Python History
•	 Features, Setting up path Basic Syntax, 

Comments, Variable
•	 Different Data Types
•	 Casting, string, Boolean
•	 Python Operators
•	 Conditional Statements
•	 Looping
•	 Control Statements, String Manipulation, 

Lists, Tuple, sets
•	 Dictionaries
•	 Arrays
•	 Iterators, modules, dates, math,
•	 Modules, Input and Output.

COPA - Elective Module - II Programming in JAVA

Object Oriented Programming and 
JAVA Language (15 Hrs)
1.	 Installing JAVA.
2.	 Setting the Class path.
3.	 Writing and Executing a simple JAVA 

Program to display “Hello”.
Demonstrate writing JAVA programs:
4.	 Use of various data types in JAVA.
5.	 Use of various operators in JAVA.
6.	 Create and use of Local, Instance and 

Class variables.

Professional 
Sk i l l  -  70 
Hrs;

Professional 
Knowledge - 
30 Hrs.

Writing programs 
using JAVA. (SSC/
N9407)

Explain the following:
•	 Object	 Oriented Programming 

with Core Java
•	 Java Programming features
•	 JVM, Byte codes and Class path
•	 Java Program Development
•	 Compilation and Execution of JAVA 

programs
•	 Basic JAVA language elements - 

keywords, comments, data types and 
variables.
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(xxvi)

7.	 Read text from the keyboard using 
scanner class read text from the 
keyboard using console class.

•	 JAVA	 Arithmetic, Assignment, 
Relat ional,  Logical,  Increment / 
Decrement operators and expressions.

•	 JAVA String Operators
•	 JAVA Input and Output streams, System 

in, System out.
•	 Input using Scanner class and Console 

class methods. (10Hrs.)

JAVA Program Flow Control (20 Hrs)
Demonstrate writing JAVA programs:
8.	 Use of the if and if … else statements.
9.	 Use of the Switch statement.
10.	Use of the Do … While and while - do 

loops.
11.	Use of the For Loop.
12.	Use of the Break and Continue 

Keywords.
13.	Use of the JAVA Numbers Class 

methods.
14.	Use of the JAVA Character Class 

methods.
15.	Use of the JAVA String Class methods.
16.	Create and use of arrays.

Explain the following:
•	 Decision making and flow control 

using if…then, if then else, nested if, 
switch case and the conditional ternary 
operators in JAVA.

•	 Loop control flow using while - do, do 
- while loops, for loop, using the break, 
continue statements.

•	 Terminating	 the JAVA program.
	 JAVA Number, Character and String 

Classes. Arrays in JAVA. (6Hrs.)

J AVA C l a s s e s ,  O v e r l o a d i n g 
a n d  I n h e r i t a n c e  ( 2 0  H r s )  
Demonstrate writing JAVA programs:
17.	Create and use of simple classes, 

objects and methods in JAVA.
18.	Pass data and Objects to Methods.
19.	Return data and Objects from 

Methods.
20.	use of constructors in JAVA.
21.	Create and use of Overloaded 

methods in JAVA.
22.	Override methods in JAVA.
23.	Create and use of Super class, Sub 

class in JAVA.

Explain the following:
•	 JAVA Objects, Classes and Methods.
•	 Pass ing data  and ob jec ts  as 

parameters to methods.
•	 Method Overloading.
•	 Constructors	a n d  O v e r l o a d e d 

constructors.
•	 Inheritance in JAVA.
•	 Method Overriding in JAVA. (8Hrs.)

Abstract Classes and Interfaces in 
JAVA (15 Hrs) Demonstrate writing 
JAVA programs:
24.	Create and use virtual methods.
25.	Create abstract classes and methods.
26.	Create interfaces in JAVA.
27.	Override methods in JAVA.
28.	Create and implement an interface.
29.	Extend interfaces in JAVA. 
30.	Create and use a package in JAVA.
Troubleshooting Java issues Download 
and Install Java, Check and Verify Java 
Configurations, Test Java, Remove Old 
Versions of Java, Find Java version, 
Always redirected to the java.com
download page

Explain the following:
•	 Concept of Virtual methods.
•	 Concept of Abstract classes and 

methods
•	 Features of Abstract Classes
•	 JAVA Interfaces and their advantages
•	 Method Overriding in JAVA
•	 Polymorphism in JAVA
•	 Creating, implementing and extending 

interfaces
•	 Creating and using Packages in JAVA. 

(6Hrs.)

Industrial Visit/Project work / Broad Area:
a)	 Create and host a web site of at least 6 web pages using JavaScript & CSS containing interactive objects, 

functions etc.
b)	 Create a project with Excel on Payroll Systems.
c)	 Create a database with MySQL on Library management system.
d)	 Create project in Python/Java programming language.
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IT & ITES	 	 એકસરસાાઈઝ 1.1.01
કોપા (COPA) - સલામત કામ કરવાની પદ્ધતિઓ	

કમ્્પ્યયુટર સિસ્ટમ સેટઅપ સાથે વિદ્યુત જોડાણો શોધો (Locate the electrical connections with 
computer system setup)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 પાવર સ્થાન અને જોડાણો ઓળખો.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : યોગ્્ય પાવર સ્થાન ઓળખો 

1	ય ોગ્્ય પાવર સ્થાનને ઓળખો અને કમ્્પ્યયુટર સિસ્ટમમાાં વિદ્યુત 
જોડાણોનો લેઆઉટ દોરો.

નોોંધ: કનકે્શન પ્રકાર અને કનકે્ટર લખો. જમે કે: પાવર પિન 
પ્્લગ.

1

1
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IT & ITES	 	 એકસરસાાઈઝ 1.1.02
કોપા (COPA) - સલામત કામ કરવાની પદ્ધતિઓ	

સલામતી ચિહ્નો અને જોખમની ઓળખ (Identifying Safety symbols and Hazard identification)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સુરક્ષા ચિહ્નોની ચાર મૂળભતૂ શ્રેણીઓને ઓળખો.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સલામતી ચિહ્નની ચાર મૂળભતૂ શ્રેણીઓને ઓળખો

	 ચિહ્ન	 પ્રકાર	 અર્્થ	 ચિહ્ન	 પ્રકાર	 અર્્થ
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IT & ITES	 	 એકસરસાાઈઝ 1.1.03
કોપા (COPA) - સલામત કામ કરવાની પદ્ધતિઓ	

વિદ્યુત આગના કિસ્્સસામાાં આગથી લડવાની સલામત પદ્ધતિઓનો અભ્્યયાસ કરો (Practice safe 
methods of fire fighting in case of electrical fire)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	વિ�દ્યુુ ત આગ દરમિ�યાાન આગથીી લડવાાનીી ક્ષમતાા દર્શાાવોો
•	 ફાયર-ફાઇટીીંગ ટીમના સભ્્ય તરીકે
•	 જૂથના નતેા તરીકે.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો (Equipment/Machines)

•	 અગ્નિશામક સાધનો - CO2 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

વિદ્યુત આગ દરમિયાન અપનાવવાની સામાન્ય પ્રક્રિયા

1 	 એલાર્્મ વગાડો. આગ ફાટી નીકળે ત્યારે એલાર્્મ સિગ્નલ વધારવા માટે 
નીચે આપેલી પદ્ધતિઓ અનુસરો.

- 	તમ ારો અવાજ ઉઠાવો અને આગને પોકાર! આગ! ધ્્યયાન દોરવા 
માટે.

- 	 સક્રિય કરવા માટે ફાયર એલાર્્મ/બેલ તરફ દોડો

- 	મ ેઇન્્સ બંધ કરો (જો શક્ય હોય તો)

2 	 જ્યારે તમે એલાર્્મ સિગ્નલ સાાંભળો છો:

- 	 કામ બંધ કરો

- 	તમ ામ મશીનરી અને પાવર બંધ કરો

- 	 પખંા/એર સર્ક્યુલેટર/એક્્ઝઝોસ્ટ ફેન બંધ કરો. (સબ મુખ્યને બંધ 
કરવંુ સારુું  છે)

3 	 જો તમે અગ્નિશામક કાર્્યમાાં સામેલ ન હોવ તો:

- 	 ઈમરજન્્સસી એક્્ઝઝિટનો ઉપયોગ કરીને સ્થળ છોડી દો.

- 	 જગ્્યયા ખાલી કરો

- 	અ ન્ય લોકો સાથે સલામત સ્થળે ભેગા થવંુ

- 	ત પાસો, જો કોઈએ ફાયર સર્વિસને ફોન કર્યો છે

- 	 દરવાજા અને બારીઓ બંધ કરો, પરંતુ લોક કે બોલ્ટ ન કરો

ફાયર-ફાઇટીીંગ ટીમના સભ્્ય તરીકે

4 	 જો તમે અગ્નિશામક કાર્્યમાાં સામેલ છો:

- 	 સંગઠિત રીતે આગ ઓલવવા માટે સૂચનાઓ લો.

જો સૂચનાઓઆપતા હોય તો:

- 	 સૂચનાઓનું પાલન કરો. સુરક્ષિત રહો અને ફસાઈ ન જાઓ.

- 	તમ ારા પોતાના વિચારોનો ઉપયોગ કરશો નહીીં.

જૂથના નતેા તરીકે

જો તમે સૂચનાઓ આપી રહ્યા છો:

-	 CO2 અગ્નિશામક શોધો અને તેનો ઉપયોગ કરો

- 	 પૂરતી મદદ માટે શોધો અને ફાયર બ્રિગેડને જાણ કરો

- 	 આગ બુઝાવવા માટે સ્થાનિક રીતે ઉપલબ્ધ યોગ્્ય માધ્્યમો શોધો

- 	 આગની તીવ્રતાનું મૂલ્યયાંકન કરો, ખાતરી કરો કે કટોકટીમાાંથી 
બહાર નીકળવાના માર્ગો કોઈ અવરોધ વિના સ્્પષ્્ટ છે અને પછી 
સ્થળને ખાલી કરવાનો પ્રયાસ કરો. (વિસ્ફોટક સામગ્રી, પદાર્થો કે 
જ ેસરળતાથી આગ  પકડી શકે તે દૂર કરો.

- 	 દરેક પ્રવૃત્તિ માટે સોોંપાયેલ જવાબદારી ધરાવતા લોકોને 
ઓળખવામાાં સહાય સાથે આગને કાબુમાાં રાખો.

5 આગને કાબૂમાાં લેવા માટે લીધેલા પગલાાંની જાણ સંબંધિત 
સત્તાવાળાઓને કરો.

આગના અકસ્માતોના વિગતવાર અહેવાલો, ભલે તે નાના 
અકસ્માતો હોય, આગના કારણોને ઓળખવામાાં મદદ કરશે. 
ઓળખાયેલ કારણો ભવિષ્્યમાાં સમાન ઘટનાઓને ટાળવા 
માટે નિવારક પગલાાં લેવામાાં મદદ કરશે.

© NIMI 

NOT TO BE REPUBLISHED



4

IT & ITES	 	 એકસરસાાઈઝ 1.1.04
કોપા (COPA) - સલામત કામ કરવાની પદ્ધતિઓ	

અગ્નિશામક સાધનોનો ઉપયોગ (Use of fire extinguishers)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 આગના પ્રકાર અનુસાર અગ્નિશામક સાધનો પસંદ કરો
•	 અગ્નિશામક ઉપકરણ ચલાવો
•	 આગ ઓલવવી.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો (Equipment/Machines)

•	અ ગ્નિશામક - CO2	 - 1 No.
•	 કાતર 100mm	 - 1 No.
•	 સેલ ફોન                   	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

1 	 જ્યારે તમે આગ જુઓ ત્યારે આગ, આગ, આગની બૂમો પાડીને 
આસપાસના વિસ્્તતારના લોકોને ચતેવણી આપો.

2 	 ફાયર સર્વિસને જાણ કરો અથવા તરત જ તેમને જાણ કરવાની વ્્યવસ્થા 
કરો.

3 	 ઈમરજન્્સસી એક્્ઝઝિટ ખોલો અને વિસ્્તતારની અંદરના લોકોને દૂર જવા 
માટે કહો.

4 	તમ ામ વીજ પુરવઠો “બંધ” કરો. લોકોને આગની નજીક જવા દો નહીીં.

5 	 આગના પ્રકારને ઓળખવા માટે વિશ્્લલેષણ કરો. કોષ્્ટક 1 નો સંદર્્ભ 
લો.

6 	 ધારો કે તે D આગ (ઇલેક્ટ્રિકલ આગ) પ્રકાર છે.

7 	 CO2 (કાર્્બન ડાયોક્સાઇડ) અગ્નિશામક પસંદ કરો.

8 	 CO2 અગ્નિશામક શોધો અને લો. તેની સમાપ્્તતિ તારીખ તપાસો.

9 	સી ીલ તોોડોો (ફિ�ગ 1).

10	 10 હેન્્ડલમાાંથી સેફ્ટી પિન ખેેંચો. (ફિગ 2) (પીન અગ્નિશામકની ટોચ 
પર સ્થિત છે.)

11 અગ્નિ�શાામક નોોઝલ અથવાા નળીીનેે આગનાા પાાયાા પર રાાખોો.  
(આ બળતણનીી આગનાા સ્ત્રોોતનેે દૂૂર કરશેે.) (ફિ�ગ 3) 

તમારી જાતને નીચી રાખો.

12	 એજન્ટનેે ડિ�સ્ચાાર્જજ  કરવાા માાટેે હેેન્ડલ લિ�વરનેે ધીીમેેથીી સ્ક્વિ�િઝ કરોો 
(ફિ�ગ 3). 

13	 આગ ઓલવવાામાંં ન આવેે ત્યાંં સુુધીી બળતણનીી આગ પર આશરે 15 
સેે.મીી.નીી બાાજુુથીી બાાજુુ  તરફ સ્વીીપ કરોો (ફિ�ગ 4). 

75 ફૂટ (22.9 મીટર) અથવા તેનાથી ઓછા અતંરનો ઉપયોગ 
કરવા માટે અગ્નિશામક સાધનોનું ઉત્્પપાદન કરવામાાં આવે છે.
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• 	 જ્યારે આગ ઝેરી ધુમાડો બહાર કાઢે ત્યારે તેને બુઝાવવાનો પ્રયાસ 
કરશો નહીીં. તેને વ્્યયાવસાયિકો પર છોડી દો.

• 	ય ાદ રાખો કે તમારુું  જીવન મિલકત કરતાાં વધુ મહત્્વનું છે. તેથી જોખમ 
ન લો.

અગ્નિશામકની સરળ કામગીરીને યાદ રાખવા માટે, P.A.S.S.

આ અગ્નિશામકનો ઉપયોગ કરવામાાં મદદ કરશે.

પુલ	 (pull) માટે 	 P

હેતુ	 (aim) માટે 	 A

સ્ક્વિઝ	(squeeze) માટે 	 S

સ્્વવીપ	 (sweep) માટે 	 S

સાવધાની

• 	 આગ ઓલવતી વખતે, આગ ભભૂકી શકે છે.

• 	 ગભરાશો નહીીં જ્યયાં સુધી તેને તાત્કાલિક મુલતવી રાખવામાાં આવે

• 	 જો તમે અગ્નિશામકનો ઉપયોગ કર્યા પછી પણ આગ સારી રીતે 
પ્રતિસાદ આપતી નથી, તો ફાયર પોઈન્ટથી દૂર જાઓ.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.1.04
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IT & ITES	 	 એકસરસાાઈઝ 1.2.05
કોપા (COPA) - ડેસ્કટોપ પીસી એસેમ્્બલ કરો	

કમ્્પ્યયુટર પેરિફેરલ્સ અને ડેસ્કટોપ કમ્્પ્યયુટરના આતંરિક ઘટકોને ઓળખો (Identify computer 
peripherals and internal components of a desktop computer)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 કમ્્પ્યયુટર સાથે જોડાયેલા વિવિધ ઇનપટુ/આઉટપટુ ઉપકરણને ઓળખો
•	 ડેસ્કટોપ કોમ્્પ્યયુટરની આગળ અને પાછળની પેનલને ઓળખો
•	 ડેસ્કટોપ કોમ્્પ્યયુટરના આતંરિક ભાગોને ઓળખો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ઈન્ટરનેટ કનેક્શન સાથે કાર્્યરત પીસી 	 - 1 No./બેચ.

ત્રણ સરખા PC પકૈી, એક PC નો ઉપયોગ પ્રશિક્ષક દ્વારા નિદર્્શન માટે કરવામાાં આવશે જ્યયાં અન્ય બેનો ઉપયોગ તાલીમાર્થીઓના બે જૂથો 
દ્વારા કરવામાાં આવશે.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : કમ્્પ્યયુટર સાથે જોડાયેલા વિવિધ ઇનપુટ/આઉટપટુ ઉપકરણોને ઓળખવા 

ઇનપુુટ/આઉટપુુટ ઉપકરણોો (તમાારીી લેેબમાંં ઉપલબ્ધ) સાાથેે જોડાાયેેલાા બતાાવશે કોોમ્પ્યુુટર અનેે તાાલીીમાાર્થીીઓ કોોષ્ટક 1 માંં તેેનોો રેેકોોર્ડડ  
બનાાવશેે (ફિ�ગ 1).

કોષ્્ટક 1

અનુુક્રમ નંંબર. ઉપકરણોોનાા નાામ પ્રકાાર

1

2

3

4

5

અનુકુ્રમ નંંબર. ઉપકરણોોનાા નાામ પ્રકાાર

6

7

8

9

10
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કાર્્ય 2 :  ડેસ્કટોપ કમ્્પ્યયુટરની આગળ અને પાછળની પેનલને ઓળખો

પ્રશિ�ક્ષક નીીચેેનાા સૂૂચકાંંકોોનાા ઉપયોોગનુંં� નિ�દર્શશન કરશેે, ફિ�ગ 
2 માંં નિ�યંતં્રણોો સ્વિ�િચ કરશેે અનેે સિ�સ્ટમ યુુનિ�ટમાંં દર્શાાવેેલ 
પ્રોોસેેસર માાટેે બહાારનાા પોોર્ટોો દર્શાાવશેે અનેે તાાલીીમાાર્થીીઓ 
કોોષ્ટક 2 અનેે કોોષ્ટક 3 માંં તેેનોો રેેકોોર્ડડ  બનાાવશેે (ફિ�ગ 3). 

કોષ્્ટક 2

અનુકુ્રમ નંંબર. CPU ફ્રન્ટ પેેનલ પરનાા ભાાગોોનેે નાામ આપોો

1

2

3

4

5

6

7

કોષ્્ટક 3

અનુકુ્રમ નંંબર. CPU બેેક પેેનલ પરનાા ભાાગોોનેે નાામ આપોો

1

2

3

4

5

6

7

Fig 3

Fig 2

કાર્્ય 3 : ડેસ્કટોપ કોમ્્પ્યયુટરના આતંરિક ભાગોને ઓળખો

પ્રશિક્ષક સિસ્ટમ યુનિટ (તમારી લેબમાાં ઉપલબ્ધ) ખોલશે અને 
ફિગ 4 અને ફિગ 5 માાં બતાવ્્યયા પ્રમાણે સિસ્ટમ યુનિટ અને 
મધરબોર્્ડ  ઘટકોના ભાગો બતાવશે અને તાલીમાર્થીઓ કોષ્્ટક 
4 અને 5 માાં ભાગોનો રેકોર્્ડ  બનાવશે.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.2.05
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Fig 4

Fig 5

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.2.05

કોષ્્ટક 4

અનુક્રમ નંબર. ડેસ્કટોપ CPU ના આતંરિક ભાગોને નામ આપો

1

2

3

4

5

6

7

8

કોષ્્ટક 5

અનુક્રમ નંબર. મધર બોર્્ડ ના ભાગોને નામ આપો

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16
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IT & ITES	 	 એકસરસાાઈઝ 1.2.06
કોપા (COPA) - ડેસ્કટોપ પીસી એસેમ્્બલ કરો	

ડેસ્કટોપ કમ્્પ્યયુટરના ઘટકોને એસેમ્્બલ કરો (Assemble components of desktop computer)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ડેસ્કટોપ કોમ્્પ્યયુટરના એસેમ્્બલ ઘટકોને ઓળખો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ઇન્ટેલ મધરબોર્્ડ  સપોર્ટેડ સાથે (I3/I5/I7/I9 
	 પ્રોસેસર અને DDR4/DDR5 / નવીનતમ મોડલ 	 – 1 No.
•	 I3/I5/I7/I9 સાથે પ્રક્રિયા હીટ ઝિિંક ફેન 	 – 1 No.
•	 થર્્મલ પેસ્ટ  	 – 1 No.
• 	 રેમ (DDR4/DDR5) 	 – 1 No

• 	 હાર્્ડ  ડિસ્ક SATA 3.5” 	 – 1 No.
•	 DVD ઓપ્્ટટિકલ ડ્્ર રાઈવ SATA 	 – 1 No.
•	 કેબિનેટ	 – 1 No.
•	 SMPS ATX	 – 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

1	 મેેઈનબોોર્ડડ  (મધરબોોર્ડડ ) તૈૈયાાર કરોો. જો તમેે એસેેમ્બલ કરવાા માંંગતાા 
હોોવ તોો તમાારેે Intel i3,i5,i7,i9 પ્રોોસેેસર સપોોર્ટેેડ મધરબોોર્ડડનો ો 
ઉપયોોગ કરવોો જોઈએ (ફિ�ગ 1). 

2	 CPU નેે મધરબોોર્ડડ નાા સોોકેેટમાંં માાઉન્ટ કરોો. CPU નેે ખોોટીી દિ�શાામાંં 
ઇન્સ્ટોોલ ન કરવાા માાટેે સાાવચેતે રહોો, તેે શોોર્ટટ -સર્કિ�ટ કરીી શકે છેે અનેે 
તમાારાા મધરબોોર્ડડને ે નુુકસાાન પહોંંચાાડીી શકે છેે (ફિ�ગ 2). 

3	 CPU કુુલરનેે મેેઇનબોોર્ડડ  સાાથેે કનેેક્ટ કરોો જો જરૂરીી હોોય તોો થર્મમલ 
પેેસ્ટનોો ઉપયોોગ કરોો (ફિ�ગ 3). 

4	અ નુુરૂપ સ્લોોટમાંં RAM (મેેમરીી) મોોડ્યુુલોો જોડોો. ખાાતરીી કરોો કેે RAM 
કાાર્્ડ્� સ પરનીી પિ�ન મધરબોોર્ડડ  કનેેક્ટર પરનીી પિ�ન સાાથેે જોડાાયેેલીી છેે 
(ફિ�ગ 4). 

Fig 1

Fig 2

Fig 3

Fig 4
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5	કે બિ�નેટ કેેસ ખોોલોો અનેે પાાવર સપ્લાાય માાઉન્ટ કરોો જે ેATX પ્રકાાર છેે. 
ડ્રાા� ઇવ્સ અનેે મધરબોોર્ડડ  સાાથેેનાા તમાામ કનેેક્શન્સનેે કનેેક્ટ કરવાાનીી 
ખાાતરીી કરોો (ફિ�ગ 5). 

6	કે સ સાાથેે મધરબોોર્ડડ  બેેક પ્લેેટ જોડોો અનેે મધરબોોર્ડડ  માાઉન્ટિં�ગ 
પોોઝિ�શન્સ તપાાસોો (ફિ�ગ 6). 

7	મ ધરબોોર્ડડને ે કેેબિ�નેેટમાંં યોોગ્ય રીીતેે સ્થાાન આપોો (ફિ�ગ 7). 

8	હા ાર્ડડ  ડિ�સ્કનેે માાઉન્ટ કરોો અનેે તેેનેે પાાવર સપ્લાાય અનેે મધરબોોર્ડડ  સાાથેે 
કનેેક્ટ કરોો. પાાવર સપ્લાાય માાટેે અલગ કનેેક્શન્સ હોોવાા જોઈએ, SATA 
હાાર્ડડ  ડિ�સ્કનાા કિસ્સામાં, જમ્પરને દૂર કરવું�����������ં����������� જોઈએ (ફિ�ગ 8). 

9	 SATA કનેેક્ટર્સસનેે ડ્રાા� ઇવ્સ અનેે USB કનેેક્ટર્સસ સાાથેે કનેેક્ટ કરોો 
અનેે કેેબિ�નેેટ ફ્રન્ટ પેેનલ પાાવર મધરબોોર્ડડ  પર સ્વિ�િચ કરોો. કેેસ અનેે 
મધરબોોર્ડડની ી સૂૂચનાાઓ જણાાવવીી જોઈએ કેે કેેબલ્સ ક્યાંં કનેેક્ટ કરવીી 
(ફિ�ગ 9). 

10	મ ધરબોોર્ડડ  સાાથેે 24 પિ�ન ATX કનેેક્ટર અનેે 4-પિ�ન પાાવર સપ્લાાય 
કંંટ્રોો� લ કનેેક્ટરનેે કનેેક્ટ કરોો (ફિ�ગ 10). 

Fig 5

Fig 6

Fig 7

Fig 8

Fig 9

Fig 10

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.2.06
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11	 DVD-ROM ડ્રાા� ઇવનેે માાઉન્ટ કરોો. SATA કેેબલનેે ઉપકરણ સાાથેે 
કનેેક્ટ કર્યાા પછીી, તેેનેે પાાવર સપ્લાાય સાાથેે જોડોો (ફિ�ગ 11).  

Fig 11

Fig 12

12	 છેેલ્લેે, સુુસંંગત ઓપરેેટિં�ગ સિ�સ્ટમ પસંંદ કરોો, અનેે DVD અથવાા USB 
નોો ઉપયોોગ કરીીનેે ઇન્સ્ટોોલ કરોો પછીી  ઇન્સ્ટોોલ કરવાા માાટેે સૂૂચનાાઓનેે 
અનુુસરોો (ફિ�ગ 12).  

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.2.06
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IT & ITES	 	 એકસરસાાઈઝ 1.3.07
કોપા (COPA) - વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમનો ઉપયોગ	

વિન્્ડડોઝ ઈન્ટરફેસ પર પ્રેક્ટિસ કરો અને વિન્્ડડોઝ નેવિગેટ કરો (Practice on Windows interface 
and navigation Windows)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 વિન્્ડડોઝ 10 ડેસ્કટોપમાાં ફાઈલો ફોલ્્ડર્્સ અને ડ્્ર રાઈવોને ઓળખો
•	 Windows 10 સેટિિંગ્્સની ઉપયોગિતાઓને ઓળખો
•	 Cortana નો ઉપયોગ કરીને અદ્યતન શોધ
•	 એપ્્લલિકેશન સેટિિંગ્્સ અને ડેસ્કટોપ પર પિન અપ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS સાથે PC 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : વિન્્ડડોઝ 10 ડેસ્કટોપમાાં ફાઇલ ફોલ્્ડર્્સ અને ડ્્ર રાઇવ્્સને ઓળખો 

1	 ટાાસ્કબાાર અથવાા સ્ટાાર્ટટ  મેેનૂૂમાંંથીી ફાાઇલ એક્સપ્લોોરર  ખોોલોો.
બીીજી રીીત વિ�ન્ડોોઝનીી શોોર્ટટકટ કીીનોો ઉપયોોગ કરીીનેે છેે ફાાઇલ 
એક્સપ્લોોરર ખોોલવાા માાટેે લોોગોો +E (ફિ�ગ 1).

2	 આ PC    પસંદ કરો 

3	તમ ારામાાં પ્રદર્શિત ડ્્ર રાઈવો અને અન્ય ચિહ્નો રેકોર્્ડ  કરો નોટબુક અને તેને 
તમારા પ્રશિક્ષક દ્વારા તપાસો.

4	 કોઈપણ જરૂરી ડ્્ર રાઈવ પસંદ કરો અને પછી ઈચ્છિત પર ક્્લલિક કરો 
ડ્્ર રાઇવમાાં ફાઇલ અથવા ફોલ્્ડર.

5	 પસંદ કરેલ ફાઇલનો સરનામું પાથ રેકોર્્ડ  કરો

સરનામું, સરનામા બાર માાં દર્શાવવામાાં આવશે. અહીીં પસંદ 
કરેલી ફાઇલનું સ્થાન છે  : This PC > Local Disk(D:) > 
Books

6	વિ ન્્ડડો બંધ કરો

Fig 1
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કાર્્ય 2 : Windows10 સેટિિંગની ઉપયોગિતાઓને ઓળખો

1	સ્ટાર્્ટ    સેટિિંગ પર ક્્લલિક કરો અથવા Windows logo + X પર 
ક્્લલિક કરો વિન્્ડડોઝ ટૂલ્સ અને ઉપયોગિતાઓનું મેનૂ પ્રદર્શિત કરો.

2 	સે ટિં�ગ્સ પસંંદ કરોો (ફિ�ગ 2). 

3 	 સશંોધિત અથવા કસ્ટમાઇઝ કરવા માટે તમારુું  તૈયાર કરેલ સાધન 
પસંદ કરો.

4 	ફે રફાારોો લાાગુુ કરવાા માાટેે ઓકેે ક્લિ�િક કરોો અનેે વિ�ન્ડોો બંંધ કરોો (ફિ�ગ 3).  

Fig 3

Fig 2

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.07
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કાર્્ય  3 : એપ્્લલિકેશન સેટિિંગ અને ટાસ્કબાર અને સ્ટાર્્ટ  મેનૂ પર પિન અપ કરો

તમે પ્રોગ્રામને ટાસ્કબારમાાં પિન કરી શકો છો સ્ટાર્્ટ  મેનૂમાાંથી 
અથવા ડેસ્કટોપમાાંથી.

1	સ્ટાર્્ટ   મેનૂનો ઉપયોગ કરીને પિન અપ કરવા માટે, સ્ટાર્્ટ  અને પછી 
ક્્લલિક કરો તમે પિન કરવા માાંગો છો તે એપ્્લલિકેશન શોધો.

2 	 એપ્્લલિકેશન પર જમણું-ક્્લલિક કરો.

3 	 ટાાસ્કબાાર પર પિ�ન કરોો ક્લિ�િક કરોો (ફિ�ગ 4). 

4 	ડ સ્કટોપનો ઉપયોગ કરીને પિન અપ કરવા માટે, ડેસ્કટોપ પર 
એપ્્લલિકેશન શોધો 

5 	 એપ્્લલિકેશન પર જમણું-ક્્લલિક કરો

6 	ટ ાસ્કબાર પર પિન કરો ક્્લલિક કરો

7 	પ્રા રંભ મેનૂમાાં એપ્્લલિકેશનને પિન કરવા માટે, ડેસ્કટોપમાાં એપ્્લલિકેશનને 
શોધો તમે પિન કરવા માાંગો છો

• 	 એપ્્લલિકેશન પર જમણું-ક્્લલિક કરો

• 	શ રૂ કરવાા માાટેે પિ�ન પર ક્લિ�િક કરોો (ફિ�ગ 5).

એપ્્લલિકેશનને અનપિન કરવા માટે, સ્ટાર્્ટ /ડેસ્કટોપ/ટાસ્ક 
બારમાાંથી અનપિન પર ક્્લલિક કરો

સ્ટાર્્ટ  મેનૂમાાં ટી એપની એપ્્લલીકેશન સેટિિંગ જોવા માટે, પહેલા એપ લોકેટ 
કરો એપ પર રાઇટ ક્્લલિક કરો અને એપ સેટિિંગ્્સ પર ક્્લલિક કરો.

જો તમેે કોોઈપણ સેેટિં�ગ (ડિ�ફોોલ્ટ, અનઇન્સ્ટોોલ, ટર્મિ�નેેટ, રીીસેેટ વગેેરેે) 
બદલવાા માંંગતાા હોો, તોો ઇચ્છિ�ત ફેેરફાારોો કરોો (ફિ�ગ 6). 

Fig 4

Fig 5

Fig 6

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.07
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IT & ITES	 	 એકસરસાાઈઝ 1.3.08
કોપા (COPA) - વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમનો ઉપયોગ		

દૂર કરી શકાય તેવી ડ્્ર રાઇવનો ઉપયોગ કરીને ફાઇલો અને ફોલ્્ડર્્સનું સંચાલન કરવાની પ્રેક્ટિસ કરો 
(Practice on managing files and folders using removable drives)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 પેન ડ્્ર રાઇવને યોગ્્ય રીતે દાખલ કરો અને દૂર કરો
•	 એન્ટીવાયરસ સોફ્ટવેરનો ઉપયોગ કરીને પેન ડ્્ર રાઈવમાાં ખરાબ સેક્ટર અને વાયરસ તપાસો
•	 પેન ડ્્ર રાઇવમાાંથી અને તેમાાં ફાઇલો અને ફોલ્્ડર્્સની નકલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS સાથે PC 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પેન ડ્્ર રાઇવને યોગ્્ય રીતે દાખલ કરો અને દૂર કરો 

1	 પેન ડ્્ર રાઇવને USB પોર્્ટમાાં દાખલ કરો.

2	 સ્ક્રીીનનાા નીીચેેનાા જમણાા ખૂૂણેે દેેખાાતીી સૂૂચનાા પર ક્લિ�િક કરોો (ફિ�ગ 1). 

•	 પેન ડ્્ર રાઈવ (કોઈપણ કદ)	 - 1 No.

3	ફ ાઇલો જોવા માટે ઓપન ફોલ્્ડર પર ક્્લલિક કરો (ફિગ 2).

6 	છુ પાાયેેલાા ચિ�હ્નોો બતાાવોો પર ક્લિ�િક કરોો (ફિ�ગ 3).

7 	સ રક્ષિત રીતે હાર્્ડવ ેર દૂર કરો, પર ક્્લલિક કરો અને મીડિયા ચિહ્ન બહાર 
કાઢો 

8 	 Eject બટન પર ક્્લલિક કરો

9 	 જ્યાારેે સલાામત હોોય ત્યાારેે, હાાર્ડડવે ર દૂૂર કરવાા માાટેેનોો સંંદેેશ સ્ક્રીીન પર 
પ્રદર્શિ�ત થાાય છેે ત્યાારેે પેેનડ્રાા� ઈવ દૂૂર કરોો (ફિ�ગ 4).

4 	 પને ડ્્ર રાઇવમાાંથી જોવા માટે ફાઇલ અથવા ફોલ્્ડર પસંદ કરો

5 	ફ ાઇલ અથવા ફોલ્્ડર બંધ કરો

Fig 1

Fig 2

Fig 3

Fig 4
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કાર્્ય 2 : પેન ડ્્ર રાઇવમાાંથી અને તેમાાં ફાઇલો અને ફોલ્્ડર્્સની નકલ કરો

1 	 પેન ડ્્ર રાઇવન USB પોર્્ટમાાં દાખલ કરો

2 	સ્ક્રીનન ા નીચેના જમણા ખૂણે દેખાતી સૂચના પર ક્્લલિક કરો.

3 	ફ ાઇલો જોવા માટે ઓપન ફોલ્્ડર પર ક્્લલિક કરો.

4 	 પેન ડ્્ર રાઇવમાાંથી ઉપલબ્ધ ફાઇલ અથવા ફોલ્્ડર પર રાઇટ ક્્લલિક કરો.

5 	ડ્ ્ર રોપ ડાઉન મેનુમાાંથી નકલ પસંદ કરો. (ફિગ 5) અથવા કૉપિ કરવા માટે 
શૉર્્ટકટ કી Ctrl+C નો ઉપયોગ કરો.

6 	 પેનડ્્ર રાઈવમાાંથી ફાઈલ કે ફોલ્્ડર પેસ્ટ કરવા માટે કોમ્્પ્યયુટર પર ડ્્ર રાઈવ 
કે ફોલ્્ડર ખોલો

 7 	 જમણું ક્્લલિક કરો અને ડ્્ર રોપ ડાઉન  મેનુ માાં પેસ્ટ વિકલ્્પ પસંદ કરો  
(ફિગ 6) અથવા પેસ્ટ કરવા માટે શોર્્ટકટ કી Ctrl+V નો ઉપયોગ કરો

8 	 કોમ્્પ્યયુટરમાાંથી પનેડ્્ર રાઈવમાાં ફાઈલો કે ફોલ્્ડર્્સ કોપી કરવા માટે, ફાઈલ 
કે ફોલ્્ડર પસંદ કરો પછી પેન ડ્્ર રાઈવમાાં કોપી અન પેસ્ટ કરો. (અથવા)

9 	 જમણું ક્્લલિક કરો અન ડ્્ર રોપ ડાઉન મેનુમાાંથી મોકલો પસંદ કરો અને પેન 
ડ્્ર રાઈવની ડ્્ર રાઈવ પસંદ કરો.

ડ્્ર રોપ ડાઉન મેનુમાાંથી કોપી વિકલ્્પનો ઉપયોગ ફાઈલ પર રાઈટ 
ક્્લલિક કરીને પેનડ્્ર રાઈવમાાં ફાઈલ કોપી કરવા માટે પણ થઈ શકે 
છે. પછી પેન ડ્્ર રાઈવ ખોલો અને રાઈટ ક્્લલિક કરો. મેનુમાાંથી પેસ્ટ 
વિકલ્્પ પસંદ કરો.

Fig 5

Fig 6

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.08
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IT & ITES	 	 એકસરસાાઈઝ 1.3.09
કોપા (COPA) - વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમનો ઉપયોગ		

ડેસ્કટોપ કસ્ટમાઇઝ કરો (Customize the desktop)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	ડ સ્કટોપ સેટિિંગ્્સ ખોલો
•	ડ સ્કટોપ સેટિિંગ્્સમાાં ફેરફાર કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS સાથે PC 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ડેસ્કટોપ સેટિિંગ્્સ ખોલો

1	સ્ટાર્્ટ   મેનુ પર ક્્લલિક કરો.

2 	સે ેટિં�ગ્સ ટેેબ પસંંદ કરોો (ફિ�ગ 1). 

કાર્્ય 2 : ડેસ્કટોપ સેટિિંગ્્સમાાં ફેરફાર કરો

1	 સેટિિંગ્્સ વિન્્ડડો ખોલો.

2 	 સેટિિંગ્્સ વિન્્ડડોમાાં સિસ્ટમ પર ક્્લલિક કરો

3 	ડિ� સ્પ્લેે સેેટિં�ગ્સ બદલવાા માાટેે ડિ�સ્પ્લેે પર ક્લિ�િક કરોો (ફિ�ગ 3).

4	ચ ેન્્જ બ્રાઇટનેસના બારને ડાબે કે જમણેથી ખેેંચીને ડિસ્્પ્લલેની બ્રાઇટનેસ 
બદલો.

5 	ચ ન્્જ બ્રાઇટનેસ બારની સૌથી ડાબી અને જમણી બાજુએ બ્રાઇટનેસ 
ટકાવારી રેકોર્્ડ  કરો.

6 	 ઓરિએન્ટેશન બદલો અને ડિસ્્પ્લલે કેવી રીતે બદલાય છે તેની નોોંધ કરો.

નોોંધ: પ્રારંભિક ઓરિએન્ટેશન પર પાછા જવા માટે, રીવર્્ટ  
દબાવો.

7 	 પૃષ્્ઠભૂમિ બદલવા માટે, સેટિિંગ્્સ વિિંડોના વ્્યક્્તતિગતકરણ આઇકોન 
પર ક્્લલિક કરો.

8 	 પર્્સનલાઇઝેશન બારી માાં બેકગ્રાઉન્્ડ ટેબ પર ક્્લલિક કરો 

9 	ત મેે રાાખવાા માંંગોો છોો તેે પૃૃષ્ઠભૂૂમિ�નોો પ્રકાાર પસંંદ કરોો. જો તેે ચિ�ત્ર છેે, તોો 
આપેેલ ચિ�ત્રમાંંથીી પસંંદ કરોો અથવાા તમેે તમાારંું ઇચ્છિ�ત ચિ�ત્ર બ્રાાઉઝ 
કરીી શકોો છોો (ફિ�ગ 4). 

10	 Fill in Choose a fit પસંંદ કરોો (ફિ�ગ5). 

Fig 2

Fig 1

Fig 3

3	 આ સેેટિં�ગ્સ વિ�ન્ડોો ખોોલશેે (ફિ�ગ 2).
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11	 રંગ, લોક સ્ક્રીન, થીમ્્સ, ફોન્્ટ્્સ, સ્ટાર્્ટ  અને ટાસ્ક બારને સશંોધિત 
કરવા માટે 7 પગલાાંઓનું પુનરાવર્્તન કરો. 

Fig 4 Fig 5

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.09
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IT & ITES	 	 એકસરસાાઈઝ 1.3.10
કોપા (COPA) - વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમનો ઉપયોગ		

સેટિિંગ્્સ અને વપરાશકર્તા એકાઉન્્ટ્્સ મેનેજ કરો (Settings and manage user accounts)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 નવા વપરાશકર્તા બનાવો
•	વ પરાશકર્તા અધિકારો આપો અને તેમાાં ફેરફાર કરો
•	વ પરાશકર્તા ખાતું દૂર કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS સાથે PC 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાાર્યય 1 : નવોો વપરાાશકર્તાા બનાાવોો 

સ્થાનિક વપરાશકર્તા ખાતું બનાવો

1	 Select Start  > Settings  > Accounts  અને પછી Family & 
other users. પસંદ કરો (વિન્્ડડોઝ ની કેટલીક આવતૃ્તિઓમાાં તમે 
અન્ય વપરાશકર્તાઓને જોશો).

2	 આ PC પર અન્ય કોઈને ઉમેરો પસંદ કરો.

3	 પસંદ કરો મારી પાસે આ વ્્યક્્તતિની સાઇન-ઇન માહિતી નથી, અને 
આગલા પૃષ્્ઠ પર, માઈક્રોસોફ્ટ એકાઉન્ટ.વગર વપરાશકર્તા ઉમેરો, 
પસંદ કરો.

4	વ પરાશકર્તા નામ, પાસવર્્ડ  અથવા પાસવર્્ડ  સંકેત દાખલ કરો અથવા 
સુરક્ષા પ્રશ્નો પસંદ કરો—અને પછી Nextપસંદ કરો.

કાર્્ય 2 : સ્થાનિક વપરાશકર્તા ખાતાને એડમિનિસ્ટ્રેટર એકાઉન્ટમાાં બદલો

1	 Start  > Settings  > Accounts પસંદ કરો.

2	ટ બ અને અન્ય વપરાશકર્તાઓ હેઠળ, એકાઉન્ટ માલિકનું નામ પસંદ 
કરો (તમારે નામ નીચે “સ્થાનિક એકાઉન્ટ (Local Account)” જોવું 
જોઈએ), પછી એકાઉન્ટ પ્રકાર બદલો, પસંદ કરો. 

નોોંધ: જો તમે એવું એકાઉન્ટ પસંદ કરો કે જ ે ઈમેલ સરનામું 
બતાવતું હોય અથવા “સ્થાનિક એકાઉન્ટ” ન કહેતું હોય, 
તો પછી તમે સ્થાનિક એકાઉન્ટને નહીીં, પણ Microsoft 
એકાઉન્ટને એડમિનિસ્ટ્રેટર પરવાનગીઓ આપી રહ્યયાં છો.

3	 એકાઉન્ટ પ્રકાર હેઠળ, એડમિનિસ્ટ્રેટર પસંદ કરો, અને પછી OK પસંદ 
કરો.

4	નવ ા એડમિનિસ્ટ્રેટર એકાઉન્ટ સાથે સાઇન ઇન કરો. (ફિગ્્સ 2 અને 3)

Fig 1

Fig 2
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Fig 3

કાર્્ય 3 : user account દૂર કરો

1	 સેટિિંગ્્સ વિન્્ડડો ખોલો

2 	 સેટિિંગ્્સ વિન્્ડડોમાાં એકાઉન્્ટ્્સ પર ક્્લલિક કરો.

3 	 Family & other people પસંદ કરો.

4 	 user account પર ક્્લલિક કરો જનેા વપરાશકર્તા અધિકારો મંજૂર 
અથવા સશંોધિત કરવાના છે.

5 	 જો તમે account of user કાઢી નાખવા માાંગતા હો, તો user 
account ક્્લલિક કરો  અને Remove પસંદ કરો.

6 	સિ�સ્ટમમાં ંથીી પસંંદ કરેેલ user account દૂૂર કરવાા delete account 
અનેે  data tab પર ક્લિ�િક કરોો (ફિ�ગ 4).

Fig 4

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.10

© NIMI 

NOT TO BE REPUBLISHED



21

IT & ITES	 	 એકસરસાાઈઝ 1.3.11
કોપા (COPA) - વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમનો ઉપયોગ		

સિસ્ટમ ગુણધર્મો અને નિયતં્રણ પેનલ વિગતો જુઓ (View System properties and control panel 
details)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ઉપકરણ મેનેજરમાાં ડેસ્કટોપ ઘટકોને ઓળખો
•	 કંટ્્ર રોલ પેનલમાાં ઘડિયાળ, તારીખ, પ્રાદેશિક ભાષા બદલો
•	 કંટ્્ર રોલ પેનલમાાં એપ્્લલિકેશનોને સમારકામ, સશંોધિત અને અનઇન્સ્ટોલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS સાથે PC 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ઉપકરણ સંચાલકમાાં ડેસ્કટોપ ઘટકોને ઓળખો 

1	ટ ાસ્કબારમાાં ફાઇલ મેનેજર પર ક્્લલિક કરો.

2 	 આ PC   પસંદ કરો અને જમણું ક્્લલિક કરો.

3 	ગ ુણધર્મો પર જમણું ક્્લલિક કરો.

4 	ફિ ગ 1 માાં ઉપકરણ સંચાલક પર ક્્લલિક કરો

5	મ ેનુમાાં Universal Serial Bus controllers પર ડબલ ક્્લલિક કરો.

6 	 USB ROOT Hub પર Right ક્લિ�િક કરોો અનેે Device નેે Disable 
પસંંદ કરોો (ફિ�ગ 2).

Fig 1

Fig 2

Fig 3

Fig 4

8	 USB સ્્લલોટમાાં પને ડ્્ર રાઇવ/ USB દાખલ કરો

9 	 કોઈપણ દૂર કરી શકાય તેવું ઉપકરણ/ USB બતાવવામાાં આવ્્યયુું છે કે 
કેમ તે જોવા માટે આ PC folder ને તપાસો.

10	 Device Manager પર જાઓ અને Univer- sal Serial Bus 
controllers.પર ડબલ ક્્લલિક કરો.

11 	 USB Root Hub પર Right click  કરોો અનેે Enable device પસંંદ 
કરોો (ફિ�ગ 4).

12	 USB સ્્લલોટમાાં પેન ડ્્ર રાઇવ/ USB દાખલ કરો

13 	 કોઈપણ removable device/USB બતાવવામાાં આવ્્યયુું છે કે કેમ તે 
જોવા માટે આ PC folder ને તપાસો. (ફિગ 5)

Fig 5

7	 USB Root Hub માાં Yes પર ક્્લલિક કરો. (ફિગ 3)
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1	 Search box માાં Control Panel લખો

2 	 Menu માંંથીી Control Panel એપ્લિ��કેશન પસંંદ કરોો. 

3	નિ�યં ંત્રણ પેેનલમાંંથીી તાારીીખ અનેે સમય પસંંદ કરોો (ફિ�ગ 7). 

કાર્્ય 2 : કંટ્્ર રોલ પેનલમાાં ઘડિયાળ, તારીખ, પ્રાદેશિક ભાષા બદલો

Fig 6

Fig 7

4	તા ારીીખ અનેે સમય બદલોો પર ક્લિ�િક કરોો (ફિ�ગ 8). 

Fig 8

5	 date and time બદલો. ઓકે દબાવો.

6 	વિ ન્્ડડો બંધ કરો

7 	 ભાષા બદલવા માટે, Control panel. માાંથી Region પસંદ કરો.

8 	ફિ ગ 9 માાં બતાવ્્યયા પ્રમાણે ભાષા પસંદગીઓ પર ક્્લલિક કરો

9 	 + Add a Language  પર ક્લિ�િક કરોો (ફિ�ગ 10).

10 	સિ�સ્ટમને કાામ કરવાા/બદલવાા માાટેે તમાારેે જે ેભાાષાાનીી જરૂર છેે તેનેુંં� નાામ 
લખોો (ફિ�ગ 11). 

11 	 Install પર ક્્લલિક કરો.

12 	વિ ન્્ડડો બંધ કરો

Fig 9

Fig 10

Fig 11

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.11
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કાર્્ય 3 : કંટ્્ર રોલ પેનલમાાં એપ્્લલિકેશનોને Repair, modify અને અનઇન્સ્ટોલ કરો

1	 કંટ્્ર રોલ પનેલમાાંથી પ્રોગ્રામ્્સ અને ફીચર્્સ પસંદ કરો.

2 	ડ્ ્ર રોપ ડાઉન મેનુમાાંથી પ્રોગ્રામ પસંદ કરો.

3 	અન ઇન્સ્ટોોલ / / Change / Repair પર ક્લિ�િક કરોો (ફિ�ગ 12). 

4 	 એપ્્લલિકેશનને અનઇન્સ્ટોલ કરવા / / Change / Repair કરવા માટે 
Yesપર ક્્લલિક કરો.

5	 વિ�ન્ડોો બંંધ કરોો.

Fig 12

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.11
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IT & ITES	 	 એકસરસાાઈઝ 1.3.12
કોપા (COPA) - વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમનો ઉપયોગ		

કીબોર્્ડ  શોર્્ટકટ આદેશો સાથે કામ કરો (Work with keyboard shortcut commands)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 કોષ્્ટકમાાં વિન્્ડડોઝ શોર્્ટકટ કી વાાંચો અને તેનું અવલોકન કરો
•	 વિન્્ડડોઝ 10 ની તમામ શોર્્ટકટ કીનો અભ્્યયાસ કરો અને કોષ્્ટકની નીચે વર્્ણન લખો

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS સાથે PC	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાાર્યય 1 : કોોષ્ટકમાંં નીીચેેનીી વિ�ન્ડોોઝ શોોર્ટટકટ કીી વાંંચોો અનેે તેેનુંં� અવલોોકન કરોો

Press This આ કરવા માટે

Windows Logo સ્ટાર્્ટ  મેનૂને ટૉગલ કરો

Windows Logo+A સૂચના પેનલ ખોલો

Windows Logo+B સૂચના ક્ષેત્રને સક્રિય કરો છુપાયેલા ચિહ્નો તીર બતાવો (છુપાયેલા ચિહ્નો દર્શાવવા માટે એન્ટર દબાવો)

Windows Logo+C વૉઇસ આદેશો માટે Cortana ખોલો

Windows Logo+D ડેસ્કટોપ પ્રદર્શિત કરવા માટે બધી ખુલ્્લલી વિન્્ડડોને નાની કરો

Windows Logo+E ફાઇલ એક્સપ્્લલોરર ચલાવો

Windows Logo+F સ્ટાર્્ટ  મેનૂ પ્રદર્શિત કરો અને શોધ બોક્સને સક્રિય કરો

Windows Logo+H શેર પેન દર્શાવો

Windows Logo+I સેટિિંગ્્સ એપ્્લલિકેશન ચલાવો

Windows Logo+K ઉપકરણો પેનલ પ્રદર્શિત કરો

Windows Logo+L તમારા કમ્્પ્યયુટરને લોક કરો

Windows Logo+M બધી વિન્્ડડો નાની કરો

Windows Logo+O બ્્લલેટ ઓરિએન્ટેશન લોક ચાલુ અને બંધ કરો

Windows Logo+P બીજા ડિસ્્પ્લલેને ગોઠવવા માટે પ્રોજકે્ટ ફલક પ્રદર્શિત કરો

Windows Logo+Q વૉઇસ આદેશો માટે Cortana ખોલો

Windows Logo+R રન ડાયલોગ બોક્સ ખોલો

Windows Logo+S કીબોર્્ડ  આદેશો માટે Cortana ખોલો

Windows Logo+T ટાસ્કબાર ચિહ્નો સક્રિય કરો (ચિહ્નો નેવિગેટ કરવા માટે એરો કીનો ઉપયોગ કરો)

Windows Logo+U Ease of Access Center ખોલો

Windows Logo+W શોધ બોક્સ સક્રિય કરો

Windows Logo+X વિન્્ડડોઝ ટૂલ્સ અને ઉપયોગિતાઓનું મેનૂ પ્રદર્શિત કરો

Windows Logo+= મેગ્નિફાયર ખોલો અને ઝૂમ ઇન કરો

Windows Logo+- ઝૂમ આઉટ કરો (જો મેગ્નિફાયરનો ઉપયોગ કરીને પહેલાથી જ ઝૂમ ઇન કરેલ હોય તો)

Windows Logo+ અસ્થાયી રૂપે ડેસ્કટોપ પ્રદર્શિત કરો

Windows Logo+Enter ઓપન નેરેટર
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Windows Logo+Left વર્્તમાન એપ્્લલિકેશનને સ્ક્રીનની ડાબી બાજુએ સ્્નનેપ કરો

Windows Logo+Right વર્્તમાન એપ્્લલિકેશનને સ્ક્રીનની જમણી બાજુએ સ્્નનેપ કરો

Windows Logo+Up ન્યૂનતમ એપ્્લલિકેશન પુનઃસ્થાપિત કરો; પનુઃસ્થાપિત એપ્્લલિકેશનને મહત્તમ કરો

Windows Logo+Down મહત્તમ એપ્્લલિકેશન પુનઃસ્થાપિત કરો; પુનઃસ્થાપિત એપ્્લલિકેશનને નાનું કરો

Windows Logo+PgUp વર્્તમાન એપ્્લલિકેશનને ડાબી મોનિટર પર ખસેડો

Windows Logo+PgDn વર્્તમાન એપ્્લલિકેશનને જમણા મોનિટર પર ખસેડો

Windows Logo+PrtSc વર્્તમાન સ્ક્રીનને કેપ્ચર કરો અને તેને પિક્્ચર્્સ ફોલ્્ડરમાાં સાચવો

Windows Logo+Ctrl+D વર્્ચ્યયુઅલ ડેસ્કટોપ બનાવો

Windows Logo+Ctrl+Right આગલા વર્્ચ્યયુઅલ ડેસ્કટોપ પર સ્્વવિચ કરો

Windows Logo+Ctrl+Left અગાાઉનાા વર્ચ્યુ�ુ�અલ ડેેસ્કટોોપ પર સ્વિ�િચ કરોોj

Windows Logo+Ctrl+F4 વર્્તમાન વર્્ચ્યયુઅલ ડેસ્કટોપ બંધ કરો

Windows Logo+Tab ટાસ્ક વ્્યયૂ ખોલો, જ ેદરેક ચાલી રહેલ એપ્્લલિકેશન તેમજ ઉપલબ્ધ વર્્ચ્યયુઅલ ડેસ્કટોપ માટે થંબનેલ્સ દર્શાવ છે

કાર્્ય 2 : વિન્્ડડોઝ 10 ની તમામ શોર્્ટકટ કીની પ્રેક્ટિસ કરો અને કોષ્્ટકની નીચે વર્્ણન લખો

ક્ર.સં. શૉર્્ટકટ કી વર્્ણન

તમારા પ્રશિક્ષક દ્વારા તે તપાસો

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.12
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IT & ITES	 	 એકસરસાાઈઝ 1.3.13
કોપા (COPA) - વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમનો ઉપયોગ		

વિવિધ આદેશોનો ઉપયોગ કરીને દસ્્તતાવેજો છાપો અને સ્કે ન કરો (Print and scan documents using 
different commands)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ઈમેજ સ્કે ન કરો અને સેવ કરો
•	 છબી અથવા દસ્્તતાવેજ છાપો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines) 

•	 Windows 10 OS સાથે PC 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : છબીને સ્કે ન કરો અને સાચવો 

વિન્્ડડોઝ ફેક્સ અને સ્કેનન ો ઉપયોગ કરીને સ્કેન  કરેલી ફાઇલોને PDF 
તરીકે સાચવો

1	વિ ન્્ડડોઝ “પ્રરિંટર્્સ અને સ્કેનર્્સ ” ખોલો.

2	ટુ લબાારમાંં નવાા સે્કેન બટન પર ક્લિ�િક કરોો (ફિ�ગ 1). 

3	બ દલોો પર ક્લિ�િક કરીીનેે અલગ સે્કેનર જુુઓ અથવાા પસંંદ કરોો સે્કેનર 
વિ�ભાાગમાંં બટન (ફિ�ગ 2).

4	પ્રોફ ાઇલ વિભાગમાાં, તમે જ ેફાઇલને ફોટો અથવા ડોક્યુમેન્્ટ્્સ તરીકે 
સ્કેન  કરવા જઇ રહ્યા છો તેનો પ્રકાર પસંદ કરો.

5 	 જો તમે ઇચ્છો તો અન્ય ડિફોલ્ટ સેટિિંગ્્સ બદલો.

6 	 હાર્્ડ  સ્કેન  કરવાનું શરૂ કરવા માટે સ્કેન  બટનને ક્્લલિક કરો સ્કેન રમાાં 
નકલ કરો.

કાર્્ય 2 : છબી અથવા દસ્્તતાવેજ છાપો.

1	 એકવાાર સે્કેનિં�ગ પૂૂર્ણણ થઈ જાય, પછીી ફાાઇલ મેનેુુ પર ક્લિ�િક કરોો અનેે 
પછીી પ્રિ�ન્ટ વિ�કલ્પ પર ક્લિ�િક કરોો. હાા, અમેે ફાાઈલનેે PDF તરીીકેે સેેવ 
કરવાા જઈ રહ્યાા છીીએ (ફિ�ગ 3). 

2 	પ્રિ�ન્ટ ર ડ્રોો� પ ડાાઉન બોોક્સમાંંથીી Microsoft Print to PDF પસંંદ કરોો 
અને પછીી પ્રિ�ન્ટ બટન પર ક્લિ�િક કરોો (ફિ�ગ 4). 

3 	 સવે પ્રિન્ટ આઉટપુટ એઝ ડાયલોગ પર, માટે નામ દાખલ કરો તમારી 
સ્કેન  કરેલી ફાઇલ.

4 	 ફાાઇલ સાાચવવાા માાટેે સ્થાાન પસંંદ કરોો (ફિ�ગ 5). 

5 	 પીડીએફ ફાઇલ તરીકે સેવ કરવા માટે સેવ બટન પર ક્્લલિક કરો.

Fig 1

Fig 2

Fig 3
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Fig 4

Fig 5

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.3.13

6 	અ થવા ઇન્સ્ટોલ કરેલ પ્રિન્ટર પસંદ કરો અને પછી પ્રિન્ટ પર ક્્લલિક 
કરો.

7 	તમ ારા પ્રશિક્ષક સાથે તેની તપાસ કરાવો
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IT & ITES	 	 એકસરસાાઈઝ 1.4.14
કોપા (COPA) - કમ્્પ્યયુટર બેઝિક્સ અને સોફ્ટવેર ઇન્સ્ટોલશેન	

BIOS સેટિિંગ્્સ અને તેમના ફેરફારો જુઓ (View the BIOS settings and their modifications)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 CMOS સેટઅપમાાં દાખલ કરો
•	 પ્રમાણભતૂ CMOS સેટઅપ દાખલ કરો અને પરિમાણો બદલો
•	 BIOS સુવિધાઓ સેટઅપમાાં દાખલ કરો અને પરિમાણો બદલો
•	 સિસ્ટમ પાસવર્્ડ  સેટ કરો
•	 સિસ્ટમ બટુ ઓર્્ડ ર બદલવા માટે સમજાવો
•	ડિ ફૉલ્ટ સેટિિંગ લોડ.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : CMOS સેટઅપમાાં દાખલ કરો 

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક કાર્્યરત પીસી	 - 1 No.

1	 Power on PC.

2	 CMOS સેટઅપ યુટિલિટી મેનૂમાાં દાખલ થવા માટે થોડીવાર <DEL> 
કી દબાવો.

પ્રોમ્્પ્્ટ સંદેશ નીચે પ્રમાણે પ્રદર્શિત થાય છે.
“સેટઅપ દાખલ કરવા <DEL> અથવા બાયપાસ કરવા માટે 
<ESC>  દબાવો “CMOS સેટઅપ યુટિલિટી” મેનુ મેમરી પર 
પ્રદર્શિત થાય છે.
કેટલાક કમ્્પ્યયુટરમાાં, F2 અથવા F10 અથવા F12 હોઈ શકે છે 
BIOS દાખલ કરવા માટે વપરાય છે.
કમ્પ્યુુટરનાા ઉત્પાાદકનાા આધાારેે તેે હોોઈ શકેે છેે બદલાાય છેે. તોો 
મેેન્યુુઅલ નોો સંંદર્ભભ લોો.

3	 રેકોર્્ડ  શીટમાાં સ્ક્રીન પર પ્રદર્શિત તમામ રૂપરેખાાંકન મેનુ વિકલ્્પપોન 
રેકોર્્ડ  કરો.

જો જરૂરી હોય તો પાસવર્્ડ  દાખલ કરો.

4	તમ ારા પ્રશિક્ષક દ્વારા કામની તપાસ કરાવો.

5 ઇચ્છિત ઉપયોગિતા પસંદ કરવા માટે એરો કીનો ઉપયોગ કરીને 
હાઇલાઇટને ઉપર અને નીચે (મુખ્ય મેનુ) ખસેડો.

હાઇલાઇટનો ઉપયોગ મેનુમાાં પસંદગીનો વિકલ્્પ દર્શાવવા માટે 
થાય છે. “ENTER” કી દબાવો નહીીં.

6 તમારા પ્રશિક્ષક દ્વારા કામની તપાસ કરાવો.

Fig 1
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કાર્્ય  3 : સિસ્ટમ પાસવર્્ડડ્્સ સેટ કરો

1	 કાર્્ય 1 માાંનાાં પગલાાંને અનુસરીને CMOS સેટઅપ યુટિલિટીમાાં દાખલ 
કરો.

2	 હાઇલાઇટને BIOS ફીચર સેટઅપ પર ખસેડો અને કી દબાવો.

3 	 હાઇલાઇટને સુરક્ષા વિકલ્્પ પર ખસેડો અને / કીનો ઉપયોગ કરીને તેને 
“સિસ્ટમ” પર સશંોધિત કરો.

4 	 CMOS સેટઅપ ઉપયોગિતા માટે “Esc” દબાવો.

5 	 હાઇલાઇટ વપરાશકર્તા પાસવર્્ડ  ખસેડો અને કી દબાવો.

6 	 પ્રદર્શિત મેનૂનું અવલોકન કરો અને પાસવર્્ડ  દાખલ કરો (પાસવર્્ડ  8 
અક્ષરની લંબાઈનો હોવો જોઈએ).

7 	 પ્રદર્શિત મેનૂનું અવલોકન કરો અને પુષ્્ટટિ કરવા માટે તે જ પાસવર્્ડ  
ફરીથી દાખલ કરો.

8 	 CMOS સેટઅપ યુટિલિટી માટે દબાવો.

9 	 ફંક્શન કી F10 દબાવો અથવા સેવ કરો અન બહાર નીકળો પસંદ કરો, 
એન્ટર દબાવો અન પછી વિકલ્્પ ‘Y’  દબાવો

આ પ્રક્રિયા સિસ્ટમને પુનઃપ્રારંભ કરવા તરફ દોરી જાય છે અને 
વધુ બુટીીંગ પ્રક્રિયા માટે પાસવર્્ડ  દાખલ કરે છે.

.કાર્્ય 2 : CMOS સેટઅપમાાં દાખલ કરો અને તારીખ અને સમય બદલો

1	 હાઇલાઇટને સ્ટાન્્ડર્્ડ  CMOS સેટઅપ પર ખસેડો અને <enter> કી 
દબાવો અને કોષ્્ટક 1 માાં સ્ક્રીનનો ઉલ્્લલેખ કરીને પરિમાણો રેકોર્્ડ  કરો.

સ્ક્રીન પર પ્રદર્શિત પેરામીટર્્સ “પેજઅપ અને પેજડાઉન” નો 
ઉપયોગ કરીને બદલી શકાય છે.

2	 “તારીખ” પેરામીટર પસંદ કરો અને પેજઅપ/પેજડાઉનનો ઉપયોગ 
કરીને વર્્તમાન તારીખ, મહિનો અને વર્્ષ સેટ કરો.

3 	 “સમય” પેેરાામીીટર પસંંદ કરોો અનેે પેેજઅપ/પેેજડાાઉનનોો ઉપયોોગ 
કરીીનેે વર્તતમાાન તાારીીખ, મહિ�નોો અનેે વર્ષષ સેેટ કરોો.

4	  “સમય” પેેરાામીીટર સેેટ કરોો અને સમય સેેટ કરોો.

5 	 બહાાર નીીકળોો CMOS સેેટઅપ સાાચવવાા માાટેે F10 દબાાવોો.

6 	તમા ારાા પ્રશિ�ક્ષક દ્વાારાા કાામનીી તપાાસ કરાાવોો

Fig 2

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.14

© NIMI 

NOT TO BE REPUBLISHED



30

કાર્્ય 4 : સિસ્ટમ બટૂ ઓર્્ડ ર કેવી રીતે બદલવો

પગલું 1 : તમારા કમ્્પ્યયુટરની BIOS સેટઅપ યુટિલિટી દાખલ કરો

પગલંુ 2 : BIOS માાં બટૂ ઓર્્ડ ર મેનૂ પર નેવિગેટ કરો

•	 બુટ, બુટ ઓપ્શન્્સ, બુટ સિક્્વન્્સ નામના મેનુ વિકલ્્પ હેઠળ 
અથવા એડવાન્્સ્્ડ ઓપ્શન્્સ ટેબ હેઠળ પણ

પગલું 3 : બટૂ ઓર્્ડ ર બદલો

•	 એકવાર તમે BIOS માાં બૂટ ઓર્્ડ ર વિકલ્્પપો માટે પૃષ્્ઠ શોધી લો, 
પછી તમે વિકલ્્પપોની સૂચિ જોશો કે જમેાાંથી તમારુું  કમ્્પ્યયુટર લોડ 
કરી શકે છે.

•	 ફરીથી, આ વિકલ્્પપો કોમ્્પ્યયુટરો વચ્ચે થોડો બદલાશે પરંતુ તેમાાં 
સામાન્ય રીતે શામેલ હશે: હાર્્ડ  ડ્્ર રાઈવ, ઓપ્્ટટિકલ (CD અથવા 
DVD) ડ્્ર રાઈવ, દૂર કરી શકાય તેવા ઉપકરણો (દા.ત. USB અથવા 
ફ્્લલોપી), અન નેટવર્્ક .

•	ય ાદીનો ક્રમ બદલો જથેી કરીને USB ઉપકરણ અથવા દૂર કરી 
શકાય તેવા ઉપકરણો પ્રથમ સૂચિબદ્ધ થાય.  (ફિગ 3)

Fig 3

પગલું 4: તમારા ફેરફારો સાચવો

•	 BIOS માાંથી બહાર નીકળતા પહેલા તમારા ફેરફારોને પ્રભાવિત 
કરવા માટે ખાતરી કરો

•	 સાચવો અને બહાર નીકળો અથવા બહાર નીકળો મેનૂ પર નેવિગેટ 
કરો અને એક વિકલ્્પ પસંદ કરો કે જ ેકહે છે, “સેવ ચેન્જીસ” અથવા 
F10 “સેવ કરેલા ફેરફારો સાથે બહાર નીકળો”

કાર્્ય 5 : BIOS ઇન્ટરફેસમાાંથી BIOS ને કેવી રીતે રીસેટ કરવું

પગલું 1:તમારા કમ્્પ્યયુટરની BIOS સેટઅપ યુટિલિટી દાખલ કરો

પગલું 2: BIOS માાં બહાર નીકળો મેનૂ પર નેવિગેટ કરો અને “સેટઅપ 
ડિફોલ્્ટ્્સ” વિકલ્્પ શોધો

પગલુંં� 3: “લોોડ સેેટઅપ ડિ�ફોોલ્ટ્્સ” વિ�કલ્પ પસંંદ કરોો અનેે એન્ટર 
 દબાાવોો.

પગલુંં� 4: બધાા ફેેરફાારોો સાાચવવાા અનેે BIOS સેેટઅપ સ્ક્રીીનમાંંથીી બહાાર 
નીીકળવાા માાટેે F10 અથવાા સેેવ કીી દબાાવોો. (ફિ�ગ 4)

Fig 4

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.14

© NIMI 

NOT TO BE REPUBLISHED



31

IT & ITES	 	 એકસરસાાઈઝ 1.4.15
કોપા (COPA) - કમ્્પ્યયુટર બેઝિક્સ અને સોફ્ટવેર ઇન્સ્ટોલશેન  	

વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો (Install Windows operating system)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 વિન્્ડડોઝ 10 ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો.

જરૂરીયાતો (Requirements)
સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક કાર્્યરત પીસી વિન્્ડડોઝ 10 OS સાથે	       -	 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

1	 Windows 10 ISO ઈમેજ સાથે તમારી બુટ કરી શકાય તેવી DVD 
અથવા USB ડિસ્ક તૈયાર કરો.

2 	તમ ારી DVD અથવા USB ને BIOS સેટઅપના બુટ ઓર્્ડ ર વિકલ્્પમાાં 
પ્રથમ બુટ ઉપકરણ તરીકે રાખો.

3	  જ્યાારેે તમાારાા કમ્પ્યુુટર પર BIOS સેેટઅપ ચાાલુુ હોોય ત્યાારેે F1 / F2 / 
F10 / Delete અથવાા Del / Esc દબાાવોો  અનેે ઉત્પાાદન લોોગોો સાાથેે 
પોોસ્ટ કોોડ સંંદેેશાાઓ પ્રદર્શિ�ત કરોો.

નોોંધ: BIOS સેટઅપ એન્ટ્ રી વિકલ્્પ ઉત્્પપાદિત કમ્્પ્યયુટર્્સ પર 
આધારિત હોઈ શકે છે, મેન્યુઅલનો સંદર્્ભ લો.

4	 BIOS સેટઅપ યુટિલિટીમાાં પ્રવશે્્યયા પછી બુટ વિકલ્્પ ‘બૂટ ઉપકરણ 
પ્રાધાન્યતા સેટિિંગ’ પસંદ કરો

5 	 ઓપ્્ટટિકલ ડ્્ર રાઇવ્્સ માટે USB અથવા CD રોમ ડ્્ર રાઇવ માટે દૂર કરી 
શકાય તેવું ઉપકરણ પસંદ કરો

6 UEFI/લેગસી, Windows10 ભલામણ કરેલ UEFI માાં બુટ મોડ 
વિકલ્્પની ખાતરી કરો.

નૉધ:

•	 લેગસી બટૂ એ BIOS ફર્્મવેર દ્વારા ઉપયોગમાાં લેવાતી બટૂ 
પ્રક્રિયા છે, તેનો ઉપયોગ માન્ય માસ્ટર બટૂ રેકોર્્ડ  (MBR) 
કરે છે.

•	 UEFI બટૂ એ UEFI ફર્્મવેર દ્વારા ઉપયોગમાાં લેવાતી બટૂ 
પ્રક્રિયા છે, તે માન્ય GUID પાર્ટીશન ટેબલ (GPT) નો 
ઉપયોગ કરે છે.

Fig 1

Fig 2

Fig 3

Fig 4
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7	 BIOS સેટઅપ રૂપરેખાાંકન સાચવવા અને બહાર નીકળવા માટે  F10.

8	 ઓપ્્ટટીકલ ડ્્ર રાઈવમાાં ઈમેજ ડીવીડી દાખલ કરો અને પીસી રીબુટ કરો 
પછી ડીવીડીમાાંથી ઈન્સ્ટોલશેન બુટ કરવા માટે કોઈપણ કી દબાવો.

9	અ થવા USB પોર્્ટમાાં USB ફ્્લલેશ ડ્્ર રાઇવ દાખલ કરો અને PC રીબૂટ 
કરો પછી બુટ કરી શકાય તેવું ઇન્સ્ટોલશેન તરત જ શરૂ થાય છે.

10	 હવે ઇન્સ્ટોલ કરવાનું પસંદ કરો

11 	 ઇન્ટરફેસની ભાષા, સમય અને ચલણ ફોર્મેટ અને કીબોર્્ડ  લેઆઉટ 
પસંદ કરો.   

12	 Windows 10 પ્રોોડક્ટ કીી દાાખલ કરોો. જો તમેે Windows નેે પછીીથીી 
સક્રિ�ય કરવાા માંંગતાા હોોવ તોો તમેે આ પગલુંં� છોોડીી શકોો છોો. ખાાતરીી 
કરોો કેે તમેે સાાચોો કોોડ દાાખલ કર્યોો છેે.

13	તમ  જ ેવિન્્ડડોઝ એડિશન ઇન્સ્ટોલ કરવા માાંગો છો તે પસંદ કરો.

Fig 5

Fig 6

Fig 7

Fig 8

Fig 9

Fig 10   
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14	લા ાઇસન્સિં��ગ શરતોો (EULA) માાટેે સંંમત થાાઓ.

15	 ઇન્સ્ટોલશન પ્રકાર પસંદ કરો: વિન્્ડડોઝના હાલના ઇન્સ્ટોલશેનને 
અપગ્રેડ કરો (સંસ્કરણ 7, 8, અથવા 10) અથવા તે નવું કમ્્પ્યયુટર 
હોવાથી કસ્ટમ પસંદ કરો.

16	ડિ સ્ક પસંદ કરો જ્યયાં Windows ફાઇલોની નકલ કરવામાાં આવશે. 
આ સ્ટેપ પર, તમે હાલની ડિસ્કને પાર્ટીશન કરી શકો છો, જો તમને 
પાર્ટીશનની જરૂર ન હોય તો અનફોર્મેટેડ ડિસ્ક પસંદ કરો બસ તેને 
પસંદ કરો અને આગળ દબાવો.

17	 સેટઅપ હવે ઇન્સ્ટોલ ડિસ્કમાાંથી ફાઇલોને તેમના અંતિમ મુકામ પર 
નકલ કરવાનું શરૂ કરશે.

18 	 ઇન્સ્ટોલશન પીસીને ઓટો રીબૂટ કરશે અને વિન્્ડડોઝ લોડ કરશે

19 	 ભૌગોલિક પ્રદેશ પસંદ કરો: ભારત, અને કીબોર્્ડ  લેઆઉટ: English 
(India)

Fig 11  

Fig 12  

Fig 13  

Fig 14  

Fig 15  

Fig 16  

Fig 17  
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બીજુ ંકીબોર્્ડ  વિકલ્્પ ઉમેરવાનું છોડો

20	 હવે અમ પ્રથમ વપરાશકર્તા ખાતું બનાવીશું જ ે આ કમ્્પ્યયુટર માટે 
એડમિનિસ્ટ્રેટર તરીકે પણ કાર્્ય કરશે.

પસંદ કરો: ઑફલાઇન એકાઉન્ટ પછી આગળ ક્્લલિક કરો

માઈક્રોસોફ્ટ એપ અને સર્વિસ : મર્યાદિત અનુભવ પછી આગળ ક્્લલિક 
કરો

પાસવર્્ડ  કન્ફર્્મ કરો પછી આગળ ક્્લલિક કરો

21	ન વા બનાવલેા એકાઉન્ટ માટે સુરક્ષા પ્રશ્ન અને જવાબ બનાવો, પરંતુ 
એવું લાગે છે કે તમારે 3 સુરક્ષા પ્રશ્નો પસંદ કરવા પડશે જ ે તમને 
પાસવર્્ડ  ભૂલી જવાના કિસ્્સસામાાં તમારુું  એકાઉન્ટ પનુઃપ્રાપ્્ત કરવામાાં 
મદદ કરશે.

Fig 18  

Fig 19  

Fig 20  

Fig 21  

પ્રકાર: વપરાશકર્તા નામ પછી આગળ ક્્લલિક કરો

Fig 22  

Fig 23  
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22	ગ ોપનીયતા સેટિિંગ્્સ સ્્વવીકારો ક્્લલિક કરો અને Cortana સેટિિંગ હવે 
નહીીં અથવા સ્્વવીકારો ક્્લલિક કરો.

23	 થોડી ક્ષણો અને કેટલીક અલગ-અલગ સ્ક્રીનો પછી તમને પહેલીવાર 
પરિચિત Windows10 ડેસ્કટોપ સાથે આવકારવામાાં આવશે.

Fig 24  

Fig 25  

Fig 26  

Fig 27 

Fig 28 

Fig 29 

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.15
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IT & ITES	 એકસરસાાઈઝ 1.4.16
કોપા (COPA) - કમ્્પ્યયુટર બેઝિક્સ અને સોફ્ટવેર ઇન્સ્ટોલશેન	

હાર્્ડ  ડિસ્કને ફોર્મેટ કરો અને પાર્ટીશન બનાવો (Format hard disk and create partition)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	ડિ સ્ક મેનેજમેન્ટ સાથે વિન્્ડડોઝ 10 માાં હાર્્ડ  ડ્્રરા ઈવને ફોર્મેટ કરો.

જરૂરીયાતો (Requirements)
સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક કાર્્યરત પીસી વિન્્ડડોઝ 10 OS સાથે	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ડિસ્ક મેનેજમેન્ટ સાથે Windows 10 માાં HD ડ્્રરા ઇવને ફોર્મેટ કરો

વિન્્ડડોઝ 10 માાં ડિસ્ક મેનેજમેન્ટ એ બિલ્ટ-ઇન ટૂલ છે જ ે
સિસ્ટમને રીબટૂ કર્યા વિના ફોર્મેટ, બનાવવા, કાઢી નાખવા, 
વિસ્્તતારવા, સકંોચવા માટે સક્ષમ કરે છે. જો તમે વિન્્ડડોઝ 10 
હાર્્ડ  ડ્્રરા ઈવને ફોર્મેટ કરવા માટે આ સાધનનો ઉપયોગ કરવા 
માાંગતા હો, તો તમારે પહેલા નીચેનામાાંથી કોઈ એક રીતે ડિસ્ક 
મેનેજમેન્ટ ખોલવંુ જોઈએ.

1	સ્ટાર્્ટ   મેનૂ પર ક્્લલિક કરો અને પછી શોધવા માટે ડિસ્ક મેનેજમેન્ટ ટાઇપ 
કરો

(અથવા)

2 	સ્ટાર્્ટ   મેનૂ પર ક્્લલિક કરો અને કમાન્્ડ લાઇન ખોલવા માટે cmd લખો 
અને પછી compmgmt.msc ઇનપુટ કરો અને પછી એન્ટર ક્્લલિક 
કરો 

(અથવા)

3 	 કમાન્્ડ લાઇન ખોલવા માટે “Windows + R” દબાવો અને પછી ડિસ્ક 
મેનેજમેન્ટ શરૂ કરવા માટે “diskmgmt.msc” દાખલ કરો.

4 	 ઓપન ડિસ્ક મેનેજમેન્ટ પછી, તમારે ફોર્મેટ (પાર્ટીશન D) કરવા માટે 
જરૂરી Windows 10 હાર્્ડ  ડ્્ર રાઈવ 

   પાર્ટીશન પર જમણું ક્્લલિક કરો અને પછી ફિગ 1 માાં બતાવ્્યયા પ્રમાણે 
ફોર્મેટ પસંદ કરો

•	 ફાઇલ સિસ્ટમ: NTFS

•	 ફાળવણી એકમ કદ: મૂળભતૂ

•	 ઝડપી ફોર્મેટ કરો: ચેક કરેલ

•	 ફાઇલ અને ફોલ્્ડર કમ્પ્રેશન સક્ષમ કરો: અનચેક

5	પો ોપ-અપ વિ�ન્ડોોમાંં, અનેે ફાાઇલ સિ�સ્ટમ અનેે ક્લસ્ટરનુંં� કદ સેેટ કરોો 
અનેે પછીી ફિ�ગ 2 અનેે 3 માંં બતાાવ્યાા પ્રમાાણેે બરાાબર ક્લિ�િક કરોો.

Fig 1

Fig 2

Fig 3

રીમાઇન્્ડર તરીકે, તમારે જ ેજોવું જોઈએ તે અહીીં છે:

•	 વોલ્યુમ લેબલ: [તમારી પસંદગીનું લેબલ]
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IT & ITES	 	 એકસરસાાઈઝ 1.4.17
કોપા (COPA) - કમ્્પ્યયુટર બેઝિક્સ અને સોફ્ટવેર ઇન્સ્ટોલશેન	

OS ઇન્સ્ટોલશેન દરમિયાન સામાન્ય હાર્્ડ વેર અને સોફ્ટવેર સમસ્્યયાઓને ઓળખો અને સુધારો (Identify 
and rectify common hardware and software issues during OS installation)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 OS ઇન્સ્ટોલ કરતી વખતે મળેલી સમસ્્યયાઓનો ચાર્્ટ  લખો.

જરૂરીયાતો (Requirements)
સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક કાર્્યરત પીસી વિન્્ડડોઝ 10 OS સાથે	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : OS ઇન્સ્ટોલ કરતી વખતે મળેલી સમસ્્યયાઓનો ચાર્્ટ  લખો

અનુક્રમ નંબર. સમસ્્યયા મળી સમસ્્યયાને નામ આપો

SW | HW

SW | HW

SW | HW

SW | HW

SW | HW

SW | HW

SW | HW © NIMI 
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IT & ITES	 	 એકસરસાાઈઝ 1.4.18
કોપા (COPA) - કમ્્પ્યયુટર બેઝિક્સ અને સોફ્ટવેર ઇન્સ્ટોલશેન	

વિન્્ડડોઝ માટે જરૂરી એપ્્લલિકેશન સોફ્ટવેર ઇન્સ્ટોલ કરો (Install necessary application software 
for Windows)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 MS-Office 0365 ઇન્સ્ટોલ કરો
•	 વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમમાાં નેરો સોફ્ટવેર ઇન્સ્ટોલ કરો
•	 VLC મીડિયા પ્્લલેયર ઇન્સ્ટોલ કરો
•	 એડોબ પીડીએફ રીડર ઇન્સ્ટોલ કરો
•	 વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમમાાં અવીરા ફ્રી એન્ટિવાયરસ સોફ્ટવેર ડાઉનલોડ અને ઇન્સ્ટોલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS સાથે PC 	 - 1 No.
•	 MS – ઓફિસ 2019 અથવા 0365 	 - 1 No.
•	 Windows માટે Nero Software  	 - 1 No.

•	 VLC મીડિયા પ્્લલેયર સોફ્ટવેર 	 - 1 No.
•	 એડોબ પીડીએફ રીડર સોફ્ટવેર 	 - 1 No.
•	અ વીરા ફ્રી એન્ટિવાયરસ સોફ્ટવેર 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : Microsoft 0365 પર સબ્સસ્ક્્રાઇબ કરવું અને ઇન્સ્ટોલ કરવું

1	 Go to https://www.microsoft.com/. પર જાઓ. પછી, 
ટોચના મેનુ બારમાાં Microsoft 365 પસંદ કરો. આ  Microsoft 365 
માટે સત્તાવાર ઉત્્પપાદન પૃષ્્ઠ છે.

a	 2022 ના અતંમાાં, માઈક્રોસોફ્ટ ઓફિસ Microsoft 365 નો 
ભાગ બની. Microsoft 365 પર સબ્સસ્ક્્રાઇબ કરવાથી તમને તે 
એપ્સની ઍક્સેસ મળે છે જ ેMicrosoft Office નો ભાગ હતી 
(દા.ત. વર્્ડ , એક્સેલ અને  પાવરપોઈન્ટ)

b	 ઓફિસ હોમ એન્્ડ સ્ટુડન્ટ 2021ની એક વખતની ખરીદી માટેનો 
વિકલ્્પ પણ છે, જમેાાં વર્્ડ , એક્સેલ અને પાવરપોઈન્ટના 2021 
વર્્ઝનનો સમાવશે થાય છે.

2	 હવે ખરીદો પર ક્્લલિક કરો. આ ટોચના મેનુ બારમાાં સ્થિત છે.

3	 યોજના પસંદ કરો. સબ્સસ્ક્્રિપ્શન પ્્લલાન માટે ખરીદી પ્રક્રિયા શરૂ કરવા 
માટે હવે ખરીદો પર ક્્લલિક કરો. ત્યયાં થોડા વિકલ્્પપો છે :

•	 વાર્ષિક અથવા માસિક ચૂકવણી કરો.

•	 જો તમારી પાસે બહુવિધ વપરાશકર્તાઓ હોય તો કૌટંુબિક પ્્લલાન 
પસંદ કરો અથવા જો તે ફક્્ત તમારા માટે જ હોય તો વ્્યક્્તતિગત 
પ્્લલાન પસંદ કરો.

4	તમ ારા Microsoft એકાઉન્ટમાાં સાઇન ઇન કરો. પછી, તમારી 
ખરીદી પૂર્્ણ કરવા માટે સૂચનાઓને અનુસરો.

વિન્્ડડોઝ પર ઇન્સ્ટોલ કરી રહ્્યુું છે

1	 https://www.office.com/ પર જાઓ. જો તમે પહેલાથી સાઇન ઇન 
ન હોય તો સાઇન ઇન પર ક્્લલિક કરો.

2	 ઓફિસ ઇન્સ્ટોલ કરો પર ક્્લલિક કરો. આ ઓફિસ હોમ પેજ પરનું એક 
બટન છે.

3	 ઇન્સ્ટોલ કરો પર ક્્લલિક કરો. તે Microsoft 365 સબ્સસ્ક્્રિપ્શન 
વિભાગમાાં એક બટન છે. આને Install Office & gt; લેબલ પણ કરી 
શકાય છે. ઓફિસ સેટઅપ ફાઇલ માટે ડાઉનલોડ શરૂ થશે.

•	 કાર્્ય અને વિદ્યાર્થી એકાઉન્્ટ્્સ માટે, તેના બદલે Office 365 
એપ્્લલિકેશન્્સ અથવા Microsoft 365 એપ્્લલિકેશન્્સ પર ક્્લલિક 
કરો.

4	 સેવ ફાઇલ પર ક્્લલિક કરો. તમારી ઓફિસ સેટઅપ ફાઇલ ડાઉનલોડ 
થવાનું શરૂ થશે.

•	તમ ારી પાસે તમારા બ્રાઉઝરના આધારે રન અથવા સેટઅપ પસંદ 
કરવાના વિકલ્્પપો હોઈ શકે છે.

Fig 1

5	 Office સેટઅપ ફાઇલ પર ડબલ-ક્્લલિક કરો. તમને તે તમારા 
કમ્્પ્યયુટરના ડિફોલ્ટ ડાઉનલોડ સ્થાનમાાં મળશે.

•	 જો સ્થાપન પહેલાથી જ શરૂ થઈ ગયું હોય તો આ પગલું અવગણો.

6	જ્યા રે પૂછવામાાં આવે ત્યારે હા પર ક્્લલિક કરો. તમે “શું તમે આ 
એપ્્લલિકેશનને તમારા ઉપકરણમાાં ફેરફારો કરવાની મંજૂરી આપવા 
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Fig 2

માાંગો છો?” પૂછતો પ્રોમ્્પ્્ટ જોઈ શકો છો. હા પસંદ કરવાથી સેટઅપ 
ફાઇલ ચાલશે અને તમારા કમ્્પ્યયુટર પર ઓફિસ ઇન્સ્ટોલ કરવાનું શરૂ 
કરશે.

Fig 3

Fig 4

Fig 5

Fig 6

Fig 7

Fig 8

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.18

7	 Microsoft Office ઇન્સ્ટોલ કરવાનું સમાપ્્ત થાય ત્યયાં સુધી રાહ 
જુઓ. આ પ્રક્રિયામાાં થોડી મિનિટો લાગી શકે છે.

8	જ્યા રે પૂછવામાાં આવે ત્યારે બધં કરો ક્્લલિક કરો. તમારા Microsoft 
Office પ્રોગ્રામ્્સ હવે તમારા કમ્્પ્યયુટર પર ઇન્સ્ટોલ થઈ ગયા છે. તમે 
તરત જ આ પ્રોગ્રામ્્સનો ઉપયોગ કરવાનું શરૂ કરી શકો છો.

કાર્્ય 2 : VLC મીડિયા પ્્લલેયર ઇન્સ્ટોલ કરવું

1	ફિગ  6 મુજબ Vlc-3.0.2-win32 exe ફાઇલ પર ડબલ ક્્લલિક કરો.

2	 વિન્્ડડોમાાં Run બટન પર ક્્લલિક કરો

3	 ભાષા પસંદ કરો અને ફિગ 7 માાં બતાવ્્યયા પ્રમાણે ઓકે બટન પર ક્્લલિક 
કરો.

4	ફિગ  8 માાં બતાવ્્યયા પ્રમાણે નેક્સ્ટ બટન પર ક્્લલિક કરો.	

5	ફિગ  9 ની જમે લાયસન્્સ એગ્રીમેન્ટ વિન્્ડડો પર આગળના બટનને ક્્લલિક 
કરો.
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ઇન્સ્ટોલશેન પ્રક્રિયા વિન્્ડડો ફિગ 12 પર દેખાશે.

Fig 10

8	ફિગ  13 પ્રમાણે ફિનિશ બટન પર ક્્લલિક કરો.

Fig 11

Fig 13

Fig 12

Fig 9

6	મ ીડિયા પ્્લલેયરના ઘટકો પસંદ કરો અને ફિગ 10 માાં બતાવ્્યયા પ્રમાણે 
નેક્સ્ટ બટન પર ક્્લલિક કરો.

7  	ફિગ  11 મુજબ ઇન્સ્ટોલ બટન પર ક્્લલિક કરો.

કાર્્ય 3 : ઇન્ટરનેટ પરથી એડોબ એક્રોબેટ રીડર ડીસી ડાઉનલોડ અને ઇન્સ્ટોલ કરો

1	 બ્રાઉઝર ખોલો

2	અ નુરૂપ વેબસાઇટ https:// get.adobe પસંદ કરો. com/reader/
other versions/ ફિગ 14 માાં બતાવ્્યયા  પ્રમાણે.

3	 “વિન્્ડડોઝ સંસ્કરણ, ભાષા અને રીડર સંસ્કરણ” પસંદ કરો

4	ફિગ  15 માાં બતાવ્્યયા પ્રમાણે ડાઉનલોડ બટન પર ક્્લલિક કરો.

ડાઉન લોડિિંગ પ્રક્રિયા શરૂ થશે અને EXE ફાઇલ બ્રાઉઝરની 
નીચે બતાવશે

5	 ઉપર એરો પર ક્્લલિક કરો અને ફિગ 16 માાં બતાવ્્યયા પ્રમાણે ફરીથી 
ફોલ્્ડર મેનૂમાાં બતાવો પર ક્્લલિક કરો.
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Fig 14

Fig 15

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.18

Fig 16

ડાઉન લોડિિંગ પ્રક્રિયા વિન્્ડડો ફિગ 19 માાં દર્શાવેલ છે.

6	ફિગ  17 માાં બતાવ્્યયા પ્રમાણે ફાઇલ પર ડબલ ક્્લલિક કરો.

Fig 17

7	ફિગ  18 માાં બતાવ્્યયા પ્રમાણે રન બટન પર ક્્લલિક કરો.

Fig 18

Fig 19

8	 ઇન્સ્ટોલશેન પૂર્્ણ કર્યા પછી ફિગ 20 માાં બતાવ્્યયા પ્રમાણે ફિનિશ બટન 
પર ક્્લલિક કરો.

Fig 20

9	 સ્્વવાગત વિન્્ડડો ફિગ 21 માાં દર્શાવલે છે.

© NIMI 

NOT TO BE REPUBLISHED



42

કાર્્ય 4 : વિન્્ડડોઝ ઓપરેટિિંગ સિસ્ટમમાાં અવીરા ફ્રી એન્ટિવાયરસ સોફ્ટવેર ઇન્સ્ટોલ કરવું

Fig 21

Fig 22

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.18

Fig 23

Fig 24

Fig 25

1	ફિગ  22 માાં બતાવ્્યયા પ્રમાણે વિન્્ડડોઝ ટાસ્ક બારમાાં “Google 
Chrome” આઇકોન પર ક્્લલિક કરો.

2	 ટેક્સ્ટ બૉક્સમાાં “વિન્્ડડોઝ 10 માટે અવિરા એન્ટિવાયરસ ડાઉનલોડ 
કરો” ટેક્સ્ટ ટાઇપ કરો અને ફિગ 23 માાં બતાવ્્યયા પ્રમાણે “શોધ” 
બટનને ક્્લલિક કરો.

ક્રોમ વેબ પેજમાાં સંબંધિત લિિંક્સની સચૂિ પ્રદર્શિત કરો.

3	 સંબંધિત લિિંક પર જમણું ક્્લલિક કરો અને ફિગ 23 માાં બતાવ્્યયા પ્રમાણે 
“નવી ટેબમાાં લિિંક ખોલો” પર ક્્લલિક કરો.

અનુરૂપ સોફ્ટવેર exe ફાઇલ વેબ પૃષ્્ઠની નીચે ડાઉનલોડ 
કરશે

4 	ફિગ  24 માાં બતાવ્્યયા પ્રમાણે વેબ સાઇટમાાં “હમણાાં શરૂ કરો” બટન પર 
ક્્લલિક કરો.

5	 ફાઇલ ડાઉનલોડ કર્યા પછી “^ બટન પર ક્્લલિક કરો” અને ફિગ 25 માાં 
બતાવ્્યયા પ્રમાણે “ઓપન” મેનુ પર  ક્્લલિક કરો.

6	ફિગ  26 માાં બતાવ્્યયા પ્રમાણે નીચેની વિન્્ડડોમાાં “રન” બટન પર ક્્લલિક 
કરો.

નીચે આપેલ સ્ક્રીન બતાવે છે કે “આ તમારા કમ્્પ્યયુટર પર 
સોફ્ટવેર ડાઉનલોડ અને ઇન્સ્ટોલ કરશે”

7	ફિગ  27 મુજબ ડાઉનલોડ કરવાની પ્રક્રિયા ચાલુ રાખવા માટે “આગલું” 
ક્્લલિક કરો.
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8	ફિગ  29 મુજબ 100% ડાઉનલોડિિંગ પ્રોગ્રેસ પૂર્્ણ કર્યા પછી “Finish” 
બટન પર ક્્લલિક કરો.

9	 ડાઉનલોડ પ્રક્રિયા પૂર્્ણ કર્યા પછી વિન્્ડડો ફિગ 30 પર દેખાશે.

10	 વિન્્ડડોની નીચે “હવે ઇન્સ્ટોલ કરો” બટન પર ક્્લલિક કરો.

“ઇન્સ્ટોોલેેશનનીી તૈૈયાારીી” પ્રક્રિ�યાા ફિ�ગ 31 થીી શરૂ થાાય છેે.

“ઇન્સ્ટોોલેેશનનીી તૈૈયાારીી” પ્રક્રિ�યાા પૂૂર્ણણ કર્યાા પછીી “ઇન્સ્ટોોલેશેન 
પ્રકાાર પસંંદ કરોો” વિ�ન્ડોો દેેખાાશેે

Fig 26

Fig 27

Fig 28

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.18

ડાઉનલોડિિંગ પ્રોગ્રેસ બાર ફિગ 28 માાં બતાવ્્યયા પ્રમાણે 
ડાઉનલોડિિંગ સ્ટેટસ પ્રદર્શિત કરશે.

Fig 29

Fig 30

Fig 31

11	 “Express (Recommended)” સેટઅપ પ્રકાર વિકલ્્પ પસંદ કરો 
અન ફિગ 32 માાં બતાવ્્યયા પ્રમાણે વિન્્ડડોની નીચે લાયસન્્સ કરાર અને 
ગોપનીયતા નીતિ વિકલ્્પ પસંદ કરો.

Fig 32
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12	  “આગલું” બટન પર ક્્લલિક કરો.

અવીરા એન્ટિવાયરસ એપ્્લલિકેશન ઇન્સ્ટોલશેન ફિગ 33 અને 
34 માાં બતાવ્્યયા પ્રમાણે પૂર્્ણ થયું.

Fig 33

Fig 34

13	તમ ારા પ્રશિક્ષક સાથે તેની તપાસ કરાવો.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.18
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IT & ITES	 	 એકસરસાાઈઝ 1.4.19
કોપા (COPA) - કમ્્પ્યયુટર બેઝિક્સ અને સોફ્ટવેર ઇન્સ્ટોલશેન	

બ્્લલૂટૂથ / Wi-Fi સેટિિંગ્્સ ગોઠવો (Configure bluetooth / Wi-Fi settings)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	બ્્લલૂ ટૂથ ઉપકરણોને Windows 10 સાથે કનકે્ટ કરી રહ્યયાં છે
•	 PC માટે WIFI કનકે્શન બનાવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ઇનબિલ્ટ સાથે કાર્્યરત પીસી બ્્લલૂટૂથ અને 
	 વાઇફાઇ સક્ષમ  	 - 1 No.
•	 Windows 10 OS	 - 1 No.
•	બ્્લલુ થુથ ડોોંગલ (જોતે પીસી સાથે ઇનબિલ્ટ નથી) 	 - 1 No.

•	 WiFi ડોોંગલ (જો તે નથી પીસી સાથે ઇનબિલ્ટ) 	 - 1 No.
•	બ્્લલૂ ટૂથ સક્ષમ ઉપકરણો(કીબોર્્ડ  / માઉસ / સ્્પપીકર/ 
	 હેડસેટ)	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : બ્્લલૂટૂથ ઉપકરણોને Windows 10 સાથે કનકે્ટ કરવું. 

બ્્લલૂટૂથ ઉપકરણોને Windows 10 સાથે કનકે્ટ કરી રહ્યયાં છીએ

1	 Windows કી + I કીબોર્્ડ  શોર્્ટકટનો ઉપયોગ કરો, સેટિિંગ્્સ 
એપ્્લલિકેશન ખોલો.

2	 ઉપકરણો પર નેવિગેટ કરો અને બ્્લલૂટૂથ પર જાઓ.

3	ખ ાતરી કરો કે બ્્લલૂટૂથ સ્્વવીચ ચાલુ સ્થિતિમાાં છે. (તમે જાણશો કે તે કામ 
કરી રહ્્યુું છે કારણ કે તમે જોશો કે સંદેશ વાાંચે છે કે “તમારુું  PC શોધી 
રહ્્યુું છે અને બ્્લલૂટૂથ ઉપકરણો દ્વારા શોધી શકાય છે.”)

4	ત મેે જે ેઉપકરણનેે જોડવાા માંંગોો છોો તેેનેે પસંંદ કરોો અનેે જોડીી પર ક્લિ�િક 
કરોો. એકવાાર તમેે જોડીી પર ક્લિ�િક  કરોો, તમેે બધુંં� પૂૂર્ણણ કરીી લોો. વિ�ન્ડોોઝ 
10 બાાકીીનીી કાાળજી લેશેેે. તમેે ઉપકરણનાા નાામ હેેઠળ “કનેેકે્ટેડ” લેેબલ 
જોશોો (ફિ�ગ 1).

ઝડપી મશુ્્કકેલીનિવારણ ટીપ્સ

જો તમનેે ઉપકરણોો પર બ્લૂૂટૂૂથ વિ�ભાાગ દેેખાાતોો નથીી, તોો સંંભવ છેે કેે બ્લૂૂટૂૂથ 
ડ્રાા� ઇવરમાંં સમસ્યાાઓ છેે. ડ્રાા� ઇવર હાાજર છેે અનેે યોોગ્ય રીીતેે ઇન્સ્ટોોલ કરેેલુંં� 
છેે તેે ચકાાસવાા માાટેે ડિવાઇસ મેનેજર પર જાઓ. હજી પણ કામ કરી રહ્યું������������������ં������������������ 
નથીી, તમેે તમાારાા કમ્પ્યુુટરનીી ઉત્પાાદક સપોોર્ટટ  વેેબસાાઇટ પરથીી નવીીનતમ 
બ્લૂૂટૂૂથ ડ્રાા� ઇવરનેે ડાાઉનલોોડ અનેે ફરીીથીી ઇન્સ્ટોોલ કરવાા માાગીી શકોો છોો 
(ફિ�ગ 3). 

Fig 2

Fig 1

5	 ઝડપી ક્રિયાઓ એરિયામાાંથી, કનેક્ટ બટનને ક્્લલિક કરો.

6	 પછીી બધાા સક્ષમ ઉપકરણોો સૂૂચિ�માંં દેેખાાશેે, ઉપકરણ પર ક્લિ�િક કરોો, 
અનેે તેે આપમેેળેે જોડાાઈ જવુંં� જોઈએ (ફિ�ગ 2). 
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Windows 10 માાંથી બ્્લલૂટૂથ પેરિફેરલ દૂર કરવંુ

વાયરલેસ પેરિફેરલને ડિસ્કનેક્ટ કરવું એ કનેક્ટ કરવા જટેલું જ સરળ છે. 
ફક્્ત નીચેના પગલાાંઓ અનુસરો:

1	 સેટિિંગ્્સ એપ્્લલિકેશન ખોલવા માટે Windows + I કીબોર્્ડ  શોર્્ટકટનો 
ઉપયોગ કરો.

2	 ઉપકરણો મારફતે નેવિગેટ કરો અને બ્્લલૂટૂથ પર જાઓ.

3	ત મેે જે ેપેેરિ�ફેરલનેે ડિ�સ્કનેેક્ટ કરવાા માંંગોો છોો તેેનાા પર ક્લિ�િક કરોો અનેે 
દૂૂર કરોો બટનનેે ક્લિ�િક કરોો અને પછીી પુુષ્ટિ�િ કરવાા માાટેે હાા ક્લિ�િક કરોો 
(ફિ�ગ 4). 

કાર્્ય 2 : PC માટે WIFI કનકે્શન બનાવો

Wi-Fi નેટવર્્ક થી કેવી રીતે કનકે્ટ કરવું

1	 સૂચના ક્ષેત્રમાાં વાયરલેસ આયકન પર ક્્લલિક કરો.

2	તમ ે કનેક્ટ કરવા માાંગો છો તે નેટવર્્ક  પસંદ કરો.

3	 આપોઆપ કનેક્ટ કરો વિકલ્્પ તપાસો.

4	 કનેેક્ટ બટન પર ક્લિ�િક કરોો (ફિ�ગ 5).

5	ન ેટવર્્ક  સુરક્ષા કી દાખલ કરો.

6	ને ેક્સ્ટ બટન પર ક્લિ�િક કરોો (ફિ�ગ 6).

Wi-Fi નેટવર્્ક થી કેવી રીતે ડિસ્કનકે્ટ કરવું

તમારા ઉપકરણને વાયરલેસ નેટવર્્કમા ાંથી દૂર કરવું એ પણ એક સીધી 
પ્રક્રિયા છે જ ેથોડી અલગ રીતે કરી શકાય છે.

ફ્્લલાયઆઉટ મેનૂનો ઉપયોગ કરીને ડિસ્કનકે્ટ થઈ રહ્્યુું છે

ડિસ્કનેક્ટ કરવાનો સૌથી સહેલો રસ્્તતો નેટવર્્ક  ફ્્લલાયઆઉટ મેનૂનો 
ઉપયોગ કરવાનો છે.

Fig 4

Fig 3

Fig 5

Fig 6

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.19

જો સમસ્્યયા સ્્પપીકર્્સ, હેડફોન, માઉસ અથવા કીબોર્્ડમા ાં હોય, તો પેરિફેરલને 
બધં કરવાની ખાતરી કરો, થોડીક સેકન્્ડડો રાહ જુઓ અને ફરી પ્રયાસ કરવા 
માટે તેને પાછંુ ચાલુ કરો.

1	 સૂચના ક્ષેત્રમાાં વાયરલેસ આયકન પર ક્્લલિક કરો.

2	 2 તમે હાલમાાં જોડાયેલા છો તે નેટવર્્ક  પસંદ કરો.

3	ને ેટવર્કક  કનેેક્શન પર ડિ�સ્કનેેક્ટ બટનનેે ક્લિ�િક કરોો (ફિ�ગ 7). 

સેટિિંગ્્સ એપ્્લલિકેશનનો ઉપયોગ કરીને ડિસ્કનકે્ટ થઈ રહ્્યુું છે.

વૈકલ્્પપિક રીતે, તમે સેટિિંગ્્સ એપ્્લલિકેશનનો ઉપયોગ કરીને Wi-Fi ને સક્ષમ 
અથવા અક્ષમ કરી શકો છો.

1	 સેટિિંગ્્સ ખોલો.

2	 નેટવર્્ક  અને સુરક્ષા પર ક્્લલિક કરો.

3	 Wi-Fi પર ક્્લલિક કરો.
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Fig 7

4	તમ ે ડિસ્કનેક્ટ ઇચ્છો છો તે એડેપ્્ટર માટે ટોગલ સ્્વવિચ બંધ કરો.

5	ચા ાલુુ કરવાા માાટેે વિ�કલ્પ પસંંદ કરવાા માાટેે ડ્રોો� પ-ડાાઉન મેનેુુનોો ઉપયોોગ 
કરોો શેેડ્યૂૂલ પર વાાયરલેેસ એડેેપ્ટર પર. 

Fig 8

Wi-Fi કનકે્શન ગુણધર્મો કેવી રીતે જોવી

1	 સેટિિંગ્્સ ખોલો.

2	ન ેટવર્્ક  અન સુરક્ષા પર ક્્લલિક કરો.

3	 Wi-Fi પર ક્્લલિક કરો.

4	 વાયરલેસ નેટવર્્ક  હેઠળ, હાર્્ડ વેર પર ક્્લલિક કરો ગુણધર્મો લિિંક.  
(ફિગ 9 અને 10)

Fig 9

Fig 10

Wi-Fi કનકે્શન્્સ કેવી રીતે મેનેજ કરવા

સેટિિંગ્્સ એપ્્લલિકેશનનો ઉપયોગ કરીને તે કિસ્્સસાઓમાાં મેન્યુઅલી Wi-Fi 
નેટવર્્ક  ઉમેરવા અથવા દૂર કરવાનું પણ શક્ય છે જ્યારે તમારે નેટવર્્ક  સાથે 
કનેક્ટ કરવાની જરૂર પડી શકે છે જ ેતેના SSID (સર્વિસ સેટ આઇડેન્ટિફાયર) 
ને બ્રોડકાસ્ટ કરતું નથી, અથવા જ્યારે તમારે સેટઅપ કરવાની જરૂર હોય 
ત્યારે સમય બચાવવા માટે અગાઉથી વાયરલેસ કનેક્શન.

Wi-Fi નેટવર્્ક  ઉમેરી રહ્યા છીએ

1	 સેટિિંગ્્સ ખોલો.

2	ન ેટવર્્ક  અને સુરક્ષા પર ક્્લલિક કરો.

3	 Wi-Fi પર ક્્લલિક કરો.

4	 જાણીીતાા નેેટવર્ક્સસ મેેનેેજ કરોો લિં�ક પર ક્લિ�િક કરોો (ફિ�ગ 11). 

Fig 11

5	નવુંં�  નેેટવર્કક  ઉમેેરોો બટન પર ક્લિ�િક કરોો (ફિ�ગ 12). 

Fig 12

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.19
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6	ન ેટવર્્ક  નામ દાખલ કરો.

7	ડ્ ્ર રોપ-ડાઉન મેનુનો ઉપયોગ કરીને, નેટવર્્ક  પસંદ કરો સુરક્ષા પ્રકાર.

8	 આપોઆપ કનેક્ટ કરો વિકલ્્પ તપાસો.

9	ન ેટવર્્ક  ન હોય તો પણ કનેક્ટ તપાસો પ્રસારણ વિકલ્્પ.

10	સા ાચવોો પર ક્લિ�િક કરોો (ફિ�ગ 13).

એકવાર તમે પગલાાંઓ પૂર્્ણ કરી લો તે પછી, જ્યારે પણ તમારુું  ઉપકરણ 
નેટવર્્કન ી શ્રેણીમાાં હોય, ત્યારે તે આગળના કોઈપણ પગલાાં વિના આપમેળે 
કનેક્ટ થઈ જશે.

Wi-Fi નેટવર્્ક  દૂર કરવંુ

જો તમારે Wi-Fi નેટવર્્ક  દૂર કરવું (ભલૂી જવું) જ જોઈએ, તો સેટિિંગ્્સ 
એપ્્લલિકેશન તેને ખૂબ જ સરળ પ્રક્રિયા બનાવે છે.

1	 સેટિિંગ્્સ ખોલો.

2	ન ેટવર્્ક  અન સુરક્ષા પર ક્્લલિક કરો.

3	 Wi-Fi પર ક્્લલિક કરો.

4	 જાણીીતાા નેેટવર્ક્સસ મેનેેેજ કરોો લિં�ક પર ક્લિ�િક કરોો (ફિ�ગ 14).

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.19

Fig 13

Fig 14

Fig 15

5	તમ ે દૂર કરવા માાંગો છો તે Wi-Fi કનેક્શન પસંદ કરો.

6	ભૂ ૂલીી જાઓ બટનનેે ક્લિ�િક કરોો (આ બટનનોો ઉપયોોગ કરીીનેે કોોઈ 
પુુષ્ટિ�િકરણ સંંવાાદ નથીી, તેેથીી ખાાતરીી કરોો કેે તમેે ખરેખર ઈચ્છોો છોો કેે 
Windows 10 બટન પર ક્લિ�િક કરતાા પહેેલાા આ કનેેક્શન ભૂૂલીી જાય) 
(ફિ�ગ 15). 

પગલાાંઓ પૂર્્ણ કર્યા પછી, તમારુું  ઉપકરણ તમે દૂર કરેલા નેટવર્્ક  સાથે 
કનેક્ટ થવાનો પ્રયત્ન કરશે નહીીં.
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IT & ITES	 	 એકસરસાાઈઝ 1.4.20
કોપા (COPA) - કમ્્પ્યયુટર બેઝિક્સ અને સોફ્ટવેર ઇન્સ્ટોલશેન	

પ્રિન્ટર, સ્કે નર, વેબ કેમેરા અને DVD ડ્્રરા ઇવ્્સ ઇન્સ્ટોલ કરો (Install printer, scanner, Web camera 
& DVD drives)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 વિન્્ડડોઝ 10 ઓપરેટિિંગ સિસ્ટમમાાં સ્થાનિક પ્રિન્ટર ઉમેરો
•	 વાયરલેસ પ્રિન્ટર, વેબ કેમેરા અને બાહ્ય DVD ડ્્રરા ઇવ ઇન્સ્ટોલ કરો
•	 Windows 10 PC માાં સ્કે નર ઉમેરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 વિન્્ડડોઝ 10 OS સાથે પીસી	 - 1 No.

PC સાથે પ્રિન્ટરને કનકે્ટ કરવાની સૌથી સામાન્ય રીત USB 
કેબલ છે, જ ે તેને સ્થાનિક પ્રિન્ટર બનાવે છે. અને વાયરલેસ 
પ્રિન્ટર પણ ઇન્સ્ટોલ કરો અથવા તમારા નેટવર્્ક  પર બીજા 
કમ્્પ્યયુટર સાથે જોડાયેલ પ્રિન્ટર ઉમેરો જ ે તેને નેટવર્્ક  પ્રિન્ટર 
બનાવે છે.

1	 USB કેબલનો ઉપયોગ કરીને પ્રિન્ટરને તમારા કમ્્પ્યયુટર સાથે કનેક્ટ 
કરો અને તેને ચાલુ કરો.

2	સ્ટાર્્ટ   મેનુમાાંથી સેટિિંગ્્સ એપ્્લલિકેશન ખોલો.

3	ફિગ  1 માાં બતાવ્્યયા પ્રમાણે ઉપકરણો પર ક્્લલિક કરો.

4	ફિગ  2 મુજબ પ્રિન્ટર અથવા સ્કેન ર ઉમેરો પર ક્્લલિક કરો.

5	 જો વિન્્ડડોઝ કનેક્ટેડ પ્રિન્ટરને શોધી શકતું નથી, તો ફિગ 3 માાં બતાવ્્યયા 
પ્રમાણે મને જોઈતું પ્રિન્ટર સૂચિબદ્ધ નથી તે લિિંકને ક્્લલિક કરો.

Fig 1

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : વિન્્ડડોઝ 10 ઓપરેટિિંગ સિસ્ટમમાાં સ્થાનિક પ્રિન્ટર ઉમેરો 

6	અ ન્ય વિકલ્્પપો સાથે પ્રિન્ટર શોધો વિન્્ડડો પર, મેન્યુઅલ સેટિિંગ્્સ રેડિયો 
બટન સાથે સ્થાનિક પ્રિન્ટર અથવા નેટવર્્ક  પ્રિન્ટર ઉમેરો પસંદ કરવા 
માટે ક્્લલિક કરો.

7	ફિગ  4 પર ચાલુ રાખવા માટે આગળ ક્્લલિક કરો.

Fig 4

Fig 2

Fig 3

•	પ્રિ ન્ટર, સ્કેન ર, વેબ કેમેરા અને ડીવીડી ડ્્ર રાઈવ સોફ્ટવેર 	 - 1 No.
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8	પ્રિ ન્ટર પોર્્ટ  પસંદ કરો વિન્્ડડો પર, ડિફૉલ્ટ વિકલ્્પપો પસંદ કરો અને 
આગળ ક્્લલિક કરો.

જો તમે અદ્યતન વપરાશકર્તા છો, તો તમે અસ્્તતિત્્વમાાંના પોર્્ટ નો 
ઉપયોગ કરો ડ્્રરો પ-ડાઉન સૂચિમાાંથી એક અલગ વિકલ્્પ પણ 
પસંદ કરી શકો છો, અથવા તમે નવંુ પોર્્ટ  રેડિયો બટન પસંદ 
કરીને અને સક્ષમ ફીલ્્ડમાાં તમારા કસ્ટમ પોર્્ટ નો ઉલ્્લલેખ કરીને 
તમારા પોતાના પોર્્ટ ને વ્્યયાખ્યાયિત કરી શકો છો. ફિગ 5 મુજબ.

9	 આગળ ક્્લલિક કરો

10	 ઈન્સ્ટોલ ધ પ્રિન્ટર ડ્્ર રાઈવર વિન્્ડડો પર, ડાબા વિભાગમાાં પ્રિન્ટર 
ઉત્્પપાદકોની પ્રદર્શિત સચૂિમાાંથી, કનેક્ટેડ પ્રિન્ટર જનેી સાથે છે તે પસંદ 
કરવા માટે ક્્લલિક કરો.

11	 જમણા વિભાગમાાંથી, પીસી સાથે જોડાયેલ પ્રિન્ટરનું ચોક્કસ મોડેલ 
પસંદ કરવા માટે શોધો અને ક્્લલિક કરો.

નોોંધ: આ સમયે, તમે હેવ ડિસ્ક બટનને પણ ક્્લલિક કરી શકો છો 
અને કનકે્ટેડ પ્રિન્ટર માટે ડ્્રરા ઇવરને બ્રાઉઝ કરીને શોધી શકો 
છો જો તમે તેને તેની સત્તાવાર વેબસાઇટ અથવા ઉત્્પપાદક દ્વારા 
લિિંક કરેલ ડ્્રરા ઇવર DVD પરથી મને્યુઅલી ડાઉનલોડ કરેલ 
હોય.

12	ફિગ  6 મુજબ આગળના પગલા પર આગળ વધવા માટે આગળ 
ક્્લલિક કરો.

13	પ્રિ ન્ટર નામની વિન્્ડડોમાાં, પ્રિન્ટર નામ ફીલ્્ડમાાં, ફિગ 7 માાં બતાવ્્યયા 
પ્રમાણે પ્રિન્ટર માટે માહિતીપ્રદ નામ ટાઈપ કરો.

14	 આગળ ક્્લલિક કરો.

15	 જો તમે પ્રિન્ટર શેર કરો છો, તો “આ પ્રિન્ટરને શેર કરો જથેી કરીને 
નેટવર્્ક  પરના અન્ય લોકો તેને શોધી અને ઉપયોગ કરી શકે” રેડિયો 
બટન પસંદ કરો.

નોોંધ: જો તમે નેટવર્્ક  વપરાશકર્તાઓ સાથે પ્રિન્ટરને શેર કરવા 
નથી માાંગતા, તો તમે આ પ્રિન્ટરને શેર કરશો નહીીં રેડિયો બટન 
પસંદ કરી શકો છો.

16	શ ેર નામ ફીલ્્ડમાાં, પ્રિન્ટર માટે ટંૂકંુ શેર નામ લખો.

નોોંધ: તમે અહીીં ઉલ્્લલેખિત કરેલ નામ દૂરસ્થ વપરાશકર્તાઓને 
પ્રદર્શિત કરવામાાં આવશે જ્યારે તેઓ નેટવર્્ક  પર આ પ્રિન્ટરને 
શોધશે.

17	તમ ારી પસંદગીની માહિતી સાથે સ્થાન અને ટિપ્પણી ક્ષેત્રો ભરો.

18	ફિગ  8 પર ચાલુ રાખવા માટે આગળ ક્્લલિક કરો.

Fig 5

Fig 6

Fig 7

Fig 8

19	 વિઝાર્્ડન ા અંતિમ પષૃ્્ઠ પર, પ્રિન્ટરની કનેક્ટિવિટી અને યોગ્્ય કામગીરી 
તપાસવા માટે પરીક્ષણ પૃષ્્ઠ છાપો બટનને ક્્લલિક કરો.

20	 પ્રક્રિયા પૂર્્ણ કરવા માટે સમાપ્્ત પર ક્્લલિક કરો.

કાર્્ય 2 : વાયરલેસ પ્રિન્ટર ઇન્સ્ટોલ કરવું

1	 સેટિિંગ્્સ ખોલો.

2	 ઉપકરણો પર ક્્લલિક કરો.

3	પ્રિ ન્ટર્્સ અને સ્કેનર્્સ  પર ક્્લલિક કરો.

4	ફિગ  9 પરની જમે પ્રિન્ટર અથવા સ્કેન ર ઉમેરો બટન પર ક્્લલિક કરો.

5	ય ાદીમાાંથી પ્રિન્ટર પસંદ કરો અને ફિગ 10 માાં બતાવ્્યયા પ્રમાણે 
વાયરલેસ પ્રિન્ટરને Windows 10 માાં ઇન્સ્ટોલ કરવા માટે ઉપકરણ 
ઉમેરો પર ક્્લલિક કરો.
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1	 ટાસ્કબાર પરના સર્્ચ બોક્સ પર જાઓ અને કંટ્્ર રોલ પેનલ ટાઈપ કરો. 
Cortana કંટ્્ર રોલ પેનલ પણ તેના પર ક્્લલિક કરો.

Fig 9 Fig 10

કાર્્ય 3 : Windows 10 PC માાં સ્કે નર ઉમેરવું

Fig 11

Fig 12

Fig 13

4	 ઉપકરણ ઉમેરો શીર્્ષક સાથેનું એક નાનું બોક્સ સ્ક્રીન પર દેખાશે અને 
તે ઉપકરણને શોધવાનું શરૂ કરશે.

5	સ્કેન   પૂર્્ણ થયા પછી, સ્કેન રનું નામ બોક્સ પર પ્રદર્શિત થશે. તેથી, 
સ્કેન રનું નામ પસંદ કરો અને ફિગ 14 માાં બતાવ્્યયા પ્રમાણે આગળ 
ક્્લલિક કરો.

Fig 14

6	 છેલ્્લલે, Windows 10 PC માાં સ્કેન ર સફળતાપૂર્્વક ઉમેર્્યુું.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.4.120

2	ફિગ  12 મુજબ ઉપકરણો અને પ્રિન્ટરો શોધો અને પસંદ કરો.

3	 ઉપકરણો અને પ્રિન્ટરની અંદર, ખાલી જગ્્યયા શોધો અને ત્યયાં જમણું-
ક્્લલિક કરો. થોડા વિકલ્્પપો દેખાશે, ફિગ 13 મુજબ ઉપકરણો અને 
પ્રિન્ટર્્સ ઉમેરો પર ક્્લલિક કરો.
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કાર્્ય 4 : વેબ કેમેરા ઇન્સ્ટોલ કરી રહ્યા છીએ

1	તમ ારા વેબ કેમેરાને તમારા કમ્્પ્યયુટર સાથે કનેક્ટ કરો.

2	તમ ારા કોમ્્પ્યયુટરને વેબ કેમેરા શોધવા માટે રાહ જુઓ. કારણ કે તમારી 
પાસે તમારા કમ્્પ્યયુટર પર વિન્્ડડો વિસ્ટા અથવા નવીનતમ ઇન્સ્ટોલ 
કરેલ છે, તમારુું  કમ્્પ્યયુટર આપમેળે શોધી કાઢશે કે તમારા USB પોર્્ટ  
સાથે નવું હાર્્ડ વેર જોડાયેલ છે. તમારી સ્ક્રીનના તળિયે જમણા ખૂણે એક 
સંદેશ દેખાશે જ ેવાાંચે છે, “તમારા ઉપકરણો ઉપયોગ માટે તૈયાર છે”

3	 કૅમેરાને ઑપરેટ કરવા માટે સૉફ્ટવેર ઇન્સ્ટોલ કરો, તમારો કૅમેરો 
તમારા કમ્્પ્યયુટર પર ઇન્સ્ટોલ કરવા માટે સૉફ્ટવેર સાથે આવ્્યયો છે. 
ફક્્ત તમારા વેબ કેમેરા સાથે આવેલી ડિસ્ક દાખલ કરો અને સૂચનાને 
અનુસરો.

કાર્્ય 5 : બાહ્ય ડીવીડી રાઈટર ઇન્સ્ટોલ કરવું

1	તમ ારા ડીવીડી રાઈટરને તમારા કમ્્પ્યયુટર સાથે જોડો.

2	 ડીવીડી રાઈટર શોધવા માટે તમારા કમ્્પ્યયુટરની રાહ જુઓ. કારણ 
કે તમારી પાસે તમારા કમ્્પ્યયુટર પર વિન્્ડડો વિસ્ટા અથવા નવીનતમ 
ઇન્સ્ટોલ કરેલ છે, તમારુું  કમ્્પ્યયુટર આપમેળે શોધી કાઢશે કે તમારા 

USB પોર્્ટ  સાથે નવું હાર્્ડ વેર જોડાયેલ છે. તમારી સ્ક્રીનના તળિયે 
જમણા ખૂણે એક સંદેશ દેખાશે જ ેવાાંચે છે, “તમારા ઉપકરણો ઉપયોગ 
માટે તૈયાર છે”.

3	ન વા બાહ્ય ડીવીડી રાઈટર વર્કકિંગ પ્્લગ અને પ્્લલે વિકલ્્પપો છે.
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IT & ITES	 	 એકસરસાાઈઝ 1.4.21
કોપા (COPA) - કમ્્પ્યયુટર બેઝિક્સ અને સોફ્ટવેર ઇન્સ્ટોલશેન	

એપ્્લલિકેશન સોફ્ટવેરનો ઉપયોગ કરીને સીડી/ડીવીડી પર ડેટા, વિડિયો અને ઑડિયો ફાઇલો બર્્ન કરો 
(Burn data, video and audio files on CD/DVD using application software)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સીડી અથવા ડીવીડીમાાં ડેટા બર્્ન કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 વિન્્ડડોઝ 10 OS સાથે પીસી 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ડેટાને CD અથવા DVD માાં બર્્ન કરો

1	 સીડીને સીડી/ડીવીડી રાઈટરમાાં મૂકો

2	 Go to Start > All programs > Nero, પછી NeroStart Smart 
પર જાઓ

3	 ડેટા આયકન શોધવા માટે, પ્રોગ્રામ વિન્્ડડોની ઉપર જમણી બાજુએ 
આવેલા ચિહ્નો પર સ્ક્રોલ કરો. (ફિગ 1)  અથવા ઓડિયો વિડિયો 
અથવા અન્ય

•	ન ેરો સોફ્ટવેર	 - 1 No.

4	 ડેટા સીડી બનાવો પસંદ કરો. આ ફિગ 2 માાં બતાવ્્યયા પ્રમાણે નેરો 
એક્સપ્રેસ શરૂ કરશે.

5	 ઉમેરો પર ક્્લલિક કરો અને હાર્્ડ  ડ્્ર રાઈવ બ્રાઉઝ કરો અને CD પર 
સમાવિષ્્ટ ફાઇલો પસંદ કરો. ફાઇલો ઉમેરવાનું સમાપ્્ત થાય ત્યારે 
સમાપ્્ત ક્્લલિક કરો.

6	 આગળ ક્્લલિક કરો અને ડિસ્કને નામ આપો.

7	 બર્્ન કર્યા પછી ડેટા ચકાસો જો તમે ખાતરી કરવા માાંગતા હોવ કે તમારુું  
બર્્ન યોગ્્ય રીતે થયું છે (આમાાં થોડો વધુ સમય લાગશે).

8	 બર્્ન પર ક્્લલિક કરો અને ફિગ 3 મુજબ ખાલી CD દાખલ કરો

Fig 1

Fig 2

Fig 3
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IT & ITES	 	 એકસરસાાઈઝ 1.5.22
કોપા (COPA) - DOS કમાન્્ડ લાઇન ઇન્ટરફેસ	

મૂળભતૂ DOS આદેશો (Basic DOS Commands)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	ડ ોસ કમાન્્ડ પ્રોમ્્પ્્ટ પર દાખલ કરો
•	 મૂળભતૂ ડોસ આદેશોનો ઉપયોગ કરો
•	 DIR આદેેશનોો ઉપયોોગ કરીીનેે ડિ�રેક્ટરીી સાામગ્રીીઓનીી સૂૂચિ� બનાાવોો
•	ડિ રેક્ટરી માળખું જુઓ.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક કાર્્યરત પીસી 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : DOS કમાન્્ડ પ્રોમ્્પ્્ટમાાં દાખલ કરો 

1	 વિન્્ડડોઝ 10 માાં, કમાન્્ડ પ્રોમ્્પ્્ટ લોન્ચ કરવાની સૌથી ઝડપી રીતોમાાંની 
એક છે શોધનો ઉપયોગ કરવો. તમારા ટાસ્કબારમાાંથી શોધ ક્ષેત્રની 
અંદર, આદેશ અથવા cmd દાખલ કરો (ફિગ 1) પછી, આદેશ પ્રોમ્્પ્્ટ 
પરિણામ પર ક્્લલિક કરો અથવા ટેપ કરો.

	અ થવા WIN+R          Type CMD નો ઉપયોગ કરીને RUN શરૂ કરો 
પછી Enter ક્્લલિક કરો.

2	 કમાાન્ડ પ્રોોમ્પ્ટ વિ�ન્ડોો સ્ક્રીીન પર પ્રદર્શિ�ત થાાય છેે (ફિ�ગ 2). 

નોોંધ: કમાન્્ડ પ્રોમ્્પ્્ટ કેસ સેન્્સસિટિવ નથી,  એટલે કે આદેશો 
મોટા અક્ષરો, લોઅરકેસ અથવા તેના કોઈપણ સંયોજન સાથે 
ટાઈપ કરી શકાય છે. આદેશ તારીખ અથવા DATE એ જ રીતે 
કામ કરશે.

Fig 1

Fig 1a

Fig 2

•	 DOS કમાન્્ડ પ્રોમ્્પ્્ટ સોફ્ટવેર	 - 1 No.
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કાર્્ય 2 : મૂળભતૂ DOS આદેશોનો ઉપયોગ કરો

નોોંધ: દરેક DOS આદેશ ફક્્ત DOS પ્રોમ્્પ્્ટ પર જ ટાઈપ કરવો 
જોઈએ અને તેને ચલાવવા માટે દરેક DOS આદેશના અતેં 
Enter કી દબાવવી જોઈએ.

a	વ ર્કકિંગ ડ્્ર રાઇવને C થી D માાં બદલો

1	પ્ર કાર D: DOS પ્રોમ્્પ્્ટ પર નીચે બતાવ્્યયા પ્રમાણે.

C:\Users\nimi> D:

નોોંધ: કીબોર્્ડ  પર એન્ટર કી દબાવવા માટેનું પ્રતીક છે. જ્યારે 
આપણે ખોટો DOS આદેશ દાખલ કરીએ છીએ, ત્યારે તે 
ખરાબ આદેશ અથવા ફાઇલનામ અથવા કેટલાક અન્ય ભૂલ 
સંદેશાઓ દર્શાવે છે (સંબંધિત થિયરી 1.5.01 માાં ચર્ચા કરવામાાં 
આવી છે). પરિણામ મેળવવા માટે આપણે ખોટા DOS આદેશને 
સુધારવો પડશે.

હવે પ્રોમ્્પ્્ટ C:\Users\nimi> થી D:\> માાં બદલાઈ ગયો છે અને હાલમાાં 
કાર્્યરત ડ્્ર રાઈવ C થી D માાં બદલાઈ ગઈ છે.

b	 સિસ્ટમ તારીખ જુઓ/બદલો

DATE આદેશનો ઉપયોગ સિસ્ટમની તારીખ જોવા/બદલવા માટે થાય છે.

D:\>DATE

2   તેે નીીચેે બતાાવ્યાા પ્રમાાણેે વર્તતમાાન તાારીીખ દર્શાાવેે છેે (ફિ�ગ 3).

3	 જો વર્તતમાાન તાારીીખ દર્શાાવવાામાંં આવીી નથીી, તોો નીીચેે આપેેલાા બોોક્સમાંં 
બતાાવ્યાા પ્રમાાણેે વર્તતમાાન તાારીીખ લખોો (ફિ�ગ 4). 

4	અ પડેટ કરવા માટે એન્ટર કી દબાવો. પ્રદર્શિત તારીખ રેકોર્્ડ  કરો. અને 
નવી અપડેટ કરેલી તારીખ.

c 	 સિસ્ટમનો સમય જુઓ/બદલો

TIME આદેશનો ઉપયોગ સિસ્ટમનો સમય જોવા/બદલવા માટે થાય છે.

D:\>TIME

1	 તેે નીીચેે બતાાવ્યાા પ્રમાાણેે વર્તતમાાન સમય દર્શાાવેે છેે (ફિ�ગ 5).

2 	 જો વર્તતમાાન સમય સાાચોો નથીી, તોો નીીચેે આપેેલાા બોોક્સમાંં બતાાવ્યાા 
પ્રમાાણેે વર્તતમાાન સમય ટાાઈપ કરોો (ફિ�ગ 6). 

3 	અ પડેટ કરવા માટે Enter કી દબાવો. પ્રદર્શિત સમય અને નવો અપડેટ 
કરેલ સમય રેકોર્્ડ  કરો.

d 	 સ્ક્રીન સાફ કરે છે

CLS આદેશનો ઉપયોગ સ્ક્રીનને સાફ કરવા માટે થાય છે.

D:\>CLS

પ્રદર્શિત સમાવિષ્્ટટો સાફ થાય છે અને DOS પ્રોમ્્પ્્ટ સ્ક્રીનના ઉપરના ડાબા 
ખૂણે દેખાય છે.

i	 માઇક્રોસોફ્ટ વિન્્ડડોઝ કમ્્પ્યયુટર્્સ માટે સંપૂર્્ણ સિસ્ટમ માહિતી 
પ્રદર્શિત કરુું  છંુ.

1 	ન ીચેનો આદેશ ટાઈપ કરો

D:\> SYSTEMINFO

2 	 તેે નીીચેે બતાાવ્યાા પ્રમાાણેે સંંપૂૂર્ણણ સિ�સ્ટમ માાહિ�તીી દર્શાાવેે છેે (ફિ�ગ 7)

Fig 3

Fig 4

Fig 7

Fig 6

Fig 5
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3	 આઉટપુટુ રેેકોોર્ડડ  કરોો.

j	 DOS સત્રમાાંથી બહાર નીકળો

EXIT આદેશનો ઉપયોગ DOS સત્રમાાંથી બહાર નીકળવા માટે થાય છે. 

1	ન ીચેનો આદેશ ટાઈપ કરો

D:\> EXIT

તે DOS સત્રમાાંથી બહાર નીકળે છે અને Windows OS પર પાછા ફરે છે

કાાર્યય 3 : DIR આદેેશનોો ઉપયોોગ કરીીનેે ડિ�રેક્ટરીી સાામગ્રીીઓનીી સૂૂચિ� બનાાવોો

DIR આદેશ ડિરેક્ટરીમાાં ફાઇલો અને ડિરેક્ટરીઓની સૂચિ દર્શાવે છે.

1	 DOS પ્રોમ્્પ્્ટ પર E: ટાઇપ કરીને E ડ્્ર રાઇવ પર બદલો.

2	ન ીચેનો આદેશ ટાઈપ કરો.

E:\> DIR

3	ત ે નીચે બતાવ્્યયા પ્રમાણે E ડ્્ર રાઇવની ફાઇલો અને ડિરેક્ટરીઓની યાદી 
દર્શાવે છે. (ફિગ 8)

4	ન ીચેનો આદેશ ટાઈપ કરો

E:\> DIR htmlnimi

5	ન ીચે બતાવ્્યયા પ્રમાણે E ડ્્ર રાઇવની HTMLNIMI ડિરેક્ટરીની ફાઇલો 
અને ડિરેક્ટરીઓની સૂચિ દર્શાવે છે. રેકોર્્ડ  કરો આઉટપુટ (ફિગ 9)

6 	ન ીચેનો આદેશ ટાઈપ કરો

નીચેનો આદેશ ટાઈપ કરો  DIR આદેશ સાથે માત્ર ઉલ્્લલેખિત 
ડ્્ર રાઇવ અથવા ડિરેક્ટરીની ડિરેક્ટરીઓ પ્રદર્શિત કરવા માટે 
થાય છે.

E:\> DIR/AD

7	ત ે નીચે બતાવ્્યયા પ્રમાણે માત્ર E ડ્્ર રાઇવની ડિરેક્ટરીઓ દર્શાવ છે. 
આઉટપુટ રેકોર્્ડ  કરો. (ફિગ 10)

8	ન ીચેનો આદેશ ટાઈપ કરો.

E:\> DIR H*.*

9	ત ે તમામ ફાઇલો અને ફોલ્્ડર્્સની યાદી આપે છે જ ેઅક્ષર H થી શરૂ 
થાય છે અને નીચે બતાવ્્યયા પ્રમાણે કોઈપણ એક્સ્્ટેંશન ધરાવે છે.  
(ફિગ 11)

10	ન ીચેનો આદેશ ટાઈપ કરો.

E:\> DIR ?????

11	ત ે તમામ ફાઇલો અને ફોલ્્ડર્્સની યાદી આપે છે જ ેનીચે બતાવ્્યયા પ્રમાણે 
કોઈપણ એક્સ્્ટેંશન વિના 5 અક્ષર  લાાંબા હોય છે.

નોોંધ:વાઇલ્્ડકાર્્ડડ્્સ સામાન્ય રીતે કાાં તો ફૂદડી (*), જ ે એક 
અથવા વધુ અક્ષરો અથવા પ્રશ્ન ચિહ્ન(?) દર્શાવે છે, જ ે એક 
અક્ષરનું પ્રતિનિધિત્્વ કરે છે.

Fig 8

Fig 9

Fig 10

Fig 11
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IT & ITES	 	 એકસરસાાઈઝ 1.5.23
કોપા (COPA) - DOS કમાન્્ડ લાઇન ઇન્ટરફેસ	

ડોસ આદેશોનો ઉપયોગ કરીને ફાઇલો અને ફોલ્્ડર્્સનું સંચાલન કરવું (Managing files and folders 
using dos commands)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 DOS આદેશોનો ઉપયોગ કરીને ફાઇલોનું સંચાલન કરો
•	 DOS આદેશોનો ઉપયોગ કરીને ડિરેક્ટરીઓનું સંચાલન કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : DOS આદેશોનો ઉપયોગ કરીને ફાઇલોનું સંચાલન કરો

•	 DOS કમાન્્ડ પ્રોમ્્પ્્ટ સોફ્ટવેર 	 - 1 No.

કમાન્્ડ પ્રોમ્્પ્્ટમાાં નીચનેા DOS આદેશોની પ્રેક્ટિસ કરો, આઉટપુટ રેકોર્્ડ  
કરો અને તેને પ્રશિક્ષક દ્વારા તપાસો:

નોોંધ : ફાઇલનું નામ 11 અક્ષરોથી વધુ ન હોવું જોઈએ જમેાાંથી 8 
અક્ષરો નામ માટે છે અને 3 અક્ષરો એક્સ્્ટેંશન માટે છે.

1 	 COPYCON lesson1.txt

•	ત ે લખાણ ફાઈલ lesson1.txt બનાવે છે (ફિગ 1)

3	 COPY lesson1.txt ex1.txt
•	ત ે ફિગ 3 માાં બતાવ્્યયા પ્રમાણે lesson1.txt ને ex1.txt પર કોપી 

કરે છે.
•	ફ ાઇલ ex1.txt યાદીમાાં છે તે તપાસવા માટે DIR આદેશનો 

ઉપયોગ કરો.

•	 ^Z (Ctrl Z) અથવા F6 નો ઉપયોગ ટેક્સ્ટ ફાઇલને સાચવવા 
માટે થાય છે.

2 	 TYPE lesson1.txt

•	ત ે ફિગ 2 માાં બતાવ્્યયા પ્રમાણે ટેક્સ્ટ ફાઇલ lesson1.txt ની 
સામગ્રી દર્શાવે છે.

5	 DEL notes.txt

•	ત  ફિગ 5 માાં બતાવ્્યયા પ્રમાણે notes.txt ફાઇલને કાઢી નાખે છે.

Fig 1

Fig 2

Fig 3

4	 REN ex1.txt notes.txt
•	ત  Fig.4 માાં બતાવ્્યયા પ્રમાણે ex1.txt ફાઇલને notes.txt તરીકે 

નામ આપે છે.
•	ફ ાઈલ ex1.txt નામ બદલીને notes.txt (ફિગ 4) છે તે તપાસવા 

માટે DIR આદેશનો ઉપયોગ કરો.

Fig 4
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6	 SORT lesson1.txt

•	ત  ફિગ 6 માાં બતાવ્્યયા પ્રમાણે ફાઈલ lesson1.txt ની સામગ્રીને 
સૉર્્ટ  કરે છે.

7	 FIND “SYS” lesson1.txt

•	ત ે ટેક્સ્ટ ફાઇલમાાં ટેક્સ્ટ સ્ટટ્રરિં ગ “SYS” માટે શોધે છે lesson1.
txt અને ટેક્સ્ટ ધરાવતી લીટી દર્શાવે છે સ્ટટ્રરિં ગ “SYS” ફિગ 7 માાં 
બતાવ્્યયા પ્રમાણે

	 FIND/n “SYS” lesson1.txt

Fig 5

Fig 6

Fig 7

Fig 8

Fig 9

8	 કૉપિ કરો અને ફાઇલોને એક ડિરેક્ટરીમાાંથી બીજી ડિરેક્ટરીમાાં 
ખસેડો.

એક અથવાા વધુુ ફાાઇલોોનેે સ્થાાનથીી બીીજા સ્થાાન પર કૉૉપિ� કરવાા માાટેે 
ઉપયોોગમાંં લેેવાાતાા COPY  આદેેશ. અહીંં આપણેે પુુસ્તકનીી નકલ કરીી 
છેે. txt ફાાઇલ C:\COPA થીી D:\CHNM સુુધીી. તેેથીી ડ્રાા� ઇવ પર CHNM 
ફોોલ્ડરમાંં ફાાઇલોોનીી યાાદીી કરતીી વખતેે Book.txt ફાાઇલ ઉપલબ્ધ છેે 
(ફિ�ગ 8). 

COPY C: |COPA|BOOK.TXTD:}CHNM

એક અથવાા વધુુ ફાાઇલોોનેે એક ડિ�રેક્ટરીીમાંંથીી બીીજી ડિ�રેક્ટરીીમાંં ખસેેડવાા 
માાટેે વપરાાતોો MOVE આદેેશ.

MOVE D: |CHNM|LOG.TXT C:|COPA

અહીંં આપણેે LOG.txt ફાાઇલનેે D:\CHNM માંંથીી C:\ COPA પર ખસેડીી 
છેે. તેેથીી ડ્રાા� ઇવ પર CHNM ફોોલ્ડરમાંં ફાાઇલોોનીી યાાદીી કરતીી વખતેે LOG.
txt ફાાઇલ ઉપલબ્ધ નથીી (ફિ�ગ 9). 

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.5.23

•	ય ાદીમાાં નોટ્સ.txt ફાઇલ ઉપલબ્ધ છે કે નહીીં તે તપાસવા માટે 
DIR આદેશનો ઉપયોગ કરો.
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કાાર્યય 2 : DOS આદેેશોોનોો ઉપયોોગ કરીીનેે ડિ�રેક્ટરીીઓ (ફોોલ્ડર્સસ) મેેનેેજ કરોો

કમાન્્ડ પ્રોમ્્પ્્ટમાાં નીચેના DOS આદેશોની પ્રેક્ટિસ કરો, આઉટપુટ રેકોર્્ડ  
કરો અને તેને પ્રશિક્ષક દ્વારા તપાસો:

1	 MD તાલીમ

•	ત ે ફિગ 10 માાં બતાવ્્યયા પ્રમાણે નવી ડિરેક્ટરી “તાલીમ” બનાવે છે

•	સૂ ૂચિ�માંં “તાાલીીમ” ડિ�રેક્ટરીી છેે તેે તપાાસવાા માાટેે DIR આદેેશનોો 
ઉપયોોગ કરોો (ફિ�ગ 10). 

2	 CD તાલીમ

•	ત ે વર્્તમાન નિર્દેશિકાને તાલીમમાાં બદલી નાખે છે અને તે ફિગ 11 માાં 
બતાવ્્યયા પ્રમાણે DOS પ્રોમ્્પ્્ટમાાં જોઈ શકાય છે.

•	 MD થિયરી

	ત  મુખ્ય ડિરેક્ટરી તાલીમમાાં નવી સબડિરેક્ટરી થિયરી બનાવે છે

•	 MD પ્રેક્ટિકલ

	ત  મુખ્ય ડિરેક્ટરી તાલીમમાાં એક નવી સબડિરેક્ટરી પ્રેક્ટિકલ બનાવે 
છે

•	 ફિગ 12 માાં બતાવ્્યયા પ્રમાણે નવી સબડિરેક્ટરીઝ થિયરી અને પ્રેક્ટિકલ 
મુખ્ય ડિરેક્ટરી તાલીમમાાં સૂચિબદ્ધ છે તે તપાસવા માટે DIR આદેશનો 
ઉપયોગ કરો

•	 CD પ્રેક્ટિકલ

• 	 તેે વર્તતમાાન કાાર્યયકાારીી નિ�ર્દેેશિ�કાાનેે આકૃૃતિ� 13 માંં બતાાવ્યાા પ્રમાાણેે 
પ્રેેક્ટિ�કલમાંં બદલેે છેે

•	 CD.

•	ત  વર્્તમાન કાર્્યકારી સબડિરેક્ટરી પ્રેક્ટિકલમાાંથી બહાર નીકળે છે 
અને ફિગ 14 માાં બતાવ્્યયા પ્રમાણે મુખ્ય ડિરેક્ટરી તાલીમમાાં જાય છે.

•	 CD થિયરી

	ત ે ફિગ 15 માાં બતાવ્્યયા પ્રમાણે વર્્તમાન કાર્્યકારી નિર્દેશિકાને થિયરીમાાં 
બદલે છે

•	 CD\

	ત  તમામ ડિરેક્ટરીઓ થીયરી અને તાલીમમાાંથી બહાર નીકળી જાય છે 
અને રુટ ડિરેક્ટરી E:\ પર જાય છે જમે કે ફિગ 15 માાં બતાવ્્યયા પ્રમાણે

4	 RD તાલીમ

•	 RD આદેશ ફક્્ત ખાલી ડિરેક્ટરીને દૂર કરે છે. તેથી પ્રથમ વસ્્તતુ એ છે કે 
ડિરેક્ટરી તાલીમની અંદરની બધી ફાઇલો અને ડિરેક્ટરીઓ દૂર કરવી.

•	 CD તાલીમ

	ત  વર્્તમાન કાર્્યકારી નિર્દેશિકાને તાલીમમાાં બદલે છે (ફિગ 16)

•	 RD થિયરી

	ત  ખાલી સબડિરેક્ટરી થિયરીને દૂર કરે છે (ફિગ 16)

Fig 10

Fig 11

Fig 12

Fig 13

Fig 14

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.5.23
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કાર્્ય 3 : આપેલ ડિરેક્ટરી સ્ટટ્રક્્ચર બનાવો (ફિગ 17)

	 E:\>MAINDIR1

		  <Subdir1>

		  <Subdir2>

 			   File1
	 |<Subdir3>

•	ડિ રેક્ટરી MAINDIR1 (ફિગ 17) ની ડિરેક્ટરી માળખું જોવા માટે 
TREE આદેશનો ઉપયોગ કરો

	 MD MAINDIR1	 -	 Creates MAINDIR1

	 CD MAINDIR1	 -	 Enters into directory

			   MAINDIR1

	 MD Subdir1	 -	 Creates Subdir1

	 MD Subdir2	 -	 Creates Subdir2

	 CD Subdir2	 -	 Enters into Subdir2

	 COPY CON File1	 -	 Creates the file File1

	 ^Z	 -	 Saves the file File1

	 MD Subdir3	 -	 Creates Subdir3

	 CD\	 -	 Exits all subdirectory and 	
		  goes to root directory E:

Fig 15

Fig 17

Fig 16

Fig 18

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.5.23

•	 RD પ્રેક્ટિકલ

	ત  ખાલી સબડિરેક્ટરી પ્રેક્ટિકલ દૂર કરે છે (ફિગ 16)

•	 CD.

	ત  વર્્તમાન કાર્્યકારી નિર્દેશિકા તાલીમમાાંથી બહાર નીકળે છે અને 
E:\&gt; પર જાય છે (ફિગ 16)

•	 DIR (ડિરેક્ટરી) તાલીમની ઉપલબ્ધતા તપાસવા માટે DIR આદેશનો 
ઉપયોગ કરો (ફિગ 16)

	 આપેલ ડિરેક્ટરી માળખું બનાવવા માટે આદેશ ક્રમ અને તે ફિગ 18 માાં 
દર્શાવેલ છે.
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IT & ITES	 	 એકસરસાાઈઝ 1.6.24
કોપા (COPA) - ઉબુન્ટુ લિનક્સ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો અને મૂળભતૂ લિનક્સ કમાન્્ડ ચલાવો	

ઉબુન્ટુ લિનક્સ ઑપરેટિિંગ સિસ્ટમનું ઇન્સ્ટોલશેન (Installation of ubuntu linux operating 
system)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ઉબુન્ટુ લિનક્સ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એ વર્કકિંગ પીસી  	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ઉબુન્ટુ લિનક્સ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરી રહ્્યુું છે 

1	 1 https://ubuntu.com/ પરથી ઉબુન્ટુ 22.04.1 ubuntu-
22.04.1-desktop amd64.iso ડાઉનલોડ કરો DVD માાં બર્્ન કરો  
અને DVD ROM ડ્્ર રાઇવ પર DVD દાખલ કરો, બદલો તે મુજબ બુટ 
ક્રમ, જથેી તે DVD ROM પ્રથમ બુટ કરી શકો છો

(અથવાા)

	 Ubuntu ISO ને USB ફ્્લલેશમાાં લોડ કરો,  બુટ કરવા માટે પ્રથમ 
યુએસબી માસ સ્ટોરેજ અનુસાર. બૂટ ક્રમ બદલો

2	 ભાષા પસંદ કરો અને ફિગ 1 મુજબ એન્ટર દબાવો.

3	 ફિગ 2 મુજબ ઉબુન્ટુ ઇન્સ્ટોલ કરો પસંદ કરો.

આ ફિગ 3 ની જમે સ્ક્રીન શરૂ થઈ રહી છે, તે એક મિનિટમાાં 
અદૃશ્્ય થઈ જશે.

થોડી સકંેડ પછી નીચેની સ્ક્રીન ફિગ 4 પર દેખાશે.

Fig 1

Fig 2

Fig 3

•	 ઉબુન્ટુ 22.04.1 / નવીનતમ Linux OS	 - 1 No.
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4	 ભાષા પસંદ કરો અને ફિગ 4 મુજબ ચાલુ રાખો ક્્લલિક કરો.

5	 ઉબુન્ટુ સ્ક્રીન ઇન્સ્ટોલ કરવાની તૈયારી પર આગળ ક્્લલિક કરો.

6	ડિ સ્કને ભૂંસી નાખો અને ઉબુન્ટુ ઇન્સ્ટોલ કરો (એટલે કે તે આને ફોર્મેટ 
કરશે સમગ્ર ડ્્ર રાઇવ અને OS ઇન્સ્ટોલ કરો). જો તમને પાર્ટીશનીીંગ સ્કીમ 
વિશે કોઈ ખ્યાલ ન હોય તો ફક્્ત ફિગ 5 મુજબ ચાલુ રાખો પર ક્્લલિક 
કરો.

7	 એકવાર ચાલુ પર ક્્લલિક કર્યા પછી, તમને સ્્વતઃ પાર્ટીશનની પુષ્્ટટિ 
કરવા માટે કહેવામાાં આવશે.   ફિગ 6 મુજબ આગળ વધવા માટે ચાલુ 
રાખો પર ક્્લલિક કરો.

એકવાર ક્્લલિક કર્યા પછી, તમને નીચેનું પૃષ્્ઠ મળશે જ્યયાં 
ઇન્સ્ટોલર ઉપલબ્ધ હાર્્ડ  ડિસ્કની સૂચિ આપે છે.આ કિસ્્સસામાાં 
પાર્ટીશન બનાવવા માટે મારી પાસે 20GB ની એક હાર્્ડ ડિસ્ક છે; 
નવા પાર્ટીશન પર ક્્લલિક કરો ખાલી પાર્ટીશન બનાવવા માટેનું 
કોષ્્ટક કારણ કે આ નવી હાર્્ડ  ડિસ્ક છે. પોપ અપ તમને પુષ્્ટટિ 
કરવા માટે પછૂશે, ફિગ 7 પર ચાલુ રાખો પર ક્્લલિક કરો.

Fig 4

Fig 5

Fig 6

Fig 7

Partition scheme will be like below:

/boot - 100MB 

swap - 2048MB (2 x RAM size)

/ - Remaining (19GB)

8 	ખ ાલી જગ્્યયા પસંદ કરો અને તળિયે + ચિહ્ન પર ક્્લલિક કરો પાર્ટીશનો 
બનાવો. ફિગ 8 મુજબ /boot પાર્ટીશન માટે નીચેના બતાવે છે.

Fig 8
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9	 સ્્વવેપ પાર્ટીશન માટે અનુસરીને, ખાતરી કરો કે તમે પસંદ કર્્યુું છે સ્્વવેપ 
એરિયા તરીકે ઉપયોગ કરો અને ફિગ 9માાં ઓકે ક્્લલિક કરો

10	 ફિગ 10 મુજબ / (રુટ) પાર્ટીશન માટે અનુસરો.

11 પાર્ટીશનોની સમીક્ષા કરો અને હવે ઇન્સ્ટોલ કરો પર ક્્લલિક કરો ફિગ 11.

12	 ફિગ 12 મુજબ પાર્ટીશન યોજનાની પુષ્્ટટિ કરો

13	 સ્થાન પસંદ કરો.

14	 ફિગ 13 મુજબ કીબોર્્ડ  લેઆઉટ પસંદ કરો.

જો તમને ખાતરી ન હોય તો, ડિટક્ટ કીબોર્્ડ  લેઆઉટ વિકલ્્પનો 
ઉપયોગ કરો અને તમે ટેસ્ટ ટેક્સ્ટ બોક્સમાાં ટાઈપ કરીને 
તમારી પસંદગીને પણ ચકાસી શકો છો.

અંતિમ સ્ક્રીનમાાં તમને સિસ્ટમ પર બનાવવામાાં આવનાર પ્રથમ 
વપરાશકર્તા વિશે માહિતી દાખલ કરવા માટે સકેંત આપવામાાં 
આવશે. ફિગ 14 મુજબ આ સ્ક્રીનમાાં તમારી માહિતી દાખલ 
કરો.

અહીીં એક વસ્્તતુ તમારે યાદ રાખવી જોઈએ - જો ‘આપમેળે લોગ 
ઇન કરો’ પસંદ કરો, તો તે તમને ક્યારેય પણ પ્રમાણીકરણ માટે 
તમારો પાસવર્્ડ  પછૂશે નહીીં જ્યારે ઉબુન્ટુ સિસ્ટમમાાં લૉગ ઇન 
કરવાનો પ્રયાસ કરો. જો તમે ઇન્સ્ટોલશેન માટે ખૂબ જ સુરક્ષિત 
પાસવર્્ડ  આપો તો તે શ્રેષ્્ઠ છે. ઉબુન્ટુ જાણ કરશે કે શું પાસવર્્ડ  
સુરક્ષિત છ કે નહી.

Fig 9

Fig 10

Fig 11

Fig 12

Fig 13
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જો તમે ‘એન્ક્રિપ્્ટ માય હોમ ફોલ્્ડર’ પસંદ કરો છો, તો તે 
તમારામાાંની બધી ફાઇલો અને ફોલ્્ડર્્સ બનાવશે હોમ ફોલ્્ડર 
અનધિકૃત જોવાથી વધુ સુરક્ષિત જો તમારી પાસે બહુવિધ 
વપરાશકર્તાઓ હોય તો તમારા કમ્્પ્યયુટર જ્યારે તમે તમારા 
કોમ્્પ્યયુટરમાાં લોગ ઇન કરો છો ત્યારે તમારી ફાઈલો સીમલેસલી 
ડિક્રિપ્્ટ થાય છે તમારુું  સત્ર. જો તમને ખાતરી ન હોય, તો આ 
બોક્સને અનચકે કર્યા વગર છોડી દો.

15	 એકવાર ઇન્સ્ટોલશેન સમાપ્્ત થઈ જાય, ફિગ 15 ની જમે હવે પુનઃપ્રારંભ 
કરો પર ક્્લલિક કરો.

16	 એકવાર મશીન પુનઃપ્રારંભ થાય, લોગિન વિન્્ડડો લોગીન વિન્્ડડો ફિગ 
16 પ્રમાણે હશે. પર પાસવર્્ડ  ટાઈપ કરો વપરાશકર્તા નામની નીચે અને 
એન્ટર દબાવો

ઉબુન્ટુ 14.10 નું ડેસ્કટોપ ફિગ 17 ની જમે નીચે હશે.

17	તમ ારા પ્રશિક્ષક સાથે તેની તપાસ કરાવો.

Fig 14

Fig 15

Fig 16

Fig 17
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IT & ITES	 	 એકસરસાાઈઝ 1.6.25
કોપા (COPA) - ઉબુન્ટુ લિનક્સ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો અને મૂળભતૂ લિનક્સ કમાન્્ડ ચલાવો	

લિનક્સમાાં જરૂરી એપ્્લલિકેશન સોફ્ટવેર ઇન્સ્ટોલ કરો (Install necessary application software in 
Linux)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	લિ� નક્સ OS માંં એડોોબ રીીડર ઇન્સ્ટોોલ કરોો
•	 લિનક્સ OS માાં VLC મીડિયા પ્્લલેયર ઇન્સ્ટોલ કરો
•	લિ� નક્સ OS માંં લીીનક્સ ઓફીીસ ઇન્સ્ટોોલ કરોો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક વર્કકિંગ પીસી  	 - 1 No.
•	 ઉબુન્ટુ 22.04.1 / નવીનતમ લિનક્સ OS 	 - 1 No.
•	 એડોબ રીડર લિનક્સ સપોર્ટેડ 	 - 1 No.

•	 VLS મીડિયા પ્્લલેયર લિનક્સ સપોર્ટેડ  	 - 1 No.
•	 લીબરઓફીસ લિનક્સ સપોર્ટેડ 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : લિનક્સ ઓએસમાાં એડોબ રીડર ઇન્સ્ટોલ કરો

1	 કીબોર્્ડ  પર Ctrl+Alt+T દબાવીને ટર્મિનલ ખોલો.

2	 આદેેશ sudo add-apt-repository “deb ચલાાવોો http://
archive.canonical.com/ ચોોક્કસ ભાાગીીદાાર”

3	 જ્યાારેે તેે પૂૂછેે ત્યાારેે વપરાાશકર્તાા પાાસવર્ડડ  લખોો.

નોંંધ: કેે જ્યાારેે તમેે કોોઈ દ્રશ્ય પ્રતિ�સાાદ નથીી પાાસવર્ડડ  ટાાઇપ 
કરીી રહ્યાા છીીએ.

4	 sudo apt-get update આદેેશ ચલાાવીીનેે પેેકેેજ સૂચૂિ�ઓનેે અપડેેટ 
કરોો

5	 sudo apt-get install acroread આદેેશ ચલાાવીીનેે એક્રોોરેેડ પેેકેેજ 
ઇન્સ્ટોોલ કરોો.

6	 ચલાાવીીનેે કેેનોોનિ�કલ પાાર્ટટનર્સસ રિ�પોોઝીીટરીી દૂૂર કરોો આદેેશ sudo 
add-apt-repository -r “deb http://archive.canonical.com 
ચોોક્કસ ભાાગીીદાાર”

7 	 આદેેશ sudo apt-get અપડેેટ ચલાાવોો
8	 આદેેશ sudo gedit /etc/gnome/ default ચલાાવોો. એડોોબ 

રીીડરનેે ડિ�ફોોલ્ટ પીીડીીએફ રીીડર તરીીકેે સેેટ કરવાા માાટેેનીી સૂચૂિ�
9	શો ોધોો અનેે લાાઇન એપ્લિ��કેશન/ pdf=evince બદલોો. ડેેસ્કટોોપ અનેે 

એપ્લિ��કેશન/ pdf=acroread.desktop

અનેે અંતંમાંં નીીચેેનીી લીીટીી ઉમેરેોો 

	 application/fdf=acroread.desktop 

	 application/xdp=acroread.desktop 

	 application/xfdf=acroread.desktop 

	 application/pdx=acroread.desktop

10	ફા ાઇલનેે સાાચવોો અને આદેેશ દ્વાારાા નોોટિ�લસનેે પુુનઃઃપ્રાારંંભ કરોો ફેેરફાારોો 
લાાગુુ કરવાા માાટેે ટર્મિ�નલમાંં nautilus -q.

કાાર્યય 2 : linux OS માંં VLC મીીડિ�યાા પ્લેેયર ઇન્સ્ટોોલ કોો

1	કીીબો ોર્ડડ  પર Ctrl+Alt+T દબાાવીીનેે ટર્મિ�નલ ખોોલોો.

2	તા ાજુંં�  કરવાા માાટેે sudo apt-get update આદેેશ ચલાાવોો સોોફ્ટવેેર 
રીીપોોઝીીટરીી કેેટલોોગ

3	 VLC મીડિયા પ્્લલેયર ઇન્સ્ટોલ કરવા માટે sudo apt-get install vlc 
આદેશ ચલાવો

4	 જ્યાારેે ‘શુંં� તમેે ચાાલુુ રાાખવાા માંંગોો છોો’ સાાથેે પૂૂછવાામાંં આવેે છેે કીીબોોર્ડડ  
પર ‘Y’ દબાાવોો.

5	સુ ુડોો આદેેશ ચલાાવીીનેે એક્રોોરેેડ પેેકેેજ ઇન્સ્ટોોલ કરોો apt-get install 
acroread

6	 sudoadd-apt repository -r “deb http://archive.cano 
nical.com/precise partner” આદેેશ ચલાાવીીનેે કેેનોોનિ�કલ 
પાાર્ટટનર્સસ રિ�પોોઝીીટરીીનેે દૂૂર કરોો

7	 આદેેશ sudo apt-get અપડેેટ ચલાાવોો.
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કાાર્યય 3 : લિ�નક્સ ઓએસ પર લિ�બરઓફિ�સ ઇન્સ્ટોોલ કરોો

1	કીીબો ોર્ડડ  પર Alt+F2 દબાાવીીનેે એપ્લિ��કેશન ચલાાવોો સંંવાાદ ખોોલોો.

2	 ચલાાવોો એપ્લિ��કેશન ડાાયલોોગ (ફિ�ગ 1) માંં glsu ઉમેરેોો apt-
repository ppa:libreoffice/ppa ચલાાવોો

3	 જ્યાારેે પૂૂછવાામાંં આવેે ત્યાારેે પાાસવર્ડડ  દાાખલ કરોો અનેે ઓકેે બટન 
દબાાવોો

4	 ALT+F2 કીી સંંયોોજનનેે ફરીીથીી દબાાવોો અનેે ચલાાવોો આદેેશ gksu 
apt-get update in “Run Application” સંંવાાદ (ફિ�ગ 2).

5	 જ્યાારેે પૂૂછવાામાંં આવેે ત્યાારેે પાાસવર્ડડ  દાાખલ કરોો અનેે ઓકેે બટન 
દબાાવોો

6	ફરી ીથીી ALT+F2 કીી સંંયોોજનનેે હિ�ટ કરોો અનેે “Run Application” 
સંંવાાદમાંં sudo apt-get install libreoffice libreoffice gnome 
language-support en આદેેશ ચલાાવોો (ફિ�ગ 3). 

7	જ્યા રે ટર્મિનલ વિન્્ડડો દેખાશે અને પૂછવામાાં આવશે ત્યારે પાસવર્્ડ  
દાખલ કરો.

8	 Y ટાાઈપ કરોો અનેે Enter દબાાવોો, ક્યાારેે પૂૂછવાામાંં આવશેે કેે શુંં� તમેે 
LibreOffice પેેકેેજ ઇન્સ્ટોોલ કરવાા માંંગોો છોો (ફિ�ગ 4). 

9 	લી ીબરઓફીીસ સંંપૂૂર્ણણપણેે સ્થાાપિ�ત નથીી અનેે ઉપયોોગ માાટેે તૈૈયાાર છેે 
(ફિ�ગ 5). 

Fig 1

Fig 2

Fig 3

Fig 5

Fig 4

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.6.25
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IT & ITES	 	 એકસરસાાઈઝ 1.6.26
કોપા (COPA) - ઉબુન્ટુ લિનક્સ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો અને મૂળભતૂ લિનક્સ કમાન્્ડ ચલાવો	

ડિરેક્ટરી લિસ્ટટિંગ ફાઇલ, ફોલ્્ડર મેનેજમેન્ટ, માટે મૂળભતૂ Linux આદેશોનો ઉપયોગ કરો (Use basic 
Linux commands for directory listing File, Folder management, Password etc.,)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ls આદેશ સાથે ડિરેક્ટરીઓની યાદી બનાવો
•	 બિલાડી કમાન્્ડ સાથે ફાઈલોની યાદી બનાવો અને ભેગા કરો
•	 સીડી આદેશ સાથે ડિરેક્ટરીઓ પર જાઓ
•	 Find, where and locate આદેશ સાથે ફાઇલો શોધો
•	 વિવિધ આદેશોનો ઉપયોગ કરીને ફાઇલો અને ડિરેક્ટરીઓનું સંચાલન કરો
•	 વપરાશકર્તા સ્્તરના આદેશોને હેન્્ડલ કરો અને પરવાનગીઓ બદલો.

	 જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક વર્કકિંગ પીસી 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાાર્યય 1 : ls આદેેશ સાાથેે ડિ�રેક્ટરીીઓનીી યાાદીી કરવીી

1	 કન્્સસોલ વિન્્ડડો ખોલો.

2	 ls લખો અને એન્ટર દબાવો.

3	 સ્ક્રીન પરના આઉટપુટનું અવલોકન કરો. આઉટપુટ ફિગ 1 માાં બતાવ્્યયા 
પ્રમાણે હશે.

4	ફ ાઇલો તેમજ ડિરેક્ટરીઓની યાદી બનાવવા માટે જ ેચોક્કસ કાર્્યકારી 
નિર્દેશિકામાાં રાખવામાાં આવે છે તે પ્રકાર ls -l. આઉટપુટ ફિગ 2 માાં 
દર્શાવવામાાં આવશે.

5	 કન્્સસોલ વિન્્ડડોમાાં નીચેનો આદેશ ટાઈપ કરો.

	 $ છે -la

6 	 કન્્સસોલ વિન્્ડડોમાાં ls -l આદેશ ટાઈપ કરો અને આઉટપુટનું અવલોકન 
કરો. આઉટપુટ વિન્્ડડો ફિગ 4 મુજબ પ્રદર્શિત થશે.

Fig 1

Fig 2

Fig 3

Fig 4

•	 ઉબુન્ટુ 22.04.1 / નવીનતમ Linux OS 	 - 1 No.

	 આઉટપુટ વિન્્ડડો ફિગ 3 માાં દર્શાવશે
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7 	 કન્્સસોલ વિન્્ડડોમાાં પ્રકાર છે. આઉટપુટ વિન્્ડડો ફિગ 5 મુજબ પ્રદર્શિત 
થશે.

કન્્સસોલ વિન્્ડડોમાાં નીચેના આદેશો અજમાવો, વર્્ણન લખો અને પ્રશિક્ષકની 
મદદથી રેકોર્્ડ  શીટમાાં આઉટપુટ સ્ક્રીનને અવલોકન કરો.

	 Commands		  Description

	       ls /usr  	

	      ls -R /  	

	      ls -Rd  /*/*/*  	

	      dir 	

	      Vdir	

કાાર્યય 2 : cat કમાાન્ડ અનેે રીીડાાયરેક્ટ સાાથેે ફાાઇલોોનેે સાંંભળવીી અનેે સંંયોોજિ�ત કરવીી.

1 	 કન્્સસોલ વિન્્ડડોમાાં નીચનેો આદેશ ટાઈપ કરો અને ફિગ 7 માાં બતાવ્્યયા 
પ્રમાણે નવી ટેક્સ્ટ ફાઈલ બનાવવા માટે આદેશ હેઠળ લખાણ લખો.

	 $ cat > samplefile1.txt

	 ઉબુન્ટુ લિનક્સમાાં આપનું સ્્વવાગત છે

	 આ cat આદેશનો ઉપયોગ કરીને નમૂના ફાઇલ છે

	 ICTSM વિષયનો આનંદ માણો

	 આઉટપુટ વિન્્ડડો ફિગ 7 પર દેખાશે

2	ફ ાઇલની સામગ્રી પ્રદર્શિત કરવા માટે ફાઇલનામ પછી cat આદેશ 
ટાઇપ કરો.

	 $ cat samplefile1.txt

	 ઉબુન્ટુ લિનક્સમાાં સ્્વવાગત છે

	 આ cat આદેશનો ઉપયોગ કરીને નમૂના ફાઇલ છે

	 ICTSM વિષયનો આનંદ માણો

	 આઉટપુટ વિન્્ડડો ફિગ 8 પર દેખાશે.

3 	 કન્્સસોલ વિન્્ડડોમાાં cat -n કમાન્્ડ ટાઈપ કરો અને પછી ફાઈલ કન્ટેન્ટમાાં 
ડિસ્્પ્લલે લાઈન નંબર્્સ માટે ફાઈલ નામ લખો. આઉટપુટ વિન્્ડડો ફિગ 9 
પર દેખાશે.

	 $ cat -n samplefile1.txt

કન્્સસોલ વિન્્ડડોમાાં નીચેના આદેશો અજમાવો, વર્્ણન લખો અન પ્રશિક્ષકની 
મદદથી રેકોર્્ડ  શીટમાાં આઉટપુટ સ્ક્રીનને અવલોકન કરો.

Fig 5

Fig 6

Fig 7

Fig 8

Fig 9

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.6.26

8	 કન્્સસોલ વિન્્ડડોમાાં ls -x આદેશ ટાઈપ કરો. આઉટપુટ વિન્્ડડો ફિગ 6 માાં 
દેખાશે.
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	  Commands		  Description

	  cat -n samplefile1 samplefile2
              (or)
	 cat  -n samplef*	
	 $cat sample* > samplefile3.txt	
	 $cat samplefile1.txt>>samplefile2.txt	
	 $ wc samplefile1.txt

કાાર્યય 3 : સીીડીી કમાાન્ડ સાાથેે ડિ�રેક્ટરીીઓમાંં ખસેેડવુંં�

1 	 કર્્સર /usr/bin ડિરેક્ટરીને ખસેડવા માટે આદેશ વિન્્ડડોમાાં cd /usr/
bin આદેશ લખો. આઉટપુટ વિન્્ડડો ફિગ 10 પર દેખાશે

2 	 કન્્સસોલ વિન્્ડડોમાાં cd લખો.. પહેલાની ડિરેક્ટરીમાાં એક સ્ટેજ ઉપર જવા 
માટે આદેશ. આઉટપુટ સ્ક્રીનનું અવલોકન કરો. આઉટપુટ વિન્્ડડો ફિગ 
11 પર દેખાશે.

3	 રૂટ ડિરેક્ટરીને ખસેડવા માટે કન્્સસોલ વિન્્ડડોમાાં cd ../.. આદેશ ટાઈપ 
કરો. આઉટપુટ વિન્્ડડો ફિગ 12 માાં પ્રદર્શિત થશે.

4	 કન્્સસોલમાાં cd ~ (અથવા) cd આદેશ ટાઈપ કરો. બ્્લિિંકિિંગ કર્્સરને હોમ 
ડિરેક્ટરીમાાં પાછા જવા માટે. આઉટપુટ વિન્્ડડો ફિગ 13 પર દેખાશે.

5	પ્રિન્ટ  વર્કકિંગ ડિરેક્ટરી માટે કન્્સસોલ વિન્્ડડોમાાં pwd આદેશ ટાઈપ કરો. 
અને આઉટપુટ વિન્્ડડોને અવલોકન કરો. અને તમારા પ્રશિક્ષક સાથે 
તેની ચકાસણી કરો

કાાર્યય 4 : ફાાઇન્ડ, વે્હેર અનેે લોોકેેટ આદેેશ સાાથેે ફાાઇલોો શોોધોો

Grep આદેશ

1	ન ીચે બતાવ્્યયા પ્રમાણે cat આદેશનો ઉપયોગ કરીને ફાઇલ બનાવો

	 UNIX અને Linux ઓપરેટિિંગ સિસ્ટમ 

	 Linux ઓપરેટિિંગ સિસ્ટમ

2	ન ીચે બતાવ્્યયા પ્રમાણે ચોક્કસ શબ્દ શોધવા માટે grep આદેશ ટાઈપ 
કરો.

	 $ grep UNIX example.txt

	 આઉટપટુ નીચે પ્રમાણે દેખાશે. 

	 UNIX ઓપરેટિિંગ સિસ્ટમ

	 UNIX અને Linux ઓપરેટિિંગ સિસ્ટમ

3	 ઉદાહરણ તરીકે નીચે grep આદેશમાાં બતાવ્્યયા પ્રમાણે મેચિિંગ શબ્દને 
બાકાત રાખવા માટે વિકલ્્પ -v સાથે બીજો grep આદેશ ટાઈપ કરો.

	 $ cat example.txt 

	 UNIX ઓપરેટિિંગ સિસ્ટમ

Fig 10

Fig 11

Fig 12

Fig 13

Fig 14

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.6.26

© NIMI 

NOT TO BE REPUBLISHED



70

	 $ grep UNIX example.txt 

	 આઉટપટુ નીચે પ્રમાણે દેખાશે.

	 UNIX ઓપરેટિિંગ સિસ્ટમ

4	 કેટલીક વિશષેતાઓ સાથે grep આદેશ અજમાવો અને પ્રશિક્ષકની 
મદદથી આઉટપુટ તપાસો.

5	 કન્્સસોલમાાં નીચેનું ઉદાહરણ ટાઈપ કરો અને તમારા પ્રશિક્ષકની મદદથી 
આઉટપુટ રેકોર્્ડ  કરો

	 $ cat testfile.txt 

	 a

	 b 

	 c 

	 d

	 $ grep -v -e “a” -e “b” -e “c” testfile.txt

6	ન ીચેના બોક્સમાાં વર્્ણન સાથે આઉટપુટ લખો.

	 Commands	 Description

	 grep -c UNIX example.txt 

	 grep -v -c testfile.txt 

	 grep -l “hai” testfile*

7	 પ્રકાર જ્યયાં કમાન્્ડ અનુસરે છે અને બીજો આદેશ. તે બતાવશે કે આદેશ 
જ્યયાં તે સ્થિત છે. આઉટપુટ વિન્્ડડો ફિગ 15 પર દેખાશે

8	 કન્્સસોલ વિન્્ડડોમાાં સ્થિત આદેશ ટાઈપ કરો. આઉટપુટ વિન્્ડડો ફિગ 16 
માાં દેખાશે.

9	 ચોક્કસ આદેશનો સારાાંશ મેળવવા માટે, કન્્સસોલ વિન્્ડડોમાાં શું છે તે 
ટાઈપ કરો જ ેઆઉટપુટ વિન્્ડડો ફિગ 17 પર દર્શાવશે.

કાાર્યય 5 : વિ�વિ�ધ આદેેશોોનોો ઉપયોોગ કરીીનેે ફાાઇલોો અનેે ડિ�રેક્ટરીીઓનુંં� સંંચાાલન કરોો

1	 કન્્સસોલ વિન્્ડડો ખોલો.

2	 કન્્સસોલમાાં ટચ કમાન્્ડ ટાઈપ કરો.

3	 આઉટપુટનું અવલોકન કરો. ફિગ 18 પ્રમાણે આઉટપુટ વિન્્ડડો.

4	 ઉદાહરણ તરીકે ફાઇલ રીમૂવ કરવાનો ઉપયોગ કરવા માટે કન્્સસોલ 
વિન્્ડડોમાાં rm આદેશ લખો.

	 $ rm testfile1.txt

5	 વધારાના લક્ષણો સાથે કન્્સસોલ વિન્્ડડોમાાં rm આદેશ અજમાવો અને 
સ્ક્રીનશોટ સાથે આઉટપુટ રેકોર્્ડ  કરો.

6	ન વી ડિરેક્ટરી બનાવવા માટે કન્્સસોલ વિન્્ડડોમાાં ડિરેક્ટરી નામ પછી 
mkdir આદેશ ટાઈપ કરો દાખ્્લલા તરીકે:-

	 $ mkdir કોમ્્પ્યયુટર

7	ડિ રેક્ટરી નામ સાથે વિવિધ લક્ષણો દ્વારા અનુસરવામાાં આવેલ mkdir 
આદેશનો પ્રયાસ કરો.

	 Command	 Description

	 mkdir memos letters email

	 mkdir -p /home/joe/customer/babu	

Fig 15

Fig 16

Fig 17

Fig 18
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8	 કન્્સસોલ વિન્્ડડોમાાં rmdir લખો અને દાખલા તરીકે ખાલી ડિરેક્ટરી દૂર 
કરવા માટે ડાયરેક્ટરી નામનો ઉપયોગ કરો.

	 $ rmdir dirname

	 Command	 Description

	 rmdir -p dir1/dir2/dir3

	 rmdir dir1/dir2/dir3 dir1/dir2 dir1 

	 rm -rf dirname	

9	 એક ફાઇલ અથવા ડિરેક્ટરીને એક જગ્્યયાએથી બીજી જગ્્યયાએ 
ખસેડવા માટે કન્્સસોલ વિન્્ડડોમાાં mv આદેશ ટાઈપ કરો, તેનો ઉપયોગ 
ઉદાહરણ માટે ડિરેક્ટરી અથવા ફાઇલનું નામ બદલવા માટે પણ થાય 
છે.

	 $ mv oldfilename newfilename (to change the file name) 

10 કેટલાક લક્ષણો સાથે mv આદેશનો પ્રયાસ કરો.

	 Command	 Description

	 mv foo /tmp

	 mv foo /tmp/joe mv /tmp/foo 				  
	 . mv /tmp/foo ~

	 mv /tmp/foo ~/dir1

	 mv foo1 foo2 foo3 dir1 				  
	 mv foo[123] dir1

	 mv foo* dir1

	 mv dir1 dir2

11	 ઉદાહરણ તરીકે ગતંવ્્ય નિર્દેશિકામાાં ફાઇલની નકલ કરવા માટે 
કન્્સસોલ વિન્્ડડોમાાં cp આદેશ લખો.

	 $ cp /home/fruits/mango.txt /root/abcd

12	અ મુક વિશષતાઓ સાથે cp આદેશનો પ્રયાસ કરો અને પ્રશિક્ષક સાથે 
તપાસ કરો.

	 Command	 Description

	 cp chapter1 /tmp 

	 cp chapter1…

	 cp file1 file2 file3 /tmp 

	 cp -r foo /tmp

	 cp /tmp/foo ~/dir1

	 cp foo1 foo2 foo3 dir1 

	 cp foo[123] dir1

	 cp foo* dir1 

	 cp -r dir1 dir2

કાાર્યય 6 : વપરાાશકર્તાા સ્તરનાા આદેેશોોનેે હેેન્ડલ કરોો અનેે પરવાાનગીીઓ બદલોો.

વપરાશકર્તા ઉમેરો - નવો વપરાશકર્તા બનાવવા માટે

1	 કન્્સસોલ વિન્્ડડોમાાં useradd આદેશ લખો અને ઉદાહરણ તરીકે 
આઉટપુટ રેકોર્્ડ  કરો.

	 $ useradd username

2	 ઉદાહરણ તરીકે લિનક્સમાાંથી વપરાશકર્તાને દૂર કરવા માટે કન્્સસોલ 
વિન્્ડડોમાાં યુઝરડેલ અને વપરાશકર્તા નામ લખો

	 $userdel tarun

3	 ઉદાહરણ માટે નવું જૂથ ઉમેરવા માટે કન્્સસોલ વિન્્ડડોમાાં groupadd 
આદેશ ટાઈપ કરો

	 $ groupadd fruits

4	 કન્્સસોલ વિન્્ડડોમાાં ઉદાહરણ માટે જૂથને કાઢી નાખવા માટે groupdel 
આદેશ લખો

	 $ groupdel fruits

5	 ઉદાહરણ તરીકે ફાઇલ અથવા ડિરેક્ટરીની માલિકી બદલવા માટે 
કન્્સસોલ વિન્્ડડોમાાં ચાઉન આદેશ લખો

	 $ ls -l

	 drwxrw-rw- 2 root root 4096 Mar 11 12:03 abcd 
(permission) (owner) (group own) (size) (name)

6	અન ે કન્્સસોલ વિન્્ડડોમાાં નીચેનું લખો

	 $ chown tarun /abcd

	 $ ls -l

	 drwxrw-rw- 2 tarun root 4096 Mar 11 12:03 abcd

7	 કન્્સસોલ વિન્્ડડોમાાં ગ્રુપ બદલવા માટે chgrp ટાઈપ કરો

	 ઉદાહરણ તરીકે ફાઇલ અથવા ડિરેક્ટરીની માલિકી

	 $ ls -l

	 drwxrw-rw- 2 tarun root 4096 Mar 11 12:03 abcd

	 $ chgrp tarun /abcd

	 $ ls -l

	 drwxrw-rw- 2 tarun root 4096 Mar 11 12:03 abcd

કન્્સસોલ વિન્્ડડોમાાં નીચેના આદેશો અજમાવો, આઉટપુટ લખો અને 
પ્રશિક્ષકની મદદથી તેની ચકાસણી કરો
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1	ફ ાઇલ/ડિરેક્ટરી ઉદાહરણમાાં સિિંગલ પરવાનગી ઉમેરો

	 $ chmod u+x filename Output:-

2	ફ ાઇલ/ડિરેક્ટરી ઉદાહરણમાાં બહુવિધ પરવાનગી ઉમેરો

	 $ chmod u+x, g+x ફાઇલનામ આઉટપુટ:-

3	ફ ાઇલ/ડિરેક્ટરી ઉદાહરણમાાંથી પરવાનગી દૂર કરો

	 $ chmod u-rx ફાઇલનામ આઉટપુટ:-

4	ફ ાઇલ/ડિરેક્ટરી ઉદાહરણ પર તમામ ભૂમિકાઓ માટે પરવાનગી 
બદલો

	 $ chmod a+x ફાઇલનામ આઉટપુટ:-

5	 બીજી ફાઇલ જવેી જ ફાઇલ માટે પરવાનગી આપો (સંદર્્ભનો ઉપયોગ 
કરીને)

	 ઉદાહરણ

	 $ chmod --સંદર્્ભ= ફાઇલ1 ફાઇલ2 આઉટપુટ:-

6	ડિ રેક્ટરી હેઠળની બધી ફાઇલોને પરવાનગી લાગુ કરો પુનરાવર્તિત

	 ઉદાહરણ

	 $ chmod -R 755 ડિરેક્ટરી-નામ/ આઉટપુટ:-

7	મ ાત્ર ડિરેક્ટરીઓ પર એક્્ઝઝિક્યુટ પરવાનગી બદલો (ફાઈલો 
પ્રભાવિત નથી)

	 ઉદાહરણ

	 $ chmod u+X * Output:-

કાાર્યય  7 : વધાારાાનાા આદેેશોોનુંં� સંંચાાલન કરવુંં�

1	 સાફ કરો - ઉદાહરણ તરીકે તે સ્ક્રીન (શોર્્ટકટ ctrl+l) સાફ કરશે.

	 $ clear

2	 બહાર નીકળો - ઉદાહરણ તરીકે વર્્તમાન ટર્મિનલ લોગીીંગ તેમજ 
વર્્તમાન સત્રને સમાપ્્ત કરવા

	 $ exit

3	મ ાણસ - ઉદાહરણ તરીકે આદેશોનું મેન્યુઅલ પેજ જોવા માટે

	 $ man mkdir

4	 ---helps -કમાન્્ડ ઉદાહરણના મદદ દસ્્તતાવેજ જોવા માટે.

	 $ ls --help

5	 Who - આ આદેશનો ઉપયોગ વપરાશકર્તા નામ દર્શાવવા માટે થાય છે 
અને તેમના આઇપી એડ્્રરેસ કે જમેણે તમારા સર્્વર ઉદાહરણ પર લૉગ 
ઇન કર્્યુું છે

	 $who

6	 whoami - આ આદેશ ઉદાહરણ તરીકે ટર્મિનલ યુઝર નેમમાાં વર્્તમાન 
લોગ ઇન દર્શાવે છે

	 $whoami

7	 ઉદાહરણ તરીકે એક વપરાશકર્તાથી બીજા વપરાશકર્તાની હોમ 
ડિરેક્ટરીમાાં સ્્વવિચ કરવા માટે su-user નામ.

	 $su mango

8	 પ્રદર્શિત કરવા માટે કન્્સસોલ વિન્્ડડોમાાં તારીખ લખો

	 ઉદાહરણ તરીકે વર્્તમાન સિસ્ટમ તારીખ

	 $ date

	 Wed Aug 18 16:24:44 EDT 2015

9	 ઉદાહરણ તરીકે વર્્તમાન મહિનાનું કેલેન્્ડર દર્શાવવા માટે કન્્સસોલ 
વિન્્ડડોમાાં Cal કમાન્્ડ ટાઈપ કરો

	 $ cal

	 August 2007

	 Su	 Mo	 Tu	 We	 Th	 Fr	 Sa

				    1	 2	 3	 4

	 5	 6	 7	 8	 9	 10	 11

	 12	 13	 14	 15	 16	 17	 18

	 19	 20	 21	 22	 23	 24	 25

	 26	 27	 28	 29	 30	 31	

10	 ઉદાહરણ તરીકે આઉટપુટ ફોર્મેટ બદલવા માટે કન્્સસોલ વિન્્ડડોમાાં ncal 
આદેશ ટાઈપ કરો

	 $ ncal

	 August 2007
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	 Mo	 6	 13	 20	 27	

	 Tu	 7	 14	 21	 28	

	 We	 1	 8	 15	 22	 29

	 Th	 2	 9	 16	 23	 30

	 Fr	 3	 10	 17	 24	 31

	 Sa	 4	 11	 18	 25	

	 Su	 5	 12	 19	 26	

11	 વિવિધ વિશષેતાઓ સાથે cal આદેશ અજમાવી જુઓ અન પ્રશિક્ષકની 
મદદથી આઉટપુટ સ્ક્રીનને સર્્વ કરો.

	 Command	 Description

	 cal 1 2007

	 cal -3 cal -J cal -e cal -m cal -j cal -p cal -w cal -y

12	 ઉદાાહરણ તરીીકેે વર્તતમાાન વપરાાશકર્તાા માાટેે પાાસવર્ડડ  બદલવાા માાટેે 
કન્સોોલ વિ�ન્ડોોમાંં passwd આદેેશ ટાાઈપ કરોો

	 $ passwd dhinesh

	 Enter new UNIX password:

	 Retype new UNIX password:

	 passwd: password updated successfully

	 $ chage --list dhinesh

	 છેલ્્લલો પાસવર્્ડ  ફેરફારઃ 23 એપ્રિલ, 2009 

	 Password expires	 : never

	 Password inactive	 : never

	 એકાઉન્ટની સમયસીમા  
	 સમાપ્્ત થાય છે		  : ક્યારેય નહીીં ન્યૂનતમ દિવસોની સખં્યા

	 between password change : 0

	 Maximum number of days

	 between password change : 99999

	 પાસવર્્ડન ી સમયસીમા સમાપ્્ત થાય તે પહેલા ચતેવણીના દિવસોની 
સખં્યા 7
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IT & ITES	 	 એકસરસાાઈઝ 1.6.27
કોપા (COPA) - ઉબુન્ટુ લિનક્સ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો અને મૂળભતૂ લિનક્સ કમાન્્ડ ચલાવો	

ફાઈલ અને ફોલ્્ડર મેનેજમેન્ટ માટે Linux ગ્રાફિકલ યુઝર ઈન્ટરફેસનો ઉપયોગ કરો, સિસ્ટમ વગેરેની 
શોધખોળ (Use the Linux graphical user interface for file and folder management, 
exploring the system etc.)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ઉબુન્ટુમાાં કોમ્્પ્યયુટર એક્સપ્્લલોરરને એક્સેસ કરવું
•	ફ ાઈલો અને ફોલ્્ડર્્સમાાં પ્રતીકો ઉમેરી રહ્યા છે
•	ફ ાઇલ અને ફોલ્્ડર પરવાનગીઓ બદલવી
•	ફ ાઇલો અને ફોલ્્ડર્્સનું નામ બદલવું અને કાઢી નાખવું.

	 જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક વર્કકિંગ પીસી 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાાર્યય 1 : ઉબુુનુ્ટુમાંં કમ્પ્યુટુર એક્સપ્લોોરરનેે ઍકે્સેસ કરોો

1	સ્થા ાનોો પસંંદ કરીી રહ્યાા છીીએ -&gt; કમ્પ્યુુટર બ્રાાઉઝિં�ગ માાટેે ઉપલબ્ધ 
ઉપકરણોો અનેે સ્થાાનોોનીી સૂૂચિ� સાાથેે નોોટિ�લસનેે બોોલાાવશેે (ફિ�ગ 1). 

2 	 ઉપરોક્્ત ફિગમાાં સિસ્ટમ પરના પ્રાથમિક ઉપકરણો સૂચિબદ્ધ છે. 
આમાાંના કોઈપણ ચિહ્ન પર ડબલ ક્્લલિક કરવાથી તે ઉપકરણ પર 
સ્થિત ફાઇલો અને ફોલ્્ડર્્સ ધરાવતી નવી વિન્્ડડો ખુલશે.

Fig 1

•	 ઉબુન્ટુ 22.04.1 / નવીનતમ Linux OS 	 - 1 No.
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3	 કોઈપણ ચિહ્નના ગુણધર્મો (જમે કે ફાઇલ સિસ્ટમ પ્રકાર અન ડિસ્ક 
વપરાશ) સાથે ક્્લલિક કરીને પ્રદર્શિત કરી શકાય છે. ચિહ્ન પર જમણું 
માઉસ બટન દબાવો અને પસંદ કરો. ફિગ 2 માાં પરિણામી સંવાદમાાંથી 
પ્રોપર્ટીઝ. નીચેની આકૃતિ હાર્્ડ  ડિસ્ક ડ્્ર રાઇવ આધારિત ફાઇલસિસ્ટમ 
માટે પ્રોપર્ટીઝ સંવાદ બતાવે છે:

કાાર્યય 2 : ફાાઇલોો અનેે ફોોલ્ડર્સસમાંં પ્રતીીકોો ઉમેેરવાા

નોટિલસના તાજતેરના સંસ્કરણો ઉપયોગી લક્ષણ પ્રદાન કરે છે જ ેવર્્ણનાત્મક પ્રતીકોને ફાઇલ અથવા ફોલ્્ડર ચિહ્નોની બાજુમાાં મકૂવાની મંજૂરી 
આપે છે. ઉદાહરણ તરીકે, તમે ફોલ્્ડર કે જમેાાં તમે ડિજિટલ ચિત્રો સંગ્રહિત કરો છો તેની બાજુમાાં ફોટો પ્રતીક અથવા પ્રસ્્તતુતિ ધરાવતી ફાઇલની 
બાજુમાાં પ્રસ્્તતુતિ પ્રતીક ઇચ્છી શકો છો. નોટિલસ પ્રોપર્ટી પેનલનો ઉપયોગ કરીને પ્રતીકોનો ઉમેરો પ્રાપ્્ત થાય છે. ઉદાહરણ તરીકે, અમે નીચેના 
ઉનાળાના વકેેશન અને સ્ટાફ મીટિિંગ ફોલ્્ડર્્સની બાજુમાાં પ્રતીકો ઉમેરીશું.

1	 “ઉનાાળુુ વેેકેેશન” ફોોલ્ડર પસંંદ કરોો અનેે રાાઇટ ક્લિ�િક કરોો માાઉસ સાાથેે. 
(ફિ�ગ 3).

2	પો ોપઅપ મેેનુુમાંંથીી, પ્રોોપર્ટીીઝ પસંંદ કરોો અનેે પ્રોોપર્ટીીઝ ડાાયલોોગમાંં 
એમ્બ્લેમ્સ ટેેબ પર ક્લિ�િક કરોો (ફિ�ગ 4). 

3	જ્યયાં  સુધી તમને પ્રતીક ન મળે ત્યયાં સુધી પ્રતીકોની સૂચિ નીચે સ્ક્રોલ 
કરો. ફોટાનું પ્રતીક અને પ્રતીક ઉમેરવા માટે ચેકબોક્સ પસંદ કરો.

4	નોં ંધ કરોો કેે તમેે એક કરતાંં વધુુ પ્રતીીક ઉમેેરીી શકોો છોો. દરેેક ફાાઇલ 
અથવાા ફોોલ્ડર. સ્ટાાફ મીીટિં�ગ ફોોલ્ડરમાંં દસ્તાાવેેજનુંં� પ્રતીીક ઉમેેરવાા માાટેે 
આ પગલાંંઓનુંં� પુુનરાાવર્તતન કરોો અનેે પ્રોોપર્ટીીઝ ડાાયલોોગ બંંધ કરોો. 
અંંતિ�મ પરિ�ણાામ નીીચેે મુુજબ દેેખાાવુંં� જોઈએ (ફિ�ગ 5). 

Fig 2

Fig 3

Fig 4
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કાાર્યય  3 : ફાાઇલ અનેે ફોોલ્ડર પરવાાનગીીઓ બદલવીી

1	 જ ે ફાઇલ અથવા ફોલ્્ડરને બદલવાની હોય તેના પર જમણા માઉસ 
બટનથી ક્્લલિક કરો અને પોપઅપ મેનુમાાંથી પ્રોપર્ટીઝ પસંદ કરો.

2	 પરિ�ણાામીી ગુુણધર્મોો સંંવાાદમાંં ફાાઇલ અથવાા ફોોલ્ડર માાટેે વર્તતમાાન 
સેેટિં�ગ્સ પ્રદર્શિ�ત કરવાા માાટેે પરવાાનગીીઓ ટેેબ પસંંદ કરોો (ફિ�ગ 6).

કાાર્યય  4 : ફાાઇલોો અનેે ફોોલ્ડર્સસનુંં� નાામ બદલવુંં� અનેે કાાઢીી નાાખવુંં�

1	 આઇકોન પર જમણું ક્્લલિક કરીને અને પોપઅપ મેનૂમાાંથી નામ બદલો 
પસંદ કરીને ફાઇલો અન ફોલ્્ડર્્સનું નામ બદલી શકાય છે. ફાઇલોને 
ઘણી રીતે ટ્્ર રેશમાાં ખસેડી શકાય છે.

2	 એક વિકલ્્પ એ છે કે ફક્્ત આયકન પસંદ કરો અને કીબોર્્ડ  પર ડિલીટ 
કી દબાવો. બીજુ ંછે આઇકોન પર ક્્લલિક કરો અને ડેસ્કટોપના તળિયે 
જમણા ખૂણે કચરાપેટીમાાં ખેેંચો અને છોડો.

3	 આયકન પર જમણું ક્્લલિક કરવાનો બીજો વિકલ્્પ અને ટ્્ર રેશમાાં ખસેડો 
પસંદ કરો.

હવે જ્યારે આપણે નોટિલસની કેટલીક વિશષેતાઓ જોઈ 
લીધી છે ત્યારે હવે આપણે ઉબુન્ટુ ફાઈલ મેનેજરને ગોઠવવાનું 
જોઈશું.

Fig 5

Fig 6
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IT & ITES	 	 એકસરસાાઈઝ 1.6.28
કોપા (COPA) - ઉબુન્ટુ લિનક્સ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો અને મૂળભતૂ લિનક્સ કમાન્્ડ ચલાવો	

ડેસ્કટોપ સેટિિંગ્્સને કસ્ટમાઇઝ કરો અને Linux માાં વપરાશકર્તા એકાઉન્્ટ્્સનું સંચાલન કરો (Customize 
desktop settings and manage user accounts in Linux)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 Linux માાં ડેસ્કટોપ વિકલ્્પપો સેટ કરો
•	 Linux પર વપરાશકર્તા ખાતાઓનું સંચાલન કરો.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય (TASK) 1 : Linux માાં ડેસ્કટોપ વિકલ્્પપો સેટ કરો 

1	 ઉબુન્ટુ ડેસ્કટોપમાાં યુનિટી લોન્ચર (2) વિકલ્્પ પસંદ કરો ફિગ 1 માાં.

7	ચિ�હ્નો ો બતાાવવાા/છુુપાાવવાા માાટેે લોોન્ચર સેેટિં�ગ્સ સેેટ કરવાા માાટેે વર્તતન 
ટેેબ પસંંદ કરોો (ફિ�ગ 6). 

8 	 જો જરૂરીી હોોય તોો ચાાલુુ બટનનોો ઉપયોોગ કરીીનેે ફરીીથીી જણાાવોો (ફિ�ગ 7).  

નોોંધ : ક્યારેય પણ રિવીલ સેન્્સસિટિવિટીને સૌથી નીચા સ્્તરે 
સેટ કરશો નહીીં કારણ કે તે લૉન્ચરને પાછંુ મેળવવું મશુ્્કકેલ 
બનાવશે.

9	વિ� કલ્પોોનેે ટેેટ કરવાા માાટેે ટૂૂલ્સનોો ઉપયોોગ કરોો (ફિ�ગ 8).

10	 વિન્્ડડો માટે મેનુ બતાવવા માટે ઉપરની આકૃતિની જમે ટિક માર્્ક સ પર 
ક્્લલિક કરો.

11	 Linux ઈન્ટરફેસની ડિફોલ્ટ સેટિિંગ્્સ મેળવવા માટે તળિયે રીસ્ટોર 
બિહેવિયર સેટિિંગ્્સને ક્્લલિક કરો.

Fig 1

2	 ઉપરના જમણા ખૂણે વપરાશકર્તા મેનૂ પર ક્્લલિક કરો, ઉબુન્ટુમાાં દેખાવ 
સેટિિંગ્્સન ઍક્સેસ કરવા માટે, ટોચના મેનૂ બાર પર અને ફિગ 2 માાં 
સિસ્ટમ સેટિિંગ્્સ પસંદ કરો.

3	 દેખાવ આઇકોન પસંદ કરો.

4	 ફિગ 3 માાં ડેસ્કટોપનું વોલપેપર સેટ કરવા માટે કોઈપણ વોલપેપર 
થંબનેલ આઇકોન પર ક્્લલિક કરો.

5	 ફિગ 4 માાં વર્કકિંગ થીમ સેટ કરવા માટે થીમ્્સમાાંથી થીમ પસંદ કરો.

6	 આઇકોોન્સનુંં� કદ બદલવાા માાટેે ડિ�સ્પ્લેેનુંં� આઇકોોન લેેવલ સેેટ કરોો 
(ફિ�ગ 5). 

Fig 2

Fig 3
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Fig 5

Fig 6

Fig 7

Fig 8

કાાર્યય  2 : Linux પર વપરાાશકર્તાા ખાાતાાઓનુંં� સંંચાાલન કરોો 

નવુંં� વપરાાશકર્તાા ખાાતુંં� ઉમેેરોો.

તમે તમારા કમ્્પ્યયુટર પર બહુવિધ વપરાશકર્તા ખાતાઓ ઉમેરી શકો છો. 
તમારા ઘર અથવા કંપનીમાાં દરેક વ્્યક્્તતિને એક એકાઉન્ટ આપો. દરેક 
વપરાશકર્તાનું પોતાનું હોમ ફોલ્્ડર હોય છે,દસ્્તતાવેજો અને સેટિિંગ્્સ.

વપરાશકર્તા એકાઉન્્ટ્્સ ઉમેરવા માટે તમારે એડમિનિસ્ટ્રેટર 
વિશષેાધિકારોની જરૂર છે.

1	 પ્રવૃત્તિઓનું વિહંગાવલોકન ખોલો અને વપરાશકર્તાઓને ટાઇપ 
કરવાનું શરૂ કરો.

2	 પેનલ ખોલવા માટે વપરાશકર્તાઓ પર ક્્લલિક કરો.

3	 ઉપલા જમણા ખૂણામાાં અનલૉક દબાવો અને જ્યારે પૂછવામાાં આવે 
ત્યારે તમારો પાસવર્્ડ  લખો.

4	ન વું વપરાશકર્તા ખાતું ઉમેરવા માટે, ડાબી બાજુએ એકાઉન્્ટ્્સની 
સૂચિની નીચે + બટન દબાવો.

5	 જો તમે ઇચ્છો છો કે નવા વપરાશકર્તા પાસે વહીવટી હોય,  કમ્્પ્યયુટરની 
ઍક્સેસ, એકાઉન્ટ પ્રકાર માટે એડમિનિસ્ટ્રેટર પસંદ કરો.

એડમિનિસ્ટ્રેટર્્સ વપરાશકર્તાઓને ઉમેરવા અને કાઢી નાખવા, 
સૉફ્ટવેર અને ડ્્રરા ઇવરો ઇન્સ્ટોલ કરવા અને તારીખ અને સમય 
બદલવા જવેી વસ્્તતુઓ કરી શકે છે.

6	ન વા વપરાશકર્તાનું પૂરુું  નામ દાખલ કરો. વપરાશકર્તાનામ સંપૂર્્ણ 
નામના આધારે આપમેળે ભરવામાાં આવશે. જો તમને સૂચિત 
વપરાશકર્તાનામ પસંદ ન હોય તો તમે તેને બદલી શકો છો.

7	તમ ે નવા વપરાશકર્તા માટે પાસવર્્ડ  સેટ કરવાનું પસંદ કરી શકો છો, 
અથવા તેમને તેમના પ્રથમ લોગિન પર તેને જાતે સેટ કરવા દો. 

જો તમે હમણાાં પાસવર્્ડ  સેટ કરવાનું પસંદ કરો છો, તો તમે આપોઆપ 
રેન્્ડમ પાસવર્્ડ  જનરેટ કરવા માટે આયકન દબાવી શકો છો.

8	 ઉમેરો પર ક્્લલિક કરો.

Delete a user account

વપરાશકર્તા ખાતું કાઢી નાખો તમે તમારા કમ્્પ્યયુટર પર બહુવિધ વપરાશકર્તા 
ખાતા ઉમેરી શકો છો. જો કોઈ વ્્યક્્તતિ હવે તમારા કમ્્પ્યયુટરનો ઉપયોગ કરતું 
નથી, તો તમે કરી શકો છો તે વપરાશકર્તાનું એકાઉન્ટ કાઢી નાખો.

વપરાશકર્તા એકાઉન્્ટ્્સ કાઢી નાખવા માટે તમારે એડમિનિસ્ટ્રેટર 
વિશષાધિકારોની જરૂર છે.

1	 પ્રવતૃ્તિઓનું વિહંગાવલોકન ખોલો અને વપરાશકર્તાઓને ટાઇપ 
કરવાનું શરૂ કરો.

2	 પેનલ ખોલવા માટે વપરાશકર્તાઓ પર ક્્લલિક કરો.

3	 ઉપલા જમણા ખૂણામાાં અનલૉક દબાવો અન જ્યારે પૂછવામાાં આવે 
ત્યારે તમારો પાસવર્્ડ  લખો.
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4	તમ ે જ ેવપરાશકર્તાને કાઢી નાખવા માાંગો છો તેને પસંદ કરો અને દબાવો 
- બટન, ડાબી બાજુના એકાઉન્્ટ્્સની સૂચિની નીચે, તે વપરાશકર્તા ખાતું 
કાઢી નાખવા માટે.

5	 દરેક વપરાશકર્તા પાસે તેમની ફાઇલો અને સેટિિંગ્્સ માટે તેમનું પોતાનું 
હોમ ફોલ્્ડર હોય છે. તમે રાખવા અથવા કાઢી નાખવાનું પસંદ કરી 
શકો છો. વપરાશકર્તાનું હોમ ફોલ્્ડર. ફાઇલો કાઢી નાખો પર ક્્લલિક 
કરો જો તમને ખાતરી હોય કે તેઓ હવે ઉપયોગમાાં લેવાશે નહીીં અને 
તમારે ડિસ્ક જગ્્યયા ખાલી કરવાની જરૂર છે. આ ફાઇલો કાયમ માટે 
કાઢી નાખવામાાં આવે છે. તેઓ પુનઃપ્રાપ્્ત કરી શકાતા નથી. તમે પાછા 
આવવા માાંગો છો શકે છે પહેલા બાહ્ય સ્ટોરેજ ઉપકરણ પર ફાઇલોને 
અપ કરો તેમને કાઢી નાખવું.

તમારો લોગિન સ્ક્રીન ફોટો બદલો.

જ્યારે તમે લૉગ ઇન કરો છો અથવા વપરાશકર્તાઓને સ્્વવિચ કરો છો, ત્યારે 
તમે તેમના લૉગિન ફોટા સાથે વપરાશકર્તાઓની સૂચિ જોશો. તમે તમારી 
બદલી શકો છો. સ્ટોક ઈમેજ અથવા તમારી પોતાની ઈમેજનો ફોટો. તમે 
તમારા વેબકૅમ વડે નવો લૉગિન ફોટો પણ લઈ શકો છો.

તમારા પોતાના સિવાયના વપરાશકર્તા એકાઉન્ટને સંપાદિત કરવા માટે 
તમારે એડમિનિસ્ટ્રેટર વિશષેાધિકારોની જરૂર છે.

1	 પ્રવૃત્તિઓનું વિહંગાવલોકન ખોલો અને વપરાશકર્તાઓને ટાઇપ 
કરવાનું શરૂ કરો.

2	 પેનલ ખોલવા માટે વપરાશકર્તાઓ પર ક્્લલિક કરો.

3	 જો તમે તમારા સિવાયના વપરાશકર્તાને સંપાદિત કરવા માાંગતા હો, તો 
ઉપરના જમણા ખૂણામાાં અનલૉક દબાવો અને તમારામાાં ટાઈપ કરો 
જ્યારે પૂછવામાાં આવે ત્યારે પાસવર્્ડ .

4	તમ ારા નામની બાજુના ચિત્ર પર ક્્લલિક કરો. કેટલાક સ્ટોક લોગિન ફોટા 
સાથે ડ્્ર રોપ-ડાઉન ગેલેરી બતાવવામાાં આવશે. જો તમને તેમાાંથી એક ગમે 
છે, તો તેને તમારા માટે વાપરવા માટે તેના પર ક્્લલિક કરો

•	 જો તમે તમારા કમ્્પ્યયુટર પર પહેલાથી જ હોય તેવા ચિત્રનો ઉપયોગ 
કરવાને બદલે, વધુ ચિત્રો માટે બ્રાઉઝ કરો ક્્લલિક કરો….

•	 જો તમારી પાસે વેબકેમ છે, તો તમે નવું લોગીન લઈ શકો છો.  ફોટો 
લો પર ક્્લલિક કરીને અત્યારે જ ફોટો…. તમારુું  ચિત્ર લો, પછી તમે 
ન જોઈતા ભાગોને કાપવા માટે ચોરસ રૂપરેખાને ખસેડો અને તેનું 
કદ બદલો. જો તમે લીધેલું ચિત્ર તમને ગમતું નથી, ફરીથી પ્રયાસ 
કરવા માટે અન્ય ચિત્ર લો પર ક્્લલિક કરો અથવા છોડી દેવા માટે 
રદ કરો.

આપમેળે લૉગ ઇન કરો

તમે તમારી સેટિિંગ્્સ બદલી શકો છો જથેી કરીને જ્યારે તમે તમારુું  કમ્્પ્યયુટર 
શરૂ કરો ત્યારે તમે આપમેળે તમારા એકાઉન્ટમાાં લૉગ ઇન થઈ જાઓ:

1	 પ્રવતૃ્તિઓનું વિહંગાવલોકન ખોલો અને વપરાશકર્તાઓને ટાઇપ 
કરવાનું શરૂ કરો.

2	 પનેલ ખોલવા માટે વપરાશકર્તાઓ પર ક્્લલિક કરો.

3	 વપરાશકર્તા ખાતું પસંદ કરો જમેાાં તમે લોગ ઇન કરવા માાંગો છો 
સ્ટાર્્ટઅપ પર આપોઆપ.

4	અન લોક દબાવો અને તમારો પાસવર્્ડ  દાખલ કરો.

5	 ઓટોમેટિક લોગિન સ્્વવિચને ચાલુ પર ટૉગલ કરો

તમારો પાસવર્્ડ  બદલો

સમય સમય પર તમારો પાસવર્્ડ  બદલવો એ એક સારો વિચાર છે, ખાસ 
કરીને જો તમને લાગે કે કોઈ અન્ય તમારો પાસવર્્ડ  જાણે છે.

તમારા પોતાના સિવાયના વપરાશકર્તા એકાઉન્ટને સંપાદિત કરવા માટે 
તમારે એડમિનિસ્ટ્રેટર વિશષાધિકારોની જરૂર છે.

1	 પ્રવૃત્તિઓનું વિહંગાવલોકન ખોલો અને વપરાશકર્તાઓને ટાઇપ 
કરવાનું શરૂ કરો.

2	 પેનલ ખોલવા માટે વપરાશકર્તાઓ પર ક્્લલિક કરો.

3	 પાસવર્્ડન ી બાજુમાાં લેબલ ····· પર ક્્લલિક કરો. જો તમે કોઈ અલગ 
વપરાશકર્તા માટે પાસવર્્ડ  બદલી રહ્યા છો, તો તમારે પહેલા પેનલને 
અનલોક કરવાની જરૂર પડશે.

4	તમ ારો વર્્તમાન પાસવર્્ડ , પછી નવો પાસવર્્ડ  દાખલ કરો. વેરીફાઈ ન્યુમાાં 
ફરીથી તમારો નવો પાસવર્્ડ  દાખલ કરો. પાસવર્્ડ  ફીલ્્ડ.

તમે આપોઆપ રેન્્ડમ પાસવર્્ડ  જનરેટ કરવા માટે આયકન દબાવી શકો 
છો.

5	 બદલો ક્્લલિક કરો.

વહીવટી વિશષેાધિકારો કોની પાસે છે

તે બદલો વહીવટી વિશષાધિકારો એ સિસ્ટમના મહત્્વપૂર્્ણ ભાગોમાાં કોણ 
ફેરફાર કરી શકે છે તે નક્કી કરવાનો એક માર્્ગ છે. તમે બદલી શકો છો 
કે કયા વપરાશકર્તાઓને વહીવટી વિશષાધિકારો છે અને કયા નથી. તે 
તમારી સિસ્ટમને સુરક્ષિત રાખવા અન સંભવિત નુકસાનકારક અનધિકૃત 
ફેરફારોને અટકાવવાનો સારો માર્્ગ છે.

એકાઉન્ટના પ્રકારો બદલવા માટે તમારે એડમિનિસ્ટ્રેટર વિશષાધિકારોની 
જરૂર છે.

1	 પ્રવતૃ્તિઓનું વિહંગાવલોકન ખોલો અને વપરાશકર્તાઓને ટાઇપ 
કરવાનું શરૂ કરો.

2	 પનેલ ખોલવા માટે વપરાશકર્તાઓ પર ક્્લલિક કરો.

3	 ઉપલા જમણા ખૂણામાાં અનલૉક દબાવો અને જ્યારે પૂછવામાાં આવે 
ત્યારે તમારો પાસવર્્ડ  લખો.

4	ત ે વપરાશકર્તાને પસંદ કરો કે જનેા વિશષેાધિકારો તમે બદલવા માાંગો 
છો.

5	 એકાઉન્ટ ટાઈપની બાજુમાાં સ્ટાન્્ડર્્ડ  લેબલ પર ક્્લલિક કરો અને 
એડમિનિસ્ટ્રેટર પસંદ કરો.

6	જ્યા રે વપરાશકર્તા આગામી લોગ ઇન કરશે ત્યારે તેમના 
વિશષાધિકારો બદલાશે.
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IT & ITES	 	 એકસરસાાઈઝ 1.6.29
કોપા (COPA) - ઉબુન્ટુ લિનક્સ ઓપરેટિિંગ સિસ્ટમ ઇન્સ્ટોલ કરો અને મૂળભતૂ લિનક્સ કમાન્્ડ ચલાવો	

Linux માાં સિસ્ટમ ગુણધર્મો જુઓ અને સિસ્ટમ સેટિિંગ્્સ મેનેજ કરો (View system properties and 
manage system setting in Linux)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ઓપન સિ�સ્ટમ ગુુણધર્મોો.

	 જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 એક વર્કકિંગ પીસી 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાાર્યય 1 : સિ�સ્ટમ પ્રોોપર્ટીીઝ ખોોલોો

2	સો ોફ્ટવેેર સેેન્ટરમાંં “સિ�સ્ટમ” માાટેે શોોધોો અનેે સિ�સ્ટમ પ્રોોફાાઇલર અનેે 
બેેન્ચમાાર્કક  ઇન્સ્ટોોલ કરોો (ફિ�ગ 2).

3	 તેેનેે લૉૉન્ચરથીી ચલાાવોો (જો તેે ન હોોય તોો “સિ�સ્ટમ” લખોો ત્યાંં પહેેલેેથીી 
જ છેે) અનેે નીી વિ�ગતવાાર સૂૂચિ� પ્રદર્શિ�ત કરશેે  હાાર્ડડવે ર કેે જે ેશ્રેેણીી દ્વાારાા 
વધુુ વિ�સ્તૃતૃ કરીી શકાાય છેે (ફિ�ગ 3). 

નોોંધ: ઉબુન્ટુ લિનક્સમાાં CPU અને મેમરી માહિતી માટે નીચેના 
ઉદાહરણો છે.

Fig 1

Fig 2

Fig 3

•	 ઉબુન્ટુ 22.04.1 / નવીનતમ Linux OS 	 - 1 No.

1	સે ેટિં�ગ્સ પર જાઓ, અનેે સિ�સ્ટમ હેેઠળ, મૂૂળભૂતૂ માાહિ�તીી માાટેે વિ�ગતોો 
પર ક્લિ�િક કરોો (ફિ�ગ 1). 
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IT & ITES	 	 એકસરસાાઈઝ 1.7.30
કોપા (COPA) - વર્્ડ  પ્રોસેસિિંગ સોફ્ટવેર

દસ્્તતાવેજોમાાં નેવિગેટ કરો (Navigate within documents)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 MS Word ખોલો અને નવો દસ્્તતાવેજ બનાવો
•	 દસ્્તતાવેજ સાચવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS કે સાથે એક કાર્્યરત પીસી	 – 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : MS વર્્ડ  ખોલો અને નવો દસ્્તતાવેજ બનાવો

1	 ‘સ્ટાર્્ટ ’ બટન પર ક્્લલિક કરો

2	 ઓપન વર્્ડ .

3	 Blank document પસંદ કરો.

	અ થવા, જો વર્્ડ  પહેલેથી જ ખુલ્્લલો હોય, તો File > New > Blank 
document પસંદ કરો.

•	 MS Office 2019 / નવીનતમ 		              - 1 No. 

	અ થવા, નમૂનાનો ઉપયોગ કરીને દસ્્તતાવેજ બનાવવા માટે

•	  ઓપન વર્્ડ . અથવા, જો વર્્ડ  પહેલેથી જ ખુલ્્લલો છે, તો પસંદ કરો 
File > New

•	  ટેમ્્પલેટ ખોલવા માટે તેને બે વાર ક્્લલિક કરો.

4	 બ્લેેન્ક પેેજ ઓપન થયાા પછીી તમેે ડોોક્યુુમેેન્ટ બનાાવવાા માંંગોો છોો તેે 
પ્રમાાણેે લખવાાનુંં� શરૂ કરોો (ફિ�ગ 1). 

કાર્્ય 2 : દસ્્તતાવેજ સાચવો

1	 ઝડપી ઍક્સેસ પર ફાઇલ  સાચવો અથવા સાચવો બટન પર 
ક્્લલિક કરો.

2	ફિ ગમાાં બતાવ્્યયા પ્રમાણે ‘સેવ’ પર ક્્લલિક કરો

3	તમ ે દસ્્તતાવેજો ક્યયાં સાચવવા માાંગો છો તે સ્થાન શોધવા માટે બ્રાઉઝ 
કરો પસંદ કરો (ડેસ્કટોપ/ડોક્યુમેન/ડાઉનલોડ્સ/લોકલ ડ્્ર રાઇવર્્સ.)

4	ફ ાઇલનામ બોક્સમાાં, નવા ફાઇલના નામ તરીકે નમૂના1 લખો. ફિગ 2 
ની જમે શબ્દ દસ્્તતાવેજ (*.docx) ટાઈપ તરીકે સાચવો.

Fig 1
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કાર્્ય 3 : Search for text

1	 એડિ�ટ વ્યૂૂમાંંથીી ફાાઇન્ડ પેેન ખોોલવાા માાટેે, દબાાવોો Ctrl+F, અથવાા 
Home > Find શોોધોો ક્લિ�િક કરોો(ફિ�ગ 3).

2	 દસ્્તતાવેજ શોધો… બોક્સમાાં લખીને લખાણ શોધો. તમે ટાઇપ કરવાનું 
શરૂ કરો કે તરત જ વર્્ડ  વેબ એપ સર્્ચ કરવાનંુ શરૂ કરે છે. શોધ 
પરિણામોને વધુ સંકુચિત કરવા માટે, બહૃદદર્્શક કાચ પર ક્્લલિક કરો 
અને એક અથવા બંને શોધ વિકલ્્પપો પસંદ કરો.

3	 જ્યાારેે તમેે તમાારાા દસ્તાાવેેજમાંં ટાાઇપ કરોો છોો અથવાા ફેેરફાાર કરોો છોો, 
ત્યાારેે Word Web App શોોધનેે થોોભાાવેે  છેે અનેે ફાાઇન્ડ પેેન સાાફ કરેે 
છેે. પરિ�ણાામોો ફરીીથીી જોવાા માાટેે, નેેક્સ્ટ સર્ચચ રિ�ઝલ્ટ અથવાા ગત સર્ચચ 
રિ�ઝલ્ટ એરોો પર ક્લિ�િક કરોો (ફિ�ગ 4).

4	જ્યા રે તમે શોધ પૂર્્ણ કરી લો, ત્યારે શોધ બોક્સના અતંે X પર ક્્લલિક 
કરો.

Fig 3

Fig 4

Fig 2
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કાર્્ય 4 : દસ્્તતાવેજોમાાં સ્થાનો સાથે લિિંક કરો

તમે ગતંવ્્યને ચિહ્નિત કરી લો તે પછી, તમે લિિંક ઉમેરવા માટે તૈયાર છો.

1	ત મેે a તરીીકેે ઉપયોોગ કરવાા માંંગોો છોો તેે ટેેક્સ્ટ અથવાા ઑબ્જેકે્ટ 
હાાઈપરલીંંકપસંંદકરોો.

2	રા ાઇટ-ક્લિ�િક કરોો અનેે પછીી હાાઇપરલિં�ક    પર ક્લિ�િક કરોો

3	ન ી લિિંક હેઠળ, આ દસ્્તતાવેજમાાં સ્થાન પર ક્્લલિક કરો.

4	 સૂચિમાાં, તમે જ ેહેડિિંગ અથવા બુકમાર્્ક  કરો છો તે પસંદ કરો સાથે લિિંક 
કરવા માાંગો છો.

કાર્્ય 5 : દસ્્તતાવેજોમાાં ચોક્કસ સ્થાનો અને ઑબ્્જજેક્્ટ્્સ પર જાઓ

માઈક્રોસોફ્ટ વર્્ડ માાં ગો ટુ ટૂલ ખોલો

1	તમ ે Windows પર વર્્ડમાાં  મેનુ અથવા કીબોર્્ડ  શોર્્ટકટનો ઉપયોગ 
કરીને ગો ટુ ટુલ ખોલી શકો છો.

• 	 Windows પર, હોમ ટેબ પર જાઓ, Find ની બાજુમાાં ડ્્ર રોપ-ડાઉન 
એરો પર ક્્લલિક કરો અને Go To પસંદ કરો.  વૈકલ્્પપિક રીતે,  
Ctrl + G દબાવો (ફિગ 5)

2	 વર્્ડ માાં આગલી અથવા પહેલાની આઇટમ પર જાઓ

• 	 એકવાર તમે ગો ટુ ટુલ ખોલી લો, પછી તમારે ચાલુ હોવું જોઈએ 
ગો ટુ ટેબ. જો નહીીં, તો તેને ટોચ પર પસંદ કરો.

• 	ડા ાબીી બાાજુુએ, તમેે જ્યાંંથીી જવાા માાગોો છોો તેે પસંંદ કરોો યાાદીી. તમેે 
પૃૃષ્ઠ, વિ�ભાાગ, રેેખાા, બુુકમાાર્કક  પસંંદ કરીી શકોો છોો.ટિ�પ્પણીી, અનેે 
વધુુ (ફિ�ગ 6). 

3	 આઇટમ નંંબર અથવાા નાામ પર જાઓ

• 	 જો તમે તમારા દસ્્તતાવેજમાાં કોઈ ચોક્કસ સ્થળ પર જવા માાંગતા 
હો, તો તમે નંબર દાખલ કરવા અથવા વસ્્તતુ    માટે નામ પસંદ 
કરવા માટે જમણી બાજુના બૉક્સનો ઉપયોગ કરી શકો છો. અહીીં 
કેટલાક ઉદાહરણો છે.

• 	કો ોઈ ચોોક્કસ પૃૃષ્ઠ, વિ�ભાાગ, રેેખાા, ફૂૂટનોોટ અથવાા એન્ડનોોટ, ટેેબલ, 
ગ્રાાફિ�ક, સમીીકરણ અથવાા મથાાળાા પર  જવાા માાટેે, બોોક્સમાંં નંંબર 
દાાખલ કરોો. દાાખલાા તરીીકેે, તમેે તમાારાા દસ્તાાવેેજમાંં 25 લાાઇન પર 
જવાા માાગીી શકોો છોો. તેેથીી તમેે સૂૂચિ�માંંથીી લાાઇન પસંંદ કરશોો, 
બોોક્સમાંં “25” દાાખલ કરોો, અનેે જાઓ પર ક્લિ�િક કરોો (ફિ�ગ 7).  

Fig 5

Fig 6

Fig 7
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4	 ચોોક્કસ માાટેે ડ્રોો �પ-ડાાઉન બોોક્સમાંંથીી નાામ પસંંદ કરોો bookmark, 
comment, field, અથવાા object.

• 	 ઉદાાહરણ તરીીકેે, જો તમેે ઉમેરેેેલીી ટિ�પ્પણીી પર જવાા માંંગતાા હોો, તોો 
ટિ�પ્પણીી પસંંદ કરોો, ડ્રોો� પ-ડાાઉન બોોક્સમાંં તમાારંું નાામ પસંંદ કરોો 
અનેે આગળ ક્લિ�િક કરોો (ફિ�ગ 8). 

5	 જો તમેે દાાખલ કરેેલ એક્સેેલ ચાાર્ટટ  પર જવાા માંંગતાા હોો, તોો ઑબ્જેકે્ટ 
પસંંદ કરોો, ડ્રોો� પ-ડાાઉન બોોક્સમાંં Microsoft Excel ચાાર્ટટ  પસંંદ કરોો 
અનેે આગળ ક્લિ�િક કરોો (ફિ�ગ 9).

6	તમ ારા વર્્તમાન સ્થાન પર સંબંધિત ખસેડો

• 	 ગો ટુ ટૂલનો ઉપયોગ કરવાની બીજી સરળ રીત છે દસ્્તતાવેજમાાં 
તમારા વર્્તમાન સ્થાનની આગળ અથવા પાછળ કૂદકો મારવો. 
અહીીં કેટલાક ઉદાહરણો છે

Fig 8

Fig 9

• 	 કદાાચ તમેે વર્તતમાાન પૃૃષ્ઠથીી દસ પાાનાા આગળ જવાા માંંગોો છોો. પૃૃષ્ઠ 
પસંંદ કરોો, બોોક્સમાંં “+10” દાાખલ કરોો, અનેે પછીી જાઓ પર 
ક્લિ�િક કરોો. પછીી તમેે દસ પેેજ આગળ વધશોો (ફિ�ગ 10). 

Fig 10
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7	ત મેે તમાારાા વર્તતમાાન સ્થાાન પરથીી પણ પાાછાા જઈ શકોો છોો. કહોો કેે તમેે પાંંચ 
વિ�ભાાગ પાાછાા ખસેેડવાા માંંગોો છોો - વિ�ભાાગ પસંંદ કરોો, બોોક્સમાંં “-5” 
દાાખલ કરોો, અનેે પછીી આ કરવાા માાટેે જાઓ પર ક્લિ�િક કરોો (ફિ�ગ 11).  

8	 આગળ જવાા માાટેે વત્તાા ચિ�હ્ન (+) અનેે બાાદબાાકીી ચિ�હ્ન (-) નોો ઉપયોોગ 
કરવાાનુંં� યાાદ રાાખોો પાાછળ જાઓ. આ પ્રતીીકોો ફક્ત તેે વસ્તુુઓ માાટેે જ 
કાાર્યય કરેે છેે જે ેબૉૉક્સમાંં નંંબર દાાખલ કરવાાનીી મંંજૂૂરીી આપેે છેે, જેમે કેે 
અગાાઉ વર્ણણવેેલ છેે.

કાર્્ય 5 : Sફોર્મેટિિંગ પ્રતીકો અને છુપાયેલ ટેક્સ્ટ બતાવો અને છુપાવો

1	 File > Options > Display પર જાઓ.

2	 સ્ક્રીીન પર હંંમેશેાા આ ફોોર્મેેટિં�ગ માાર્કક સ બતાાવોો હેેઠળ, દરેેક ફોોર્મેેટિં�ગ 
માાર્કક  માાટેે ચેેક બોોક્સ પસંંદ કરોો કેે જેનેેે તમેે હંંમેશેાા દર્શાાવવાા માંંગોો છોો, 
જો બતાાવોો/ છુુપાાવોો બટન ચાાલુુ અથવાા બંંધ હોોય તોો ધ્યાાનમાંં  લીીધાા 
વગર. તમેે હંંમેશેાા પ્રદર્શિ�ત કરવાા માંંગતાા નથીી તેેવાા કોોઈપણ ચેેક 
બોોક્સનેે સાાફ કરોો (ફિ�ગ 12). 

Fig 11

Fig 12
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IT & ITES	 	 એકસરસાાઈઝ 1.7.31
કોપા (COPA) - વર્્ડ  પ્રોસેસિિંગ સોફ્ટવેર	

ફોર્મેટ દસ્્તતાવેજો (Format documents)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 MS Word ખોલો અને નવો દસ્્તતાવેજ બનાવો
•	 દસ્્તતાવેજ સાચવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી         	 – 1 No. •	 MS Office 2019 / નવીનતમ		              - 1 No. 

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : દસ્્તતાવેજ પૃષ્્ઠઠો સેટ કરો 

પૃષ્્ઠ ઓરિએન્ટેશન બદલવા માટે

1	 લેઆઉટ ટેબ પસંદ કરો.

2	પૃ ૃષ્ઠ સેેટઅપમાંં ઓરિ�એને્ટેશન આદેેશનેે ક્લિ�િક કરોો જૂૂથ (ફિ�ગ 1).

3	 એક ડ્રોો� પ-ડાાઉન મેેનુુ દેેખાાશેે. પૃૃષ્ઠ ઓરિ�એને્ટેશન બદલવાા માાટેે પોોટ્રેે�ટ  
અથવાા લેેન્ડસ્કેપ પર ક્લિ�િક કરોો (ફિ�ગ 2).

4	 દસ્્તતાવેજનું પૃષ્્ઠ ઓરિએન્ટેશન બદલવામાાં આવશે.

પૃષ્્ઠનું કદ : મૂળભતૂ રીતે, નવા દસ્્તતાવેજનું પૃષ્્ઠ કદ 8.5 ઇંચ બાય  
11 ઇંચ છે. તમારા પ્રોજકે્ટના આધારે, તમારે તમારા દસ્્તતાવેજના પૃષ્્ઠના 
કદને સમાયોજિત કરવાની જરૂર પડી શકે છે. એ નોોંધવું અગત્યનું છે કે 
ડિફૉલ્ટ પૃષ્્ઠ કદમાાં ફેરફાર કરતાાં પહેલાાં, તમારે તમારા પ્રિન્ટર કયા પૃષ્્ઠ 
કદને સમાવી શકે છે તે જોવા માટે તમારે તપાસ કરવી જોઈએ.

Fig 1

Fig 2

પૃષ્્ઠનું કદ બદલવા માટે: વર્્ડમાાં  પસંદ કરવા માટે વિવિધ પૂર્્વવ્્યયાખ્યાયિત 
પૃષ્્ઠ કદ છે.

1	 લેેઆઉટ ટેેબ પસંંદ કરોો, પછીી માાપ આદેેશ પર ક્લિ�િક કરોો (ફિ�ગ 3). 

Fig 3
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2	 પેજ સેટઅપ ડાયલોગ બોક્સ દેખાશે.

3	 પહોળાઈ અને ઊંચાઈ માટેના મૂલ્યોને સમાયોજિત કરો, પછી ક્્લલિક 
કરો ઠીક છે (ફિગ 6).

4	 દસ્્તતાવેજનું પૃષ્્ઠ કદ બદલાશે.

પૃષ્્ઠ માર્જિન : માર્જિન એ તમારા દસ્્તતાવેજની ટેક્સ્ટ અને કિનારી વચ્ચેની 
જગ્્યયા છે. ડિફૉલ્ટ રૂપે, નવા દસ્્તતાવેજના માર્જિન સામાન્ય પર સેટ છે, જનેો 
અર્્થ છે કે તેમાાં ટેક્સ્ટ અને દરેક કિનારી વચ્ચે એક-ઇંચની જગ્્યયા છે. તમારી 
જરૂરિયાતોને આધારે, વર્્ડ  તમને તમારા દસ્્તતાવેજનું માર્જિન માપ બદલવાની 
મંજૂરી આપે છે.

પૃષ્્ઠ માર્જિનને ફોર્મેટ કરવા માટે: શબ્દ પસંદ કરવા માટે વિવિધ 
પરૂ્્વવ્્યયાખ્યાયિત માર્જિન કદ ધરાવે છે.

1 	લે ેઆઉટ ટેેબ પસંંદ કરોો, પછીી માાર્જિ�ન્સ આદેેશ પર ક્લિ�િક કરોો  
(ફિ�ગ 7). 

2	 એક ડ્રોો� પ-ડાાઉન મેેનુુ દેેખાાશેે. તમનેે જોઈતાા પૂૂર્વવવ્યાાખ્યાાયિ�ત માાર્જિ�ન કદ 
પર ક્લિ�િક કરોો (ફિ�ગ 8). 

3	 દસ્્તતાવેજના માર્જિન બદલવામાાં આવશે. 

કસ્ટમ માર્જિનનો ઉપયોગ કરવા માટે : વર્્ડ  તમને પેજ સટેઅપ ડાયલોગ 
બોક્સમાાં તમારા માર્જિનનું કદ કસ્ટમાઇઝ કરવાની પણ મંજૂરી આપે છે.

1 	લે ેઆઉટ ટૅૅબમાંંથીી, માાર્જિ�ન્સ પર ક્લિ�િક કરોો. ડ્રોો� પ-ડાાઉન મેેનૂૂમાંંથીી 
કસ્ટમ માાર્જિ�ન પસંંદ કરોો (ફિ�ગ 9). 

Fig 4

Fig 6

2 	 એક ડ્રોો� પ-ડાાઉન મેેનુુ દેેખાાશેે. વર્તતમાાન પૃૃષ્ઠનુંં� કદ પ્રકાાશિ�ત થયેેલ છેે. 
ઇચ્છિ�ત પૂૂર્વવવ્યાાખ્યાાયિ�ત પૃૃષ્ઠ કદ પર ક્લિ�િક કરોો (ફિ�ગ 4). 

3   દસ્્તતાવેજનું પૃષ્્ઠ કદ બદલવામાાં આવશે.

કસ્ટમ પેજ સાઈઝનો ઉપયોગ કરવા માટે : વર્્ડ  તમને પેજ સેટઅપ 
ડાયલોગ બોક્સમાાં પેજનું કદ કસ્ટમાઈઝ કરવાની પણ પરવાનગી આપે છે.

1 	 લેેઆઉટ ટેેબમાંંથીી, માાપ પર ક્લિ�િક કરોો. ડ્રોો� પ-ડાાઉન મેેનૂૂમાંંથીી વધુુ 
પેેપર સાાઇઝ પસંંદ કરોો (ફિ�ગ 5). 

Fig 5
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2	 પેજ સેટઅપ ડાયલોગ બોક્સ દેખાશે.

3	 દરેક માર્જિન માટે મૂલ્યોને સમાયોજિત કરો, પછી ઠીક ક્્લલિક કરો. 

4	 દસ્તાાવેેજનાા માાર્જિ�ન બદલવાામાંં આવશેે (ફિ�ગ 10).
	ત મેે લેેઆઉટ ટેેબ પર નેેવિ�ગેટ કરીીનેે અનેે પૃૃષ્ઠ સેેટઅપ જૂૂથનાા તળિ�યેે-

જમણાા ખૂૂણેે નાાનાા તીીરનેે ક્લિક કરીને પૃષ્ઠ સેટઅપ સં�����������ં����������વાાદ બોોક્સ પણ 
ખોોલીી શકોો છોો (ફિ�ગ 11).

તમેે કરેેલાા તમાામ ફોોર્મેેટિં�ગ ફેેરફાારોોનેે સાાચવવાા અનેે નવાા દસ્તાાવેેજો પર 
આપમેેળેે લાાગુુ કરવાા માાટેે તમેે વર્ડડ નાા અનુુકૂૂળ સેેટનોો ડિ�ફોોલ્ટ સુુવિ�ધાા તરીીકેે 
ઉપયોોગ કરીી શકોો છોો. 

Fig 7

Fig 8 Fig 9
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કાાર્યય 2 : હેેડરોો અનેે ફૂૂટર્સસ દાાખલ કરોો અનેે સંશંોોધિ�ત કરોો 

વર્ડડમાંં  બિ�લ્ટ-ઇન હેેડર્સસ અનેે ફૂૂટર્સસનોો ઉપયોોગ કરોો: જો તમેે વર્ડડ  
ડોોક્યુુમેેન્ટમાંં ઝડપથીી હેેડર અથવાા ફૂૂટર ઉમેેરવાા માંંગતાા હોો, તોો તમેે પ્રીીસેેટ 
વિ�કલ્પોોમાંંથીી એકનોો ઉપયોોગ કરીી શકોો છોો. આ તમનેે તમાારાા હેેડર અથવાા 
ફૂૂટર માાટેે લેેઆઉટ પસંંદ કરવાા દેે છેે. ઉદાાહરણ તરીીકેે, તમેે ત્રણ કૉૉલમ્સ 
સાાથેે હેેડર અથવાા ફૂૂટરનોો ઉપયોોગ કરવાા, રંંગનોો ઉપયોોગ કરતીી શૈૈલીી લાાગુુ 
કરવાા અથવાા વિ�શિ�ષ્ટ વિ�ગતોો શાામેેલ કરવાા માાટેે તેેનેે ફોોર્મેેટ કરવાા માંંગોો 
છોો.

વર્્ડ માાં પ્રીસેટ હેડર અથવા ફૂટર ઉમેરવા માટે

1	રિ બન બાર પર ઇન્્સર્્ટ  ટેબના હેડર અને ફૂટર વિભાગ પર જાઓ.

2	 હેડર અથવા ફૂટર પર ક્્લલિક કરો, પછી ડ્્ર રોપ-ડાઉન બોક્સમાાં વિકલ્્પપોની 
સમીક્ષા કરો.

•	 જો તમનેે પૃૃષ્ઠ નંંબર જોઈએ છેે, તોો તેે ડ્રોો� પ-ડાાઉન તીીરનેે ક્લિ�િક કરોો 
અનેે સ્થાાન પસંંદ કરોો (ફિ�ગ 12).

Fig 10 Fig 11

Fig 12

3 	તમને ે જોઈતુંં� હેેડર અથવાા ફૂૂટર શૈૈલીી પસંંદ કરોો અનેે તેે તમાારાા 
દસ્તાાવેેજમાંં દેેખાાશેે (ફિ�ગ 13). 

• 	 જો તમેે પસંંદ કરેેલ વિ�કલ્પ વધાારાાનીી વિ�ગતોોનીી રાાહ જોઈ રહ્યોો 
હોોય, તોો તેમેનેે ઉમેેરવાા માાટેે હેેડર અથવાા ફૂૂટરમાંં નિ�યુુક્ત વિ�સ્તાાર 
પર જાઓ. ઉદાાહરણ તરીીકેે, તમાારેે કસ્ટમ દસ્તાાવેેજ શીીર્ષષક 
ઉમેેરવાાનીી જરૂર પડીી શકે છેે (ફિ�ગ 14). 

હેડર અથવા ફૂટરને કસ્ટમાઇઝ કરો: એકવાર તે સંપાદન માટે ખુલ્્લલુું થઈ 
જાય પછી તમે હેડર અથવા ફૂટર વિભાગમાાં તમને ગમે તે ટાઇપ કરી શકો 
છો. આ અનુકૂળ હોવા છતાાં, તમે રિબન બાર પર હેડર અને ફૂટર ટેબનો 
ઉપયોગ કરીને આપમેળે અન્ય વિગતો પણ દાખલ કરી શકો છો.

રિ�બનનીી ડાાબીી બાાજુુએ, તમાારીી પાાસેે ઉપરનીી જેમે બિ�લ્ટ-ઇન હેેડર, ફૂૂટર 
અને પેેજ નંંબર વિ�કલ્પોો છેે. આ તમનેે પ્રીીસેેટ શૈૈલીી લાાગુુ કરવાા અથવાા પછીી 
પૃૃષ્ઠ નંંબર ઉમેેરવાાનીી મંંજૂૂરીી આપેે છેે (ફિ�ગ 15).

જમણી બાજુએ, તમે ઇન્્સર્્ટ  સેક્શન જોશો. રિબન આનાથી તમે ઉપયોગ 
કરવા માાંગો છો તે વિગતો, જમે કે તારીખ અન સમય, દસ્્તતાવેજનું શીર્્ષક 
અને વધુ. (ફિગ 16)

1 	તા ારીીખ અનેે સમય: તાારીીખ અનેે સમય સમાાવવાા માાટેે, તાારીીખ અનેે 
સમય બટન પર ક્લિ�િક કરોો. દેેખાાતીી વિ�ન્ડોોમાંં તમેે જે ેફોોર્મેેટનોો ઉપયોોગ 
કરવાા માંંગોો છોો તેેનેે પસંંદ કરોો અનેે ઓકેે ક્લિ�િક કરોો (ફિ�ગ 17). 
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2	 દસ્તાાવેેજનીી માાહિ�તીી: આ ડ્રોો� પ-ડાાઉન બોોક્સમાંં, તમેે લેખેક, ફાાઇલનુંં� 
નાામ અનેે દસ્તાાવેેજ શીીર્ષષક જેવેાા વિ�કલ્પોો જોશોો. તમેે કેેટેેગરીી, કંંપનીી 
અનેે મેેનેેજર જેવેીી વસ્તુુઓ માાટેે સમાાન પોોપ-આઉટ મેનેૂૂમાંં અલગ 
દસ્તાાવેેજ પ્રોોપર્ટીી પણ પસંંદ કરીી શકોો છોો (ફિ�ગ 18). 

Fig 13

Fig 14

Fig 15

Fig 16

Fig 17

Fig 18

3	 વધુુમાંં, તમેે ઘણાા બધાા ક્ષેેત્ર વિ�કલ્પોોમાંંથીી પસંંદ કરોો છોો. આમાંં 
હાાઇપરલિં�ક, સંંદર્ભભ, વિ�ભાાગ અથવાા પ્રતીીક જેવેીી વસ્તુુઓનોો સમાાવેશે 
થાાય છેે. ફીીલ્ડ પસંંદ કરોો, ઉપલબ્ધ વિ�કલ્પોોનીી સમીીક્ષાા કરોો, પછીી તમનેે 
જોઈતોો વિ�કલ્પ પસંંદ કરોો. તેેનેે દાાખલ કરવાા માાટેે ઓકેે ક્લિ�િક કરોો 
(ફિ�ગ 19). 

4	 ઝડપીી ભાાગોો: જો તમાારીી પાાસેે ઓટોોટેેક્સ્ટ સેેટઅપ હોોય, જેમે કેે સહીી, 
તોો ક્વિ�િક પાાર્્ટ્�સ ડ્રોો� પ ડાાઉન વિ�કલ્પોોનોો ઉપયોોગ કરોો. તમેે સમાાન ડ્રોો� પ 
ડાાઉન મેનેૂૂમાંંથીી ડોોક્યુુમેેન્ટ પ્રોોપર્ટીીઝ અથવાા ફીીલ્ડ વિ�કલ્પ પણ પસંંદ 
કરીી શકોો છોો (ફિ�ગ 20). 

5	 ચિ�ત્રોો અનેે ઓનલાાઈન ચિ�ત્રોો: જો તમેે કોોઈ ઈમેેજ, જેમે કેે કંંપનીીનોો 
લોોગોો સાામેેલ કરવાા માંંગતાા હોો, તોો ઈમેેજ  પસંંદ કરવાા અનેે દાાખલ 
કરવાા માાટેે પિ�ક્ચર્સસ અનેે ઓનલાાઈન પિ�ક્ચર્સસ બટનનોો ઉપયોોગ કરોો 
(ફિ�ગ 21). 
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Fig 19

Fig 20

Fig 21
હેેડર અનેે ફૂૂટર ટેેબ પરનાા બાાકીીનાા વિ�કલ્પોો તમનેે હેેડર અનેે ફૂૂટર વિ�ભાાગોો 
વચ્ચેે સરળતાાથીી કૂૂદકોો માારવાા, વિ�ષમ અનેે સમાાન પૃૃષ્ઠોો પર વિ�વિ�ધ હેેડર 
અનેે ફૂૂટર્સસનોો ઉપયોોગ કરવાા અનેે વિ�ભાાગ અનેે માાર્જિ�ન વચે્ચેનાા અંતંરનેે 
સમાાયોોજિ�ત કરવાાનીી મંંજૂૂરીી આપેે છેે (ફિ�ગ 22). 

Fig 22
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Fig 23

6	ત મેે બોોલ્ડ અથવાા ઇટાાલિ�ક ફોોર્મેેટિં�ગ લાાગુુ કરવાા અથવાા તમાારાા 
દસ્તાાવેેજ ટેેક્સ્ટનીી જેમે ફોોન્ટ શૈૈલીી અનેે રંંગ પસંંદ કરવાા માાટેે હોોમ ટેેબ 
પર ફોોન્ટ ફોોર્મેેટિં�ગ વિ�કલ્પોોનોો ઉપયોોગ કરીી શકોો છોો (ફિ�ગ 23). 

Fig 24

7	હે ડર અથવાા ફૂૂટરનેે સંંપાાદિ�ત કરવાાનુંં� સમાાપ્ત કરવાા માાટેે, રિ�બનનીી 
જમણીી બાાજુુએ હેેડર અનેે ફૂૂટર બંંધ કરોો પર ક્લિ�િક કરોો. વૈૈકલ્પિ�િક 
રીીતેે, તમાારાા દસ્તાાવેેજમાંં તેે વિ�સ્તાારોોનીી બહાારનાા સ્થાાન પર ડબલ-
ક્લિ�િક કરોો (ફિ�ગ 24). 

હેડર અથવા ફૂટર સંપાદિત કરો અથવા દૂર કરો : તમે વર્્ડમાાં  હેડર અથવા 
ફૂટર દાખલ કર્યા પછી તેને કોઈપણ સમયે બદલી અથવા દૂર કરી શકો છો.

a	 આ કરવાા માાટેે, ઇન્સર્ટટ  ટેેબ પર જાઓ, હેેડર અથવાા ફૂૂટર પર ક્લિ�િક કરોો 
અને ડ્રોો� પ-ડાાઉન સૂૂચિ�માંંથીી હેેડર અથવાા ફૂૂટર સંંપાાદિ�ત કરોો પસંંદ કરોો. 
આ તમાારાા ફેેરફાારોો કરવાા માાટેે તમાારાા માાટેે તૈૈયાાર વિ�ભાાગ ખોોલશેે.

b	 તેેમનેે દૂૂર કરવાા માાટેે, ડ્રોો� પ-ડાાઉન સૂૂચિ�માંં હેેડર દૂૂર કરોો અથવાા ફૂૂટર દૂૂર 
કરોો પસંંદ કરોો (ફિ�ગ 25). 

Fig 25

કાાર્યય 4 : પૃૃષ્ઠ પૃૃષ્ઠભૂૂમિ� ઘટકોોનેે ગોોઠવોો  

પૃષ્્ઠભૂમિ રંગ ઉમેરો અથવા બદલો

1	 Design > Page Color પર જાઓ.

2	 થીમ કલર્્સ અથવા સ્ટાન્્ડર્્ડ  કલર્્સ હેઠળ તમને જોઈતો રંગ પસંદ કરો.

•	 જો તમને જોઈતો રંગ દેખાતો નથી, તો વધુ રંગો પસંદ કરો અને 
પછી કલર્્સ બોક્સમાાંથી એક રંગ પસંદ કરો.

•	ગ્રેડિય ન્ટ, ટેક્સચર, પટેર્્ન અથવા ચિત્ર ઉમેરવા માટે, ફિલ ઇફેક્્ટ્્સ 
પસંદ કરો અન પછી ગ્રેડિયન્ટ, ટેક્સચર, પટેર્્ન અથવા પિક્્ચર પર 
જાઓ અને વિકલ્્પ પસંદ કરો.
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.પૃૃષ્ઠભૂૂમિ� રંંગ દૂૂર કરોો

1	 Design > Page Color પર જાઓ

2	 No Color પસંદ કરો

પૃષ્્ઠભૂમિ વોટરમાર્્ક  ઉમેરો અથવા બદલો

1	 Design > Watermark પર જાઓ.

2	ગો ોપનીીય હેેઠળ તમનેે જોઈતોો વોોટરમાાર્કક  પસંંદ કરોો અથવાા અસ્વીીકરણ 
અથવાા તાાત્કાાલિ�ક (ફિ�ગ 27).

•	 જો તમનેે જોઈતોો વોોટરમાાર્કક  દેેખાાતોો નથીી, તોો Office.com માંંથીી 
વધુુ વોોટરમાાર્કક  પસંંદ કરોો અથવાા કસ્ટમ વોોટરમાાર્કક  - પિ�ક્ચર 
વોોટરમાાર્કક  અથવાા ટેેક્સ્ટ વોોટરમાાર્કક  પસંંદ કરોો (ટેેક્સ્ટનેે તમનેે જરૂર 
મુુજબ ફોોર્મેેટ કરોો) (ફિ�ગ 28). 

Fig 26

Fig 27

Fig 30

આખાા પૃૃષ્ઠનેે ભરવાા માાટેે પેેટર્નન અનેે ટેેક્સચરનેે પુુનરાાવર્તિ�ત (અથવાા 
“ટાાઇલ્ડ”) કરવાામાંં આવેે છેે. જો તમેે તમાારાા દસ્તાાવેેજનેે વેેબપેેજ તરીીકેે 
સાાચવોો છોો, તોો ટેેક્સચર JPEG ફાાઇલોો તરીીકેે સાાચવવાામાંં આવેે છેે, અનેે 
પેેટર્નન અનેે ગ્રેેડિ�યન્ટ્સ PNG ફાાઇલોો તરીીકેે સાાચવવાામાંં આવેે છેે (ફિ�ગ 26)

Fig 28

પૃષ્્ઠભૂમિ વોટરમાર્્ક  દૂર કરો

3	 Design > Watermark પર જાઓ.

4	 વોટરમાર્્ક  દૂર કરો પસંદ કરો.

પૃષ્્ઠભૂમિ પૃષ્્ઠ બોર્્ડ ર્્સ ઉમેરો અથવા બદલો

1	ડિ ઝાઇન > Page Boarders પેજ બોર્્ડર્્સ  પર જાઓ.

2	પૃ ષ્ઠ હેેઠળ તમનેે જોઈતુંં� પૃૃષ્ઠ બોોર્ડડ ર પસંંદ કરોો બોોર્ડડ ર ટેેબ (ફિ�ગ 29). 

3	 કોઈ નહીીં અથવા બૉક્સ અથવા શેડો અથવા 3-D તરીકે સટેિિંગ લાગુ 
કરવું અથવા કસ્ટમ.

4	 સરહદ રેેખાા અનેે રંંગ અનેે પહોોળાાઈનીી શૈૈલીી લાાગુુ કરવીી કદ અનેે કલાા 
(ફિ�ગ 30. )
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5	 આ બધું લાગુ કર્યા પછી આપણે પૃષ્્ઠ બોર્્ડ રનું પૂર્વાવલોકન કરી 
શકીએ છીએ અને આ સેટિિંગ નીચેના કોઈપણ પૃષ્્ઠઠો પર પણ લાગુ 
કરી શકાય છે.

•	 સમગ્ર દસ્્તતાવેજો

•	 આ વિભાગ

•	 આ વિભાગ - માત્ર પ્રથમ પૃષ્્ઠ (ફિગ 31)

•	 આ વિભાગ - પ્રથમ પૃષ્્ઠ સિવાય તમામ

6	 પછી સમાપ્્ત કરવા માટે OK પર ક્્લલિક કરો

પૃષ્્ઠભૂમિ પૃષ્્ઠ બોર્્ડ ર્્સ દૂર કરો

1	 Design > Page Borders પર જાઓ.

2	 સેટિિંગમાાં કંઈ નહીીં પસંદ કરો અને બરાબર ક્્લલિક કરો.

Fig 29

Fig 31
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IT & ITES	 	 એકસરસાાઈઝ 1.7.32
કોપા (COPA) - વર્્ડ  પ્રોસેસિિંગ સોફ્ટવેર	

દસ્્તતાવેજો સાચવો અને શેર કરો (Save and share documents)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 દસ્્તતાવેજોને વકૈલ્્પપિક ફાઇલ ફોર્મેટમાાં સાચવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી          	 – 1 No. •	 MS Office 2019 / નવીનતમ	 - 1 No. 

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : દસ્્તતાવેજોને વકૈલ્્પપિક ફાઇલ ફોર્મેટમાાં સાચવો 

પૃષ્્ઠ ઓરિએન્ટેશન બદલવા માટે

1	 Select File > Save As.

2	ફ ાઇલ સાચવવા માટે સ્થળ પસંદ કરો અથવા બ્રાઉઝ કરો પસંદ કરો 
અને તમે જ્યયાં ફાઇલ સાચવવા માાંગો છો ત્યયાં જાઓ.

3	 દસ્્તતાવેજ માટે નામ દાખલ કરો.

4	 પ્રકાર તરીકે સાચવો પસંદ કરો અને તમે જ ેફાઇલ ફોર્મેટ કરો છો તે 
પસંદ કરો ઉપયોગ કરવા માાંગો છો. 

5 	સા ાચવોો પસંંદ કરોો  (ફિ�ગ 1).

કાર્્ય 2 : મૂળભતૂ દસ્્તતાવેજ ગુણધર્મોમાાં ફેરફાર કરો

1	ફ ાઇલ ટેબ પર ક્્લલિક કરો.

2	મા ાહિ�તીી પર ક્લિ�િક કરોો પછીી ગુુણધર્મોોનીી વિ�ગતોો જુુઓ (ફિ�ગ 2). 

3	 પૃષ્્ઠની ટોચ પર ગુણધર્મોને ક્્લલિક કરો અને પછી અદ્યતન ગુણધર્મો 
પસંદ કરો.

4	અહી ીં તમે વિશે સારાાંશ વિગતો દસ્્તતાવેજો સંપાદિત કરી શકો છો.

Fig 1
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5	 કસ્ટમ ટેેબ પર ક્લિ�િક કરોો (ફિ�ગ 3). 

•	ન ામ બોક્સમાાં, કસ્ટમ પ્રોપર્ટી માટે નામ લખો, અથવા યાદીમાાંથી 
નામ પસંદ કરો.

Fig 2 Fig 3

Fig 4

•	 પ્રકાર સૂચિમાાં, તમે ઉમેરવા માાંગો છો તે મિલકત માટે ડેટા પ્રકાર 
પસંદ કરો.

•	 મૂલ્ય બોક્સમાાં, મિલકત માટે મૂલ્ય લખો. તમે જ ેમલૂ્ય લખો છો તે 
પ્રકાર સૂચિમાાંની પસંદગી સાથે મેળ ખાતું    હોવું જોઈએ. ઉદાહરણ 
તરીકે, જો તમે પ્રકાર સૂચિમાાં નંબર પસંદ કરો છો, તો તમારે મૂલ્ય 
બોક્સમાાં નંબર    લખવો આવશ્્યક છે. મિલકતના પ્રકાર સાથે મેળ 
ખાતા ન હોય તેવા મૂલ્યો ટેક્સ્ટ તરીકે સંગ્રહિત થાય છે.

6	ઠી ીક ક્લિ�િક કરોો (ફિ�ગ 4).
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કાર્્ય 3 : પ્રિન્ટ સેટિિંગ્્સમાાં ફેરફાર કરો

1	 File > Print પસંદ કરો.

2	 દરેેક પૃૃષ્ઠનુંં� પૂૂર્વાાવલોોકન કરવાા માાટેે, પૃૃષ્ઠનાા તળિ�યેે આગળ અનેે 
પાાછળનાા તીીરોો પસંંદ કરોો (ફિ�ગ 5). 

	 જો ટેેક્સ્ટ વાંંચવાા માાટેે ખૂૂબ નાાનુંં� છેે, તોો તેેનેે મોોટુંં�  કરવાા માાટેે પૃૃષ્ઠનાા 
તળિ�યે ઝૂૂમ સ્લાાઇડરનોો ઉપયોોગ કરોો (ફિ�ગ 6). 

3	ન કલોોનીી સંખં્યાા અનેે તમનેે જોઈતાા કોોઈપણ અન્ય વિ�કલ્પોો પસંંદ કરોો 
અનેે પ્રિ�ન્ટ બટન પસંંદ કરોો (ફિ�ગ 7). 

કાર્્ય 4 : દસ્્તતાવેજોને ઇલકે્ટ્રો નિક રીતે શેર કરો

1	 File > Share કરો ક્્લલિક કરો.

2	ત મેે લોોકોો સાાથેે શેેર કરીીનેે અથવાા ઈમેલે દ્વાારાા અથવાા ઓનલાાઈન 
પ્રસ્તુતુ કરીીનેે અથવાા બ્લોોગ પોોસ્ટ  કરીીનેે દસ્તાાવેેજ શેેર કરીી શકોો છોો 
(ફિ�ગ 8). 

3	 જો તમે લોકો સાથે શેરનો વિકલ્્પ પસંદ કરવા માાંગતા હોવ તો તમારા 
દસ્્તતાવેજને OneDrive ક્્લલાઉડમાાં સાચવો, જો તે પહેલાથી ત્યયાં ન હોય 
તો.

4	 જો તમારો દસ્્તતાવેજ હાલમાાં OneDrive માાં સાચવેલ ન હોય તો શેર 
વિન્્ડડો પ્રદર્શિત થાય છે. OneDrive વિકલ્્પ પસંદ કરો, પછી તમારા 
દસ્્તતાવેજને નામ આપો અને ઓકે પસંદ કરો.

નોોંધ: શેર કરતા પહેલા, કૃપા કરીને ખાતરી કરો કે પ્રેષક અને 
પ્રાપ્્તકર્તા પાસે Microsoft Outlook ઈમેલ એકાઉન્ટ અથવા 
Microsoft O365 સબ્સસ્ક્્રાઇબ કરેલ સંસ્થા ઈમેલ એકાઉન્ટ 
હોવું આવશ્્યક છે.

5	તમ ે જનેી સાથે શેર કરવા માાંગો છો તે લોકોના ઈમેલ એડ્્રરેસ દાખલ કરો 
અને તમે પરવાનગી આપવા માાંગો છો તે માટે પસંદગી કરો.

6	 જો તમે ઇચ્છો તો સંદેશ લખો અને મોકલો પસંદ કરો.

	તમ  જ ેલોકો સાથે શેર કરી રહ્યયાં છો તેઓને તમારા દસ્્તતાવેજની લિિંક 
સાથે તમારા તરફથી મેઇલ મળશે.

Fig 5

Fig 6

Fig 7

Fig 8
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IT & ITES	 	 એકસરસાાઈઝ 1.7.33
કોપા (COPA) - વર્્ડ  પ્રોસેસિિંગ સોફ્ટવેર	

મદુ્દાઓ માટે દસ્્તતાવેજોનું નિરીક્ષણ કરો (Inspect documents for issues)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 છુપાયેલા ગુણધર્મો અને વ્્યક્્તતિગત માહિતી શોધો અને દૂર કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 – 1 No. •	 MS Office 2019 / નવીનતમ		              - 1 No. 

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : છુપાયેલા ગુણધર્મો અને વ્્યક્્તતિગત માહિતી શોધો અને દૂર કરો

વર્્ડ  દસ્્તતાવેજોમાાં છુપાયેલ ડેટા અને વ્્યક્્તતિગત માહિતી શોધવા 
અને દૂર કરવા માટે તમ દસ્્તતાવેજ નિરીક્ષકનો ઉપયોગ કરી 
શકો છો. તમે તમારા વર્્ડ  ડોક્યુમેન્ટની ઈલકે્ટ્રો નિક કોપી, જમે 
કે ઈ-મેલ એટેચમેન્ટ શેર કરો તે પહેલાાં ડોક્યુમેન્ટ ઈન્્સ્પપેક્ટરનો 
ઉપયોગ કરવો એ સારો વિચાર છે.

1	 વર્્ડ  ડોક્યુમેન્ટ ખોલો જ ેતમે છુપાયેલા ડેટા અને વ્્યક્્તતિગત માહિતી 
માટે તપાસવા માાંગો છો.

2	ફ ાઇલ ટેબ પર ક્્લલિક કરો, આ રીતે સાચવો પર ક્્લલિક કરો અને પછી 
તમારા મૂળ દસ્્તતાવેજની નકલ સાચવવા માટે ફાઇલ નામ બોક્સમાાં 
નામ લખો.

3	તમ ારા મૂળ દસ્્તતાવેજની નકલમાાં, ફાઇલ ટેબ પર ક્્લલિક કરો અને પછી 
માહિતી પર ક્્લલિક કરો.

4	મુ દ્દાાઓ માાટેે તપાાસોો પર ક્લિ�િક કરોો અનેે પછીી દસ્તાાવેેજનુંં� નિ�રીીક્ષણ 
કરોો પર ક્લિ�િક કરોો (ફિ�ગ 1). 

5	 દસ્તાાવેેજ નિ�રીીક્ષક સંંવાાદ બોોક્સમાંં, તમેે તપાાસવાા માંંગોો છોો તેે છુુપાાયેેલ 
સાામગ્રીીનાા પ્રકાારોોનેે પસંંદ કરવાા માાટેે ચેેક બોોક્સ પસંંદ કરોો (ફિ�ગ 2). 

6 	તપા ાસોો ક્લિ�િક કરોો (ફિ�ગ 3).

Fig 1

Fig 2

Fig 3
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7	 દસ્તાાવેેજ નિ�રીીક્ષક સંંવાાદ બોોક્સમાંં નિ�રીીક્ષણનાા પરિ�ણાામોોનીી સમીીક્ષાા 
કરોો (ફિ�ગ 4). 

8	ત મેે તમાારાા દસ્તાાવેેજમાંંથીી જે ેછુુપાાયેેલાા સાામગ્રીીનેે દૂૂર કરવાા માંંગોો છોો 
તેેનાા માાટેે નિ�રીીક્ષણ પરિ�ણાામોોનીી બાાજુુમાંં બધાાનેે દૂૂર કરોો પર ક્લિ�િક કરોો 
(ફિ�ગ 5). 

Fig 4

Fig 5
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કાર્્ય 2 : ઍક્સેસિબિલિટી સમસ્્યયાઓ શોધો અને તેને ઠીક કરો ઍક્સેસિબિલિટી તપાસનારનો ઉપયોગ કરો

1 	 Microsoft Office એપ્્લલિકેશનના રિબન પર, સમીક્ષા ટેબ પસંદ કરો. 
જો તમે આઉટલુકનો ઉપયોગ કરી રહ્યયાં છો, તો તમને મેસેજ લખતી 
વખતે કે જવાબ આપતી વખતે જ રિવ્્યયૂ ટેબ દેખાશે.

2 	 ચેક એક્સેસિબિલિટી સ્્પ્લલિટ બટનનો ઉપરનો ભાગ પસંદ 
કરો. ઍક્સેસિબિલિટી ફલક સ્ક્રીનની જમણી બાજુએ ખુલે છે. 
ઍક્સેસિબિલિટી રિબન સ્ક્રીનની ટોચ પર સક્રિય થાય છે.

	 ટીીપ: વધુુ વિ�કલ્પોો જોવાા માાટેે, ઍકે્સેસિ�બિ�લિ�ટીી તપાાસોો બટનનોો 
નીીચેેનોો ભાાગ પસંંદ કરોો (ફિ�ગ 6).

3 	 ઍક્સેસિબિલિટી ફલકમાાં, ભલામણ કરેલ ક્રિયાઓ લાગુ કરોમાાં 
સૂચના મુજબ તારણોની સમીક્ષા કરો અને તેને સંબોધિત કરો.

ભલામણ કરેલ ક્રિયાઓ લાગુ કરો : ઍક્સેસિબિલિટી ફલકમાાં, તમે 
ભૂલો, ચતેવણીઓ અને દરેક માટે કેવી રીતે ઠીક કરવી તે ભલામણો 
સાથેની ટિપ્સ જોશો. સમસ્્યયાઓને ઝડપથી ઠીક કરવા માટે, ભલામણ 
કરેલ ક્રિયાઓમાાંથી એક લાગુ કરો. તારણો કેવી રીતે વર્ગીકૃત કરવામાાં 
આવે છે તેના પર વધુ માહિતી માટે, ઍક્સેસિબિલિટી તપાસનાર માટેના 
નિયમો પર જાઓ.

1	 ઍક્સેસિબિલિટી ફલકમાાં, ચતેવણીઓ અથવા ભૂલો હેઠળ સમસ્્યયા 
પસંદ કરો. સૂચિ વિસ્્તરે છે અને સમસ્્યયાથી પ્રભાવિત વસ્્તતુઓ અને 
ઑબ્્જજેક્ટ બતાવે છે.

	 ટીપ: અસરગ્રસ્્ત વસ્્તતુ અથવા ઑબ્્જજેક્ટનું ચોક્કસ સ્થાન જોવા માટે, 
આઇટમ અથવા ઑબ્્જજેક્ટ પસંદ કરો.

2	 સમસ્યાાનેે ઉકેેલવાા માાટેે, તેેનીી પાાસેેનાા ડાાઉન એરોો બટનનેે પસંંદ કરોો. 
ભલાામણ કરેેલ ક્રિ�યાાઓનીી સૂૂચિ� ખુુલેે છેે (ફિ�ગ 7).  

3	 એક ક્્લલિક ફિક્સ લાગુ કરવા માટે, ભલામણ કરેલ ક્રિયાઓની 
સૂચિમાાંથી એક ક્રિયા પસંદ કરો. પ્રતિ વધુ વિકલ્્પપો જુઓ, ક્રિયાની 
બાજુમાાં જમણું એરો બટન પસંદ કરો (જો ઉપલબ્ધ હોય તો).

4	 ચતેવણીઓ હેઠળ દરેક મુદ્દા પર જાઓ અન ઉકેલો અને ભૂલો.

ઍક્સેસિબિલિટી તપાસનાર દેખાતો નથી? : જો તમને સમીક્ષા ટેબ પર 
ઍક્સેસિબિલિટી તપાસો બટન દેખાતું નથી, તો તમારી પાસે એપ્્લલિકેશનનું 
જૂનું સંસ્કરણ હોઈ શકે છે. અનુસરો જૂના એપ્્લલિકેશન સંસ્કરણમાાં 
ઍક્સેસિબિલિટી તપાસનારને ખોલવા માટે આ પગલાાંઓ:

1	 File > Info પસંદ કરો.

2	મુ ુદ્દાાઓ માાટેે તપાાસોો બટન પસંંદ કરોો (ફિ�ગ 8). 

	 ટીપ: તપાસો સુલભતા બટનની જમણી બાજુએ, તપાસ શીર્્ષક હેઠળ, 
કોઈપણ સંભવિત સમસ્્યયાઓની સૂચિ છે.

3	મુ ુદ્દાાઓ માાટેે તપાાસોો ડ્રોો� પ-ડાાઉન મેેનુુમાંં, પસંંદ કરોો ઍક્સેેસિ�બિ�લિ�ટીી 
તપાાસોો (ફિ�ગ 9). 

Fig 6

Fig 7

Fig 8
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4	 ઍક્સેેસિ�બિ�લિ�ટીી તપાાસનાાર કાાર્યય ફલક આગળ દેેખાાય છેે તમાારીી 
સાામગ્રીી પર અનેે નિ�રીીક્ષણ પરિ�ણાામોો બતાાવેે છેે (ફિ�ગ 10).

Fig 9

Fig 10

Fig 11

5	 સમસ્યાા શાા માાટેે અનેે કેેવીી રીીતેે ઠીીક કરવીી તેેનીી માાહિ�તીી જોવાા માાટેે, 
નિ�રીીક્ષણ પરિ�ણાામોો હેેઠળ, સમસ્યાા પસંંદ કરોો. પરિ�ણાામોો વધાારાાનીી 
માાહિ�તીી હેેઠળ દેેખાાય છેે, અનેે તમેે તમાારીી ફાાઇલમાંં અપ્રાાપ્ય સાામગ્રીી 
તરફ નિ�ર્દેશિ�ત (ફિ�ગ 11).
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કાર્્ય 3 : સુસંગતતા સમસ્્યયાઓ શોધો અને તેને ઠીક કરો

પહેલાનાાં સંસ્કરણો સાથે ફાઇલ સુસંગતતા તપાસો

સુસંગતતા તપાસનારનો ઉપયોગ કરીને તમે તમારી Microsoft Office 
ફાઇલોના સંસ્કરણો વચ્ચે સુસંગતતા તપાસી શકો છો કે ફાઇલમાાંના 
લક્ષણો Officeના જૂના સંસ્કરણો દ્વારા સમર્થિત છે કે કેમ તે જોવા માટે.

ઓફિસના જૂના સંસ્કરણ સાથે સુસંગતતા તપાસવા માટે

1 	ફ ાઇલ ટેબ પર ક્્લલિક કરો અને પછી માહિતી પર ક્્લલિક કરો.

2	 મુદ્દાઓ માટે તપાસો પર ક્્લલિક કરો અને પછી સુસંગતતા તપાસો પર 
ક્્લલિક કરો.

3	સં ંસ્કરણોો વચ્ચેેનીી કોોઈપણ સમસ્યાાઓ સુુસંંગતતાા તપાાસનાાર વિં�ડોોમાંં 
સાારાંંશ હેેઠળ સૂૂચિ�બદ્ધ છેે (ફિ�ગ 12). 

Fig 12
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IT & ITES	 	 એકસરસાાઈઝ 1.8.34
કોપા (COPA) - ફોર્મેટ દસ્્તતાવેજો	

ટેક્સ્ટ અને ફકરા દાખલ કરો (Insert text and paragraphs)
ઉદ્દેશ્્યયો : આ એકસરસાઈઝ (Exercise) ના અતંે તમે શીખી શકશો:
•	 ટેક્સ્ટ શોધો અને બદલો
•	 પ્રતીકો અને વિશિષ્્ટ અક્ષરો દાખલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટેક્સ્ટ શોધો અને બદલો

1	 Go to Home > Replace અથવા Ctrl + H પર જાઓ

2	 શું શોધો માાં તમે બદલવા માાંગો છો તે શબ્દ અથવા શબ્દસમહૂ દાખલ 
કરો.

3	 સાથે બદલો માાં તમારુું  નવું લખાણ દાખલ કરો.

4	 શબ્દ અથવા શબ્દસમહૂની બધી ઘટનાઓને બદલવા માટે બધાને 
બદલો પસંદ કરો. અથવા, જ્યયાં સુધી તમે અપડેટ કરવા માાંગો છો તે ન 
મળે ત્યયાં સુધી આગળ શોધો પસંદ કરો અને પછી બદલો પસંદ કરો.

5	 તમારી શોધમાાં ફક્્ત અપર કે લોઅરકેસનો ઉલ્્લલેખ કરવા માટે,   
More > Match case પસંદ કરો. આ મેનૂમાાં શોધવા માટેની અન્ય 
ઘણી રીતો છે.

•	 MS Office 2019 / નવીનતમ		  - 1 No.
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કાર્્ય 2 : પ્રતીકો અને વિશિષ્્ટ અક્ષરો દાખલ કરો

1	 Go to Insert > Symbol. 2	 પ્રતીક ચૂંટો, અથવા વધુ પ્રતીકો પસંદ કરો.

3	 પ્રતીક અથવા વિશિષ્્ટ અક્ષર ટેબ પસંદ કરો અને તમે જ ેદાખલ કરવા 
માાંગો છો તે શોધવા માટે ઉપર અથવા નીચે સ્ક્રોલ કરો.

4	જ્યા રે તમને જોઈતું પ્રતીક અથવા વિશિષ્્ટ પાત્ર મળે, ત્યારે તેના પર 
ડબલ ક્્લલિક કરો. પ્રતીક તમારી ફાઇલમાાં  દાખલ કરવામાાં આવશે.

5	 બંધ પસંદ કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.8.35
કોપા (COPA) - ફોર્મેટ દસ્્તતાવેજો	

ટેક્સ્ટ અને ફકરાઓને ફોર્મેટ કરો (Format text and paragraphs)
ઉદ્દેશ્્યયો : આ એકસરસાઈઝ (Exercise) ના અતંે તમે શીખી શકશો:
•	 ટેક્સ્ટ ઇફેક્્ટ્્સ લાગુ કરો
•	 ફોર્મેટ પેઇન્ટરનો ઉપયોગ કરીને ફોર્મેટિિંગ લાગુ કરો
•	 રેખા અને ફકરાનું અતંર અને ઇન્્ડડેન્ટેશન સેટ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાાર્યયપદ્ધતિ� (PROCEDURE)

કાાર્યય 1 : ટેેક્સ્ટ ઇફેેક્ટ્્સ લાાગુુ કરોો  

ઇફેક્ટ ટેક્સ્ટ ઇફેક્ટ ઉમેરો

1	 તે ટેક્સ્ટ પસંદ કરો કે જમેાાં તમે અસર ઉમેરવા માાંગો છો.

2	 હોમ ટેબ પર, ફોન્ટ જૂથમાાં, ટેક્સ્ટ ઇફેક્ટ પર ક્્લલિક કરો. (ફિગ 1)

3	 તમને જોઈતી અસર પર ક્્લલિક કરો. વધુ પસંદગીઓ માટે, આઉટલાઈન, 
શેડો, રિફ્્લલેક્શન અથવા ગ્્લલો પર નિર્દેશ કરો અને પછી તમે જ ેઈફેક્ટ 
ઉમેરવા માાંગો છો તેને ક્્લલિક કરો. (ફિગ 2)

ટેક્સ્ટમાાંથી અસર દૂર કરો

1	 જ ેટેક્સ્ટમાાંથી તમે અસર દૂર કરવા માાંગો છો તેને પસંદ કરો.

2	હો ોમ ટેેબ પર, ફોોન્ટ જૂૂથમાંં, ફોોર્મેેટિં�ગ સાાફ કરોો ક્લિ�િક કરોો. (ફિ�ગ 3)

કાાર્યય 2 : ફોોર્મેેટ પેેઇન્ટરનોો ઉપયોોગ કરીીનેે ફોોર્મેેટિં�ગ લાાગુુ કરોો

2  	 ફોર્મેટ પેઇન્ટર પસંદ કરવા માટે:

હોમ ટેબ પર, ક્્લલિપબોર્્ડમા ાં ફોર્મેટ પેઇન્ટર પસંદ કરો જૂથ (ફિગ 4)

3	 કર્્સર પેઇન્ટબ્રશ આઇકોનમાાં બદલાય છે.

4	ફો ોર્મેેટિં�ગ લાાગુુ કરવાા માાટેે ટેેક્સ્ટ અથવાા ગ્રાાફિ�ક્સનીી પસંંદગીી પર 
પેેઇન્ટ કરવાા માાટેે બ્રશનોો ઉપયોોગ કરોો. આ  માાત્ર એક જ વાાર કાામ કરેે 

Fig 1

Fig 3

Fig 2

•	 MS Office 2019 / નવીનતમ	 - 1 No.

1	 ટેક્સ્ટ અથવા ગ્રાફિક પસંદ કરો કે જમેાાં ફોર્મેટિિંગ હોય તમે નકલ કરવા 
માાંગો છો.

નોોંધ: જો તમ ટેક્સ્ટ ફોર્મેટિિંગની નકલ કરવા માાંગતા હો, 
તો ફકરાનો એક ભાગ પસંદ કરો. જો તમે ટેક્સ્ટ અને ફકરા 
ફોર્મેટિિંગની નકલ કરવા માાંગતા હો, તો ફકરાના ચિહ્ન સહિત 
સમગ્ર ફકરો પસંદ કરો.
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છેે. તમાારાા દસ્તાાવેેજમાંં બહુુવિ�ધ પસંંદગીીઓનાા ફોોર્મેેટનેે બદલવાા માાટેે, 
તમાારેે પહેેલાા ફોોર્મેેટ પેેઇન્ટર પર ડબલ-ક્લિ�િક કરવુંં� આવશ્યક છેે.

5	 ફોર્મેટિિંગ રોકવા માટે, ESC દબાવો

કાાર્યય 3 : રેેખાા અનેે ફકરાાનુંં� અંતંર અનેે ઇન્ડેેને્ટેશન સેેટ કરોો

ફકરા ઇન્્ડડેન્ટ અને અતંર બદલો

1	 એક અથવા વધુ ફકરા પસંદ કરો જનેે તમે સમાયોજિત કરવા માાંગો છો. 
(ફિગ 5)

2	હો ોમ પર જાઓ અનેે પછીી ફકરોો ડાાયલોોગ બોોક્સ લોોન્ચર પસંંદ કરોો. 
(ફિ�ગ 6)

3	 ઇન્ડેેન્ટ અનેે અંતંર ટેેબ પસંંદ કરોો.

જનરલ

	 ગોઠવણી	ચી ીંથરેહાલ જમણી ધાર સાથે ટેક્સ્ટને ડાબી બાજુએ સંરેખિત કરવા માટે ડાબે પસંદ કરો (અથવા કીબોર્્ડ નો ઉપયોગ કરો
		  શોર્્ટકટ, Ctrl+L).

		ચી  ીંથરેહાલ ડાબી અને જમણી ધાર (Ctrl+E) સાથે કેન્દદ્રથી મધ્્યમાાં ટેક્સ્ટ પસંદ કરો. 

		ચી  ીંથરેહાલ ડાબી ધાર (Ctrl+R) સાથે જમણી બાજુએ ટેક્સ્ટને સંરેખિત કરવા માટે જમણે પસંદ કરો.

		  શબ્દો (Ctrl+J) વચ્ચે જગ્્યયા ઉમેરીને, ટેક્સ્ટને ડાબે અને જમણે બંને સંરેખિત કરવા માટે જસ્ટિફાઈ પસંદ કરો.

	 રૂપરેખા સ્્તર	 આઉટલાઇન વ્્યયૂમાાં ફકરો જ ેસ્્તર પર દેખાય છે.

		  જો તમે ડિફૉલ્ટ રૂપે સંકુચિત હેડિિંગ સાથે દસ્્તતાવેજ ખોલવા માાંગતા હોવ તો ડિફૉલ્ટ રૂપે સંકુચિત પસંદ કરો.
ઇન્્ડડેન્ટેશન

	 ડાબી	 તમે પસંદ કરો છો તે રકમ દ્વારા ડાબી બાજુના ફકરાને ઇન્્ડડેન્ટ કરે છે.

Fig 4

Fig 5

Fig 6
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	 જમણી	 તમે પસંદ કરો છો તે રકમ દ્વારા જમણી બાજુના ફકરાને ઇન્્ડડેન્ટ કરે છે.

	 ખાસ	 ફકરાની પ્રથમ લાઇનને ઇન્્ડડેન્ટ કરવા માટે પ્રથમ First line > By દ્વારા પસંદ કરો.

		હે  ેં ગિિંગ પસંદ કરો > દ્વારા હેેં ગિિંગ ઇન્્ડડેન્ટ બનાવવા માટે. 

	મિ રર ઇન્્ડડેન્્ટ્્સ	જ્યા રે તમે આ પસંદ કરો છો, ત્યારે ડાબે અને જમણે અંદર અને બહાર બની જાય છે. આ પુસ્્તક શૈલી પ્રિન્ટટીંગ માટે છે.

અતંર

	 પહેલાાં	 ફકરા પહેલાાં જગ્્યયાની માત્રાને સમાયોજિત કરે છે.

	 પછી	 ફકરા પછી જગ્્યયાની માત્રાને સમાયોજિત કરે છે.

	 રેખા અતંર	 સિિંગલ ટુ સિિંગલ-સ્્પપેસ ટેક્સ્ટ પસંદ કરો.

		  એક અતંર કરતાાં દોઢ ગણા સ્્પપેસ ટેક્સ્ટ માટે 1.5 લીટીઓ પસંદ કરો. 	

		  ડબલ ટુ ડબલ-સ્્પપેસ ટેક્સ્ટ પસંદ કરો.

		  લાઇન પર સૌથી મોટા ફોન્ટ અથવા ગ્રાફિકને ફિટ કરવા માટે જરૂરી અતંરની ન્યૂનતમ રકમ સેટ કરવા માટે 

		  At least > At પસંદ કરો.

		  ચોક્કસ રેખા અતંર સેટ કરવા Exactly > At પર પસંદ કરો, જ ેપોઈન્ટમાાં દર્શાવવામાાં આવે છે.

		  વધુુ સંખં્યાામાંં દર્શાાવવાામાંં આવેેલાા બહુુવિ�ધ તરીીકેે રેેખાા અંતંર સેેટ કરવાા માાટેે Multiple > At પર પસંંદ કરોો

	 ઉમેેરશોો નહીંં	જ્યા ારેે તમનેે ફકરાા વચ્ચેે વધાારાાનીી જગ્યાા ન જોઈતીી હોોય ત્યાારેે ફકરાા વચ્ચેે જગ્યાા ન ઉમેેરોો પસંંદ કરોો.

જો તમે તમારા ડિફોલ્ટ તરીકે પસંદ કરેલ સટેિિંગ્્સને સાચવવા માાંગતા હો, 
તો ડિફોલ્ટ તરીકે સેટ કરો પસંદ કરો.

4	 લાઇન અને પેજ બ્રેક્સ ટેબ પસંદ કરો

પેજ પર અથવા કૉલમમાાં ફકરાની રેખાઓ એકસાથે રાખો

1	 ફકરા પસંદ કરો જમેાાં તમે ઇચ્છો છો તે લીટીઓ ધરાવે છેસાથે રાખો.

2	 વર્્ડમા ાં હોમ ટેબ પર, ફકરો પસંદ કરોડાયલોગ બોક્સ લોન્ચર   .

3	 લાઇન અને પેજ બ્રેક્સ ટેબ પસંદ કરો.

4	 પૃષ્્ઠ ક્રમાાંક હેઠળ, રેખાઓ સાથે રાખો પસંદ કરો.

5	 બરાબર પસંદ કરો.

પેજ પર અથવા કૉલમમાાં ફકરાઓને એકસાથે રાખો

1	 હોમ ટેબ ‘ ફકરો ડાયલોગ બોક્સ લોન્ચર  પસંદ કરો 

2	 લાઇન અને પેજ બ્રેક્સ ટેબ પસંદ કરો.

3	 પૃષ્્ઠ ક્રમાાંક હેઠળ, આગામી સાથે Keep પસંદ કરો.

4	 બરાબર પસંદ કરો.

ફકરા પહેલા હંમશેા પેજ બ્રેક કરવાની ફરજ પાડો

1	 હોમ ટેબ ‘ ફકરો ડાયલોગ બોક્સ લોન્ચર   પસંદ કરો 

2	 લાઇન અને પેજ બ્રેક્સ ટેબ પસંદ કરો.

3	 પૃષ્્ઠ ક્રમાાંક હેઠળ, પૃષ્્ઠ વિરામ પહેલા પસંદ કરો.

4	 બરાબર પસંદ કરો.

વિધવા અને અનાથ રેખાઓને નિયંત્રિત કરો

1	 હોમ ટેબ   ફકરો ડાયલોગ બોક્સ લોન્ચ   પસંદ કરો 

2	 લાઇન અને પેજ બ્રેક્સ ટેબ પસંદ કરો.

3	 પૃષ્્ઠ ક્રમાાંક હેઠળ, વિધવા/અનાથ નિયંત્રણ પસંદ કરો.

4	 બરાબર પસંદ કરો.

નોોંધ: આ વિકલ્્પ મૂળભતૂ રીતે ચાલુ છે.

ફકરામાાંથી રેખા નંબરોને દબાવો અથવા ફકરા

1	 હોમ ટેબ   ફકરો ડાયલોગ બોક્સ લોન્ચર પસંદ કરો. 

2	 લાઇન અને પેજ બ્રેક્સ ટેબ પસંદ કરો.

3	 ફોર્મેટિિંગ હેઠળ, રેખા નંબરોને દબાવો પસંદ કરો.

4	 બરાબર પસંદ કરો.

ફકરા અથવા ફકરામાાંથી હાઇફન્્સ દૂર કરો

1	 હોમ ટેબ ‘ ફકરો ડાયલોગ બોક્સ લોન્ચર   પસંદ કરો 

2	 લાઇન અને પેજ બ્રેક્સ ટેબ પસંદ કરો.

3	 ફોર્મેટિિંગ હેઠળ, હાઇફેનેટ કરશો નહીીં પસંદ કરો.

4	 બરાબર પસંદ કરો. 

ટેક્સ્ટ બોક્સ વિકલ્્પપો

તમે ટેક્સ્ટ બૉક્સની આસપાસના ટેક્સ્ટને વધુ ચુસ્્તપણે લપેટીને ટેક્સ્ટ 
બૉક્સ વિકલ્્પપોનો ઉપયોગ કરી શકો છો. આ વિકલ્્પપોનો ઉપયોગ કરવા 
માટે, ટેક્સ્ટ બોક્સની બોર્્ડ ર પારદર્્શક હોવી જોઈએ (કોઈ લાઇન અને કોઈ 
ભરણ નહીીં), અને લપેટી ટેક્સ્ટ ટાઇટ અથવા થ્રુ પર સેટ હોવી આવશ્્યક 
છે.
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1	 હોમ ટેબ    ફકરો ડાયલોગ બોક્સ લોન્ચર પસંદ કરો.

2	 લાઇન અને પેજ બ્રેક્સ ટેબ પસંદ કરો.

3	 ટેક્સ્ટબોક્સ વિકલ્્પપો હેઠળ, ટાઈટ રેપ સૂચિમાાં, પસંદ કરો નીચેનામાાંથી 
એક:

•	 બધા

•	 પ્રથમ અને છેલ્્લલી લીટીઓ

•	 માત્ર પ્રથમ લાઇન

•	મા ાત્ર છેેલ્લીી લાાઇન

નોોંધ: ફેરફારો પૂર્્વવત્ કરવા માટે, કંઈ નહીીં પસંદ કરો.

4	 બરાબર પસંદ કરો.

5	 તમારા સેટિિંગ્્સ પસંદ કરો, અને પછી બરાબર પસંદ કરો

કાાર્યય 4 : ટેેક્સ્ટમાંં બિ�લ્ટ-ઇન શૈૈલીીઓ લાાગુુ કરોો

1	 તમે ફોર્મેટ કરવા માાંગો છો તે ટેક્સ્ટ પસંદ કરો.

2	 હોમ ટેબ પર, તેનું પરૂ્વાવલોકન કરવા માટે શૈલી તરફ નિર્દેશ કરો.

જો તમને જોઈતી શૈલી દેખાતી નથી, તો ગેલેરીને વિસ્્તતૃત કરવા માટે વધુ 
બટનને ક્્લલિક કરો.

3	શૈ ૈલીી પસંંદ કરોો.

હેડિિંગનો ઉપયોગ કરવાથી તમે View > Navigation પેનનો ઉપયોગ 
કરીને દસ્્તતાવેજના ભાગોને આસપાસ ખસેડી શકો છો અને પછી 
દસ્્તતાવેજમાાં સૂચિબદ્ધ મથાળાઓને ઉપર અથવા નીચે ખસેડી શકો છો. 
શીર્્ષકોનો ઉપયોગ સામગ્રીના કોષ્્ટકની રચનામાાં પણ થઈ શકે છે.
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કાાર્યય 5 : ફોોર્મેેટિં�ગ સાાફ કરોો

ફોર્મેટિિંગ પૂર્્વવત્ કરો

છેલ્્લલા ફોર્મેટિિંગ ફેરફારને પૂર્્વવત્     કરવા માટે પૂર્્વવત્ કરો પસંદ કરો. 

બધા ફોર્મેટિિંગ સાફ કરો

1	 તમે સાફ કરવા માાંગો છો તે ફોર્મેટિિંગ સાથેનો ટેક્સ્ટ પસંદ કરો.

2	 Home > Clear બધા ફોર્મેટિિંગ સાફ કરો    પસંદ કરો અથવા 
Ctrl + Spacebar દબાવો  
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IT & ITES	 	 એકસરસાાઈઝ 1.8.36
કોપા (COPA) - ફોર્મેટ દસ્્તતાવેજો	

દસ્્તતાવેજ વિભાગો બનાવો અને ગોઠવો (Create and configure document sections)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંંતેે તમેે શીીખીી શકશોો
•	 બહુવિધ કૉલમમાાં ટેક્સ્ટ ફોર્મેટ કરો
•	 પૃષ્્ઠ, વિભાગ અને કૉલમ વિરામ દાખલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : બહુવિધ કૉલમમાાં ટેક્સ્ટને ફોર્મેટ કરો 

તમે કૉલમ ઉમેરીને તમારા દસ્્તતાવેજને અખબાર-શૈલીના કૉલમ લેઆઉટમાાં 
ફોર્મેટ કરી શકો છો. લેઆઉટ ટેબ પર, કૉલમ પર ક્્લલિક કરો, પછી તમને 
જોઈતા લેઆઉટ પર ક્્લલિક કરો.

1	 તમારા કર્્સર સાથે, તમારા દસ્્તતાવેજના માત્ર ભાગ પર કૉલમ લાગુ 
કરવા માટે, તમે જ ેટેક્સ્ટને ફોર્મેટ કરવા માાંગો છો તેને પસંદ કરો.

2	 લેઆઉટ ટૅબ પર, કૉલમ પર ક્્લલિક કરો, પછી વધુ કૉલમ પર ક્્લલિક 
કરો.

3	 લાગુ કરો બોક્સમાાંથી પસંદ કરેલ ટેક્સ્ટ પર ક્્લલિક કરો અને પછી 
બરાબર ક્્લલિક કરો.

કાર્્ય 2 : પૃષ્્ઠ, વિભાગ અને કૉલમ વિરામ દાખલ કરો

પેજ બ્રેક્સ દાખલ કરો

1	 તમારુું  કર્્સર મૂકો જ્યયાં તમે એક પૃષ્્ઠ સમાપ્્ત કરવા માાંગો છો અને  શરૂ 
કરવા માટે આગામી.

2	 Insert > Page Break  પર જાઓ.

ટીપ: જો Word તમારા દસ્્તતાવેજમાાં અનપેક્ષિત રીતે નવું પૃષ્્ઠ મૂકે છે, તો તે 
પૃષ્્ઠ વિરામને કારણે હોઈ શકે છે. પૃષ્્ઠ વિરામ જોવા માટે જથેી કરીને તમે 
તેમને પસંદ કરી અને કાઢી શકો, Home > Show/Hide પર જાઓ
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વિભાગ વિરામ દાખલ કરો

1	 તમે જ્યયાંથી નવો વિભાગ શરૂ કરવા માાંગો છો તે પસંદ કરો.

2	 Layout > Breaks પર જાઓ.

તમને જોઈતા વિભાગ વિરામનો પ્રકાર પસંદ કરો:

•	 આગલું પૃષ્્ઠ વિભાગ વિરામ નીચેના પૃષ્્ઠ પર નવો વિભાગ શરૂ કરે છે.

•	 સતત વિભાગ વિરામ એ જ પૃષ્્ઠ પર નવો વિભાગ શરૂ કરે છે. આ 
વિભાગ વિરામના પ્રકારનો ઉપયોગ ઘણીવાર નવું પૃષ્્ઠ શરૂ કર્યા વિના 
કૉલમની સખં્યા બદલવા માટે થાય છે.

•	 ઈવન પેજ સેકશન બ્રેક આગામી સમ-ક્રમાાંકિત પેજ પર એક નવો 
વિભાગ શરૂ કરે છે.

•	 વિષમ પૃષ્્ઠ વિભાગ વિરામ આગલા વિષમ-ક્રમાાંકિત પૃષ્્ઠ પર એક 
નવો વિભાગ શરૂ કરે છે.

કૉલમ વિરામ દાખલ કરો

જો તમે દસ્્તતાવેજને કૉલમ સાથે ફોર્મેટ કરો છો (જમે કે કેટલાક ન્યૂઝલેટર 
લેઆઉટમાાં છે), તો ટેક્સ્ટ આપમેળે એક કૉલમમાાંથી બીજી કૉલમમાાં 
વહેશે. દસ્્તતાવેજ ફોર્મેટ પર વધુ નિયંત્રણ માટે તમે તમારા પોતાના કૉલમ 
બ્રેક્સ દાખલ કરી શકો છો.

1	 જ્યયાં તમે કૉલમ તૂટવા માગો છો ત્યયાં તમારુું  કર્્સર મૂકો.

2	 Layout > Breaks પર ક્્લલિક કરો.

3	 વિકલ્્પપો સાથેનું મેનુ દેખાશે. કૉલમ પર ક્્લલિક કરો.

4	 કૉલમ વિરામ દાખલ કરવામાાં આવે છે. તેને જોવા માટે Home > 
Show/Hide પર ક્્લલિક કરો.

ટીપ: કીબોર્્ડ  શોર્્ટકટ Ctrl+Shift+Enter એ કૉલમ બ્રેક પણ દાખલ કરે 
છે જ્યયાં તમે તમારુું  કર્્સર મૂક્્યુું છે.
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કાર્્ય 3 : વિભાગ માટે પૃષ્્ઠ સેટઅપ વિકલ્્પપો બદલો

1	 વર્્ડમા ાં લેઆઉટ ટેબ પર, પેજ સેટઅપ લોન્ચર પસંદ કરો.

2 	 લેઆઉટ વિકલ્્પ ‘ વિભાગ ‘ વિભાગ પ્રારંભ પસંદ કરો

3 	 તમે ઇચ્છો તે પ્રમાણે પૃષ્્ઠ સેટઅપ પસંદ કરો.

4 	 પછી પૂર્્ણ કરવા માટે OK પર ક્્લલિક કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.9.37
કોપા (COPA) - કોષ્્ટકો અને સૂચિઓનું સંચાલન કરો	

કોષ્્ટકો બનાવો (Create tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	ટ ક્સ્ટને કોષ્્ટકોમાાં કન્્વર્્ટ  કરો
•	 કોષ્્ટકોને ટેક્સ્ટમાાં કન્્વર્્ટ  કરો
•	 પંક્્તતિઓ અને કૉલમનો ઉલ્્લલેખ કરીને કોષ્્ટકો બનાવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી 	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટેક્સ્ટને કોષ્્ટકોમાાં કન્્વર્્ટ  કરો

ટેેક્સ્ટનેે કોોષ્ટકમાંં અથવાા કોોષ્ટકમાંં ટેેક્સ્ટમાંં કન્વર્ટટ  કરવાા માાટેે, હોોમ ટૅૅબ 
પર ફકરોો બતાાવોો/છુુપાાવોો પર ક્લિ�િક કરીીનેે પ્રાારંંભ કરોો જેથેીી તમેે જોઈ શકોો 
કેે તમાારાા દસ્તાાવેેજમાંં ટેેક્સ્ટનેે કેેવીી રીીતેે અલગ કરવાામાંં આવેે છેે (ફિ�ગ 1). 

•	 MS Office 2019 / નવીનતમ	          - 1 No.

Fig 1

ટેક્સ્ટને ટેબલમાાં કન્્વર્્ટ  કરો

1	 વિભાજક અક્ષરો દાખલ કરો-જમે કે અલ્્પવિરામ અથવા ટૅબ્્સ- 
ટેક્સ્ટને કોષ્્ટક કૉલમમાાં ક્યયાં વિભાજીત કરવો તે સૂચવવા માટે.

નોોંધ: જો તમારી પાસે તમારા ટેક્સ્ટમાાં અલ્્પવિરામ છે, તો 
તમારા વિભાજક અક્ષરો માટે ટૅબ્્સનો ઉપયોગ કરો.

2	તમ ે નવી કોષ્્ટક પંક્્તતિ ક્યયાંથી શરૂ કરવા માાંગો છો તે દર્શાવવા માટે 
ફકરાના ચિહ્નોનો ઉપયોગ કરો.

	 આ ઉદાાહરણમાંં, ટૅૅબ્સ અનેે ફકરાાનાા ચિ�હ્નોો 3 કૉૉલમ અનેે 2 પંંક્તિ�િઓ 
સાાથેેનુંં� કોોષ્ટક બનાાવશેે (ફિ�ગ 2).

3	ત મેે કન્વર્ટટ  કરવાા માંંગોો છોો તેે ટેેક્સ્ટ પસંંદ કરોો, અનેે પછીી Insert > 
Table > Convert Text to Table ક્લિ�િક કરોો (ફિ�ગ 3). 

4	 કન્વર્ટટ  ટેેક્સ્ટ ટુુ ટેેબલ બોોક્સમાંં, તમનેે જોઈતાા વિ�કલ્પોો પસંંદ કરોો 
(ફિ�ગ 4). 

	 કોષ્્ટકના કદ હેઠળ, ખાતરી કરો કે નંબરો તમને જોઈતી કૉલમ અને 
પંક્્તતિઓની સખં્યા સાથે મેળ ખાય છે.

	 ઑટોફિટ વર્્તણૂક હેઠળ, તમે તમારુું  ટેબલ કેવું દેખાવા માગો છો તે 
પસંદ કરો. શબ્દ આપમેળે ટેબલ કૉલમ માટે પહોળાઈ પસંદ કરે છે. 

Fig 2

Fig 3

Fig 4
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આ કરવા માટે આ વિકલ્્પ પસંદ કરો

બધા કૉલમ માટે પહોળાઈનો 
ઉલ્્લલેખ કરો

સ્થિર કૉલમ પહોળાઈ બૉક્સમાાં, 
મૂલ્ય ટાઇપ કરો અથવા પસંદ 
કરો.

દરેક કૉલમમાાં ટેક્સ્ટની પહોળાઈને 
ફિટ કરવા માટે કૉલમનું કદ બદલો

સમાવિષ્્ટટો માટે સ્્વતઃફિટ

ઉપલબ્ધ જગ્્યયાની પહોળાઈમાાં 
ફેરફાર થવાના કિસ્્સસામાાં આપમેળે 
કોષ્્ટકનું કદ બદલો (ઉદાહરણ 
તરીકે, વેબ લેઆઉટ અથવા 
લેન્્ડસ્કેપ ઓરિએન્ટેશન)

વિન્્ડડો પર ઓટોફિટ

જો તમને અલગ કૉલમની પહોળાઈ જોઈતી હોય, તો આ વિકલ્્પપોમાાંથી 
એક પસંદ કરો:

	 પર અલગ ટેક્સ્ટ હેઠળ, તમે ટેક્સ્ટમાાં ઉપયોગમાાં લીધેલ વિભાજક 
અક્ષર પસંદ કરો.

5	 બરાાબર ક્લિ�િક કરોો. કોોષ્ટકમાંં રૂપાંંતરિ�ત ટેેક્સ્ટ કંંઈક આનાા જેવેુંં� હોોવુંં� 
જોઈએ (ફિ�ગ 5). 

કાાર્યય 2 : કોોષ્ટકોોનેે ટેેક્સ્ટમાંં કન્વર્ટટ  કરોો કોોષ્ટકનેે ટેેક્સ્ટમાંં કન્વર્ટટ  કરોો

1	ત મેે ટેેક્સ્ટમાંં કન્વર્ટટ  કરવાા માંંગોો છોો તેે પંંક્તિ�િઓ અથવાા કોોષ્ટક પસંંદ 
કરોો.

2	લ ેઆઉટ ટેબ પર, ડેટા વિભાગમાાં, ટેક્સ્ટમાાં કન્્વર્્ટ  કરો ક્્લલિક કરો.

3	ટ ક્સ્ટમાાં રૂપાાંતરિત કરો બોક્સમાાં, સાથે અલગ લખાણ હેઠળ, તમે 
કૉલમની સીમાઓની જગ્્યયાએ ઉપયોગ કરવા માાંગો છો તે વિભાજક 

અક્ષરને ક્્લલિક કરો. પંક્્તતિઓ ફકરાના ગુણ દ્વારા અલગ કરવામાાં 
આવશે.

4	 બરાાબર ક્લિ�િક કરોો (ફિ�ગ 6). 

કાાર્યય 3 : પંંક્તિ�િઓ અનેે કૉૉલમનોો ઉલ્લેખે કરીીનેે કોોષ્ટકોો બનાાવોો

1	મૂ ળભૂતૂ કોોષ્ટક માાટેે, Insert > Table પર ક્લિ�િક કરોો અનેે જ્યાંં સુુધીી 
તમેે ઇચ્છોો તેે કૉૉલમ અનેે પંંક્તિ�િઓનીી સંંખ્યાાનેે હાાઇલાાઇટ ન કરોો ત્યાંં 
સુુધીી કર્સસરનેે ગ્રીીડ પર ખસેેડોો (ફિ�ગ 7). 

ટિપ્સ

•	 જો તમારી પાસે પહેલેથી જ ટેબ દ્વારા અલગ કરેલ ટેક્સ્ટ હોય, તો તમે 
તેને ઝડપથી ટેબલમાાં કન્્વર્્ટ  કરી શકો છો. Insert > Table પસંદ કરો 
અન પછી ટેક્સ્ટને ટેબલમાાં કન્્વર્્ટ  કરો પસંદ કરો.

•	તમ ારુું  પોતાનું ટેબલ દોરવા માટે, Insert > Table > Draw Table 
દોરો પસંદ કરો.

2	મો ોટાા ટેેબલ માાટેે, અથવાા ટેેબલ કસ્ટમાાઇઝ કરવાા માાટેે, Insert > 
Table > Insert Table પસંંદ કરોો (ફિ�ગ 8).

Fig 5

Fig 6

Fig 7

Fig 8
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IT & ITES	 	 એકસરસાાઈઝ 1.9.38
કોપા (COPA) - કોષ્્ટકો અને સૂચિઓનું સંચાલન કરો	

કોષ્્ટકો સશંોધિત કરો (Modify tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સૉર્્ટ  ટેબલ ડેટા
•	 સેલ માર્જિન અને અતંર ગોઠવો
•	 કોષોને મર્્જ  અને વિભાજિત કરો
•	 કોષ્્ટકો, પંક્્તતિઓ અને કૉલમનું કદ બદલો
•	 વિભાજિત કોષ્્ટકો
•	 પુનરાવર્તિત પંક્્તતિ હેડરને ગોઠવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No. •	 MS Office 2019 / નવીનતમ	          - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટેબલ ડેટાને સૉર્્ટ  કરો 

વર્્ડ માાં ટેબલ સૉર્્ટ  કરો

1	તમ ે કોષ્્ટકમાાં જ્યયાં સૉર્્ટ  કરવા માાંગો છો તે કોઈપણ કૉલમ પસંદ કરો.

Name Trade

RamKumar CHNM

Amar Electrician

Sekar Welder

Vikram RACT

Karthick MTTW

2	 કોષ્્ટક સાધનો Layout > Data Group > Sort કરો પસંદ કરો. 
(ફિગ 1).

3	તમ ારા સૉર્્ટ  માપદંડ પસંદ કરો:

•	તમ  જ ેકૉલમને સૉર્્ટ  કરવા માાંગો છો તેને પસંદ કરો.

•	 બીજી કૉલમ પર સૉર્્ટ  કરવા માટે, પછી પસંદ કરો અને બીજી 
કૉલમ પસંદ કરો.

•	 ચડતા અથવા ઉતરતા પસંદ કરો.

Name Trade

Amar Electrician

Karthick MTTW

RamKumar CHNM

Sekar Welder

Vikram RACT

4	 બરાબર પસંદ કરો.

•	 કોષ્્ટકની ટોચ પર હેડર પંક્્તતિ રાખવા માટે, હેડર પંક્્તતિ પસંદ કરો. 
(ફિગ 2)

Fig 1

Fig 2
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કાર્્ય 2 : સેલ માર્જિન અને અતંર ગોઠવો

કોષ્્ટકની અંદર જગ્્યયા ઉમેરો અથવા બદલો

તમાારાા ટેેબલનીી અંંદર જગ્યાા ઉમેેરવાા માાટેે, તમેે સેેલ માાર્જિ�ન અથવાા સેેલ 
સ્પેેસિં�ગ એડજસ્ટ કરીી શકોો છોો (ફિ�ગ 3). 

કોષ માર્જિન ટેબલ કોષની અંદર છે, જમે કે ગ્રાફિકની ટોચ પર વાદળી તીર. 
કોષનું અતંર કોષો વચ્ચે છે, જમે કે તળિયે નારંગી તીર.

1	ટ બલ પર ક્્લલિક કરો.

2	લ ેઆઉટ ટેબ પર, સંરેખણ જૂથમાાં, સલે માર્જિન પર ક્્લલિક કરો અને 
પછી કોષ્્ટક વિકલ્્પપો સંવાદ બોક્સમાાં

3	ન ીચેનામાાંથી એક કરો:

•	ડિ ફોલ્ટ સેલ માર્જિન હેઠળ, તમે ટોચ, નીચે, ડાબે અથવા જમણા 
માર્જિનને સમાયોજિત કરવા માાંગો છો તે માપ દાખલ કરો.

•	ડિ ફૉલ્ટ સેલ સ્્પપેસિિંગ હેઠળ, સેલ વચ્ચે અતંર રાખવાની મંજૂરી 
આપો ચેક બૉક્સ પસંદ કરો અને પછી તમને જોઈતું માપ દાખલ 
કરો.

નોોંધ: તમ પસંદ કરો છો તે સેટિિંગ્્સ ફક્્ત સક્રિય કોષ્્ટકમાાં 
જ ઉપલબ્ધ છે. તમે બનાવો છો તે કોઈપણ નવા કોષ્્ટકો મૂળ 
ડિફોલ્ટ સેટિિંગનો ઉપયોગ કરશે.

કાર્્ય 3 : કોષોને મર્્જ  કરો અને વિભાજિત કરો 

કોષોને મર્્જ  કરો અને વિભાજિત કરો

તમે સમાન પંક્્તતિ અથવા કૉલમમાાં સ્થિત બે અથવા વધુ કોષ્્ટક કોષોને 
એક કોષમાાં જોડી શકો છો.

1	ત મેે મર્જજ  કરવાા માંંગોો છોો તેે કોોષોો પસંંદ કરોો (ફિ�ગ 4). 

2	 ટેેબલ ટૂૂલ્સ હેેઠળ, લેેઆઉટ ટેેબ પર, મર્જજ  જૂૂથમાંં, કોોષોોનેે મર્જજ  કરોો પર 
ક્લિ�િક કરોો (ફિ�ગ 5). 

3	ત મેે પસંંદ કરેેલ કોોષોો હવે એકસાાથેે મર્જજ  કરવાામાંં આવશેે (ફિ�ગ 6).

વિભાજિત કોષો

1	કો ોષમાંં ક્લિ�િક કરોો, અથવાા બહુુવિ�ધ કોોષોો પસંંદ કરોો જેનેેે તમેે વિ�ભાાજિ�ત 
કરવાા માંંગોો છોો (ફિ�ગ 7). 

2	 ટેેબલ ટૂૂલ્સ હેેઠળ, લેેઆઉટ ટેેબ પર, મર્જજ  જૂૂથમાંં, વિ�ભાાજિ�ત કોોષોો પર 
ક્લિ�િક કરોો (ફિ�ગ 8).  

3	કૉ ૉલમ અથવાા પંંક્તિ�િઓનીી સંખં્યાા દાાખલ કરોો કેે જેમેાંં તમેે પસંંદ કરેેલાા 
કોોષોોનેે વિ�ભાાજિ�ત કરવાા માંંગોો છોો (ફિ�ગ 9). 

Fig 3

Fig 5

Fig 9
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4	તમા ારીી પસંંદગીીનીી પુુષ્ટિ�િ કરવાા માાટેે ઓકેે ક્લિ�િક કરોો (ફિ�ગ 10).

5	તમ ારા કોષોને હવે તમે સ્્પ્લલિટ સલે ડાયલોગ બોક્સમાાં પસંદ કરેલ 
મલૂ્યોનો ઉપયોગ કરીને વિભાજિત કરવામાાં આવશે.

કાર્્ય 4 : કોષ્્ટકો, પંક્્તતિઓ અને કૉલમનું કદ બદલો

ઑટોફિટ વડે ઑટોમૅટિક રીતે કૉલમ અથવા કોષ્્ટકનું કદ બદલો

ઑટોફિટ બટનનો ઉપયોગ કરીને તમારી સામગ્રીના કદને ફિટ કરવા માટે 
તમારા ટેબલ અથવા કૉલમને ઑટોમૅટિક રીતે ગોઠવો.

1	તમ ારુું  ટેબલ પસંદ કરો.

2	લે ેઆઉટ ટૅૅબ પર, સેેલ સાાઇઝ જૂૂથમાંં, ઑટોોફિ�ટ પર ક્લિ�િક કરોો (ફિ�ગ 11).  

3	ન ીચેનામાાંથી એક કરો.

•	 કૉલમની પહોળાઈને આપમેળે સમાયોજિત કરવા માટે, ઑટોફિટ 
સામગ્રીઓ પર ક્્લલિક કરો.

•	ટ બલની પહોળાઈને આપમેળે સમાયોજિત કરવા માટે, ઑટોફિટ 
વિન્્ડડો પર ક્્લલિક કરો.

નોોંધ: જ્યયાં સુધી તમે તેને મેન્યુઅલી બદલો નહીીં ત્યયાં સુધી 
પંક્્તતિની ઊંચાઈ આપમેળે સામગ્રીના કદ સાથે સમાયોજિત 
થાય છે.

AutoFit બંધ કરો

જો તમે ઑટોફિટ તમારા ટેબલ અથવા કૉલમની પહોળાઈને ઑટોમૅટિક 
રીતે સમાયોજિત કરવા માગતા નથી, તો તમે તેને બંધ કરી શકો છો.

1	તમા ારંું ટેેબલ પસંંદ કરોો (ફિ�ગ 12). 

2	લ ેઆઉટ ટૅબ પર, સલે સાઇઝ જૂથમાાં, ઑટોફિટ પર ક્્લલિક કરો.

3	 સ્થિર કૉલમ પહોળાઈ પર ક્્લલિક કરો. 

આખા ટેબલનું મેન્યુઅલી માપ બદલો

1	ટ બલના નીચેના જમણા ખૂણે ટેબલ રીસાઈઝ હેન્્ડલ દેખાય ત્યયાં સુધી 
કર્્સરને ટેબલ પર રાખો.

 2	 કર્્સરને ટેબલ રીસાઈઝ હેન્્ડલ પર આરામ કરો જ્યયાં સુધી તે બે 
માથાવાળો તીર ન બને. 

3	જ્યયાં  સુધી ટેબલ તમને જોઈતું કદ ન થાય ત્યયાં સુધી કોષ્્ટકની સીમાને 
ખેેંચો.

કાર્્ય 5 : કોષ્્ટકોને વિભાજિત કરો

એકવાર તમારી પાસે વર્્ડમાાં  કોષ્્ટક હોય, તો તમે તે કોષ્્ટકને બે અથવા 
વધુ કોષ્્ટકોમાાં વિભાજિત કરવાનું નક્કી કરી શકો છો. આ રીતે, તમે નાના 
કોષ્્ટકો બનાવી શકો છો, અથવા બે કોષ્્ટકો વચ્ચે ટેક્સ્ટ ઉમેરી શકો છો.

1 	તમ ારા કર્્સરને તે પંક્્તતિ પર મૂકો જ ેતમે તમારા બીજા કોષ્્ટકની પ્રથમ 
પંક્્તતિ તરીકે ઇચ્છો છો. ઉદાહરણ કોષ્્ટકમાાં, તે ત્રીજી પંક્્તતિ પર છે. 
(ફિગ 13)

	જ્યા રે તમે કોષ્્ટકની અંદર ક્્લલિક કરો છો, ત્યારે રિબન પર બે નવા 
ટેબલ ટૂલ્સ ટેબ્્સ દેખાય છે: ડિઝાઇન અને લેઆઉટ. આ ટૂલ્સ ફક્્ત 
ત્યારે જ દેખાય છે જ્યારે તમે કોષ્્ટકમાાં હોવ, ઉદાહરણ તરીકે, જ્યારે 
તમે કોષોમાાં સામગ્રી ઉમેરો છો. 

2 	લે ેઆઉટ ટેેબ પર, મર્જજ  જૂૂથમાંં, વિ�ભાાજિ�ત કોોષ્ટક પર ક્લિ�િક કરોો (ફિ�ગ 14).  

	ટ બલ બે કોષ્્ટકોમાાં વિભાજિત થાય છે.

	 જ્યાંં સુુધીી બહુુવિ�ધ પંંક્તિ�િઓ હોોય ત્યાંં સુુધીી તમેે કોોષ્ટકનેે વધુ 
વિ�ભાાજિ�ત કરીી શકોો છોો (ફિ�ગ 15). 

Fig 10

Fig 11

Fig 13

Fig 14

Fig 15
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કાર્્ય 6 : પુનરાવર્તિત પંક્્તતિ હેડરને ગોઠવો

જ્યારે તમે ખૂબ લાાંબા ટેબલ સાથે કામ કરો છો, ત્યારે તે બહુવિધ પૃષ્્ઠઠો પર 
ચાલશે. તમે ટેબલ સટે કરી શકો છો જથેી કરીને ટેબલ હેડર પંક્્તતિ અથવા 
પંક્્તતિઓ દરેક પૃષ્્ઠ પર આપમેળે દેખાય.

તમે તમારા ટેબલને સટે કરવા માટે બે રીતોમાાંથી પસંદ કરી શકો છો જથેી 
કરીને તેની હેડર પંક્્તતિ અથવા પંક્્તતિઓ પુનરાવર્તિત થાય.

તમે નીચેની બાબતો કરી શકો છો:

1	હ ડર પંક્્તતિ અથવા પંક્્તતિઓ પસંદ કરો જનેે તમે દરેક પૃષ્્ઠ પર 
પુનરાવર્્તન કરવા માાંગો છો. પસંદગીમાાં કોષ્્ટકની પ્રથમ પંક્્તતિ શામેલ 
હોવી આવશ્્યક છે.

2	 ટેેબલ ટૂૂલ્સ હેેઠળ, લેેઆઉટ ટેેબ પર, ડેેટાા જૂૂથમાંં, મથાાળાાનીી પંંક્તિ�િઓનુંં� 
પુુનરાાવર્તતન કરોો ક્લિ�િક કરોો (ફિ�ગ 16). 

અથવા, તમે આ અભિગમનો ઉપયોગ કરી શકો છો:

1 	 કોષ્્ટકમાાં, તમે પુનરાવર્્તન કરવા માાંગો છો તે પંક્્તતિ પર જમણું-ક્્લલિક 
કરો અને પછી કોષ્્ટક ગુણધર્મો પર ક્્લલિક કરો.

2	 કોષ્્ટક ગુણધર્મો સંવાદ બૉક્સમાાં, પંક્્તતિ ટૅબ પર, દરેક પૃષ્્ઠની ટોચ પર 
હેડર પંક્્તતિ તરીકે પુનરાવર્્તન કરો ચેક બૉક્સ પસંદ કરો.

3	 બરાબર પસંદ કરો. 
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IT & ITES	 	 એકસરસાાઈઝ 1.9.39
કોપા (COPA) - કોષ્્ટકો અને સૂચિઓનું સંચાલન કરો	

યાદીઓ બનાવો અને સશંોધિત કરો (Create and modify lists)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ફકરાઓને ક્રમાાંકિત અને બુલટેેડ સૂચિ તરીકે ફોર્મેટ કરો
•	 બુલટે કેરેક્ટર અને નંબર ફોર્મેટ બદલો
•	 કસ્ટમ બુલટે અક્ષરો અને નંબર ફોર્મેટ વ્્યયાખ્યાયિત કરો
•	ય ાદી સ્્તરો વધારો અને ઘટાડો
•	 પુનઃપ્રારંભ કરો અને સૂચિ નંબરિિંગ ચાલુ રાખો
•	 પ્રારંભિક સખં્યાના મૂલ્યો સટે કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ફકરાઓને ક્રમાાંકિત અને બુલટેેડ સૂચિ તરીકે ફોર્મેટ કરો

એક યાદી બનાવો

ક્રમાાંકિત સૂચિ શરૂ કરવા માટે, 1, એક અવધિ (.), એક જગ્્યયા અને અમુક 
ટેક્સ્ટ લખો. શબ્દ આપમેળે તમારા માટે ક્રમાાંકિત સૂચિ શરૂ કરશે.

ટાઈપ કરો* અન તમારા ટેક્સ્ટની પહેલા એક જગ્્યયા, અને વર્્ડ  બુલેટેડ સૂચિ 
બનાવશે.

તમારી સૂચિ પૂર્્ણ કરવા માટે, જ્યયાં સુધી બુલેટ્સ અથવા નંબરિિંગ સ્્વવીચ 
બંધ ન થાય ત્યયાં સુધી Enter દબાવો.

હાલના ટેક્સ્ટમાાંથી સૂચિ બનાવો

1	તમ ે સૂચિમાાં બદલવા માાંગો છો તે ટેક્સ્ટ પસંદ કરો.

2	 Home> Bullets or Home> Numbering પર જાઓ.

બુલટે લાઇબ્રેરી (ફિગ 1)

Fig 1

Fig 2

•	 MS Office 2019 / નવીનતમ	 - 1 No.

નંબરિિંગ લાઇબ્રેરી (ફિગ 2)

નોોંધ: બુલેટ્સ અથવા નંબરિિંગની બાજુમાાં ડાઉન એરો પર ક્્લલિક 
કરીને વિવિધ બુલેટ શૈલીઓ અને નંબરિિંગ ફોર્મેટ શોધો.
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કાર્્ય 2 : બુલેટ કેરેક્ટર અને નંબર ફોર્મેટ બદલો

1	ત મેે બદલવાા માંંગોો છોો તેે ટેેક્સ્ટ અથવાા બુુલેેટેેડ સૂૂચિ� પસંંદ કરોો (ફિ�ગ 3).  

2	તમ ે બદલવા માાંગો છો તે સૂચિમાાં બુલેટ અથવા નંબર પર ક્્લલિક કરો.

	 આપમેળે ઓળખાયેલી બુલેટેડ અથવા નંબરવાળી સૂચિમાાં બલુેટ 
અથવા નંબર પર ક્્લલિક કરીને, તમે સંપૂર્્ણ સૂચિ પસંદ કરો છો.

3	હ ોમ ટેબ પર, ફકરા જૂથમાાં, બલુેટ્સ અથવા નંબરિિંગ પર ક્્લલિક કરો.

	સૂ ૂચિ�નેે પાાછુંં�   બદલવાા માાટેે, ક્યાંં તોો બુુલેેટ અથવાા નંંબરિં�ગ પર ક્લિ�િક 
કરોો (ફિ�ગ 4)

કાર્્ય 3 : કસ્ટમ બુલટે અક્ષરો અને નંબર ફોર્મેટ વ્્યયાખ્યાયિત કરો

બુલેટને પ્રતીક / ચિત્ર / ફોન્ટમાાં બદલો

1	ત મેે બદલવાા માંંગોો છોો તેે ટેેક્સ્ટ અથવાા બુુલેેટેેડ સૂૂચિ� પસંંદ કરોો  
(ફિ�ગ 5).

2	હ ોમ ટેબ પર, ફકરો જૂથમાાં, બુલેટેડ સૂચિ                      (ફિગ 6) ની બાજુના 
તીરને ક્્લલિક કરો.

3	 પછી નવી બુલેટ વ્્યયાખ્યાયિત કરો પર ક્્લલિક કરો (ફિગ 7)

•	સિ મ્્બબોલ પર ક્્લલિક કરો અને પછી તમે જ ે સિમ્્બબોલનો ઉપયોગ 
કરવા માાંગો છો તેને ક્્લલિક કરો.

•	 બરાબર ક્્લલિક કરો.

બુલેટને ચિત્રમાાં બદલો

•	ચિ�ત્ર  પર ક્લિ�િક કરોો અનેે પછીી ફાાઇલ અથવાા Bing છબીી શોોધમાંંથીી 
તમાારાા ચિ�ત્ર માાટેે બ્રાાઉઝ કરોો (ફિ�ગ 8).

•	 દાખલ કરો ક્્લલિક કરો.

•	પિક્્ચ ર બલુેટ્સ કેવા દેખાશે તેની સમીક્ષા કરો અન તેને ઉમેરવા માટે 
ઓકે ક્્લલિક કરો અથવા 3-5 પગલાાંઓનું પુનરાવર્્તન કરીને ચિત્ર 
બદલો.

Fig 4

Fig 3

Fig 5

Fig 6

Fig 7
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બુલટેને ફોન્ટમાાં બદલો

•	ફો ોન્ટ પર ક્લિ�િક કરોો અનેે પછીી બુુલેેટ માાટેે ઉપયોોગમાંં લેેવાાતાા ફોોન્ટ 
ગુુણધર્મોો બદલોો. તમેે ફોોન્ટ ટેેબ અથવાા એડવાાન્સ ટેેબ પર સેેટિં�ગ્સ 
પસંંદ કરીી શકોો છોો (ફિ�ગ 9)

Tab Description

Font tab Change the bullet font, 
style, size, color, underline 
style, underline color, and 
effects

Advanced tab Change the bullet font 
character spacing and 
OpenType features.

બુલટે સંરેખણ બદલો

1	સં ંરેેખણ હેેઠળ, ડાાબેે, મધ્યમાંં અથવાા જમણેે પસંંદ કરોો (ફિ�ગ 10). 

2	 બરાબર ક્્લલિક કરો.

નવા નંબર ફોર્મેટને વ્્યયાખ્યાયિત કરો

1	ત મેે બદલવાા માંંગોો છોો તેે ટેેક્સ્ટ અથવાા નંંબરવાાળીી સૂૂચિ� પસંંદ કરોો 
(ફિ�ગ 11). 

2	હ ોમ ટેબ પર, ફકરા જૂથમાાં, ક્રમાાંકિત સૂચિની પાસેના તીરને ક્્લલિક કરો 
અન પછી નવા નંબર  ફોર્મેટને વ્્યયાખ્યાયિત કરો પર ક્્લલિક 
કરો.

3	શ ૈલી બદલવા માટે, નંબર શૈલીની બાજુમાાં નીચે તીરને ક્્લલિક કરો અને 
સખં્યાઓ, અક્ષરો અથવા અન્ય કાલક્રમિક ફોર્મેટ પસંદ કરો.

4	ફો ોન્ટનુંં� કદ, શૈૈલીી અનેે રંંગ બદલવાા માાટેે, ફોોન્ટ પર ક્લિ�િક કરોો અનેે ફોોન્ટ 
ટેેબ અથવાા એડવાાન્સ ટેેબ પર સેેટિં�ગ પસંંદ કરોો (ફિ�ગ 12 અનેે 13) 

Tab Description
Font tab Change the bullet font, style, size, 

color, underline style, underline 
color, and effects.

Advanced tab Change the bullet font character 
spacing and OpenType features.

5	ડ શ, કૌૌંસ અથવા અન્ય મૂલ્ય સાથે નંબરિિંગ ઉમેરવા માટે, તેને નંબર 
ફોર્મેટ ફીલ્્ડમાાં દાખલ કરો.

6	ન ંબરની ગોઠવણી બદલવા માટે, સંરેખણ હેઠળ ડાબે, મધ્્યમાાં અથવા 
જમણે પસંદ કરો.

7	 OK પર ક્્લલિક કરો.

Fig 10

Fig 11
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Fig 8

Fig 9
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કાર્્ય 4 : સૂચિ સ્્તરો વધારો અને ઘટાડો

તમે સૂચિ આઇટમન સ્્તર સરળતાથી બદલી શકો છો.

1	 બુલેટ અથવા નંબર પર ક્્લલિક કરો કે જ ેસ્થિતિની બહાર ખસી ગયું છે.

2	 હોોમ ટેેબ પર, ફકરાા હેેઠળ, બુુલેેટ્્સ અથવાા નંંબરિં�ગનીી બાાજુુનાા તીીરનેે 
ક્લિ�િક કરોો (ફિ�ગ 14). 

3	સૂ ૂચિ� સ્તર બદલવાા માાટેે નિ�ર્દેશ કરોો, અનેે પછીી તમનેે જોઈતાા સ્તર પર 
ક્લિ�િક કરોો (ફિ�ગ 15). 

Fig 12 Fig 13

Fig 14

Fig 15
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કાર્્ય 5 : પુનઃપ્રારંભ કરો અને સૂચિ નંબરિિંગ ચાલુ રાખો

1 પર નંબરિિંગ પુનઃપ્રારંભ કરો

1	ત મેે નવીી સૂૂચિ�માંં પ્રથમ આઇટમ બનવાા માંંગોો છોો તેે આઇટમ પર 
ક્લિ�િક કરોો (ફિ�ગ 16). 

2	 Ctrl+ક્લિ�િક કરોો અથવાા આઇટમ પર જમણુંં� ક્લિ�િક કરોો, અનેે પછીી 
નંંબરિં�ગ પુુનઃઃપ્રાારંંભ કરોો ક્લિ�િક કરોો (ફિ�ગ 17).

3	 પછી બુલેટીીંગ નંબર લિસ્ટ 1 થી શરૂ થાય છે (ફિગ 18)

નંબરિિંગ ચાલુ રાખો

1 	ત મેે નવીી સૂૂચિ�માંં પ્રથમ આઇટમ બનવાા માંંગોો છોો તેે આઇટમ પર 
ક્લિ�િક કરોો (ફિ�ગ 19).

2 	 Ctrl+ક્લિ�િક કરોો અથવાા આઇટમ પર જમણુંં� ક્લિ�િક કરોો, અનેે પછીી 
નંંબરિં�ગ ચાાલુુ રાાખોો પર ક્લિ�િક કરોો (ફિ�ગ 20). 

3	 પછી બુલેટીીંગ નંબર લિસ્ટ ઉપરથી શરૂ થવાનું ચાલુ રહેશે. (ફિગ 21)

Fig 16

Fig 18

Fig 19

Fig 21
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Fig 20
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કાર્્ય 6 : પ્રારંભિક સખં્યાની કિિંમતો સટે કરો

1	યા ાદીીમાંંનાા નંંબરોો પર ડબલ-ક્લિ�િક કરોો. ટેેક્સ્ટ પસંંદ થયેેલ દેેખાાશેે 
નહીંં (ફિ�ગ 22). 

2	તમ ે જ ેનંબર બદલવા માાંગો છો તેના પર જમણું-ક્્લલિક કરો.

3	સે ેટ નંંબરિં�ગ વેેલ્યુુ પર ક્લિ�િક કરોો (ફિ�ગ 23). 

4	મૂ ૂલ્ય આનાા પર સેેટ કરોો: બોોક્સમાંં, તમનેે જોઈતાા નંંબર પર મૂૂલ્ય 
બદલવાા માાટેે તીીરોોનોો ઉપયોોગ કરોો.  ઉદાાહરણ માાટેે 9 વડે મૂૂલ્ય સેેટ 
કરોો પછીી ઠીીક ક્લિ�િક કરોો (ફિ�ગ 24). 

5	 પછીી પરિ�ણાામ 9 દ્વાારાા અનુુસરવાામાંં આવશેે (ફિ�ગ 25).

Fig 22

Fig 25
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Fig 23

Fig 24
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IT & ITES	 	 એકસરસાાઈઝ 1.10.40
કોપા (COPA) - સંદર્ભો બનાવો અને મેનેજ કરો	

સંદર્્ભ તત્્વવો બનાવો અને મેનેજ કરો (Create and manage reference elements)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ફૂટનોટ્સ અને એન્્ડનોટ્સ દાખલ કરો
•	 ફૂટનોટ અને એન્્ડનોટ પ્રોપર્ટીઝમાાં ફેરફાર કરો
•	 ગ્રંથસૂચિ અવતરણ સ્ત્રોતો બનાવો અને સશંોધિત કરો
•	 ગ્રંથસૂચિ માટે ટાાંકણો દાખલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ફૂટનોટ્સ અને એન્્ડનોટ્સ દાખલ કરો 

ફૂટનોટ્સ પેજના તળિયે દેખાય છે અને એન્્ડનોટ્સ દસ્્તતાવેજના અતંે આવે 
છે. ફૂટનોટ અથવા એન્્ડનોટ પરનો નંબર અથવા પ્રતીક દસ્્તતાવેજમાાંના 
સંદર્્ભ ચિહ્ન સાથે મેળ ખાય છે.

1	 જ્યયાં તમે ફૂટનોટ અથવા એન્્ડનોટનો સંદર્્ભ આપવા માાંગો છો ત્યયાં 
ક્્લલિક કરો.

2	 સંદર્ભો ટેબ પર, ફૂટનોટ દાખલ કરો અથવા એન્્ડનોટ દાખલ કરો પસંદ 
કરો.

કાર્્ય 2 : ફૂટનોટ અને એન્્ડનોટ ગુણધર્મોમાાં ફેરફાર કરો

ફૂટનોટ ફોન્ટ, ફૂટનોટ ફોન્ટ સાઈઝ, ફૂટનોટ સુપરસ્ક્રીપ્્ટ અને ફૂટનોટ 
સ્્પપેસિિંગ - આ વિડીયો આ વિશષેતાઓને કેવી રીતે બદલવી તે સમજાવશે.

ફૂટનોટ ફોન્ટનું કદ અને ફોર્મેટિિંગ બદલો

ફૂટનોટ્સના ફોન્ટ, કદ અને ફોર્મેટિિંગ બદલવા માટે:

1	 હોમ ટેબ પર ક્્લલિક કરો, અને પછી સ્ટાઇલ જૂથમાાં, વધુ વિકલ્્પપો માટે 
તીરને ક્્લલિક કરો. અથવા,  ALT+CTRL+SHIFT+S દબાવો.

2	 સ્ટાઇલ ફલકના તળિયે, સ્ટાઇલ મેનેજ કરો બટનને ક્્લલિક કરો.

3	 સૉર્્ટ  ઓર્્ડ ર માટે, આલ્ફાબેટીકલ પસંદ કરો.

4	ન ીચેનામાાંથી એક કરો:

•	 ફૂટનોટ નંબરોનું ફોર્મેટિિંગ બદલવા માટે, ફૂટનોટ્સ સંદર્્ભ શૈલી 
પસંદ કરો.

•	 જો તમે પાનાના તળિયે ફૂટનોટ ટેક્સ્ટનું ફોર્મેટિિંગ બદલવા માાંગતા 
હો, તો ફૂટનોટ ટેક્સ્ટ શૈલી પસંદ કરો.

5	 સશંોધિત કરો પર ક્્લલિક કરો, અને પછી ફોર્મેટિિંગ વિકલ્્પપો બદલો 
(ફોન્ટ, કદ, અને તેથી વધુ). વધુ ફોર્મેટિિંગ વિકલ્્પપો માટે, નીચેના-ડાબા 
ખૂણામાાં ફોર્મેટ બટનને ક્્લલિક કરો.

•	 MS Office 2019 / નવીનતમ	 - 1 No.

3	 ફૂટનોટ અથવા એન્્ડનોટમાાં તમને જ ેજોઈએ છે તે દાખલ કરો.

4	નો ોંધની શરૂઆતમાાં નંબર અથવા પ્રતીક પર ડબલ ક્્લલિક કરીને 
દસ્્તતાવેજમાાં તમારા સ્થાન પર પાછા ફરો
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કાર્્ય 3 : ગ્રંથસૂચિ અવતરણ સ્ત્રોતો બનાવો અને સશંોધિત કરો

1	તમ  ટાાંકવા માાંગો છો તે ટેક્સ્ટના અતંે તમારુું  કર્્સર મૂકો.

2	 References > Style, પર જાઓ અને અવતરણ શૈલી પસંદ કરો.

3	 દાખલો દાખલ કરો પસંદ કરો.

4	ન વો સ્ત્રોત ઉમેરો પસંદ કરો અને તમારા સ્ત્રોત વિશેની માહિતી ભરો.

એકવાર તમે તમારી સૂચિમાાં સ્રોત ઉમેર્યા પછી, તમે તેને ફરીથી ટાાંકી શકો 
છો:

1	તમ ે ટાાંકવા માાંગો છો તે ટેક્સ્ટના અતંે તમારુું  કર્્સર મૂકો.

2	 References > Insert Citation પર જાઓ, અને તમે ટાાંકી રહ્યા છો 
તે સ્ત્રોત પસંદ કરો.

3	 વિગતો ઉમેરવા માટે, જમે કે પૃષ્્ઠ નંબર જો તમે કોઈ પુસ્્તક ટાાંકતા 
હોવ, સંદર્્ભ વિકલ્્પપો પસંદ કરો, અને પછી ઉદ્ધરણ સંપાદિત કરો.

ગ્રંથસૂચિ બનાવો

તમારા દસ્્તતાવેજમાાં ઉલ્્લલેખિત સ્ત્રોતો સાથે, તમે ગ્રંથસૂચિ બનાવવા માટે 
તૈયાર છો.

1	 જ્યયાં તમને ગ્રંથસૂચિ જોઈતી હોય ત્યયાં તમારુું  કર્્સર મૂકો.

2	 References > Bibliography પર જાઓ અને ફોર્મેટ પસંદ કરો.

કાર્્ય 4 : ગ્રંથસૂચિ માટે ટાાંકણો દાખલ કરો

દસ્્તતાવેજમાાં નવું ટાાંકણું અને સ્ત્રોત ઉમેરો

1 	 સંદર્ભો ટેબ પર, સંદર્ભો અને ગ્રંથસૂચિ જૂથમાાં, શૈલીની બાજુમાાંના તીરને 
ક્્લલિક કરો અને તમે જ ેશૈલીનો ઉપયોગ સંદર્્ભ અને સ્ત્રોત માટે કરવા 
માાંગો છો તેના પર ક્્લલિક કરો. ઉદાહરણ તરીકે, સામાજિક વિજ્ઞાન  

દસ્્તતાવેજો સામાન્ય રીતે ટાાંકણો અન સ્ત્રોતો માટે MLA અથવા APA 
શૈલીઓનો ઉપયોગ કરે છે.

2 	તમ ે જ ેવાક્ય અથવા શબ્દસમહૂને ટાાંકવા માાંગો છો તેના અતંે ક્્લલિક 
કરો. 
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3	 સંદર્્ભ ટેબ પર, ઇન્્સર્્ટ  સિટેશન પર ક્્લલિક કરો અને પછી નીચેનામાાંથી 
એક કરો:

•	 સ્ત્રોત માહિતી ઉમેરવા માટે, નવો સ્ત્રોત ઉમેરો પર ક્્લલિક કરો 
અને પછી, સ્ત્રોત બનાવો સંવાદ બોક્સમાાં,  સ્ત્રોતના પ્રકારની 
બાજુમાાં તીરને ક્્લલિક કરો, અને તમે ઉપયોગ કરવા માાંગો છો તે 
સ્રોતનો પ્રકાર પસંદ કરો  (ઉદાહરણ તરીકે, પુસ્્તક વિભાગ અથવા 
વેબસાઇટ ).

•	 પ્્લલેસહોલ્્ડર ઉમેરવા માટે, જથેી તમે ટાાંકણ બનાવી શકો અને 
સ્ત્રોત માહિતી પછીથી ભરી શકો, નવું પ્્લલેસહોલ્્ડર ઉમેરો પર 
ક્્લલિક કરો. સોર્્સ મેનેજરમાાં પ્્લલેસહોલ્્ડર સ્ત્રોતોની બાજુમાાં એક 
પ્રશ્ન ચિહ્ન દેખાય છે.

4	 જો તમે સ્ત્રોત ઉમેરવાનું પસંદ કર્્યુું હોય, તો સ્ત્રોત માટેની વિગતો 
દાખલ કરો. સ્ત્રોત વિશે વધુ માહિતી ઉમેરવા માટે, તમામ ગ્રંથસૂચિ 
ક્ષેત્રો બતાવો ચેક બોક્સને ક્્લલિક કરો.

5	જ્યા રે સમાપ્્ત થાય ત્યારે બરાબર ક્્લલિક કરો. તમે તમારા દસ્્તતાવેજમાાં 
જ ેસ્થાન પસંદ કર્્યુું છે તેના પર સ્ત્રોતને અવતરણ તરીકે ઉમેરવામાાં 
આવે છે.

જ્યારે તમે આ પગલાાં પૂર્્ણ કરી લો, ત્યારે અવતરણ ઉપલબ્ધ અવતરણોની 
સૂચિમાાં ઉમેરવામાાં આવે છે. આગલી વખતે જ્યારે તમે આ સંદર્્ભ ક્્વવોટ 
કરો છો, ત્યારે તમારે તેને ફરીથી લખવાની જરૂર નથી. તમે ફક્્ત તમારા 
દસ્્તતાવેજમાાં અવતરણ ઉમેરો. તમે સ્રોત ઉમેર્યા પછી, તમને કદાચ પછીથી 
તેમાાં ફેરફાર કરવાની જરૂર પડશે.

તમારા દસ્્તતાવેજમાાં ટાાંકણો ઉમેરો

1	તમ ે જ ેવાક્ય અથવા શબ્દસમહૂને ટાાંકવા માાંગો છો તેના અતંે ક્્લલિક 
કરો, અને પછી સંદર્ભો ટૅબ પર, સંદર્ભો અને ગ્રંથસૂચિ જૂથમાાં, દાખલો 
દાખલ કરો પર ક્્લલિક કરો.

2	 ઇન્્સર્્ટ  સિટેશન હેઠળના અવતરણોની સૂચિમાાંથી, તમે ઉપયોગ કરવા 
માાંગો છો તે અવતરણ પસંદ કરો.

સ્ત્રોત શોધો

તમે ઉપયોગ કરો છો તે સ્ત્રોતની સૂચિ ઘણી લાાંબી બની શકે છે. અમુક 
સમયે, તમારે એવા સ્ત્રોતને શોધવાની જરૂર પડી શકે છે જ ે તમે બીજા 
દસ્્તતાવેજમાાં ટાાંક્યો હોય.

1	 સંદર્ભો ટેબ પર, સંદર્ભો અને ગ્રંથસૂચિ જૂથમાાં, સ્ત્રોતોનું સંચાલન કરો 
પર ક્્લલિક કરો.

જો તમે નવો દસ્્તતાવેજ ખોલો છો જમેાાં હજી સુધી ટાાંકણો નથી, તો તમે 
અગાઉના દસ્્તતાવેજોમાાં ઉપયોગમાાં લીધેલા તમામ સ્ત્રોતો માસ્ટર લિસ્ટ 
હેઠળ દેખાશે.

જો તમે કોઈ દસ્્તતાવેજ ખોલો છો જમેાાં અવતરણોનો સમાવશે થાય છે, તો 
તે ટાાંકણો માટેના સ્ત્રોત વર્્તમાન સૂચિ હેઠળ દેખાય છે. તમે ટાાંકેલા તમામ 
સ્ત્રોતો, કાાં તો અગાઉના દસ્્તતાવેજોમાાં અથવા વર્્તમાન દસ્્તતાવેજમાાં, માસ્ટર 
લિસ્ટ હેઠળ દેખાય છે.

2	ચ ોક્કસ સ્ત્રોત શોધવા માટે, નીચેનામાાંથી એક કરો:

•	 સૉર્ટટિંગ બૉક્સમાાં, લેખક, શીર્્ષક, ટૅગ નામ અથવા વર્્ષ દ્વારા સૉર્્ટ  
કરો, અને પછી પરિણામી સૂચિમાાં તમને  જોઈતો સ્રોત શોધો.

•	શ ોધ બોક્સમાાં, તમે જ ે સ્ત્રોત શોધવા માાંગો છો તેનું શીર્્ષક 
અથવા લખેક લખો. તમારા શોધ શબ્દ સાથે મેળ કરવા માટે સૂચિ 
ગતિશીલ રીતે સાાંકડી થાય છે.

સ્ત્રોત સંપાદિત કરો

1 	 સંદર્ભો ટેબ પર, સંદર્ભો અને ગ્રંથસૂચિ જૂથમાાં, સ્ત્રોતોનું સંચાલન કરો 
પર ક્્લલિક કરો.

2	 સ્ત્રોત મેનેજર સંવાદ બોક્સમાાં, માસ્ટર લિસ્ટ અથવા વર્્તમાન સૂચિ 
હેઠળ, તમે સંપાદિત કરવા માાંગો છો તે સ્રોત પસંદ કરો, અને પછી 
સંપાદિત કરો પર ક્્લલિક કરો.
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નોોંધ: અવતરણ માહિતી ઉમેરવા માટે પ્્લલેસહોલ્્ડરને સંપાદિત 
કરવા માટે, વર્્તમાન સૂચિમાાંથી પ્્લલેસહોલ્્ડરને પસંદ કરો અને 
સંપાદિત કરો પર ક્્લલિક કરો.

3 	 સ્ત્રોત સંપાદિત કરો સંવાદ બોક્સમાાં, તમને જોઈતા ફેરફારો કરો અને 
બરાબર ક્્લલિક કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.10.41
કોપા (COPA) - સંદર્ભો બનાવો અને મેનેજ કરો	

સંદર્્ભ કોષ્્ટકો બનાવો અને મેનેજ કરો (Create and manage reference tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સામગ્રીના કોષ્્ટકો દાખલ કરો
•	 વિષયવસ્્તતુના કોષ્્ટકોને કસ્ટમાઇઝ કરો
•	 ગ્રંથસૂચિ દાખલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સામગ્રીના કોષ્્ટકો દાખલ કરો 

સામગ્રીનું કોષ્્ટક બનાવો

નોોંધ: વિષયવસ્્તતુનું કોષ્્ટક બનાવતા પહેલા, મથાળા 1, મથાળું2, 
મથાળું 3 અને વગેરે દ્વારા સ્ટાઇલ જૂથ દ્વારા ફોર્મેટ કરેલ તમારા 
દસ્્તતાવેજોનું મથાળું રાખો.

1	 પછી તમારુું  કર્્સર મૂકો જ્યયાં તમે સામગ્રીનું કોષ્્ટક ઉમેરવા માાંગો છો.

નોોંધ: તૈયાર કરી શકાય તેવા પ્રથમ પૃષ્્ઠનો ઉપયોગ પુસ્્તકના 
અનકુ્રમણિકા તરીકે વિષયવસ્્તતુના કોષ્્ટકમાાં કરવામાાં આવશે.

2	 References > Table of Contents પર જાઓ. અને સ્્વચાલિત 
શૈલી પસંદ કરો.

હેડિિંગ જોવા માટે Ctrl + F

3	 જો તમે તમારા દસ્્તતાવેજમાાં ફેરફાર કરો છો જ ેવિષયવસ્્તતુના કોષ્્ટકને 
અસર કરે છે, તો વિષયવસ્્તતુના કોષ્્ટક પર જમણું-ક્્લલિક કરીને અને 
અપડેટ ફીલ્્ડ પસંદ કરીને સમાવિષ્્ટટોના કોષ્્ટકને અપડેટ કરો.

ઉદાહરણ: પરિણામ

•	 MS Office 2019 / નવીનતમ	 - 1 No.
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	 Table of Contents

	 Create and manage references (3Hrs.)........................................................................................	 1

	 Ex.No:1.10.40. Create and manage reference elements (1.4 Hrs) .............................................	 1

		  Task1: Insert footnotes and endnotes.....................................................................................	 1

		  Task2: Modify footnote and endnote properties .....................................................................	 1

		  Task3: Create and modify bibliography citation sources .......................................................	 2 

	 Create a bibliography ....................................................................................................	 3

	 Task4: Insert citations for bibliographies ...............................................................................	 3

	 Add a new citation and source to a document .............................................................	 3

	 Add citations to your document ...................................................................................	 4

	 Find a source  .............................................................................................................	 5

	 Edit a source ...............................................................................................................	 5

	 Ex.No:1.10.41. Create and manage reference tables (1.6 Hrs) ...............................................	 6

	 Task1 Insert tables of contents ............................................................................................	 6

	 Create the table of contents  .......................................................................................	 6

	 Task2 Customize tables of contents ...................................................................................	 8

	 Task3 Insert bibliographies .................................................................................................	 8

કાર્્ય 2 : વિષયવસ્્તતુના કોષ્્ટકોને કસ્ટમાઇઝ કરો

1	 References > Table of Contents પર જાઓ.

2	 વિષયવસ્્તતુનું વૈવિધ્્યપૂર્્ણ કોષ્્ટક પસંદ કરો.
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3	 પૃષ્્ઠ નંબરો બતાવવા, છુપાવવા અને સંરેખિત કરવા માટે સેટિિંગ્્સનો 
ઉપયોગ કરો, ટેબ લીડર ઉમેરો અથવા  બદલો, ફોર્મેટ્સ સેટ કરો અને 
મથાળાના કેટલા સ્્તરો દર્શાવવા તે સ્્પષ્્ટ કરો.

•	 પ્રિન્ટ પૂર્વાવલોકન તમે પસંદ કરેલ સેટિિંગ્્સ સાથે દસ્્તતાવેજમાાં 
તમારી સામગ્રીનું કોષ્્ટક કેવું દેખાય છે તેનું  ઉદાહરણ દર્શાવે છે.

•	 વેબ પૂર્વાવલોકન બતાવે છે કે વેબ પર તમારી સામગ્રીનું કોષ્્ટક કેવું 
દેખાય છે. મળૂભતૂ રીતે, મથાળાઓ નંબરોને બદલે હાઇપરલિિંકનો 
ઉપયોગ કરે છે. જ્યારે તમે વિષયવસ્્તતુના કોષ્્ટકમાાં એન્ટ્ રી પર 
ક્્લલિક કરો છો, ત્યારે તે તમને તે મથાળા પર લઈ જાય છે. જો તમે 
પેજ નંબર્્સ બોક્સને બદલે હાઇપરલિિંકનો ઉપયોગ કરો છો, તો તમે 
ટેબ લીડર સાથે પ્રમાણભતૂ નંબરો જુઓ છો.

•	 પેજ નંબર્્સ બતાવો પૃષ્્ઠ નંબરો અને ટૅબ લીડરને ચાલુ અથવા 
બધં કરે છે.

•	 જમણી બાજુએ સંરેખિત પૃષ્્ઠ નંબરો તમારા પૃષ્્ઠ નંબરોને પૃષ્્ઠના 
જમણા હાાંસિયામાાં મૂકે છે. શીર્્ષકોની  બાજુમાાં પૃષ્્ઠ નંબરો મૂકવા 
માટે બોક્સને સાફ કરો.

•	 ટૅબ લીડર તમને લીડર્્સની વિવિધ શૈલીઓ પસંદ કરવા માટે ડ્્રરો પ 
ડાઉન આપે છે, જમે કે બિિંદુઓ (ડિફોલ્ટ), ડૅશ અથવા નક્કર રેખા. 
ટેબ લીડર્્સન બંધ કરવા માટે (કોઈ નહીીં) પસંદ કરો.

•	 ફોર્મેટ્સ તમને સામગ્રીની વિવિધ શૈલીઓનું ટેબલ પસંદ કરવા દે 
છે.

•	 બતાવો સ્્તર મથાળાના સ્્તરોની સખં્યાને સમાયોજિત કરે છે 
(જો તમારા દસ્્તતાવેજમાાં બહુવિધ સ્્તરો હોય) તમે વિષયવસ્્તતુના 
કોષ્્ટકમાાં જુઓ છો.

•	 વિકલ્્પપો તમને તમારા વિષયવસ્્તતુનું કોષ્્ટક બનાવવા માટે 
ઉપયોગમાાં લેવાતી શૈલીઓ પસંદ કરવા દે છે, જમે કે બહુવિધ 
મથાળાઓ, હેડર, ફૂટર્્સ, ટિપ્પણી ટેક્સ્ટ વગેરે.

નોોંધ: મથાળાની પસંદગી શો સ્્તર સેટિિંગ સાથે આગળ અને 
પાછળ પ્રતિબિિંબિત થાય છે. ઉદાહરણ તરીકે, જો તમે બતાવવા 
માટે 3 સ્્તરો સેટ કરો છો, તો શીર્્ષકો 1, 2 અને 3 ઉપલબ્ધ 
શૈલીઓ હેઠળ તપાસવામાાં આવશે:

•	 સશંોધિત સામગ્રી એન્ટ્ રીઓના ટેબલ પર ઉપયોગમાાં લેવાતા 
ઇન્્ડડેન્ટેશન અને શૈલીને સેટ કરે છે. વધુ સારા ફેરફારો કરવા માટે 
સ્ટાઈલ ડાયલોગમાાં મોડિફાઈનો ઉપયોગ કરો.

•	 ઓકે તમારા ફેરફારોને સાચવે છે અને દસ્્તતાવેજ પર પાછા ફરે છે.

•	 રદ કરો તમારા ફેરફારોને કાઢી નાખો અને દસ્્તતાવેજ પર પાછા 
ફરો.

કાર્્ય 3 : ગ્રંથસૂચિ દાખલ કરો

ગ્રંથસૂચિ બનાવો

1	 ગ્રંથસૂચિ દાખલ કરતા પહેલા References > Manager Sources 
પર જાઓ માાં વિગતો અપડેટ કરો.

2	 પુસ્્તકના લખેક, શીર્્ષક, વર્્ષ, શહેર અને પ્રકાશક વિશ માસ્ટર લિસ્ટ 
બનાવવા માટે નવું પસંદ કરો.

3	 બરાબર ક્્લલિક કરો

4	મ ાસ્ટર લિસ્ટ બનાવ્્યયા પછી આપણે જોઈ શકીએ છીએ

5	 બધં કરો ક્્લલિક કરો.
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તમારા દસ્્તતાવેજમાાં ઉલ્્લલેખિત સ્ત્રોતો સાથે, તમે ગ્રંથસૂચિ બનાવવા માટે 
તૈયાર છો.

1	 જ્યયાં તમને ગ્રંથસૂચિ જોઈતી હોય ત્યયાં તમારુું  કર્્સર મૂકો.

2	 References > Bibliography પર જાઓ અને ફોર્મેટ પસંદ કરો.

3	 દાખલ કર્યા પછી ગ્રંથસૂચિ / સંદર્ભો / કૃતિઓ ટાાંકવામાાં આવી છે

ગ્રંથસૂચિ

E, A. (2022). કમ્્પ્યયુટર ઓપરેટર અન પ્રોગ્રામિિંગ મદદનીશ. ચેન્નાઈ: NIMI, 
ચેન્નાઈ.

સંદર્્ભ

E, A. (2022). કમ્્પ્યયુટર ઓપરેટર અને પ્રોગ્રામિિંગ મદદનીશ. ચેન્નાઈ: NIMI, 
ચેન્નાઈ.

ટાાંકવામાાં આવેલ કાર્યો

E, A. (2022). કમ્્પ્યયુટર ઓપરેટર અને પ્રોગ્રામિિંગ મદદનીશ. ચેન્નાઈ: NIMI, 
ચેન્નાઈ.
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IT & ITES	 	 એકસરસાાઈઝ 1.11.42
કોપા (COPA) - ગ્રાફિક તત્્વવોનું સંચાલન કરો	

ચિત્રો અને ટેક્સ્ટ બોક્સ દાખલ કરો (Insert illustrations and text boxes)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 આકારો, ચિત્રો, 3D મોડલ, સ્માર્્ટ  આર્્ટ  ગ્રાફિક્સ, સ્ક્રીનશોટ અને સ્ક્રીન ક્્લલિપિિંગ્્સ દાખલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : આકારો દાખલ કરો

એમએસ વર્્ડમા ાં આકાર ઉમેરવાનાાં પગલાાં

પગલુંં� 1: નેેવિ�ગેશેન મેેનૂૂ પર ઇન્સર્ટટ  પર ક્લિ�િક કરોો વિ�કલ્પ (ફિ�ગ 1). 

•	 MS Office 2019 / નવીનતમ	          - 1 No.

પગલું 2: ચિત્ર વિભાગમાાં આકૃતિમાાં બતાવ્્યયા પ્રમાણે આકારનો વિકલ્્પ 
પસંદ કરો: (ફિગ 2)

પગલુંં� 3: આકાારોોનીી સૂૂચિ� સ્ક્રીીન પર પોોપ અપ થશેે જ્યાંં તમેે વિ�વિ�ધ 
પ્રકાારનાા આકાાર પસંંદ કરીી શકોો છોો (ફિ�ગ 3). 

આકારમાાં કુલ 8 વિભાગો છે

1 	 રેખાઓ 	 2 	લ ંબચોરસ

3 	 મૂળભતૂ આકારો 	  4 	 બ્્લલોક એરો

5 	 સમીકરણ આકારો	  6 	 ફ્્લલોચાર્્ટ

7 	 સ્ટાર્્સ અને બેનર્્સ	  8 	 કૉલઆઉટ્સ

પગલુંં� 4: હવેે તમાારીી જરૂરિ�યાાત મુુજબ આકાાર પસંંદ કરોો (ફિ�ગ 4). 

પગલું 5: આગળ તમારા વર્્તમાન પૃષ્્ઠ પર કર્્સરને ખેેંચો આકાર દોરો.

પગલુંં� 6: નાા વર્તતમાાન પૃૃષ્ઠ પર છેેલ્લેે આકાાર ઉમેેરવાામાંં આવેે છેે આકૃૃતિ�માંં 
બતાાવ્યાા પ્રમાાણેે દસ્તાાવેેજ (ફિ�ગ 5).

પગલુંં� 7: હવેે કદ સેેટ કરવાા માાટેે ડે્રે�ગ બટન પર ક્લિ�િક કરોો આકૃૃતિ�માંં 
બતાાવ્યાા પ્રમાાણેે આકાાર (ફિ�ગ 6).

Fig 1

Fig 2  

તમે એક અથવા વધુ આકારો ઉમેર્યા પછી, તમે તેમાાં ટેક્સ્ટ, બુલેટ્સ અને 
નંબરિિંગ ઉમેરી શકો છો, અને તમે ફોર્મેટ ટેબ પર તેમની ભરણ, રૂપરેખા 
અને અન્ય અસરો બદલી શકો છો.

પગલુંં� 8: નેેવિ�ગેશેન મેેનૂૂ પર આકાારનેે રંંગ, લેેઆઉટ, શૈૈલીી આપવાા માાટેે 
ફોોર્મેેટ વિ�કલ્પ પર ક્લિ�િક કરોો (ફિ�ગ 7). 

પગલું 9: હેઠળ આકાર શૈલી વિભાગ શૈલી પેનલ ખોલવા માટે ડ્્રરો પડાઉન 
તીર પર ક્્લલિક કરો. (ફિગ 8)

પગલું 10: થીમ શૈલી રંગ પનેલ ખુલશે જ્યયાં તમે આકૃતિમાાં બતાવ્્યયા 
પ્રમાણે આકાર માટે વિવિધ પ્રકારની રંગ શૈલીઓ પસંદ કરી શકો છો: 
(ફિગ 9)

પગલુંં� 11: તમાારીી પસંંદગીીનોો રંંગ પસંંદ કરોો (ફિ�ગ 10). 

પગલું 12: તમે આકૃતિમાાં બતાવ્્યયા પ્રમાણે અન્ય થીમ ફિલ્સ વિકલ્્પપોમાાંથી 
અલગ રંગની પેટર્્ન પણ પસંદ કરી શકો છો: (ફિગ 11)

પગલુંં� 13: તમેે આકાાર ભરોો વિ�કલ્પમાંંથીી અલગ રંંગ પણ પસંંદ કરીી શકોો 
છોો (ફિ�ગ 12). 
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પગલુંં� 14: આગળ આપવાા માાટેે આકાારનીી રૂપરેેખાા વિ�કલ્પ પર ક્લિ�િક કરોો 
આકાારનીી રૂપરેેખાા (ફિ�ગ 13).

પગલું 15: થીમ કલર્્સ પેનલમાાંથી રંગ પસંદ કરો આકૃતિમાાં બતાવ્્યયા 
પ્રમાણે: (ફિગ 14)

પગલુંં� 16: આગળ આકાાર અસરોો વિ�કલ્પ પર ક્લિ�િક કરોો (ફિ�ગ 15). 

પગલુંં� 17: હવેે મેેનુુમાંંથીી વિ�કલ્પ પસંંદ કરોોતમાારીી જરૂરિ�યાાત (અંંજીર 16 
અનેે 17). 

છેેલ્લેે, આકાાર તમાારાા દસ્તાાવેેજમાંં દાાખલ કરવાામાંં આવેે છેે (ફિ�ગ 18). 

Fig 3

Fig 4

Fig 5

Fig 6

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.11.42
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Fig 7

Fig 8

Fig 9

Fig 10

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.11.42
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Fig 11

Fig 12

Fig 13

Fig 14

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.11.42
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Fig 15

Fig 16

Fig 17

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.11.42
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કાાર્યય 2 : ચિ�ત્રોો દાાખલ કરોો

એમએસ વર્ડડમાંં  ફાાઇલોોમાંંથીી ચિ�ત્રોો કેેવીી રીીતેે દાાખલ કરવાા?

પગલુંં� 1: નેેવિ�ગેશેન મેેનૂૂમાંંથીી દાાખલ વિ�કલ્પ પસંંદ કરોો (ફિ�ગ 19). 

પગલું 2: હવે બતાવ્્યયા પ્રમાણે ચિત્ર વિકલ્્પ પસંદ કરો: (ફિગ 20)

પગલું 3: ચિત્ર દાખલ કરવાની બે રીત છે:

•	 આ ઉપકરણ - તમે તમારા કમ્્પ્યયુટરમાાંથી ચિત્ર ફાઇલ દાખલ કરી શકો 
છો.

•	 ઓનલાઈન પિક્્ચર્્સ - તમે ઓનલાઈન સાઈટ પરથી પણ ચિત્રો દાખલ 
કરી શકો છો.

પગલું 4: બતાવ્્યયા પ્રમાણે આ ઉપકરણ વિકલ્્પ પસંદ કરો: (ફિગ 21)

પગલું 5: ચિત્ર દાખલ કરો સંવાદ બોક્સ ખુલશે. 

પગલું 6: ડાબી પનેલ મેનૂમાાંથી ડ્્રરા ઇવ અથવા ફોલ્્ડર પસંદ કરો

પગલું 7: આગળ તમે તમારા દસ્્તતાવેજમાાં જ ે ચિત્ર/ઇમેજ દાખલ કરવા 
માાંગો છો તેને પસંદ કરો.

પગલું 8: બતાવ્્યયા પ્રમાણે દાખલ કરો વિકલ્્પ પર ક્્લલિક કરો: (ફિગ 22)

પગલુંં� 9: હવેે તમેે ડોોટ બટનનોો ઉપયોોગ કરીીનેે તમાારીી જરૂરિ�યાાત અનુુસાાર 
તમાારાા ચિ�ત્રનુંં� કદ સેેટ અથવાા માાપ  બદલીી શકોો છોો (ફિ�ગ 23). 

પગલુંં� 10: ચિ�ત્રનેે શૈૈલીી આપવાા માાટેે નેેવિ�ગેશેન મેેનૂૂમાંંથીી ફોોર્મેેટ વિ�કલ્પ પર 
ક્લિ�િક કરોો (ફિ�ગ 24).

પગલુંં� 11: ડ્રોો� પ-ડાાઉન એરોો અનેે તમાારીી પસંંદગીી મુુજબ ચિ�ત્ર શૈૈલીી પસંંદ 
કરોો (ફિ�ગ 25).  

છેેલ્લેે, તમાારાા દસ્તાાવેેજમાંં ચિ�ત્રોો/છબીીઓ ઉમેેરવાામાંં આવેે છેે (ફિ�ગ 26). 

Fig 18

Fig 19

Fig 20

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.11.42
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Fig 21

Fig 22

Fig 23

Fig 24 

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.11.42
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એમએસ વર્્ડમા ાં ઓનલાઈન ઈમેજીસ કેવી રીતે દાખલ કરવી?

પગલુંં� 1: નેેવિ�ગેશેન મેેનૂૂમાંંથીી દાાખલ વિ�કલ્પ પસંંદ કરોો (ફિ�ગ 27). 

પગલું 2: હવે ચિત્ર વિકલ્્પ પસંદ કરો અને ચિત્ર દાખલ કરો સંવાદ બોક્સ 
ખુલશે.

પગલું 3: બતાવ્્યયા પ્રમાણે ઓનલાઈન પિક્્ચર્્સ વિકલ્્પ પસંદ કરો:  
(ફિગ 28)

પગલુંં� 4: ઓનલાાઈન પિ�ક્ચર્સસ ડાાયલોોગ બોોક્સ ખુુલશેે જ્યાંં તમેે વિ�વિ�ધ 
ઓનલાાઈન પિ�ક્ચર્સસ શોોધીી શકોો છોો (ફિ�ગ 29).  

પગલુંં� 5: શોોધ બાારમાંં ચિ�ત્ર/છબીીનુંં� નાામ શોોધોો (ફિ�ગ 30).

પગલું 6: ચિત્ર પસંદ કરો અન પછી બતાવ્્યયા પ્રમાણે દાખલ કરો બટન પર 
ક્્લલિક કરો:

છેલ્્લલે, ઓનલાઈન ઈમેજો તમારા દસ્્તતાવેજમાાં ઉમેરવામાાં આવશે (ફિગ 31).

Fig 25 Fig 26

Fig 27

Fig 28

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.11.42 
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Fig 29

Fig 30

Fig 31
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કાર્્ય 3 : 3D મોડલ્સ દાખલ કરો

સ્થાનિક ફાઇલમાાંથી 3D ઑબ્્જજેક્ટ ઉમેરો

1 	ત મેે તમાારીી ફાાઇલોોમાંં અન્ય છબીીઓનીી જેમે જ 3D મોોડલ્સ દાાખલ કરોો 
છોો. રિ�બનનાા ઇન્સર્ટટ  ટેેબ પર 3D મોોડલ્સ પસંંદ કરોો અનેે પછીી એક 
ફાાઇલમાંંથીી (ફિ�ગ 32).

2	 એકવાર તે દાખલ થઈ જાય તે પછી તમે ઇમેજની હેરફેર કરવા માટે 
નિયંત્રણોનો ઉપયોગ કરી શકો છો: (ફિગ 33)

3	 તમારા 3D મોડલને કોઈપણ દિશામાાં ફેરવવા અથવા નમાવવા 
માટે 3D નિયંત્રણનો ઉપયોગ કરો. ફક્્ત તમારા માઉસથી ક્્લલિક કરો, 
પકડી રાખો અને ખેેંચો.

	  તમારી છબી મોટી કે નાની બનાવવા માટે ઇમેજ હેન્્ડલ્સને 
અંદર અથવા બહાર ખેેંચો.

4 	તમ ે હજી પણ તમારી છબીને ઘડિયાળની દિશામાાં અથવા કાઉન્ટર-
ક્્લલોકવાઇઝ ફેરવવા માટે રોટેશન  હેન્્ડલનો ઉપયોગ કરી 
શકો છો, પરંતુ અમે ઉપર વાત કરી છે તે 3D રોટેશન કંટ્્રરોલન ો ઉપયોગ 
કરીને તમને વધુ સારો અનુભવ મળશે.

અમારી ઑનલાઇન લાઇબ્રેરીમાાંથી 3D મોડલ્સ ઉમેરો

1 	અમા ારીી ઓનલાાઈન લાાઈબ્રેરેીીમાંંથીી 3D મોોડલ પસંંદ કરવાા માાટેે, 3D 
મોોડલ્સ &gt; ઓનલાાઈન સ્ત્રોોતોોમાંંથીી પસંંદ કરોો. દેેખાાતાા સંંવાાદ 
બોોક્સમાંં તમેે કેેટલોોગમાંંથીી 3D છબીીઓ બ્રાાઉઝ કરીી શકોો છોો અથવાા 
શોોધીી શકોો છોો (ફિ�ગ 34). 

2   એક અથવાા વધુ છબીીઓ પસંંદ કરોો અનેે શાામેેલ કરોો ક્લિ�િક કરોો (ફિ�ગ 35).  

ઓફિસમાાં તમારા 3D મોડલ્સ કેવા દેખાય છે તે બદલો

1	જ્યા રે તમે તમારી Office ફાઇલમાાં 3D મોડલ દાખલ કરો છો ત્યારે 
તમને 3D મોડલ ટૂલ્સ હેઠળ રિબન પર એક સંદર્્ભ ટેબ મળશે જનેે 
ફોર્મેટ કહેવાય છે. ફોર્મેટ ટૅબ પર તમારી 3D છબીઓ કેવી દેખાશે તે 
કસ્ટમાઇઝ કરવામાાં તમારી સહાય કરવા માટે કેટલાક સરળ નિયંત્રણો 
છે.

2	 3D મોોડલ વ્યુુઝ ગેલેેેરીી તમનેે પ્રીીસેેટ દૃશ્યોોનોો સંંગ્રહ આપેે છેે જેનેોો તમેે 
તમાારીી છબીી પર ઉપયોોગ કરીી શકોો છોો.  ઉદાાહરણ તરીીકેે તમેે ઝડપથીી 
હેેડ-ઓન વ્યૂૂ અથવાા ટોોપ-ડાાઉન વ્યૂૂ પસંંદ કરીી શકોો છોો (ફિ�ગ 36). 

3	 જ તમાારીી પાાસેે બહુુવિ�ધ 3D મોોડલ છેે અને તમેે જેનેીી સાાથેે કાામ 
કરવાા માંંગોો છોો તેેનેે પસંંદ કરવાામાંં તમનેે મુશુ્કેેલીી આવીી રહીી છેે, તોો 
ઑબ્જેક્ે્ટ્સનીી સૂૂચિ� ચાાલુુ કરવાા માાટેે પસંંદગીી ફલક પર ક્લિ�િક કરોો. 
પછીી તમેે જે ેઈમેેજ કેે ઈમેેજીસનેે પસંંદ કરવાા માંંગોો છોો તેેનેે સરળતાાથીી 
પસંંદ કરીી શકોો છોો (ફિ�ગ 37). 

4	 સંરેખિત ટૂલ તમને તમારી છબીને પૃષ્્ઠ પર અથવા સ્્લલાઇડ-ટોચ 
અથવા બાજુ પર મૂકવામાાં મદદ કરે છે, ઉદાહરણ તરીકે.

Fig 32

Fig 33

Fig 34
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5	 પને અને ઝૂમ તમને તમારી 3D ઇમેજ ફ્રેમમાાં કેવી રીતે ફિટ થાય છે તેનું 
નિયંત્રણ આપે છે. પાન અને ઝૂમ બટન પર ક્્લલિક કરો, પછી ઑબ્્જજેક્ટને 
ખસેડવા માટે ફ્રેમની અંદર ક્્લલિક કરો અને ખેેંચો. ઑબ્્જજેક્ટને ફ્રેમની 
અંદર મોટી અથવા નાની દેખાય તે માટે ફ્રેમની જમણી બાજુએ ઝૂમ 
એરોનો ઉપયોગ કરો

6	 એકવાર તમે તમારી 3D છબીઓ દાખલ કરી લો તે પછી તમે 
તેમની સાથે તમામ પ્રકારની ઉત્તેજક વસ્્તતુઓ કરી શકો છો, જમે કે 
પાવરપોઈન્ટના મોર્્ફ  ટ્્રરા ન્્ઝઝિશનનો ઉપયોગ કરીને ઑબ્્જજેક્ટને ફેરવવા 
અથવા સ્્પપિન કરવા માટે.

કાર્્ય 4 : સ્માર્્ટ  આર્્ટ  ગ્રાફિક્સ દાખલ કરો

સ્માર્્ટઆર્્ટ  ગ્રાફિક દાખલ કરો અને તેમાાં ટેક્સ્ટ ઉમેરો

1	 ઇન્સર્ટટ  ટેેબ પર, ચિ�ત્ર જૂૂથમાંં, સ્માાર્ટટઆર્ટટ  પર ક્લિ�િક કરોો (ફિ�ગ 38). 

2	 સ્માાર્ટટઆર્ટટ  ગ્રાાફિ�ક પસંંદ કરોો સંંવાાદ બોોક્સમાંં, તમેે ઇચ્છોો તેે પ્રકાાર અનેે 
લેેઆઉટ પર ક્લિ�િક કરોો (ફિ�ગ 39). 

તમારા SmartArt ગ્રાફિકમાાં આકારો ઉમેરો અથવા કાઢી નાખો
1	સ્માર્્ટ આર્્ટ  ગ્રાફિક પર ક્્લલિક કરો કે જમેાાં તમે બીજો આકાર ઉમેરવા 

માાંગો છો.
2	તમ ે જ્યયાં નવો આકાર ઉમેરવા માાંગો છો તેની સૌથી નજીક સ્થિત 

હાલના આકાર પર ક્્લલિક કરો.
3	 સ્માાર્ટટઆર્ટટ  ટૂૂલ્સ હેેઠળ, ડિ�ઝાાઇન ટેેબ પર, ગ્રાાફિ�ક જૂૂથ બનાાવોોમાંં, 

આકાાર ઉમેરેોો નીી બાાજુુનાા તીીરનેે ક્લિ�િક કરોો (ફિ�ગ 42). 

Fig 35

Fig 36

Fig 37

Fig 38

Fig 42

Fig 39

3	ન ીચેનામાાંથી એક કરીને તમારુું  લખાણ દાખલ કરો:

•	ટે ક્સ્ટ ફલકમાંં [ટેેક્સ્ટ] પર ક્લિક કરો, અને પછી તમારું����������ં���������� લખાાણ 
લખોો (ફિ�ગ 40).  

4	ટા ાઈપ કરેેલ ટેેક્સ્ટ પછીી અહીંં બતાાવવાામાંં આવશેે (ફિ�ગ 41). 

•	 જો તમને સ્માર્્ટઆર્્ટ  ટૂલ્સ અથવા ડિઝાઇન ટેબ્્સ દેખાતા નથી, 
તો ખાતરી કરો કે તમે સ્માર્્ટઆર્્ટ  ગ્રાફિક  પસંદ કર્્યુું છે. ડિઝાઇન 
ટેબ ખોલવા માટે તમારે સ્માર્્ટઆર્્ટ  ગ્રાફિક પર ડબલ ક્્લલિક કરવું 
પડશે.

4	ન ીચેનામાાંથી એક કરો:
•	 પસંદ કરેલા આકાર પછી આકાર દાખલ કરવા માટે, પછી આકાર 

ઉમેરો પર ક્્લલિક કરો.
•	 પસંદ કરેલ આકાર પહેલા આકાર દાખલ કરવા માટે, પહેલા 

આકાર ઉમેરો પર ક્્લલિક કરો.
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કાર્્ય 5 : સ્ક્રીનશોટ અને સ્ક્રીન ક્્લલિપિિંગ્્સ દાખલ કરો

1	તમ ે જ્યયાં સ્ક્રીનશોટ ઉમેરવા માાંગો છો તે સ્થાન પરના દસ્્તતાવેજમાાં 
ક્્લલિક કરો.

2	દા ાખલ કરોો ટેેબ પર, ચિ�ત્ર જૂૂથમાંં, સ્ક્રીીનશોોટ પર ક્લિ�િક કરોો(ફિ�ગ 43). 

3	 ઉપલબ્ધ વિ�ન્ડોોઝ ગેેલેેરીી દેેખાાય છેે, જે ે તમનેે હાાલમાંં ખુુલેેલીી બધીી 
વિ�ન્ડોો દર્શાાવેે છેે. નીીચેેનાામાંંથીી એક કરોો:

•	તમ ારા દસ્્તતાવેજમાાં સમગ્ર વિન્્ડડોનો સ્ક્રીનશોટ દાખલ કરવા માટે, 
તે વિન્્ડડોની થંબનેલ ઈમેજ પર ક્્લલિક કરો.

•	 ઉપલબ્ધ વિ�ન્ડોોઝ ગેેલેેરીીમાંં દર્શાાવેેલ પ્રથમ વિ�ન્ડોોનોો પસંંદ કરેેલ 
ભાાગ ઉમેેરવાા માાટેે, સ્ક્રીીન ક્લિ�િપીંંગ પર ક્લિ�િક   કરોો; જ્યાારેે સ્ક્રીીન 
સફેેદ થઈ જાય અનેે પોોઇન્ટર ક્રોોસ બનીી જાય, ત્યાારેે ડાાબુંં� માાઉસ 
બટન દબાાવોો અનેે પકડીી રાાખોો અનેે સ્ક્રીીનનાા જે ેભાાગનેે તમેે કેેપ્ચર 
કરવાા માંંગોો છોો તેેનેે પસંંદ કરવાા માાટેે ખેંંચોો (ફિ�ગ 44). 

4	ત મેે પસંંદ કરેેલ વિ�ન્ડોો અથવાા સ્ક્રીીનનોો ભાાગ આપમેેળેે તમાારાા 
દસ્તાાવેેજમાંં ઉમેેરવાામાંં આવેે છેે. તમેે સ્ક્રીીનશૉૉટનેે સંંપાાદિ�ત કરવાા અનેે 
વધાારવાા માાટેે પિ�ક્ચર ટૂૂલ્સ ટૅૅબ પરનાા સાાધનોોનોો ઉપયોોગ કરીી શકોો 
છોો (ફિ�ગ 45). 

Fig 40

Fig 41

Fig 43
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કાાર્યય 6 : ટેેક્સ્ટ બોોક્સ દાાખલ કરોો

ટેક્સ્ટ બોક્સ ઉમેરો

1	 ઇન્સર્ટટ  > ટેેક્સ્ટ બોોક્સ પર જાઓ, અનેે પછીી સૂૂચિ�માંંથીી પૂૂર્વવ-ફોોર્મેેટ 
કરેેલાા ટેેક્સ્ટ બોોક્સમાંંથીી એક પસંંદ કરોો, આમાંંથીી વધુ ટેેક્સ્ટ 
બોોક્સ પસંંદ કરોો. Office.com, અથવાા ડ્રોો�  ટેેક્સ્ટ બોોક્સ પસંંદ કરોો  
(અંંજીર 46 અને  47). 

જો તમે માઉસનો ઉપયોગ કરતા નથી

1	 ALT, N દબાવો અને છોડો અન પછી X દબાવો.

2	તમ ે જ ે ટેક્સ્ટ બોક્સ પસંદ કરો છો તેને પસંદ કરવા માટે એરો કી 
દબાવો જોઈએ, અન પછી ENTER દબાવો.

3	તમ ે ઇચ્છો તે ટેક્સ્ટ ટાઇપ કરો.

4	જ્યા રે તમે ટાઇપ કરવાનું સમાપ્્ત કરો અને સ્્વવિચ કરવા માાંગો છો 
તમારા દસ્્તતાવેજમાાં ટેક્સ્ટ સંપાદિત કરવા પર પાછા જાઓ, ESC 
દબાવો.

ટેક્સ્ટ બોક્સની નકલ કરો

1	ટ ક્સ્ટ બોક્સની બોર્્ડ ર પસંદ કરો કે જનેે તમે કોપી કરવા માાંગો છો.

2	 Ctrl+C દબાવો.

નોોંધ: ખાતરી કરો કે નિર્દેશક ટેક્સ્ટ બોક્સની સરહદ પર છે, 
તેની અંદર નથી. જો પોઇન્ટર અંદર હોય, તો Ctrl+C દબાવવાથી 
ટેક્સ્ટની નકલ થશે, ટેક્સ્ટ બોક્સની નહીીં.

2	 જો તમેે ટેેક્સ્ટ બોોક્સ દોોરોો પસંંદ કરોો છોો, તોો દસ્તાાવેેજમાંં ક્લિ�િક 
કરોો, અનેે પછીી ટેેક્સ્ટ બોોક્સનેે તમનેે જોઈતાા કદનેે દોોરવાા માાટેે ખેંંચોો  
(ફિ�ગ 48). 

3	ટે ક્સ્ટ ઉમેેરવાા માાટેે, બોોક્સનીી અંંદર પસંંદ કરોો અનેે લખોો અથવાા 
તમાારંું લખાાણ પેેસ્ટ કરોો (ફિ�ગ 49).

Fig 44

Fig 45

Fig 46
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3	 એક સ્થાન પસંદ કરો અને ટેક્સ્ટ બોક્સને પેસ્ટ કરવા માટે Ctrl+V 
દબાવો.

ટેક્સ્ટ બોક્સ કાઢી નાખો

•	ટ ક્સ્ટ બોક્સની બોર્્ડ ર પસંદ કરો કે જનેે તમે કાઢી નાખવા માાંગો છો, 
અને પછી કાઢી નાખો દબાવો.

નોોંધ: ખાતરી કરો કે નિર્દેશક ટેક્સ્ટ બોક્સની સરહદ પર છે અને 
તેની અંદર નથી. જો પોઈન્ટર બોક્સની અંદર હોય, તો ડિલીટ 
દબાવવાથી ટેક્સ્ટ બોક્સની અંદરનો ટેક્સ્ટ ડિલીટ થઈ જશે, 
બોક્સમાાં નહીીં.

Fig 47

Fig 48 Fig 49
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IT & ITES	 	 એકસરસાાઈઝ 1.11.43
કોપા (COPA) - ગ્રાફિક તત્્વવોનું સંચાલન કરો

ફોર્મેટ ચિત્રો અને ટેક્સ્ટ બોક્સ (Format illustrations and text boxes)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 કલાત્મક અસરો, ચિત્ર અસરો અને ચિત્ર શૈલીઓ લાગુ કરો
•	 ચિત્ર પૃષ્્ઠભૂમિ દૂર કરો
•	 ગ્રાફિક તત્્વવો, સ્માર્્ટઆર્્ટ  ગ્રાફિક્સ અને 3D મોડલ્સને ફોર્મેટ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No. •	 MS Office 2019 / નવીનતમ	          - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : કલાત્મક અસરો લાગુ કરો 

કલાત્મક અસરો લાગુ કરો

1	 ચિત્ર પસંદ કરો.

2	ચિ� ત્રનુંં� ફોોર્મેેટ પસંંદ કરોો અનેે કલાાત્મક અસરોો પસંંદ કરોો (ફિ�ગ 1). 

3	 વિ�કલ્પોોનુંં� પૂૂર્વાાવલોોકન કરવાા માાટેે તેેનાા પર હોોવર કરોો, પછીી તમનેે 
જોઈતોો એક પસંંદ કરોો (ફિ�ગ 2). 

નોોંધ: તમે ચિત્ર પર એક સમયે માત્ર એક જ કલાત્મક અસર 
લાગુ કરી શકો છો, તેથી અલગ કલાત્મક અસર લાગુ કરવાથી 
અગાઉ લાગુ કરાયેલ કલાત્મક અસર દૂર થઈ જશે. (3a અને 
3b)

Fig 1

Fig 2
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કાર્્ય 2 : ચિત્ર પ્રભાવો અને ચિત્ર શૈલીઓ લાગુ કરો

ચિત્ર અસરો લાગુ કરો

1	 ચિત્ર પસંદ કરો.

2	પિ�ક્ચ ર ફોોર્મેેટ પસંંદ કરોો અનેે પિ�ક્ચર ઇફેેક્્ટ્સ પસંંદ કરોો (ફિ�ગ 4). 

3	તમને ે જોઈતુંં� હોોય તેે પસંંદ કરોો: શેેડોો, રિ�ફ્લેેક્શન, ગ્લોો, સોોફ્ટ એજ, 
બેેવલ અથવાા 3-ડીી રોોટેેશન (ફિ�ગ 5). 

કાર્્ય 3 : ચિત્રની પૃષ્્ઠભૂમિ દૂર કરો

1	તમ  જ ેચિત્રમાાંથી પૃષ્્ઠભમૂિ દૂર કરવા માાંગો છો તે ચિત્ર પસંદ કરો.

2 	ટુ લબાાર પર, પિ�ક્ચર ફોોર્મેેટ > રીીમુુવ બેેકગ્રાાઉન્ડ, અથવાા ફોોર્મેેટ > રીીમુુવ 
બેેકગ્રાાઉન્ડ પસંંદ કરોો (ફિ�ગ 6). 

	 જો તમને પૃષ્્ઠભૂમિ દૂર કરો દેખાતું નથી, તો ખાતરી કરો કે તમે એક 
ચિત્ર પસંદ કર્્યુું છે. તમારે ચિત્રને પસંદ કરવા માટે તેના પર ડબલ ક્્લલિક 
કરવું પડશે અન પિક્્ચર ફોર્મેટ ટેબ ખોલવી પડશે.

3	ડિફ ૉલ્ટ પૃષ્્ઠભૂમિ વિસ્્તતારને દૂર કરવા માટે ચિહ્નિત કરવા માટે રંગીન 
કિરમજી હશે, જ્યારે અગ્રભાગ તેના કુદરતી રંગને જાળવી રાખશે.

Fig 3a & b

Fig 4
Fig 5
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4	 જો ડિફોલ્ટ વિસ્્તતાર સાચો ન હોય, તો પૃષ્્ઠભમૂિ દૂર કરવા > ચિત્ર 
સાધનો પર જાઓ અને નીચેનામાાંથી એક અથવા બંને કરો:

•	 જો તમે રાખવા માાંગો છો તે ચિત્રના ભાગો કિરમજી (દૂર કરવા માટે 
ચિહ્નિત) હોય, તો રાખવા માટેના વિસ્્તતારોને ચિહ્નિત કરો પસંદ કરો 
અને તમે રાખવા માાંગો છો તે ચિત્ર પરના વિસ્્તતારોને ચિહ્નિત કરવા 
માટે ફ્રી-ફોર્્મ ડ્્રરો ઇંગ પેન્્સસિલ  નો ઉપયોગ કરો.

ડિફૉલ્ટ પૃષ્્ઠભૂમિ (ફિગ 7)

પૃષ્્ઠભૂમિ દૂર કર્યા પછી પસંદ કરો (ફિગ 8)

•	ચિ� ત્રનાા વધુુ ભાાગોોનેે દૂૂર કરવાા માાટેે, દૂૂર કરવાા માાટેેનાા વિ�સ્તાારોોનેે 
ચિ�હ્નિ�ત કરોો પસંંદ કરોો અનેે તેે વિ�સ્તાારોોનેે ચિ�હ્નિ�ત કરવાા માાટેે 
ડ્રોો�ઈં ગ પેેન્સિ��લ  નોો ઉપયોોગ કરોો (ફિ�ગ 9). 

5 	જ્યા રે તમે પૂર્્ણ કરી લો, ત્યારે ફેરફારો રાખો અથવા બધા ફેરફારો 
કાઢી નાખો પસંદ કરો.

	 પછીીનાા ઉપયોોગ માાટેે ઇમેેજનેે અલગ ફાાઇલમાંં સાાચવવાા માાટેે, ઇમેેજ 
પર જમણુંં�-ક્લિ�િક કરોો અનેે સેેવ એઝ પિ�ક્ચર પસંંદ કરોો (ફિ�ગ 10). 

કાર્્ય 4 : ગ્રાફિક ઘટકોને ફોર્મેટ કરો

1	તમ ારા દસ્્તતાવેજમાાં ક્્લલિક કરો જ્યયાં તમે ચિત્ર/ચિત્ર બનાવવા માાંગો છો.

2	દા ાખલ કરોો ટૅૅબ પર, ચિ�ત્ર જૂૂથમાંં, આકાારોો અથવાા ચિ�ત્ર પર ક્લિ�િક કરોો 
(ફિ�ગ 11).

3 	તમ ે ફોર્મેટ ટેબ પર નીચેનામાાંથી કોઈપણ કરી શકો છો, જ ેતમે ડ્્રરો ઈંગ 
આકાર/ચિત્ર દાખલ કરો પછી દેખાય છે:

•	 ચિત્ર પસંદ કરો.

•	 ચિત્ર ફોર્મેટ પસંદ કરો 

ચિત્ર ફોર્મેટ

•	 આકાર પસંદ કરો

•	શ ેપ ફોર્મેટ પસંદ કરો 

આકારનું ફોર્મેટ (ફિગ 12)

Fig 6

Fig 7

Fig 8

Fig 9

Fig 10
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કાર્્ય 5 : સ્માર્્ટઆર્્ટ  ગ્રાફિક્સ ફોર્મેટ કરો

તમે SmartArt ગ્રાફિકમાાં દરેક આકારના દેખાવને કસ્ટમાઇઝ કરી શકો 
છો.

1	તમ ે ફોર્મેટ કરવા માાંગો છો તે SmartArt આકારને ક્્લલિક કરો.

2	સ્માર્્ટ આર્્ટ  ટૂલ્સ હેઠળ ફોર્મેટ ટેબ પર ક્્લલિક કરો. 

3	 દરેેક આકાારનેે ફોોર્મેેટ કરવાા માાટેે આકાાર શૈૈલીી જૂૂથમાંં વિ�કલ્પોોનોો 
ઉપયોોગ કરોો (ફિ�ગ 13). 

કાર્્ય 6 : 3D મોડલ્સને ફોર્મેટ કરો

તમે 3D માાં દરેક આકારના દેખાવને કસ્ટમાઇઝ કરી શકો છો મોડલ્સ.

1 	તમ ે ફોર્મેટ કરવા માાંગો છો તે 3D મોડલ્સ પર ક્્લલિક કરો.

2 	 3D મોડલ્સ ટૂલ્સ હેઠળ ફોર્મેટ ટેબ પર ક્્લલિક કરો.

	 દરેેક આકાારનેે ફોોર્મેેટ કરવાા માાટેે 3D મોોડલ વ્યૂૂ જૂૂથમાંંનાા વિ�કલ્પોોનોો 
ઉપયોોગ કરોો (ફિ�ગ 14).

Fig 11

Fig 12

Fig 13

Fig 14
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IT & ITES	 	 એકસરસાાઈઝ 1.11.44
કોપા (COPA) - ગ્રાફિક તત્્વવોનું સંચાલન કરો	

ગ્રાફિક ઘટકોમાાં ટેક્સ્ટ ઉમેરો (Add text to graphic elements)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ટેક્સ્ટ બોક્સમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો
•	 આકારોમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો
•	 SmartArt ગ્રાફિક સામગ્રી ઉમેરો અને સશંોધિત કરો

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No. •	 MS Office 2019 / નવીનતમ	          - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટેક્સ્ટ બોક્સમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો

1	 ઇન્્સર્્ટ  > ડ્્રરો  ટેક્સ્ટ બોક્સ પર ક્્લલિક કરો. 

2	 આકારની નજીક ટેક્સ્ટ બોક્સ દોરો.

3	ટ ક્સ્ટ બોક્સની અંદર ક્્લલિક કરો અને ટાઇપ કરવાનું શરૂ કરો.

નોોંધ: ટેક્સ્ટ બોક્સ જ્યારે તમે ખસેડશો નહીીં જ્યયાં સુધી તમે 
ટેક્સ્ટને જૂથબદ્ધ ન કરો ત્યયાં સુધી આકારને ખસેડો બોક્સ અને 
આકાર.

નોોંધ: આ સંદર્્ભ Ex.1.11.42 પર વધુ મેળવવા માટેકાર્્ય 6.

કાર્્ય 2 : આકારોમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો

1	 ઇન્્સર્્ટ  > આકારો પર ક્્લલિક કરો  

2	 આકાર દોરો.

3	 આકાારનીી અંંદર ક્લિ�િક કરોો અથવાા આકાાર પર જમણુંં� ક્લિ�િક કરોો અનેે 
ટેેક્સ્ટ ઉમેેરોો પસંંદ કરોો પછીી ટાાઇપ કરવાાનુંં� શરૂ કરોો (ફિ�ગ 1). 

4	ફે રફાાર કરવાા માાટેે આકાારનીી અંંદર ક્લિ�િક કરોો અથવાા આકાાર પર 
જમણુંં� ક્લિ�િક કરોો અનેે ટેેક્સ્ટ સંંપાાદિ�ત કરોો પસંંદ કરોો પછીી ટાાઇપ 
કરવાાનુંં� શરૂ કરોો (ફિ�ગ 2). 

નોોંધ: જ્યયાં સુધી તમે ટેક્સ્ટ બૉક્સ અને આકારને જૂથબદ્ધ 
કરશો નહીીં ત્યયાં સુધી તમે આકારને ખસેડો ત્યારે ટેક્સ્ટ બૉક્સ 
ખસેડશે નહીીં.

કાર્્ય 3 : SmartArt ગ્રાફિક સામગ્રી ઉમેરો અને સશંોધિત કરો

Ex.No.1.11.42 નો સંદર્્ભ લો - કાર્્ય 4. સ્માર્્ટ  આર્્ટ  ગ્રાફિક્સ દાખલ કરો

Fig 1

Fig 2

© NIMI 

NOT TO BE REPUBLISHED



152

IT & ITES	 	 એકસરસાાઈઝ 1.11.45
કોપા (COPA) - ગ્રાફિક તત્્વવોનું સંચાલન કરો	

ગ્રાફિક ઘટકોમાાં ફેરફાર કરો (Modify graphic elements)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	પો ોઝીીશન ઓબ્જેકે્ત્સ
•	 ઑબ્્જજેક્ટની આસપાસ ટેક્સ્ટ લપેટી
•	 સુલભતા માટે ઑબ્્જજેક્્ટ્્સમાાં વકૈલ્્પપિક ટેક્સ્ટ ઉમેરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No. •	 MS Office 2019 / નવીનતમ	          - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પોઝિશન ઑબ્્જજેક્્ટ્્સ

પૃષ્્ઠ પર છબીઓ, ટેક્સ્ટ બોક્સ, આકારોની સ્થિતિ

1	 સ્થિતિ બદલવા માટે, ચિત્ર ફોર્મેટ (ગ્રાફિક્સ ફોર્મેટ, શેપ ફોર્મેટ) ટેબ 
પર, ગોઠવો જૂથમાાં, સ્થિતિ બટન (ફિગ 1) પર ક્્લલિક કરો.

2	વધુ ુ લેેઆઉટ વિ�કલ્પ પસંંદ કરોો (ફિ�ગ 2).

3	 આ વિકલ્્પપોનો ઉપયોગ કરીને, ઑબ્્જજેક્ટન પૃષ્્ઠ હાાંસિયાને સંબધંિત 
ચોક્કસ સ્થાન પર મૂકો.

Fig 1

Fig 2
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કાર્્ય 2 : ઑબ્્જજેક્ટની આસપાસ ટેક્સ્ટને લપેટી 

ટેક્સ્ટ રેપિિંગ બદલો

મૂળભતૂ રીતે, વર્્ડ  ઇન્્સર્્ટટ્્સ (નીચે ઉદાહરણો જુઓ):

•	 ચિત્રો (છબીઓ અને ફોટા), ટેક્સ્ટને અનુરૂપ ચાર્્ટ .

•	ટ ક્સ્ટ બોક્સ, ટેક્સ્ટની સામે આકાર.

•	ટ ક્સ્ટની પાછળ વર્્ડ આર્્ટ  ઑબ્્જજેક્ટ.

ટેક્સ્ટને ઑબ્્જજેક્ટ કેવી રીતે લપેટી જોઈએ તે રીતે બદલવા માટે, તેને પસંદ 
કરો, પછી નીચેનામાાંથી એક કરો:

•	પિક્્ચ ર ફોર્મેટ (શેપ ફોર્મેટ, ગ્રાફિક્સ ફોર્મેટ) ટેબ પર, ગોઠવો જૂથમાાં, 
લખાણ વીીંટો બટન પર ક્્લલિક કરો: (ફિગ 3)

•	 ઑબ્્જજેક્ટ પર જમણું-ક્્લલિક કરો, પછી પોપઅપ મેનૂમાાં રેપ ટેક્સ્ટ પસંદ 
કરો: (ફિગ 4) અથવા

•	 પસંદ કરેલ આકૃતિની બાજુમાાં દેખાતા લેઆઉટ વિકલ્્પપો બટનને 
ક્્લલિક કરો: (ફિગ 5)

રેપ ટેક્સ્ટ સૂચિમાાંથી, તમે પસંદ કરો છો તે વિકલ્્પ પસંદ કરો:

•	 ઇન લાઇન વિથ ટેક્સ્ટ આસપાસના ટેક્સ્ટની સમાન લાઇન પર 
ફકરામાાં ઑબ્્જજેક્ટ મૂકે છે. લખાણ તેની આસપાસ લપેટતું નથી.

•	 ચોરસ લખાણને ચિત્રની આસપાસ અથવા આકારની ચારે બાજુએ 
જમણા ખૂણો (ચોરસ પેટર્્ન) પર લપેટી લે છે જાણે કે તે લંબચોરસ 
હોય. ટેક્સ્ટ બાકીના લંબચોરસ પ્રદેશને ભરે છે.

આ વિ�કલ્પ ટેેક્સ્ટ રેેપિં�ગનુંં� સૌૌથીી સાામાાન્ય સ્વરૂપ છેે

•	 Tight wraps આકૃતિની કિનારીઓની આસપાસ ટેક્સ્ટને ચુસ્્ત રીતે 
લપટેી. ટેક્સ્ટ આકારને અનુસરે છે.

	 આ વિકલ્્પ મોટા ભાગની પૃષ્્ઠની પહોળાઈને આવરી લેતી મોટી 
છબીઓ માટે સૌથી વધુ ઉપયોગી છે. (ફિગ્્સ 6, 7 અને 8)

Fig 3

Fig 4

Fig 5

Fig 6

Fig 7

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.11.45
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•	 ચિત્ર અથવા આકારની ધારની આસપાસના લખાણને વીીંટાળવા દ્વારા, 
કોઈપણ સફેદ ગાબડાઓ સહિત. જો ઈમેજ અથવા આકારમાાં કોઈ 
સફેદ જગ્્યયા ન હોય, તો ટેક્સ્ટ રેપિિંગ ટાઇટની જમે જ કામ કરે છે.

	 આ વિકલ્્પ એક અદ્યતન સેટિિંગ છે કારણ કે તમે છબી અને આકારના 
બિિંદુઓને તેમની મૂળ સરહદોની અંદર અને બહાર ખેેંચો અથવા ખેેંચો 
છો: (ફિગ 9)

•	 ઇમેેજનેે તેેનીી લાાઇન પર રાાખવાા માાટેે ટોોપ અનેે બોોટમ આકૃૃતિ�નીી ઉપર 
અનેે નીીચેે ટેેક્સ્ટનેે લપેેટીી લેે છેે. તેેનીી બંંનેે બાાજુુએ કોોઈ લખાાણ નથીી 
(ફિ�ગ 10). 

•	 ટેક્સ્ટની પાછળ, કોઈપણ અસ્્તતિત્્વમાાંના ટેક્સ્ટની પાછળ અથવા 
નીચે આકૃતિ મૂકે છે. લખાણ તેની આસપાસ લપેટતું નથી.

	ચિ� ત્ર વોોટરમાાર્કક  અથવાા પૃૃષ્ઠભૂૂમિ� જેવેુંં� લાાગેે છેે છબીી (ફિ�ગ 11).

નોોંધ: ટેક્સ્ટની પાછળની વસ્્તતુઓ સાથે કામ કરતી વખતે 
પસંદગી ફલકનો ઉપયોગ કરો.

•	 ટેેક્સ્ટનાા આગળનાા ભાાગમાંં ઑબ્જેકે્ટનેે ટેેક્સ્ટનીી ટોોચ પર મૂૂકેે છેે. 
ટેેક્સ્ટ આવરિ�ત નથીી, તેેથીી આકૃૃતિ�નીી પાારદર્શિ�તાાનાા આધાારેે તેેમાંંથીી 
કેેટલાાક અવરોોધિ�ત થઈ શકે છેે (ફિ�ગ 12). 

નોોંધ: સ્ક્વેર, ટાઇટ, થ્રુ, ટોપ એન્્ડ બોટમ, બિહાઇન્્ડ ટેક્સ્ટ 
અથવા ઇન ફ્રન્ટ ઑફ ટેક્સ્ટ રેપિિંગ સ્ટાઇલનો ઉપયોગ કરતી 
આકૃતિઓને તરતી ગણવામાાં આવે છે.

ફકરા અથવા પૃષ્્ઠ પર આકૃતિ મકૂો

ઉપરાાંત, વર્્ડ  તમામ રેપિિંગ શૈલીઓ માટે બે વિકલ્્પપો ઓફર કરે છે સિવાય 
કે ટેક્સ્ટ સાથનેી લાઇન (ફ્્લલોટિિંગ આકૃતિઓ માટે): અથવા

•	ટ ક્સ્ટ સાથે ખસેડો આસપાસના ટેક્સ્ટ સાથે આકૃતિને ખસેડે છે.

	 જો કોઈ આકૃતિ ફકરાની અંદર સ્થિત છે, અને તમે ફકરા પહેલા 
કોઈપણ સામગ્રીને કાઢી નાખો છો અથવા ઉમેરો છો, તો આકૃતિ ફકરા 
સાથે આગળ વધે છે.

•	 પૃષ્્ઠ પર ફિક્સ પોઝિશન જ્યારે ટેક્સ્ટ ઉમેરવામાાં આવે અથવા દૂર 
કરવામાાં આવે ત્યારે પૃષ્્ઠ પર તે જ સ્થાને આકૃતિ રાખે છે.

	 જો ફકરોો જ્યાંં આકૃૃતિ� સ્થિ�ત છેે (તેે ફકરોો એન્કર ધરાાવેે છેે) તેે આગલાા 
પૃૃષ્ઠ પર જાય છેે, તોો આકૃૃતિ� ખસેેડેે છેે અનેે પૃૃષ્ઠનીી તુુલનાામાંં તેેનીી 
સ્થિ�તિ� જાળવીી રાાખેે છેે (ફિ�ગર 13 અને 14). 

નોોંધ: સમાન વિકલ્્પપો તમે શોધી શકો છો લેઆઉટ સંવાદ 
બોક્સમાાં, સ્થિતિ ટેબ પર, વિકલ્્પપો વિભાગમાાં: (ફિગ 15)

	ટ ક્સ્ટ સાથે ખસેડો ઑબ્્જજેક્ટ ચેક બૉક્સને ચેક કરવું એ રેપ ટેક્સ્ટ 
ડ્્રરો પડાઉન સૂચિમાાંથી ટેક્સ્ટ સાથે ખસેડો વિકલ્્પની સમકક્ષ છે. ટેક્સ્ટ 
ચેક બોક્સ સાથે ખસેડો ઑબ્્જજેક્ટને અનચેક કરવું એ પેજ પર ફિક્સ 
પોઝિશન વિકલ્્પની સમકક્ષ છે.

બંને બાજુઓ પર અથવા ફક્્ત એક બાજુ પર ટેક્સ્ટને લપેટી

1	વ ધારાના વિકલ્્પપો બદલવા માટે, લેઆઉટ વિકલ્્પપો મેનૂમાાં રેપ ટેક્સ્ટ 
ડ્્રરો પડાઉન સૂચિમાાંથી અથવા વધુ જુઓ... લિિંકમાાંથી વધુ લેઆઉટ 
વિકલ્્પપો પસંદ કરો.

Fig 8

Fig 9

Fig 10

Fig 11

Fig 12
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2	લ ેઆઉટ સંવાદ બોક્સમાાં, ટેક્સ્ટ રેપિિંગ ટેબ પર: (ફિગ 16)

•	 રેપિિંગ શૈલી જૂથમાાં, કોઈપણ શૈલીને લખાણ સાથે ચોક્કસ રીતે 
પસંદ કરો (ઉપર જુઓ).

•	 રેપ ટેક્સ્ટ જૂથમાાં (સ્ક્વેર, ટાઈટ અને થોટ રેપિિંગ શૈલીઓ માટે 
ઉપલબ્ધ), કોઈપણ વધારાના વિકલ્્પપો પસંદ કરો:

•	 બંને બાજુઓ ઇમેજ અથવા આકારની બંને બાજુએ ટેક્સ્ટને વીીંટ 
છે: (ફિગ 17)

Fig 13 Fig 14

Fig 15
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•	ડ ાબું ફક્્ત છબી અથવા આકારની ડાબી બાજુની આસપાસ 
ટેક્સ્ટને વીીંટ છે: (ફિગ 18)

ટેક્સ્ટ અને ઑબ્્જજેક્ટ વચ્ચેનું અતંર બદલો

•	ટ ક્સ્ટ અને વિઝ્યુઅલ ઑબ્્જજેક્ટ વચ્ચેનું અતંર બદલવા માટે, 
નીચેની પદ્ધતિઓમાાંથી એક દ્વારા લેઆઉટ સંવાદ બોક્સ ખોલો:

•	પિક્્ચ ર ફોર્મેટ (આકાર ફોર્મેટ, ગ્રાફિક્સ ફોર્મેટ) ટેબ પર, ગોઠવો 
જૂથમાાં, લખાણ વીીંટો બટન પર ક્્લલિક કરો, પછી વધુ લેઆઉટ 
વિકલ્્પપો પસંદ કરો...

•	 ઑબ્્જજેક્ટ પર જમણું-ક્્લલિક કરો, લપેટી ટેક્સ્ટ સૂચિ પર ક્્લલિક 
કરો, પછી પોપઅપ મેનૂમાાં વધુ લેઆઉટ  વિકલ્્પપો... પસંદ કરો. 

•	લ ેઆઉટ વિકલ્્પપો મેનુમાાં વધુ જુઓ... લિિંકને ક્્લલિક કરો.

લેઆઉટ સંવાદ બૉક્સમાાં, ટેક્સ્ટ રેપિિંગ ટૅબ પર, ટેક્સ્ટમાાંથી અતંર 
વિભાગમાાં, ટેક્સ્ટ અને ચિત્ર વચ્ચેના અતંર માટે સ્્વતંત્ર રીતે કસ્ટમ મૂલ્યો 
દાખલ કરો:

•	ટ ોપ અને બોટમ (સ્ક્વેર, ટાઈટ, થોટ અને ટોપ એન્્ડ બોટમ રેપિિંગ 
સ્ટાઈલ માટે ઉપલબ્ધ),

•	ડ ાબે અને જમણે (સ્ક્વેર, ટાઈટ અન થોટ રેપિિંગ શૈલીઓ માટે 
ઉપલબ્ધ).

•	 જમણી બાજુ ફક્્ત છબી અથવા આકારની જમણી બાજુની 
આસપાસ ટેક્સ્ટને વીીંટ છે: (ફિગ 19)

•	 સૌથી મોટંુ માત્ર ઇમેજ અથવા આકારની બાજુ પરના ટેક્સ્ટને 
માર્જિનથી મોટા અતંર સાથે લપેટી લે છે.

Fig 16

Fig 17

Fig 18

Fig 19
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ઉદાહરણ તરીકે, બધી બાજુઓ પર 0.3-ઇંચના અતંર સાથે: (ફિગ 20)

હાઇફનશેન પોઇન્ટ સંપાદિત કરો

ચુસ્્ત અથવા થ્રુ વિકલ્્પપોનો અસરકારક રીતે ઉપયોગ કરવા માટે, તમારે 
છબી અથવા આકાર માટે રેપિિંગ પોઈન્્ટ્્સને સમાયોજિત કરવાની જરૂર 
પડી શકે છે. રેપ પોઈન્્ટ્્સને સંપાદિત કરવા માટે, ઑબ્્જજેક્ટ પસંદ કરો, 
પછી નીચેની પદ્ધતિઓમાાંથી કોઈ એક વડ રેપ પોઈન્્ટ્્સ વ્્યયૂને સંપાદિત કરો 
સક્રિય કરો:

•	પિક્્ચ ર ફોર્મેટ (શેપ ફોર્મેટ, ગ્રાફિક્સ ફોર્મેટ) ટેબ, ગોઠવો જૂથમાાં, 
લખાણ વીીંટો બટન પર ક્્લલિક કરો. પછી રૅપ ટેક્સ્ટ ડ્્રરો પડાઉન 
સૂચિમાાંથી લપેટી પોઈન્્ટ્્સ સંપાદિત કરો પસંદ કરો: (ફિગ 21)

•	 ઑબ્્જજેક્ટ પર જમણું-ક્્લલિક કરો અને પોપઅપ મેનૂમાાં Wrap Text > 
Edit Wrap Points પસંદ કરો: (ફિગ 22)

•	 એડિટ રૅપ પોઈન્્ટ્્સ વ્્યયૂમાાં, જ્યયાં ટેક્સ્ટ લપેટી જાય ત્યયાં ગોઠવવા માટે 
લાલ રેખાઓને ખેેંચો (ફિગ 23)

નોોંધ: પોઈન્ટ ઉમેરવાની કોઈ રીત નથી. તમે ઇચ્છો તે પ્રમાણે 
તમે હાલના રેપ પોઈન્ટને ખસેડી શકો છો

Fig 20

Fig 21

Fig 22

Fig 23
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કાર્્ય 3 : સુલભતા માટે ઑબ્્જજેક્્ટ્્સમાાં વકૈલ્્પપિક ટેક્સ્ટ ઉમેરો

વકૈલ્્પપિક ટેક્સ્ટ ઉમેરો

1 	ન ીચેનામાાંથી એક કરો:

•	 ઑબ્્જજેક્ટ પર જમણું-ક્્લલિક કરો અને Alt ટેક્સ્ટને સંપાદિત કરો 
પસંદ કરો (ફિગ 24)

•	 ઑબ્્જજેક્ટ પસંદ કરો અને પછી ઑબ્્જજેક્ટ માટે ફોર્મેટ મેનૂ પસંદ 
કરો, ઉદાહરણ તરીકે, પિક્્ચર ફોર્મેટ. Alt Text પસંદ કરો.

નોોંધ: સમગ્ર સ્માર્્ટઆર્્ટ  ગ્રાફિક અથવા ચાર્્ટ માાં વકૈલ્્પપિક ટેક્સ્ટ 
ઉમેરવા માટે, સ્માર્્ટઆર્્ટ  ગ્રાફિક અથવા ચાર્્ટ ની સરહદ પર 
ક્્લલિક કરો, અને વ્્યક્્તતિગત આકાર અથવા ભાગને નહીીં.

2	 Alt ટેક્સ્ટ ફલકમાાં, ઑબ્્જજેક્ટ અને તેના સંદર્્ભનું વર્્ણન કરવા માટે 
ટેક્સ્ટ બૉક્સમાાં 1-2 વાક્યો લખો જ ેતેને જોઈ શકતા નથી (ફિગ 25 
અને 26)

વિઝ્યુઅલને સશુોભન તરીકે ચિહ્નિત કરો

1	 Alt ટેક્સ્ટ પને ખોલવા માટે, નીચેનામાાંથી એક કરો:

•	 ઈમેજ પર જમણું-ક્્લલિક કરો, અને પછી Alt ટેક્સ્ટને સંપાદિત કરો 
પસંદ કરો.

•	છ બી પસંદ કરો, Format > Alt Text પસંદ કરો.

2	સ શુોભન તરીકે ચિહ્નિત કરો ચેકબોક્સ પસંદ કરો. ટેક્સ્ટ એન્ટ્રી  ફીલ્્ડ 
ગ્રે થઈ જાય છે.

સ્્વચાલિત Alt ટેક્સ્ટને ચાલુ અને બંધ ટૉગલ કરો

જો તમે દાખલ કરેલ ચિત્રોમાાં આપમેળે જનરેટ થયેલ Alt ટેક્સ્ટ ઉમેરવા 
માાંગતા નથી, તો તમે સ્્વચાલિત Alt ટેક્સ્ટ વિકલ્્પને બંધ કરી શકો છો. જો 
તમે પછીથી તમારો વિચાર બદલો છો, તો તમે તેને એટલી જ સરળતાથી 
ફરી ચાલુ કરી શકો છો.

1	 File > Options > Accessibility. પસંદ કરો.

2	 ઓટોમેટીક ઓલ્ટ ટેક્સ્ટ વિભાગમાાં, ઓટોમેટીકલી જનરેટ ઓલ્ટ 
ટેક્સ્ટ ફોર મી વિકલ્્પ પસંદ કરો અથવા  નાપસંદ કરો, અને પછી ઓકે 
પસંદ કરો.

સ્્વચાલિત વકૈલ્્પપિક ટેક્સ્ટને મંજૂરી આપો

તમે Microsoft 365 માાં સ્્વતઃ-જનરેટેડ વૈકલ્્પપિક ટેક્સ્ટને મંજૂરી આપી 
શકો છો.

1	 જો Alt ટેેક્સ્ટ સંતંોોષકાારક હોોય, તોો Alt ટેેક્સ્ટ મંંજૂૂર કરોો ચેેકબોોક્સ 
પસંંદ કરોો (ફિ�ગ 27). 

Fig 24

Fig 25
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Fig 27
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IT & ITES	 	 એકસરસાાઈઝ 1.12.46
કોપા (COPA) - દસ્્તતાવેજ સહયોગ મેનેજ કરો	

ટિપ્પણીઓ ઉમેરો અને મેનેજ કરો (Add and manage comments)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ટિપ્પણીઓ ઉમેરો, સમીક્ષા કરો અને ટિપ્પણીઓનો જવાબ આપો, ટિપ્પણીઓ ઉકેલો, ટિપ્પણીઓ કાઢી નાખો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટિપ્પણીઓ ઉમેરવા માટે

1	 કેટલાક ટેક્સ્ટને હાઇલાઇટ કરો, અથવા જ્યયાં તમે ટિપ્પણી દેખાવા 
માાંગો છો ત્યયાં નિવશે બિિંદુ મૂકો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.

2	 સમીક્ષા ટૅબમાાંથી, નવી ટિપ્પણી આદેશ પર ક્્લલિક કરો.

3	તમ ારી ટિપ્પણી લખો. જ્યારે તમે પૂર્્ણ કરી લો, ત્યારે તમે Esc કી 
દબાવીને અથવા ટિપ્પણી બોક્સની બહાર ગમે ત્યયાં ક્્લલિક કરીને 
ટિપ્પણી બોક્સને બંધ કરી શકો છો.

કાર્્ય 2 : સમીક્ષા કરો અને ટિપ્પણીઓનો જવાબ આપો

1	 ટિપ્પણીની સમીક્ષા કરવા અને જવાબ આપવા માટે, ટિપ્પણી પર 
જાઓ અને જવાબ આપો પસંદ કરો.

2	તમ ારી જવાબ ટિપ્પણી લખો. જો તમે તમારી કોઈપણ ટિપ્પણીઓમાાં 
ફેરફાર કરવા માાંગતા હો.

ટિપ્પણીઓ ઉકેલો

1	 ટિપ્પણી ઉકેલવા માટે, ટિપ્પણી પર જાઓ, અને ઉકેલ પસંદ કરો.

2	 પછી કોમેન્ટ બોક્સ અક્ષમ થઈ જશે.

3	 જો તમે ટિપ્પણી અપડેટ કરવા માાંગતા હોવ તો ફરીથી ખોલો પસંદ 
કરો.
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ટિપ્પણીઓ કાઢી નાખવા માટે

1	તમ ે કાઢી નાખવા માાંગો છો તે ટિપ્પણી પસંદ કરો.

2	 સમીક્ષા ટેબમાાંથી, કાઢી નાાંખો આદેશ પર ક્્લલિક કરો.

3	 ટિપ્પણી કાઢી નાખવામાાં આવશે.

	 બધીી ટિ�પ્પણીીઓ કાાઢીી નાાખવાા માાટેે, કાાઢીી નાાખોો ડ્રોો �પડાાઉન એરોો પર 
ક્લિ�િક કરોો અનેે દસ્તાાવેેજમાંં બધીી ટિ�પ્પણીીઓ કાાઢીી નાાખોો પસંંદ 
કરોો.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.12.46
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IT & ITES	 	 એકસરસાાઈઝ 1.12.47
કોપા (COPA) - દસ્્તતાવેજ સહયોગ મેનેજ કરો	

ફેરફાર ટ્્રરે કિિંગ મેનેજ કરો (Manage change tracking)	
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ફેરફારોને ટ્્ર રૅક કરો, ટ્્ર રૅક કરેલા ફેરફારોની સમીક્ષા કરો, ટ્્ર રૅક કરેલા ફેરફારોને સ્્વવીકારો અને નકારો અને ફેરફારને લૉક અને ટ્્ર રે કિિંગ અનલૉક કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટ્્ર રૅક ફેરફારો ચાલુ કરવા માટે

1	 સમીક્ષા ટૅબમાાંથી, Track Changes આદેશ પર ક્્લલિક કરો.

•	 MS Office 2019 / નવીનતમ	 - 1 No.

2	ટ્્રરે  ક ફેરફારો ચાલુ કરવામાાં આવશે. આ બિિંદુથી, તમે દસ્્તતાવેજમાાં 
કોઈપણ ફેરફારો કરો છો તે રંગીન માર્્કઅ પતરીકે દેખાશે.

	તમ ારા ટ્્રરૅ ક કરેલા ફેરફારો તમારા કમ્્પ્યયુટરની માર્્કઅ પ સેટિિંગ્્સના 
આધારે, ઉપર જોયેલા ફેરફારો કરતાાં અલગ દેખાઈ શકે છે.

ફેરફારોની સમીક્ષા કરી રહ્યા છીએ

ટ્્રરૅક કરેલા ફેરફારો ખરેખર માત્ર સૂચવેલા ફેરફારો છે. કાયમી બનવા માટે, 
તેમન સ્્વવીકારવું આવશ્્યક છે. બીજી બાજુ, મૂળ લખેક કેટલાક ટ્્રરે ક કરેલા 
ફેરફારો સાથે અસમંત થઈ શકે છે અને તેમને નકારવાનું પસંદ કરી શકે છે.

ફેરફારો સ્્વવીકારવા અથવા નકારવા માટે:

1	તમ ે સ્્વવીકારવા અથવા નકારવા માાંગો છો તે ફેરફાર પસંદ કરો.

2	 સમીક્ષા ટૅબમાાંથી, સ્્વવીકારો અથવા નકારો આદેશ પર ક્્લલિક કરો.
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3	મ ાર્્કઅ પ અદૃશ્્ય થઈ જશે, અને વર્્ડ  આપમેળે આગલા ફેરફાર પર 
જશે. જ્યયાં સુધી તમે તે બધાની સમીક્ષા ન કરો ત્યયાં સુધી તમે દરેક 
ફેરફારને સ્્વવીકારવાનું કે નકારવાનું ચાલુ રાખી શકો છો.

4	જ્યા રે તમ પૂર્્ણ કરી લો, ત્યારે ટ્્રરૅ ક ફેરફારોને બંધ કરવા માટે Track 
Changes આદેશ પર ક્્લલિક કરો.

	 એકસાથે બધા ફેરફારો સ્્વવીકારવા માટે, સ્્વવીકારો ડ્્રરો પડાઉન એરો 
પર ક્્લલિક કરો, પછી બધા સ્્વવીકારો પસંદ કરો. જો તમે હવે તમારા 
ફેરફારોને ટ્્રરૅ ક કરવા માાંગતા નથી, તો તમે બધા સ્્વવીકારો અને ટ્્રરે  કિિંગ 
બંધ કરો પસંદ કરી શકો છો.

ટ્્રરૅક ફેરફારો જોવાના વિકલ્્પપો : જો તમારી પાસે ઘણા બધા ટ્્રરૅ ક કરેલા 
ફેરફારો છે, જો તમે કોઈ દસ્્તતાવેજ વાાંચવાનો પ્રયાસ કરી રહ્યયાં હોવ તો તે 
વિચલિત થઈ શકે છે. સદનસીબે, વર્્ડ  ટ્્રરૅ ક કરેલા ફેરફારો કેવી રીતે દેખાય 
છે તે કસ્ટમાઇઝ કરવાની કેટલીક રીતો પ્રદાન કરે છે: ટ્્રરૅ ક ફેરફારો જોવાના 

વિકલ્્પપો : જો તમારી પાસે ઘણા બધા ટ્્રરૅ ક કરેલા ફેરફારો છે, જો તમે કોઈ 
દસ્્તતાવેજ વાાંચવાનો પ્રયાસ કરી રહ્યયાં હોવ તો તે વિચલિત થઈ શકે છે. 
સદભાગ્્યયે, વર્્ડ  ટ્્રરૅ ક કરેલા ફેરફારો કેવી રીતે દેખાય છે તે કસ્ટમાઇઝ 
કરવાની કેટલીક રીતો પ્રદાન કરે છે:
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•	 સરળ માર્્ક અપ: આ ઇનલાઇન માર્્કઅ પ વિના અંતિમ સંસ્કરણ બતાવે 
છે. ક્યયાં ફેરફાર કરવામાાં આવ્્યયો છે તે દર્શાવવા માટે ડાબા હાાંસિયામાાં 
લાલ માર્્કર્્સ  દેખાશે.

•	ત મામ માર્્ક અપ: આ ઇનલાઇન માર્્કઅ પ સાથેનું અંતિમ સંસ્કરણ 
બતાવે છે.

•	 કોઈ માર્્ક અપ નથી: આ અંતિમ સંસ્કરણ બતાવે છે અને તમામ 
માર્્કઅ પ છુપાવે છે.

•	 મૂળ: આ મૂળ સંસ્કરણ બતાવે છે અને તમામ માર્્ક અપ છુપાવે છે.

ટ્્ર રેક કરેલા ફેરફારો છુપાવવા માટે:

1	 રિવ્્યયુ ટેબમાાંથી, ટ્્રરે ક ચેન્જીસ આદેશની જમણી બાજુએ ડિસ્્પ્લલે ફોર 
રિવ્્યયુ આદેશ પર ક્્લલિક કરો.

2	ડ્્રરો  પ ડાઉન મેનુમાાંથી ઇચ્છિત વિકલ્્પ પસંદ કરો. અમારા ઉદાહરણમાાં, 
અમે ફેરફારો સ્્વવીકારતા પહેલા દસ્્તતાવેજના અંતિમ સંસ્કરણનું 
પરૂ્વાવલોકન કરવા માટે નો માર્્ક અપ પસંદ કરીશું.

	તમ ે સિમ્્પલ માર્્ક અપ અને ઓલ માર્્ક અપ વચ્ચે સ્્વવિચ કરવા માટે 
ડાબા હાાંસિયામાાં માર્્ક ર પર પણ ક્્લલિક કરી શકો છો.

	ય ાદ રાખો કે ટ્્રરૅ ક ફેરફારો છુપાવવા એ ફેરફારોની રીવ્્યયુ કરવા સમાન 
નથી. તમારા દસ્્તતાવેજનું અંતિમ સંસ્કરણ મોકલતા પહેલા તમારે હજુ 
પણ ફેરફારો સ્્વવીકારવા અથવા નકારવા પડશે.

બલુુન્સ પુુનરાાવર્તતનોો બતાાવવાા માાટેે: મોોટાાભાાગનાંં પુુનરાાવર્તતનોો ઇનલાાઇન 
દેેખાાય છેે, એટલેે કેે ટેેક્સ્ટ પોોતેે ચિ�હ્નિ�ત થયેેલ છેે. બલુુન્સ પુુનરાાવર્તતનોો 
બતાાવવાાનુંં� પણ પસંંદ કરીી શકોો છોો, જે ેમોોટાાભાાગનાા પુુનરાાવર્તતનોોનેે જમણાા 
માાર્જિ�ન પર ખસેેડેે છેે. ઇનલાાઇન માાર્કકઅ પ્સ દૂૂર કરવાાથીી દસ્તાાવેેજ વાંંચવાામાંં 

સરળતાા રહેે છેે, અનેે બલુુન્સ કેેટલાાક માાર્કકઅ પ્સ વિ�શેે વધુુ વિ�ગતવાાર 
માાહિ�તીી પણ પ્રદાાન કરેે છેે.

1	 From the Review tab, Show Markup > Balloons > Show 
Revisions in Balloons પર ક્્લલિક કરો.
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2	મ ોટા ભાગના પુનરાવર્્તનો જમણા હાાંસિયામાાં દેખાશે, જો કે કોઈપણ 
ઉમેરાયેલ ટેક્સ્ટ હજુ પણ ઇનલાઇન દેખાશે.

	 ઇનલાઇન માર્્કઅ પ્સ પર પાછા જવા માટે, તમે કાાં તો બધા પુનરાવર્્તનો 
ઇનલાઇન બતાવો અથવા ફુગ્્ગગામાાં ફક્્ત ટિપ્પણીઓ અને ફોર્મેટિિંગ 
બતાવો પસંદ કરી શકો છો.

લોક અને અનલૉક ફેરફાર ટ્્રરે કિિંગ

•	 વર્્ડમાાં  Review > Track Changes > LockTracking પર ક્્લલિક 
કરો

•	 પાસવર્્ડ  નાખો.

	 હવે જ્યારે ટ્્રરૅ ક ફેરફારો લૉક છે, તેને પાસવર્્ડ  વિના અક્ષમ કરી શકાશે 
નહીીં. અન્ય વપરાશકર્તાઓ પણ ફેરફારો સ્્વવીકારી અથવા નકારી 
શકતા નથી. આનાથી તમે ફેરફારોને મેનેજ કરી શકો છો, પાસવર્્ડ  
દાખલ કરી શકો છો અને પછી ફેરફારોને તેના અંતિમ સ્્વરૂપમાાં સ્થાયી 
કરવા માટે સ્્વવીકારી અથવા નકારી શકો છો.
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IT & ITES	 	 એકસરસાાઈઝ 1.13.48
કોપા (COPA) - મેઇલિિંગ્્સ મેનેજ કરો	

મેઇલ મર્ ્જ કરો (Perform mail merge)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 એન્્વલપ્સ, લેબલ્સ, નવી મેઈલીીંગ લિસ્ટ બનાવો અને હાલની યાદીનો ઉપયોગ કરીને મેઈલ મર્ ્જ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : એન્્વલપ્સ બનાવો 

એન્્વલપ્સ બનાવો

1	મ ઇલિિંગ્્સ ટેબ પર ક્્લલિક કરો.

2	 બનાવો જૂથમાાં એન્્વલપ્સ બટન પર ક્્લલિક કરો.

3	 ડિલિવરી અને રીટર્્ન એડ્્રરેસ દાખલ કરો.

જો તમે એન્્વલપ્સ બટન પર ક્્લલિક કરતા પહેલા દસ્્તતાવેજમાાં ડિલિવરી 
સરનામું પસંદ કરો છો, તો તે આપમેળે ભરાઈ જશે.

સરનામું દાખલ કરો બટન પર ક્્લલિક કરો, તમે ઉપયોગ કરવા માાંગો છો તે 
પ્રોફાઇલ પસંદ કરો અને સંપર્્ક  પસંદ કરો.

4	 (વૈકલ્્પપિક) વિકલ્્પપો પર ક્્લલિક કરો

એન્્વલપ ઓપ્શન્્સ ડાયલોગ બોક્સ ખલુે છે, જમેાાં પરબિડીયું સેટ કરવા 
માટે વિકલ્્પપોના બે ટેબ છે.

5	તમ ારા પરબિડીયુંના વિકલ્્પપો પસંદ કરો.

•	 પરબિડીયું વિકલ્્પપો: પરબિડીયુંનું કદ સ્્પષ્્ટ કરો, રિટર્્ન અન 
ડિલિવરી સરનામાાંમાાં ઉપયોગમાાં લેવાતા ફોન્ટને કસ્ટમાઇઝ કરો 
અન પરબિડીયું પર સરનામાાંનું સ્થાન ગોઠવો.

•	પ્રિન્ટટિં ગ વિકલ્્પપો: તમે સ્્પષ્્ટ કરી શકો છો કે કેવી રીતે પરબિડીયું 
પ્રિન્ટરને ખવડાવવામાાં આવે છે. તમે જ ે  પ્રિન્ટરનો ઉપયોગ કરી 
રહ્યયાં છો તેના આધારે આ સેટિિંગ બદલાશે.

6	 બરાબર ક્્લલિક કરો.

પરબિડીયું વિકલ્્પપો સાચવવામાાં આવે છે.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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7	 પરબિડીયું છાપવા માટે પ્રિન્ટ પર ક્્લલિક કરો અથવા વર્્તમાન 
દસ્્તતાવેજમાાં નવા પૃષ્્ઠ તરીકે એન્્વલપ ઉમેરવા માટે દસ્્તતાવેજમાાં ઉમેરો 
પર ક્્લલિક કરો.

તમાારીી ક્રિ�યાાનાા આધાારેે, પરબિ�ડીીયુંં� પ્રિ�ન્ટરનેે મોોકલવાામાંં આવેે છેે અથવાા 
વર્તતમાાન દસ્તાાવેેજમાંં તેેનાા પોોતાાનાા પૃૃષ્ઠ તરીીકેે ઉમેેરવાામાંં આવેે છેે
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કાાર્યય 2 : લેેબલ્સ બનાાવોો

સમાન લેબલ્સનું પૃષ્્ઠ બનાવો અને છાપો

1	મ ઇલિિંગ્્સ > લેબલ્સ પર જાઓ.

2	 વિકલ્્પપો પસંદ કરો અને લેબલ વેન્્ડર પસંદ કરો અને ઉપયોગ કરવા 
માટે ઉત્્પપાદન. ઓકે પસંદ કરો.

જો તમને તમારો ઉત્્પપાદન નંબર દેખાતો નથી, તો નવું લેબલ પસંદ કરો અને 
કસ્ટમ લેબલ ગોઠવો.

3	 એડ્્રરેસ બોક્સમાાં સરનામું અથવા અન્ય માહિતી લખો (ફક્્ત ટેક્સ્ટ).
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તમારા સંપર્કોની સૂચિમાાંથી સરનામાાંનો ઉપયોગ કરવા માટે સરનામું દાખલ 
કરો પસંદ કરો.

4	 ફોર્મેટિિંગ બદલવા માટે, ટેક્સ્ટ પસંદ કરો, જમણું ક્્લલિક કરો અને ફોન્ટ 
અથવા ફકરા સાથે ફેરફારો કરો.

5	 બરાબર પસંદ કરો.

6	 સમાન લેબલનું પૂર્્ણ પૃષ્્ઠ પસંદ કરો.

7	 સંપાદિત કરવા, સાચવવા માટે પ્રિન્ટ અથવા નવો દસ્્તતાવેજ પસંદ કરો 
પછીથી છાપો.

જો તમનેે માાત્ર એક લેેબલનીી જરૂર હોોય, Mailings > Labels મેનેૂૂમાંંથીી 
સિં�ગલ લેેબલ પસંંદ કરોો અનેે લેેબલ શીીટ પરનીી સ્થિ�તિ� જ્યાંં તમેે તેેનેે 
દેેખાાવાા માંંગોો છોો. ઓકેે, ગંતંવ્ય પસંંદ કરોો અનેે સાાચવોો.

ટીપ: ટેક્સ્ટ લેબલ્સ સાથે સંરેખિત થાય છે તેની ખાતરી કરવા માટે 
પ્રિન્ટરમાાં લેબલ્સ લોડ કરતા પહેલા તમારા લેબલ્સ કાગળની શીટ પર 
છાપો.

કાાર્યય 3 : નવીી મેેઇલિં�ગ સૂૂચિ� બનાાવોો

નવી મેઇલ મર્ ્જ સૂચિ બનાવો

1	 File > New > Blank Document > Mailings પર જાઓ.

2	 Recipients > Type a New List

3	ન વી સરનામું સૂચિ સંવાદ બોક્સમાાં યોગ્્ય હોય તેમ દરેક કૉલમમાાં 
પ્રાપ્્તકર્તા માહિતી લખો.

4	 દરેક નવા રેકોર્્ડ  માટે, નવું ઉમેરો પસંદ કરો.

5	 જો તમને વધુ કૉલમની જરૂર હોય, જમે કે ઓર્્ડ ર નંબર માટે, તો આ 
પગલાાં અનુસરો:

a 	ન વી એડ્્રરેસ લિસ્ટ ડાયલોગ બોક્સમાાં કસ્ટમાઇઝ કોલમ પસંદ 
કરો.
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b	 ઉમેરો પસંદ કરો

c	 ફીલ્્ડનું નામ લખો અને પછી બરાબર પસંદ કરો.	

d 	 દરેેક કૉૉલમ અથવાા ફીીલ્ડ માાટેે પગલાંં b અનેે c પુુનરાાવર્તતન કરોો 
ઉમેરેોો.

6	જ્યા રે તમે તમારી સૂચિમાાં તમને જોઈતા હોય તેવા તમામ લોકોને 
ઉમેરવાનું પૂર્્ણ કરી લો, ત્યારે બરાબર પસંદ કરો.

7	 સેવ એડ્્રરેસ લિસ્ટ સંવાદ બોક્સમાાં, તમારી નવી ફાઇલને નામ આપો, 
અને પછી સેવ પસંદ કરો.

હવે તમે તમારા દસ્્તતાવેજમાાં મેઇલ મર્્જ  ફીલ્્ડડ્્સ દાખલ કરી શકો છો.

કાાર્યય 4 : હાાલનીી સૂૂચિ�નોો ઉપયોોગ કરીીનેે મેેઇલ મર્જજ  કરોો

હાલની સૂચિ

અસ્્તતિત્્વમાાં છે તે સૂચિ એક્સેલ સ્પ્રેડશીટ, એક્સેસ ડેટાબેઝ અથવા અન્ય 
કોઈ પ્રકારનો ડેટાબેઝ હોઈ શકે છે. તમારા ડેટા સ્ત્રોત તરીકે તેનો ઉપયોગ 
કરવા માટે, અસ્્તતિત્્વમાાં રહેલી સૂચિનો ઉપયોગ કરો પસંદ કરો.

મહત્્વપૂર્્ણ: ડેટા સ્ત્રોત તરીકે તમે કયા પ્રકારની ફાઇલનો ઉપયોગ કરો 
છો તે મહત્્વનું નથી, તેને તમારા સ્થાનિક કમ્્પ્યયુટર અથવા ફાઇલ શેર પર 
સાચવવાનું ભલૂશો નહીીં; મેલ મર્્જ  માટે HTTP સ્થાન પર સાચવવું સમર્થિત 
નથી.

નોોંધ: મેઇલ મર્ ્જ તમને બેચ બનાવવા દે છે જો દરેક પ્રાપ્્તકર્તા 
માટે વ્્યક્્તતિગત કરેલ દસ્્તતાવેજો. ઉદાહરણ તરીકે1 બલ્ક ઈમલે 
2 લેટર્્સ 3 ફોર્્મ 4 ફેક્સ વિતરણ 5 ડિરેક્ટરીઓ.

તેનો ઉપયોગ સામાન્ય રીતે પત્રોમાાંથી બહુવિધ પ્રાપ્્તકર્તાઓને છાપવા 
અથવા ઇમેઇલ કરવા માટે થાય છે. 

•	 એક્સેલ સ્પ્રેડશીટ એક્સેલ સ્પ્રેડશીટ મેઈલ મર્્જ  માટે ડેટા સ્ત્રોત 
તરીકે સારી રીતે કામ કરે છે જો તમામ ડેટા સારી રીતે ફોર્મેટ કરેલ હોય 
અને એક શીટ પર હોય જથેી તે વર્્ડ  દ્વારા વાાંચી શકાય.

•	 એક્સેસ ડેટાબેઝ એક્સેસ સાથે, તમે ડેટાબેઝમાાં વ્્યયાખ્યાયિત કોઈપણ 
ટેબલ અથવા ક્્વવેરીમાાંથી ડેટા પસંદ કરી શકો છો.

•	અ ન્ય ડેટાબેઝ ફાઇલો અન્ય પ્રકારના ડેટા સ્ત્રોતોને ઍક્સેસ કરવા 
માટે, તમે ડેટા કનેક્શન વિઝાર્્ડ  ચલાવશો:

1	 Mailings > Select Recipients > Use an Existing List, પછી 
ડેટા કનેક્શન વિઝાર્્ડ  ખોલવા માટે નવો સ્ત્રોત પસંદ કરો.
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2	તમ ે મેઇલ મર્્જ  માટે ઉપયોગ કરવા માાંગો છો તે ડેટા સ્ત્રોતનો પ્રકાર 
પસંદ કરો અને પછી આગળ પસંદ કરો.

3	મર્્જ   દસ્્તતાવેજમાાં ડેટા કનેક્શન પૂર્્ણ કરવા માટે ડેટા કનેક્શન 
વિઝાર્્ડમા ાંના સંકેતોને અનુસરો.
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વ્્યક્્તતિગત મર્ ્જ ફીલ્્ડડ્્સ ઉમેરો

ફોન નંબર્્સ અથવા ઇમેઇલ સરનામાાં જવેા ડેટાને શામેલ કરવા માટે, તમે તે 
મર્્જ  ફીલ્્ડડ્્સ ખાસ દાખલ કરો છો. ઉપરાાંત, ફર્સસ્ટ  નેમ જવેા મર્્જ  ફીલ્્ડને એડ્્રરેસ 
બ્્લલોક અથવા ગ્રીટિિંગ લાઇનનો ભાગ હોવો જરૂરી નથી. જો તમે તમારા 
પ્રાપ્્તકર્તાઓના પ્રથમ નામોનો સમાવશે કરીને દસ્્તતાવેજને વ્્યક્્તતિગત કરવા 
માાંગતા હો, તો તેની જાતે જ First_Name મર્્જ  ફીલ્્ડ દાખલ કરો.

1	તમન ે જ્યયાં મર્્જ  ફીલ્્ડ જોઈએ છે ત્યયાં ક્્લલિક કરો અથવા ટેપ કરો.

2	 ઇન્્સર્્ટ  મર્્જ  ફીલ્્ડ હેઠળ ડાઉન એરો પસંદ કરો અને ફીલ્્ડ પસંદ કરો.
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3	 જો તમને સૂચિમાાં તમારા ફીલ્્ડનું નામ દેખાતું નથી, તો મર્્જ  ફીલ્્ડ દાખલ 
કરો પસંદ કરો.

4	તમ ારા ડેટા સ્ત્રોતમાાં રહેલા ફીલ્્ડડ્્સની યાદી જોવા માટે ડેટાબેઝ 
ફીલ્્ડડ્્સ પસંદ કરો.

5	 દાખલ કરો પસંદ કરો.

મેઇલ મર્ ્જ જુઓ

1 	 Mailings > Click Preview Result પર ક્્લલિક કરો

2	ડ ટાબેઝમાાં ઉપલબ્ધ તમામ યાદી જોવા માટે આગળ, પહેલાનું, Frist 
અન Last પર ક્્લલિક કરો.

3	 ઈમેલ અથવા પ્રિન્ટ ડોક્યુમેન્્ટ્્સ તરીકે મોકલવા માટે સમાપ્્ત કરો અને 
મર્્જ  કરો ક્્લલિક કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.13.48
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IT & ITES	 	 એકસરસાાઈઝ 1.14.49
કોપા (COPA) - સ્પ્રેડ શીટ એપ્્લલિકેશન, વર્્ક શીટ્સ અને વર્્ક બકુનું સંચાલન કરો	

MS Excel માાં ફાઇલો ખોલો (Open files in MS Excel)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 એમએસ એક્સેલ ખોલો
•	 નવી એક્સેલ ફાઇલ બનાવો
•	 ટેમ્્પલેટમાાંથી નવી એક્સેલ ફાઈલ બનાવો
•	 હાલની એક્સેલ ફાઇલ ખોલો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : એમએસ એક્સેલ ખોલો 

1	 વિન્્ડડોઝ સ્ટાર્્ટ  બટન પર ક્્લલિક કરો Start Button > Choose Excel 
પસંદ કરો.

	અ થવા Ctrl + R > Type Excel > Click OK પસંદ કરો

2	મ ાઈક્રોસોફ્ટ એક્સેલ એપ્્લલિકેશન ખુલવાનું શરૂ થશે.

કાર્્ય 2 : નવી એક્સેલ ફાઇલ બનાવો

વર્્ક બુક બનાવો

1	 એક્સેલ ખોલો.

2	ખ ાલી વર્્ક બુક પસંદ કરો અથવા Ctrl+N દબાવો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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3	ટ ાઇપ કરવાનું શરૂ કરો.

તમારી વર્્ક બકુ સાચવો

તમે તમારા કમ્્પ્યયુટર અથવા વેબ પર જ્યયાં પણ તમારી વર્્ક બુકને સાચવવા 
માાંગતા હો, ત્યયાં તમે તમારી બધી બચત File tab > Save અથવા 
પહેલીવાર સવે કરવા માટે Ctrl+S દબાવો અથવા તમારે તમારી હાલની 
વર્્ક બુકને અલગ જગ્્યયાએ સાચવવા માટે Save As નો ઉપયોગ કરવાની 
જરૂર છે, અથવા તે જ અથવા બીજા સ્થાને તમારી વર્્ક બુકની નકલ બનાવવા 
માટે.

1	 File tab > Save અથવા પ્રથમ વખત સાચવવા માટે Ctrl+S દબાવો 

2	 લોકલ ડ્્ર રાઇવ બ્રાઉઝ કરવા માટે સ્થાન અથવા વધુ વિકલ્્પ પસંદ કરો.

3	તમ ે જ્યયાં સાચવવા માાંગો છો તે સ્થાન બ્રાઉઝ કરો અને ફાઇલનું નામ 
આપો અને ફાઇલ પ્રકાર પસંદ કરો.XLSX પછી સાચવો પર ક્્લલિક 
કરો.  

તમારી વર્્ક બકુ તરીકે સાચવો

1	 Click File > Save As

2	 Save As હેઠળ, તમે જ્યયાં તમારી વર્્ક બુક સાચવવા માાંગો છો તે સ્થાન 
પસંદ કરો. ઉદાહરણ તરીકે, તમારા  ડેસ્કટૉપ પર અથવા તમારા 
કમ્્પ્યયુટર પરના ફોલ્્ડરમાાં સાચવવા માટે, કમ્્પ્યયુટર પર ક્્લલિક કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.14.49
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3	 તમારા દસ્્તતાવેજ ફોલ્્ડરમાાં તમે ઇચ્છો તે સ્થાન શોધવા માટે બ્રાઉઝ 
કરો ક્્લલિક કરો.

4	 ફાઇલ નામ બોક્સમાાં, નવી વર્્ક બુક માટે નામ દાખલ કરો. જો તમે 
હાલની વર્્ક બુકની નકલ બનાવી રહ્યા હોવ તો અલગ નામ દાખલ કરો.

5	તમ ારી વર્્ક બુકને અલગ ફાઇલ ફોર્મેટમાાં સાચવવા માટે (જમે કે .xls 
અથવા .txt), સેવ એઝ ટાઈપ લિસ્ટમાાં (ફાઈલ નામ બોક્સ હેઠળ), 
તમને જોઈતું ફોર્મેટ પસંદ કરો.

6	 સાચવો પર ક્્લલિક કરો

કાર્્ય 3 : નમૂનામાાંથી નવી એક્સેલ ફાઇલ બનાવો

નમૂનામાાંથી વર્્ક બુક બનાવો

1	 ફાઇલ > નવું પસંદ કરો.

2	વ ધુ નમૂનો પસંદ કરો

3	 ઉપલબ્ધ નમૂનામાાંથી શોધો અથવા પસંદ કરો. 

4	ટ મ્્પલેટ પર ડબલ-ક્્લલિક કરો અને બનાવો પર ક્્લલિક કરો

5	ટ મ્્પલેટનો ઉપયોગ કરવા માટે ડેટા પર ક્્લલિક કરો અને એન્ટ્ રી કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.14.49
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કાર્્ય 4 : હાલની એક્સેલ ફાઇલ ખોલો

વર્્ક બુક ખોલો

તમે તમારા કમ્્પ્યયુટર પર વર્્ક બુક શોધી શકો છો અને તેને ખોલવા માટે તેને 
ફક્્ત ડબલ-ક્્લલિક કરી શકો છો, પરંતુ તમે એક્સેલ પ્રોગ્રામની અંદરથી 
વર્્ક બુક પણ ખોલી શકો છો.

1	 ફાઇલ ટેબ પર ક્્લલિક કરો.

2	ખ ોલો ક્્લલિક કરો. અથવા

બેકસ્ટેજ વ્્યયૂના ઓપન ટેબને ઝડપથી પ્રદર્શિત કરવા માટે Ctrl + O 
દબાવો.

3	ત ે સ્થાન પસંદ કરો જ્યયાં ફાઇલ સાચવેલ છે.

તમે આમાાંથી પસંદ કરી શકો છો:

•	ત ાજતેરની: તાજતેરની ફાઇલો જનેા પર તમે કામ કર્્યુું છે.

•	મ ારી સાથે શેર કરેલ: અન્ય લોકોએ તમારી સાથે OneDrive અથવા 
SharePoint Online પર શેર કરેલી ફાઇલો.

•	 OneDrive: Microsoftનું ક્્લલાઉડ આધારિત સ્ટોરેજ.

•	 આ PC: તમારા સ્થાનિક કમ્્પ્યયુટર પર ફાઇલોને બ્રાઉઝ કરો.

•	 બ્રાઉઝ કરો: એક સવંાદ બોક્સ ખોલે છે જ્યયાં તમે તમારા કમ્્પ્યયુટરના 
ફોલ્્ડર્્સ, ડ્્ર રાઇવ્્સ અન નેટવર્્ક  શેર્્સ દ્વારા બ્રાઉઝ કરી શકો છો.

4	તમ  ખોલવા માાંગો છો તે ફાઇલ પસંદ કરો.

5	ખ ોલો ક્્લલિક કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.14.49
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IT & ITES	 	 એકસરસાાઈઝ 1.14.50
કોપા (COPA) - સ્પ્રેડ શીટ એપ્્લલિકેશન, વર્્ક શીટ્સ અને વર્્ક બકુનું સંચાલન કરો	

ડેટા આયાત કરો (Import data)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 txt ફાઇલોમાાંથી ડેટા આયાત કરો
•	 csv ફાઇલોમાાંથી ડેટા આયાત કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : txt ફાઇલોમાાંથી ડેટા આયાત કરો 

ટેક્સ્ટ ફાઇલન એક્સેલમાાં ખોલીને આયાત કરો

તમે ઓપન કમાન્્ડનો ઉપયોગ કરીને એક્સેલ વર્્ક બુક તરીકે બીજા 
પ્રોગ્રામમાાં બનાવેલ ટેક્સ્ટ ફાઇલ ખોલી શકો છો. એક્સેલમાાં ટેક્સ્ટ ફાઇલ 
ખોલવાથી ફાઇલનું ફોર્મેટ બદલાતું નથી — તમે તેને એક્સેલ ટાઇટલ 
બારમાાં જોઈ શકો છો, જ્યયાં ફાઇલનું નામ ટેક્સ્ટ ફાઇલ નામ એક્સટન્શનને 
જાળવી રાખે છે (ઉદાહરણ તરીકે, .txt અથવા .csv).

1	 Go to File > Open પર જાઓ અને ટેક્સ્ટ ફાઇલ સમાવે છે તે સ્થાન 
પર બ્રાઉઝ કરો.

2	 ઓપન ડાયલોગ બોક્સમાાં ફાઇલ પ્રકાર ડ્્ર રોપડાઉન સૂચિમાાં ટેક્સ્ટ 
ફાઇલો પસંદ કરો.

3	તમ ે ખોલવા માાંગો છો તે ટેક્સ્ટ ફાઇલને શોધો અને ડબલ-ક્્લલિક કરો.

•	 જો ફાઇલ ટેક્સ્ટ ફાઇલ (.txt) હોય, તો એક્સેલ ઇમ્્પપોર્્ટ  ટેક્સ્ટ 
વિઝાર્્ડ  શરૂ કરે છે. જ્યારે તમે પગલાાંઓ સાથે પૂર્્ણ કરી લો.

4	 આયાત કામગીરી પૂર્્ણ કરવા માટે સમાપ્્ત પર ક્્લલિક કરો. 

કાર્્ય 2 : csv ફાઇલોમાાંથી ડેટા આયાત કરો

1	 Go to File > Open અથવા Data ટેબ પર જાઓ, Get &amp; 
Transform Data ગ્રૂપમાાં, Import Data સંવાદ બોક્સમાાં From 
Text/CSV પર ક્્લલિક કરો.

2	તમ ે ખોલવા માાંગો છો તે CSV ફાઇલને શોધો અને ડબલ-ક્્લલિક કરો.

• 	 જો ફાઇલ .csv ફાઇલ છે, તો Excel આપમેળે ટેક્સ્ટ ફાઇલ ખોલે 
છે અને ડેટાને નવી વર્્ક બુકમાાં પ્રદર્શિત કરે છે.

3	 આયાત કામગીરી પૂર્્ણ કરવા માટે સમાપ્્ત પર ક્્લલિક કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.

© NIMI 

NOT TO BE REPUBLISHED



178

IT & ITES	 	 એકસરસાાઈઝ 1.14.51
કોપા (COPA) - સ્પ્રેડ શીટ એપ્્લલિકેશન, વર્્ક શીટ્સ અને વર્્ક બકુનું સંચાલન કરો	

વર્્ક બકુમાાં નેવિગેટ કરો (Navigate within workbooks)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ડેટા શોધો
•	 નામાાંકિત કોષો, શ્રેણીઓ અથવા વર્્ક બકુ તત્્વવો પર નેવિગેટ કરો
•	 હાઇપરલિિંક દાખલ કરો અને દૂર કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ડેટા શોધો

શોધો

કંઈક શોધવા માટે, Ctrl+F દબાવો અથવા go to Home > Editing> 
Find & Select > Find.

નોોંધ: નીચેના ઉદાહરણમાાં, અમે સમગ્ર શોધ સંવાદ બતાવવા 
માટે Options >> બટન પર ક્્લલિક કર્્યુું છે. મૂળભતૂ રીતે, તે 
છુપાયેલા વિકલ્્પપો સાથે પ્રદર્શિત થશે.

1	 શું શોધો: બૉક્સમાાં, તમે જ ે ટેક્સ્ટ અથવા નંબરો શોધવા માાંગો છો 
તે લખો અથવા શું શોધો: બૉક્સમાાં તીરને ક્્લલિક કરો અને પછી 
સૂચિમાાંથી તાજતેરની શોધ આઇટમ પસંદ કરો.

	 ટીપ્સ: તમે તમારા શોધ માપદંડમાાં વાઇલ્્ડકાર્્ડ  અક્ષરો — પ્રશ્ન ચિહ્ન 
(?), ફૂદડી (*), ટિલ્્ડ (~) — નો ઉપયોગ કરી શકો છો.

2	તમ ારી શોધ ચલાવવા માટે બધા શોધો અથવા આગળ શોધો પર 
ક્્લલિક કરો.

3	 જો જરૂરી હોય તો તમારી શોધને વધુ વ્્યયાખ્યાયિત કરવા માટે 
Options>> to પર ક્્લલિક કરો:

•	અ ંદર: વર્્કશ ીટમાાં અથવા સમગ્ર વર્્ક બુકમાાં ડેટા શોધવા માટે, શીટ 
અથવા વર્્ક બુક પસંદ કરો.

•	શ ોધ: તમે કાાં તો પંક્્તતિઓ (ડિફૉલ્ટ) દ્વારા અથવા કૉલમ દ્વારા 
શોધવાનું પસંદ કરી શકો છો.

•	અ ંદર જુઓ: ચોક્કસ વિગતો સાથે ડેટા શોધવા માટે, બોક્સમાાં, 
ફોર્્મ્યયુલા, મૂલ્યો, નોોંધો અથવા ટિપ્પણીઓ પર ક્્લલિક કરો.

નોોંધ: સતૂ્રો, મૂલ્યો, નોોંધો અને ટિપ્પણીઓ ફક્્ત શોધો ટેબ પર 
ઉપલબ્ધ છે; રિપ્્લલેસ ટેબ પર માત્ર ફોર્્મ્યયુલા જ ઉપલબ્ધ છે.

•	મ ેચ કેસ - જો તમે કેસ-સવંેદનશીલ ડેટા શોધવા માાંગતા હોવ તો 
આ તપાસો.

•	 સમગ્ર કોષની સામગ્રીઓ સાથે મેળ કરો - જો તમે એવા કોષો 
શોધવા માાંગતા હોવ કે જમેાાં તમે શું શોધો:  બોક્સમાાં ટાઈપ કરેલા 
અક્ષરો હોય તો આને તપાસો.

4	 જો તમે ચોક્કસ ફોર્મેટિિંગ સાથે ટેક્સ્ટ અથવા નંબરો શોધવા માાંગતા 
હો, તો ફોર્મેટ પર ક્્લલિક કરો, અન પછી ફોર્મેટ શોધો સંવાદ બોક્સમાાં 
તમારી પસંદગીઓ કરો.
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કાર્્ય 2 : નામના કોષો, શ્રેણીઓ અથવા વર્્ક બકુ તત્્વવો પર નેવિગેટ કરો

તમે Go To સુવિધાનો ઉપયોગ કરીને નામવાળી શ્રેણી શોધી શકો છો જ ે
સમગ્ર વર્્ક બુકમાાં કોઈપણ નામવાળી શ્રેણીમાાં નેવિગેટ કરે છે.

1	તમ ે હોમ ટેબ પર જઈને, શોધો અને પસંદ કરો અને પછી જાઓ પર 
ક્્લલિક કરીને નામવાળી શ્રેણી શોધી શકો છો.

	અ થવા, તમારા કીબોર્્ડ  પર Ctrl+G દબાવો.

2	 પર જાઓ બોક્સમાાં, તમે જ ેનામની શ્રેણી શોધવા માાંગો છો તેના પર 
ડબલ-ક્્લલિક કરો.

3	 બરાબર ક્્લલિક કરો

નોોંધો: 

•	 કોષ અથવા બીજી શીટ પરની શ્રેણીમાાં જવા માટે, સંદર્્ભ બોક્સમાાં 
નીચેના દાખલ કરો: ઉદાહરણ તરીકે: sheet2!$D$12 સેલ પર જવા 
માટે, અને sheet3!$C$12:$F$21 રેન્્જમાાં જવા માટે.

•	તમ ે સંદર્્ભ બોક્સમાાં બહુવિધ નામવાળી શ્રેણીઓ અથવા સેલ સંદર્ભો 
દાખલ કરી શકો છો. દરેકને અલ્્પવિરામથી અલગ કરવું, આના જવેું: 
કિિંમત, પ્રકાર અથવા B14:C22,F19:G30,H21:H29. જ્યારે તમે એન્ટર  
દબાવો અથવા ઓકે ક્્લલિક કરો, ત્યારે એક્સેલ બધી શ્રેણીઓને 
પ્રકાશિત કરશે.

કાર્્ય 3 : હાઇપરલિિંક દાખલ કરો અને દૂર કરો

એક્સેલમાાં હાઇપરલિિંક એ ચોક્કસ ફાઇલ, દસ્્તતાવેજ, સ્થાન, વેબ અને 
ઇમેઇલ સરનામાાંની લિિંક છે. હાઇપરલિિંકનો ઉપયોગ કરીને વપરાશકર્તાઓ 
ચોક્કસ ફાઇલ, દસ્્તતાવેજ અથવા સ્થાન પર જઈ શકે છે.

હાઇપરલિિંક્સ ઓળખવામાાં સરળ છે કારણ કે આ રેખાાંકિત વાદળી અથવા 
જાાંબલી રંગના હાઇલાઇટ કરેલ ટેક્સ્ટ છે. 

હાલની વર્્ક બુકમાાં હાઇપરલિિંક ઉમેરો

વપરાશકર્તાઓ એક્સેલમાાં મેન્યુઅલી હાઇપરલિિંક ઉમેરી શકે છે. જ્યારે 
વપરાશકર્તાઓ સેલમાાં કોઈપણ વેબ સરનામું અથવા ઇમેઇલ સરનામું 
દાખલ કરે છે ત્યારે Excel આપમેળે એક હાઇપરલિિંક પણ બનાવે છે.

1	 પ્રથમ, “Insert”” ટેબ પર જાઓ અને પછી પર ક્્લલિક કરો “Link” જૂથ 
હેઠળ “Link”” આયકન.

2	 અથવા, સલે પર જમણું ક્્લલિક કરો, જ્યયાં તમે હાઇપરલિિંક ઉમેરવા 
માાંગો છો, અને પછી પોપ-અપ મેનૂમાાંથી “લિિંક” વિકલ્્પ પર ક્્લલિક કરો.

3	અ થવા, કીબોર્્ડમાાં થી CTRL + K શોર્્ટકટ દબાવો.

4	 એકવાર તમે ઉપરોક્્ત કોઈપણ પગલાાંને અનુસરો, પછી તમને 
“હાયપરલિિંક શામેલ કરો” વિન્્ડડો ખોલવામાાં આવશે.

5	ત ે પછી, “હાલની ફાઇલ અથવા વેબ પેજ” વિકલ્્પ પસંદ કરો અને પછી 
તે ફાઇલ અથવા દસ્્તતાવેજ જ્યયાં  મૂકવામાાં આવ્્યયો છે તે સ્થાન પસંદ 
કરો.

6	 હવે, ફાઇલ અથવા દસ્્તતાવેજ પસંદ કરો અને પછી “પ્રદર્શિત કરવા માટે 
ટેક્સ્ટ” કૉલમમાાં ટેક્સ્ટ દાખલ કરો કે  જનેે તમે હાઇપરલિિંક કરેલા 
નામ તરીકે દર્શાવવા માાંગો છો, અને OK ક્્લલિક કરો.
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હાલની વર્્ક બકુની ચોક્કસ શીટમાાં હાઇપરલિિંક ઉમેરો

1	 પ્રથમ, “હાલની ફાઇલ અથવા વેબ પેજ” વિકલ્્પ પસંદ કરો અને પછી તે 
સ્થાન પસંદ કરો જ્યયાં તે ફાઇલ અથવા દસ્્તતાવેજ મૂકવામાાં આવ્્યયો છે.

2	ત ે પછી, ફાઇલ અથવા દસ્્તતાવેજ પસંદ કરો અને પછી “બુકમાર્્ક ” બટન 
પર ક્્લલિક કરો.

3	 હવે, ચોક્કસ શીટ અને તે હાલની શીટની લક્ષિત કોષ પસંદ કરો અને 
ઓકે ક્્લલિક કરો.
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વર્્તમાન વર્્ક બકુની ચોક્કસ શીટમાાં હાઇપરલિિંક ઉમેરો

1	 પ્રથમ, “પ્્લલેસ ઇન ધ ડોક્યુમેન્ટ” વિકલ્્પ પસંદ કરો અને તમને વર્્તમાન 
વર્્ક બુકની બધી શીટ્સ મળશે.

2	ત ે પછી, ચોક્કસ શીટ અને લક્ષિત કોષ પસંદ કરો અને બરાબર ક્્લલિક 
કરો.

વેબ એડ્્રરેસ પર હાઇપરલિિંક ઉમેરો

1	 સૌપ્રથમ, બ્રાઉઝરમાાં વેબ પેજ ખોલો અને વેબ એડ્્રરેસની નકલ કરો અને 
તેને “Insert Hyperlink” વિન્્ડડોમાાં  “Address” કોલમમાાં પેસ્ટ કરો.

2	ત ે પછી, “પ્રદર્શિત કરવા માટે ટેક્સ્ટ” કૉલમમાાં ટેક્સ્ટ દાખલ કરો કે 
જનેે તમે હાઇપરલિિંક કરેલા નામ તરીકે દર્શાવવા માાંગો છો, અને પછી 
ઠીક ક્્લલિક કરો.

નવી વર્્ક બકુ ખોલવા માટે હાઇપરલિિંક ઉમેરો

1	 પ્રથમ, “નવા દસ્્તતાવેજ બનાવો” વિકલ્્પ પસંદ કરો અને “નવા દસ્્તતાવેજનું 
નામ” કૉલમમાાં નવી કાર્્યપુસ્્તતિકાનું નામ દાખલ કરો.

2	ત ે પછી, “પ્રદર્શિત કરવા માટે ટેક્સ્ટ” કૉલમમાાં ટેક્સ્ટ દાખલ કરો કે 
જનેે તમે હાઇપરલિિંક કરેલા નામ તરીકે દર્શાવવા માાંગો છો.

3	 હવે, જો તમે નવી વર્્ક બુકનું સેવિિંગ લોકેશન બદલવા માાંગતા હોવ તો 
ચેન્્જ બટન પર ક્્લલિક કરો અને ઓકે   ક્્લલિક કરો.
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ઇમેઇલ સરનામાાં પર હાઇપરલિિંક ઉમેરો

1	 સૌપ્રથમ, “ઈ મેઈલ સરનામું” વિકલ્્પ પસંદ કરો અને પછી “ઈ મેઈલ 
સરનામું” કૉલમમાાં ઈમેલ આઈડી દાખલ    કરો અને “વિષય” કૉલમમાાં 
ઈમેલનો વિષય દાખલ કરો.

2	ત ે પછી, “પ્રદર્શિત કરવા માટે ટેક્સ્ટ” માાં ટેક્સ્ટ દાખલ કરો કે જનેે તમે 
હાઇપરલિિંક કરેલા નામ તરીકે દર્શાવવા માાંગો છો, અને ઓકે ક્્લલિક 
કરો.

3	તમ ે સેલમાાં સીધું ઈમેલ એડ્્રરેસ પણ દાખલ કરી શકો છો અને Excel તે 
ઈમેલની હાઇપરલિિંક ઓટો-ક્રિએટ કરશે.

Excel માાં હાયપરલિિંક્સ દૂર કરો

એક્સેલમાાંથી હાઇપરલિિંક્સ દૂર કરવું એ હાઇપરલિિંક્સ ઉમેરવા અથવા 
બનાવવા કરતાાં સરળ અને ઝડપી છે. એક્સેલ વપરાશકર્તાઓને નીચે 
દર્શાવ્્યયા મુજબ માત્ર બે ક્્લલિક્સમાાં હાઇપરલિિંકને દૂર કરવાની મંજૂરી આપે 
છે.

1	 સેલમાાંથી હાઇપરલિિંક દૂર કરવા માટે, હાઇપરલિિંક ધરાવતા સેલ પર 
જમણું ક્્લલિક કરો અને પછી પોપ-અપ મેનૂમાાંથી “હાયપરલિિંક દૂર 
કરો” પર ક્્લલિક કરો.
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2	 બહુવિધ કોષોમાાંથી હાઇપરલિિંક્સ દૂર કરવા માટે, કોષોને એકસાથે 
પસંદ કરો અને જમણું ક્્લલિક કરો અને  પોપ-અપ મેનૂમાાંથી 
“હાયપરલિિંક દૂર કરો” પસંદ કરો.

3	 હાઇપરલિિંક્સ દૂર કરવા માટે, વર્્તમાન વર્્કશ ીટ બનાવો, કીબોર્્ડમાાં થી 
CTRL+A દબાવીને આખી વર્્કશ ીટ પસંદ કરો.

4	 હવે, “હોમ” ટેબ પર જાઓ અને “ક્્લલીયર” આઇકોન ડ્્ર રોપ-ડાઉન એરો 
પર ક્્લલિક કરો અને પછી “હાયપરલિિંક્સ દૂર કરો” પસંદ કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.14.52
કોપા (COPA) - સ્પ્રેડ શીટ એપ્્લલિકેશન, વર્્ક શીટ્સ અને વર્્ક બકુનું સંચાલન કરો	

વર્્ક શીટ્સ અને વર્્ક બકુને ફોર્મેટ કરો (Format worksheets and workbooks)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 પૃષ્્ઠ સેટઅપમાાં ફેરફાર કરો
•	 પંક્્તતિની ઊંચાઈ અને કૉલમની પહોળાઈને સમાયોજિત કરો
•	 હેડરો અને ફૂટર કસ્ટમાઇઝ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પૃષ્્ઠ સેટઅપમાાં ફેરફાર કરો

1	 પેજ સેટઅપ

પેજના લેઆઉટ અન પ્રિન્ટ વિકલ્્પપોને સેટ કરવા માટે પેજ સેટઅપ ડાયલોગ 
બોક્સનો ઉપયોગ કરો.

પૃષ્્ઠ લેઆઉટ ટેબ પર ક્્લલિક કરો, પછી પૃષ્્ઠ સેટઅપ જૂથમાાં, લેન્્ડસ્કેપ 
અને પોટ્્ર રેટ વચ્ચે ડાયલોગ બોક્સ લોન્ચર    ઓરિએન્ટેશન પસંદ કરો 
પર ક્્લલિક કરો.   

જ્યારે તમે છાપો છો ત્યારે સ્કે લિિંગ વર્્કશ ીટ અથવા પસંદગીને મોટંુ અથવા 
ઘટાડે છે જથેી કરીને તે નિર્દિષ્્ટ સખં્યાના પૃષ્્ઠઠો પર બંધબેસે.

•	જ્યા રે તમે એડજસ્ટ ટુ પસંદ કરો છો, ત્યારે તમે % સામાન્ય કદના 
બોક્સમાાં ટકાવારી દાખલ કરી શકો છો.

•	જ્યા રે તમે ફિટ ટુ પસંદ કરો છો, ત્યારે તમે પૃષ્્ઠ(ઓ)માાં બૉક્સ અને 
ઊંચા બૉક્સ દ્વારા પહોળા નંબર દાખલ કરી શકો છો. કાગળની 
પહોળાઈ ભરવા અને જરૂરી હોય તેટલા પૃષ્્ઠઠોનો ઉપયોગ કરવા માટે, 
બૉક્સ દ્વારા પહોળા પૃષ્્ઠઠોમાાં 1 ટાઈપ કરો અને ઊંચા બોક્સને ખાલી 
છોડી દો.

કાગળનું કદ: આ બૉક્સમાાં, સૂચવવા માટે પત્ર, કાનૂની અથવા અન્ય કદના 
વિકલ્્પપો પર ક્્લલિક કરો કદ કે જ ેતમે તમારા મુદ્રિત દસ્્તતાવેજ માટે વાપરવા 
માાંગો છો અથવા પરબિડીયું

પ્રિન્ટ ગુણવત્તા: આ બોક્સમાાં, સક્રિય વર્્કશ ીટ માટે પ્રિન્ટ ગુણવત્તા સ્્પષ્્ટ 
કરવા માટે રિઝોલ્યુશન પર ક્્લલિક કરો. રિઝોલ્યુશન એ મુદ્રિત પૃષ્્ઠ પર 
દેખાતા રેખીય ઇંચ (dpi) દીઠ બિિંદુઓની સખં્યા છે. 

પ્રથમ પૃષ્્ઠ નંબર: આ બૉક્સમાાં, “1” (જો તે પ્રિન્ટ જોબનું પ્રથમ પૃષ્્ઠ છે) 
અથવા પછીના અનુક્રમ નંબર પર (જો તે પ્રિન્ટ જોબનું પ્રથમ પૃષ્્ઠ ન હોય 
તો) પર નંબર આપવાનું શરૂ કરવા માટે ઑટો દાખલ કરો. “1” સિવાયના 
પ્રારંભિક પૃષ્્ઠ નંબરનો ઉલ્્લલેખ કરવા માટે એક નંબર દાખલ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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કાર્્ય 2 : પંક્્તતિની ઊંચાઈ અને કૉલમની પહોળાઈને સમાયોજિત કરો

ચોક્કસ પહોળાઈ પર કૉલમ સેટ કરો

1	તમ ે બદલવા માાંગો છો તે કૉલમ અથવા કૉલમ પસંદ કરો.

2	 હોમ ટેબ પર, કોષ જૂથમાાં, ફોર્મેટ પર ક્્લલિક કરો.

3	 સેલ સાઈઝ હેઠળ, કૉલમની પહોળાઈ અથવા પંક્્તતિની ઊંચાઈ પર 
ક્્લલિક કરો

4	 કૉલમ પહોળાઈ અને પંક્્તતિની ઊંચાઈ બૉક્સમાાં, તમને જોઈતી કિિંમત 
ટાઈપ કરો

5	 બરાબર ક્્લલિક કરો.

કાર્્ય 3 : હેડરો અને ફૂટરને કસ્ટમાઇઝ કરો

પૃષ્્ઠ લેઆઉટ દૃશ્્યમાાં હેડર અથવા ફૂટર્્સ ઉમેરો અથવા બદલો

1	વર્્કશ  ીટ પર ક્્લલિક કરો જ્યયાં તમે હેડર અથવા ફૂટર્્સ ઉમેરવા અથવા 
બદલવા માાંગો છો.

2	 ઇન્્સર્્ટ  ટેબ પર, ટેક્સ્ટ જૂથમાાં, હેડર અને ફૂટર પર ક્્લલિક કરો.

Excel પૃષ્્ઠ લેઆઉટ દૃશ્્યમાાં વર્્ક શીટ દર્શાવે છે.

3	 હેડર અથવા ફૂટર ઉમેરવા અથવા સંપાદિત કરવા માટે, વર્્કશ ીટ 
પૃષ્્ઠની ઉપર અથવા નીચે ડાબે, મધ્્યમાાં અથવા જમણે હેડર અથવા 
ફૂટર ટેક્સ્ટ બોક્સ પર ક્્લલિક કરો (હેડર હેઠળ, અથવા ફૂટર ઉપર).

4	ન વું હેડર અથવા ફૂટર લખાણ લખો.
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પૃષ્્ઠ સેટઅપમાાં હેડર અથવા ફૂટર્્સ ઉમેરો અથવા બદલો

1	 પેજનું હેડર અન ફૂટર સેટ કરવા માટે પેજ સેટઅપ ડાયલોગ બોક્સનો 

ઉપયોગ કરો. 2	 પૃષ્્ઠ લેઆઉટ ટેબ પર ક્્લલિક કરો, પછી પૃષ્્ઠ 
સેટઅપ જૂથમાાં, ડાયલોગ બોક્સ લોન્ચરને ક્્લલિક કરો.

3	 હેડર/ફૂટર પસંદ કરો

4	 કસ્ટમ હેડર અથવા કસ્ટમ ફૂટર પસંદ કરો.

5	લખ ાણ, પૃષ્્ઠ નંબર, તારીખ, સમય, છબી અને વગેરે દાખલ કરો. તમે 
ડાબા વિભાગ / કેન્દદ્ર વિભાગ / જમણા વિભાગમાાં હેડર અથવા ફૂટર 
તરીકે રાખવા માાંગો છો

6	 Ok પર ક્્લલિક કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.14.53
કોપા (COPA) - સ્પ્રેડ શીટ એપ્્લલિકેશન, વર્્ક શીટ્સ અને વર્્ક બકુનું સંચાલન કરો	

વિકલ્્પપો અને દૃશ્્યયોને કસ્ટમાઇઝ કરો (Customize options and views)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 વિવિધ દૃશ્્યયોમાાં સામગ્રી પ્રદર્શિત અને સશંોધિત કરો
•	 પંક્્તતિઓ અને કૉલમ સ્થિર કરો
•	 વિન્્ડડો દૃશ્્યયો બદલો
•	 મૂળભતૂ વર્્ક બકુ ગુણધર્મો સશંોધિત કરો
•	 સતૂ્રો દર્શાવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : વિવિધ દૃશ્્યયોમાાં સામગ્રી પ્રદર્શિત કરો અને સશંોધિત કરો

ત્યયાં ત્રણ બિલ્ટ-ઇન દૃશ્્ય પ્રકારો છે, સામાન્ય, પૃષ્્ઠ બ્રેક પરૂ્વાવલોકન અને 
પૃષ્્ઠ લેઆઉટ, તેમજ કસ્ટમાઇઝ કરી શકાય તેવા દૃશ્્ય વિકલ્્પપોનો સમહૂ.

વ્્યયુ પ્રકારોનો અસરકારક રીતે ઉપયોગ કરવો એ વર્્કશ ીટ મેનેજમેન્ટ અને 
લેઆઉટ ડિઝાઇનનો આવશ્્યક ભાગ છે.

સામાન્ય દૃશ્્ય એક્સેલ 

એક્સેલ નોર્્મલ વ્્યયુ, જ ેતમામ વર્્કશ ીટ્સ માટે ડિફોલ્ટ વ્્યયુ પણ છે, તે ડેટાને 
મેનેજ કરવા, ફોર્્મ્યયુલા બનાવવા અને પંક્્તતિઓ અને કૉલમને ફોર્મેટિિંગ કરવા 
માટે સૌથી સરળ વ્્યયુ છે. જ્યારે તમે નવી વર્્ક બુક અથવા શીટ ખોલો છો, 
ત્યારે તે સામાન્ય રીતે આ દૃશ્્ય સક્રિય થવા સાથે ખુલશે.

કાર્્યપત્રકને સામાન્ય દૃશ્્ય પર સટે કરવા માટે:

1	 રિબન પર વ્્યયુ ટેબ પર ક્્લલિક કરો.

2	વર્્ક  બુક વ્્યયુઝ જૂથમાાં, સામાન્ય પર ક્્લલિક કરો. 

Excel માાં સામાન્ય દૃશ્્ય એ સૌથી સામાન્ય રીતે ઉપયોગમાાં લેવાતું દૃશ્્ય છે 
અને કાર્્યપત્રકમાાં ડેટા ઉમેરવા માટે દલીલપરૂ્્વક શ્રેષ્્ઠ દૃશ્્ય છે.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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પેજ બ્રેક પૂર્વાવલોકન એક્સેલ 

Excel માાં પેજ બ્રેક પ્રિવ્્યયૂ એ ખૂબ જ શક્્તતિશાળી પ્રિન્ટ પ્રિવ્્યયૂ છે જ ેતમને પેજ 
બ્રેક્સને મેન્યુઅલી ખસડેવા અને પ્રિન્ટટિંગ માટે પૃષ્્ઠઠોમાાં વર્્કશ ીટને ફરીથી 
ગોઠવવાની મંજૂરી આપે છે. તમે Excel 2016 પેજ બ્રેક પ્રીવ્્યયૂની વાદળી 
રેખાઓને ખસડેીને બરાબર શ્રેષ્્ઠ સ્થાન પર કૉલમ અથવા પંક્્તતિઓ તોડી 
શકો છો.

એક્સેલ પેજ બ્રેક પૂર્વાવલોકનનો ઉપયોગ કરવા માટે:

1	 રિબન પર વ્્યયુ ટેબ પર ક્્લલિક કરો.

2	વર્્ક  બુક વ્્યયુઝ ગ્રુપમાાં, પેજ બ્રેક પ્રિવ્્યયુ પર ક્્લલિક કરો.

3	 પેજ 1 અને પેજ 2 દર્શાવતા ફેઇન્ટ વોટરમાર્્ક , વર્્કશ ીટમાાં કેટલા પૃષ્્ઠઠો છે 
અને તે છાપશે તેનો સંકેત છે.

4	જ્યા રે તમે વર્્કશ ીટ પ્રિન્ટ કરશો ત્યારે ડાર્્ક  ગ્રે એરિયામાાંનો તમામ ડેટા 
(નંબર, ચિહ્નો, ટેક્સ્ટ વગેરે) બાકાત રાખવામાાં આવશ.

પૃષ્્ઠઠોનું કદ બદલવા અને પંક્્તતિઓ અથવા કૉલમ્્સ શામેલ કરવા 
અથવા બાકાત કરવા

1	 ઊભી વાદળી રેખા પર ક્્લલિક કરો અને કૉલમને શામેલ કરવા અથવા 
બાકાત કરવા માટે લાઇનને ડાબી અથવા જમણી તરફ ખેેંચવા માટે 
ડાબી માઉસ બટન દબાવી રાખો. આ રેખા પૃષ્્ઠની પહોળાઈ સુયોજિત 
કરે છે. તમે આ લાઇનને ખેેંચો છો તે પહોળાઈને ફિટ કરવા માટે Excel 
આપમેળે પૃષ્્ઠ પરના ડેટાનું કદ બદલશ, જ ેક્યારેક પ્રિન્ટેડ ડેટા વાાંચવા 
માટે ખૂબ નાનો હોઈ શકે છે.

2	 આડી વાદળી રેખા પર ક્્લલિક કરો અને પંક્્તતિઓ શામેલ કરવા અથવા 
બાકાત કરવા માટે લાઇનને ઉપર અથવા નીચે ખેેંચવા માટે ડાબી 
માઉસ બટન દબાવી રાખો. આ લીટી પૃષ્્ઠની ઊંચાઈ સુયોજિત કરે છે. 
તમે  આ લાઇનને ખેેંચો છો તે ઊંચાઈને ફિટ કરવા માટે Excel આપમેળે 
પૃષ્્ઠ પરના ડેટાનું કદ બદલશે, જ ે કેટલીકવાર ડેટાને છાપવામાાં પણ 
પરિણમી શકે છે, જ્યારે તે વાાંચવા માટે ખૂબ નાનો છે.

આ દૃશ્્યમાાં વર્્કશ ીટની હેરફેર કરવી ઝડપી અને સરળ છે જથેી કરીને તે 
ચોક્કસ સખં્યાના પૃષ્્ઠઠો પર પ્રિન્ટ કરે તેની ખાતરી કરી શકાય.

પૃષ્્ઠ લેઆઉટ જુઓ એક્સેલ

તમે વર્્કશ ીટના હેડરો અને ફૂટર્્સમાાં ડિઝાઇન તત્્વવો ઉમેરવા માટે એક્સેલ 
પેજ લેઆઉટ વ્્યયૂનો ઉપયોગ કરો છો, જમે કે કંપનીના લોગો, પૃષ્્ઠ નંબર, 
દસ્્તતાવેજના નામ, તારીખો અને સમય. આ ઘટકો સામાન્ય રીતે અન્ય દૃશ્્ય 
પ્રકારોમાાં દેખાતા નથી, પરંતુ વર્્ક બુકના દરેક પૃષ્્ઠ સાથે છાપવામાાં આવશે.

એમએસ એક્સેલ પેજ લેઆઉટ વ્્યયુ પર નેવિગેટ કરવા માટે:

1	 રિબન પર વ્્યયુ ટેબ પર ક્્લલિક કરો.

2	વર્્ક  બુક વ્્યયુઝ ગ્રુપમાાં, પેજ લેઆઉટ વ્્યયૂ પર ક્્લલિક કરો.

પેજ લેઆઉટ વ્્યયૂમાાં, એક્સેલ વર્્કશ ીટ બનાવી શકાય છે, મેનેજ કરી શકાય 
છે, ફોર્મેટ કરી શકાય છે અન એડિટ કરી શકાય છે જાણે કે તે નિયમિત MS 
વર્્ડ  ડોક્યુમેન્ટમાાં પેજ હોય.
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મુખ્ય લક્ષણો અને ક્રિયાઓ જે  આ લેઆઉટમાાં પ્રભાવિત થઈ શકે છે 
તે છે:

1	 પૃષ્્ઠ માર્જિનની પહોળાઈનું કદ બદલવા માટે આડી શાસકનો ઉપયોગ 
કરો.

2	 પૃષ્્ઠ માર્જિનની ઊંચાઈનું કદ બદલવા માટે વર્ટિકલ રૂલરનો ઉપયોગ 
કરો.

3	 સામગ્રી ઉમેરવા માટે હેડર વિસ્્તતારમાાં ક્્લલિક કરો.

4	 સામગ્રી ઉમેરવા માટે ફૂટર વિસ્્તતારમાાં ક્્લલિક કરો.

તમે વર્્કશ ીટના હેડર અથવા ફૂટર ક્ષેત્રમાાં ઓટોમેટિક પેજ નંબર, તારીખ, 
સમય, જ્યયાં ફાઇલ સેવ કરવામાાં આવી છે, ફાઇલનું નામ, વર્્કશ ીટનું નામ, 
કંપનીનો લોગો જવેી છબીઓ, ટાઈપ કરેલા શબ્દો અને નંબરો અન વધુ 
ઉમેરી શકો છો.

ત્રણ સરળ પગલાઓમાાં એક્સેલ હેડર અને ફૂટર વિસ્્તતારોમાાં સામગ્રી 
ઉમેરો:

1	 હેડર અથવા ફૂટર વિસ્્તતારમાાં ક્્લલિક કરો.

2	 હેડર અને ફૂટર ટૂલ્સ સંદર્્ભ ટેબ પર ક્્લલિક કરો (યાદ રાખો કે જો તમે 
હેડર અથવા ફૂટર એરિયામાાં ક્્લલિક કર્્યુું હોય તો જ આ દેખાય છે).

3	 હેડર અથવા ફૂટરમાાં ઉમેરવા માટે સામગ્રી પસંદ કરો.
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નીચે સ્ક્રીનશોટમાાં નારંગી રંગમાાં દર્શાવેલ વિસ્્તતારની જમે તમે હેડર અથવા 
ફૂટરમાાં ઉમેરો છો તે સામગ્રી વિચિત્ર રીતે પ્રદર્શિત થાય ત્યારે ગભરાશો 
નહીીં. આ માઈક્રોસોફ્ટ એક્સેલની સામગ્રીને સંગ્રહિત કરવાની રીત છે અને 

જ્યારે તમે હેડર અને ફૂટર પ્રદેશમાાંથી બહાર નીકળો છો અથવા વર્્કશ ીટ 
છાપો છો, ત્યારે આ વિચિત્ર અક્ષરો અદૃશ્્ય થઈ જશે.

એક્સેલમાાં પેજ લેઆઉટ વ્્યયુ તમને પીડીએફ ફોર્મેટમાાં પ્રિન્ટ કરવા અથવા 
શેર કરવા માટે વ્્યયાવસાયિક અને સૌૌંદર્્યલક્ષી રીતે આનંદદાયક વર્્કશ ીટ્સ 
બનાવવામાાં મદદ કરશે, બિલકુલ સમય વિના!

કસ્ટમ વ્્યયૂઝ એક્સેલ 

જો ઉપર સૂચિબદ્ધ દૃશ્્યયોમાાંથી કોઈ પણ તમે જ ેશોધી રહ્યયાં છો તે બરાબર 
નથી, તો Microsoft એ વધુ કસ્ટમાઇઝ કરી શકાય તેવા દૃશ્્ય પ્રકારનો 
ઉમેરો કર્યો છે, જનેે યોગ્્ય રીતે કસ્ટમ વ્્યયૂઝ નામ આપવામાાં આવ્્યયુું છે. આ 
વિકલ્્પ તમને તમે પસંદ કરો છો તે ચોક્કસ દૃશ્્ય અને પ્રિન્ટ સેટિિંગ્્સને સેટ 
કરવાની મંજૂરી આપે છે અને પછી તમને માાંગ પર અન્ય કાર્્યપત્રકો પર આ 
દૃશ્્ય લાગુ કરવાની મંજૂરી આપે છે.

એક્સેલમાાં કસ્ટમ વ્્યયૂ ફીચરને ટ્્ર રાયલ કરવા માટે:

1	 હાલની વર્્કશ ીટ ખોલો.

2	 ઝૂમને 50% પર સમાયોજિત કરો. (ઝૂમ ઇન અને આઉટ કરવાની 
ઝડપી રીત, ઝૂમ ઇન અને આઉટ કરવા માટે માઉસ પર સ્ક્રોલિિંગ 
વ્હીલનો ઉપયોગ કરતી વખતે તમારા કીબોર્્ડ  પરની કંટ્્ર રોલ કી દબાવી 
રાખો).

3 	 રિબન પર વ્્યયુ ટેબ પર ક્્લલિક કરો અને શો જૂથમાાં, ગ્રીડલાઇન્્સ અને 
હેડિિંગ બોક્સને અનટિક કરો.

ઉપરના ત્રણ પગલાાંમાાં બનાવેલ કસ્ટમ વ્્યયૂને સાચવવા માટે:

1	 રિબન પર વ્્યયુ ટેબ પર ક્્લલિક કરો.

2	વર્્ક  બુક વ્્યયુઝ ગ્રુપમાાં, કસ્ટમ વ્્યયુઝ પર ક્્લલિક કરો.

3	 કસ્ટમ વ્્યયુઝ ડાયલોગ બોક્સમાાં, એડ પર ક્્લલિક કરો.
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4	તમ ારા વૈવિધ્્યપૂર્્ણ દૃશ્્યને નામ આપો, ઉદાહરણ તરીકે, MyView. 5	 કસ્ટમ વ્્યયુ સાચવવા માટે ઓકે દબાવો.

કાર્્ય 2 : પંક્્તતિઓ અને કૉલમ સ્થિર કરો

પ્રથમ કૉલમ સ્થિર કરો

•	 બીજી કૉલમ પસંદ કરો.

•	 View > Freeze Panes > Freeze First Column. પસંદ કરો.

The faint line that appears between Column A and B shows 
that the first column is frozen. 

પ્રથમ પંક્્તતિ સ્થિર કરો

1	 બીજી પંક્્તતિ પસંદ કરો

2	 View > Freeze Panes > Freeze Top Row. પસંદ કરો

કૉલમ અને પંક્્તતિઓ સ્થિર કરો

1	 પંક્્તતિઓની નીચેનો કોષ પસંદ કરો અને તમે જ્યારે સ્ક્રોલ કરો ત્યારે 
તમે દૃશ્્યમાન રાખવા માાંગો છો તે કૉલમની જમણી બાજુએ.

2	 View > Freeze Panes > Freeze Panes પસંદ કરો.

ઉપરના પગલાઓમાાં બનાવેલ કસ્ટમ વ્્યયૂ લાગુ કરવા માટે:

1	 ઝૂમ બદલો અને ગ્રીડલાઈન અને હેડિિંગ ફરીથી પ્રદર્શિત કરો.

2	 રિબન પર વ્્યયુ ટેબ પર ક્્લલિક કરો.

3	વર્્ક  બુક વ્્યયુઝ ગ્રુપમાાં, કસ્ટમ વ્્યયુઝ પર ક્્લલિક કરો.

4	 કસ્ટમ વ્્યયુઝ ડાયલોગ બોક્સમાાં, તમે બનાવેલ કસ્ટમ વ્્યયુનું નામ પસંદ 
કરો અને તેને લાગુ કરવા માટે બતાવો દબાવો.

આ વ્્યયુનો ફાયદો એ છે કે તમે વર્્કશ ીટમાાં ઝૂમ ઇન અને આઉટ કરી શકો છો 
અથવા વર્્કશ ીટને સંપાદિત કરતી વખતે અથવા ડેટા ઉમેરતી વખતે તેનો 
ઉપયોગ કરવાનું વધુ અનુકૂળ બનાવવા માટે અન્ય દૃશ્્ય સેટિિંગ્્સ બદલી 
શકો છો. એકવાર તમે પૂર્્ણ કરી લો તે પછી, તમે બનાવેલ નામના કસ્ટમ વ્્યયૂ 
દ્વારા તમે ઝડપથી તમારા મનપસંદ દૃશ્્ય પર પાછા આવી શકો છો.
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પંક્્તતિઓ અથવા કૉલમ્્સને અનફ્રીઝ કરો

•	 On the View tab > Window > Unfreeze Panes.

નોોંધ: જો તમને વ્્યયૂ ટેબ દેખાતી નથી, તો સંભવ છે કે તમે 
એક્સેલ સ્ટાર્્ટરનો ઉપયોગ કરી રહ્યયાં છો. એક્સેલ સ્ટાર્્ટરમાાં 
તમામ સુવિધાઓ સમર્થિત નથી.

કાર્્ય 3 : વિન્્ડડો દૃશ્્યયો બદલો

સંપૂર્્ણ અથવા પર સ્્વવિચ કરો Excel માાં સામાન્ય સ્ક્રીન દૃશ્્ય

સ્ક્રીન પર વધુ ડેટા જોવા માટે, તમે અસ્થાયી રૂપે પૂર્્ણ સ્ક્રીન દૃશ્્ય પર 
સ્્વવિચ કરી શકો છો. પૂર્્ણ સ્ક્રીન વ્્યયુ માઇક્રોસોફ્ટ ઓફિસ ફ્્લલુએન્ટ યુઝર 
ઇન્ટરફેસ રિબન, ફોર્્મ્યયુલા બાર અને સ્ટેટસ બારને છુપાવે છે. છુપાયેલા 
તત્્વવોને ફરીથી ઍક્સેસ કરવા માટે, તમારે સામાન્ય સ્ક્રીન દૃશ્્ય પર પાછા 
ફરવું પડશે.

•	 પૂર્્ણ સ્ક્રીન દૃશ્્ય પર સ્્વવિચ કરવા માટે, CTRL+SHIFT+F1 દબાવો.

•	 સામાન્ય સ્ક્રીન દૃશ્્ય પર પાછા આવવા માટે, દબાવો ફરીથી 
CTRL+SHIFT+F1.

	 ટીપ: હજુ પણ બધું જોઈ શકતા નથી? ALT+SPACE દબાવો અને 
મહત્તમ પસંદ કરો.

કાર્્ય 4 : મૂળભતૂ વર્્ક બકુ ગુણધર્મોમાાં ફેરફાર કરો

1	 ફાઇલ ટેબ પર ક્્લલિક કરો.

2	મ ાહિતી પર ક્્લલિક કરો.

3	 પૃષ્્ઠની ટોચ પર પ્રોપર્ટીઝ પર ક્્લલિક કરો, અને પછી એડવાન્્સ્્ડ 
પ્રોપર્ટીઝ પસંદ કરો.

નોોંધો: 

•	 ઍક્સેસમાાં તમે ડેટાબેઝ ગુણધર્મો જુઓ અને સંપાદિત કરો પસંદ 
કરશો

•	પ્રો જકે્ટમાાં તમે પ્રોજકે્ટ માહિતી પસંદ કરશો

•	 પ્રકાશકમાાં તમે પ્રકાશન ગુણધર્મો પસંદ કરશો

•	 Currently, you can’t view or create custom properties 
for Visio files 

4	 કસ્ટમ ટેબ પર ક્્લલિક કરો.

•	ન ામ બોક્સમાાં, કસ્ટમ પ્રોપર્ટી માટે નામ લખો, અથવા યાદીમાાંથી 
નામ પસંદ કરો.

•	 પ્રકાર સૂચિમાાં, તમે ઉમેરવા માાંગો છો તે મિલકત માટે ડેટા પ્રકાર 
પસંદ કરો.

•	 મૂલ્ય બોક્સમાાં, મિલકત માટે મૂલ્ય લખો. તમે જ ેમલૂ્ય લખો છો તે 
પ્રકાર સૂચિમાાંની પસંદગી સાથે મેળ ખાતું હોવું જોઈએ.

કાર્્ય 5 : સતૂ્રો દર્શાવો

ફોર્્મ્યયુલા બતાવો/છુપાવો

મૂળભતૂ રીતે, એક્સેલ વાસ્્તવિક સૂત્રો બતાવવાને બદલે વર્્કશ ીટમાાં સૂત્રોના 
પરિણામો દર્શાવે છે. જો કે, તમે Excel માાં સૂત્રો દર્શાવવાનું પસંદ કરી શકો 
છો જથેી તમે જોઈ શકો કે તેઓ કેવી રીતે એકસાથે મૂકવામાાં આવ્્યયા છે.

1	 ફોર્્મ્યયુલા ટેબ પર ક્્લલિક કરો.

2	 ફોર્્મ્યયુલા બતાવો બટન પર ક્્લલિક કરો.
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સૂત્રો વર્્કશ ીટમાાં પ્રદર્શિત થાય છે અને જો જરૂરી હોય તો, સૂત્રોને સમાવવા 
માટે કૉલમ પહોળા થાય છે.

જો તમે સતૂ્રો પ્રદર્શિત કરો અને પછી ફોર્્મ્યયુલા ધરાવતા કોષને પસંદ કરો, તો 
ફોર્્મ્યયુલા દ્વારા સંદર્ભિત કોષોની આસપાસ રંગીન રેખાઓ દેખાય છે.

3	 સૂત્રોને છુપાવવા માટે ફરીથી ફોર્્મ્યયુલા બતાવો બટન પર ક્્લલિક કરો.
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ફોર્્મ્યયુલા હવે પ્રદર્શિત થતા નથી અને કૉલમ તેમના મૂળ કદમાાં પાછા ફરે છે.

સતૂ્રો હાઇલાઇટ કરો

જો તમે વાસ્્તવિક સૂત્રો જોવા માાંગતા ન હોવ, પરંતુ તે જાણવા માાંગતા હોવ કે 
કયા કોષો તેમાાં સમાવે છે, તો તેના બદલે સૂત્રો સાથે કોષોને હાઇલાઇટ કરો.

1	 હોમ ટેબ પર ક્્લલિક કરો.

2	 શોધો અને પસંદ કરો બટન પર ક્્લલિક કરો.

3	 ફોર્્મ્યયુલા પસંદ કરો.

કોઈપણ કોષો કે જમેાાં સૂત્ર હોય છે તે પ્રકાશિત થાય છે; જો કે, આ સેલ 
ફોર્મેટિિંગમાાં ફેરફાર કરતું નથી. જ્યારે તમે વર્્કશ ીટમાાં કોઈપણ અન્ય કોષને 
ક્્લલિક કરો છો, ત્યારે હાઇલાઇટ કરેલ કોષો નાપસંદ કરવામાાં આવે છે.
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IT & ITES	 	 એકસરસાાઈઝ 1.14.54
કોપા (COPA) - સ્પ્રેડ શીટ એપ્્લલિકેશન, વર્્ક શીટ્સ અને વર્્ક બકુનું સંચાલન કરો	

સહયોગ માટે સામગ્રીને ગોઠવો (Configure content for collaboration)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	પ્રિ ન્ટ વિસ્્તતાર સેટ કરો
•	 વર્્ક બકુને વકૈલ્્પપિક ફાઇલ ફોર્મેટમાાં સાચવો
•	પ્રિ ન્ટ સેટિિંગ્્સ ગોઠવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પ્રિન્ટ એરિયા સેટ કરો 

પ્રિન્ટ થયેલ વર્્ક બુક ડેટાનો ઉલ્્લલેખ કરવાની બે રીતો છે: પ્રિન્ટ એરિયા સેટ 
કરવું અને પેજ બ્રેક્સને સમાયોજિત કરવું.

પ્રિન્ટ એરિયા સેટ કરો

કેટલીકવાર તમે વર્્કશ ીટનો માત્ર એક ભાગ જ છાપવા માાંગો છો. તમે 
વિસ્્તતારને વ્્યયાખ્યાયિત કરી શકો છો જથેી તમે કોઈપણ સમયે છાપો, ફક્્ત 
તે સેલ શ્રેણી છાપવામાાં આવે.

1	તમ ે છાપવા માાંગો છો તે કોષો પસંદ કરો.

2	 પૃષ્્ઠ લેઆઉટ ટેબ પર ક્્લલિક કરો.

3	પ્રિન્ટ  એરિયા બટન પર ક્્લલિક કરો.

4	પ્રિન્ટ  વિસ્્તતાર સેટ કરો પસંદ કરો.

એકવાર પ્રિન્ટ એરિયા સટે થઈ જાય પછી, વધારાના કોષો પસંદ કરીને, 
પ્રિન્ટ એરિયા બટન પર ક્્લલિક કરીને અને પ્રિન્ટ એરિયામાાં ઉમેરો પસંદ 
કરીને વધારાના પ્રિન્ટ વિસ્્તતારો ઉમેરો.

પ્રિન્ટ વિસ્્તતારની આસપાસ ઘેરા રાખોડી રંગની સરહદ દેખાય છે. જ્યારે તમે 
છાપો છો, ત્યારે ફક્્ત તે શ્રેણીમાાંના કોષો પૃષ્્ઠ પર દેખાય છે.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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પ્રિન્ટ એરિયા દૂર કરો

1	 પૃષ્્ઠ લેઆઉટ ટેબ પર ક્્લલિક કરો.

2	પ્રિન્ટ  એરિયા બટન પર ક્્લલિક કરો.

3	 સાફ કરો પ્રિન્ટ વિસ્્તતાર પસંદ કરો.

પ્રિન્ટ એરિયા સાફ થઈ ગયો છે અને આખી વર્્કશ ીટ ફરી એકવાર પ્રિન્ટ 
થશે.

કાર્્ય 2 : વર્્ક બકુને વકૈલ્્પપિક ફાઇલ ફોર્મેટમાાં સાચવો

ફાઇલ ફોર્મેટ્સની સૂચિ માટે (જનેે ફાઇલ પ્રકાર પણ કહેવાય છે) તમે કરી 
શકો છો (અને કરી શકતા નથી) Excel માાં ખોલો અથવા સાચવો.

1	તમ ે સાચવવા માાંગો છો તે વર્્ક બુક ખોલો.

2	 Click File > Save As. પર ક્્લલિક કરો.

3	 સ્થાનો હેઠળ, તે સ્થાન પસંદ કરો જ્યયાં તમે વર્્ક બુક સાચવવા માાંગો 
છો. ઉદાહરણ તરીકે, તમારા વેબ સ્થાન પર સાચવવા માટે OneDrive 
પસંદ કરો અથવા તમારા દસ્્તતાવેજો જવેા સ્થાનિક ફોલ્્ડરમાાં સાચવવા 
માટે કમ્્પ્યયુટર પસંદ કરો.

4	 આ રીતે સાચવો સંવાદ બોક્સમાાં, તમને જોઈતા સ્થાન પર નેવિગેટ 
કરો.
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5	 પ્રકાર તરીકે સાચવો યાદીમાાં, તમને જોઈતા ફાઈલ ફોર્મેટ પર ક્્લલિક 
કરો. સૂચિમાાં દેખાતા ન હોય તેવા ફાઇલ ફોર્મેટ પર સ્ક્રોલ કરવા માટે 
તીરને ક્્લલિક કરો.

6	 ફાઇલ નામ બોક્સમાાં, સૂચવેલ નામ સ્્વવીકારો અથવા વર્્ક બુક માટે નવું 
નામ લખો

કાર્્ય 3 : પ્રિન્ટ સેટિિંગ્્સ ગોઠવો

વિકલ્્પ #1 MS એક્સેલમાાં N નંબર સાથે આખી વર્્ક બકુ કેવી રીતે પ્રિન્ટ 
કરવી

પગલુંં� 1: એક્સેેલ શીીટ પર જાઓ, જે ે વપરાાશકર્તાા પ્રિ�ન્ટ કરવાા માંંગેે છેે. 
ફાાઇલ ખોોલોો મેનેુુ બાાર અનેે પ્રિ�ન્ટ પર ક્લિ�િક કરોો.
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પગલંુ 2: હવે પ્રિન્ટ સેટિિંગ ખલુશે, પછી સેટિિંગ વિભાગ હેઠળ, ‘પ્રિન્ટ’ પસંદ 
કરો 

આખી વર્્ક બુક’

પગલું 3: હવે વપરાશકર્તા દ્વારા જરૂરી નકલોની સખં્યા પર ક્્લલિક કરો

પગલું 4: વર્્ક બુક છાપવા માટે, પ્રિન્ટ બટન પર ક્્લલિક કરો.

સારાાંશ: જમે વપરાશકર્તાએ આપ્્યયુું છે પ્રિન્ટ કમાન્્ડમાાં સૂચના, તે સમગ્ર 
વર્્ક બુક સાથેના પૃષ્્ઠઠોની સખં્યાને છાપશે.

વિકલ્્પ #2 MS Excel માાં પેજ ઓરિએન્ટેશન સાથે પસંદ કરેલ વિસ્્તતાર 
વર્્ક બકુ કેવી રીતે પ્રિન્ટ કરવી

પગલું 1: એક્સેલ શીટ પર જાઓ, જનેે વપરાશકર્તા પ્રિન્ટ કરવા માાંગે છે, 
અને પ્રિન્ટ કરવાની જરૂર હોય તે  વિસ્્તતાર પસંદ કરો.
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પગલું 2: ફાઇલ મેનુ બાર ખોલો અને પ્રિન્ટ ટેબ પર ક્્લલિક કરો. પગલું 3: હવે પ્રિન્ટ સેટિિંગ ખુલશે, પછી સેટિિંગ વિભાગ હેઠળ, ‘પ્રિન્ટ 
સિલેક્શન’ પસંદ કરો.
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પગલંુ 4: હવે વપરાશકર્તા દ્વારા જરૂરી પૃષ્્ઠના ઓરિએન્ટેશન પર ક્્લલિક 
કરો.

પગલંુ 5: સેટિિંગ મુજબ વર્્ક બુક પ્રિન્ટ કરવા માટે પ્રિન્ટ બટન પર ક્્લલિક કરો.

સારાાંશ: પ્રિન્ટ કમાન્્ડમાાં આપેલ સૂચના મુજબ, તે ફક્્ત લેન્્ડસ્કેપ 
ઓરિએન્ટેશનમાાં પસંદ કરેલ વિસ્્તતાર સાથે પ્રિન્ટ કરશે.
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પ્રિન્ટ સેટિિંગ્્સ

બહુવિધ નકલો: જો વપરાશકર્તા એક કરતાાં વધુ નકલો છાપવા માાંગે છે, 
તો તેણે નકલ વિભાગમાાં કેટલી નકલો છાપવી છે તેની ગણતરી કરવાની 
જરૂર છે.

પ્રિન્ટર પસંદ કરો: વર્્ક બુક સાચવવા માટે બહુવિધ વિકલ્્પપો છે; 
વપરાશકર્તાઓની જરૂરિયાત મુજબ; તે ઉમેરેલા પ્રિન્ટરમાાં વિકલ્્પપો પસંદ 
કરી શકે છે, PDF, OneNote, XPS દસ્્તતાવેજ લખેક તરીકે સાચવી શકે છે, 
FAX મોકલી શકે છે અથવા કોઈપણ નવું પ્રિન્ટર ઉમેરી શકે છે.

પ્રિન્ટ પસંદગી: આ વિકલ્્પ પ્રિન્ટ કમાન્્ડમાાં માત્ર વર્્તમાન પસંદગીને જ પ્રિન્ટ 
કરશે

સક્રિય શીટ્સ છાપો: આ વિકલ્્પ વર્્ક બુકમાાં ફક્્ત સક્રિય શીટને જ છાપશે.

આખી વર્્ક બકુ છાપો: આ વિકલ્્પ વર્્ક બુકના તમામ પૃષ્્ઠઠોને છાપશે
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કોલેટેડ: જો વપરાશકર્તાની વર્્ક બુકમાાં બહુવિધ પૃષ્્ઠઠો હોય, તો પ્રિન્ટ આદેશ 
માટે કોલેટેડ અને અનકોલેટેડ વચ્ચે સ્્વવિચ કરવાનો વિકલ્્પ છે.

ઉદાહરણ તરીકે, જો વપરાશકર્તા વર્્ક બુકમાાંથી 10 નકલો છાપવા માાંગે છે, 
તો કોલેટેડ સંપૂર્્ણ પ્રથમ નકલ અન પછી સંપૂર્્ણ બીજી નકલ છાપે છે.

અથવા જો વપરાશકર્તા અનકોલેટેડ પ્રિન્ટ પસંદ કરી રહ્યો હોય તો પેજ 1 ની 
10 કોપી, પેજ 2 ની 10 કોપી વગેરે.

ઓરિએન્ટેશન: વપરાશકર્તા પોર્ટ્રેટ ઓરિએન્ટેશન (પૃષ્્ઠ પર વધુ પંક્્તતિઓ 
પરંતુ ઓછા કૉલમ હોય ત્યારે શ્રેષ્્ઠ) અને લેન્્ડસ્કેપ ઓરિએન્ટેશન (પેજ 
પર વધુ કૉલમ પરંતુ ઓછી પંક્્તતિઓ હોય ત્યારે શ્રેષ્્ઠ) વચ્ચે સ્્વવિચ કરી 
શકે છે.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.14.54

પૃષ્્ઠ માર્જિન: જો વપરાશકર્તા પૃષ્્ઠ માર્જિનને સમાયોજિત કરવા માાંગે છે, તો 
તે નીચેના પગલાાંન અનુસરીને આમ કરી શકે છે.

પગલંુ 1 - માર્જિન્્સ ડ્્ર રોપ-ડાઉન સૂચિમાાંથી પૂર્્વ-નિર્ધારિત માર્જિન (સામાન્ય, 
પહોળા અથવા સાાંકડા)માાંથી એક પસંદ કરીને.

પગલંુ 2 - અથવા વિન્્ડડોની નીચે જમણી બાજુએ ‘શો માર્જિન્્સ’ આયકન 
પર ક્્લલિક કરો. હવે વપરાશકર્તા પેજ માર્જિનને મેન્યુઅલી બદલવા માટે 
લીટીઓને ખેેંચી શકે છે.

સ્કેલિિંગ: જો વપરાશકર્તા એક પૃષ્્ઠ પર વધુ અને વધુ ડેટા ફિટ કરવા માાંગે 
છે, તો તે શીટને એક પૃષ્્ઠ પર ફિટ કરી શકે છે. આ સેટિિંગ્્સ મેળવવા માટે, 
તેણે નીચેની પ્રક્રિયાને અનુસરવાની જરૂર છે.

•	સ્કે  લિિંગ ડ્્ર રોપ-ડાઉન સૂચિમાાંથી ‘એક પૃષ્્ઠ પર શીટ ફિટ કરો’ પસંદ 
કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.15.55
કોપા (COPA) - ડેટા સેલ અને રેન્્જ મેનેજ કરો

ડેટાની હેરફેર કરો (Manipulate data)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 વિશિષ્્ટ પેસ્ટ વિકલ્્પપોનો ઉપયોગ કરીને ડેટા પેસ્ટ કરો
•	 ઓટો ફિલનો ઉપયોગ કરીને કોષો ભરો
•	 બહુવિધ કૉલમ અથવા પંક્્તતિઓ દાખલ કરો અને કાઢી નાખો 
•	 કોષો દાખલ કરો અને કાઢી નાખો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : વિશિષ્્ટ પેસ્ટ વિકલ્્પપોનો ઉપયોગ કરીને ડેટા પેસ્ટ કરો 

મેનુ વિકલ્્પપો પેસ્ટ કરો (રિબન પર)

હોમ પસંદ કરો, ક્્લલિપબોર્્ડ  આયકન (પેસ્ટ કરો) પસંદ કરો અને તમને 
જોઈતો ચોક્કસ પેસ્ટ વિકલ્્પ પસંદ કરો. ઉદાહરણ તરીકે, કૉપિ કરેલ 

કોષમાાંથી માત્ર ફોર્મેટિિંગ પેસ્ટ કરવા માટે, ફોર્મેટિિંગ  પસંદ કરો. આ 
કોષ્્ટક પેસ્ટ મેનૂમાાં ઉપલબ્ધ વિકલ્્પપો બતાવે છે: 	

	          ચિહ્ન		       વિકલ્્પ નામ		  શું પેસ્ટ કર્્યુું છે

 		  પેસ્ટ કરો	તમ ામ કોષ સામગ્રીઓ

 		  સ્ત્રોત કૉલમ	 કોષની સામગ્રી તેની કૉલમની પહોળાઈ સાથે કૉપિ કરી.				  
		  પહોળાઈ રાખો

 		ટ્  ્ર રાન્્સપોઝ	 પેસ્ટ કરતી વખતે કૉપિ કરેલા કોષોની સામગ્રીને ફરીથી દિશામાન કરે છે. 			 

		  સૂત્રો	 પંક્્તતિઓમાાંનો ડેટા કૉલમમાાં પેસ્ટ કરવામાાં આવે છે અન ઊલટ.

 		  મૂલ્યો	 ફોર્્મ્યયુલા(ઓ), ફોર્મેટિિંગ અથવા ટિપ્પણીઓ વિના.

 		  ફોર્મેટિિંગ	 ફોર્્મ્યયુલા પરિણામો, ફોર્મેટિિંગ અથવા ટિપ્પણીઓ વિના.

 		  મૂલ્યો અને સ્ત્રોત	 કૉપિ કરેલા કોષોમાાંથી માત્ર ફોર્મેટિિંગ.
		  ફોર્મેટિિંગ

 		  લિિંક પેસ્ટ કરો	 કૉપિ કરેલા કોષોમાાંથી મૂલ્યો અને ફોર્મેટિિંગ.					   

		  ચિત્ર	 કૉપિ કરેલ સેલ સમાવિષ્્ટટોને બદલે સ્રોત કોષોનો સંદર્્ભ.

 		  લિિંક કરેલ ચિત્ર	 મૂળ કોષોની લિિંક સાથે કૉપિ કરેલી છબી (જો તમે મૂળ કોષોમાાં કોઈ ફેરફાર કરો 

			   છો તો તે ફેરફારો પેસ્ટ કરેલી છબીમાાં પ્રતિબિિંબિત થાય છે).

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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ખાસ પેસ્ટ કરો

પેસ્ટ સ્્પપેશિયલ બોક્સમાાંથી વિકલ્્પપોનો ઉપયોગ કરવા માટે, હોમ પસંદ 
કરો, ક્્લલિપબોર્્ડ  આયકન (પેસ્ટ કરો) પસંદ કરો અને પેસ્ટ સ્્પપેશિયલ પસંદ 
કરો.

કીબોર્્ડ  શોર્્ટકટ: Ctrl+Alt+V દબાવો.

પેસ્ટ સ્્પપેશિયલ બોક્સમાાં, તમે પેસ્ટ કરવા માાંગો છો તે એટ્્રરિબ્્યયુટ પસંદ 
કરો.

નોોંધ: તમે કોપી કરેલ ડેટાના પ્રકાર અને તમે પસંદ કરેલ પેસ્ટ 
વિકલ્્પના આધારે, કેટલાક અન્ય વિકલ્્પપો ગ્રે થઈ શકે છે.

	 પેસ્ટ વિકલ્્પ	ક્ રિયા

	 બધા	 કોપી કરેલ ડેટાની તમામ કોષ સામગ્રી અને ફોર્મેટિિંગ પેસ્ટ કરે છે.

	 સૂત્રો	 ફોર્્મ્યયુલા બારમાાં દાખલ કર્યા મુજબ કૉપિ કરેલા ડેટાના ફૉર્્મ્યયુલા જ પેસ્ટ કરે છે.

	 મૂલ્યો	 કોષોમાાં દર્શાવ્્યયા મુજબ માત્ર કૉપિ કરેલા ડેટાના મૂલ્યોને જ પેસ્ટ કરે છે.

	 ફોર્મેટ્સ	 કૉપિ કરેલા ડેટાનું માત્ર સેલ ફોર્મેટિિંગ પેસ્ટ કરે છે.

	 ટિપ્પણીઓ અને નોોંધો	 કૉપિ કરેલ કોષ સાથે જોડાયેલ માત્ર ટિપ્પણીઓ અને નોોંધો પેસ્ટ કરે છે.				  

	મ ાન્યતા	 પેસ્ટ એરિયામાાં કૉપિ કરેલા કોષો માટે ડેટા માન્યતા નિયમો પેસ્ટ કરે છે.

	 બધા સ્રોત થીમનો	 દસ્્તતાવેજ થીમ ફોર્મેટિિંગમાાં તમામ કોષ સામગ્રીઓ પેસ્ટ કરે છે જ ેકૉપિ કરેલા ડેટા પર લાગુ થાય છે. 			 
	 ઉપયોગ કરે છે 	

	 સરહદો સિવાય તમામ	કિન ારીઓ સિવાય કૉપિ કરેલ કોષ પર લાગુ કરેલ તમામ કોષ સામગ્રીઓ અને ફોર્મેટિિંગ પેસ્ટ કરે છે.

	 કૉલમની પહોળાઈ	 એક કૉપિ કરેલ કૉલમ અથવા કૉલમની શ્રેણીની પહોળાઈને બીજા કૉલમ અથવા કૉલમની શ્રેણીમાાં પેસ્ટ કરે છે.

	 ફોર્્મ્યયુલા અને નંબર ફોર્મેટ્સ	 કૉપિ કરેલ કોષોમાાંથી માત્ર સૂત્રો અને તમામ નંબર ફોર્મેટિિંગ વિકલ્્પપો પેસ્ટ કરે છે.				 

	 મૂલ્યો અને સખં્યા બંધારણો	 કૉપિ કરેલા કોષોમાાંથી માત્ર મૂલ્યો અને તમામ નંબર ફોર્મેટિિંગ વિકલ્્પપો પેસ્ટ કરે છે.			 

	 બધા મર્જજિંગ શરતી ફોર્મેટ	 કૉપિ કરેલા કોષોમાાંથી સામગ્રીઓ અને શરતી ફોર્મેટિિંગ વિકલ્્પપોને પેસ્ટ કરે છે.				  

તમે કૉપિ કરેલા ડેટા પર લાગુ કરવા માટે ગાણિતિક ઑપરેશનનો પણ 
ઉલ્્લલેખ કરી શકો છો.

	 ઓપરેશન	 એક્શન

	 કોઈ નહિ	 સ્્પષ્્ટ કરે છે કે કૉપિ કરેલા ડેટા પર કોઈ ગાણિતિક ઑપરેશન લાગુ કરવામાાં આવશ નહીીં.

	 ઉમેરો	 કૉપિ કરેલા ડેટાને ગતંવ્્ય કોષ અથવા કોષોની શ્રેણીમાાંના ડેટામાાં ઉમેરે છે.

	 બાદબાકી કરો	 ગતંવ્્ય કોષ અથવા કોષોની શ્રેણીમાાંના ડેટામાાંથી કૉપિ કરેલ ડેટાને બાદ કરે છે.

	 ગુણાકાર	 કૉપિ કરેલા ડેટાને ગતંવ્્ય કોષ અથવા કોષોની શ્રેણીમાાંના ડેટા સાથે ગુણાકાર કરે છે.

	 વિભાજન	 કૉપિ કરેલા ડેટાને ગતંવ્્ય કોષ અથવા કોષોની શ્રેણીમાાંના ડેટા દ્વારા વિભાજિત કરે છે.

	 અન્ય વિકલ્્પપો	ક્ રિયા

	ખ ાલી જગ્્યયાઓ છોડો	 જ્યારે તમે આ ચેક બોક્સ પસંદ કરો છો ત્યારે કોપી વિસ્્તતારમાાં ખાલી કોષો આવે ત્યારે તમારા પેસ્ટ વિસ્્તતારમાાં 
		  મૂલ્યોને બદલવાનું ટાળે છે.

	ટ્ ્ર રાન્્સપોઝ	 જ્યારે તમે આ ચેક બૉક્સ પસંદ કરો છો ત્યારે કૉપિ કરેલા ડેટાના કૉલમને પંક્્તતિઓમાાં અને ઊલટ બદલે છે.

	 લિિંક પેસ્ટ કરો	 કૉપિ કરેલા સેલ(કોષો)ની લિિંક બનાવવા માટે ક્્લલિક કરો.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.15.55
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પેસ્ટ કરેલ ફોર્્મ્યયુલામાાં સેલ સંદર્ભોને ચકાસો અને ઠીક કરો

નોોંધ: જ્યારે તમે ફોર્્મ્યયુલા કાપો (કોપી નહીીં) અને પેસ્ટ કરો ત્યારે 
સેલ સંદર્ભો આપમેળે ગોઠવાય છે.

તમે કૉપિ કરેલ ફોર્્મ્યયુલા પેસ્ટ કરો તે પછી, તમારે ચકાસવું જોઈએ કે નવા 
સ્થાન પર બધા કોષ સંદર્ભો સાચા છે. સૂત્રમાાં વપરાતા સંદર્્ભ પ્રકાર (સંપૂર્્ણ, 
સંબધંિત અથવા મિશ્ર)ના આધારે કોષ સંદર્ભો બદલાયા હોઈ શકે છે.

ઉદાહરણ તરીકે, જો તમે કોષ A1 માાં ફોર્્મ્યયુલાની નકલ કરો અને તેને બે કોષો 
નીચે અને જમણી બાજુએ (C3) પેસ્ટ કરો, તો પેસ્ટ કરેલ ફોર્્મ્યયુલામાાં સેલ 
સંદર્ભો નીચે પ્રમાણે બદલાશે:

	 આ સંદર્્ભ:				    આમાાં ફેરફારો:

$A$1 (સંપૂર્્ણ કૉલમ અને સંપૂર્્ણ પંક્્તતિ) 	 $A$1

A$1 (સંબંધિત કૉલમ અને સંપૂર્્ણ પંક્્તતિ)	 C$1

$A1 (સંપૂર્્ણ કૉલમ અને સંબંધિત પંક્્તતિ)	 $A3

A1 (સંબંધિત કૉલમ અન સંબંધિત પંક્્તતિ) 	 C3

જો સૂત્રમાાંના કોષ સંદર્ભો તમને જોઈતું પરિણામ આપતા નથી, તો વિવિધ 
સંદર્્ભ પ્રકારો પર સ્્વવિચ કરવાનો પ્રયાસ કરો:

1	 સૂત્ર ધરાવતો કોષ પસંદ કરો.

2	 ફોર્્મ્યયુલા બાર  માાં, તમે જ ેસંદર્્ભ બદલવા માાંગો છો તે 
પસંદ કરો.

3	 સંદર્્ભ સંયોજનો વચ્ચે સ્્વવિચ કરવા માટે F4 દબાવો, અને તમને જોઈતું 
હોય તે પસંદ કરો.

કાર્્ય 2 : ઓટો ફિલનો ઉપયોગ કરીને કોષો ભરો

1	વ ધારાના કોષો ભરવા માટે આધાર તરીકે તમે ઉપયોગ કરવા માાંગો છો 
તે એક અથવા વધુ કોષો પસંદ કરો.

	 1, 2, 3, 4, 5... જવેી શ્રેણી માટે, પ્રથમ બે કોષોમાાં 1 અને 2 લખો. શ્રેણી 2, 
4, 6, 8..., ટાઇપ 2 અને 4 માટે.

	 શ્રેણી 2, 2, 2, 2... માટે, ફક્્ત પ્રથમ કોષમાાં 2 લખો.

2	ભ રણ હેન્્ડલ  ને ખેેંચો.  .

3	 જો જરૂરી હોય, તો ઓટો ફિલ વિકલ્્પપો  પર ક્્લલિક કરો અને તમને 
જોઈતો વિકલ્્પ પસંદ કરો.

કાર્્ય 3 : બહુવિધ કૉલમ અથવા પંક્્તતિઓ દાખલ કરો અને કાઢી નાખો

કૉલમ દાખલ કરો અથવા કાઢી નાખો

1	 કૉલમમાાં કોઈપણ સલે પસંદ કરો, Home> Insert > Insert Sheet 
Columns or Delete Sheet Columns. 

2	વ ૈકલ્્પપિક રીતે, કૉલમની ટોચ પર જમણું-ક્્લલિક કરો, અને પછી શામેલ 
કરો અથવા કાઢી નાખો પસંદ કરો. 

3	 બરાબર ક્્લલિક કરો

એક પંક્્તતિ દાખલ કરો અથવા કાઢી નાખો
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1	 પંક્્તતિની અંદર કોઈપણ સેલ પસંદ કરો, પછી Home >Insert > 
Insert Sheet Rows or Delete Sheet Rows.

2	વ ૈકલ્્પપિક રીતે, પંક્્તતિ નંબર પર જમણું-ક્્લલિક કરો, અને પછી શામેલ 
કરો અથવા કાઢી નાખો પસંદ કરો. 

કાર્્ય 4 : કોષો દાખલ કરો અને કાઢી નાખો

કોષ દાખલ કરો અથવા કાઢી નાખો

1	 કૉલમ અથવા પંક્્તતિની અંદર કોઈપણ સેલ પસંદ કરો, પછી Home > 
Insert > Insert Cell or Delete Cell પર જાઓ.

2	 સલે દાખલ કરતી વખતે શિફ્ટ સેલને જમણે અથવા નીચે શિફ્ટ કરો 
પસંદ કરો અને ઠીક ક્્લલિક કરો.

3	 સેલ ડિલીટ કરતી વખતે શિફ્ટ સેલ ડાબે અથવા શિફ્ટ સેલ ઉપર 
પસંદ કરો અને ઓકે ક્્લલિક કરો.

4	વ ૈકલ્્પપિક રીતે, કૉલમની ટોચ પર જમણું-ક્્લલિક કરો, અન પછી શામેલ 
કરો અથવા કાઢી નાખો પસંદ કરો.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.15.55
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IT & ITES	 	 એકસરસાાઈઝ 1.15.56
કોપા (COPA) - ડેટા સેલ અને રેન્્જ મેનેજ કરો	

કોષો અને શ્રેણીઓ ફોર્મેટ કરો ( Format cells and ranges)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 કોષોને મર્ ્જ કરો અને અનમર્ ્જ કરો
•	 સેલ સંરેખણ, ઓરિએન્ટેશન અને ઇન્્ડડેન્ટેશનમાાં ફેરફાર કરો
•	 ફોર્મેટ પેઇન્ટરનો ઉપયોગ કરીને કોષોને ફોર્મેટ કરો
•	 કોષોની અંદર ટેક્સ્ટને લપેટી
•	 નંબર ફોર્મેટ લાગુ કરો
•	 ફોર્મેટ કોષ સવંાદ બોક્સમાાંથી સેલ ફોર્મેટ લાગુ કરો
•	 સેલ શૈલીઓ લાગુ કરો
•	 સ્્પષ્્ટ સેલ ફોર્મેટિિંગ.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : કોષોને મર્ ્જ કરો અને અનમર્ ્જ કરો 

કોષોને મર્ ્જ કરો

1	મર્્જ   કરવા માટે કોષો પસંદ કરો.

2	મર્્જ   અને સેન્ટર પસંદ કરો. 

કોષોને અનમર્ ્જ કરો

1	મર્્જ   અને સેન્ટર ડાઉન એરો પસંદ કરો.

2	 કોષોને અનમર્્જ  કરો પસંદ કરો.

કાર્્ય 2 : સેલ સંરેખણ, ઓરિએન્ટેશન અને ઇન્્ડડેન્ટેશનમાાં ફેરફાર કરો

કોષમાાં ટેક્સ્ટનું ઓરિએન્ટેશન બદલો

1	 કોષ, પંક્્તતિ, કૉલમ અથવા શ્રેણી પસંદ કરો.

2	 Select Home > Orientation  પસંદ કરો, અને પછી 
વિકલ્્પ પસંદ કરો.

તમે તમારા ટેક્સ્ટને ઉપર, નીચે, ઘડિયાળની દિશામાાં અથવા 
કાઉન્ટરક્્લલોકવાઇઝ ફેરવી શકો છો અથવા ટેક્સ્ટને ઊભી રીતે સંરેખિત 
કરી શકો છો:

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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ટેક્સ્ટને ચોક્કસ ખૂણા પર ફેરવો

1	 કોષ, પંક્્તતિ, કૉલમ અથવા શ્રેણી પસંદ કરો.

2	 Home > Orientation  > Format Cell Alignment 
પસંદ કરો.   > Format Cell Alignment.

3	 જમણી બાજુના ઓરિએન્ટેશન હેઠળ, ડિગ્રી બોક્સમાાં, તમે પસંદ કરેલ 
સેલ ટેક્સ્ટને ફેરવવા માાંગો છો તે  ડિગ્રીની ચોક્કસ સખં્યા સેટ કરવા 
માટે ઉપર અથવા નીચે તીરનો ઉપયોગ કરો.

હકારાત્મક સખં્યાઓ ટેક્સ્ટને ઉપર તરફ ફેરવે છે. નકારાત્મક સખં્યાઓ 
ટેક્સ્ટને નીચે તરફ ફેરવે છે. 

કૉલમ અથવા પંક્્તતિ સંરેખિત કરો

તમે સંરેખિત કરવા માાંગો છો તે કોષ અથવા કોષોને પસંદ કરીને પ્રારંભ 
કરો. તમે એક કોષ, કોષોની શ્રેણી, એક પંક્્તતિ અથવા પંક્્તતિઓ, કૉલમ 

અથવા કૉલમ્્સ અથવા સમગ્ર કાર્્યપત્રકમાાં ટેક્સ્ટને સંરેખિત કરી શકો છો. 
(તમામ કોષો પસંદ કરવા માટે Ctrl+A નો ઉપયોગ કરો.)

1	તમ ે સંરેખિત કરવા માાંગો છો તે કોષો પસંદ કરો.

2	 હોમ ટેબ પર, સંરેખણ જૂથમાાં, આડી ગોઠવણી વિકલ્્પ પસંદ કરો:

	ડ ાબે સંરેખિત કરો           મધ્્યમાાં સંરેખિત કરો      જમણે સંરેખિત કરો

	                                             	                      

3	 હોમ ટેબ પર, સંરેખણ જૂથમાાં, ઊભી ગોઠવણી વિકલ્્પ પસંદ કરો:

	ટ ોચનું સંરેખિત કરો	       મધ્્ય સંરેખિત કરો	        નીચે સંરેખિત કરો

                     	                  	                    

કાર્્ય 3 : ફોર્મેટ પેઇન્ટરનો ઉપયોગ કરીને કોષોને ફોર્મેટ કરો 

1	તમ  કૉપિ કરવા માાંગો છો તે ફોર્મેટિિંગ સાથેનો સેલ પસંદ કરો.

2	 Home > Format Painter પસંદ કરો. 

3	તમ ે ફોર્મેટિિંગ લાગુ કરવા માાંગો છો તે કોષ અથવા શ્રેણીને પસંદ કરવા 
માટે ખેેંચો.

4	મ ાઉસ બટન છોડો અને ફોર્મેટિિંગ હવે લાગુ થવું જોઈએ.

કાર્્ય 4 : કોષોની અંદર ટેક્સ્ટને લપેટી

ટેક્સ્ટને આપમેળે લપેટી

1	વર્્કશ  ીટમાાં  તમે જ ેકોષોને ફોર્મેટ કરવા માાંગો છો તે પસંદ કરો.

2	 હોમ ટેબ પર, સંરેખણ જૂથમાાં, લખાણ વીીંટો ક્્લલિક કરો. (ડેસ્કટોપ માટે 
એક્સેલ પર, તમે સેલ પણ પસંદ કરી શકો છો, અને પછી Alt + H + 
W દબાવો.)

આવરિત તમામ ટેક્સ્ટને દૃશ્્યક્ષમ બનાવવા માટે પંક્્તતિની ઊંચાઈને 
સમાયોજિત કરો

1	 કોષ અથવા શ્રેણી પસંદ કરો કે જનેા માટે તમે પંક્્તતિની ઊંચાઈને 
સમાયોજિત કરવા માાંગો છો.

2	 હોમ ટેબ પર, કોષ જૂથમાાં, ફોર્મેટ પર ક્્લલિક કરો.

3	 કોષના કદ હેઠળ, નીચેનામાાંથી એક કરો:

•	 પંક્્તતિની ઊંચાઈને આપમેળે ગોઠવવા માટે, ઑટોફિટ પંક્્તતિની 
ઊંચાઈ પર ક્્લલિક કરો.

•	 પંક્્તતિની ઊંચાઈનો ઉલ્્લલેખ કરવા માટે, પંક્્તતિની ઊંચાઈ પર ક્્લલિક 
કરો અને પછી પંક્્તતિની ઊંચાઈ  બૉક્સમાાં તમને જોઈતી પંક્્તતિની 
ઊંચાઈ ટાઈપ કરો.

કાર્્ય 5 : નંબર ફોર્મેટ લાગુ કરો

1	 કોષ અથવા કોષ શ્રેણી પસંદ કરો.

2	 હોમ ટેબ પર, ડ્્ર રોપડાઉનમાાંથી નંબર પસંદ કરો.

•	ન ાનો એરો, ડાયલોગ બોક્સ લોન્ચર પસંદ કરો અને પછી નંબર 
પસંદ કરો.

3	તમન ે જોઈતું ફોર્મેટ પસંદ કરો.

સખં્યા બંધારણો

બધા ઉપલબ્ધ નંબર ફોર્મેટ્સ જોવા માટે, નંબર જૂથમાાં હોમ ટેબ પર નંબરની 
બાજુમાાં ડાયલોગ બોક્સ લોન્ચરને ક્્લલિક કરો.

	અ થવા, તમે આ વિકલ્્પપોમાાંથી એક પસંદ કરી શકો છો:

•	 CTRL + 1 દબાવો અને નંબર પસંદ કરો.

•	 સેલ અથવા સલે રેેંજ પર જમણું-ક્્લલિક કરો, ફોર્મેટ સેલ પસંદ 
કરો... અને નંબર પસંદ કરો.
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કાર્્ય 6 : ફોર્મેટ કોષ સંવાદ બોક્સમાાંથી સેલ ફોર્મેટ્સ લાગુ કરો

ઔપચારિક કોષો

1	 કોષો પસંદ કરો.

2	 બોલ્્ડ, ફોન્ટ કલર અથવા ફોન્ટ સાઈઝ તરીકે ફેરફારો પસંદ કરવા માટે 
રિબન પર જાઓ.

એક્સેલ સ્ટાઇલ લાગુ કરો 

1	 કોષો પસંદ કરો.

2	 Home > Cell Styleપસંદ કરો અને શૈલી પસંદ કરો. 

એક્સેલ શૈલીમાાં ફેરફાર કરો

1	 એક્સેલ શૈલી સાથે કોષો પસંદ કરો.

2	 Home > Cell Styles લાગુ શૈલી પર જમણું-ક્્લલિક કરો.

3	તમન ે જ ેજોઈએ છે તે બદલવા માટે સશંોધિત કરો Modify > Format 
પસંદ કરો.

કાર્્ય 7 : સેલ શૈલીઓ લાગુ કરો 

સેલ શૈલી લાગુ કરો

1	તમ ે જ ેકોષોને ફોર્મેટ કરવા માાંગો છો તેને પસંદ કરો. 2	 હોમ ટેબ પર, સ્ટાઇલ જૂથમાાં, સ્ટાઇલ ગેલેરીમાાં વધુ ડ્્ર રોપડાઉન એરો 
પર ક્્લલિક કરો અને તમે લાગુ કરવા માાંગો છો તે સેલ શૈલી પસંદ કરો.
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કાર્્ય 8 : સેલ ફોર્મેટિિંગ સાફ કરો 

1	તમ  સાફ કરવા માાંગો છો તે કોષો, પંક્્તતિઓ અથવા કૉલમ પસંદ કરો.

	 ટીપ: કોષોની પસંદગીને રદ કરવા માટે, વર્્કશ ીટ પરના કોઈપણ કોષને 
ક્્લલિક કરો.

2	 હોમ ટેબ પર, સંપાદન જૂથમાાં, સાફ કરો બટનની બાજુમાાં તીરને ક્્લલિક 
કરો અન પછી નીચનેામાાંથી એક કરો:

•	 પસંદ કરેલ કોષોમાાં સમાવિષ્્ટ તમામ સામગ્રીઓ, ફોર્મેટ્સ અને 
ટિપ્પણીઓને સાફ કરવા માટે, બધા સાફ કરો ક્્લલિક કરો.

•	 ફક્્ત પસંદ કરેલા કોષો પર લાગુ થયેલા બંધારણોને સાફ કરવા 
માટે, ફોર્મેટ્સ સાફ કરો પર ક્્લલિક કરો.

•	 કોઈપણ ફોર્મેટ્સ અન ટિપ્પણીઓને સ્થાને છોડીને, ફક્્ત પસંદ 
કરેલા કોષોમાાંની સામગ્રીઓને સાફ કરવા  માટે, સામગ્રી સાફ કરો 
પર ક્્લલિક કરો.

•	 પસંદ કરેલ કોષો સાથે જોડાયેલ કોઈપણ ટિપ્પણીઓ અથવા 
નોોંધોને સાફ કરવા માટે, ટિપ્પણીઓ અને નોોંધો સાફ કરો પર 
ક્્લલિક કરો.

•	 પસંદ કરેલ કોષો સાથે જોડાયેલ કોઈપણ હાઈપરલિિંક્સને સાફ 
કરવા માટે, હાયપરલિિંક સાફ કરો પસંદ કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.15.57
કોપા (COPA) - ડેટા સેલ અને રેન્્જ મેનેજ કરો	

નામવાળી રેન્્જને વ્્યયાખ્યાયિત કરો અને સંદર્્ભ આપો (Define and reference named ranges) 
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 નામવાળી શ્રેણી વ્્યયાખ્યાયિત કરો
•	 ટેબલનું નામ આપો
•	 ડેટાને દૃષ્્ટટિની રીતે સારાાંશ આપો સ્્પપાર્્ક  લાઇન્્સ દાખલ કરો
•	 બિલ્ટ ઇન કન્્ડડીશનલ ફોર્મેટિિંગ લાગુ કરો
•	શ રતી ફોર્મેટિિંગ દૂર કરો

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : નામવાળી શ્રેણી વ્્યયાખ્યાયિત કરો

એક્સેલ નામની રેન્્જ કેવી રીતે બનાવવી

એક્સેલમાાં નામ વ્્યયાખ્યાયિત કરવાની 3 રીતો છે: નેમ બોક્સ, ડિફાઈન નેમ 
બટન અને એક્સેલ નેમ મેનેજર.

નેમ બોક્સમાાં નામ લખો

એક્સેલમાાં નેમ બોક્સ નામવાળી શ્રેણી બનાવવાની સૌથી ઝડપી રીત છે:

1	 કોષ અથવા કોષોની શ્રેણી પસંદ કરો જનેે તમે નામ આપવા માાંગો છો.

2	ન ામ બોક્સમાાં નામ લખો.

3	 Enter કી દબાવો.

એક્સેલ નામની નવી શ્રેણી બનાવવામાાં આવી છે! 

Range A1:A10   Item_List	

Define Name વિકલ્્પનો ઉપયોગ કરીને નામ બનાવો

1	 સેલ પસંદ કરો.

2	 ફોર્્મ્યયુલા ટેબ પર, નામો વ્્યયાખ્યાયિત કરો જૂથમાાં, નામ વ્્યયાખ્યાયિત કરો 
બટનને ક્્લલિક કરો.

3	નવ ા નામ સંવાદ બોક્સમાાં, ત્રણ વસ્્તતુઓનો ઉલ્્લલેખ કરો:

•	ન ામ બોક્સમાાં, શ્રેણીનું નામ લખો.

•	સ્કો પ ડ્્ર રોપડાઉનમાાં, નામનો સ્કોપ સેટ કરો (બાય ડિફોલ્ટ વર્્ક બુક).

•	 Refers to બોક્સમાાં, સંદર્્ભને ચેક કરો અને જો જરૂરી હોય તો તેને 
ઠીક કરો.

4	 ફેરફારો સાચવવા માટે ઓકે ક્્લલિક કરો અને સંવાદ બોક્સ બંધ કરો.

નૉધ. મૂળભતૂ રીતે, એક્સેલ સંપૂર્્ણ સંદર્ભો સાથે નામ બનાવે 
છે. જો તમારી પાસે સંબંધિત નામની શ્રેણી હોય, તો સંદર્્ભમાાંથી 
$ ચિહ્ન દૂર કરો.

Range B1:B10    Sales

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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અગાઉની પદ્ધતિની તુલનામાાં, એક્સેલમાાં નામ વ્્યયાખ્યાયિત કરવા માટે 
થોડી વધારાની ક્્લલિક્સ લાગે છે, પરંતુ તે નામનો અવકાશ સેટ કરવા અને 
નામ વિશે કંઈક સમજાવતી ટિપ્પણી ઉમેરવા જવેા કેટલાક વધુ વિકલ્્પપો 
પણ પ્રદાન કરે છે. વધમુાાં, એક્સેલની ડિફાઈન નેમ ફીચર તમને કોન્સસ્ટન્ટ 
અથવા ફોર્્મ્યયુલા માટે નામ બનાવવાની મંજૂરી આપે છે.

એક્સેલ નેમ મેનેજરનો ઉપયોગ કરીને નામવાળી શ્રેણી બનાવો

એક્સેલમાાં નેમ મેનેજરનો ઉપયોગ હાલના નામો સાથે કામ કરવા માટે થાય 
છે.  જો કે, તે તમને નવું નામ બનાવવામાાં પણ મદદ કરી શકે છે.

1 	 ફોર્્મ્યયુલા ટેબ &gt; વ્્યયાખ્યાયિત નામ જૂથ પર જાઓ, નેમ મેનેજર પર 
ક્્લલિક કરો. અથવા, ફક્્ત Ctrl + F3 (મારી પસંદગીની રીત) દબાવો.

2 	ન ેમ મેનેજર ડાયલોગ વિન્્ડડોની ઉપરના ડાબા ખૂણામાાં, નવું... બટન પર 
ક્્લલિક કરો:

3 	 આ નવું નામ સંવાદ બોક્સ ખોલશે જ્યયાં તમે અગાઉના વિભાગમાાં 
દર્શાવ્્યયા મુજબ નામ ગોઠવો છો
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કાર્્ય 2 : ટેબલનું નામ આપો

કોષ્્ટકનું નામ બદલવા માટે

1	ટ બલ પર ક્્લલિક કરો.

2	ટ બલ Tools > Design > Properties > Table Name  પર જાઓ.

3	 કોષ્્ટકનું નામ હાઇલાઇટ કરો અને નવું નામ દાખલ કરો.

કાર્્ય 3 : ડેટાને દૃષ્્ટટિની રીતે સારાાંશ આપો સ્્પપાર્્ક  લાઇન્્સ દાખલ કરો

સ્્પપાર્્ક લાઇન ઉમેરો

1	ડ ટાની પંક્્તતિના અતંે ખાલી કોષ પસંદ કરો.

2	 ઇન્્સર્્ટ  પસંદ કરો અને સ્્પપાર્્કલ ાઇન પ્રકાર પસંદ કરો, જમે કે લાઇન 
અથવા કૉલમ.

3	 પંક્્તતિમાાં કોષો પસંદ કરો અને મેનુમાાં બરાબર.

4	ડ ટાની વધુ પંક્્તતિઓ? દરેક પંક્્તતિ માટે સ્્પપાર્્કલ ાઇન ઉમેરવા માટે 
હેન્્ડલને ખેેંચો.

સ્્પપાર્્ક લાઇન ચાર્્ટ  ફોર્મેટ કરો

1	 સ્્પપાર્્કલ ાઇન ચાર્્ટ  પસંદ કરો.

2	 સ્્પપાર્્કલ ાઇન પસંદ કરો અને પછી વિકલ્્પ પસંદ કરો.

•	 ચાર્્ટનો પ્રકાર બદલવા માટે લાઇન, કૉલમ અથવા જીત/હાર પસંદ 
કરો.

• 	 સ્્પપાર્્કલ ાઇન ચાર્્ટમાાં વ્્યક્્તતિગત મૂલ્યોને પ્રકાશિત કરવા માટે 
માર્્કર્્સ  તપાસો.

• 	 સ્્પપાર્્કલ ાઇન માટે શૈલી પસંદ કરો.

• 	 સ્્પપાર્્કલ ાઇન રંગ અને રંગ પસંદ કરો.

• 	 સ્્પપાર્્કલ ાઇનની પહોળાઈ પસંદ કરવા માટે સ્્પપાર્્કલ ાઇન રંગ &gt; 
વજન પસંદ કરો.

• 	મ ાર્્ક રનો રંગ બદલવા માટે માર્્ક રનો રંગ પસંદ કરો.

કાર્્ય 4 : બિલ્ટ ઇન કન્્ડડીશનલ ફોર્મેટિિંગ લાગુ કરો 

શરતી ફોર્મેટિિંગ લાગુ કરો

1	 કોષોની શ્રેણી, કોષ્્ટક અથવા આખી શીટ પસંદ કરો કે જનેા પર તમે 
શરતી ફોર્મેટિિંગ લાગુ કરવા માાંગો છો.

2	 હોમ ટેબ પર, કન્્ડડીશનલ ફોર્મેટિિંગ પર ક્્લલિક કરો.

	 પ્રકાશિત કરવા માટે	 આ કરો

	 ચોક્કસ કોષોમાાં મૂલ્યો. 	 કોષોના નિયમો અથવા ટોપ/બોટમ

	 ઉદા: 50 અને 100 ની 	 નિયમોને હાઇલાઇટ કરો અને પછી

	વ ચ્ચેની સખં્યા	ય ોગ્્ય વિકલ્્પ પર ક્્લલિક કરો.

	 કોષ શ્રેણીમાાં મૂલ્યોનો 	ડ ટા બાર તરફ નિર્દેશ કરો, અને પછી

	 સંબંધ. ઉદાહરણો સૌથી 	તમ ે ઇચ્છો તે ભરણ પર ક્્લલિક કરો.

	મ ોટા શહેરોમાાં કિિંમતો 

	અ થવા વસ્્તતીની તુલના છે.

	 કોષમાાં મૂલ્યોનો સંબંધ શ્રેણી	 રંગ ભીીંગડા તરફ નિર્દેશ કરો, અને 

	 સમગ્ર પ્રદેશોમાાં વેચાણ 	 પછી તમને જોઈતા સ્કેલ પર

	 વિતરણનું ઉદાહરણ છે. 	 ક્્લલિક કરો.

	 એક કોષ શ્રેણી જમેાાં મૂલ્યોના 	 આયકન સેટ્સ તરફ નિર્દેશ કરો અને

	 ત્રણથી પાાંચ જૂથો હોય છે, જ્યયાં 	 પછી સેટ પર ક્્લલિક કરો.

	 દરેક જૂથની પોતાની થ્રેશોલ્્ડ હોય 

	 છે. ઉદાહરણ તરીકે તમે 

	 ઓટોમોબાઈલ માટે 5 પોઈન્ટ 

	 રેટિિંગ સિસ્ટમ સોોંપી શકો છો 

	અન ે પાાંચ આઈકોન્્સનો સમહૂ 

	લ ાગુ કરી શકો છો.	

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.15.57
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શરતી ફોર્મેટિિંગ સાથે તાપમાન માહિતી લાગુ કરવામાાં આવી છે જ ેટોચના 
10% અને નીચેના 10% મૂલ્યો દર્શાવે છે.

3 કલર સ્કેલ શરતી ફોર્મેટિિંગ લાગુ સાથે તાપમાન માહિતી

કાર્્ય 5 : શરતી ફોર્મેટિિંગ દૂર કરો

પસંદ કરેલ શ્રેણીના શરતી ફોર્મેટિિંગને કાઢી નાખવા માટે, કૃપા કરીને આ 
પ્રમાણે કરો:

1	તમ ે શરતી ફોર્મેટિિંગ દૂર કરવા માાંગો છો તે શ્રેણી પસંદ કરો.

2	 Home > Conditional Formatting > Clear Rules> Clear 
Rules પર ક્્લલિક કરો. પસંદ કરેલ કોષોમાાંથી નિયમો સાફ કરો 
સ્ક્રીનશોટ જુઓ:

3	અન ે પસંદ કરેલ શરતી ફોર્મેટિિંગ દૂર કરવામાાં આવ્્યયુું છે. સ્ક્રીનશોટ 
જુઓ:

સમગ્ર કાર્્યપત્રક શરતી ફોર્મેટિિંગને કાઢી નાખવા માટે, કૃપા કરીને નીચે 
મુજબ કરો:

Home > Conditional Formatting > Clear Rules >Clear 
Rules from Entire Sheet, પર ક્્લલિક કરો આખી શીટ અને આખી 
વર્્કશ ીટમાાંથી નિયમો સાફ કરો શરતી ફોર્મેટિિંગ દૂર કરવામાાં આવશે.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.15.57
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IT & ITES	 	 એકસરસાાઈઝ 1.16.58
કોપા (COPA) - કોષ્્ટકો અને કોષ્્ટક ડેટાનું સંચાલન કરો	

કોષ્્ટકો બનાવો અને ફોર્મેટ કરો (Create and format tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સેલ રેન્્જમાાંથી એક્સેલ કોષ્્ટકો બનાવો
•	ટ બલ શૈલીઓ લાગુ કરો
•	 કોષ્્ટકોને સેલ રેન્્જમાાં કન્્વર્્ટ  કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સેલ રેન્્જમાાંથી એક્સેલ કોષ્્ટકો બનાવો 

1	તમ ારા ડેટાની અંદર એક કોષ પસંદ કરો.

2	 Home > Format as Table પસંદ કરો.

3	તમ ારા ટેબલ માટે શૈલી પસંદ કરો.

4	 ટેબલ તરીકે ફોર્મેટ કરો સંવાદ બોક્સમાાં, તમારી સેલ શ્રેણી સેટ કરો.

5	 જો તમારા કોષ્્ટકમાાં હેડર હોય તો માર્્ક  કરો.

6	 બરાબર પસંદ કરો.

કાર્્ય 2 : કોષ્્ટક શૈલીઓ લાગુ કરો 

હાલના ટેબલ પર ટેબલ સ્ટાઇલ લાગુ કરો

1	 કોષ્્ટકમાાં કોઈપણ કોષ પસંદ કરો.

2	 Home > Format as Table or Design Table પસંદ કરો

3	 કોષ્્ટક શૈલીઓ ગેલેરીમાાં, તમે લાગુ કરવા માાંગો છો તે ટેબલ શૈલી 
પસંદ કરો.

•	 કોષ્્ટકમાાં છેલ્્લલી પંક્્તતિમાાં વિશષે ફોર્મેટિિંગ ઉમેરવા માટે, Design > 
Total Row. પસંદ કરો.

•	 વૈકલ્્પપિક પંક્્તતિ અથવા કૉલમના રંગો અન કોષ્્ટકોને વાાંચવામાાં સરળ 
બનાવવા માટે, Design > Banded  Rows or Design > Banded 
Columns  પસંદ કરો.

કોષ્્ટક શૈલી વિકલ્્પપો બદલો

કોષ્્ટકની ડિઝાઇન બદલવા માટે, નીચેનામાાંથી એક અથવા વધુ કરો:

•	 કોષ્્ટકમાાં પ્રથમ પંક્્તતિમાાં વિશષે ફોર્મેટિિંગ ઉમેરવા માટે, Design > 
Header Row પસંદ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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કાર્્ય 3 : કોષ્્ટકોને સેલ રેન્્જમાાં કન્્વર્્ટ  કરો

1	 કોષ્્ટકમાાં ગમે ત્યયાં ક્્લલિક કરો અને પછી Table Tools > Design પર 
જાઓ.

2	 ટૂલ્સ ગ્રુપમાાં, કન્્વર્્ટ  ટુ રેન્્જ પર ક્્લલિક કરો.

	 -અથવા-

	 ટેબલ પર જમણું-ક્્લલિક કરો, પછી શૉર્્ટકટ મેનૂમાાં,Table > Convert 
to Range ક્્લલિક કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.16.58
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IT & ITES	 	 એકસરસાાઈઝ 1.16.59
કોપા (COPA) - કોષ્્ટકો અને કોષ્્ટક ડેટાનું સંચાલન કરો	

કોષ્્ટકો અને તેના ડેટાનું સંચાલન (Managing tables and its data)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 કોષ્્ટક પંક્્તતિઓ અને કૉલમ ઉમેરો અથવા દૂર કરો
•	ટ બલ શૈલી વિકલ્્પપોને ગોઠવો
•	 કુલ પંક્્તતિઓ દાખલ કરો અને ગોઠવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : કોષ્્ટકની હરોળ અને કૉલમ ઉમેરો અથવા દૂર કરો 

મોડલ 15 નો સંદર્્ભ લો - કાર્્ય 3 બહુવિધ કૉલમ અથવા પંક્્તતિઓ દાખલ કરો અને કાઢી નાખો

કાર્્ય 2 : કોષ્્ટક શૈલી વિકલ્્પપોને ગોઠવો

1	 કોષ્્ટકની અંદર કોઈપણ કોષ પસંદ કરો, અથવા કોષોની શ્રેણી કે જનેે 
તમે કોષ્્ટક તરીકે ફોર્મેટ કરવા માાંગો છો.

2	 હોમ ટેબ પર, ટેબલ તરીકે ફોર્મેટ કરો પર ક્્લલિક કરો.

3	તમ ે ઉપયોગ કરવા માાંગો છો તે ટેબલ શૈલી પર ક્્લલિક કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.

© NIMI 

NOT TO BE REPUBLISHED



220

કાર્્ય 3 : કુલ પંક્્તતિઓ દાખલ કરો અને ગોઠવો

તમે ડિઝાઇન ટેબ પર કુલ પંક્્તતિ ચેકબોક્સ પસંદ કરીને કોષ્્ટકમાાં સરવાળો 
ઉમેરી શકો છો. તમે કુલ પંક્્તતિ ડ્્ર રોપ-ડાઉનમાાંથી ફંક્શન પણ ઉમેરી શકો 
છો.

1	 કોષ્્ટકમાાં કોષ પસંદ કરો.

2	 Design > Total Row. પસંદ કરો.

3	 કુલ પંક્્તતિ કોષ્્ટકની નીચે ઉમેરવામાાં આવે છે. 4	 કુલ પંક્્તતિ ડ્્ર રોપ-ડાઉનમાાંથી, તમે એક કાર્્ય પસંદ કરી શકો છો, જમે 
કે સરેરાશ, ગણતરી, સખં્યા સખં્યા, મહત્તમ, લઘુત્તમ, સરવાળો, 
StdDev, Var, અને વધુ.

નોોંધ: નવી પંક્્તતિ ઉમેરવા માટે, કુલ પંક્્તતિ ચકેબોક્સને અનચકે 
કરો, પંક્્તતિ ઉમેરો અને પછી કુલ પંક્્તતિ ચકેબોક્સને ફરીથી 
તપાસો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.16.59
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IT & ITES	 	 એકસરસાાઈઝ 1.16.60
કોપા (COPA) - કોષ્્ટકો અને કોષ્્ટક ડેટાનું સંચાલન કરો	

કોષ્્ટક ડેટા ફિલ્ટર અને સૉર્્ટ  કરો (Filter and sort table data)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ફિલ્ટર રેકોર્્ડડ્્સ
•	 બહુવિધ કૉલમ દ્વારા ડેટાને સૉર્્ટ  કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : રેકોર્્ડડ્્સ ફિલ્ટર કરો

કોષ્્ટકમાાં અમુક ડેટાને અસ્થાયી રૂપે છુપાવવા માટે ફિલ્ટર્્સનો ઉપયોગ 
કરો, જથેી તમે જ ેડેટા જોવા માાંગો છો તેના પર ફોકસ કરી શકો.

ડેટાની શ્રેણીને ફિલ્ટર કરો

1	 શ્રેણીની અંદર કોઈપણ કોષ પસંદ કરો.

2	 Data > Filter પસંદ કરો.

3	 કૉલમ હેડર એરો પસંદ કરો.

4	 ટેક્સ્ટ ફિલ્ટર્્સ અથવા નંબર ફિલ્ટર્્સ પસંદ કરો, અને પછી સરખામણી 
પસંદ કરો, જમે કે વચ્ચે.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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5	ફિ લ્ટર માપદંડ દાખલ કરો અને બરાબર પસંદ કરો.

કોષ્્ટકમાાં ડેટા ફિલ્ટર કરો

જ્યારે તમે કોષ્્ટકો બનાવો અને ફોર્મેટ કરો છો, ત્યારે ફિલ્ટર નિયંત્રણો 
આપમેળે કોષ્્ટક હેડરમાાં ઉમેરવામાાં આવે છે.

1	તમ  ફિલ્ટર કરવા માાંગો છો તે કૉલમ માટે કૉલમ હેડર એરો પસંદ કરો.

2	અન ચેક કરો (બધા પસંદ કરો) અને તમે બતાવવા માાંગો છો તે બોક્સ 
પસંદ કરો.

3.	 ઓકે ક્્લલિક કરો.

કૉલમ હેડર એરો  ફિલ્ટર આયકનમાાં બદલાય છે.  

ફિલ્ટરને બદલવા અથવા સાફ કરવા માટે આ     આયકન પસંદ કરો     

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.16.60
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કાર્્ય 2 : બહુવિધ કૉલમ દ્વારા ડેટાને સૉર્્ટ  કરો 

ટેબલ સૉર્્ટ  કરો

1	 ડેટાની અંદર સેલ પસંદ કરો.

2	 Home > Sort & Filter  પસંદ કરો.

	અ થવા, Data > Sort પસંદ કરો.

3	 વિકલ્્પ પસંદ કરો:

•	 A થી Z સૉર્્ટ  કરો - પસંદ કરેલ કૉલમને ચડતા ક્રમમાાં સૉર્્ટ  કરે છે.

•	 Z થી A સૉર્્ટ  કરો - પસંદ કરેલ કૉલમને ઉતરતા ક્રમમાાં સૉર્્ટ  કરે છે.

•	 કસ્ટમ સૉર્્ટ  - વિવિધ સૉર્્ટ  માપદંડો લાગુ કરીને બહુવિધ કૉલમમાાં 
ડેટાને સૉર્્ટ  કરે છે.

કસ્ટમ સૉર્્ટ  કેવી રીતે કરવું તે અહીીં છે:

i	 કસ્ટમ સૉર્્ટ  પસંદ કરો.

ii	 એડ લેવલ પસંદ કરો.

iii	 કૉલમ માટે, ડ્્ર રોપ ડાઉનમાાંથી તમે જ ેકૉલમને સૉર્્ટ  કરવા માગો છો તે 
કૉલમ પસંદ કરો અને પછી બીજી કૉલમ પસંદ કરો જ ેપછી તમે સૉર્્ટ  
કરવા માાંગો છો. ઉદાહરણ તરીકે, વિભાગ દ્વારા અને પછી સ્થિતિ દ્વારા 
સૉર્્ટ  કરો.

iv	 સૉર્્ટ  ઑન માટે, મૂલ્યો પસંદ કરો.

v	 ઓર્્ડ ર માટે, વિકલ્્પ પસંદ કરો, જમે કે A થી Z, સૌથી નાનું થી સૌથી 
મોટંુ અથવા સૌથી નાનું.

vi	 દરેક વધારાની કૉલમ માટે કે જનેે તમે સૉર્્ટ  કરવા માાંગો છો, પગલાાં 2-5 
પનુરાવર્્તન કરો.

નોોંધ: સ્્તર કાઢી નાખવા માટે, સ્્તર કાઢી નાખો પસંદ કરો.

vii	 જો તમારા ડેટામાાં હેડર પંક્્તતિ હોય તો મારા ડેટામાાં હેડર છે ચેકબોક્સને 
ચેક કરો.

viii	ઓકે પસંદ કરો
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IT & ITES	 	 એકસરસાાઈઝ 1.17.61
કોપા (COPA) - સતૂ્રો અને કાર્યોનો ઉપયોગ કરીને કામગીરી કરો	

સંદર્ભો દાખલ કરો (Insert references)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સંબંધિત, સંપૂર્્ણ અને મિશ્ર સંદર્ભો દાખલ કરો
•	 સતૂ્રોમાાં નામવાળી શ્રેણીઓ અને નામાાંકિત કોષ્્ટકોનો સંદર્્ભ.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સંબંધિત, સંપૂર્્ણ અને મિશ્ર સંદર્ભો દાખલ કરો 

સંબંધિત સંદર્ભોનો ઉપયોગ કરીને ફોર્્મ્યયુલા બનાવવા અને નકલ કરવા 
માટે:

નીચેના ઉદાહરણમાાં, અમે એક સૂત્ર બનાવવા માાંગીએ છીએ જ ેદરેક વસ્્તતુની 
કિિંમતને જથ્્થથા દ્વારા ગુણાકાર કરશે. દરેક પંક્્તતિ માટે એક નવું ફોર્્મ્યયુલા 
બનાવવાને બદલે, આપણે સેલ D2 માાં એક ફોર્્મ્યયુલા બનાવી શકીએ છીએ 
અન પછી તેને અન્ય પંક્્તતિઓમાાં કૉપિ કરી શકીએ છીએ. અમે સંબંધિત 
સંદર્ભોનો ઉપયોગ કરીશું જથેી સૂત્ર યોગ્્ય રીતે દરેક આઇટમ માટે કુલની 
ગણતરી કરે.

1	 કોષ પસંદ કરો જમેાાં સૂત્ર હશે. અમારા ઉદાહરણમાાં, અમે સેલ D2 
પસંદ કરીશંુ.

2	 ઇચ્છિત મૂલ્યની ગણતરી કરવા માટે સૂત્ર દાખલ કરો. અમારા 
ઉદાહરણમાાં, અમે ટાઇપ કરીશું =B2*C2.

3	તમ ારા કીબોર્્ડ  પર Enter દબાવો. સૂત્રની ગણતરી કરવામાાં આવશે, 
અન પરિણામ સેલમાાં પ્રદર્શિત થશે.

4	 ઇચ્છિત કોષના નીચલા-જમણા ખૂણે ફિલ હેન્્ડલ શોધો. અમારા 
ઉદાહરણમાાં, અમે સેલ D2 માટે ફિલ હેન્્ડલ શોધીશું.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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5	તમ ે ભરવા માાંગો છો તે કોષો પર ભરણ હેન્્ડલને ક્્લલિક કરો, પકડી 
રાખો અન ખેેંચો. અમારા ઉદાહરણમાાં, અમે સેલ D3:D12 પસંદ કરીશું.

6	મ ાઉસ છોડો. ફોર્્મ્યયુલાને સંબંધિત સંદર્ભો સાથે પસંદ કરેલા કોષોમાાં 
નકલ કરવામાાં આવશે અને દરેક કોષમાાં મૂલ્યોની ગણતરી કરવામાાં 
આવશે.

તમે ભરેલા કોષોને ચોકસાઈ માટે તેમના સૂત્રો તપાસવા માટે બે વાર ક્્લલિક 
કરી શકો છો. તેની પંક્્તતિના આધારે દરેક કોષ માટે સંબંધિત કોષ સંદર્ભો 
અલગ હોવા જોઈએ.

સંપૂર્્ણ સંદર્ભોનો ઉપયોગ કરીને ફોર્્મ્યયુલા બનાવવા અને કૉપિ કરવા 
માટે: અમારા ઉદાહરણમાાં, અમે કૉલમ Dમાાં તમામ વસ્્તતુઓ માટે GST 
ટેક્સની ગણતરી કરવા સેલ E1માાં 5% GST કર દરનો ઉપયોગ કરીશંુ. 
અમારે સંપૂર્્ણ સેલ સંદર્્ભ $ નો ઉપયોગ કરવાની જરૂર પડશે. અમારા 
ફોર્્મ્યયુલામાાં E$1. કારણ કે દરેક ફોર્્મ્યયુલા સમાન ટેક્સ દરનો ઉપયોગ કરી 
રહી છે, અમે ઇચ્છીએ છીએ કે જ્યારે ફોર્્મ્યયુલા કૉપિ કરવામાાં આવે અને 
કૉલમ Dમાાં અન્ય કોષોમાાં ભરવામાાં આવે ત્યારે તે સંદર્્ભ સ્થિર રહે.

1	 કોષ પસંદ કરો જમેાાં સૂત્ર હશે. અમારા ઉદાહરણમાાં, અમે સેલ D3 
પસંદ કરીશંુ.

2	 ઇચ્છિત મૂલ્યની ગણતરી કરવા માટે સૂત્ર દાખલ કરો. અમારા 
ઉદાહરણમાાં, અમે ટાઇપ કરીશું  (B3*C3)*$E$1.

3	તમ ારા કીબોર્્ડ  પર Enter દબાવો. સૂત્ર ગણતરી કરશે, અને પરિણામ 
કોષમાાં પ્રદર્શિત થશ.

4	 ઇચ્છિત કોષના નીચલા-જમણા ખૂણે ફિલ હેન્્ડલ શોધો. અમારા 
ઉદાહરણમાાં, અમે સેલ D3 માટે ફિલ હેન્્ડલ શોધીશું.

5	તમ ે ભરવા માાંગો છો તે કોષો પર ક્્લલિક કરો, પકડી રાખો અને ખેેંચો, 
સેલ D4:D13 અમારા ઉદાહરણમાાં.

6	મ ાઉસ છોડો. ફોર્્મ્યયુલાને ચોક્કસ સંદર્્ભ સાથે પસંદ કરેલા કોષોમાાં 
કૉપિ કરવામાાં આવશે અને દરેક કોષમાાં મૂલ્યોની ગણતરી કરવામાાં 
આવશે.

તમે ભરેલા કોષોને ચોકસાઈ માટે તેમના સૂત્રો તપાસવા માટે બે વાર ક્્લલિક 
કરી શકો છો. સંપૂર્્ણ સંદર્્ભ દરેક કોષ માટે સમાન હોવો જોઈએ, જ્યારે 
અન્ય સંદર્ભો કોષની પંક્્તતિથી સંબંધિત છે.
જ્યારે પણ તમે બહુવિધ કોષોમાાં સંપૂર્્ણ સંદર્્ભ બનાવી રહ્યા હો ત્યારે ડોલર 
ચિહ્ન ($) શામેલ કરવાની ખાતરી કરો. ડોલરના ચિહ્નોને અવગણવામાાં 
આવ્્યયા હતા, જનેા કારણે સ્પ્રેડશીટ તેને સંબંધિત સંદર્્ભ તરીકે અર્્થઘટન 
કરવા માટેનું કારણ બને છે, જ્યારે અન્ય કોષોમાાં નકલ કરવામાાં આવે ત્યારે 
ખોટંુ પરિણામ ઉત્્પન્ન કરે છે.

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.17.61

દાખ્લા તરીકે:
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મિશ્ર સંદર્્ભ

મિશ્ર સંદર્્ભ એ સંપૂર્્ણ સંદર્્ભનો એક પ્રકાર છે જમેાાં કાાં તો સ્્તતંભને સ્થિર 
બનાવવામાાં આવે છે અથવા પંક્્તતિ સતત બનાવવામાાં આવે છે.

દાખ્્લલા તરીકે: 

•	 $F1: આમાાં કૉલમ F સ્થિર છે.

•	 F$1: આમાાં પંક્્તતિ 1 સ્થિર છે.

T0 મિશ્ર સંદર્્ભ કરે છે:

પગલું 1: કોઈપણ કોષમાાં સૂત્ર લખો. અમે લખીએ છીએ  સેલ C2 માાં 
ફોર્્મ્યયુલા(=B2+A2) અને એન્ટર દબાવો.

પગલું 2: ફિલ હેન્્ડલ પર ક્્લલિક કરો અને પકડી રાખો.

પગલું 3: તમે ભરવા માાંગો છો તે સેલ પર તેને ખેેંચો. અમે તેને સેલ C3 સુધી 
ખેેંચીએ છીએ.

પગલું 4: અમે કૉલમ A અચલની પંક્્તતિ 2 બનાવી નથી, આમ આપણે 
જોઈએ છીએ કે જમે જમે આપણે કોષ C3 માાં ફોર્્મ્યયુલાની નકલ કરીએ 
છીએ, A2 A3 માાં બદલાય છે એટલે કે ઉમેરણ A2 અને B2, A3 અને B3 
વચ્ચે કરવામાાં આવે છે.

અમે 2 પહેલા ડોલરનું ચિહ્ન ઉમેરીને કૉલમ A અચલની પંક્્તતિ 2 
બનાવીએ છીએ.

પગલું 5: કોઈપણ કોષમાાં સૂત્ર લખો. આપણે સેલ C2 માાં 
ફોર્્મ્યયુલા(=B2+A$2) લખીએ છીએ અને એન્ટર દબાવો.

પગલું 6: ફિલ હેન્્ડલ પર ક્્લલિક કરો અને પકડી રાખો.

પગલું 7: તમે ભરવા માાંગો છો તે સેલ પર તેને ખેેંચો. અમે તેને સેલ C3 સુધી 
ખેેંચીએ છીએ.

પગલું 8: અમે કૉલમ A અચળની પંક્્તતિ 2 બનાવી છે, આમ આપણે જોઈએ 
છીએ કે જમે આપણે કોષ C3 માાં સૂત્રની નકલ કરીએ છીએ, A2 A3 માાં 
બદલાતું નથી એટલે કે A2 સેલ B2 અને B3 માાં ઉમેરાય છે.
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કાર્્ય 2 : સતૂ્રોમાાં નામવાળી શ્રેણીઓ અને નામાાંકિત કોષ્્ટકોનો સંદર્્ભ આપો

સંદર્્ભ નામવાળી શ્રેણીઓ 

EX.NO.15.57 માાં વપરાયેલ સમાન કોષ્્ટકનો ઉપયોગ કરો અને નામવાળી 
શ્રેણીઓ અને કાર્્ય 1 ને વ્્યયાખ્યાયિત કરો અને સંદર્્ભ આપો: આ કસરતને 
ચલાવવા માટે નામવાળી શ્રેણી વ્્યયાખ્યાયિત કરો

1	 સેલ B1 પસંદ કરો.

2	 એક્સેલ નેમ મેનેજર ખોલવા માટે Ctrl + F3 દબાવો, અને નવા પર 
ક્્લલિક કરો...

3	ન ામ બૉક્સમાાં, ઇચ્છિત નામ લખો, કહો, આઇટમ_ બાકી.

4	 Refers to બોક્સમાાં, =A1 લખો.

5	 બરાબર ક્્લલિક કરો.

હવે, ચાલો જોઈએ કે જ્યારે આપણે સૂત્રમાાં આઇટમ_લેફ્ટ નામનો ઉપયોગ 
કરીએ ત્યારે શંુ થાય છે, ઉદાહરણ તરીકે:

=SUMIF(items_list, item_left, sales)

જ્યયાં વસ્્તતુઓ_સૂચિ $A$2:$A$10 અને વેચાણનો સંદર્્ભ આપે છે નીચેના 
કોષ્્ટકમાાં $B$2:$B$10.

જ્યારે તમે કોષ E2 માાં ફોર્્મ્યયુલા દાખલ કરો છો, અને પછી તેને કૉલમ નીચે 
કૉપિ કરો છો, ત્યારે તે દરેક ઉત્્પપાદનના કુલ વેચાણની વ્્યક્્તતિગત રીતે 
ગણતરી કરશે કારણ કે item_left એ સંબંધિત નામ છે અને તેનો સંદર્્ભ 
કૉલમ અન પંક્્તતિની સંબંધિત સ્થિતિના આધારે ગોઠવાય છે જ્યયાં સૂત્ર 
નકલ કરવામાાં આવે છે:

સંદર્્ભ નામનું કોષ્્ટક

1	 સમગ્ર કોષ્્ટક પસંદ કરો અથવા કર્્સરને કોઈપણ કોષમાાં મૂકો. એક્સેલ 
ટેબલ ડિઝાઇન ટેબને તરત જ પ્રદર્શિત કરે છે.

2	 ટેબલ ડિઝાઇન પર ક્્લલિક કરો.

3	 ગુણધર્મો વિભાગમાાં કોષ્્ટક નામ સંવાદ બોક્સ હેઠળ ટેબલ નામ 
(એટલે કે, ન્યુયોર્્ક સેલ) સોોંપો.

4	 ENTER દબાવો. એક્સેલ પછી આ કોષ્્ટકને નામ સોોંપે છે.

5	અ ન્ય 2 કોષ્્ટકો (એટલે કે, બોસ્ટનસેલ, લોસએન્્જજે લસેલ) માટે 
પગલાાંઓનું પુનરાવર્્તન કરો. 
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6	તમ ે Formulas > Name Manager (વ્્યયાખ્યાયિત નામ વિભાગમાાં) 
નો ઉપયોગ કરીને નામકરણ તપાસી શકો છો. અને તમે નેમ મેનેજર 

વિન્્ડડોમાાં અસાઇન કરેલ તમામ ટેબલ નામો જોશો.

અમે તેમને સરળતાથી સંદર્્ભ આપવા માટે કોષ્્ટકોના વિશિષ્્ટ નામો 
અસાઇન કર્યા હોવાથી, હવે અમે તેમને સતૂ્રોમાાં સંદર્્ભ આપવા આગળ 
વધીએ છીએ. 

અન્ય શીટમાાં કોષ્્ટકોનો સંદર્્ભ આપવા માટે નીચેની પદ્ધતિઓ અનુસરો.

પગલું 1: ફોર્્મ્યયુલા બારમાાં સમાન ચિહ્ન (=) દાખલ કર્યા પછી ફોર્્મ્યયુલા 
ટાઇપ કરવાનું શરૂ કરો. પછી, નીચેની ઈમેજમાાં બતાવ્્યયા પ્રમાણે તેનો સંદર્્ભ 
આપવા માટે કોષ્્ટકનું નામ ટાઈપ કરો. એક્સેલ કોષ્્ટક સંદર્્ભ લાવે છે; તેના 
પર ડબલ ક્્લલિક કરો.

પગલું 2: કોષ્્ટકનો ઉલ્્લલેખ કર્યા પછી, ત્રીજો કૌૌંસ લખો (એટલે કે,[ ). Excel 
પસંદ કરવા માટે કૉલમ નામો બતાવે છે. ટોટલ સેલ પર ડબલ ક્્લલિક કરો 
અન નીચે આપેલા ચિત્ર પ્રમાણે કૌૌંસ બંધ કરો.
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અમે પહેલા ન્યૂ યોર્્ક  સેલ ટેબલ અસાઇન કરીએ છીએ અને પછી તેની 
એક કૉલમ (એટલે કે, કુલ વેચાણ) પછીથી. અમે બનંે દલીલોને રંગીન 
લંબચોરસમાાં સૂચવીએ છીએ.

પગલંુ 3: C5 સેલમાાં સૂત્ર લાગુ કરવા માટે ENTER કીનો ઉપયોગ કરો.

સંબંધિત કોષોમાાં અન્ય કોષ્્ટકોનો સંદર્્ભ આપવા માટે પગલાાં 1, 2 અને 3 
ને અનુસરો. સંદર્્ભ આપ્્યયા પછી એક્સેલ નીચેની ઈમેજમાાં દર્શાવ્્યયા મુજબ 
સંબંધિત કોષ્્ટકોના કુલ વેચાણ કૉલમનો સરવાળો બતાવે છે.

તમે કોઈપણ કોષ્્ટકનો સંદર્્ભ ફક્્ત ફોર્્મ્યયુલામાાં નામ આપીને કૉલમ હેડર 
સાથે આપી શકો છો જનેી સાથે તમે વ્્યવહાર કરવા માાંગો છો.
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IT & ITES	 	 એકસરસાાઈઝ 1.17.62
કોપા (COPA) - સતૂ્રો અને કાર્યોનો ઉપયોગ કરીને કામગીરી કરો

ડેટાની ગણતરી અને રૂપાાંતર કરો (Calculate and transform data)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 AVERAGE(), MIN(), MAX() અને SUM() નો ઉપયોગ કરીને ગણતરીઓ કરો
•	 COUNT(), COUNTIF() અને COUNTBLANK() નો ઉપયોગ કરીને કોષોની ગણતરી કરો
•	 IF() ફંક્શનનો ઉપયોગ કરીને શરતી કામગીરી કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : AVERAGE(), MIN(), MAX() અને SUM() નો ઉપયોગ કરીને ગણતરીઓ કરો

1	 કોષ્્ટક બનાવો અને સંબંધિત ડેટા ભરો. 

2	 એક્સેલ ફોર્્મ્યયુલાને એક્્ઝઝિક્યુટ કરવા માટે શીટમાાં કોઈપણ કોષને 
પસંદ કરો જ ેબધા = ચિહ્નથી શરૂ થાય છે, ત્યારબાદ ફંક્શન નામ અને 
રેન્્જ અથવા દલીલો પ્રદાન કરવા માટે કૌૌંસમાાં એક વિભાગ. ટાઇપ 
કરીને શરૂઆત કરો =sum(

3	 સરવાળે તમે એકસાથે ઉમેરવા માાંગો છો તે કોષોની શ્રેણીની જરૂર છે. 
તમ તમારી શ્રેણી લખી શકો છો, અથવા તમે તમારા માઉસ અથવા 
ઇનપુટ ઉપકરણનો ઉપયોગ કરીને તેને પસંદ કરી શકો છો. આ 
કિસ્્સસામાાં, અમે D2:D21 પસંદ કરીશું. આગળ તમે કૌૌંસ બંધ કરી શકો 
છો, જોકે એક્સેલના નવા સંસ્કરણો તમારા માટે તેને સ્્વતઃ બધં કરશે.

4	અ ન્ય કાર્યો માટે પણ 2 અને 3 ના સમાન પગલાનું પુનરાવર્્તન કરો

5	 પરિણામ આવશે

વધારાની ટિપ્સ

વિકલ્્પ1: સ્્વતઃ SUM કાર્યો

1	ખ ાલી કોષ પર છેલ્્લલી પંક્્તતિની નીચે પસંદ કરો અને તમને જોઈતું યોગ્્ય 
કાર્્ય પસંદ કરો. 

2	 પછી Excel આપમેળે ગણતરી કરવા માટે ડેટાની શ્રેણી પસંદ કરશે.

•	 MS Office 2019 / નવીનતમ	          - 1 No.

© NIMI 

NOT TO BE REPUBLISHED



231

3	 ફંક્શનની કિિંમત જોવા માટે એન્ટર પર ક્્લલિક કરો. 

વિકલ્્પ 2: 

સ્ક્રીનની નીચે જમણી બાજુએ, એક્સેલ તમને ડિફોલ્ટ રૂપે સરવાળો, 
સરેરાશ અને ગણતરી પ્રદાન કરે છે તે શ્રેણી પસંદ કરો અને લઘુત્તમ, 

મહત્તમ અને સખં્યાત્મક ગણતરી પ્રદાન કરવા માટે તેના પર જમણું-ક્્લલિક 
કરીને ગોઠવી શકાય છે.

કાર્્ય 2 : COUNT(), COUNTIF() અને COUNTBLANK() નો ઉપયોગ કરીને કોષોની ગણતરી કરો

1	 કાર્્ય 1 માાં વપરાયેલ સમાન કોષ્્ટકનો ઉપયોગ કરો: અને ગણતરીના 
કાર્યોને ચલાવવા માટે સપ્્ટટેમ્્બર 1  અને સપ્્ટટેમ્્બર 2 નું પુનરાવર્્તન કરો.

•	 COUNT: રકમ કૉલમમાાં સખં્યાઓ ધરાવતા કોષોની ગણતરી 
કરવા.

•	 COUNTA: સરનામાાં કૉલમમાાં ખાલી ન હોય તેવા કોષોની ગણતરી 
કરવા.

•	 COUNTIF: સરનામાાં કૉલમમાાં “ચેન્નાઈ” તરીકે નિર્દિષ્્ટ માપદંડને 
પૂર્્ણ કરતા કોષોની ગણતરી કરવા.

•	 COUNTBLANK: કોષોની ગણતરી કરવા માટે કે જ ે ખાલી 
જગ્્યયાના સરનામા કૉલમ છે.

2	 પરિણામ આવશે.

કાર્્ય 3 : IF() ફંક્શનનો ઉપયોગ કરીને શરતી કામગીરી કરો
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If Function

IF ફંક્શન તપાસે છે કે કોઈ શરત પૂરી થઈ છે કે નહીીં, અને જો TRUE હોય 
તો એક મૂલ્ય અને FALSE હોય તો બીજુ ંમૂલ્ય પરત કરે છે.

1	 સેલ C1 પસંદ કરો અને નીચેનું કાર્્ય દાખલ કરો.  (ફિગ 1) = 1F (A1 
>10,”સાચો,”ખોટો”)

 Fig 1 

IF ફંક્શન સાચો આપે છે કારણ કે સેલ A1 માાં મૂલ્ય 10 કરતા વધારે છે.

And Function

જો બધી શરતો સાચી હોય તો AND ફંક્શન TRUE પરત કરે છે અન જો 
કોઈપણ શરતો ખોટી હોય તો FALSE પરત કરે છે.

2	 સેલ D1 પસંદ કરો અને નીચેનું સૂત્ર દાખલ કરો. (ફિગ 2) = 
1F(AND(A1)10,B1>5), ”સાચો,”ખોટો”

AND ફંક્શન FALSE પરત કરે છે કારણ કે સેલ B1 માાં વેલ્યુ 5 કરતા વધારે 
નથી. પરિણામે IF ફંક્શન ખોટંુ પરત કરે છે.

 

Fig 2 

 Fig 3 

Or Function

જો કોઈપણ શરતો TRUE હોય તો OR ફંક્શન TRUE પરત કરે છે અને જો 
બધી શરતો ખોટી હોય તો FALSE પરત કરે છે.

3	 સેલ E1 પસંદ કરો અને નીચેનું સૂત્ર દાખલ કરો.(ફિગ 3) = 
1F(અથવા(A1)10,B1>5), ”સાચો,”ખોટો”)
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IT & ITES	 	 એકસરસાાઈઝ 1.17.63
કોપા (COPA) - સતૂ્રો અને કાર્યોનો ઉપયોગ કરીને કામગીરી કરો

ટેક્સ્ટને ફોર્મેટ કરો અને સશંોધિત કરો (Format and modify text)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 RIGHT(), LEFT() અને MID() ફંક્શનનો ઉપયોગ કરીને ટેક્સ્ટને ફોર્મેટ કરો
•	 UPPER(), LOWER() અને LEN() ફંક્શનનો ઉપયોગ કરીને ટેક્સ્ટને ફોર્મેટ કરો
•	 CONCAT() અને TEXTJOIN() ફંક્શનનો ઉપયોગ કરીને ટેક્સ્ટને ફોર્મેટ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : RIGHT(), LEFT() અને MID() ફંક્શનનો ઉપયોગ કરીને ટેક્સ્ટને ફોર્મેટ કરો

Right

1	શ બ્દમાળામાાંથી સૌથી જમણા અક્ષરો બહાર કાઢો, RIGHT ફંક્શનનો 
ઉપયોગ કરો. (Fig 1) = Right (A1,2)

 Fig 1 

Left

2	શ બ્દમાળામાાંથી ડાબી બાજુના અક્ષરો બહાર કાઢો, આનો ઉપયોગ 
કરો ડાબું કાર્્ય. (ફિગ 2) = ડાબે (A1,4)

Mid

3	 એક સબસ્ટ્રિં�ંગનેે બહાાર કાાઢોો, સ્ટ્રિં�ંગનીી મધ્યમાંં શરૂ કરીીનેે, MID 
ફંંક્શનનોો ઉપયોોગ કરોો. (ફિ�ગ 3) =MID(A1,53)

 Fig 2 

 Fig 3 

કાર્્ય 2 : UPPER(), LOWER() અને LEN() ફંક્શનનો ઉપયોગ કરીને ટેક્સ્ટને ફોર્મેટ કરો

નોોંધ: પોઝિશન 5 (p) પર લંબાઈ 3(ple) સાથે શરૂ થયું.

Len

1	સ્ટટ્રરિં  ગની લંબાઈ મેળવો, LEN ફંક્શનનો ઉપયોગ કરો. (ફિગ 4) 
=LEN(A1)

નોોંધ: જગ્્યયા (પોઝિશન 8) શામેલ છે!

 Fig 4 

Lower/Upper Case

1	 બધા અક્ષરોને a માાં કન્્વર્્ટ  કરવા માટે LOWER ફંક્શનનો ઉપયોગ 
કરો. લોઅરકેસમાાં ટેક્સ્ટ સ્ટટ્રરિં ગ. (ફિગ 5)=નીચલી(A1)

 

Fig 5 

2	 બધા અક્ષરોને a માાં કન્્વર્્ટ  કરવા માટે UPPER ફંક્શનનો ઉપયોગ કરો 
ટેક્સ્ટ સ્ટટ્રરિં ગથી અપરકેસ. (ફિગ 6)=UPPER(A1)

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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Fig 6 

કાર્્ય 3 : CONCAT() અને TEXTJOIN() ફંક્શનનો ઉપયોગ કરીને ટેક્સ્ટને ફોર્મેટ કરો

સકંલિત શબ્દમાળાઓ

આ ઉદાહરણ એક્સેલમાાં સ્ટટ્રરિં ગ્્સને જોડવાની (જોડાવાની) ચાર 
અલગ અલગ રીતો દર્શાવે છે.

1	શ બ્દમાળાઓ જોડવા માટે ફક્્ત &amp; ઓપરેટરનો ઉપયોગ કરો. 
(ફિગ 7)=A2&amp;””&amp;B2&amp;”“&amp;C2&amp;” 
“D)2

 Fig 7 

નોોંધ: જગ્્યયા દાખલ કરવા માટે, “” નો ઉપયોગ કરો

2	 CONCATENATE કાર્્ય ચોક્કસ ઉત્્પપાદન કરે છે સમાન પરિણામ. 
(ફિગ 8) = CONCATENATE (A2,” “B2”, “ “C2”“,D2”) 

 Fig 8 

3	 એક્સેલ 2016 માાં CONCAT કાર્્ય ચોક્કસ સમાન પરિણામ આપે છે. 
(ફિગ 9) = CONCAT(A2,” “B2”, “”C2””,D2”) 

 Fig 9 

 Fig 10 

4	 CONCAT ફંક્શન સ્ટટ્રરિં ગની શ્રેણીમાાં પણ જોડાઈ શકે છે. જો યુઝરને 
સીમાાંકક (જગ્્યયા, અલ્્પવિરામ, ડૅશ, વગેરે)ની જરૂર ન હોય તો આ 
ઉપયોગી થઈ શકે છે. (ફિગ 10) =CONCAT(A1:E1)

 Fig 11 

5	 CONCAT કાર્્ય ખાલી કોષોને અવગણી શકતું નથી. જો સેલ E2 માાં 
ફંક્શનને સેલ E11 પર નીચે ખેેંચો તો નીચે કૉલમ E માાં બધી વધારાની 
જગ્્યયાઓ પર એક નજર નાખો. (ફિગ 11) 

 Fig 12 

IT & ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.17.63

7	 Excel 2016માંં TEXTJOIN ફંંક્શન એ છેે કેે તેે ખાાલીી કોોષોોનેે અવગણીી 
શકે છેે (જો બીીજી દલીીલ TRUE પર સેેટ કરેેલીી હોોય). (ફિ�ગ 12)

નોોંધ: TEXTJOIN ફંક્શન સીમાાંકક (પ્રથમ દલીલ) નો ઉપયોગ 
કરીને શબ્દમાળાઓની શ્રેણીને જોડે છે.

6 તમારા પ્રશિક્ષક સાથે તેની તપાસ કરાવો.
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IT & ITES	 	 એકસરસાાઈઝ 1.18.64
કોપા (COPA) - ચાર્્ટ  મેનેજ કરો	

ચાર્્ટ  બનાવો (Create Charts)
ઉદ્દેશ્્યયો : આ એકસરસાઈઝ (Exercise) ના અતંે તમે શીખી શકશો:
•	 ચાર્્ટ  બનાવો 
•	 ચાર્્ટ  શીટ્સ બનાવો.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ચાર્્ટ  બનાવો

1	 ટેબલ બનાવો 

2	 ચાર્્ટ  માટે A1:D13 શ્રેણીનો ડેટા પસંદ કરો.

3	 Insert > Recommended Charts પસંદ કરો.

4	 ચાર્્ટનું પૂર્વાવલોકન કરવા માટે, ભલામણ કરેલ ચાર્્ટટ્્સ ટેબ પર એક 
ચાર્્ટ  પસંદ કરો.

5	 અથવા ઇન્્સર્્ટ  ટેબ પર, ચાર્્ટટ્્સ જૂથમાાં, રેખા પ્રતીક પર ક્્લલિક કરો.

6	 મા      ર્્ક ર સાથે લાઇન પર ક્્લલિક કરો

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No. •	 MS Office 2019 / નવીનતમ	          - 1 No.
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પરિણામ:

નોોંધ: ચાર્્ટ  શીર્્ષક પર ક્્લલિક કરીને શીર્્ષક દાખલ કરો. 
ઉદાહરણ તરીકે: વેચાણ અહેવાલ.

ચાર્્ટ નો પ્રકાર બદલો

તમે ટેબલ અથવા ચાર્્ટનો ઉપયોગ કરીને કોઈપણ સમયે એક અલગ 
પ્રકારના ચાર્્ટમાાં સરળતાથી બદલી શકો છો.

1	 ચાર્્ટ  પસંદ કરો.

2	 ચાર્્ટ  ડિઝાઇન ટેબ પર, પ્રકાર જૂથમાાં, ચાર્્ટ  પ્રકાર બદલો ક્્લલિક કરો.

3	 ડાબી બાજુએ, કૉલમ પર ક્્લલિક કરો.

4	 બરાબર ક્્લલિક કરો.

પરિણામ:

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.18.64
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લિજને્્ડ પોઝિશન

દંતકથાને ચાર્્ટની જમણી બાજુએ ખસેડવા માટે, નીચેના પગલાાંઓ ચલાવો.

1	 ચાર્્ટ  પસંદ કરો.

2	 ચાર્્ટની જમણી બાજુના + બટન પર ક્્લલિક કરો, Legend ની બાજુના 
તીરને ક્્લલિક કરો અને જમણે ક્્લલિક કરો.

પરિણામ:

કાર્્ય 2 : ચાર્્ટ  શીટ્સ બનાવો

અત્યાર સુધી, અમે સ્રોત ડેટા (એમ્્બબેડેડ ચાર્્ટટ્્સ) તરીકે સમાન વર્્ક શીટ પર 
માત્ર ચાર્્ટ  જોયા છે. જો કે, તમે ચાર્્ટને એક અલગ શીટમાાં પણ ખસેડી શકો 
છો જમેાાં માત્ર ચાર્્ટ  (ચાર્્ટ  શીટ) હોય.

ચાર્્ટને ચાર્્ટ  શીટમાાં ખસેડવા માટે, નીચેના પગલાાંઓ ચલાવો.

1	 ચાર્્ટ  પસંદ કરો.

2	 ચાર્્ટ  ડિઝાઇન ટેબ પર, સ્થાન જૂથમાાં, ચાર્્ટ  ખસેડો ક્્લલિક કરો.

મૂવ ચાર્્ટ  ડાયલોગ બોક્સ દેખાય છે.

3	 નવી શીટ પર ક્્લલિક કરો અને નામ દાખલ કરો.

4	 બરાબર ક્્લલિક કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.18.64
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પરિણામ

નોોંધ: આ પગલાાંઓનું પુનરાવર્્તન કરો, પરંતુ પગલું 3 પર નવી 
શીટને બદલે, ઑબ્્જજેક્ટ ઇન પર ક્્લલિક કરો, ચાર્્ટ ને સ્રોત ડેટાની 
સમાન વર્્ક શીટ પર પાછા ખસેડવા માટે.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.18.64
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IT & ITES	 	 એકસરસાાઈઝ 1.18.65
કોપા (COPA) - ચાર્્ટ  મેનેજ કરો	

ચાર્્ટ માાં ફેરફાર કરો (Modify charts) 
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંંતેે તમેે શીીખીી શકશોો
•	 ચાર્્ટ માાં ડેટા શ્રેણી ઉમેરો
•	 સ્ત્રોત ડેટામાાં પંક્્તતિઓ અને કૉલમ વચ્ચે સ્્વવિચ કરો
•	 ચાર્્ટ  ઘટકો ઉમેરો અને સશંોધિત કરો
•	 ચાર્્ટ માાં વલણ રેખાઓ ઉમેરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ચાર્્ટ માાં ડેટા શ્રેણી ઉમેરો

સંદર્્ભ - EX.1.18.64 - કાર્્ય 1 - આ કવાયત ચલાવવા માટે 
કોષ્્ટક અને ચાર્્ટ . 

1	 વર્્ક શીટ પર કે જમેાાં તમારો ચાર્્ટ  ડેટા છે, ચાર્્ટ  માટે તમારા હાલના સ્રોત 
ડેટાની બાજુમાાં અથવા નીચે આવેલા કોષોમાાં, તમે ઉમેરવા માાંગો છો તે 
નવી ડેટા શ્રેણી દાખલ કરો.

2	 વર્્ક શીટ પર ક્્લલિક કરો જમેાાં તમારો ચાર્્ટ  છે.

3	 ચાર્્ટ  પર જમણું-ક્્લલિક કરો, અને પછી ડેટા પસંદ કરો પસંદ કરો.

વર્્ક શીટ પર ડેટા સ્ત્રોત પસંદ કરો સંવાદ બોક્સ દેખાય છે જમેાાં ચાર્્ટ  માટેનો 
સ્રોત ડેટા હોય છે.

4	 નવી ડેટા શ્રેણી ઉમેરો, સંપાદિત કરો અને દૂર કરો એ ડેટા સ્ત્રોત પસંદ 
કરો સંવાદ બોક્સમાાં લિજને્્ડ એન્ટ્ રીઝ  (સિરીઝ) અને હોરિઝોન્ટલ 
(કેટેગ ry) એક્સિસ લેબલ્સ હેઠળ દેખાય છે.

5	 જરૂરી ફેરફારો પૂર્્ણ થયા પછી સંવાદ બોક્સ બંધ કરવા અને ચાર્્ટ  શીટ 
પર પાછા જવા માટે ઓકે ક્્લલિક કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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કાર્્ય 2 : સ્ત્રોત ડેટામાાં પંક્્તતિઓ અને કૉલમ્્સ વચ્ચે સ્્વવિચ કરો

સંદર્્ભ - EX.1.18.64 - કાર્્ય 1 - આ કસરત ચલાવવા માટે સમાન 
કોષ્્ટક અને ચાર્્ટ નો ઉપયોગ કરો.

જો તમે આડી અક્ષ પર વસ્્તતુઓ (મહિનાઓને બદલે) પ્રદર્શિત કરવા માાંગો 
છો, તો નીચેના પગલાાંઓ ચલાવો.

1	 ચાર્્ટ  પસંદ કરો.

2	 ચાર્્ટ  ડિઝાઇન ટેબ પર, ડેટા જૂથમાાં, સ્્વવિચ રો/કૉલમ પર ક્્લલિક કરો.

પરિણામ:

કાર્્ય 3 : ચાર્્ટ  ઘટકો ઉમેરો અને સશંોધિત કરો 

સંદર્્ભ - EX.1.18.64 - કાર્્ય 1 - આ કવાયત ચલાવવા માટે 
કોષ્્ટક અને ચાર્્ટ .

ચાર્્ટ  તત્્વવો

તમે તમારા વાચકોનું ધ્્યયાન એક ડેટા શ્રેણી અથવા ડેટા બિિંદુ પર કેન્દ્રિત 
કરવા માટે ડેટા લેબલનો ઉપયોગ કરી શકો છો.

1	 ચાર્્ટ  પસંદ કરો.

2	 ચાર્્ટની જમણી બાજુના + બટનને ક્્લલિક કરો અને ડેટા લેબલ્સ પાસેના 
ચેક બોક્સને ક્્લલિક કરો.

પરિણામ:
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કાર્્ય 4 : ચાર્્ટ માાં વલણ રેખાઓ ઉમેરો

સંદર્્ભ - EX.1.18.64 - કાર્્ય 1 - આ કસરત ચલાવવા માટે સમાન 
કોષ્્ટક અને ચાર્્ટ નો ઉપયોગ કરો.

1	 ચાર્્ટ  પસંદ કરો.

2	 ચાર્્ટની ઉપર જમણી બાજુએ + પસંદ કરો.

3	ટ્્રરે   ન્્ડલાઇન પસંદ કરો.

4	ટ્્રરે   ન્્ડલાઇન ઉમેરો સંવાદ બોક્સમાાં, કોઈપણ ડેટા પસંદ કરો તમને 
જોઈતા શ્રેણી વિકલ્્પપો, અને ઠીક ક્્લલિક  કરો.

પરિણામ:

ટ્્રરે ન્્ડલાઇન ફોર્મેટ કરો

1	 ચાર્્ટમાાં ગમે ત્યયાં ક્્લલિક કરો.

2	 ફોર્મેટ ટેબ પર, વર્્તમાન પસંદગી જૂથમાાં, ડ્્રરો પડાઉન સૂચિમાાં ટ્્રરે  ન્્ડલાઇન 
વિકલ્્પ પસંદ કરો.

3	 ફોર્મેટ પસંદગી પર ક્્લલિક કરો.

4	 ફોર્મેટ ટ્્રરે  ન્્ડલાઇન ફલકમાાં, તમે તમારા ચાર્્ટ  માટે ઇચ્છો તે ટ્્રરે  ન્્ડલાઇન 
પસંદ કરવા માટે ટ્્રરે  ન્્ડલાઇન વિકલ્્પ પસંદ કરો. ટ્્રરે  ન્્ડલાઇનનું ફોર્મેટ 
કરવું એ ડેટાને માપવાની આંકડાકીય રીત છે:

5	 તમારા ડેટાને ભવિષ્્યમાાં પ્રોજકે્ટ કરવા માટે ફોરવર્્ડ  અને બેકવર્્ડ  
ફીલ્્ડમાાં મૂલ્ય સેટ કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.18.65
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IT & ITES	 	 એકસરસાાઈઝ 1.18.66
કોપા (COPA) - ચાર્્ટ  મેનેજ કરો	

ચાર્્ટ માાં ફેરફાર કરો (Format charts)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ચાર્્ટ  લેઆઉટ લાગુ કરો
•	 ચાર્્ટ  શલૈીઓ લાગુ કરો
•	 સલુભતા માટે ચાર્્ટ માાં વકૈલ્્પપિક ટેક્સ્ટ ઉમેરો.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ચાર્્ટ  લેઆઉટ લાગુ કરો

સંદર્્ભ - EX.1.18.64 - કાર્્ય 1 - આ કસરત ચલાવવા માટે સમાન 
કોષ્્ટક અને ચાર્્ટ નો ઉપયોગ કરો.

1	 તમે જ ેચાર્્ટને ફોર્મેટ કરવા માાંગો છો તેને ક્્લલિક કરો.

	 આ ડિઝાઇન, લેઆઉટ અને ફોર્મેટ ટૅબ્્સ ઉમેરીને, ચાર્્ટ  ટૂલ્સ પ્રદર્શિત 
કરે છે.

2	ડિ ઝાઇન ટેબ પર, ચાર્્ટ  લેઆઉટ જૂથમાાં, તમે ઉપયોગ કરવા માાંગો છો 
તે ઝડપી લેઆઉટ પર ક્્લલિક કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

3	 તમે બનાવવા માાંગો છો તે કોઈપણ ચાર્્ટ  લેઆઉટ પસંદ કરો. 

4	 પરિણામ: લેઆઉટ5 પસંદ કર્્યુું

કાર્્ય 2 : ચાર્્ટ  શલૈીઓ લાગુ કરો

સંદર્્ભ - EX.1.18.64 - કાર્્ય 1 - આ કસરત ચલાવવા માટે સમાન 
કોષ્્ટક અને ચાર્્ટ નો ઉપયોગ કરો.

1	 તમે જ ેચાર્્ટને ફોર્મેટ કરવા માાંગો છો તેને ક્્લલિક કરો.

	 આ ડિઝાઇન, લેઆઉટ અને ફોર્મેટ ટૅબ્્સ ઉમેરીને, ચાર્્ટ  ટૂલ્સ પ્રદર્શિત 
કરે છે.

2	ડિ ઝાઇન ટેબ પર, ચાર્્ટ  શૈલી જૂથમાાં, તમે ઉપયોગ કરવા માાંગો છો તે 
ચાર્્ટ  શૈલી પર ક્્લલિક કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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3	 તમે બનાવવા માાંગો છો તે કોઈપણ ચાર્્ટ  શૈલી પસંદ કરો.

4	 પરિણામ: શૈલી 8 પસંદ કરી

કાર્્ય 3 : સલુભતા માટે ચાર્્ટ માાં વકૈલ્્પપિક ટેક્સ્ટ ઉમેરો

સંદર્્ભ - EX.1.18.64 - કાર્્ય 1 - આ કવાયતને ચલાવવા માટે 
સમાન કોષ્્ટક અને ચાર્્ટ નો ઉપયોગ કરો.

ચાર્્ટમાાં વૈકલ્્પપિક ટેક્સ્ટ ઉમેરો

1	 સમગ્ર ચાર્્ટ  પસંદ કરો.

2	 નીચેનામાાંથી એક કરો:

•	 Format > Alt Text પસંદ કરો.

•	 ચાર્્ટ  પર જમણંુ-ક્્લલિક કરો અને Alt ટેક્સ્ટ સંપાદિત કરો પસંદ 
કરો. 

3	 Alt ટેક્સ્ટ ફલકમાાં, ચાર્્ટનું વર્્ણન કરતું Alt ટેક્સ્ટ દાખલ કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.18.66
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IT & ITES	 	 એકસરસાાઈઝ 1.19.67
કોપા (COPA) - પિવટ કોષ્્ટકોનું સંચાલન કરો	

પીવટ કોષ્્ટકો બનાવો (Create Pivot Tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સેલ રેન્્જમાાંથી પિવટ કોષ્્ટકો બનાવો
•	 ઇચ્છિત વિશ્્લલેષણ મેળવવા માટે ફીલ્્ડડ્્સ (કૉલમ્્સ) ને મેનિપ્્યયુલેટ કરો
•	 પીવટ કોષ્્ટકો માટે ફિલ્ટર્્સનો ઉપયોગ કરો
•	 ગણતરી, સરવાળો, સરેરાશ અને પંક્્તતિ / કૉલમના % તરીકે ડેટા રજૂ કરે છે
•	 એકંદર અહેવાલો માટે કૉલમ અને પંક્્તતિઓમાાં જૂથ ડેટા.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સેલ રેન્્જમાાંથી પિવટ કોષ્્ટકો બનાવો

1	ન વી ફાઇલ ખોલો અને ફિગ 1 માાં બતાવ્્યયા પ્રમાણે અનુગામી કોષોમાાં 
ડેટા દાખલ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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2	 સક્રિય કોષ બનાવવા માટે કોષ્્ટકની અંદર A1 પર ક્્લલિક કરો.

3	  ટેબ                   પસંદ કરો.

4	 ફિગ 2 માાં બતાવ્્યયા પ્રમાણે બટન   જૂથ પર ક્્લલિક  
કરો.

“પિવોટ ટેબલ બનાવો” સંવાદ બોક્સ ફિગ 3 માાં બતાવ્્યયા 
પ્રમાણે ઓટો સિલકે્ટેડ ટેબલ રેન્્જ સાથે દેખાશે.

5	 ઉપરના ડાયલોગ બોક્સમાાં  બટન પર ક્્લલિક કરો.

	 વર્્ક બુકમાાં એક નવી વર્્કશ ીટ દેખાશે, જમેાાં ફિગ 4 માાં બતાવ્્યયા પ્રમાણે 
સ્ક્રીનની જમણી બાજુએ એક વિશિષ્્ટ ફલક હશે.

6	 “ટ્્રરેડ” ફીલ્્ડને ખેેંચો અન તેને ફલકની  નીચે મૂકો અને ફિગ 
5 માાં બતાવ્્યયા પ્રમાણે સ્ક્રીન દેખાશે.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.19.67
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7	 “નામ” ફીલ્્ડને ખેેંચો અને તેને ફલકની નીચે  મૂકો અને 
સ્ક્રીન 6 માાં બતાવ્્યયા પ્રમાણે તેનો દેખાવ બદલે છે.

8	 “ટ્રેે�ડ” ફીીલ્ડનેે ખેંંચોો અનેે તેેનેે ફલકનીી બહાાર મૂૂકોો.

9	 “ક્્વવોલી” ફીલ્્ડને ખેેંચો અને તેને ફલકની નીચે  મૂકો.  

10	 “નામ” ફીલ્્ડ અને “ઉંમર” ફીલ્્ડને ખેેંચો અને તેને  પેન 
હેઠળ મૂકો. 

કાર્્ય 2 : ઇચ્છિત વિશ્્લલેષણ મેળવવા માટે ફીલ્્ડડ્્સ (કૉલમ્્સ) ને મેનિપ્્યયુલેટ કરો

1	રિ બન પર PivotTable Tools અને Analyze>Field List પર ક્્લલિક 
કરો.

2	 ફીલ્્ડ લિસ્ટમાાં ફીલ્્ડ સેક્શન હોય છે જમેાાં તમે તમારા પીવટ ટેબલમાાં 
જ ેફીલ્્ડડ્્સ બતાવવા માાંગો છો તે પસંદ કરો છો અને એરિયાઝ સેક્શન 
(નીચે) જમેાાં તમે તે ફીલ્્ડડ્્સને તમે ઇચ્છો તે રીતે ગોઠવી શકો છો.
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3	 જો તમે ક્ષેત્ર સૂચિમાાં વિભાગો કેવી રીતે બતાવવામાાં આવે છે તે બદલવા 
માાંગતા હો, તો ટૂલ્સ બટનને   ક્્લલિક કરો અને પછી તમને 
જોઈતો લેઆઉટ પસંદ કરો.    

ફીલ્્ડ લિસ્ટમાાં ફીલ્્ડડ્્સ ઉમેરો, ફરીથી ગોઠવો અને કાઢી નાખો

1	તમ ારા પીવટ ટેબલમાાં ફીલ્્ડડ્્સ ઉમેરવા માટે ફીલ્્ડ લિસ્ટના ફીલ્્ડ 
સેક્શનનો ઉપયોગ કરો, ફીલ્્ડ લિસ્ટના ડિફોલ્ટ એરિયામાાં તે ફીલ્્ડડ્્સને 
મૂકવા માટે ફીલ્્ડના નામની બાજુના બોક્સને ચેક કરીને.

નોોંધ: સામાન્ય રીતે, બિનસખં્યાત્મક ક્ષેત્રો પંક્્તતિઓ ક્ષેત્રમાાં 
ઉમેરવામાાં આવે છે, સખં્યાત્મક ક્ષેત્રો મૂલ્યોના ક્ષેત્રમાાં ઉમેરવામાાં 
આવે છે, અને ઑનલાઇન વિશ્્લલેષણાત્મક પ્રક્રિયા (OLAP) 
તારીખ અને સમય વશંવેલો કૉલમ વિસ્્તતારમાાં ઉમેરવામાાં આવે 
છે.

2	 ક્ષેત્રોન ચાર ક્ષેત્રોની વચ્ચે ખેેંચીને તમે ઇચ્છો તે રીતે ક્ષેત્રોને ફરીથી 
ગોઠવવા માટે ફીલ્્ડ લિસ્ટના વિસ્્તતાર વિભાગનો ઉપયોગ કરો.

3	 ક્ષેત્રો કે જ ેતમે જુદા જુદા વિસ્્તતારોમાાં મૂકો છો તે પીવટ ટેબલમાાં નીચે 
પ્રમાણે બતાવવામાાં આવે છે:

•	 ફિલ્ટર ક્ષેત્ર ફીલ્્ડડ્્સ પિવટ ટેબલની ઉપરના ટોચના સ્્તરના રિપોર્્ટ  
ફિલ્ટર્્સ તરીકે બતાવવામાાં આવે છે, આના જવેું:

•	 કૉલમ વિસ્્તતાર ફીલ્્ડડ્્સ પિવટ ટેબલની ટોચ પર કૉલમ લેબલ્સ 
તરીકે બતાવવામાાં આવે છે, જમે કે:

4	 ફીલ્્ડડ્્સના વશંવેલાના આધારે, કૉલમ્્સ કૉલમ્્સની અંદર નેસ્ટ કરી 
શકાય છે જ ેપોઝિશનમાાં ઉચ્ચ હોય છે.

•	 પંક્્તતિઓ ક્ષેત્ર ફીલ્્ડડ્્સ PivotTable ની ડાબી બાજુએ રો લેબલ્સ 
તરીકે બતાવવામાાં આવે છે, જમે કે:

5	 ફીલ્્ડના વશંવેલાના આધારે, પંક્્તતિઓ એવી પંક્્તતિઓની અંદર નેસ્ટ 
કરી શકાય છે જ ેપોઝિશનમાાં ઊંચી હોય છે.

•	 મૂલ્યો ક્ષેત્ર ક્ષેત્રો પિવટ ટેબલમાાં સારાાંશ આંકડાકીય મૂલ્યો તરીકે 
દર્શાવવામાાં આવે છે, જમે કે:
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જો તમારી પાસે એક વિસ્્તતારમાાં એક કરતાાં વધુ ફીલ્્ડ છે, તો તમે ફીલ્્ડડ્્સને 
તમને જોઈતી ચોક્કસ સ્થિતિમાાં ખેેંચીને ઓર્્ડ રને ફરીથી ગોઠવી શકો છો.

6	 PivotTable માાંથી ફીલ્્ડ કાઢી નાખવા માટે, ફીલ્્ડને તેના વિસ્્તતાર 
વિભાગની બહાર ખેેંચો. તમે ફીલ્્ડની પાસેના ડાઉન એરો પર ક્્લલિક 
કરીને અન પછી ફીલ્્ડ દૂર કરો પસંદ કરીને ફીલ્્ડડ્્સને પણ દૂર કરી શકો 
છો.

કાર્્ય 3 : પિવટ કોષ્્ટકો માટે ફિલ્ટર્્સનો ઉપયોગ કરો

1	 Task I માાંથી સ્ટેપ્સ 6 અને 7 ને પુનરાવર્તિત કરો અથવા તે જ કોષ્્ટકનો 
ઉપયોગ કરો.

2	ન જીકના ડ્્ર રોપ ડાઉન એરો  પર ક્્લલિક કરો 

એક સંદર્્ભ મેનૂ દેખાશે.

3	ન ામને વિપરીત રીતે ગોઠવવા માટે પસંદ કરો.

તમે નામોને અહીીં અને ત્યયાં ખેેંચીને મેન્યુઅલી પણ ઓર્્ડ ર બદલી 
શકો છો

4 	ત ેની નજીકના ચેક બોક્સ પર ક્્લલિક કરીને કેટલાક વેપારના નામની 
પસંદગી હટાવો. 

હવે વર્્ક શીટ દેખાશે.

5	 MMV જૂથની વિગતો જોવા માટે, B4 પર ડબલ ક્્લલિક કરો.
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કાર્્ય 4 : ગણતરી, સરવાળો, સરેરાશ અને પંક્્તતિ / કૉલમના % તરીકે ડેટાનું પ્રતિનિધિત્્વ કરો

સ્ક્રીનનો દેખાવ. 

અહીીં એક્સેલ દરેક લાયકાત હેઠળની વ્્યક્્તતિઓની સખં્યા 
શોધવા માટે “કાઉન્ટ” ફંક્શનનો ઉપયોગ કરે છે અને દરેક 
લાયકાત હેઠળની વ્્યક્્તતિઓની ઉંમર ઉમેરવા માટે “સમ” 
ફંક્શનનો ઉપયોગ કરે છે.

1	 “સમનો સરવાળો” શબ્દ પર ડબલ ક્્લલિક કરો.

એક “વેલ્યુ ફિલ્્ડ સેટિિંગ” સંવાદ બોક્સ દેખાશે.

2	 ન્યૂનતમ વિકલ્્પ પસંદ કરો અને  દબાવો 
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હવે તે દરેક લાયકાત હેઠળ આવતી લઘુત્તમ વય દર્શાવશે. 3	શ બ્દ “મિન ઓફ એજ” પર ડબલ ક્્લલિક કરો.

4	 સરેરાશ વિકલ્્પ પસંદ કરો અને દબાવો .

હવે તે દરેક લાયકાત હેઠળની સરેરાશ ઉંમર દર્શાવશે.
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5	 c5 થી c8 પસંદ કરો.

6	મ ાઉસનું જમણું બટન ક્્લલિક કરો.

મિની ટૂલબાર બટનો સ્ક્રીન પર દેખાશે.

7	 ઓછા દશાાંશ સ્થાનો બતાવવા માટે “દશાાંશ ઘટાડો” પસંદ કરો.

કાર્્ય 5 : એકંદર અહેવાલો માટે કૉલમ અને પંક્્તતિઓમાાં જૂથ ડેટા 

પિવટ કોષ્્ટકમાાં આઇટમ્્સનું જૂથ કરો
ગ્રૂપિિંગ તમન ડેટાનું સ્્પષ્્ટ દૃશ્્ય મેળવવામાાં મદદ કરી શકે છે અને તમે 
જનેું પૃથ્્થકરણ કરવા માાંગો છો તે જ ડેટા બતાવી શકે છે. પીવટ કોષ્્ટકમાાં 
તારીખો, સખં્યાઓ અથવા પસંદ કરેલી વસ્્તતુઓને કેવી રીતે જૂથબદ્ધ કરવી 
તે નીચનેો વિષય વર્્ણવે છે.
તારીખ દ્વારા પિવટ કોષ્્ટકનું જૂથ બનાવો
1	ત ારીખો ધરાવતી પંક્્તતિ અથવા કૉલમ ફીલ્્ડમાાં કોષ પર જમણું-ક્્લલિક 

કરો અને જૂથ પસંદ કરો.

	અ થવા PivotTable Tools પર | વિશ્્લલેષણ ટેબ, જૂથમાાં, જૂથ ક્ષેત્ર 
બટનને ક્્લલિક કરો.

2	 ગ્રુપિિંગ ડાયલોગ બોલાવવામાાં આવે છે. તમે જ ે પ્રથમ અને છેલ્્લલી 
તારીખ અથવા સમય અનુસાર જૂથ કરવા માાંગો છો તે ટાઇપ કરો, જૂથ 
કરવા માટે એક અથવા વધુ તારીખ અથવા સમય અતંરાલ પસંદ કરો 
અને ઠીક ક્્લલિક કરો.
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3	 પરિણામે, તારીખ ફીલ્્ડ નીચેની છબીમાાં બતાવ્્યયા પ્રમાણે જૂથબદ્ધ 
કરવામાાં આવશે.

પીવટ કોષ્્ટકને સખં્યાઓ દ્વારા જૂથબદ્ધ કરો

1	 પંક્્તતિ અથવા કૉલમ ફીલ્્ડમાાં સખં્યાત્મક મૂલ્યો ધરાવતા કોષ પર 
જમણું-ક્્લલિક કરો અને જૂથ પસંદ કરો.

	અ થવા PivotTable Tools પર | વિશ્્લલેષણ ટેબ, જૂથમાાં, જૂથ ક્ષેત્ર 
બટનને ક્્લલિક કરો.click the Group Field button.

2	 ગ્રુપિિંગ ડાયલોગ બોલાવવામાાં આવે છે. સ્ટાર્્ટ  વેલ્યુ, એન્્ડ વેલ્યુ, 
ઈન્ટરવલ ટાઈપ કરો અને ઓકે ક્્લલિક કરો.

3	 પરિણામ નીચનેી છબીમાાં બતાવેલ છે.

જૂથ પસંદ કરેલી વસ્્તતુઓ

1	તમ ે જૂથ કરવા માાંગો છો તે વસ્્તતુઓ પસંદ કરો.

2	 પસંદ કરેલ શ્રેણી પર જમણું-ક્્લલિક કરો અને સંદર્્ભ મેનૂમાાંથી જૂથ 
આઇટમ પસંદ કરો.

	અ થવા PivotTable Tools પર | વિશ્્લલેષણ ટેબ, જૂથમાાં, જૂથ પસંદગી 
બટનને ક્્લલિક કરો.

3	 પરિણામે, પસંદ કરેલ શ્રેણીને એક જૂથમાાં જોડવામાાં આવશે. જૂથનું નામ 
બદલવા માટે, જૂથ હેડર પસંદ કરો, F2 દબાવો અને જરૂરી નામ લખો.
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4	તમ ે બનાવેલ જૂથ માટે પેટાસરવાળો દર્શાવવાનું સક્ષમ અથવા અક્ષમ 
પણ કરી શકો છો. તે કરવા માટે, ગ્રુપ હેડર પર જમણું-ક્્લલિક કરો અને 
સબટોટલ ‘ફિલ્્ડ નેમ’ આઇટમ પસંદ કરો.

5	 પરિણામી અહેવાલ નીચેની છબીમાાં દર્શાવેલ છે.

ડેટા અનગ્રુપ કરો

પિવટ કોષ્્ટકમાાં ડેટાને જૂથમાાંથી બહાર કાઢવા માટે, નીચેનામાાંથી એક કરો.

•	 જૂથબદ્ધ ફીલ્્ડ પર જમણું-ક્્લલિક કરો અને સંદર્્ભ મેનૂમાાંથી અનગ્રુપ... 
પસંદ કરો.

•	 જૂથબદ્ધ ફીલ્્ડમાાં અન પીવટ ટેબલ ટૂલ્સ | પર કોઈપણ કોષ પસંદ કરો 
વિશ્્લલેષણ ટૅબ, જૂથમાાં, અનગ્રુપ બટનને ક્્લલિક કરો.

નોોંધ કરો કે આકંડાકીય અથવા તારીખ અને સમય ફીલ્્ડને 
જૂથમાાંથી બહાર કાઢવાથી તે ક્ષેત્ર માટેના તમામ જૂથો દૂર થઈ 
જશે. જો તમે પસંદ કરેલી આઇટમના જૂથને અનગ્રુપ કરો છો, 
તો માત્ર પસંદ કરેલી આઇટમ્્સ જ અનગ્રુપ કરવામાાં આવશે.
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IT & ITES	 	 એકસરસાાઈઝ 1.20.68
કોપા (COPA) - પાવર પોઈન્ટ પ્રેઝન્ટેશન	

MS PowerPoint માાં ફાઇલો ખોલો (Open files in MS PowerPoint)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 MS PowerPoint ખોલો
•	 નવી પાવરપોઈન્ટ ફાઈલ બનાવો
•	 ટેમ્્પલેટમાાંથી નવી પાવરપોઈન્ટ ફાઈલ બનાવો
•	 હાલની પાવરપોઈન્ટ ફાઈલ ખોલો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : MS પાવરપોઈન્ટ ખોલો

1	 Windows Start Button > Choose PowerPoint પસંદ કરો.

	અ થવા Ctrl + R  > Type POWERPNT > Click ઓકે ક્્લલિક કરો

2	મ ાઈક્રોસોફ્ટ પાવર પોઈન્ટ એપ્્લલિકેશન ખોલવાનું શરૂ થશે.  

કાર્્ય 2 : નવી પાવરપોઈન્ટ ફાઈલ બનાવો

એક પ્રસ્્તતુતિ બનાવો

1	 પાવરપોઈન્ટ ખોલો.

2	 ડાબી તકતીમાાં, નવું પસંદ કરો અથવા Ctrl+N દબાવો.

3	 વિકલ્્પ પસંદ કરો:

•	શ રૂઆતથી પ્રસ્્તતુતિ બનાવવા માટે, ખાલી પ્રસ્્તતુતિ પસંદ કરો. 

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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4	 મૂળભતૂ રીતે, શીર્્ષક સ્્લલાઇડ દેખાશે પછી શીર્્ષક અને ઉપશીર્્ષક 
લખવાનું શરૂ કરો. 

તમારી વર્્ક બકુ સાચવો

તમે તમારા કમ્્પ્યયુટર અથવા વેબ પર જ્યયાં પણ તમારી પ્રસ્્તતુતિને સાચવવા 
માાંગતા હો, ત્યયાં તમે ફાઇલ ટેબ પર તમારી File tab > Save અથવા 
પ્રથમ વખત સાચવવા માટે Ctrl+S દબાવો અથવા તમારે તમારી હાલની 
પ્રસ્્તતુતિને અલગ સ્થાને સાચવવા માટે Save As નો ઉપયોગ કરવાની જરૂર 
છે. , અથવા તે જ અથવા અન્ય સ્થાને તમારી પ્રસ્્તતુતિની નકલ બનાવવા 
માટે.

1	 File tab > Save અથવા પ્રથમ વખત સાચવવા માટે Ctrl+S દબાવો 

2	લ ોકલ ડ્્ર રાઇવ બ્રાઉઝ કરવા માટે સ્થાન અથવા વધુ વિકલ્્પ પસંદ કરો. 

3	તમ ે જ્યયાં સાચવવા માાંગો છો તે સ્થાન બ્રાઉઝ કરો અને ફાઇલને નામ 
આપો અને ફાઇલ પ્રકાર પસંદ કરો. PPTX પછી સાચવો પર ક્્લલિક 
કરો. 

તમારી વર્્ક બકુ તરીકે સાચવો

1	 Click File > Save As.

2	 Save As હેઠળ, તમે જ્યયાં તમારી વર્્ક બુક સાચવવા માાંગો છો તે 
સ્થાન પસંદ કરો. ઉદાહરણ તરીકે, તમારા ડેસ્કટૉપ પર અથવા તમારા 
કમ્્પ્યયુટર પરના ફોલ્્ડરમાાં સાચવવા માટે, આ PC પર ક્્લલિક કરો.
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3	તમ ારા દસ્્તતાવેજ ફોલ્્ડરમાાં તમને જોઈતું સ્થાન શોધવા માટે બ્રાઉઝ 
કરો ક્્લલિક કરો.

4	 ફાઇલ નામ બોક્સમાાં, નવી પ્રસ્્તતુતિ માટે નામ દાખલ કરો. જો તમે 
હાલની પ્રેઝન્ટેશનની કૉપિ બનાવી રહ્યયાં હોવ તો અલગ નામ દાખલ 
કરો.

5	તમ ારી પ્રસ્્તતુતિને અલગ ફાઇલ ફોર્મેટમાાં (જ ેમ કે .pdf અથવા .ppsx) 
સાચવવા માટે, સેવ એઝ ટાઈપ લિસ્ટમાાં (ફાઈલ નામ બોક્સ હેઠળ), 
તમને જોઈતું ફોર્મેટ પસંદ કરો.

6	 સાચવો પર ક્્લલિક કરો

કાર્્ય 3 : ટેમ્્પલેટમાાંથી નવી પાવરપોઈન્ટ ફાઈલ બનાવો 

નમૂનામાાંથી પ્રેઝન્ટેશન બનાવો

1	 Select File > New.

2	 વધુ નમૂનો પસંદ કરો

3	 ઉપલબ્ધ નમૂનામાાંથી શોધો અથવા પસંદ કરો.

4	 ટેમ્્પલેટ પસંદ કરો અને બનાવો પર ક્્લલિક કરો
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5	 ટેમ્્પલેટમાાંથી ટેક્સ્ટને ક્્લલિક કરો અને એડિટ કરો.

કાર્્ય 4 : હાલની પાવરપોઈન્ટ ફાઈલ ખોલો 

હાલની પ્રેઝન્ટેશન ખોલો

1	 ફાઇલ ટેબ પર ક્્લલિક કરો.

2	ખ ોલો ક્્લલિક કરો.
	 Ctrl + O દબાવો.
	 ઓપન સ્ક્રીન દેખાય છે અને તમને ખોલવા માટે પ્રસ્્તતુતિ શોધવાની 

કેટલીક રીતો આપે છે.
3	ત  સ્થાન પસંદ કરો જ્યયાં ફાઇલ સાચવેલ છે.

•	ત ાજતેરની પ્રસ્્તતુતિઓની સૂચિ દર્શાવે છે જ ેતમે તાજતેરમાાં ખોલી 
છે.

•	મ ારી સાથે શેર કરેલ ફાઇલો અન્ય લોકોએ તમારી સાથે One 
Drive અથવા Share Point Online પર શેર કરી છે તે દર્શાવે 
છે.

•	 OneDrive અને/અથવા SharePoint તમને આ ક્્લલાઉડ 
સેવાઓ પર સંગ્રહિત તમારી ફાઇલોને બ્રાઉઝ કરવા દે છે, જો 
તમારી પાસે તે હોય.

•	 આ PC તમને ફાઇલો ખોલવા માટે તમારા દસ્્તતાવેજ ફોલ્્ડર 
મારફતે બ્રાઉઝ કરવા દે છે.

•	 બ્રાઉઝ કરવાથી એક સંવાદ બોક્સ ખલુે છે, જ્યયાં તમે તમારા 
કમ્્પ્યયુટરના ફોલ્્ડર્્સ, ડ્્ર રાઇવ્્સ અને નેટવર્્ક  શેર્્સ દ્વારા બ્રાઉઝ કરી 
શકો છો.

4	તમ ે ખોલવા માાંગો છો તે ફાઇલને શોધો અને ડબલ-ક્્લલિક કરો.
	 પ્રસ્્તતુતિ PowerPoint માાં ખલુે છે અને તમે સંપાદનો કરવાનું શરૂ કરી 

શકો છો.
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IT & ITES	 	 એકસરસાાઈઝ 1.20.69
કોપા (COPA) - પાવર પોઈન્ટ પ્રેઝન્ટેશન	

પાવરપોઈન્ટ પ્રસ્્તતુતિઓ ફોર્મેટ કરો (Format Power Point Presentations)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સ્્લલાઇડ્સ ઉમેરો, ટાઇટલ અને ટેક્સ્ટ ઉમેરો
•	 સ્્લલાઇડ લેઆઉટ પસંદ કરો
•	 પાવરપોઈન્ટ ટેમ્્પલેટ ઉમેરો
•	 ડુપ્્લલિકેટ સ્્લલાઇડ્સ.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સ્્લલાઇડ્સ ઉમેરો 

1	તમ  તમારી નવી સ્્લલાઇડને અનુસરવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

2	 Home > New Slide અથવા Ctrl M પસંદ કરો.

3	 ટાઇલ અને સામગ્રી સ્્લલાઇડ લેઆઉટ પસંદ કરો અને જ્યયાં પણ તેની 
જરૂર હોય ત્યયાં સંબંધિત અન્ય લેઆઉટ  પસંદ કરો.

4	 પછી ટેક્સ્ટ બોક્સ પસંદ કરો અને પ્રસ્્તતુતિની આવશ્્યક સામગ્રી ટાઇપ 
કરો. 

કાર્્ય 2 : શીર્્ષકો અને ટેક્સ્ટ ઉમેરો

1	અ ગાઉની કવાયત અને કાર્યોમાાંથી ટેક્સ્ટને ટેક્સ્ટ બોક્સમાાં ઉમેરો 
જ્યયાં તે ઉપલબ્ધ હોય ત્યયાં શીર્્ષક ઉમેરવા માટે ક્્લલિક કરો અને શીર્્ષક 
સ્્લલાઇડમાાં સબટાઈટલ ઉમેરવા માટે ક્્લલિક કરો:

•	 MS Office 2019 / નવીનતમ	          - 1 No.

2	શ ીર્્ષક ઉમેરવા ક્્લલિક કરો અને ટેક્સ્ટ સામગ્રી સ્્લલાઇડ ઉમેરવા માટે 
ક્્લલિક કરો.  
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કાર્્ય 3 : સ્્લલાઇડ લેઆઉટ પસંદ કરો
સ્્લલાઇડ લેઆઉટ બદલો

જો તમને નવી સ્્લલાઇડને ડિફૉલ્ટ રૂપે સોોંપવામાાં આવેલ લેઆઉટ પસંદ ન 
હોય, તો એક નવું પસંદ કરો. PowerPoint તમને પસંદ કરવા માટે નવ 
જુદા જુદા લેઆઉટ આપે છે અને તમે તમારા પોતાના કસ્ટમ લેઆઉટ પણ 
બનાવી શકો છો.

1	 પસંદ કરેલ સ્્લલાઇડ સાથે, સ્્લલાઇડ્સ જૂથમાાં સ્્લલાઇડ લેઆઉટ બટનને 
ક્્લલિક કરો.

2	ન વો લેઆઉટ પસંદ કરો.

પ્રેઝન્ટેશનમાાં પસંદ કરેલ લેઆઉટ સાથે નવી સ્્લલાઇડ દાખલ કરવામાાં 
આવી છે.
3	શ ીર્્ષક પ્્લલેસહોલ્્ડરમાાં ક્્લલિક કરો અને તમારુું  લખાણ લખો.
4	 સામગ્રી પ્્લલેસહોલ્્ડરમાાં ક્્લલિક કરો અને તમારુું  ટેક્સ્ટ ટાઇપ કરો.
5	ગ્રાફિ ક પ્રકાર પસંદ કરો અને ઇચ્છિત ગ્રાફિક દાખલ કરો.
જો તમે પછીથી લેઆઉટ બદલવાનું નક્કી કરો છો, તો નવા લેઆઉટ 
અનુસાર ટેક્સ્ટ અને ચિત્રો આપમેળે ખસેડવામાાં આવશે અને તેનું કદ 
બદલાશે.

કાર્્ય 4 : પાવરપોઈન્ટ ટેમ્્પલેટ્સ ઉમેરો

EX.1.20.68 - કાર્્ય 3 નો સંદર્્ભ લો

કાર્્ય 5 : ડુપ્્લલિકેટ સ્્લલાઇડ્સ 

ડુપ્્લલિકેટ સ્્લલાઇડ્સ

1	તમ ે ડુપ્્લલિકેટ કરવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

2	ન વી સ્્લલાઇડ યાદી તીર પર ક્્લલિક કરો.

3	 ડુપ્્લલિકેટ પસંદ કરેલ સ્્લલાઇડ્સ પસંદ કરો.

એક સ્્લલાઇડ કૉપિ કરો

જો તમે પ્રેઝન્ટેશનમાાં બીજા સ્થાને નકલ બનાવવા માાંગતા હો, તો તેના બદલે 
કૉપિ અને પેસ્ટનો ઉપયોગ કરો.

1	તમ ે કૉપિ કરવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

2	 હોમ ટેબ પર કોપી બટન પર ક્્લલિક કરો.

	 Ctrl + C દબાવો.

3	 થંબનેલ્સ ફલકમાાં નવા સ્થાન પર ક્્લલિક કરો જ્યયાં તમે નકલ મૂકવા 
માાંગો છો.

4	 પેસ્ટ બટન પર ક્્લલિક કરો.

	 Ctrl + V દબાવો.

Ctrl + D દબાવો અથવા સ્્લલાઇડ પર જમણું-ક્્લલિક કરો અને ડુપ્્લલિકેટ 
સ્્લલાઇડ પસંદ કરો.

સ્્લલાઇડ ડુપ્્લલિકેટ છે અને મૂળ સ્્લલાઇડની બરાબર પછી સ્થિત છે.
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© NIMI 

NOT TO BE REPUBLISHED



260

IT & ITES	 	 એકસરસાાઈઝ 1.20.70
કોપા (COPA) - પાવર પોઈન્ટ પ્રેઝન્ટેશન	

સ્્લલાઇડ માસ્ટર્્સ, હેન્્ડઆઉટ માસ્ટર્્સ અને નોટ માસ્ટર્્સમાાં ફેરફાર કરો (Modify slide masters, 
handout masters, and note masters)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સ્્લલાઇડ માસ્ટર થીમ અથવા બેકગ્રાઉન્્ડ બદલો
•	 સ્્લલાઇડ માસ્ટર સામગ્રીને સશંોધિત કરો
•	 સ્્લલાઇડ લેઆઉટને સશંોધિત કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સ્્લલાઇડ માસ્ટર થીમ અથવા પૃષ્્ઠભમૂિ બદલો 

1	 વ્્યયુ ટેબ પર, સ્્લલાઇડ માસ્ટર પર ક્્લલિક કરો. સ્્લલાઇડ માસ્ટર વ્્યયૂમાાં, 
સ્્લલાઇડ માસ્ટર તેની નીચે સંબંધિત લેઆઉટ સાથે થંબનેલ ફલકની 
ટોચ પર દેખાય છે.

શીર્્ષક સ્્લલાઇડ:

શીર્્ષક અને સામગ્રી સ્્લલાઇડ:

2	મ ાસ્ટર સ્્લલાઇડ પસંદ કરવા માટે ક્્લલિક કરો અને પછી સ્્લલાઇડ માસ્ટર 
ટેબ પર માસ્ટર લેઆઉટ પર ક્્લલિક કરો.

3	 સ્્લલાઇડ માસ્ટર પર શીર્્ષક, ટેક્સ્ટ, તારીખ, સ્્લલાઇડ નંબર્્સ અથવા ફૂટર 
પ્્લલેસહોલ્્ડર્્સ બતાવવા અથવા છુપાવવા માટે, બતાવવા માટે બોક્સને 
ચેક કરો અથવા પ્્લલેસહોલ્્ડર્્સને છુપાવવા માટે બોક્સ સાફ કરો.

4	 પૃષ્્ઠભૂમિ શૈલી બદલવા માટે, પૃષ્્ઠભૂમિ શૈલીઓ પર ક્્લલિક કરો, અને 
પછી પૃષ્્ઠભૂમિ શૈલી પસંદ કરો.

5	 પૃષ્્ઠભૂમિની ભરણને સશંોધિત કરવા માટે ફોર્મેટ પૃષ્્ઠભૂમિ પસંદ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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6	 સ્્લલાઇડ માસ્ટર ટેબ પર, માસ્ટર વ્્યયૂ બંધ કરો પર ક્્લલિક કરો.

કાર્્ય 2 : સ્્લલાઇડ માસ્ટર સામગ્રીમાાં ફેરફાર કરો

સ્્લલાઇડ માસ્ટર બદલો

1	 View > Slide Master. પસંદ કરો.

2	તમન ે જોઈતા ટેક્સ્ટ, રંગ અને ગોઠવણીમાાં ફેરફાર કરો.

	 જો તમે પૂર્્વવ્્યયાખ્યાયિત થીમનો ઉપયોગ કરવા માાંગતા હો, તો સ્્લલાઇડ 
માસ્ટર ટેબ પર થીમ્્સ પર ક્્લલિક કરીને પહેલા તેને પસંદ કરો. પછી 
રંગો, ફોન્્ટ્્સ, ઇફેક્્ટ્્સ અને બેકગ્રાઉન્્ડ સ્ટાઇલ પસંદ કરવાનું આગળ 
વધો.

રંગ:

ફોન્્ટ્્સ:

અસર:

3	જ્યા રે તમે પૂર્્ણ કરી લો, ત્યારે માસ્ટર વ્્યયૂ બંધ કરો પસંદ કરો

કાર્્ય 3 : સ્્લલાઇડ લેઆઉટમાાં ફેરફાર કરો

1	 સ્્લલાઇડ માસ્ટર વ્્યયૂ ખોલો, વ્્યયૂ ટેબ પર, સ્્લલાઇડ માસ્ટર પસંદ કરો:

2	 Slide master > Layout masters > Choose Layout પસંદ કરો 
અને દાખલ કરો અથવા ફેરફાર કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.20.71
કોપા (COPA) - પાવર પોઈન્ટ પ્રેઝન્ટેશન	

પ્રસ્્તતુતિ વિકલ્્પપો અને દૃશ્્યયો બદલો (Change presentation options and views)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સ્્લલાઇડનું કદ બદલો
•	વિવિ ધ દૃશ્્યયોમાાં પ્રસ્્તતુતિઓ પ્રદર્શિત કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સ્્લલાઇડનું કદ બદલો 

સ્્લલાઇડનું કદ બદલો

1	 ડિઝાઇન ટેબ પર, એકદમ જમણી બાજુએ કસ્ટમાઇઝ જૂથમાાં, સ્્લલાઇડ 
સાઈઝ પર ક્્લલિક કરો.

2	 કસ્ટમ સ્્લલાઇડ માપ પર ક્્લલિક કરો.

3	ય ાદી માટે માપવાળી સ્્લલાઇડ્સમાાં, તમે ઉપયોગ કરવા માાંગો છો તે કદ 
પર ક્્લલિક કરો અથવા કસ્ટમ માપ પસંદ કરવા માટે પહોળાઈ અને 
ઊંચાઈ બોક્સનો ઉપયોગ કરો.

4	 બરાબર ક્્લલિક કરો.

5	 પાવરપોઈન્ટ હવે તમને નવા લેઆઉટ પર તમારી સામગ્રીના કદને 
મહત્તમ કરવા (આ કરવા માટે, મહત્તમ પર ક્્લલિક કરો) અથવા તેને નીચું 
સ્કેલ કરવા માટે પૂછે છે જથેી બધી સામગ્રી નવા લેઆઉટમાાં બંધબેસે 
(આ કરવા માટે, ખાતરી કરો પર ક્્લલિક કરો).

નોોંધ: જો તમે મહત્તમ કરવાનંુ પસંદ કરો છો, તો કેટલીક સામગ્રી 
પ્રિન્ટ માર્જિનની બહાર આવી શકે છે.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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કાર્્ય 2 : વિવિધ દૃશ્્યયોમાાં પ્રસ્્તતુતિઓ દર્શાવો

તમે તમારી પાવરપોઈન્ટ ફાઇલને વિવિધ રીતે જોઈ શકો છો. જ્યારે તમે 
તમારી પ્રેઝન્ટેશન બનાવતા હોવ ત્યારે કેટલાક દૃશ્્યયો મદદરૂપ થાય છે, અને 
કેટલાક તમારી પ્રસ્્તતુતિ પહોોંચાડવા માટે સૌથી વધુ મદદરૂપ હોય છે.

નીચે બતાવ્્યયા પ્રમાણે તમે વ્્યયૂ ટેબ પર પાવરપોઈન્ટ વ્્યયૂના વિવિધ વિકલ્્પપો 
શોધી શકો છો.
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નીચે બતાવ્્યયા પ્રમાણે, તમે સ્્લલાઇડ વિન્્ડડોની નીચે જમણી બાજુએ ટાસ્ક બાર 
પર સૌથી વધુ ઉપયોગમાાં લેવાતા દૃશ્્યયો પણ શોધી શકો છો.

તમારી પ્રસ્્તતુતિ બનાવવા માટેના દૃશ્્યયો

સામાન્ય દૃશ્્ય

તમે સ્્લલાઇડ વિન્્ડડોની નીચે ટાસ્ક બાર  માાંથી અથવા રિબન પરના વ્્યયૂ 
ટેબમાાંથી સામાન્ય દૃશ્્ય પર પહોોંચી શકો છો.

સામાન્ય દૃશ્્ય એ એડિટિિંગ મોડ છે જ્યયાં તમે તમારી સ્્લલાઇડ્સ બનાવવા 
માટે વારંવાર કામ કરશો. નીચે, સામાન્ય દૃશ્્ય ડાબી બાજુએ સ્્લલાઇડ 
થંબનેલ્સ પ્રદર્શિત કરે છે, વર્્તમાન સ્્લલાઇડ દર્શાવતી મોટી વિન્્ડડો અને 
વર્્તમાન સ્્લલાઇડની નીચેનો વિભાગ જ્યયાં તમે તે સ્્લલાઇડ માટે તમારી સ્્પપીકર 
નોોંધો ટાઇપ કરી શકો છો.

સ્્લલાઇડ સોર્્ટર દૃશ્્ય

તમ સ્્લલાઇડ વિન્્ડડોની નીચે ટાસ્ક બાર  માાંથી અથવા રિબન પરના વ્્યયૂ 
ટેબમાાંથી સ્્લલાઇડ સોર્્ટર વ્્યયૂ પર જઈ શકો છો.

સ્્લલાઇડ સોર્્ટર વ્્યયૂ (નીચે) તમારી પ્રેઝન્ટેશનની બધી સ્્લલાઇડ્સ આડા 
ક્રમમાાં, થંબનેલ્સમાાં પ્રદર્શિત કરે છે. જો તમારે તમારી સ્્લલાઇડ્સને ફરીથી 
ગોઠવવાની જરૂર હોય તો સ્્લલાઇડ શો વ્્યયૂ મદદરૂપ થાય છે—તમે ફક્્ત 
તમારી સ્્લલાઇડ્સને નવા સ્થાન પર ક્્લલિક કરીને ખેેંચી શકો છો અથવા 
તમારી સ્્લલાઇડ્સને અર્્થપૂર્્ણ જૂથોમાાં ગોઠવવા માટે વિભાગો ઉમેરી શકો 
છો.
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નોોંધો પૃષ્્ઠ દૃશ્્ય

તમે સ્્લલાઇડ વિન્્ડડોના તળિય નોોંધો બટન  વડે તમારી સ્્પપીકર 
નોોંધો બતાવી અથવા છુપાવી શકો છો અથવા તમે રિબન પરના વ્્યયુ 
ટેબમાાંથી નોોંધો પૃષ્્ઠ દૃશ્્ય પર પહોોંચી શકો છો.

નોોંધો ફલક સ્્લલાઇડ વિન્્ડડોની નીચે સ્થિત છે. તમે તમારી નોોંધો છાપી શકો 
છો અથવા તમે પ્રેઝન્ટેશનમાાં નોોંધો શામેલ કરી શકો છો જ ેતમે પ્રેક્ષકોને 
મોકલો છો, અથવા જ્યારે તમે પ્રસ્્તતુત કરી રહ્યયાં હોવ ત્યારે તમારા માટે 
સંકેતો તરીકે તેનો ઉપયોગ કરી શકો છો.

રૂપરેખા દૃશ્્ય

તમે રિબન પરના વ્્યયૂ ટેબમાાંથી આઉટલાઈન વ્્યયૂ પર જઈ શકો છો. 
(પાવરપોઈન્ટ 2013 અન પછીના સમયમાાં, તમે હવે સામાન્ય વ્્યયૂમાાંથી 
આઉટલાઈન વ્્યયૂ પર જઈ શકશો નહીીં. તમારે વ્્યયૂ ટૅબમાાંથી તેને મેળવવું 
પડશે.

તમારી પ્રસ્્તતુતિ માટે આઉટલાઇન અથવા સ્ટોરી બોર્્ડ  બનાવવા માટે 
આઉટલાઇન વ્્યયૂનો ઉપયોગ કરો. તે તમારી સ્્લલાઇડ્સ પર માત્ર ટેક્સ્ટ 
પ્રદર્શિત કરે છે, ચિત્રો અથવા અન્ય ગ્રાફિકલ વસ્્તતુઓ નહીીં.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.20.71
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મુખ્ય દૃશ્્યયો

માસ્ટર વ્્યયૂ પર જવા માટે, વ્્યયૂ ટેબ પર, માસ્ટર વ્્યયૂઝ ગ્રૂપમાાં, તમને જોઈતો 
માસ્ટર વ્્યયૂ પસંદ કરો.

માસ્ટર વ્્યયૂમાાં સ્્લલાઇડ, હેન્્ડઆઉટ અને નોટ્સનો સમાવશે થાય છે. 
માસ્ટર વ્્યયૂમાાં કામ કરવાનો મુખ્ય ફાયદો એ છે કે તમે તમારી પ્રસ્્તતુતિ 
સાથે સંકળાયેલ દરેક સ્્લલાઇડ, નોટ્સ પેજ અથવા હેન્્ડઆઉટમાાં સાર્્વત્રિક 
શૈલીમાાં ફેરફાર કરી શકો છો.

પ્રસ્્તતુતિ વિતરિત કરવા અને જોવા માટેના દૃશ્્યયો

સ્્લલાઇડ શો દૃશ્્ય

તમે સ્્લલાઇડ વિન્્ડડોની નીચે ટાસ્ક બાર   માાંથી સ્્લલાઇડશો વ્્યયૂ પર 
પહોોંચી શકો છો.

તમારી પ્રસ્્તતુતિ તમારા પ્રેક્ષકો સુધી પહોોંચાડવા માટે સ્્લલાઇડ શો દૃશ્્યનો 
ઉપયોગ કરો. સ્્લલાઇડ શો દૃશ્્ય સંપૂર્્ણ કમ્્પ્યયુટર સ્ક્રીન પર કબજો કરે છે, 
જ ેરીતે તમારી પ્રસ્્તતુતિ મોટી સ્ક્રીન પર દેખાશે જ્યારે તમારા પ્રેક્ષકો તેને 
જુએ છે.

પ્રસ્્તતુતકર્તા દૃશ્્ય

પ્રસ્્તતુતકર્તા દૃશ્્ય પર જવા માટે, સ્્લલાઇડ શો દૃશ્્યમાાં, સ્ક્રીનના નીચનેા ડાબા 
ખૂણામાાં, ક્્લલિક  કરો, અને પછી પ્રસ્્તતુતકર્તા દૃશ્્ય બતાવો (નીચે 
બતાવ્્યયા પ્રમાણે) ક્્લલિક કરો.

તમારી પ્રસ્્તતુતિ વિતરિત કરતી વખતે તમારી નોોંધો જોવા માટે પ્રસ્્તતુતકર્તા 
દૃશ્્યનો ઉપયોગ કરો. પ્રસ્્તતુતકર્તા દૃશ્્યમાાં, તમારા પ્રેક્ષકો તમારી નોોંધો જોઈ 
શકતા નથી.

વાાંચન દૃશ્્ય

તમે સ્્લલાઇડ વિન્્ડડોની નીચે ટાસ્ક બાર  માાંથી વાાંચન દૃશ્્ય પર પહોોંચી 
શકો છો.

પ્રસ્્તતુતકર્તા વિના પાવરપોઈન્ટ પ્રેઝન્ટેશનની સમીક્ષા કરતા મોટાભાગના 
લોકો વાાંચન દૃશ્્યનો ઉપયોગ કરવા માાંગશે. તે સ્્લલાઇડ શો વ્્યયૂ જવેી પૂર્્ણ 
સ્ક્રીનમાાં પ્રેઝન્ટેશન પ્રદર્શિત કરે છે, અન તેમાાં સ્્લલાઇડ્સ દ્વારા ફ્્લલિપ કરવાનું 
સરળ બનાવવા માટે થોડા સરળ નિયંત્રણોનો સમાવશે થાય છે.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.20.71
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IT & ITES	 	 એકસરસાાઈઝ 1.20.72
કોપા (COPA) - પાવર પોઈન્ટ પ્રેઝન્ટેશન	

પાવરપોઈન્ટ પ્રસ્્તતુતિઓ સાચવો અને શેર કરો (Save and share PowerPoint Presentations)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	પ્ર સ્્તતુતિઓને વકૈલ્્પપિક ફાઇલ ફોર્મેટમાાં સાચવો
•	વિવિ ધ પ્રિન્ટ સેટિિંગ્્સ ગોઠવો
•	પ્ર સ્્તતુતિઓને ઈલકે્ટ્ રોનિક રીતે શેર કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પ્રસ્્તતુતિઓને વકૈલ્્પપિક ફાઇલ ફોર્મેટમાાં સાચવો 

વિવિધ ફાઇલ ફોર્મેટમાાં સાચવો

પાવરપોઈન્ટ ફાઇલો સામાન્ય રીતે પાવરપોઈન્ટ પ્રેઝન્ટેશન તરીકે 
સાચવવામાાં આવે છે, પરંતુ તમે માહિતીને અન્ય ફાઇલ ફોર્મેટમાાં પણ 
સાચવી શકો છો. ઉદાહરણ તરીકે, તમે તમારી ફાઇલને પીડીએફ તરીકે 

સાચવવા માગી શકો છો જથેી કોઈ વ્્યક્્તતિ જનેી પાસે પાવરપોઈન્ટ નથી તે 
પ્રસ્્તતુતિ જોઈ શકે.

1	 ફાઇલ ટેબ પર ક્્લલિક કરો.

2	 Save As પર ક્્લલિક કરો.

3	તમ ે તમારી ફાઇલને ક્યયાં સાચવવા માાંગો છો તે પસંદ કરો.

4	 (વૈકલ્્પપિક) નવી ફાઇલનું નામ દાખલ કરો.

5	 સેવ એઝ ટાઈપ લિસ્ટ એરો પર ક્્લલિક કરો.

	તમ ે ડ્્ર રોપ ડાઉન સૂચિમાાં કોઈપણ ફાઇલ પ્રકાર તરીકે તમારી પ્રસ્્તતુતિને 
સાચવવાનું પસંદ કરી શકો છો.

6	 ફાઇલ ફોર્મેટ પસંદ કરો.

7	 સાચવો પર ક્્લલિક કરો.

કાર્્ય 2 : વિવિધ પ્રિન્ટ સેટિિંગ્્સને ગોઠવો

એકવાર તમે પ્રેઝન્ટેશન બનાવી લો અને તમારુું  કમ્્પ્યયુટર પ્રિન્ટર સાથે 
કનેક્ટ થઈ જાય, પછી તમે કૉપિ પ્રિન્ટ કરી શકો છો.

તમે આ કરો તે પહેલાાં, તે કેવું દેખાશે તેનું પૂર્વાવલોકન કરવું એક સારો 
વિચાર છે.
1	 ફાઇલ ટેબ પર ક્્લલિક કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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2	પ્રિ ન્ટ પસંદ કરો. 

	 Ctrl + P દબાવો.

3	 સ્ક્રીનની જમણી બાજુએ પ્રિન્ટ પૂર્વાવલોકનનું પરીક્ષણ કરો, ખાતરી કરો 
કે પરૂ્વાવલોકન તમે ઇચ્છો તે રીતે દેખાય છે.

4	પ્રિ ન્ટર સૂચિ તીર પર ક્્લલિક કરીને અને તેને સૂચિમાાંથી પસંદ કરીને 
સાચા પ્રિન્ટરને પસંદ કરો.

5	ન ીચે આપલેા કોષ્્ટકમાાં વર્્ણવેલ પ્રિન્ટરની નીચેના વિકલ્્પપોનો ઉપયોગ 
કરીને પ્રિન્ટર સેટિિંગ્્સને સમાયોજિત કરો.

6	ન કલો ટેક્સ્ટ ફીલ્્ડમાાં નકલોની સખં્યા પસંદ કરો.

7	 પ્રિન્ટ પર ક્્લલિક કરો.

	પ્રિ ન્ટ સેટિિંગ્્સ

	પ્રિ ન્ટ રેન્્જ	 સમગ્ર પ્રસ્્તતુતિ, પસંદગી, ચોક્કસ સ્્લલાઇડ શ્રેણી, એક સ્્લલાઇડ અથવા કસ્ટમ શ્રેણી છાપો.		

	પ્રિ ન્ટ લેઆઉટ	તમ ે દરેક પૃષ્્ઠ પર શું છાપવા માાંગો છો તે નક્કી કરો. તમે એક સ્્લલાઇડ, બહુવિધ બાજુઓ, સ્્લલાઇડ નોોંધો, હેન્્ડઆઉટ્સ 
		અન  ે વધુ પ્રિન્ટ કરી શકો છો.		

	 કોલેટ	 કોલેટીીંગ સમગ્ર રીતે (1, 2, 3; 1, 2, 3) દ્વારા પ્રસ્્તતુતિની બહુવિધ નકલો છાપે છે, જ્યારે અનકોલેટેડ પ્રિન્ટ દરેક સ્્લલાઇડની 
		  એકસાથે અનેક નકલો છાપે છે (1, 1; 2, 2; 3, 3).	

	 ઓરિએન્ટેશન	 મુદ્રિત પૃષ્્ઠ, પોટ્્ર રેટ અથવા લેન્્ડસ્કેપનું પૃષ્્ઠ ઓરિએન્ટેશન બદલે છે.		

	 રંગ	પ્રે ઝન્ટેશનને સંપૂર્્ણ રંગ, ગ્રેસ્કેલ અથવા શદુ્ધ કાળા અને સફેદ રંગમાાં છાપવું કે નહીીં તે પસંદ કરો.

કાર્્ય 3 : પ્રસ્્તતુતિઓને ઇલેક્ટ્ રોનિક રીતે શેર કરો 

1	 File > Share ક્્લલિક કરો.

2	તમ ે લોકો સાથે શેર કરીને અથવા ઈમેલ દ્વારા અથવા ઓનલાઈન 
પ્રસ્્તતુત કરીને અથવા બ્્લલોગ પોસ્ટ કરીને દસ્્તતાવેજ શેર કરી શકો છો.

3	 જો તમે લોકો સાથે શેર કરવાનો વિકલ્્પ પસંદ કરવા માાંગતા હોવ તો 
તમારા દસ્્તતાવેજને OneDrive ક્્લલાઉડમાાં સાચવો, જો તે પહેલાથી ત્યયાં 
ન હોય તો.

4	 જો તમારો દસ્્તતાવેજ હાલમાાં OneDrive માાં સાચવેલ ન હોય તો શેર 
વિન્્ડડો પ્રદર્શિત થાય છે. OneDrive વિકલ્્પ પસંદ કરો, પછી તમારા 
દસ્્તતાવેજને નામ આપો અને ઓકે પસંદ કરો.

નોોંધ: શેર કરતા પહેલા, કૃપા કરીને ખાતરી કરો કે પ્રેષક અને 
પ્રાપ્્તકર્તા પાસે Microsoft Outlook ઈમેલ એકાઉન્ટ અથવા 
Microsoft O365 સબ્સસ્ક્્રાઇબ કરેલ સંસ્થા ઈમેલ એકાઉન્ટ 
હોવું આવશ્્યક છે. 

5	તમ ે જનેી સાથે શેર કરવા માાંગો છો તે લોકોના ઈમેલ એડ્્રરેસ દાખલ કરો 
અને તમે પરવાનગી આપવા માાંગો છો તે માટે પસંદગી કરો.

6	 જો તમે ઇચ્છો તો સંદેશ લખો અને મોકલો પસંદ કરો.

	તમ ે જ ેલોકો સાથે શેર કરી રહ્યયાં છો તેઓ તમારા દસ્્તતાવેજની લિિંક 
સાથે તમારા તરફથી મેઇલ મેળવશે.
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IT & ITES	 	 એકસરસાાઈઝ 1.20.73
કોપા (COPA) - પાવર પોઈન્ટ પ્રેઝન્ટેશન	

સ્્લલાઇડ શો ગોઠવો અને પ્રસ્્તતુત કરો (Configure and present slide shows)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	પ્ર સ્્તતુત કરતી વખતે અનિચ્છનીય સ્્લલાઇડ્સ છુપાવો
•	 સ્્લલાઇડ શો વિકલ્્પપોને ગોઠવો
•	પ્ર સ્્તતુતકર્તા વ્્યયૂનો ઉપયોગ કરીને સ્્લલાઇડ શો રજૂ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પ્રસ્્તતુત કરતી વખતે અનિચ્છનીય સ્્લલાઇડ્સ છુપાવો 

એક સ્્લલાઇડ છુપાવો

જો તમે અંતિમ સ્્લલાઇડ શોમાાં સ્્લલાઇડને સામેલ કરવા માાંગતા નથી, તો તમે 
તેને તમારા પ્રેક્ષકોથી છુપાવી શકો છો. જ્યારે તમે સ્્લલાઇડ શો ચલાવો ત્યારે 
તે દેખાશે નહીીં, પરંતુ તમે હજી પણ તેને સંપાદન દૃશ્્યયોમાાં જોશો જથેી તમે 
તેને ભવિષ્્યમાાં પાછંુ લાવી શકો.

1	તમ ે છુપાવવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

2	 સ્્લલાઇડ શો ટેબ પર ક્્લલિક કરો.

3	 સ્્લલાઇડ છુપાવો પર ક્્લલિક કરો.

	 સ્્લલાઇડ પર જમણું-ક્્લલિક કરો અને સ્્લલાઇડ છુપાવો પસંદ કરો.

	 સ્્લલાઇડ નંબર ક્રોસ આઉટ છે, જ ેદર્શાવે છે કે તે છુપાયેલ છે.

	 સ્્લલાઇડને છુપાવવા માટે, તેને પસંદ કરો અને પછી ફરીથી સ્્લલાઇડ 
છુપાવો પર ક્્લલિક કરો.

કાર્્ય 2 : સ્્લલાઇડ શો વિકલ્્પપોને ગોઠવો

સ્્લલાઇડ શો સેટ કરો

1	રિ બન પરની સ્્લલાઇડ શો ટેબ પર ક્્લલિક કરો.

2	 વધુ વિકલ્્પપો જોવા માટે સ્્લલાઇડ શો સેટ કરો બટન પર ક્્લલિક કરો.

3	 સેટિિંગ્્સમાાં કોઈપણ ઇચ્છિત ફેરફારો કરો.

•	 પ્રકાર બતાવો: તમે જ ેપ્રસ્્તતુતિ આપી રહ્યા છો તેનો પ્રકાર પસંદ 
કરો.

•	 વિકલ્્પપો બતાવો: લૂપિિંગ, વર્્ણન, એનિમશન, ગ્રાફિક્સ, પેન અને 
લેસર વિકલ્્પપોને સમાયોજિત કરો.

•	 સ્્લલાઇડ્સ બતાવો: પ્રસ્્તતુતિમાાં કઈ સ્્લલાઇડ્સ બતાવવાની છે તે 
પસંદ કરો.

•	 એડવાન્્સ સ્્લલાઇડ્સ: સ્્લલાઇડ્સને મેન્યુઅલી અથવા આપમેળે 
એડવાન્્સ કરવાનું પસંદ કરો.

•	 બહુવિધ મોનિટર્્સ: બહુવિધ મોનિટરનો ઉપયોગ કરીને પ્રસ્્તતુત 
કરવા માટે સેટ કરો.

4.	 ઠીક ક્્લલિક કરો.

	 હવે તમે પસંદ કરેલ સેટિિંગ્્સ અનુસાર સ્્લલાઇડ શો ચાલશે

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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કાર્્ય 3 : પ્રસ્્તતુતકર્તા વ્્યયુનો ઉપયોગ કરીને સ્્લલાઇડ શો રજૂ કરો 

પાવરપોઈન્ટ પ્રેઝેન્ટર વ્્યયૂ તમને પ્રસ્્તતુત કરતી વખતે ધ્્યયાન કેન્દ્રિત કરવામાાં 
અને તમારા પ્રેક્ષકો સાથે કનેક્ટ કરવામાાં મદદ કરવા માટે તમને વર્્તમાન 
સ્્લલાઇડ, આગલી સ્્લલાઇડ અને તમારી સ્્પપીકર નોોંધો બતાવે છે. 

1	 સ્્લલાઇડ શો ટેબ પસંદ કરો.

2	 પ્રસ્્તતુતકર્તા દૃશ્્યનો ઉપયોગ કરો ચેકબોક્સ પસંદ કરો.

3	 પ્રસ્્તતુતકર્તા દૃશ્્યને પ્રદર્શિત કરવા માટે કયું મોનિટર પસંદ કરો.

4	શ રૂઆતથી પસંદ કરો અથવા F5 દબાવો.

પ્રસ્્તતુતકર્તા દૃશ્્યમાાં, તમે આ કરી શકો છો:

•	તમ ારી વર્્તમાન સ્્લલાઇડ, આગલી સ્્લલાઇડ અને સ્્પપીકર નોોંધો જુઓ.

•	 સ્્લલાઇડ્સ વચ્ચે જવા માટે સ્્લલાઇડ નંબરની પાસેના તીરો પસંદ કરો.

•	 ઉપર ડાબી બાજુએ સ્્લલાઈડ ટાઈમરને થોભાવવા અથવા રીસેટ કરવા 
માટે થોભો બટન અથવા રીસેટ બટન પસંદ કરો.

•	તમ ારી પ્રસ્્તતુતિને આગળ ધપાવવામાાં મદદ કરવા માટે વર્્તમાન સમય 
જુઓ.

•	 સ્્પપીકર નોોંધને મોટી કે નાની બનાવવા માટે ફોન્ટના ચિહ્નો પસંદ કરો.

•	 રીઅલ ટાઇમમાાં સ્ક્રીન પર દોરવા માટે એનોટેશન પેન આઇકોન પસંદ 
કરો અથવા લેસર પોઇન્ટર પસંદ કરો.

•	તમ ારી પ્રસ્્તતુતિની બધી સ્્લલાઇડ્સ જોવા માટે થંબનેલ આઇકોન પસંદ 
કરો અને ઝડપથી બીજી સ્્લલાઇડ પર જાઓ.

•	 સ્્લલાઇડના ચોક્કસ ભાગ પર ઝૂમ કરવા માટે બહૃદદર્્શક કાચનું 
આઇકન પસંદ કરો.

•	 સ્ક્રીન આયકન તમને તમારા પર ધ્્યયાન કેન્દ્રિત કરવા માટે સ્ક્રીનને 
અસ્થાયી રૂપે કાળી બનાવવા દે છે.

•	જ્યા રે તમે પ્રસ્્તતુત કરવાનું પૂર્્ણ કરી લો ત્યારે સ્્લલાઇડશો સમાપ્્ત કરો 
પસંદ કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.20.74
કોપા (COPA) - પાવર પોઈન્ટ પ્રેઝન્ટેશન	

સહયોગ માટે પ્રસ્્તતુતિઓ તૈયાર કરો (Prepare presentations for collaboration)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 પાસવર્્ડ નો ઉપયોગ કરીને પ્રસ્્તતુતિઓને સુરક્ષિત કરો
•	પ્ર સ્્તતુતિઓને અન્ય ફોર્મેટમાાં નિકાસ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પાસવર્્ડ નો ઉપયોગ કરીને પ્રસ્્તતુતિઓને સુરક્ષિત કરો 

ફાઇલમાાં પાસવર્્ડ  સુરક્ષા ઉમેરો

1	 File > Info પસંદ કરો.

2	 Protect Presentation > Encrypt with Password પસંદ કરો. 

3	 પાસવર્્ડ  બોક્સમાાં, તમે ઉપયોગ કરવા માાંગો છો તે પાસવર્્ડ  દાખલ 
કરો. ઓકે પસંદ કરો.

4	 પાવરપોઈન્ટ તમને પાસવર્્ડ  ફરી એકવાર દાખલ કરીને તેની પષુ્્ટટિ 
કરવા માટે સંકેત આપે છે.

5	 પાસવર્્ડ  પ્રભાવી થાય તેની ખાતરી કરવા માટે ફાઇલ સાચવો.
	 ODP (ઓપન ડોક્યુમેન્ટ પ્રેઝન્ટેશન) ફાઈલો માટે પાવરપોઈન્ટમાાં 

પાસવર્્ડ  સુરક્ષા સમર્થિત નથી. 
	 ફાઇલમાાંથી પાસવર્્ડ  દૂર કરો
	 દસ્્તતાવેજમાાંથી પાસવર્્ડ  દૂર કરવો એ એક સરળ પ્રક્રિયા છે, પરંતુ તમારે 

મૂળ પાસવર્્ડ  જાણવો પડશે.
1	 પ્રસ્્તતુતિ ખોલો જનેો પાસવર્્ડ  તમે દૂર કરવા માાંગો છો.
2	 File > Info પસંદ કરો.
3	 Protect Presentation > Encrypt with Password પસંદ કરો.
4	 પાસવર્્ડ  બોક્સમાાં પાસવર્્ડ  સાફ કરો અથવા દૂર કરો, અને પછી OK 

ક્્લલિક કરો.

કાર્્ય 2 : પ્રસ્્તતુતિઓને અન્ય ફોર્મેટમાાં નિકાસ કરો

1	 File > Export તમને તમારી પ્રસ્્તતુતિને એક અલગ ફોર્મેટમાાં બદલવામાાં 
મદદ કરે છે, જમે કે PDF, વિડિયો અથવા વર્્ડ બેઝ્ડ હેન્્ડઆઉટ. આ 
બધા વિકલ્્પપો નીચે આવરી લેવામાાં આવ્્યયા છે.

2	 જો તમે ફ્્લલેશ ડ્્ર રાઇવ જવેી અલગ સ્ટોરેજ સિસ્ટમમાાં ફાઇલ (તેના 
વર્્તમાન .pptx ફોર્મેટમાાં) "નિકાસ" કરવા માાંગતા હો, તો તે ફ્્લલેશ 
ડ્્ર રાઇવને તમારા કમ્્પ્યયુટરમાાં પ્્લગ કરો અને ફાઇલ &gt; સેવ એઝ 
(અથવા કૉપિ સાચવો) નો ઉપયોગ કરો. તે નવા સ્થાન પર સાચવવા 
માટે.
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IT & ITES	 	 એકસરસાાઈઝ 1.21.75
કોપા (COPA) - સ્્તતુતિઓ ફોર્મેટ કરો	

ટેક્સ્ટ અને ફકરા દાખલ કરો (Insert text and paragraphs)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ટેક્સ્ટ શોધો અને બદલો
•	 ચિહ્નો અને વિશષે અક્ષરો દાખલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટેક્સ્ટ શોધો અને બદલો 

ટેક્સ્ટ શોધો

શોધો પ્રસ્્તતુતિમાાં ચોક્કસ શબ્દો અને શબ્દસમહૂો શોધવાનું ખૂબ જ સરળ 
બનાવે છે.

1	 જો જરૂરી હોય, તો હોમ ટેબ પર સંપાદન જૂથને વિસ્્તતૃત કરો.

2	શ ોધો બટન પર ક્્લલિક કરો.

	 Ctrl + F દબાવો.

3	 શું લખાણ શોધો બોક્સમાાં તમે જ ેલખાણ શોધવા માાંગો છો તે લખો.

	 જો તમે ચોક્કસ કેસ અથવા ફક્્ત સંપૂર્્ણ શબ્દો શોધવા માાંગતા હો, તો 
ટેક્સ્ટ ફીલ્્ડની નીચે સ્થિત ચેક બોક્સ  પસંદ કરો.

4	 જ્યયાં સુધી તમને જ ેજોઈએ છે તે ન મળે ત્યયાં સુધી આગલું શોધો ક્્લલિક 
કરો.

5	જ્યા રે તમે પૂર્્ણ કરી લો ત્યારે બંધ કરો ક્્લલિક કરો.
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ટેક્સ્ટ બદલો

રિપ્્લલેસ ટૂલ ચોક્કસ શબ્દો અને શબ્દસમહૂો શોધે છે, અને પછી તેને કંઈક 
બીજુ ંવડે બદલે છે.

1	 જો જરૂરી હોય, તો હોમ ટેબ પર સંપાદન જૂથને વિસ્્તતૃત કરો.

2	 બદલો બટન પર ક્્લલિક કરો.

3	 શું લખાણ શોધો બોક્સમાાં તમારે બદલવાની જરૂર હોય તે શબ્દ લખો.

4	 ટેક્સ્ટ સાથે બદલો બોક્સમાાં રિપ્્લલેસમેન્ટ શબ્દ દાખલ કરો.

5	 જો જરૂરી હોય, તો શોધ વિકલ્્પ પસંદ કરો.

6	 પ્રથમ દાખલો શોધવા માટે આગળ શોધો પર ક્્લલિક કરો.
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7	 બદલી વિકલ્્પ પસંદ કરો.

•	 બદલો: એક સમયે એક ઘટનાને બદલે છે.

•	 બધા બદલો: એક જ સમયે દરેક દાખલાને બદલો.

8	 (વૈકલ્્પપિક) જો તમે બધા બદલો પસંદ કર્્યુું હોય, તો જ્યારે સંવાદ બોક્સ 
દેખાય ત્યારે ઓકે ક્્લલિક કરો.

9	જ્યા રે તમે પૂર્્ણ કરી લો ત્યારે બંધ કરો ક્્લલિક કરો.

કાર્્ય 2 : પ્રતીકો અને વિશિષ્્ટ અક્ષરો દાખલ કરો

1	 Insert > Symbol પર જાઓ. 2	 પ્રતીક ચૂંટો, અથવા વધુ પ્રતીકો પસંદ કરો.

3	 પ્રતીક પસંદ કરો અને તમે જ ેદાખલ કરવા માાંગો છો તે શોધવા માટે 
ઉપર અથવા નીચે સ્ક્રોલ કરો.

4	જ્યા રે તમને જોઈતું પ્રતીક અથવા વિશિષ્્ટ અક્ષર મળે, ત્યારે તેના પર 
ડબલ ક્્લલિક કરો અથવા ઇન્્સર્્ટ  પસંદ કરો પછી તમારી ફાઇલમાાં 
પ્રતીક દાખલ કરવામાાં આવશે.

5	 બંધ પસંદ કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.21.76
કોપા (COPA) - સ્્તતુતિઓ ફોર્મેટ કરો	

ટેક્સ્ટ અને ફકરાઓને ફોર્મેટ કરો (Format text and paragraphs)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ટેક્સ્ટ ઇફેક્્ટ્્સ લાગુ કરો
•	 ફોર્મેટ પેઇન્ટરનો ઉપયોગ કરીને ફોર્મેટિિંગ લાગુ કરો
•	 રેખા અને ફકરાનું અતંર અને ઇન્્ડડેન્ટેશન સેટ કરો
•	 ટેક્સ્ટ પર બિલ્ટ-ઇન શૈલીઓ લાગુ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટેક્સ્ટ ઇફેક્્ટ્્સ લાગુ કરો 

ફોન્ટનો પ્રકાર બદલો

પ્રેઝન્ટેશનમાાં ટેક્સ્ટ પર ભાર મૂકવાની એક રીત તેના ફોન્ટ પ્રકારને બદલીને 
છે. ફોન્ટ પ્રકાર એ સમાન ડિઝાઇન અને આકાર ધરાવતા અક્ષરોનો સમહૂ 
છે.

1	તમ ે બદલવા માાંગો છો તે ટેક્સ્ટ પસંદ કરો.

	 જો તમે ટેક્સ્ટ બોક્સમાાંનો તમામ ટેક્સ્ટ બદલવા માાંગતા હો, તો તમે 
ફક્્ત ટેક્સ્ટ બોક્સ પસંદ કરી શકો છો.

2	 ફોન્ટ સૂચિ તીરને ક્્લલિક કરો.

	મ ેનૂમાાં તેના પર હોવર કરીને ફોન્ટનું પૂર્વાવલોકન કરો.

3	ન વો ફોન્ટ પસંદ કરો.

	જ્યા રે તમે ટેક્સ્ટ પસંદ કરો ત્યારે માઉસની નજીક દેખાતા મીની 
ટૂલબાર પર ફોન્ટ સૂચિ તીરનો ઉપયોગ કરો.

ફોન્ટનું કદ બદલો

1	તમ  બદલવા માાંગો છો તે ટેક્સ્ટ પસંદ કરો.

2	 ફોન્ટ સાઈઝ યાદી તીરને ક્્લલિક કરો.

	મ ેનૂમાાં તેના પર હોવર કરીને ફોન્ટના કદનું પૂર્વાવલોકન કરો.

3	 ફોન્ટ માપ પસંદ કરો.

	મ ીની ટૂલબાર પર ફોન્ટ સાઇઝ લિસ્ટ એરોનો ઉપયોગ કરો.

ફોન્ટનો રંગ બદલો

ફૉન્ટનો રંગ બદલવો એ પ્રસ્્તતુતિમાાં ટેક્સ્ટ પર ભાર મૂકવાની બીજી રીત છે.

1	તમ ે બદલવા માાંગો છો તે ટેક્સ્ટ પસંદ કરો.

2	 ફોન્ટ કલર લિસ્ટ એરો પર ક્્લલિક કરો.

	 ટોચ પર દેખાતા રંગો તમારી વર્્તમાન પ્રસ્્તતુતિ થીમ સાથે સંકલન કરે 
છે.

	મ ેનૂમાાં તેના પર હોવર કરીને ફોન્ટ રંગનંુ પૂર્વાવલોકન કરો.

3	ન વો રંગ પસંદ કરો.

મીની ટૂલબાર પર ફોન્ટ કલર લિસ્ટ એરોનો ઉપયોગ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.

© NIMI 

NOT TO BE REPUBLISHED



275

ફોન્ટ કલર બટન હંમશેા તે રંગ દર્શાવે છે જ ેતાજતેરમાાં ઉપયોગમાાં લેવાયો 
હતો. આ રંગને અન્ય પસંદ કરેલા ટેક્સ્ટ પર ઝડપથી લાગુ કરવા માટે, 
સૂચિ તીરને બદલે ફૉન્ટ કલર બટનને ક્્લલિક કરો.

ટેક્સ્ટ ઇફેક્્ટ્્સ લાગુ કરો

ફોન્ટનો પ્રકાર, કદ અને રંગ બદલવા ઉપરાાંત, તમે ટેક્સ્ટ ઇફેક્્ટ્્સ બદલીને 
પ્રેઝન્ટેશનમાાં ટેક્સ્ટ પર પણ ભાર મૂકી શકો છો. સૌથી સામાન્ય અન 
લોકપ્રિય શૈલીઓ બોલ્્ડ, ઇટાલિક અને અન્્ડરલાઇન છે, પરંતુ અન્ય 
શૈલીઓ જમે કે શેડો અને સ્ટ્ રાઇકથ્રુ પણ ઉપયોગી છે.

1	તમ ે બદલવા માાંગો છો તે ટેક્સ્ટ પસંદ કરો.

2	 બોલ્્ડ, ઇટાલિક અથવા અન્્ડરલાઇન જવેી ફોન્ટ શૈલી પસંદ કરો.

શૉર્્ટકટ્સ

•	 બોલ્્ડ કરવા માટે, Ctrl + B.

•	 ઇટાલિક કરવા માટે,  Ctrl + I.

•	 રેખાાંકિત કરવા માટે,  Ctrl + U.

પસંદ કરેલ ટેક્સ્ટમાાંથી ફોન્ટ શૈલી દૂર કરવા માટે, ફક્્ત શૈલી બટનને 
ફરીથી ક્્લલિક કરો, અથવા બધા ફોર્મેટિિંગ સાફ કરો બટનનો ઉપયોગ કરો.

કેસ બદલો

જો તમે ટેક્સ્ટના આખા બ્્લલોક માટે લેટર કેસ બદલવા માાંગતા હો, તો દરેક 
અક્ષરને મેન્યુઅલી બદલ્યા વિના લોઅરકેસ, અપરકેસ, વાક્ય કેસમાાં 
સ્્વવિચ કરવંુ અથવા દરેક શબ્દને કેપિટલાઇઝ કરવંુ સરળ છે. તમે ટૉગલ 
કેસ વિકલ્્પ વડે પસંદ કરેલા ટેક્સ્ટના કેસને પણ ઉલટાવી શકો છો.

1	 ટેક્સ્ટ પસંદ કરો.

2	 કેસ બદલો બટન પર ક્્લલિક કરો.

3	 કેસ વિકલ્્પ પસંદ કરો.

ટેક્સ્ટ સંરેખિત કરો

ટેક્સ્ટ બોક્સમાાં ટેક્સ્ટને સંરેખિત કરવાની કેટલીક અલગ અલગ રીતો 
છે. તમે બનંે આડા અન ઊભી ગોઠવણી વિકલ્્પપોમાાંથી પસંદ કરી શકો છો.

1	 ટેક્સ્ટ પસંદ કરો.

2	 આડી ગોઠવણી વિકલ્્પ પસંદ કરો.

3	 ઊભી ગોઠવણી વિકલ્્પ પસંદ કરો.

કાર્્ય 2 : ફોર્મેટ પેઇન્ટરનો ઉપયોગ કરીને ફોર્મેટિિંગ લાગુ કરો 

1	 ટેક્સ્ટ અથવા ગ્રાફિક પસંદ કરો કે જમેાાં ફોર્મેટિિંગ છે જનેી તમે નકલ 
કરવા માાંગો છો.

નોોંધ: જો તમ ટેક્સ્ટ ફોર્મેટિિંગની નકલ કરવા માાંગતા હો, 
તો ફકરાનો એક ભાગ પસંદ કરો. જો તમે ટેક્સ્ટ અને ફકરા 
ફોર્મેટિિંગની નકલ કરવા માાંગતા હો, તો ફકરાના ચિહ્ન સહિત 
સમગ્ર ફકરો પસંદ કરો.

2	 ફોર્મેટ પેઇન્ટર પસંદ કરવા માટે:

	 હોમ ટેબ પર, ક્્લલિપબોર્્ડ  જૂથમાાં ફોર્મેટ પેઇન્ટર પસંદ કરો. 
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3	 કર્્સર પેઇન્ટબ્રશ આઇકોનમાાં બદલાય છે.

4	 ફોર્મેટિિંગ લાગુ કરવા માટે ટેક્સ્ટ અથવા ગ્રાફિક્સની પસંદગી પર 
પેઇન્ટ કરવા માટે બ્રશનો ઉપયોગ કરો. આ  માત્ર એક જ વાર કામ કરે 

છે.  તમારા દસ્્તતાવેજમાાં બહુવિધ પસંદગીઓના ફોર્મેટને બદલવા માટે, 
તમારે પહેલા ફોર્મેટ પેઇન્ટર પર ડબલ-ક્્લલિક કરવંુ આવશ્્યક છે. 

5	 ફોર્મેટિિંગ રોકવા માટે, ESC દબાવો

કાર્્ય 3 : રેખા અને ફકરાનું અતંર અને ઇન્્ડડેન્ટેશન સેટ કરો 

લાઇન સ્્પપેસિિંગ (સિિંગલ-સ્્પપેસ, ડબલ-સ્્પપેસ, અને તેથી વધુ) અને વર્ટિકલ 
એલાઇનમેન્ટ (ટોચ, નીચે અથવા મધ્્યમ) ફકરા જૂથમાાં, રિબનના હોમ ટેબ 
પરના મેનુ બટનોમાાંથી ઉપલબ્ધ છે.

આકૃતિ 1: રેખા અતંર

આકૃતિ 2: ઊભી ગોઠવણી

ફકરા સંવાદ બોક્સમાાં વધુ વિગતવાર અતંર વિકલ્્પપો ઉપલબ્ધ છે:

1	 સ્્લલાઇડ પર, તમ જ ેટેક્સ્ટ બદલવા માાંગો છો તેને પસંદ કરો.

2	 હોમ પર ક્્લલિક કરો, અને ફકરા જૂથમાાં, ડાયલોગ બોક્સ લોન્ચરને 
ક્્લલિક કરો.

ફકરો સંવાદ બોક્સ દેખાય છે:

અહીીં સંવાદ બોક્સમાાં ઉપલબ્ધ વિકલ્્પપો છે:

ગોઠવણી

•	 ટેક્સ્ટનું આડું  સ્થાન બદલવા માટે, સંરેખણ બૉક્સમાાં, ડાબે, મધ્્યમાાં, 
જમણે, ન્યાયીકૃત અથવા વિતરિત પસંદ કરો.   

	 Left:	 Center:	

	 Right:

ઇન્્ડડેન્ટેશન

•	 ઇન્્ડડેન્ટેશન ઉમેરવા અથવા ટેક્સ્ટ પહેલાાં ઇન્્ડડેન્ટેશનની માત્રા બદલવા 
માટે.

•	તમ ે બદલવા માાંગો છો તે ટેક્સ્ટ પસંદ કરો, પછી નીચેનામાાંથી એક કરો:

•	 સમગ્ર ફકરાના ડાબા ઇન્્ડડેન્ટને વધારવા અથવા ઘટાડવા માટે, હોમ ટેબ 
પર, ફકરા જૂથમાાં, સૂચિ સ્્તર વધારો  અથવા સૂચિ સ્્તર ઘટાડો પર 
ક્્લલિક કરો.
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અતંર

•	 ફકરાની ઉપર અથવા નીચેનું અતંર બદલવા માટે, પહેલાાં અથવા 
પછીની બાજુના તીરોને ટાઇપ કરો અથવા ક્્લલિક કરો. આ સખં્યા 
કોઈપણ પૂર્્ણ સખં્યા અથવા દશાાંશ હોઈ શકે છે, જમે કે 6.5.

•	 ઉપર અને ફકરામાાં અંતર બદલવા માટે, લાઇન સ્્પપેસિિંગ વિકલ્્પપોનો 
ઉપયોગ કરો: સિિંગલ, 1.5 લાઇન્્સ અથવા ડબલ. અથવા બરાબર 
પસંદ કરો અને પછી At બોક્સમાાં પોઈન્ટ વેલ્યુ (0 અને 1584 વચ્ચે) 
ઉમેરો.

	 Normal:	 After Spacing: 

નોોંધ: જો તમે પ્્લલેસહોલ્્ડરમાાં જગ્્યયા પુરી ન થાય ત્યયાં સુધી તમે લાઈનો 
ઉમેરવાનું ચાલુ રાખો છો, તો ઑટોફિટ પ્્લલેસહોલ્્ડરમાાં બધી સૂચિ 
વસ્્તતુઓને ફિટ કરવા માટે રેખા અતંર અને ફોન્ટ કદને સમાયોજિત કરે 
છે. જ્યારે આવું થાય, ત્યારે AutoFit વિકલ્્પપો  નિયંત્રણ દેખાય છે. 
ઑટોફિટને બંધ કરવા માટે, ઑટોફિટ વિકલ્્પપો પર ક્્લલિક કરો અને પછી 
આ પ્્લલેસહોલ્્ડરમાાં ટેક્સ્ટ ફિટિિંગ બંધ કરો પર ક્્લલિક કરો.

કાર્્ય 4 : ટેક્સ્ટમાાં બિલ્ટ-ઇન શૈલીઓ લાગુ કરો

વર્્ડ આર્્ટ  દાખલ કરો

1	 ઇન્્સર્્ટ  ટેબ પર ક્્લલિક કરો.

2	 રિબન પર ટેક્સ્ટ જૂથને વિસ્્તતૃત કરો.

3	 વર્્ડ આર્્ટ  પર ક્્લલિક કરો. 

	 વર્્ડ આર્્ટ  વિકલ્્પપોની એક ગલેેરી દેખાય છે.	

4	 વર્્ડ આર્્ટ  શૈલી પસંદ કરો.

	 પસંદ કરેલ ટેક્સ્ટની વર્્ડ આર્્ટ  શૈલી બદલવા માટે, ફોર્મેટ ટેબ પર 
ક્્લલિક કરો, ઝડપી શૈલીઓ પસંદ કરો અને પસંદગી કરો.

5	 પ્્લલેસહોલ્્ડર ટેક્સ્ટ બદલવા માટે ટાઈપ કરો.

તમે વિકલ્્પપોનો ઉપયોગ કરીને તમારા વર્્ડ આર્્ટ  ટેક્સ્ટને પણ સશંોધિત કરી 
શકો છો હોમ ટેબ પર ફોન્ટ જૂથમાાં.

વર્્ડ આર્્ટ ને ફોર્મેટ કરો

તમે વર્્ડ આર્્ટન દાખલ કર્યા પછી તેને ફોર્મેટ પણ કરી શકો છો. ઉદાહરણ 
તરીકે, તમે ટેક્સ્ટ ફિલ અને આઉટલાઇન રંગ બદલી શકો છો, નવી વર્્ડ આર્્ટ  
શૈલી પસંદ કરી શકો છો અથવા ટેક્સ્ટ ઇફેક્ટ લાગુ કરી શકો છો.

1	 વર્્ડ આર્્ટ  પસંદ કરો.

2	 વર્્ડ આર્્ટ  પસંદ કરો.

3	 વર્્ડ આર્્ટ  સ્ટાઇલ જૂથમાાં, ઝડપી શૈલીઓ પર ક્્લલિક કરો.

4	 બીજી શૈલી પસંદ કરો.
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5	 ટેક્સ્ટ ફિલ લિસ્ટ એરો પર ક્્લલિક કરો અને ફિલ બદલવા માટે વિકલ્્પ 
પસંદ કરો.

	તમ ે વર્્ડ આર્્ટન ચિત્રો, ગ્રેડિએન્્ટ્્સ અને ટેક્સચર સાથે ભરી શકો છો 
અથવા તમે સરળ રંગ પસંદ કરી શકો છો.

6	 ટેક્સ્ટ આઉટલાઇન સૂચિ તીરને ક્્લલિક કરો અને રૂપરેખા બદલવા માટે 
વિકલ્્પ પસંદ કરો.

7	શ ેપ ઇફેક્્ટ્્સ બટન પર ક્્લલિક કરો અને શેપ ઇફેક્ટ ઉમેરવા માટે 
વિકલ્્પ પસંદ કરો.

	તમ ે ઇચ્છો તેટલી ઇફેક્્ટ્્સ લાગુ કરી શકો છો, પરંતુ સામાન્ય રીતે 
સામાન્ય દેખાવ શ્રેષ્્ઠ કામ કરે છે.
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IT & ITES	 	 એકસરસાાઈઝ 1.21.77
કોપા (COPA) - સ્્તતુતિઓ ફોર્મેટ કરો	

વિભાગો બનાવો અને ગોઠવો (Create and configure sections)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 બહુવિધ કૉલમમાાં ટેક્સ્ટ ફોર્મેટ કરો
•	 ટેક્સ્ટ અને છબી પ્રસ્્તતુતિ શૈલીઓ
•	 સ્્પષ્્ટ ફોર્મેટિિંગ.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : બહુવિધ કૉલમમાાં ટેક્સ્ટને ફોર્મેટ કરો

બહુવિધ કૉલમ ઉમેરો

જ્યારે તમારી પાસે સ્્લલાઇડ પર ટેક્સ્ટ હોય, ત્યારે પાવરપોઇન્ટ તેને 
આપમેળે એક કૉલમમાાં મૂકે છે, પરંતુ જો તે વધુ યોગ્્ય હોય તો તમે તેને 
બહુવિધ કૉલમમાાં તોડી શકો છો.

1	તમ ે કૉલમમાાં રૂપાાંતરિત કરવા માાંગો છો તે વસ્્તતુઓ સાથે ટેક્સ્ટ બોક્સ 
પસંદ કરો.

	 જો ટેક્સ્ટ ટેક્સ્ટ બોક્સની બહાર વહે છે, તો પણ તે આપમેળે કૉલમમાાં 
વિભાજિત થતું નથી.

2	 હોમ ટેબ પર કૉલમ ઉમેરો અથવા દૂર કરો બટનને ક્્લલિક કરો.

3	 કૉલમ વિકલ્્પ પસંદ કરો.

ક્રમાાંકિત અને બુલેટેડ યાદીઓ

જ્યારે સૂચિમાાં વસ્્તતુઓના ક્રમમાાં કોઈ ફરક ન પડતો હોય ત્યારે બુલેટેડ 
સૂચિઓનો ઉપયોગ કરો, જમે કે તમારે ખરીદવાની જરૂર હોય તેવી 
વસ્્તતુઓની સૂચિ કરવી. જ્યારે સૂચિમાાં વસ્્તતુઓનો ક્રમ મહત્્વનો હોય, જમે 
કે પગલું-દર-પગલાાં સૂચનો રજૂ કરવા, તેના બદલે ક્રમાાંકિત સૂચિનો ઉપયોગ 
કરો.

1	તમ ે સૂચિમાાં રૂપાાંતરિત કરવા માાંગો છો તે વસ્્તતુઓ સાથે ટેક્સ્ટ બોક્સ 
પસંદ કરો.

2	ન ંબરિિંગ બટન અથવા બુલેટ બટન પર ક્્લલિક કરો.

સૂચિમાાંથી બુલેટ્સ અને નંબરિિંગને દૂર કરવા માટે, સૂચિ પસંદ કરો અને 
ફકરા જૂથમાાં બુલેટ્સ અથવા નંબરિિંગ બટનને ક્્લલિક કરો.

સૂચિ શૈલી બદલો

જો તમને બુલેટ કેરેક્ટર અથવા નંબરની શૈલી પસંદ ન હોય જ ે તમારી 
સૂચિમાાં ડિફૉલ્ટ રૂપે અસાઇન કરવામાાં આવી હોય, તો તમે તેને હંમશેા 
બદલી શકો છો.

1	તમ ે જ ેશૈલી બદલવા માાંગો છો તે વસ્્તતુઓ પસંદ કરો.

2	ન ંબરિિંગ અથવા બુલેટ બટન સૂચિ તીરને ક્્લલિક કરો.

3	ન વી શૈલી પસંદ કરો.
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નવા બુલટ અક્ષર અથવા સખં્યા શૈલી પસંદ કરેલ ફકરા(ઓ) પર લાગુ 
કરવામાાં આવે છે.

યાદીઓ સાથે કામ કરવા માટે કીબોર્્ડ  શોર્્ટકટ્સ

	 કીસ્ટ્ રોક	 એક્શન

	 Enter	 પાછલા એક જવેા જ ફોર્મેટિિંગ સાથે નવો 
		  ફકરો દાખલ કરે છે.

	 Tab	 ફકરાને એક લેવલ ડિમોટ કરે છે.

	 Shift + Tab	 ફકરાને એક સ્્તરનો પ્રચાર કરે છે.

કાર્્ય 2 : ટેક્સ્ટ અને છબી પ્રસ્્તતુતિ શૈલીઓ
છબી શૈલી પસંદ કરો

1	 ચિત્ર પસંદ કરો.

2	 રિબન પર ફોર્મેટ ટેબ પર ક્્લલિક કરો.

3	 ચિત્ર શૈલી જૂથમાાં ઝડપી શૈલીઓ બટનને ક્્લલિક કરો.

4	શ ૈલી પસંદ કરો.

શૈલીમાાં ફેરફાર કરો

શૈલી લાગુ કર્યા પછી, વધુ કસ્ટમાઇઝ દેખાવ માટે પ્રીસેટ શૈલીના વિવિધ 
ઘટકોને સશંોધિત કરો.

1	 ચિત્ર પસંદ કરો.

2	 રિબન પર ફોર્મેટ ટેબ પર ક્્લલિક કરો.

3	 ચિત્ર શૈલીને સંપાદિત કરવા માટે ચિત્ર શૈલી જૂથમાાંના સાધનોનો 
ઉપયોગ કરો.

•	 ચિત્ર બોર્્ડ ર: બોર્્ડ રનો રંગ અને જાડાઈ સમાયોજિત કરો.

•	 ચિત્ર અસરો: ગ્્લલો અને બેવલ જવેી જટિલ અસરો ઉમેરો અથવા 
દૂર કરો.

•	 ચિત્ર લેઆઉટ: સ્માર્્ટઆર્્ટ  બનાવવા માટે ટેક્સ્ટ ઉમેરો અને ચિત્રને 
ફરીથી આકાર આપો.

ચિત્ર બદલો

તમે પહેલાથી જ લાગુ પડેલા કોઈપણ ચિત્ર શૈલી વિકલ્્પપોને રાખીને એક 
ચિત્રને બીજા માટે સ્્વવેપ કરી શકો છો.

2	તમ ે દાખલ કરવા માાંગો છો તે ચિત્રનો પ્રકાર પસંદ કરો.

3	ન ેવિગેટ કરો અન નવંુ ચિત્ર પસંદ કરો.

4	ખ ોલો અથવા દાખલ કરો ક્્લલિક કરો.

ચિત્રની અદલાબદલી થઈ ગઈ છે, પરંતુ શૈલી એ જ રહે છે.

1	 પસંદ કરેલ ચિત્ર સાથે, ફોર્મેટ ટેબ પર સમાયોજિત જૂથમાાં ચિત્ર બદલો 
બટનને ક્્લલિક કરો.

કાર્્ય 3 : ફોર્મેટિિંગ સાફ કરો

ફોર્મેટિિંગ પરૂ્્વવત્ કરો

છેલ્્લલા ફોર્મેટિિંગ ફેરફારને પરૂ્્વવત્  કરવા માટે પૂર્્વવત્ કરો પસંદ કરો.   

બધા ફોર્મેટિિંગ સાફ કરો

1	તમ ે સાફ કરવા માાંગો છો તે ફોર્મેટિિંગ સાથેનો ટેક્સ્ટ પસંદ કરો.

2	 Home > Clear All Formatting અથવા Ctrl + Spacebar 
દબાવો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.21.77
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IT & ITES	 	 એકસરસાાઈઝ 1.22.78
કોપા (COPA) - કોષ્્ટકો અને બુલેટેડ ટેક્સ્ટ મેનેજ કરો	

કોષ્્ટકો બનાવો (Create tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 પાવરપોઈન્ટમાાં કોષ્્ટકો દાખલ કરો
•	 બિલ્ટ-ઇન ટેબલ શૈલીઓ લાગુ કરો
•	 પંક્્તતિઓ અને કૉલમનો ઉલ્્લલેખ કરીને કોષ્્ટકો બનાવો.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પાવરપોઈન્ટમાાં કોષ્્ટકો દાખલ કરો 

10 કૉલમ અને 8 પંક્્તતિઓ સુધીનું કોષ્્ટક બનાવો

1	ત ે સ્્લલાઇડ પસંદ કરો કે જમેાાં તમે ટેબલ ઉમેરવા માાંગો છો.

2	 દાખલ કરો ટેબ પર, કોષ્્ટક પસંદ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

3	 કોષ્્ટક બનાવવા માટે તમને જરૂર હોય તેટલા સેલ પસંદ કરવા માટે 
કર્્સરને જમણે (કૉલમ પસંદ કરવા) અને નીચે (પંક્્તતિઓ પસંદ કરવા) 
ગ્રીડને ખસેડો અથવા ખેેંચો.

એક ટેબલ દોરો

ખાલી ટેબલ મેન્યુઅલી બનાવવા માટે, ઇન્્સર્્ટટ્્સ ટેબ પર, કોષ્્ટકો જૂથમાાં, 
કોષ્્ટક બટનને ક્્લલિક કરો, પછી ડ્્ર રોપડાઉન સૂચિમાાંથી કોષ્્ટક દોરો પસંદ 
કરો:

કર્્સર પેન્્સસિલમાાં બદલાય છે જ ેસ્્લલાઇડ પર સીધા કોષોને દોરવાની મંજૂરી 
આપે છે:

1	મ ાઉસ બટનને પકડી રાખો અને પેન્્સસિલ કર્્સરને એક લંબચોરસ દોરવા 
માટે ખસેડો જ ેનવા ટેબલની બાહ્ય ફ્રેમ હશે:

માઉસ બટન રીલીઝ કર્યા પછી, નવા ટેબલની બાહ્ય ફ્રેમ દેખાય છે, અને 
પાવરપોઈન્ટ ટેબલ ડિઝાઇન અને લેઆઉટ ટેબ્્સ દર્શાવે છે: 

•	 MS Office 2019 / નવીનતમ	          - 1 No.

© NIMI 

NOT TO BE REPUBLISHED



282

2	 ટેબલ ડિઝાઇન ટેબ પર, ડ્્ર રો બોર્્ડર્્સ  જૂથમાાં, જો તે પહેલેથી સક્ષમ ન 
હોય તો ડ્્ર રોઇંગને ફરીથી સક્ષમ કરવા માટે ડ્્ર રો ટેબલ બટનને ક્્લલિક 
કરો:

3	 ઇચ્છિત પંક્્તતિઓ અન કૉલમ દોરવા માટે માઉસ બટન દબાવો અને 
પેન્્સસિલ કર્્સરને ખસેડો.

જ્યારે તમ કર્્સરને ઊભી અથવા આડી રીતે ખસેડવાનું શરૂ કરો છો, ત્યારે 
પાવરપોઈન્ટ લાઇનને સીધી અને બરાબર ઊભી અથવા આડી અથવા 
હાલના કોષોના બે ખૂણાઓ વચ્ચે ત્રરાંસા રાખવાનો પ્રયાસ કરે છે.

નોોંધ: જો તમે ખોટી રીતે રેખા દોરો છો, તો તેને દૂર કરવા માટે 
ટેબલ ડિઝાઇન ટેબના ડ્્ર રો બોર્્ડ ર્્સ જૂથમાાં ઇરેઝર બટનને ક્્લલિક 
કરો:

4	 દોરવાનું બંધ કરવા માટે, નીચેનામાાંથી એક કરો:

•	ડ્ ્ર રો ટેબલ બટન પર ફરીથી ક્્લલિક કરો,

•	 ટેબલની બહાર સ્્લલાઇડ પર ગમે ત્યયાં ક્્લલિક કરો,

•	 Esc દબાવો

કાર્્ય 2 : ટેબલ શૈલીમાાં બિલ્ટ લાગુ કરો 

ફોર્મેટ કોષ્્ટક

ટેબલને ફોર્મેટ કરવંુ એ તેના દેખાવને મસાલા બનાવવાની સરળ રીત છે. 
કોષ્્ટક શૈલી એ વિવિધ ફોર્મેટિિંગ આદેશોનો સમહૂ છે જ ેએક જ પગલામાાં 
ટેબલ પર લાગુ કરી શકાય છે.

1	 પસંદ કરેલ કોષ્્ટક સાથે, ટેબલ ટૂલ્સ હેઠળ ડિઝાઇન ટેબ પર ક્્લલિક 
કરો.

2	 ટેબલ સ્ટાઇલ ગેલેરી મોર બટન પર ક્્લલિક કરો.

3	ન વી કોષ્્ટક શૈલી પસંદ કરો.

4	 કોષ્્ટક શૈલી વિકલ્્પપો જૂથમાાં એક વિકલ્્પ પર ક્્લલિક કરો:

•	 હેડર પંક્્તતિ: ટેબલની ટોચની પંક્્તતિને અન્ય ટેબલની પંક્્તતિઓથી 
અલગ રાખવા માટે ખાસ કરીને ફોર્મેટ કરે છે.

•	 કુલ પંક્્તતિ: કોષ્્ટકની છેલ્્લલી પંક્્તતિ માટે વિશિષ્્ટ ફોર્મેટિિંગ દર્શાવે 
છે.

•	 બેન્્ડડેડ પંક્્તતિઓ: કોષ્્ટક ડેટાને વાાંચવામાાં સરળ બનાવવા માટે 
પંક્્તતિઓને પણ વિષમ પંક્્તતિઓ કરતાાં અલગ રીતે ફોર્મેટ કરે છે.

•	 પ્રથમ કૉલમ: કોષ્્ટકની પ્રથમ કૉલમ માટે વિશિષ્્ટ ફોર્મેટિિંગ 
દર્શાવે છે.

•	 છેલ્્લલુું કૉલમ: કોષ્્ટકની છેલ્્લલી કૉલમ માટે વિશિષ્્ટ ફોર્મેટિિંગ 
દર્શાવે છે.

•	 બેન્્ડડેડ કૉલમ્્સ: ટેબલ ડેટાને વાાંચવામાાં સરળ બનાવવા માટે 
વિષમ કૉલમ્્સ કરતાાં અલગ કૉલમ પણ ફોર્મેટ કરે છે.
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જો તમે કોષ્્ટક ફોર્મેટિિંગને વધુ કસ્ટમાઇઝ કરવા માાંગો છો, તો ચોક્કસ 
કોષો અથવા સલે રેન્્જ પસંદ કરો અને ટેબલ સ્ટાઇલ જૂથમાાં શેડિિંગ, 
બોર્્ડર્્સ  અને ઇફેક્્ટ્્સ બટનનો ઉપયોગ કરો.

કાર્્ય 3 : પંક્્તતિઓ અને કૉલમનો ઉલ્્લલેખ કરીને કોષ્્ટકો બનાવો

એક ટેબલ દાખલ કરો

1	 ઇન્્સર્્ટ  ટેબલ સામગ્રી પ્્લલેસહોલ્્ડર પર ક્્લલિક કરો.

	તમ ે રિબન પર ઇન્્સર્્ટ  ટેબ અને પછી ટેબલ બટન પર ક્્લલિક કરીને 
ટેબલ પણ દાખલ કરી શકો છો.

2	 કૉલમ અન પંક્્તતિઓની સખં્યા સ્્પષ્્ટ કરો. 

3	 બરાબર ક્્લલિક કરો.

4	 સેલમાાં ક્્લલિક કરો અને તમારી માહિતી ટાઈપ કરો.

નેવિગશેન શોર્્ટકટ્સ:

•	 આગામી નજીકના કોષ પર જવા માટે ટેબ કી દબાવો.

•	 એક સમયે એક સેલ ખસેડવા માટે એરો કીનો ઉપયોગ કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.22.79
કોપા (COPA) - કોષ્્ટકો અને બુલેટેડ ટેક્સ્ટ મેનેજ કરો	

કોષ્્ટકો સશંોધિત કરો (Modify tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 કોષ્્ટક પંક્્તતિઓ અને કૉલમ દાખલ કરો અને કાઢી નાખો
•	 સેલ માર્જિન અને અતંર ગોઠવો
•	 કોષોને મર્્જ  અને વિભાજિત કરો
•	 કોષ્્ટકો, પંક્્તતિઓ અને કૉલમનું કદ બદલો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : કોષ્્ટકની પંક્્તતિઓ અને કૉલમ દાખલ કરો અને કાઢી નાખો

પંક્્તતિઓ અથવા કૉલમ ઉમેરો

તમે પંક્્તતિઓ અને કૉલમ દાખલ કરીને કોષ્્ટકને મોટંુ બનાવી શકો છો.

1	 પસંદ કરેલ કોષ્્ટક સાથે, લેઆઉટ ટેબ પર ક્્લલિક કરો.

2	 વધારાના કોષ્્ટક કોષો ઉમેરવા માટે પંક્્તતિઓ અને કૉલમ જૂથમાાં 
બટનોનો ઉપયોગ કરો.

3	અ થવા જમણું-ક્્લલિક કરો અને મીની ટૂલબારમાાં શામેલ ડ્્ર રોપડાઉન 
સૂચિ પસંદ કરો:

નવી પંક્્તતિઓ અથવા કૉલમ આના આધારે ઉમેરવામાાં આવે છે કોષ્્ટકમાાં 
કર્્સરની સ્થિતિ.

પંક્્તતિઓ અથવા કૉલમ કાઢી નાખો

તમે પંક્્તતિઓ અને કૉલમ કાઢી નાખીને કોષ્્ટકને નાનું બનાવી શકો છો.

1	તમ ે જ ેપંક્્તતિ અથવા કૉલમને કાઢી નાખવા માાંગો છો તેમાાં ક્્લલિક કરો.

2	લ ેઆઉટ ટેબ પર ડિલીટ બટન પર ક્્લલિક કરો.

3	 કાઢી નાખવાનો વિકલ્્પ પસંદ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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4	અ થવા જમણું-ક્્લલિક કરો અન મીની ટૂલબારમાાં ડ્્ર રોપડાઉન સૂચિ કાઢી 
નાખો પસંદ કરો:

કાર્્ય 2 : સેલ માર્જિન અને અતંર ગોઠવો 

સેલ માર્જિન બદલો

સલે સ્્પપેસિિંગ બદલવા માટે, એક સેલ અથવા ઘણા કોષો પસંદ કરો, પછી 
નીચેનામાાંથી એક કરો:

•	 ટેબલ લેઆઉટ ટેબ પર, સંરેખણ જૂથમાાં, સેલ માર્જિન્્સ ડ્્ર રોપડાઉન 
સૂચિ પર ક્્લલિક કરો અને નીચેના વિકલ્્પપોમાાંથી એક પસંદ કરો:

a	 સામાન્ય,

b	 કોઈ નહીીં,

c	સા ાંકડી,

d	 પહોળો,

e	 કસ્ટમ માર્જિન પર ક્્લલિક કરો.....

સલે ટેક્સ્ટ લેઆઉટ સંવાદ બૉક્સમાાં, આતંરિક માર્જિન વિભાગમાાં, તમે 
પસંદ કરો છો તે મૂલ્યો ટાઇપ કરો અથવા પસંદ કરો:

•	 પસંદગી પર જમણું-ક્્લલિક કરો, પછી પોપઅપ મેનૂમાાં ફોર્મેટ શેપ... 
પસંદ કરો. ફોર્મેટ શેપ ફલક પર, ટેક્સ્ટ ઓપ્શન્્સ ટેબ પર, ટેક્સ્ટબોક્સ 
જૂથમાાં, ડાબો હાાંસિયો, જમણો હાાંસિયો, ટોચનો માર્જિન અને બોટમ 
માર્જિન ફીલ્્ડડ્્સમાાં યોગ્્ય મૂલ્યો ટાઇપ કરો અથવા પસંદ કરો:

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.22.79

© NIMI 

NOT TO BE REPUBLISHED



286

દાખ્્લલા તરીકે:

કાર્્ય 3 : કોષોને મર્્જ  કરો અને વિભાજિત કરો

કોષોને મર્્જ  કરો

એક કોષમાાં બહુવિધ કોષ્્ટક કોષોને જોડવા માટે, નીચેના કરો:

1	તમ  જ ેકોષોને જોડવા માાંગો છો તેને પસંદ કરો.

2	ન ીચેનામાાંથી એક કરો:

•	 ટેબલ લેઆઉટ ટેબ પર, મર્્જ  કરો જૂથમાાં, કોષોને મર્્જ  કરો બટનને 
ક્્લલિક કરો:

•	 રાઇટ-ક્્લલિક કરો અને પોપઅપ મેનૂમાાં કોષોને મર્્જ  કરો પસંદ કરો:

નોોંધ: તમે ડ્્ર રોઇંગ ટૂલ્સનો પણ ઉપયોગ કરી શકો છો: ટેબલને 
સક્રિય કરો, પછી ટેબલ ડિઝાઇન ટેબ પર, ડ્્ર રો બોર્્ડ ર્્સ જૂથમાાં, 
ઇરેઝર બટનને ક્્લલિક કરો.

જ્યારે કર્્સર ઇરેઝરમાાં બદલાય છે, ત્યારે તમારે કોષોને મર્્જ  કરવાની જરૂર 
નથી તે બોર્્ડ રને ક્્લલિક કરો. સમાપ્્ત કર્યા પછી, ફરીથી ઇરેઝર બટન પર 
ક્્લલિક કરો અથવા Esc કી દબાવો

વિભાજિત કોષો

ટેબલ સેલ અથવા કોષોને બહુવિધ કોષોમાાં વિભાજિત કરવા માટે, નીચેના 
કરો:

1	તમ ે વિભાજિત કરવા માાંગો છો તે સેલ અથવા કોષોને સક્રિય કરો 
અથવા પસંદ કરો.

2	ન ીચેનામાાંથી એક કરો:

•	 ટેબલ લેઆઉટ ટેબ પર, મર્્જ  જૂથમાાં, સ્્પ્લલિટ સેલ બટનને ક્્લલિક 
કરો:

•	 રાઇટ-ક્્લલિક કરો અને પોપઅપ મેનૂમાાં સ્્પ્લલિટ સેલ પસંદ કરો:
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3	 વિભાજિત કોષો સંવાદ બોક્સમાાં, તમારે પસંદગીને વિભાજિત કરવાની 
જરૂર હોય તેવા કૉલમ અને પંક્્તતિઓની સખં્યા દાખલ કરો અથવા 
પસંદ કરો:

પસંદગીમાાંના દરેક કોષને ઉલ્્લલેખિત સખં્યામાાં કૉલમ અને પંક્્તતિઓમાાં 
વિભાજિત કરવામાાં આવશે.

નોોંધ: તમે ડ્્ર રોઇંગ ટૂલ્સનો પણ ઉપયોગ કરી શકો છો: ટેબલને 
સક્રિય કરો, પછી ટેબલ ડિઝાઇન ટેબ પર, ડ્્ર રો બોર્્ડ ર્્સ જૂથમાાં, 
ડ્્ર રો બટનને ક્્લલિક કરો:

જ્યારે કર્્સર પેન્્સસિલમાાં બદલાય છે, ત્યારે સેલ બોર્્ડ રમાાંથી તે બિિંદુથી ખેેંચો 
કે જ્યયાં તમે વિભાજન શરૂ કરવા માાંગો છો તે સેલ બોર્્ડ ર પર જ્યયાં તમે તેને 
રોકવા માાંગો છો. જ્યારે તમે ડ્્ર રોઇંગ કરી રહ્યયાં હોવ ત્યારે ડેશવાળી લાઇન 
વિભાજિત સ્થાન સૂચવે છે. જ્યારે તમે કર્્સર છોડો છો, ત્યારે હાલમાાં પસંદ 
કરેલી રેખા શૈલી, પહોળાઈ અને રંગની સરહદ ડેશ કરેલી રેખાને બદલે છે:

સમાપ્્ત કર્યા પછી, ફરીથી દોરો બટન પર ક્્લલિક કરો, ટેબલની બહાર ગમે 
ત્યયાં ક્્લલિક કરો, અથવા ડ્્ર રોઇંગ મોડને રોકવા માટે Esc કી દબાવો.

કાર્્ય 4 : કોષ્્ટકો, પંક્્તતિઓ અને કૉલમનું કદ બદલો 

કોષ્્ટક અને કોષ્્ટક તત્્વવોનું કદ બદલો

કોષ્્ટકનું કદ બદલવા માટે, કોષ્્ટકને સક્રિય કરો (કોષ્્ટક ડિઝાઇન અન 
લેઆઉટ ટેબ્્સ જોવા માટે કોષ્્ટકમાાં ગમે ત્યયાં ક્્લલિક કરો), અને પછી 
નીચેનામાાંથી કોઈપણ કરો:

•	 ટેબલની ઊંચાઈ, પહોળાઈ અથવા ઊંચાઈ અને પહોળાઈ બદલવા 
માટે કદ બદલવાના હેન્્ડલ્સને ખેેંચો:

•	 ટેબલ લેઆઉટ ટૅબ પર, કોષ્્ટક કદ જૂથમાાં, ઊંચાઈ અને સેટ કરો 
ચોક્કસ પરિમાણો માટે પહોળાઈ:

નોોંધ: ટેબલ લેઆઉટ ટૅબ પર, કોષ્્ટક કદ જૂથમાાં, જો તમે 
કોષ્્ટકનો આકાર બદલવા માાંગતા ન હોવ તો કોષ્્ટકનું કદ 
બદલતા પહેલા લૉક એસ્્પપેક્ટ રેશિયો ચકેબોક્સ પસંદ કરો.

કોષ્્ટક તત્્વવોની પહોળાઈ અથવા ઊંચાઈ બદલવા માટે, નીચનેામાાંથી એક 
કરો:

•	ત મેે બદલવાા માંંગોો છોો તેે કોોષ્ટક તત્વ અથવાા તત્વોો (કોોષ અથવાા 
કોોષોો, કૉૉલમ અથવાા કૉૉલમ, પંંક્તિ�િ અથવાા પંંક્તિ�િઓ) પસંંદ કરોો, પછીી 
નીીચેેનાામાંંથીી એક કરોો:

•	ટે બલ લેેઆઉટ ટૅૅબ પર, સેેલ સાાઇઝ જૂૂથમાંં:
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•	 પસંદગીની પહોળાઈ બદલવા માટે, પહોળાઈ ફીલ્્ડમાાં નવો નંબર 
દાખલ કરો, પછી Enter દબાવો,

•	 પસંદગીની ઊંચાઈ બદલવા માટે, ઊંચાઈ ફીલ્્ડમાાં નવો નંબર 
દાખલ કરો, પછી Enter દબાવો.

નોોંધ: તમે એક સમયે એક એકમ દ્વારા મૂલ્ય વધારવા અથવા 
ઘટાડવા માટે યોગ્્ય ફીલ્્ડની જમણી બાજુના તીરો પર ક્્લલિક 
કરી શકો છો.

•	 પસંદગીની અંદર પંક્્તતિઓ સમાન પહોળાઈ બનાવવા માટે 
પંક્્તતિઓનું વિતરણ કરો બટન પર ક્્લલિક કરો.

•	 પસંદગીની અંદર કૉલમને સમાન પહોળાઈ બનાવવા માટે કૉલમ 
વિતરણ કરો બટન પર ક્્લલિક કરો.

•	 સ્્તતંભની જમણી કિનારી અથવા પંક્્તતિની નીચેની કિનારીને તેની 
સૌથી પહોળી અથવા સૌથી લાાંબી  સામગ્રીને ફિટ કરવા માટે તેને 
માપવા માટે તેને ડબલ-ક્્લલિક કરો.

નોોંધો:

1	 કોષની સામગ્રી પ્રદર્શિત કરવા માટે કોલમની પહોળાઈને તેના કરતા 
ઓછી પર સેટ કરવાથી કોષની અંદરની સામગ્રી લપેટી જાય છે.

2	 પંક્્તતિની ઊંચાઈને તેની સામગ્રી પ્રદર્શિત કરવા માટે જરૂરી કરતાાં ઓછી 
પર સેટ કરવી ઊંચાઈને ન્યૂનતમ પર સેટ કરે છે.

•	 કોઈપણ કોષની આતંરિક સરહદ તરફ નિર્દેશ કરો. કર્્સર ડબલ-
માથાવાળા તીરમાાં બદલાયા પછી, તમારી  ઈચ્છા મુજબ સરહદને 
ખેેંચો:
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IT & ITES	 	 એકસરસાાઈઝ 1.22.80
કોપા (COPA) - કોષ્્ટકો અને બુલેટેડ ટેક્સ્ટ મેનેજ કરો

બુલેટેડ ટેક્સ્ટ બનાવો અને સશંોધિત કરો (Create and modify bulleted text)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ફકરાઓને ક્રમાાંકિત અને બુલટેેડ સૂચિ તરીકે ફોર્મેટ કરો
•	 બુલટે કેરેક્ટર અને નંબર ફોર્મેટ બદલો
•	 સચૂિ ઇન્્ડડેન્ટમાાં વધારો અને ઘટાડો
•	પ્રા રંભિક સખં્યાના મૂલ્યો સટે કરો
•	 પુનઃપ્રારંભ કરો અને વિવિધ સ્્લલાઇડ્સ પર સૂચિ નંબરિિંગ ચાલુ રાખો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ફકરાઓને ક્રમાાંકિત અને બુલટેેડ સૂચિ તરીકે ફોર્મેટ કરો 

EX.1.9.39 નો સંદર્્ભ લો. યાદીઓ બનાવો અને સશંોધિત કરો - કાર્્ય 1

કાર્્ય 2 : બુલટે કેરેક્ટર અને નંબર ફોર્મેટ બદલો 

Ex.1.9.39 નો સંદર્્ભ લો. યાદીઓ બનાવો અને સશંોધિત કરો - કાર્્ય 2

કાર્્ય 3 : સચૂિ ઇન્્ડડેન્ટમાાં વધારો અને ઘટાડો 

Ex.1.9.39 નો સંદર્્ભ લો. યાદીઓ બનાવો અને સશંોધિત કરો - કાર્્ય 4

કાર્્ય 4 : પ્રારંભિક સખં્યાની કિિંમતો સટે કરો  

Ex.1.9.39 નો સંદર્્ભ લો. યાદીઓ બનાવો અને સશંોધિત કરો - કાર્્ય 6

કાર્્ય 5 : પુનઃપ્રારંભ કરો અને વિવિધ સ્્લલાઇડ્સ પર સૂચિ નંબરિિંગ ચાલુ રાખો 

Ex.1.9.39 નો સંદર્્ભ લો. યાદીઓ બનાવો અને સશંોધિત કરો - કાર્્ય 5
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IT & ITES	 	 એકસરસાાઈઝ 1.22.80A
કોપા (COPA) - કોષ્્ટકો અને બુલેટેડ ટેક્સ્ટ મેનેજ કરો	

સંદર્્ભ તત્્વવો (હાયપરલિિંક્સ) બનાવો અને મેનેજ કરો (Create and manage reference elements 
(hyperlinks))
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 પ્રસ્્તતુતિઓમાાં હાઇપરલિિંક્સ બનાવો
•	 ફાઇલો અને અન્ય સ્ત્રોતો માટે પ્રસ્્તતુતિઓમાાં હાઇપરલિિંક બનાવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પ્રસ્્તતુતિઓમાાં હાઇપરલિિંક બનાવો 

તમારી પ્રસ્્તતુતિમાાં હાઇપરલિિંક ઉમેરવા માટે, નીચેના કરો:

1	 સ્્લલાઇડ પર કોઈપણ આકાર અથવા ટેક્સ્ટબોક્સ અથવા ચિત્ર પસંદ 
કરો: 

રોજગાર અને તાલીમ નિયામક (તાલીમ પાાંખ)

2	 ટેક્સ્ટ પસંદ કરો, તેના પર જમણું-ક્્લલિક કરો અને પછી હાઇપરલિિંક 
સૂચિ પસંદ કરો અને પછી પોપઅપ મેનૂમાાં લિિંક..... દાખલ કરો.

3	અ થવા ટૅબ દાખલ કરો હાયપરલિિંક દાખલ કરવા માટે લિિંક્સ 
જૂથમાાંથી લિિંક પસંદ કરો  

4	 કેટલીક વેબ સાઇટનું સરનામું દાખલ કરવા માટે:

•	ય ાદીની લિિંકમાાં હાલની ફાઇલ અથવા વેબ પેજ પસંદ કરો,

•	 આના દ્વારા હાઇપરલિિંક સરનામું દાખલ કરો:

•	ત ેને એડ્્રરેસ ટેક્સ્ટબોક્સમાાં ટાઇપ કરવું 

•	અ થવા બ્રાઉઝ ધ વેબ બટનનો ઉપયોગ કરીને વેબસાઈટ પસંદ 
કરવી - ,

•	 વૈકલ્્પપિક રીતે, ટેક્સ્ટબોક્સ દર્શાવવા માટે ટેક્સ્ટમાાંની લિિંક માટે 
ટેક્સ્ટ બદલો,

•	 વૈકલ્્પપિક રીતે, ScreenTip... બટનનો ઉપયોગ કરીને સ્ક્રીન ટીપ 
દાખલ કરો,

•	 બરાબર ક્્લલિક કરો.

પરિણામ: જ્યારે પ્રેઝન્ટેશન ક્્લલિક વિકલ્્પ હાઇપરલિિંક કરેલ ટેક્સ્ટ પર 
સક્ષમ હશે. તેથી ડિફૉલ્ટ બ્રાઉઝર દ્વારા વેબસાઇટ લિિંક ખોલવા માટે 
ડાયરેક્ટ સિિંગલ ક્્લલિક કરો.
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કાર્્ય 2 : ફાઇલો અને અન્ય સ્ત્રોતો માટે પ્રસ્્તતુતિઓમાાં હાઇપરલિિંક બનાવો 

1 થી 3 સુધીના પગલાને પુનરાવર્તિત કરો

આ PPT માાં સાથે સ્થળની હાઇપરલિિંક દાખલ કરવા માટે: 

1	મા ાંથી હાલની સ્્લલાઇડ પસંદ કરો

•	 પ્રથમ સ્્લલાઇડ

•	 છેલ્્લલી સ્્લલાઇડ

•	 આગળની સ્્લલાઇડ

•	 પાછલી સ્્લલાઇડ 

•	અ થવા સ્્લલાઇડ ટાઇટલ ---- બધી ઉપલબ્ધ સ્્લલાઇડમાાંથી

2	 બરાબર ક્્લલિક કરો.

પરિણામ: જ્યારે પ્રેઝન્ટેશન ક્્લલિક વિકલ્્પ હાઇપરલિિંક કરેલ ટેક્સ્ટ પર 
સક્ષમ હશે. તેથી સ્્લલાઇડ ખોલવા માટે ડાયરેક્ટ સિિંગલ ક્્લલિક કરો.
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2	 નવા દસ્્તતાવેજ બનાવવા માટે હાઇપરલિિંક દાખલ કરવા માટે:

•	લ ોકલ પીસીમાાં આવેલી ફાઈલને બ્રાઉઝ કરવા બદલો પર ક્્લલિક 
કરો અથવા એક્સ્્ટેંશન સહિત ફાઈલના નામ સાથે દસ્્તતાવેજનો 
સંપૂર્્ણ પાથ લખો

•	 બરાબર ક્્લલિક કરો

પરિણામ: જ્યારે પ્રેઝન્ટેશન ક્્લલિક વિકલ્્પ હાઇપરલિિંક કરેલ ટેક્સ્ટ પર 
સક્ષમ હશે. તેથી સ્્લલાઇડ ખોલવા માટે ડાયરેક્ટ સિિંગલ ક્્લલિક કરો. હાયપરલિિંક દાખલ કરવા માટે ઈ-મેલ સરનામું:

•	ય ાદીની લિિંકમાાં ઈ-મેલ સરનામું પસંદ કરો,

•	 ઈ મેલ એડ્્રરેસ ટેક્સ્ટબોક્સમાાં ઈ-મેલ એડ્્રરેસ દાખલ કરો,

•	 વૈકલ્્પપિક રીતે:

•	 ટેક્સ્ટ બોક્સ દર્શાવવા માટે ટેક્સ્ટમાાં લિિંક માટે ટેક્સ્ટ બદલો,

•	 ScreenTip... બટનનો ઉપયોગ કરીને સ્ક્રીન ટીપ દાખલ કરો,

•	 વિષય ટેક્સ્ટબોક્સમાાં ઈ-મેઈલ માટે વિષય દાખલ કરો,

•	 બરાબર ક્્લલિક કરો

પરિણામ: જ્યારે પ્રેઝન્ટેશન ક્્લલિક વિકલ્્પ હાઇપરલિિંક કરેલ ટેક્સ્ટ 
પર સક્ષમ હશે. તેથી તમારા કમ્્પ્યયુટર પર રૂપરેખાાંકિત ઈમેઈલ એજન્ટ 
(આઉટલુક) દ્વારા મેઈલ મોકલવા માટે ડાયરેક્ટ સિિંગલ ક્્લલિક કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.23.81
કોપા (COPA) - ગ્રાફિક તત્્વવોનું સંચાલન કરો	

ચિત્રો અને ટેક્સ્ટ બોક્સ દાખલ કરો (Insert illustrations and text boxes)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 આકારો દાખલ કરો
•	 ચિત્રો દાખલ કરો
•	 SmartArt ગ્રાફિક્સ દાખલ કરો
•	 સ્ક્રીનશૉટ્સ અને સ્ક્રીન ક્્લલિપિિંગ્્સ દાખલ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : આકારો દાખલ કરો

એક આકાર દાખલ કરો

1	 ઇન્્સર્્ટ  ટેબ પર ક્્લલિક કરો.

2	 આકારો પર ક્્લલિક કરો.

	 બધા ઉપલબ્ધ આકારો દર્શાવતું મેનુ દેખાય છે.

3	તમ ે દાખલ કરવા માાંગો છો તે આકાર પસંદ કરો.

	 સીધી રેખા દોરવા માટે, સંપૂર્્ણ ચોરસ અથવા વર્્તતુળ, અથવા અન્ય 
આકારોના પરિમાણોને નિયંત્રિત કરવા માટે, તમે ખેેંચો ત્યારે Shift કી 
દબાવો અને પકડી રાખો.

4	તમ ે જ્યયાં આકાર મૂકવા માાંગો છો ત્યયાં ક્્લલિક કરો અથવા સ્ક્રીન પર 
આકારને “ડ્્ર રો” કરવા માટે ક્્લલિક કરો અને ખેેંચો.

	 આકાર સ્્લલાઇડ પર દાખલ કરવામાાં આવે છે અને ડ્્ર રોઇંગ ટૂલ્સ હેઠળ 
રિબન પર ફોર્મેટ સંદર્્ભ ટેબ દેખાય છે.

કાર્્ય 2 : ચિત્રો દાખલ કરો 

પ્્લલેસહોલ્્ડર્્સ સાથે ચિત્રો દાખલ કરો

ચિત્ર દાખલ કરવાની સૌથી ઝડપી રીત એ સામગ્રી પ્્લલેસહોલ્્ડરનો ઉપયોગ 
કરવાનો છે જ ેતમારી સ્્લલાઇડ પર પહેલેથી જ છે.

1	 સામગ્રી પ્્લલેસહોલ્્ડરના ચિત્રો અથવા ઑનલાઇન ચિત્રો બટનને ક્્લલિક 
કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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2	તમ  ઉપયોગ કરવા માાંગો છો તે ચિત્ર પર નેવિગટે કરો અને તેને પસંદ 
કરો.

3	 ઇન્્સર્્ટ  પર ક્્લલિક કરો.

ચિત્ર દાખલ કરવામાાં આવે છે, અને રિબન પર ફોર્મેટ ટેબ દેખાય છે.

છબી દૂર કરવા માટે, ફક્્ત તેને પસંદ કરો અને કાઢી નાખો કી દબાવો.

રિબન સાથે ચિત્રો દાખલ કરો

જો કોઈ સામગ્રી પ્્લલેસહોલ્્ડર્્સ ઉપલબ્ધ ન હોય તો તમે ચિત્રો દાખલ કરવા 
માટે રિબનનો ઉપયોગ પણ કરી શકો છો.

1	 સ્્લલાઇડ પસંદ કરો જ્યયાં તમે ચિત્ર ઉમેરવા માાંગો છો.

4	તમ ે જ ેચિત્રનો ઉપયોગ કરવા માાંગો છો તેના પર નેવિગેટ કરો અથવા 
શોધો અને તેને પસંદ કરો.

	 એક સમયે એક કરતાાં વધુ ચિત્રો દાખલ કરવા માટે, તમે દરેક છબીને 
ક્્લલિક કરો ત્યારે Ctrl દબાવી રાખો.

5	 દાખલ કરો ક્્લલિક કરો.

2	 ઇન્્સર્્ટ  ટેબ પર ક્્લલિક કરો.

3	 ચિત્રો અથવા ઓનલાઈન ચિત્રો પર ક્્લલિક કરો.

કાર્્ય 3 : સ્માર્્ટઆર્્ટ  ગ્રાફિક્સ દાખલ કરો

SmartArt દાખલ કરો

SmartArt સવુિધા તમને ડિઝાઇનર-ગુણવત્તાવાળા આકૃતિઓ બનાવવા 
અને કસ્ટમાઇઝ કરવા દે છે. તમે સ્માર્્ટઆર્્ટ  ડાયાગ્રામ ટૂલ્સનો ઉપયોગ 
કરીને બુલેટેડ લિસ્ટને ડાયાગ્રામમાાં કન્્વર્્ટ  પણ કરી શકો છો.

1	 ઇન્્સર્્ટ  ટેબ પર ક્્લલિક કરો.

2	 રિબન પર સ્માર્્ટઆર્્ટ  બટનને ક્્લલિક કરો.

	તમ ે સામગ્રી પ્્લલેસહોલ્્ડરમાાં સ્માર્્ટઆર્્ટ  આઇકોનન પણ ક્્લલિક કરી 
શકો છો.

3	 શ્રેણી પસંદ કરો.

4	 ગ્રાફિક પસંદ કરો.

	 જમણી બાજુએ પરૂ્વાવલોકન અને વર્્ણન દેખાય છે.

5	 બરાબર ક્્લલિક કરો.
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સ્માર્્ટઆર્્ટ  ગ્રાફિક પ્રસ્્તતુતિમાાં દાખલ કરવામાાં આવે છે.

સ્માર્્ટઆર્્ટ  ગ્રાફિક પ્રકારો

	ય ાદી	 બિન-ક્રમિક માહિતી બતાવો.

	 પ્રક્રિયા	 પ્રક્રિયા અથવા સમયરેખામાાં પગલાાં બતાવો.

	 સાયકલ	 સતત પ્રક્રિયા બતાવો.

	 વશંવલેો	 એક સંસ્થા ચાર્્ટ  બનાવો અથવાનિર્્ણય વૃક્ષ.

	 સંબંધ	 જોડાણો સમજાવો.

	મ ેટ્્રરિક્સ	ભ ાગો સંપૂર્્ણ સાથે કેવી રીતે સંબંધિત છે તે બતાવો.

	પિ રામિડ	 ઉપર અથવા નીચે સૌથી મોટા ઘટક સાથે  
		  પ્રમાણસર સંબંધો બતાવો.

	 ચિત્ર	 એક સ્માર્્ટઆર્્ટ  ગ્રાફિક બનાવો જમેાાં ચિત્રોનો  
		  સમાવશે થાય છે.

કાર્્ય 4 : સ્ક્રીનશોટ અને સ્ક્રીન ક્્લલિપિિંગ્્સ દાખલ કરો

1	 પાવરપોઈન્ટમાાં: ઈન્્સર્્ટ  ટેબ પર, ઈમેજીસ ગ્રુપમાાં, સ્ક્રીનશોટ પર ક્્લલિક 
કરો.

2	 ઉપલબ્ધ વિન્્ડડોઝ ગેલેરી દેખાય છે, જ ે તમને હાલમાાં ખુલેલી બધી 
વિન્્ડડો દર્શાવે છે. નીચેનામાાંથી એક કરો:

•	તમ ારા દસ્્તતાવેજમાાં સમગ્ર વિન્્ડડોનો સ્ક્રીનશોટ દાખલ કરવા માટે, 
તે વિન્્ડડોની થંબનેલ ઈમેજ પર ક્્લલિક કરો.

•	 ઉપલબ્ધ વિન્્ડડોઝ ગેલેરીમાાં દર્શાવેલ પ્રથમ વિન્્ડડોનો પસંદ કરેલ 
ભાગ ઉમેરવા માટે, સ્ક્રીન ક્્લલિપીીંગ પર ક્્લલિક કરો; જ્યારે સ્ક્રીન 
સફેદ થઈ જાય અને પોઇન્ટર ક્રોસ બની જાય, ત્યારે ડાબું માઉસ 
બટન દબાવો અને પકડી     રાખો અને સ્ક્રીનના જ ે ભાગને તમે 
કેપ્ચર કરવા માાંગો છો તેને પસંદ કરવા માટે ખેેંચો.

3	તમ ે પસંદ કરેલ વિન્્ડડો અથવા સ્ક્રીનનો ભાગ આપમેળે તમારા 
દસ્્તતાવેજમાાં ઉમેરવામાાં આવે છે. તમે સ્ક્રીનશૉટને સંપાદિત કરવા અને 
વધારવા માટે પિક્્ચર ટૂલ્સ ટૅબ પરના સાધનોનો ઉપયોગ કરી શકો 
છો.
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IT & ITES	 	 એકસરસાાઈઝ 1.23.82
કોપા (COPA) - ગ્રાફિક તત્્વવોનું સંચાલન કરો	

ફોર્મેટ ચિત્રો અને ટેક્સ્ટ બોક્સ (Format illustrations and text boxes)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 કલાત્મક અસરો લાગુ કરો
•	 ચિત્ર પ્રભાવો અને ચિત્ર શૈલીઓ લાગુ કરો
•	 ચિત્ર પૃષ્્ઠભૂમિ દૂર કરો
•	 છબીઓ કાપો
•	 ગ્રાફિક ઘટકોને ફોર્મેટ કરો
•	 SmartArt ગ્રાફિક્સ ફોર્મેટ કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : કલાત્મક અસરો લાગુ કરો 

એક આકાર દાખલ કરો

કલાત્મક અસરો લાગુ કરો

1	 ચિત્ર પસંદ કરો.

2	 ચિત્ર સાધનો > ફોર્મેટ પસંદ કરો અને કલાત્મક પસંદ કરો અસરો.

3	 પૂર્વાવલોકન કરવા માટે વિકલ્્પપો પર હોવર કરો અને પસંદ કરો જ ેતમે 
ઇચ્છો છો. 

કાર્્ય 2 : ચિત્ર પ્રભાવો અને ચિત્ર શૈલીઓ લાગુ કરો

એક શૈલી પસંદ કરો

1	 ચિત્ર પસંદ કરો.

2	 રિબન પર ફોર્મેટ ટેબ પર ક્્લલિક કરો.

3	 ચિત્ર શૈલીમાાં ઝડપી શૈલીઓ બટનને જૂથ ક્્લલિક કરો

4	શ લી પસંદ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.

Before: 

 After Artistic Effects:
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શૈલીમાાં ફેરફાર કરો

શૈલી લાગુ કર્યા પછી, વધુ કસ્ટમાઇઝ દેખાવ માટે પ્રીસેટ શૈલીના વિવિધ 
ઘટકોને સશંોધિત કરો.

1	 ચિત્ર પસંદ કરો.

2	 રિબન પર ફોર્મેટ ટેબ પર ક્્લલિક કરો.

3	 ચિત્ર શૈલીને સંપાદિત કરવા માટે ચિત્ર શૈલી જૂથમાાંના સાધનોનો 
ઉપયોગ કરો.

• 	 ચિત્ર બોર્્ડ ર: બોર્્ડ રનો રંગ સમાયોજિત કરો અનેજાડાઈ

•	 ચિત્ર અસરો: જટિલ ઉમેરો અથવા દૂર કરો ગ્્લલો અને બેવલ જવેી 
અસરો.

•	 ચિત્ર લેઆઉટ: ટેક્સ્ટ ઉમેરો અને ચિત્રને ફરીથી આકાર આપો 
સ્માર્્ટઆર્્ટ  બનાવવા માટે.

ચિત્ર બદલો

તમે પહેલાથી જ લાગુ પડેલા કોઈપણ ચિત્ર શૈલી વિકલ્્પપોને રાખીને એક 
ચિત્રન બીજા માટે સ્્વવેપ કરી શકો છો.

1	 પસંદ કરેલ ચિત્ર સાથે, ફોર્મેટ ટેબ પર સમાયોજિત જૂથમાાં ચિત્ર બદલો 
બટનને ક્્લલિક કરો.

2	તમ ે દાખલ કરવા માાંગો છો તે ચિત્રનો પ્રકાર પસંદ કરો.

3	ન ેવિગેટ કરો અન નવું ચિત્ર પસંદ કરો.

4	ખ ોલો અથવા દાખલ કરો ક્્લલિક કરો.

	 ચિત્રની અદલાબદલી થઈ ગઈ છે, પરંતુ શૈલી એ જ રહે છે.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.82

	 Before: 	

	 After:	 	  

	 Before:

 After:
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કાર્્ય 3 : ચિત્રની પૃષ્્ઠભૂમિ દૂર કરો

એક પૃષ્્ઠભૂમિ દૂર કરો

તમે તમારી પ્રસ્્તતુતિમાાં કોઈપણ સ્ક્રીનશોટ, ચિત્ર અથવા ગ્રાફિકની 
પૃષ્્ઠભૂમિને દૂર કરી શકો છો.

1	તમ ે દૂર કરવા માાંગો છો તે પૃષ્્ઠભૂમિ સાથેનું ચિત્ર પસંદ કરો.

2	 ફોર્મેટ ટેબ પર પૃષ્્ઠભૂમિ દૂર કરો ક્્લલિક કરો.

	 રિબન પર એક નવું ટેબ દેખાય છે, અને ચિત્ર તેજસ્્વવી કિરમજી રંગથી 
પ્રકાશિત થાય છે. કોઈપણ કિરમજી વિસ્્તતારો દૂર કરવામાાં આવશે.

	તમ ે જ ે રાખવા માાંગો છો તેની આસપાસ બોક્સને ક્્લલિક કરો અન 
ખેેંચો.

3	 રિફાઇન જૂથમાાં માર્્ક  વિસ્્તતારો બટન પર ક્્લલિક કરો:

•	 રાખવા માટેના વિસ્્તતારોને ચિહ્નિત કરો: તમે જ ેચિત્ર રાખવા માાંગો 
છો તેના વિસ્્તતારો પર રેખાઓ દોરો.

•	 દૂર કરવા માટેના વિસ્્તતારોને ચિહ્નિત કરો: તમે જ ેચિત્રન દૂર કરવા 
માાંગો છો તેના વિસ્્તતારો પર રેખાઓ દોરો.

4	 ચિત્રના વિભાગને ઉમેરવા અથવા દૂર કરવા માટે તેના પર ક્્લલિક કરો 
અને ખેેંચો.

5	 Keep Changes પર ક્્લલિક કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.82
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પૃષ્્ઠભમૂિ પનુઃસ્થાપિત કરવા માટે, છબી પસંદ કરો, પૃષ્્ઠભૂમિ દૂર કરો 
બટનન ક્્લલિક કરો અને બધા ફેરફારો કાઢી નાખો પર ક્્લલિક કરો.

કાર્્ય 4 : છબીઓ કાપો

હેન્્ડલ્સ દ્વારા ચિત્ર કાપો

ક્રોપિિંગ હેન્્ડલ્સનો ઉપયોગ કરીને ચિત્ર કાપવાની સૌથી સરળ રીતનો 
ઉપયોગ કરવા માટે, નીચેના કરો:

1	 ચિત્રને પસંદ કરવા માટે તેના પર ક્્લલિક કરો.

નોોંધ: તમે એક સાથે અનકે ચિત્રો કાપી શકતા નથી.

2	 ચિત્ર ફોર્મેટ ટેબ પર, કદ જૂથમાાં, કાપો બટનને ક્્લલિક કરો:

નોોંધ: તમે ક્રોપ ડ્્ર રોપડાઉન સૂચિ પણ ખોલી શકો છો અને ક્રોપ 
આદેશ પસંદ કરી શકો છો:

3	 બિનજરૂરી વિસ્્તતારોને કાપવા માટે ઇમેજના ખૂણામાાં અને બાજુઓ પર 
દેખાતા કાળા હેન્્ડલ્સને ખેેંચો:

	 જ ેવિસ્્તતારોને કાપેલા ચિત્રમાાંથી બાકાત રાખવામાાં આવશે તે શેડમાાં છે:

4	 જ્યયાં સુધી ઇમેજના તમામ બિનજરૂરી વિસ્્તતારો દૂર કરવામાાં ન આવે 
ત્યયાં સુધી પુનરાવર્્તન કરો. જ્યારે તમે સમાપ્્ત કરો, ત્યારે ચિત્રની 
સીમાઓની બહાર ક્્લલિક કરો અથવા ક્રોપ ઇફેક્ટ લાગુ કરવા માટે 
ફરીથી ક્રોપ બટન પર ક્્લલિક કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.82

 Result:
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“નંબર દ્વારા” ચિત્રને કાપો

ફોર્મેટ પિક્્ચર પને પર ક્રોપ સેટિિંગ્્સનો ઉપયોગ કરીને “નંબરો દ્વારા” ચિત્રન 
કાપવા માટે, નીચનેા કરો:

1	 ચિત્ર પર જમણું-ક્્લલિક કરો અને પોપઅપ મેનૂમાાં ફોર્મેટ પિક્્ચર... પસંદ 
કરો:

2	 ફોર્મેટ પિક્્ચર પેન પર, ચિત્ર જૂથમાાં, પાક વિભાગમાાં:

•	 ચિત્ર સ્થિતિ હેઠળ:

•	 ચિત્રનું કદ બદલવા અન ફ્રેમના પરિમાણો રાખવા માટે 
પહોળાઈ અને ઊંચાઈ ફીલ્્ડમાાં મૂલ્યો પસંદ કરો  અથવા 
દાખલ કરો,

•	 ઑફસેટ X અને ઑફસેટ Y ફીલ્્ડડ્્સમાાં ઇચ્છિત મૂલ્યો પસંદ 
કરો અથવા દાખલ કરો:

•	 પાકની સ્થિતિ હેઠળ:

•	 જમણી બાજુથી ચિત્ર કાપવા માટે પહોળાઈ ફીલ્્ડમાાં મૂલ્ય 
ઘટાડવું,

•	 ચિત્રને તળિયેથી કાપવા માટે ઊંચાઈ ફીલ્્ડમાાં મૂલ્ય ઘટાડવું,

•	અ નુક્રમે તે બાજુઓમાાંથી ચિત્ર કાપવા માટે ડાબી અને ટોચની 
ફીલ્્ડમાાં મૂલ્યો પસંદ કરો અથવા ટાઇપ કરો:

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.82
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ચિત્રને આકારમાાં કાપો

ચિત્રન આકારમાાં કાપવા માટે, નીચેના કરો:

1	 ચિત્રને પસંદ કરવા માટે તેના પર ક્્લલિક કરો.

2	 ચિત્ર ફોર્મેટ ટેબ પર, કદ જૂથમાાં, કાપો બટનને ક્્લલિક કરો અન પછી 
ડ્્ર રોપડાઉન સૂચિમાાંથી આકારમાાં કાપો પસંદ કરો:

3	 ખુલતી ગેલેરીમાાંથી આકાર પસંદ કરો:

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.82
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આકારમાાં છબી ભરો અથવા ફિટ કરો

પાવરપોઈન્ટ ઈમેજો માટે બે સુવિધાઓ પ્રદાન કરે છે જ ેતેમને આકારમાાં 
રાખવામાાં મદદ કરી શકે છે:

•	ભ રો વિકલ્્પ આકારની ઊંચાઈ અથવા પહોળાઈ, બમેાાંથી જ ેમોટંુ હોય 
તેને મેચ કરવા માટે છબીના કદને સમાયોજિત કરે છે:

•	 ફીટ વિકલ્્પ છબીના કદને સમાયોજિત કરે છે જથેી કરીને ઊંચાઈ અને 
પહોળાઈ બનંે આકાર સાથે મેળ ખાય:

કાર્્ય 5 : ગ્રાફિક ઘટકોને ફોર્મેટ કરો

બ્રાઇટનેસ, કોન્ટ્રા સ્ટ અથવા શાર્્પનેસ એડજસ્ટ કરો

1	 ચિત્ર પસંદ કરો.

2	 Picture Tools > Format પસંદ કરો અને સુધારાઓ પસંદ કરો.

3	વિ કલ્્પપોનું પૂર્વાવલોકન કરવા માટે તેના પર હોવર કરો અને તમને 
જોઈતો એક પસંદ કરો.

કલાત્મક અસરો લાગુ કરો

1	 ચિત્ર પસંદ કરો.

2	 Picture Tools > Format પસંદ કરો અને કલાત્મક પસંદ કરો 
અસરો.

3	વિ કલ્્પપોનું પૂર્વાવલોકન કરવા માટે તેના પર હોવર કરો અને તમને 
જોઈતો એક પસંદ કરો.

રંગ બદલો

1	 ચિત્ર પસંદ કરો.

2	 Picture Tools > Format પસંદ કરો અને રંગ પસંદ કરો.

3	વિ કલ્્પપોનું પૂર્વાવલોકન કરવા માટે તેના પર હોવર કરો અને તમને 
જોઈતો એક પસંદ કરો.

પિક્્ચર ઇફેક્્ટ્્સ લાગુ કરો

1	 ચિત્ર પસંદ કરો.

2	 Picture Tools > Format પસંદ કરો અને ચિત્ર પસંદ કરો અસરો.

3	તમન ે જોઈતું એક પસંદ કરો: પડછાયો, પ્રતિબિિંબ, ગ્્લલો,નરમ કિનારીઓ, 
બેવલ અથવા 3-D પરિભ્રમણ.

સરહદ ઉમેરો

1	 ચિત્ર પસંદ કરો.

2	 Picture Tools > Format પસંદ કરો અને બોર્્ડ ર પસંદ કરો.

ચિત્રને સકુંચિત કરો

1	 ચિત્ર પસંદ કરો.

2.	 Picture Tools > Format પસંદ કરો અન કોમ્પ્રેસ પિક્્ચર્્સ પસંદ 
કરો.

3	તમન ે જોઈતા વિકલ્્પપો પસંદ કરો અને બરાબર પસંદ કરો.

ચિત્ર રીસેટ કરો

1	 ચિત્ર પસંદ કરો.

2	 Picture Tools > Format પસંદ કરો અન રીસેટ પસંદ કરો ચિત્ર

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.82
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કાર્્ય 6 : સ્માર્્ટઆર્્ટ  ગ્રાફિક્સ ફોર્મેટ કરો

SmartArt ફોર્મેટ કરો

પાવરપોઈન્ટમાાં વિવિધ પ્રકારના સ્માર્્ટઆર્્ટ  લેઆઉટ અને શૈલીઓ છે જ ે
તમને બટનના ક્્લલિક સાથે તમારા સ્માર્્ટઆર્્ટ  ગ્રાફિક્સને ફોર્મેટ કરવાની 
મંજૂરી આપે છે.

1	 SmartArt ગ્રાફિક પસંદ કરો.

2	 સ્માર્્ટઆર્્ટ  ટૂલ્સ ડિઝાઇન ટેબ પર રંગો બદલો બટનને ક્્લલિક કરો.

3	મ નુમાાંથી રંગ પસંદ કરો.

4	 સ્માર્્ટઆર્્ટ  સ્ટાઇલ ગેલેરી માટે વધુ બટન પર ક્્લલિક કરો. 

	 કેટલીક સુંદર જગંલી શૈલીઓ ઉપલબ્ધ હોવા છતાાં,  તેને સરળ રાખવું 
શ્રેષ્્ઠ છે.

5	શ ૈલી પસંદ કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.82
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IT & ITES	 	 એકસરસાાઈઝ 1.23.83
કોપા (COPA) - ગ્રાફિક તત્્વવોનું સંચાલન કરો	

ગ્રાફિક ઘટકોમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો (Add and modify text in graphic elements)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ટેક્સ્ટ બોક્સમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો
•	 આકારોમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો
•	 SmartArt ગ્રાફિક ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો
•	 ચાર્્ટ  બનાવો, દાખલ કરો અને સશંોધિત કરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટેક્સ્ટ બોક્સમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો

સ્્લલાઇડ પર ટેક્સ્ટ બોક્સ દાખલ કરો

ટેક્સ્ટ બોક્સ દાખલ કરવા માટે, ઇન્્સર્્ટ  ટેબ પર, ટેક્સ્ટ જૂથમાાં, ટેક્સ્ટ 
બોક્સ બટનન ક્્લલિક કરો:

•	ટ ક્સ્ટ બોક્સ બનાવવા માટે કે જ ેતમે એક લીટી પર જ ેપણ ટાઇપ કરો 
છો તેને ફિટ કરવા માટે વિસ્્તતૃત થાય છે, ફક્્ત સ્્લલાઇડ પર ક્્લલિક કરો 
જ્યયાં તમે ટેક્સ્ટ બોક્સ મૂકવા માાંગો છો અને પછી ટેક્સ્ટ દાખલ કરો:

•	 એક નિશ્ચિત પહોળાઈનું ટેક્સ્ટ બોક્સ બનાવવા માટે, જ્યયાં તમે ટેક્સ્ટ 
બોક્સ મૂકવા માાંગો છો ત્યયાં બોક્સને ખેેંચો અને પછી ટેક્સ્ટ દાખલ 
કરો:

ટેક્સ્ટ ફીલ્્ડ એક લાઇનની ઊંચાઈને ફિટ કરવા માટે ગોઠવાય છે પરંતુ 
તમે ઉલ્્લલેખિત કરો છો તે પહોળાઈ જાળવી રાખે છે. જ્યારે ટેક્સ્ટ ફીલ્્ડની 
જમણી સીમા પર પહોોંચે છે, ત્યારે એક નવી લાઇન આપમેળે ઉમેરવામાાં 
આવે છે, અને ટેક્સ્ટ લપટેી જાય છે. જમે જમે ટેક્સ્ટ દાખલ કરવામાાં આવે છે 
તેમ, બૉક્સની પહોળાઈ સમાન રહે છે, પરંતુ તમામ ટેક્સ્ટને સમાવવા માટે 
જરૂરિયાત મુજબ ઊંચાઈ વધે છે.

સ્્લલાઇડમાાં ટેક્સ્ટ કાઢી નાખો

માત્ર એક અથવા થોડા અક્ષરો કાઢી નાખવા માટે, નીચે મુજબ કરો:

1	તમ ે જ ે ટેક્સ્ટને કાઢી નાખવા માાંગો છો તેની ડાબી (જમણી બાજુએ) 
કર્્સરને તરત જ સ્થિત કરો.

2	તમ ે કાઢી નાખવા માાંગો છો તે દરેક અક્ષર માટે એકવાર કાઢી નાખો 
(બેકસ્્પપેસ) કી દબાવો.

ગમે તેટલા ટેક્સ્ટને ડિલીટ કરવા માટે, તમે ડિલીટ કરવા માાંગો છો તે 
ટેક્સ્ટ પસંદ કરો, પછી ડિલીટ કી અથવા બેકસ્્પપેસ કી દબાવો.

કાર્્ય 2 : આકારોમાાં ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો

સ્્લલાઇડ પર આકાર દાખલ કરવા માટે, દાખલ કરો ટેબ પર, ચિત્ર જૂથમાાં, 
આકારો બટનને ક્્લલિક કરો, અને પછી આકારોની ડ્્ર રોપડાઉન સૂચિમાાંથી તમે 
જ ેઆકાર દાખલ કરવા માાંગો છો તે પસંદ કરો:

ટેક્સ્ટને સીધા આકારોમાાં ઉમેરવા માટે, નીચેનામાાંથી એક કરો:

•	 એક આકાર પસંદ કરો, પછી તમે આકાર પર પ્રદર્શિત કરવા માાંગો છો 
તે ટેક્સ્ટ દાખલ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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•	 આકાર પર જમણું-ક્્લલિક કરો અને પોપઅપ મેનૂમાાં ટેક્સ્ટ સંપાદિત 
કરો પસંદ કરો:

•	 આકાર પર ડબલ-ક્્લલિક કરો - કર્્સર ટેક્સ્ટનું સ્થાન સૂચવતું દેખાય છે; 
ટાઇપ કરવાનું શરૂ કરો.

ટેક્સ્ટ પસંદ કરો

પાવરપોઈન્ટ પ્રેઝન્ટેશન સ્્લલાઈડમાાં એક અક્ષર પસંદ કરવા માટે, 
નીચેનામાાંથી એક કરો:

•	 કીબોર્્ડ નો ઉપયોગ કરીને: કર્્સરને ટેક્સ્ટની શરૂઆતમાાં (ટેક્સ્ટના 
અતંે) મૂકો અને પછી અક્ષર/શબ્દ/લાઇન પસંદ કરવા માટે Shift+ 
જમણો તીર (ડાબો તીર) દબાવો

•	 માઉસનો ઉપયોગ કરીને: અક્ષર/ શબ્દ/ રેખાની સામે ક્્લલિક કરો 
(અક્ષર/ શબ્દ/ રેખા પછી) અને જ્યારે તમે તમારા કર્્સરને તેને પસંદ 
કરવા માટે ખેેંચો ત્યારે પકડી રાખો:

પાવરપોઈન્ટ પ્રેઝન્ટેશન સ્્લલાઈડમાાં એક શબ્દ પસંદ કરવા માટે, નીચેનામાાંથી 
એક કરો:

પાવરપોઈન્ટ પ્રેઝન્ટેશન સ્્લલાઈડમાાં લીટી પસંદ કરવા માટે, નીચેનામાાંથી 
એક કરો:

પાવરપોઈન્ટ પ્રેઝન્ટેશન સ્્લલાઈડમાાં ફકરો પસંદ કરવા માટે, નીચેનામાાંથી 
એક કરો:

પાવરપોઈન્ટ પ્રેઝન્ટેશન સ્્લલાઈડમાાં ટુકડો પસંદ કરવા માટે, નીચેનામાાંથી 
એક કરો:

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.83

•	 કીબોર્્ડન ો ઉપયોગ કરીને: કર્્સરને તમે જ ેટુકડાને પસંદ કરવા માાંગો છો 
તેની શરૂઆતમાાં મૂકો (અતંમાાં), અને Shift+ જમણો એરો (ડાબો તીર) 
દબાવો.

લીટી પસંદ કરવા માટે, Shift+ એરો ડાઉન (એરો ઉપર) દબાવો.

•	મ ાઉસનો ઉપયોગ કરીને: ટુકડાના પ્રથમ અક્ષરની સામે ક્્લલિક કરો 
(ટુકડાના છેલ્્લલા અક્ષર પછી), Shift દબાવી રાખો અને પછી તમે જ ે
ટુકડાને પસંદ કરવા માાંગો છો તેના છેલ્્લલા અક્ષર પછી ક્્લલિક કરો 
(ટુકડાના પ્રથમ અક્ષરની સામે).

વર્્તમાન પ્્લલેસહોલ્્ડરમાાં તમામ સામગ્રી પસંદ કરવા માટે, નીચેનામાાંથી એક 
કરો:

•	 હોમ ટેબ પર, સંપાદન જૂથમાાં, પસંદ કરો બટનને ક્્લલિક કરો, અને પછી 
બધા પસંદ કરો પર ક્્લલિક કરો:

•	 Ctrl+A દબાવો.
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કાર્્ય 3 : SmartArt ગ્રાફિક ટેક્સ્ટ ઉમેરો અને સશંોધિત કરો

સ્માર્્ટઆર્્ટ  ગ્રાફિક્સની રચના કરો

સ્માર્્ટઆર્્ટ  ગ્રાફિકમાાં ટેક્સ્ટ ઉમેરવાની બે રીત છે: ટેક્સ્ટ પેન અથવા 
ગ્રાફિકનો ઉપયોગ કરીને.

1	 સ્માર્્ટઆર્્ટ  ડાયાગ્રામ પસંદ કરો.

2	 સ્માર્્ટઆર્્ટ  ગ્રાફિકની ડાબી ધાર પરના તીરને ક્્લલિક કરો.

3	ટ ક્સ્ટ ફલકમાાં દરેક બલુેટ માટે ટેક્સ્ટ લખો.

4	ટ ક્સ્ટ પેનનાાં ક્્લલોઝ બટનન ક્્લલિક કરો અથવા સ્માર્્ટઆર્્ટ  ડાયાગ્રામની 
બહાર ક્્લલિક કરો.

5	 ગ્રાફિકમાાં કોઈપણ ન વપરાયેલ આકારો પસંદ કરો.

6	ત ેમને ગ્રાફિકમાાંથી દૂર કરવા માટે Backspace અથવા Delete કી 
દબાવો.

કાર્્ય 4 : ચાર્્ટ  બનાવો, દાખલ કરો અને સશંોધિત કરો

1	 Click Insert > Chart.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.83

સૂચિને સ્માર્્ટઆર્્ટ  ગ્રાફિકમાાં કન્્વર્્ટ  કરો

1	તમ ે સ્માર્્ટઆર્્ટમાાં કન્્વર્્ટ  કરવા માાંગો છો તે સૂચિ સાથેની સ્્લલાઇડ પસંદ 
કરો.

2	ય ાદી લખાણ બોક્સ પસંદ કરો.

3	 હોમ ટેબ પર કન્્વર્્ટ  ટુ સ્માર્્ટઆર્્ટ  ગ્રાફિક બટન પર ક્્લલિક કરો.

4	 સ્માર્્ટઆર્્ટ  શૈલી પસંદ કરો.

5	 જરૂર મુજબ ગ્રાફિકનું માપ બદલો અને સ્થાન આપો.
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2	 ચાર્્ટ  પ્રકાર પર ક્્લલિક કરો અને પછી તમને જોઈતા ચાર્્ટ  પર ડબલ-
ક્્લલિક કરો.

3	 દેખાય છે તે કાર્્યપત્રકમાાં, પ્્લલેસહોલ્્ડર ડેટાને તમારી પોતાની માહિતી 
સાથે બદલો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.83

4	જ્યા રે તમે ચાર્્ટ  દાખલ કરો છો, ત્યારે તેના ઉપરના જમણા ખૂણાની 
બાજુમાાં નાના બટનો દેખાય છે. અક્ષ શીર્્ષકો અથવા ડેટા લેબલ 
જવેી વસ્્તતુઓ બતાવવા, છુપાવવા અથવા ફોર્મેટ કરવા માટે ચાર્્ટ  
એલિમેન્્ટ્્સ બટનનો ઉપયોગ કરો. અથવા ચાર્્ટનો રંગ અથવા શૈલી 
ઝડપથી બદલવા માટે ચાર્્ટ  સ્ટાઇલ બટનનો ઉપયોગ કરો.

સ્્લલાઇડ પર ચાર્્ટ  ડેટા બદલો

1	 સ્્લલાઇડ પર, તમે બદલવા માાંગો છો તે ચાર્્ટ  પસંદ કરો. ચાર્્ટ  ડિઝાઇન 
ટૂલ્સ સંદર્્ભ ટેબ પાવરપોઇન્ટ વિન્્ડડોની ટોચ પર દેખાય છે.

2	 ચાર્્ટ  ટૂલ્સ હેઠળ, ચાર્્ટ  ડિઝાઇન ટેબ પર, ડેટા જૂથમાાં, ડેટા સંપાદિત 
કરો પર ક્્લલિક કરો.

© NIMI 

NOT TO BE REPUBLISHED



308

3	ન ીચેનામાાંથી એક કર્્યુું:

•	 પાવરપોઈન્ટમાાં ડેટા સંપાદિત કરવા માટે, ડેટા સંપાદિત કરો પર 
ક્્લલિક કરો. આ તમારી સ્પ્રેડશીટમાાંથી એક વિન્્ડડો ખોલશ.

•	 Excel માાં સીધો ડેટા સંપાદિત કરવા માટે, Excel માાં ડેટા સંપાદિત 
કરો પર ક્્લલિક કરો.

4	તમન  જોઈતા ફેરફારો કરો. તેઓ પાવરપોઈન્ટના ચાર્્ટમાાં પ્રતિબિિંબિત 
થશે.

ચાર્્ટ નો પ્રકાર બદલો

વિવિધ પ્રકારની માહિતી પ્રસ્્તતુત કરવા માટે વિવિધ પ્રકારના ચાર્્ટ  વધુ સારા 
છે. ઉદાહરણ તરીકે, કૉલમ ચાર્્ટ  વિવિધ વસ્્તતુઓના મૂલ્યોની તુલના કરવા 
માટે શ્રેષ્્ઠ છે, પરંતુ વલણો અથવા સંબંધોને દર્શાવવા માટે નહીીં. જો તમને 
લાગે કે તમે બનાવેલ ચાર્્ટ  તમારા ડેટા માટે સૌથી યોગ્્ય નથી, તો તમે એક 
અલગ ચાર્્ટ  પ્રકાર પર સ્્વવિચ કરી શકો છો.

1	 ચાર્્ટ  પસંદ કરો.

2	 ચાર્્ટ  ટૂલ્સ ડિઝાઇન ટેબ પર ચાર્્ટ  પ્રકાર બદલો બટનને ક્્લલિક કરો.

ચાર્્ટ  ફોર્મેટ કરો

તમારા ચાર્્ટના દેખાવને બદલવા અને તમે પસંદ કરેલ ચાર્્ટ  પ્રકાર માટે 
ઘટકોને સશંોધિત કરવા માટે સખં્યાબંધ ફોર્મેટિિંગ ટૂલ્સ ઉપલબ્ધ છે. ફોર્મેટ 
કરવાના વિકલ્્પપો ચાર્્ટ  ટૂલ્સ ડિઝાઇન અને ફોર્મેટ ટૅબ્્સ પર ઉપલબ્ધ છે, 
પરંતુ તમે ચાર્્ટ  ટૂલ્સ શૉર્્ટકટ્સનો પણ ઉપયોગ કરી શકો છો જ ેજ્યારે ચાર્્ટ  
પસંદ કરવામાાં આવે ત્યારે તેની જમણી બાજુએ દેખાય છે.

1	 ચાર્્ટ  અથવા ચાર્્ટ  ઘટક પસંદ કરો.

2	 ચાર્્ટ  સ્ટાઇલ બટન પર ક્્લલિક કરો.

3	શ ૈલી અથવા રંગ વિકલ્્પ પસંદ કરો.

•	 ચાર્્ટ  શૈલીઓ: ચાર્્ટની એકંદર દ્રશ્્ય શૈલી બદલો.

•	 ચાર્્ટ  રંગો: વર્્તમાન પ્રસ્્તતુતિ થીમ સાથે સંકલન કરવા માટે રચાયેલ 
રંગ યોજનાઓની શ્રેણીમાાંથી પસંદ કરો.

4	 ચાર્્ટ  એલિમેન્્ટ્્સ બટન પર ક્્લલિક કરો.

	 આ તે છે જ્યયાં તમે શીર્્ષકો, લેબલ્સ અને દંતકથા જવેી વસ્્તતુઓ ઉમેરી 
અથવા દૂર કરો છો. તમે અહીીં જ ેજુઓ છો તે તમે દાખલ કરેલ ચાર્્ટના 
પ્રકારને આધારે બદલાશે.

5	 ચાર્્ટ  તત્્વવોને ચાલુ અથવા બંધ કરો.

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.23.83

	તમ  ડાબી બાજુએ બધી ઉપલબ્ધ શ્રેણીઓ જુઓ છો.

3	 શ્રેણી પસંદ કરો.

4	 ચાર્્ટ  પ્રકાર પસંદ કરો.

5	 બરાબર ક્્લલિક કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.24.84
કોપા (COPA) - ઑડિઓ અને વિડિયો ઘટકોનું સંચાલન કરો	

ઑડિઓ ઘટકો ઉમેરો (Add Audio elements)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 પ્રસ્્તતુતિઓમાાં ઑડિઓ ફાઇલો આયાત કરો
•	 ઓડિયો પ્્લલેબેક વિકલ્્પપોને ગોઠવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પ્રસ્્તતુતિઓમાાં ઑડિઓ ફાઇલો આયાત કરો 

સ્્લલાઇડમાાં ઓડિયો ઉમેરો

1	 રિબન પર ઇન્્સર્્ટ  ટેબ પર ક્્લલિક કરો.

2	 જો જરૂરી હોય, તો મીડિયા જૂથને વિસ્્તતૃત કરવા માટે ક્્લલિક કરો.

3	 ઓડિયો પર ક્્લલિક કરો.

4	મ ારા PC પર ઓડિયો પસંદ કરો.

5	 પર નેવિગેટ કરો અને સાઉન્્ડ ક્્લલિપ પસંદ કરો.

6	 ઇન્્સર્્ટ  પર ક્્લલિક કરો.

સ્્લલાઇડ પર ધ્્વનિ ચિહ્ન દેખાય છે અને રિબન પર ઑડિઓ ટૂલ્સ ટૅબ્્સ 
દેખાય છે જ્યયાં તમે ઑડિયોને સમાયોજિત કરી શકો છો.

7	તમ ારા ઓડિયોને ચકાસવા માટે પ્્લલે પર ક્્લલિક કરો.

ઓડિયો રેકોર્્ડ  કરો

જો તમને કોઈ ચોક્કસ અવાજની જરૂર હોય જ ે તમે ઑનલાઇન શોધી 
શકતા નથી અથવા જ ેતમારા કમ્્પ્યયુટર પર પહેલાથી સાચવેલ નથી, તો તમે 
તેના બદલે જાતે અવાજ રેકોર્્ડ  કરી શકો છો.

1	 રિબન પર ઇન્્સર્્ટ  ટેબ પર ક્્લલિક કરો.

2	મ ીડિયા જૂથને વિસ્્તતૃત કરવા માટે ક્્લલિક કરો.

3	 ઓડિયો પર ક્્લલિક કરો.

4	 ઓડિયો રેકોર્્ડ  કરો પસંદ કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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5	 રેકોર્્ડ  પર ક્્લલિક કરો.

6	તમ ારો ઓડિયો રેકોર્્ડ  કરો.

7	 સ્ટોપ બટન પર ક્્લલિક કરો.

8	ત ેને સાચવવા માટે OK પર ક્્લલિક કરો.

કાર્્ય 2 : ઓડિયો પ્્લલેબેક વિકલ્્પપોને ગોઠવો

ઑડિઓ વિકલ્્પપો

1	 ઓડિયો ક્્લલિપ પસંદ કરો.

2	 પ્્લલેબેક ટેબ પર ક્્લલિક કરો.

3	 ઓડિયો વિકલ્્પપો જૂથને વિસ્્તતૃત કરો.

4	વ ોલ્યુમ બટન પર ક્્લલિક કરો.

5	વ ોલ્યુમ વિકલ્્પ પસંદ કરો.

6	 સ્ટાર્્ટ  લિસ્ટ એરો પર ક્્લલિક કરો અને વિકલ્્પ પસંદ કરો.

•	 આપમેળે: જ્યારે તમે સ્્લલાઇડ દાખલ કરો છો ત્યારે ઑડિયો શરૂ 
થાય છે.

•	 ક્્લલિક પર: જ્યયાં સુધી તમે માઉસ ક્્લલિક ન કરો ત્યયાં સુધી ઑડિયો 
થોભાવવામાાં આવે છે.

7	 કોઈપણ અન્ય સેટિિંગ્્સન સમાયોજિત કરવા માટે ઑડિઓ વિકલ્્પપો 
જૂથમાાં ચેક બૉક્સનો ઉપયોગ કરો.

•	 સ્્લલાઇડ્સ પર ચલાવો: જમે તમે આગલી સ્્લલાઇડ્સ પર સ્્વવિચ 
કરશો તેમ ઑડિયો ચાલુ રહેશે.

•	 બંધ ન થાય ત્યયાં સુધી લૂપ કરો: જ્યારે તમે પ્રસ્્તતુતિ દરમિયાન આ 
સ્્લલાઇડ પર રહેશો ત્યારે ઑડિયો લૂપમાાં ફરી  ચાલશે.

•	 શો દરમિયાન છુપાવો: પ્રસ્્તતુતિ દરમિયાન ઓડિયો આયકન 
છુપાવવામાાં આવશે.

•	 વગાડ્યા પછી રીવાઇન્્ડ કરો: ઑડિયો એકવાર ચાલશે અને 
પછી આપમેળે રીવાઇન્્ડ થશે.

પ્્લલેબૅક ટૅબ પર વધારાના ઉપયોગી વિકલ્્પપો છે, જમે કે ઑડિયોને ફેડ 
ઇન અથવા આઉટ કરવા માટે સેટ કરવો, ઑડિયોને ટ્્રરિમ કરવો અથવા 
બુકમાર્્ક  દાખલ કરવો.

ઓડિયો દૂર કરવા માટે, ફક્્ત ધ્્વનિ આયકન પસંદ કરો અન તમારા કીબોર્્ડ  
પર ડિલીટ કી દબાવો.
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IT & ITES	 	 એકસરસાાઈઝ 1.24.85
કોપા (COPA) - ઑડિઓ અને વિડિયો ઘટકોનું સંચાલન કરો	

વિડિઓ ઘટકો ઉમેરો (Add video elements)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 પ્રસ્્તતુતિઓમાાં વિડિઓ ફાઇલો આયાત કરો
•	 સ્્લલાઇડને ફિટ કરવા માટે વિડિયોનું કદ બદલો
•	 વિડિયો પ્્લલેબેક વિકલ્્પપોને ગોઠવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પ્રસ્્તતુતિઓમાાં વિડિઓ ફાઇલો આયાત કરો

સ્્લલાઇડમાાં વિડિઓ ઉમેરો

તમારા કમ્્પ્યયુટરમાાંથી વિડિઓ દાખલ કરો

વિડિયોઝ કે જ ે ફાઇલમાાંથી દાખલ કરવામાાં આવે છે તે સીધા જ 
પાવરપોઈન્ટ પ્રેઝન્ટેશનમાાં એમ્્બબેડ કરવામાાં આવે છે, તેથી જ્યારે વિડિયો 
દાખલ કરવામાાં આવે ત્યારે પ્રસ્્તતુતિ ફાઇલનું કદ વધશે.

1	 રિબન પર ઇન્્સર્્ટ  ટેબ પર ક્્લલિક કરો.

2	મ ીડિયા જૂથને વિસ્્તતૃત કરવા માટે ક્્લલિક કરો.

3	 વિડિઓ ક્્લલિક કરો.

4	મ ારા PC પર વિડિઓ પસંદ કરો.

જો તમારી પાસે તમારા કમ્્પ્યયુટર પર વિડિઓ સાચવેલ નથી, તો તમે 
YouTube માાંથી વિડિઓ ઉમેરવા અથવા એમ્્બબેડ કોડનો ઉપયોગ કરવા 
માટે ઑનલાઇન વિડિઓ પણ પસંદ કરી શકો છો.

5	 પર નેવિગેટ કરો અને વિડિયો પસંદ કરો.

6	 ઇન્્સર્્ટ  પર ક્્લલિક કરો.

વિડિઓ સ્્લલાઇડમાાં દાખલ કરવામાાં આવી છે.

અન્ય ઑબ્્જજેક્્ટ્્સની જમે, તમે વિડિયોનું કદ બદલવા અથવા ખસેડવા માટે 
ક્્લલિક અને ખેેંચી શકો છો.

7	તમ ારા વિડિયોનું પરૂ્વાવલોકન કરવા માટે પ્્લલે પર ક્્લલિક કરો.

વિડિઓ કાઢી નાખવા માટે, વિડિઓ પસંદ કરો અન તમારા કીબોર્્ડ  પર 
કાઢી નાખો કી દબાવો.
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કાર્્ય 2 : સ્્લલાઇડને ફિટ કરવા માટે વિડિઓનું કદ બદલો

વિડિઓ કદ

જો વિડિયો એકદમ યોગ્્ય કદનો ન હોય, તો તમે તેને પણ બદલી શકો છો, 
જમે કે તમે ચિત્રની જમે.

1	 કદના હેન્્ડલ્સને ખેેંચો અથવા કદ ફીલ્્ડમાાં મૂલ્યને સમાયોજિત કરો.

કાર્્ય 3 : વિડિઓ પ્્લલેબેક વિકલ્્પપોને ગોઠવો

વિડિઓ દેખાવ વિકલ્્પપો

ફોર્મેટ ટૅબના એડજસ્ટ ગ્રૂપમાાં વિડિયોના દેખાવને સશંોધિત કરવા માટે 
જરૂરી તમામ વિકલ્્પપોનો સમાવશે થાય છે.

1	 વિડીયો ટૂલ્સ ફોર્મેટ ટેબ પર ક્્લલિક કરો.

2	 ગોઠવણ વિકલ્્પ પસંદ કરો.

•	 સુધારાઓ: વિડિયોની બ્રાઈટનેસ અથવા કોન્ટ્રાસ્ટમાાં  ફેરફાર કરો.

•	 રંગ: શૈલીની અસર લાગુ કરો, જમે કે રંગ અથવા ગ્રેસ્કેલ.

•	 પોસ્ટર ફ્રે મ: વિડિઓની પૂર્વાવલોકન છબી સટે કરો.

•	 ડિઝાઇન રીસેટ કરો: વિડિયો પર લાગુ થયેલા તમામ ફોર્મેટિિંગ 
ફેરફારોને કાઢી નાખો.

વિડિઓ પ્્લલેબેક વિકલ્્પપો

1	 પ્્લલેબેક ટેબ પર ક્્લલિક કરો.

2	 વિડિઓ વિકલ્્પપો જૂથમાાં સેટિિંગ્્સને સમાયોજિત કરો.

•	 વૉલ્યૂમ: વીડિયો ક્્લલિપના ઑડિયો માટે વૉલ્યૂમને સમાયોજિત 
કરે છે.

•	 પ્રારંભ: વિડિયો ક્્લલિપ ક્યારે ચાલશે તે નિર્ધારિત કરે છે. ડિફૉલ્ટ 
સેટિિંગ “ઑન ક્્લલિક” છે, પરંતુ તમે સેટિિંગને સમાયોજિત કરી શકો 
છો જથેી વિડિઓ આપમેળે શરૂ થાય.

•	 પૂર્્ણ સ્ક્રીન ચલાવો: જ્યારે પ્રસ્્તતુતિ ચાલી રહી હોય ત્યારે પૂર્્ણ 
સ્ક્રીન ચલાવવા માટે વિડિઓને વિસ્્તતૃત કરે છે.

•	 વગાડતા ન હોય ત્યારે છુપાવો: વિડિયો ફ્રેમ જ્યારે ચાલતી ન 
હોય ત્યારે છુપાવે છે.

•	 બંધ ન થાય ત્યયાં સુધી લૂપ કરો: જ્યયાં સુધી તે મેન્યુઅલી 
થોભાવવામાાં ન આવે અથવા પ્રસ્્તતુતિ આગળની સ્્લલાઇડ પર ન 
જાય ત્યયાં સુધી વિડિયોનું પુનરાવર્્તન થાય છે.

•	 વગાડ્યા પછી રીવાઇન્્ડ કરો: પ્્લલેબેક સમાપ્્ત થયા પછી વિડિયો 
ક્્લલિપને શરૂઆતની સ્થિતિમાાં પરત કરે છે.

વિડિયો સ્ટાર્્ટ  અને એન્્ડ પોઈન્ટ સેટ કરો

ટ્્રરિમ વિડિયો વિકલ્્પ તમને વિડિયોની શરૂઆત અથવા અતંના ભાગોને ટંૂકા 
બનાવવા માટે તેને કાપી નાખવાની મંજૂરી આપે છે.

1	 ટ્્રરિમ વિડીયો બટન પર ક્્લલિક કરો.

2	શ રૂઆત અને અંતિમ બિિંદુઓને સમાયોજિત કરો.

	તમ ે કાાં તો સ્ટાર્્ટ  ટાઈમ અને એન્્ડ ટાઈમ ફીલ્્ડડ્્સમાાં ચોક્કસ મૂલ્યો 
ટાઈપ કરી શકો છો અથવા વિડિયોની નીચેની સમયરેખામાાં સ્ટાર્્ટ  અને 
એન્્ડ હેન્્ડલ્સને ક્્લલિક કરીને ખેેંચી શકો છો.

3	 બરાબર ક્્લલિક કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.25.86
કોપા (COPA) - સકં્રમણો અને એનિમશેન મેનેજ કરો	

સ્્લલાઇડ સકં્રમણો ઉમેરો (Add slide transitions)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 બધી સ્્લલાઇડ્સ માટે સમાન સ્્લલાઇડ સકં્રમણ ઉમેરો
•	 સકં્રમણ અસર સમયગાળો સેટ કરો
•	 સકં્રમણ પ્રારંભ અને સમાપ્્તતિ વિકલ્્પપોને ગોઠવો
•	 પસંદગીના સ્્લલાઇડ સકં્રમણોને કસ્ટમાઇઝ કરો

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : બધી સ્્લલાઇડ્સ માટે સમાન સ્્લલાઇડ સકં્રમણ ઉમેરો 

સકં્રમણો વિશે

પસંદ કરવા માટે અનન્ય સંક્રમણોની ત્રણ શ્રેણીઓ છે, જ ેતમામ સંક્રમણો 
ટેબ પર મળી શકે છે.

•	 સૂક્ષ્મ: આ સંક્રમણોના સૌથી મૂળભતૂ પ્રકારો છે. તેઓ સ્્લલાઇડ્સ વચ્ચે 
ખસેડવા માટે સરળ એનિમશેનનો ઉપયોગ કરે છે.

•	 ઉત્તેજક: આ સ્્લલાઇડ્સ વચ્ચે સંક્રમણ કરવા માટે વધુ જટિલ 
એનિમશેનનો ઉપયોગ કરે છે. 

•	 ગતિશીલ સામગ્રી: જો તમે સમાન સ્્લલાઇડ લેઆઉટનો ઉપયોગ કરતી 
બે સ્્લલાઇડ્સ વચ્ચે સંક્રમણ કરી રહ્યયાં છો, તો ગતિશીલ સંક્રમણો ફક્્ત 
પ્્લલેસહોલ્્ડર્્સન જ ખસેડશે, સ્્લલાઇડ્સને નહીીં.

સંક્રમણોનો ઉપયોગ મધ્્યસ્થતામાાં શ્રેષ્્ઠ રીતે થાય છે. ઘણા બધા સંક્રમણો 
ઉમેરવાથી તમારી પ્રસ્્તતુતિ થોડી મરૂ્્ખ લાગે છે અને તમારા પ્રેક્ષકોનું ધ્્યયાન 

ભંગ કરી શકે છે. મોટે ભાગે સૂક્ષ્મ સંક્રમણોનો ઉપયોગ કરવાનું વિચારો, 
અથવા સંક્રમણોનો બિલકુલ ઉપયોગ ન કરો.

સકં્રમણ લાગુ કરો

1	તમ ે સંક્રમણ લાગુ કરવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

	 બહુવિધ સ્્લલાઇડ્સ પસંદ કરવા માટે, તમે દરેક સ્્લલાઇડ પસંદ કરો તેમ 
Ctrl દબાવી રાખો.

2	 સંક્રમણો ટેબ પર ક્્લલિક કરો.
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3	 સ્્લલાઇડ સંક્રમણો વધુ બટન પર ક્્લલિક કરો.

4	તમ ે ઉપયોગ કરવા માાંગો છો તે સંક્રમણ પસંદ કરો.

સંક્રમણ ફક્્ત પસંદ કરેલ સ્્લલાઇડ પર લાગુ થાય છે. પ્રસ્્તતુતિની બધી 
સ્્લલાઇડ્સ પર સંક્રમણ લાગુ કરવા માટે, સંક્રમણો ટેબ પર બધા પર લાગુ 
કરો બટનને ક્્લલિક કરો.

સકં્રમણનું પૂર્વાવલોકન કરવા માટે:

5	 (વૈકલ્્પપિક) સંક્રમણ લાગુ થયા પછી તેનું પરીક્ષણ કરવા માટે, 
પૂર્વાવલોકન બટનને ક્્લલિક કરો.

તમે આ બે પદ્ધતિઓમાાંથી એકનો ઉપયોગ કરીને કોઈપણ સમયે પસંદ 
કરેલ સ્્લલાઇડ માટે સંક્રમણનું પૂર્વાવલોકન કરી શકો છો:

•	ટ્ ્ર રાન્્ઝઝિશન ટેબ પર પરૂ્વાવલોકન આદેશને ક્્લલિક કરો.

•	 સ્લાાઇડ નેેવિ�ગેશેન ફલકમાંં પ્લેે એનિ�મેશેન કમાાન્ડ પર ક્લિ�િક કરોો.

6	સં ંક્રમણ દૂૂર કરવાા માાટેે, સ્લાાઇડ ટ્રાા�ન્ઝિ��શન  ગેેલેેરીીમાંં કંંઈ નહીંં પસંંદ 
કરોો.
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કાાર્યય 2 : સંકં્રમણ અસરનીી અવધિ� સેેટ કરોો 

સકં્રમણ અસર સેટ કરવા માટે:

તમે સંક્રમણની દિશા બદલીને તેના દેખાવને ઝડપથી કસ્ટમાઇઝ કરી શકો 
છો.

1	તમ ે જ ેસંક્રમણમાાં ફેરફાર કરવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

2	 ઇફેક્ટ ઓપ્શન્્સ આદેશ પર ક્્લલિક કરો અન ઇચ્છિત વિકલ્્પ પસંદ 
કરો. આ વિકલ્્પપો પસંદ કરેલ સંક્રમણના  આધારે બદલાશે.

3	 સંક્રમણમાાં ફેરફાર કરવામાાં આવશે, અને સંક્રમણનું પૂર્વાવલોકન 
દેખાશે.

કેટલાક સંક્રમણો તમને દિશામાાં ફેરફાર કરવાની મંજૂરી આપતા નથી.

સકં્રમણ અવધિમાાં ફેરફાર કરવા માટે:

1	તમ ે જ ેસંક્રમણમાાં ફેરફાર કરવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

2	 સંક્રમણો ટેબ પર, સમય જૂથમાાં, સમય જૂથમાાં અવધિ ક્ષેત્રમાાં, સંક્રમણ 
માટે ઇચ્છિત સમય દાખલ કરો. આ ઉદાહરણમાાં, સંક્રમણને ઝડપી 
બનાવવા માટે અમ સમયને અડધી સેકન્્ડ અથવા 00.50 સુધી 
ઘટાડીશું.

3	 સમય માાં વધારાના ફેરફાર વિકલ્્પપો પસંદ કર જૂથ:

•	 ધ્્વનિ: સ્્લલાઇડ સંક્રમણ સાથે એકસાથે વગાડવા માટે અવાજ 
પસંદ કરો.

•	 અવધિ: સંક્રમણની લંબાઈ સ્્પષ્્ટ કરો.

•	 બધાને લાગુ કરો: વર્્તમાન સ્્લલાઇડના સંક્રમણ, અસરો અને સમય 
સેટિિંગ્્સને સમગ્ર પ્રસ્્તતુતિ પર લાગુ કરો.

•	 માઉસ ક્્લલિક પર: જ્યારે માઉસ ક્્લલિક કરવામાાં આવે ત્યારે 
સ્્લલાઇડ એડવાન્્સ રાખવા માટે આ વિકલ્્પ પસંદ  કરો.

•	 પછીી: તમેે ઉલ્લેેખિ�ત કરેેલ સમય પછીી સ્લાાઇડ એડવાાન્સ મેેળવવાા 
માાટેે આ વિ�કલ્પ પસંંદ કરોો.

4	લા ાગુુ થયેેલાા ફેેરફાારોો સાાથેે તમાારંું સંંક્રમણ કેેવુંં� દેેખાાય છેે તેે જોવાા માાટેે 
પૂૂર્વાાવલોોકન પર ક્લિ�િક કરોો.
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કાાર્યય 3 : સંકં્રમણનીી શરૂઆત અનેે સમાાપ્તિ�� વિ�કલ્પોોનેે ગોોઠવોો

આગળ વધતી સ્્લલાઇડ્સ

સામાન્ય રીતે, સ્્લલાઇડ શો વ્્યયૂમાાં તમે તમારા માઉસ પર ક્્લલિક કરીને અથવા 
તમારા કીબોર્્ડ  પર સ્્પપેસબાર અથવા એરો કી દબાવીને આગલી સ્્લલાઇડ 
પર જશો. ટાઈમિિંગ ગ્રુપમાાં એડવાન્્સ સ્્લલાઈડ્સ સેટિિંગ પ્રેઝન્ટેશનને તેની 
જાતે જ આગળ વધવા અને દરેક સ્્લલાઈડને ચોક્કસ સમય માટે પ્રદર્શિત 
કરવાની મંજૂરી આપે છે. આ સુવિધા ખાસ કરીને ધ્્યયાન વગરની પ્રસ્્તતુતિઓ 
માટે ઉપયોગી છે, જમે કે ટ્્ર રેડ શો બૂથ પર.

આપમેળે સ્્લલાઇડ્સને આગળ વધારવા માટે:

1	તમ ે સશંોધિત કરવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

2	 સંક્રમણો ટેબ પર સમય જૂથને શોધો. એડવાન્્સ સ્્લલાઇડ હેઠળ, ઓન 
માઉસ ક્્લલિકની બાજુના બોક્સને અનચેક કરો.

3	 આફ્ટર ફીલ્્ડમાાં, તમે સ્્લલાઇડ પ્રદર્શિત કરવા માાંગો છો તેટલો સમય 
દાખલ કરો. આ ઉદાહરણમાાં, અમે 1 મિનિટ અને 15 સેકન્્ડ અથવા 
01:15:00 પછી આપમેળે સ્્લલાઇડને આગળ વધારીશું.

•	 જ્યારે તમે માઉસ પર ક્્લલિક કરો ત્યારે સ્્લલાઈડને આગલી સ્્લલાઈડ 
પર આગળ વધારવા માટે, ઓન માઉસ ક્્લલિક ચેક બોક્સ પસંદ 
કરો.

•	 સ્્લલાઇડને આપમેળે આગળ વધારવા માટે, આફ્ટર ચેક બોક્સ 
પસંદ કરો, અને પછી તમને જોઈતી મિનિટો અથવા સેકન્્ડની સખં્યા 
દાખલ કરો. જ્યારે અંતિમ એનિમશેન અથવા સ્્લલાઇડ પરની અન્ય 
અસર સમાપ્્ત થાય ત્યારે ટાઈમર શરૂ થાય છે.

•	મ ાઉસ અને ઓટોમેટિક એડવાન્્સ બંનેને સક્ષમ કરવા માટે, ઓન 
માઉસ ક્્લલિક ચેક બોક્સ અને આફ્ટર ચેક બોક્સ બંને પસંદ કરો. 
પછી, આફ્ટર પર, તમને જોઈતી મિનિટ અથવા સેકન્્ડની સખં્યા 
દાખલ કરો. સ્્લલાઇડ આપમેળે આગળ વધશે, પરંતુ તમે માઉસ પર 
ક્્લલિક કરીને તેને વધુ ઝડપથી આગળ વધારી શકો છો.

બીીજી સ્લાાઇડ પસંંદ કરોો અનેે જ્યાંં સુુધીી બધીી સ્લાાઇડ્્સનેે ઇચ્છિ�ત સમય 
ન મળે ત્યાંં સુુધીી પ્રક્રિ�યાાનેે પુુનરાાવર્તિ�ત કરોો. તમેે બધીી સ્લાાઇડ્્સ પર સમાાન 
સમય લાાગુુ કરવાા માાટેે બધાા માાટેે લાાગુુ કરોો આદેેશનેે પણ ક્લિ�િક કરીી શકોો 
છોો.

કાાર્યય 4 : પસંંદ કરેેલ સ્લાાઇડ સંકં્રમણોોનેે કસ્ટમાાઇઝ કરોો

સકં્રમણ કસ્ટમાઇઝ કરો

તમે તમારી જરૂરિયાતોને પૂર્્ણ કરવા માટે સંક્રમણ અસરને કસ્ટમાઇઝ કરી 
શકો છો, જમેાાં તેની ઝડપ અથવા અવધિને સમાયોજિત કરવી અને અવાજ 
ઉમેરવાનો સમાવશે થાય છે.

1	 ઇફેક્ટ ઓપ્શન્્સ બટન પર ક્્લલિક કરો.

	તમ  જ ે સંક્રમણ લાગુ કર્્યુું છે તેના આધારે અહીીં ઉપલબ્ધ વિકલ્્પપો 
બદલાશે.

2	અ સર વિકલ્્પ પસંદ કરો.

3	 સમય જૂથમાાં વધારાના ફેરફાર વિકલ્્પપો પસંદ કરો:

•	 ધ્્વનિ: સ્્લલાઇડ સંક્રમણ સાથે એકસાથે વગાડવા માટે અવાજ 
પસંદ કરો.

•	 અવધિ: સંક્રમણની લંબાઈ સ્્પષ્્ટ કરો.

•	 બધાને લાગુ કરો: વર્્તમાન સ્્લલાઇડના સંક્રમણ, અસરો અને સમય 
સેટિિંગ્્સને સમગ્ર પ્રસ્્તતુતિ પર લાગુ કરો.
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•	 માઉસ ક્્લલિક પર: જ્યારે માઉસ ક્્લલિક કરવામાાં આવે ત્યારે 
સ્્લલાઇડ એડવાન્્સ રાખવા માટે આ વિકલ્્પ પસંદ કરો.

•	 પછી: તમે ઉલ્્લલેખિત કરેલ સમય પછી સ્્લલાઇડ એડવાન્્સ મેળવવા 
માટે આ વિકલ્્પ પસંદ કરો.

અવાજ ઉમેરવા માટે:

1	તમ ે જ ેસંક્રમણમાાં ફેરફાર કરવા માાંગો છો તે સ્્લલાઇડ પસંદ કરો.

2	 સમય જૂથમાાં સાઉન્્ડ ડ્્ર રોપ-ડાઉન મેનૂ પર ક્્લલિક કરો.

3	 પસંદ કરેલ સ્્લલાઇડ પર લાગુ કરવા માટે અવાજ પર ક્્લલિક કરો, પછી 
અવાજ સાાંભળવા માટે સંક્રમણનું  પૂર્વાવલોકન કરો.

અવાજનો ઉપયોગ મધ્્યસ્થતામાાં શ્રેષ્્ઠ રીતે થાય છે. તમારો સ્્લલાઇડ શો રજૂ 
કરતી વખતે દરેક સ્્લલાઇડની વચ્ચે અવાજ લગાવવો એ પ્રેક્ષકોને જબરજસ્્ત 
અથવા હેરાન પણ કરી શકે છે.

સકં્રમણ દૂર કરવા માટે:

1	તમ ે દૂર કરવા માાંગો છો તે સંક્રમણ સાથેની સ્્લલાઇડ પસંદ કરો.

2	 આ સ્્લલાઇડ જૂથમાાં સંક્રમણમાાંથી કંઈ નહીીં પસંદ કરો. સંક્રમણ દૂર 
કરવામાાં આવશે.

બધી સ્્લલાઇડ્સમાાંથી સંક્રમણો દૂર કરવા માટે, સ્્લલાઇડ પર કંઈ નહીીં સંક્રમણ 
લાગુ કરો, પછી બધા પર લાગુ કરો આદેશ પર ક્્લલિક કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.25.87
કોપા (COPA) - સકં્રમણો અને એનિમશેન મેનેજ કરો	

એનિમશેન ઉમેરો (Add Animations)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ટેક્સ્ટ અને ગ્રાફિક ઘટકોને એનિમેટ કરો
•	 આકારો, છબીઓ અને ટેક્સ્ટ બોક્સ ઓર્્ડ ર કરો
•	 સમહૂ આકારો, છબીઓ અને ટેક્સ્ટ બોક્સ
•	 એનિમશેન અસરો ગોઠવો
•	 એનિમશેન પાથ ગોઠવો
•	 સ્્લલાઇડ પર એનિમશેનને ફરીથી ગોઠવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટેક્સ્ટ અને ગ્રાફિક ઘટકોને એનિમેટ કરો 

એનિમેટ ટેક્સ્ટ અથવા ઑબ્્જજેક્ટ: 

નોોંધ: સ્્લલાઇડ પર ઑબ્્જજેક્ટને એનિમેટ કરવું એ ખરેખર ટેક્સ્ટ 
એનિમેટ કરતાાં અલગ નથી. જો કે, તમે જોશો કે ઉપલબ્ધ અસર 
વિકલ્્પપો શું એનિમેટેડ છે તેના આધારે અલગ હશે.

1	તમ  એનિમેટ કરવા માાંગો છો તે ટેક્સ્ટ અથવા ઑબ્્જજેક્ટ પસંદ કરો.

2	 એનિમશેન ટેબ પર ક્્લલિક કરો.

3	 એનિમશેન જૂથમાાં એનિમશેન સ્ટાઇલ બટનને ક્્લલિક કરો. એનિમશેન 
અસરોનું ડ્્ર રોપ-ડાઉન મેનૂ દેખાશે. ઇચ્છિત અસર પસંદ કરો. 

4	અહી ીંથી, તમે બધા ઉપલબ્ધ એનિમશેન જોઈ શકો છો કે તેઓ પ્રવશે, 
બહાર નીકળો અને ભાર અસરો દ્વારા જૂથબદ્ધ છે.

•	 પ્રવશે: આ ઑબ્્જજેક્ટ સ્્લલાઇડમાાં કેવી રીતે પ્રવશેે છે તેનું નિયંત્રણ 
કરે છે. 

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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•	 બહાર નીકળો: આ ઑબ્્જજેક્ટ સ્્લલાઇડમાાંથી કેવી રીતે બહાર 
નીકળે છે તેનું નિયંત્રણ કરે છે.

•	 ભાર: જ્યારે ઑબ્્જજેક્ટ સ્્લલાઇડ પર હોય ત્યારે આ એનિમશેન 
થાય છે, જ ેઘણીવાર માઉસ ક્્લલિક દ્વારા ટ્્રરિ ગર થાય છે.

5	મ ેનનુા તળિયે, તમે વધારાની અસરોને ઍક્સેસ કરી શકો છો.

તમારા એનિમશેન સાથે ખૂબ ઉન્મત્ત થશો નહીીં. તમારી સ્્લલાઇડના મુખ્ય 
મુદ્દાઓ તરફ ધ્્યયાન દોરવા માટે એનિમશેન ઇફેક્ટનો ઉપયોગ કરવો 
જોઇએ. ઘણી બધી અસરો તમારી પ્રસ્્તતુતિમાાં ઘટાડો કરી શકે છે.

પ્રીસેટ એનિમશેન ટેક્સ્ટ અથવા ઑબ્્જજેક્ટ પર લાગુ થાય છે અને અસરનું 
પરૂ્વાવલોકન પ્રદર્શિત થાય છે. ઑબ્્જજેક્ટની બાજુમાાં એક નંબર દેખાય છે જ ે
ક્રમમાાં એનિમશેન પ્રદર્શિત થશે.
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6	અ સર ઑબ્્જજેક્ટ પર લાગુ થશે. ઑબ્્જજેક્ટ પાસે એનિમશેન છે તે 
બતાવવા માટે તેની બાજુમાાં એક નાની સખં્યા હશે. સ્્લલાઇડ પનેમાાં, 
સ્્લલાઇડની બાજુમાાં સ્ટારનું પ્રતીક પણ દેખાશે.

એનિમશેનનું પૂર્વાવલોકન કરવા માટે:

તમે લાગુ કરેલ કોઈપણ એનિમશેન અસરો જ્યારે તમે સ્્લલાઈડ શો 
ચલાવશો ત્યારે દેખાશે. જો કે, તમે સ્્લલાઇડ શો જોયા વિના વર્્તમાન સ્્લલાઇડ 
માટે એનિમશનનું ઝડપથી પૂર્વાવલોકન પણ કરી શકો છો.

1	તમ ે પરૂ્વાવલોકન કરવા માાંગો છો તે સ્્લલાઇડ પર નેવિગેટ કરો.

2	 એનિમશન ટેબમાાંથી, પૂર્વાવલોકન આદેશ પર ક્્લલિક કરો. વર્્તમાન 
સ્્લલાઇડ માટે એનિમશેન ચાલશ.

એનિમશેન અસર દૂર કરો

જો તમે નક્કી કરો કે તમને તે પસંદ નથી, તો એનિમશેન અસર ઝડપથી દૂર 
કરી શકાય છે.

વિકલ્્પ1:

1	તમ ે જ ેએનિમશેન દૂર કરવા માાંગો છો તે ટેક્સ્ટ અથવા ઑબ્્જજેક્ટ પસંદ 
કરો.

2	 એનિમશેન સ્ટાઇલ બટન પર ક્્લલિક કરો.

3	 કોઈ નહીીં પસંદ કરો.

એનિમશેન અસર ટેક્સ્ટ અથવા ઑબ્્જજેક્ટમાાંથી દૂર કરવામાાં આવે છે.

વિકલ્્પ2:

એનિમશેન દૂર કરવા માટે:

1	 એનિમેટેડ ઑબ્્જજેક્ટની બાજુમાાં આવલેી નાની સખં્યા પસંદ કરો.

2	 કાઢી નાાંખો કી દબાવો. એનિમશેન કાઢી નાખવામાાં આવશે.
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કાર્્ય 2 : આકારો, છબીઓ અને ટેક્સ્ટ બોક્સ ઓર્્ડ ર કરો

સંરેખિત વસ્્તતુઓ

જ્યારે તમે પાવરપોઈન્ટમાાં ઑબ્્જજેક્્ટ્્સ ખસેડો છો, ત્યારે ગોઠવણી 
માર્્ગદર્શિકાઓ અને અતંર માર્્ગદર્શિકાઓ તમને તેમને સંરેખિત કરવામાાં 
મદદ કરવા ઑબ્્જજેક્ટની આસપાસ ડૅશ કરેલી નારંગી રેખાઓ અને તીરો 

તરીકે દેખાશે. જો કે, જો તમારી પાસે એક સ્્લલાઇડ પર ઘણી વસ્્તતુઓ હોય, 
તો તેને સંપૂર્્ણ રીતે ગોઠવવામાાં મશુ્્કકેલ અને સમય માાંગી શકે છે. સદભાગ્્યયે, 
પાવરપોઈન્ટમાાં ઘણા સંરેખણ આદેશો છે જ ે તમને ઑબ્્જજેક્્ટ્્સને 
સરળતાથી ગોઠવવા અને સ્થાન આપવા માટે પરવાનગી આપે છે.

બે અથવા વધુ ઑબ્્જજેક્્ટ્્સને સંરેખિત કરવા માટે:

1	તમ  સંરેખિત કરવા માાંગો છો તે ઑબ્્જજેક્ટ પસંદ કરો. એકસાથે 
બહુવિધ ઑબ્્જજેક્ટ પસંદ કરવા માટે, જ્યારે તમે ક્્લલિક કરો ત્યારે 
Shift કી દબાવી રાખો. ફોર્મેટ ટેબ દેખાશે.

2	 ફોર્મેટ ટૅબમાાંથી, સંરેખિત આદેશ પર ક્્લલિક કરો, પછી પસંદ કરેલ 
ઑબ્્જજેક્ટને સંરેખિત કરો પસંદ કરો.
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3	 ફરીથી સંરેખિત આદેશ પર ક્્લલિક કરો, પછી છ ગોઠવણી વિકલ્્પપોમાાંથી 
એક પસંદ કરો.

4	તમ ે પસંદ કરેલ વિકલ્્પના આધારે ઑબ્્જજેક્્ટ્્સ સંરેખિત થશે.

ઑબ્્જજેક્્ટ્્સને સ્્લલાઇડ પર ગોઠવવા માટે:

કેટલીકવાર તમે એક અથવા વધુ ઑબ્્જજેક્્ટ્્સને સ્્લલાઇડની અંદર ચોક્કસ 
સ્થાન પર ગોઠવવા માગી શકો છો, જમે કે ઉપર અથવા નીચે. તમે 
ઑબ્્જજેક્ટને સંરેખિત કરતા પહેલા અલાઈન ટુ સ્્લલાઈડ વિકલ્્પ પસંદ કરીને 
આ કરી શકો છો.

1	તમ ે સંરેખિત કરવા માાંગો છો તે ઑબ્્જજેક્ટ પસંદ કરો. એકસાથે 
બહુવિધ ઑબ્્જજેક્ટ પસંદ કરવા માટે, જ્યારે તમે ક્્લલિક કરો ત્યારે 
Shift કી દબાવી રાખો.
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2	 ફોર્મેટ ટેબમાાંથી, સંરેખિત આદેશ પર ક્્લલિક કરો, પછી સ્્લલાઇડ માટે 
સંરેખિત કરો પસંદ કરો.

3	 ફરીથી સંરેખિત આદેશ પર ક્્લલિક કરો, પછી છ ગોઠવણી વિકલ્્પપોમાાંથી 
એક પસંદ કરો.

4	તમ  પસંદ કરેલ વિકલ્્પના આધારે ઑબ્્જજેક્્ટ્્સ સંરેખિત થશે.
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વસ્્તતુઓને સમાનરૂપે વિતરિત કરવા માટે:

જો તમે એક પંક્્તતિ અથવા કૉલમમાાં ઑબ્્જજેક્ટ ગોઠવ્્યયા હોય, તો તમે તેમને 
વધુ સુઘડ દેખાવ માટે એકબીજાથી સમાન અંતર રાખવા માગી શકો છો. 
તમે વસ્્તતુઓને આડી અથવા ઊભી રીતે વિતરિત કરીને આ કરી શકો છો.

1	તમ ે સંરેખિત કરવા માાંગો છો તે ઑબ્્જજેક્ટ પસંદ કરો. એકસાથે 
બહુવિધ ઑબ્્જજેક્ટ પસંદ કરવા માટે, જ્યારે  તમે ક્્લલિક કરો ત્યારે 
Shift કી દબાવી રાખો.

2	 ફોર્મેટ ટૅબમાાંથી, સંરેખિત આદેશ પર ક્્લલિક કરો, પછી સ્્લલાઇડ પર 
સંરેખિત કરો અથવા પસંદ કરેલ ઑબ્્જજેક્ટને સંરેખિત કરો પસંદ કરો.

3	 ફરીથી સંરેખિત આદેશ પર ક્્લલિક કરો, પછી દેખાતા ડ્્ર રોપડાઉન 
મેનૂમાાંથી આડા વિતરિત કરો અથવા ઊભી રીતે વિતરિત કરો પસંદ 
કરો.

4	 વસ્્તતુઓ સમાનરૂપે વિતરિત કરશે.
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કાર્્ય 3 : જૂથ આકાર, છબીઓ અને ટેક્સ્ટ બોક્સ

વસ્્તતુઓનું જૂથીકરણ

તમે બહુવિધ ઑબ્્જજેક્્ટ્્સને એક ઑબ્્જજેક્ટમાાં જૂથબદ્ધ કરવા માગી શકો 
છો જથેી તેઓ એકસાથે રહેશે જો તેઓ ખસેડવામાાં આવે અથવા તેનું કદ 
બદલાય. દરેક વખતે જ્યારે તમે તેમને ખસેડવા માાંગતા હો ત્યારે તમામ 
ઑબ્્જજેક્્ટ્્સને પસંદ કરવા કરતાાં આ ઘણી વાર સરળ હોય છે.

ચિત્રો, આકાર, ક્્લલિપ આર્્ટ  અને ટેક્સ્ટ બોક્સ બધાને જૂથબદ્ધ કરી શકાય 
છે; જો કે, પ્્લલેસહોલ્્ડર્્સને જૂથબદ્ધ કરી શકાતા નથી. જો તમે ચિત્રોનું જૂથ 
બનાવતા હોવ, તો પ્્લલેસહોલ્્ડરની અંદરના ચિત્ર આઇકોનને બદલે ચિત્રો 
દાખલ કરવા માટે દાખલ કરો ટેબ પર છબીઓ જૂથમાાંના આદેશોમાાંથી 
એકનો ઉપયોગ કરો.

ઑબ્્જજેક્્ટ્્સને જૂથ કરવા માટે:

1	તમ  સંરેખિત કરવા માાંગો છો તે ઑબ્્જજેક્ટ પસંદ કરો. એકસાથે 
બહુવિધ ઑબ્્જજેક્ટ પસંદ કરવા માટે, જ્યારે તમે ક્્લલિક કરો ત્યારે 
Shift કી દબાવી રાખો. ફોર્મેટ ટેબ દેખાશે.

2	 ફોર્મેટ ટેબમાાંથી, ગ્રુપ આદેશ પર ક્્લલિક કરો, પછી જૂથ પસંદ કરો.

3	 પસંદ કરેલ ઑબ્્જજેક્ટ હવે જૂથબદ્ધ કરવામાાં આવશે. તેઓ એક જૂથ છે 
તે દર્શાવવા માટે સમગ્ર જૂથની આસપાસ કદ બદલવાના હેન્્ડલ્સ સાથે 
એક બોક્સ હશે. હવે તમે એકસાથે તમામ ઑબ્્જજેક્ટને ખસેડી શકો છો 
અથવા તેનું કદ બદલી શકો છો.
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જો તમે જૂથમાાંના એક ઑબ્્જજેક્ટને સંપાદિત કરવા અથવા ખસેડવા માાંગતા 
હો, તો ઑબ્્જજેક્ટ પસંદ કરવા માટે ડબલ-ક્્લલિક કરો. પછી તમે તેને 
સંપાદિત કરી શકો છો અથવા તેને ઇચ્છિત સ્થાન પર ખસેડી શકો છો.

જો તમ ઑબ્્જજેક્્ટ્્સ પસંદ કરો છો અને ગ્રુપ આદેશ અક્ષમ છે, તો તે 
ઑબ્્જજેક્્ટ્્સમાાંથી એક પ્્લલેસહોલ્્ડરની અંદર હોવાને કારણે હોઈ શકે છે. 
જો આવું થાય, તો ઇન્્સર્્ટ  ટેબ પર પિક્્ચર્્સ કમાન્્ડનો ઉપયોગ કરીને ઇમેજને 
ફરીથી દાખલ કરવાનો પ્રયાસ કરો.

ઑબ્્જજેક્્ટ્્સને અનગ્રુપ કરવા માટે:

1	તમ ે જ ેઑબ્્જજેક્ટ જૂથને અનગ્રુપ કરવા માાંગો છો તેને પસંદ કરો.

2	 ફોર્મેટ ટૅબમાાંથી, ગ્રુપ કમાન્્ડ પર ક્્લલિક કરો, પછી અનગ્રુપ પસંદ કરો.
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3	 ઑબ્્જજેક્ટ અનગ્રુપ કરવામાાં આવશે.

ઑબ્્જજેક્ટ ઑર્્ડ રિિંગ

ઑબ્્જજેક્ટને ગોઠવવા ઉપરાાંત, પાવરપોઈન્ટ તમને ઑબ્્જજેક્્ટ્્સન ચોક્કસ 
ક્રમમાાં ગોઠવવાની ક્ષમતા આપે છે. જ્યારે બે અથવા વધુ ઑબ્્જજેક્ટ 
ઓવરલેપ થાય ત્યારે ક્રમાાંકન મહત્્વપૂર્્ણ છે કારણ કે તે નક્કી કરશે કે કઈ 
વસ્્તતુઓ આગળ કે પાછળ છે.

સમજ સ્્તર

જ્યારે ઑબ્્જજેક્્ટ્્સને સ્્લલાઇડમાાં શામેલ કરવામાાં આવે છે, ત્યારે તેઓ જ ે
ક્રમમાાં સ્્લલાઇડમાાં શામેલ કરવામાાં આવ્્યયા હતા તે મુજબ સ્્તરો પર મૂકવામાાં 
આવે છે. અમારા ઉદાહરણમાાં, અમ ટોચના સ્્તર પર એક તીર દોર્્યુું છે, પરંતુ 
અમે તેને અન્ય ઑબ્્જજેક્્ટ્્સની પાછળ મૂકવા માટે સ્્તર બદલી શકીએ 
છીએ.

એક સ્્તર દ્વારા ઓર્્ડ ર બદલવા માટે:

1	 ઑબ્્જજેક્ટ પસંદ કરો. ફોર્મેટ ટેબ દેખાશે.

2	 ફોર્મેટ ટૅબમાાંથી, ઑબ્્જજેક્ટના ક્રમને એક સ્્તરથી બદલવા માટે આગળ 
લાવો અથવા પાછળ મોકલો આદેશ પર ક્્લલિક કરો. જો સ્્લલાઇડ પર 

બહુવિધ ઑબ્્જજેક્્ટ્્સ હોય, તો તમારે ઇચ્છિત ક્રમ પ્રાપ્્ત કરવા માટે 
આદેશને ઘણી વખત ક્્લલિક કરવાની જરૂર પડી શકે છે.
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3	 ઑબ્્જજેક્ટ ફરીથી ગોઠવશે.

ઑબ્્જજેક્ટને આગળ અથવા પાછળ લાવવા માટે:

જો તમ કોઈ ઑબ્્જજેક્ટને ઘણા ઑબ્્જજેક્ટની પાછળ અથવા આગળ 
ખસેડવા માાંગતા હો, તો ઑર્્ડ રિિંગ કમાન્્ડને ઘણી વખત ક્્લલિક કરવાને 
બદલે તેને આગળ લાવવા અથવા પાછળ મોકલવું સામાન્ય રીતે ઝડપી છે.

1	 ઑબ્્જજેક્ટ પસંદ કરો.

2	 ફોર્મેટ ટેબમાાંથી, આગળ લાવો અથવા પાછળ મોકલો ડ્્ર રોપ ડાઉન એરો 
પર ક્્લલિક કરો.

3	ડ્ ્ર રોપ ડાઉન મેનુમાાંથી, આગળ લાવો અથવા પાછળ મોકલો પસંદ કરો.

4	 ઑબ્્જજેક્ટ ફરીથી ગોઠવશે.

જો તમારી પાસે એક બીજાની ટોચ પર ઘણી વસ્્તતુઓ મૂકવામાાં આવી હોય, 
તો વ્્યક્્તતિગત ઑબ્્જજેક્ટ પસંદ કરવાનું મશુ્્કકેલ હોઈ શકે છે. પસંદગી ફલક 
તમને ઑબ્્જજેક્ટને નવા સ્થાન પર સરળતાથી ખેેંચવાની મંજૂરી આપે છે. 

પસંદગી ફલકને ઍક્સેસ કરવા માટે, ફોર્મેટ ટેબ પર પસંદગી ફલક પર 
ક્્લલિક કરો.
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ફરતી વસ્્તતુઓ

જો તમારે કોઈ ઑબ્્જજેક્ટને ફેરવવાની જરૂર હોય જથેી તે જુદી દિશામાાં હોય, 
તો તમ તેને ડાબી કે જમણી તરફ ફેરવી શકો છો અથવા તેને આડી અથવા 
ઊભી રીતે ફ્્લલિપ કરી શકો છો.

ઑબ્્જજેક્ટને ફેરવવા માટે: 

1	 ઑબ્્જજેક્ટ પસંદ કરો. ફોર્મેટ ટેબ દેખાશે.

2	 ફોર્મેટ ટેબમાાંથી, Rotate આદેશ પર ક્્લલિક કરો. એક ડ્્ર રોપ-ડાઉન મેનુ 
દેખાશે.

3	 ઇચ્છિત પરિભ્રમણ વિકલ્્પ પસંદ કરો.
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4	 ઑબ્્જજેક્ટ ફરશે.

કાર્્ય 4 : એનિમશેન અસરોને ગોઠવો 

એનિમશન કસ્ટમાઇઝ કરો

1	 એનિમશેન લાગુ કરેલ ઑબ્્જજેક્ટ પસંદ કરો.

2	 એનિમશેન ટેબ પર ક્્લલિક કરો.

3	 ઇફેક્ટ ઓપ્શન્્સ બટન પર ક્્લલિક કરો. 

	મ ેનૂમાાં ઉપલબ્ધ વિકલ્્પપો તમે ઉપયોગ કરી રહ્યયાં છો તે એનિમશેન અને 
તમે જ ેઑબ્્જજેક્ટ એનિમેટ કરી રહ્યયાં છો તેના આધારે બદલાશે.

4	અ સર વિકલ્્પ પસંદ કરો.

એનિમશેન પેઇન્ટર સાથે એનિમશેનની નકલ કરવા માટે:

કેટલાક કિસ્્સસાઓમાાં, તમે એક કરતાાં વધુ ઑબ્્જજેક્ટ પર સમાન અસરો 
લાગુ કરવા માગી શકો છો. તમે એનિમશેન પેઇન્ટરનો ઉપયોગ કરીને એક 
ઑબ્્જજેક્ટથી બીજા ઑબ્્જજેક્ટ પર ઇફેક્ટ કૉપિ કરીને આ કરી શકો છો. 
અમારા ઉદાહરણમાાં, અમે એનિમશેનને એક સ્્લલાઇડમાાંથી બીજી સ્્લલાઇડમાાં 
કૉપિ કરવા માગીએ છીએ કારણ કે તેમાાં સમાન લેઆઉટ છે.

1	 ઑબ્્જજેક્ટ પર ક્્લલિક કરો કે જનેી અસરો તમે કૉપિ કરવા માાંગો છો. 
અમારા ઉદાહરણમાાં, અમે અમારા જવાબના ટેક્સ્ટને ક્્લલિક કરીશું.
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2	 એનિમશેન ટેબમાાંથી, એનિમશેન પેઇન્ટર આદેશ પર ક્્લલિક કરો.

3	તમ  જ ેઑબ્્જજેક્ટ પર ઇફેક્ટ કૉપિ કરવા માાંગો છો તેને ક્્લલિક કરો. 
અમારા ઉદાહરણમાાં, અમે આગળની સ્્લલાઇડ પરના જવાબના ટેક્સ્ટને 
ક્્લલિક કરીશું. બંને વસ્્તતુઓ હવે સમાન અસર ધરાવે છે.

એનિમશેન ફલક

એનિમશેન પેન તમને વર્્તમાન સ્્લલાઇડ પરની તમામ અસરો જોવા અને 
સંચાલિત કરવાની મંજૂરી આપે છે. તમે એનિમશેન પનેમાાંથી સીધા જ 
અસરોને સશંોધિત અને પનુઃક્રમાાંકિત કરી શકો છો, જ ેખાસ કરીને ઉપયોગી 
છે જ્યારે તમારી પાસે ઘણી અસરો હોય.

એનિમશેન પેન ખોલવા માટે:

1	 એનિમશેન ટેબમાાંથી, એનિમશેન પને આદેશ પર ક્્લલિક કરો.

2.	 વિન્્ડડોની જમણી બાજુએ એનિમશેન પેન ખલુશ. તે વર્્તમાન સ્્લલાઇડ 
માટે જ ેક્રમમાાં દેખાશે તે તમામ અસરો બતાવશે.

જો તમારી પાસે અનેક એનિમેટેડ ઑબ્્જજેક્્ટ્્સ હોય, તો એનિમશેન ફલકમાાં 
તેમને પુનઃક્રમાાંકિત કરતાાં પહેલાાં તેનું નામ બદલવામાાં મદદ કરી શકે છે. તમે 
પસંદગી ફલકમાાં તેમનું નામ બદલી શકો છો.

પસંદગી ફલક ખોલવા માટે, ઑબ્્જજેક્ટ પર ક્્લલિક કરો, પછી ફોર્મેટ 
ટૅબમાાંથી પસંદગી ફલક પર ક્્લલિક કરો. ઑબ્્જજેક્ટનું નામ બદલવા માટે 
તેના નામ પર ડબલ-ક્્લલિક કરો.
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એનિમશેન પેનમાાંથી અસરોનું પૂર્વાવલોકન કરવા માટે:

1	 એનિમશેન પેનમાાંથી, પ્્લલે બટન પર ક્્લલિક કરો.

2	 વર્્તમાન સ્્લલાઇડ માટેની અસરો ચાલશ. એનિમશેન ફલકની જમણી 
બાજુએ, તમે સમયરેખા જોઈ શકશો જ ેદરેક અસર દ્વારા પ્રગતિ દર્શાવે 
છે.

જો સમયરેખા દૃશ્્યમાન ન હોય, તો અસર માટે ડ્્ર રોપ-ડાઉન તીરને ક્્લલિક 
કરો, પછી એડવાન્્સ્્ડ સમયરેખા બતાવો પસંદ કરો.
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અસરનો પ્રારંભ વિકલ્્પ બદલવા માટે:

મૂળભતૂ રીતે, જ્યારે તમ સ્્લલાઇડ શો દરમિયાન માઉસ પર ક્્લલિક કરો છો 
ત્યારે અસર રમવાનું શરૂ થાય છે. જો તમારી પાસે બહુવિધ અસરો હોય, 
તો તમારે દરેક અસરને વ્્યક્્તતિગત રીતે શરૂ કરવા માટે ઘણી વખત ક્્લલિક 
કરવાની જરૂર પડશે. જો કે, દરેક અસર માટે શરુઆતનો વિકલ્્પ બદલીને, 
તમારી પાસે એવી અસરો થઈ શકે છે જ ેએક જ સમયે અથવા એક પછી 
એક આપમેળે ચાલતી હોય છે.

1	 એનિમશેન પેનમાાંથી, અસર પસંદ કરો. અસરની બાજુમાાં એક 
ડ્્ર રોપડાઉન એરો દેખાશે.

2	ડ્ ્ર રોપ ડાઉન એરો પર ક્્લલિક કરો અને ત્રણ ઇચ્છિત સ્ટાર્્ટ  વિકલ્્પપોમાાંથી 
એક પસંદ કરો.
a	 જ્યારે માઉસ ક્્લલિક કરવામાાં આવે ત્યારે સ્ટાર્્ટ  ઓન ક્્લલિક અસર 

શરૂ કરશે, 
b	 પહેલાની સાથે પ્રારંભ કરો એ પહેલાની અસરની જમે તે જ સમયે 

અસર શરૂ કરશે, અને
c	 જ્યારે પાછલી અસર સમાપ્્ત થાય ત્યારે પહેલાની શરૂઆત 

પછીની અસર શરૂ થશે.

જ્યારે તમે એનિમશેનનું પૂર્વાવલોકન કરો છો, ત્યારે બધી અસરો આપમેળે 
ચાલશે. સ્ટાર્્ટ  ઓન ક્્લલિક પર સેટ કરેલી અસરોને ચકાસવા માટે, તમારે 
સ્્લલાઇડ શો ચલાવવાની જરૂર પડશે.

એનિમશેનની અવધિ અને વિલંબ બદલો

1	તમ ે સશંોધિત કરવા માાંગો છો તે એનિમશેન પસંદ કરો.

2	 સમય સમાયોજિત કરવા માટે અવધિ અને વિલંબ ફીલ્્ડમાાં ઉપર અને 
નીચે તીરો પર ક્્લલિક કરો.

3	 પરૂ્વાવલોકન પર ક્્લલિક કરો.

ઇફેક્ટ ઓપ્શન્્સ ડાયલોગ બોક્સ : એનિમશેન પેનમાાંથી, તમે ઇફેક્ટ 
ઓપ્શન્્સ ડાયલોગ બોક્સને એક્સેસ કરી શકો છો, જમેાાં વધુ અદ્યતન 
વિકલ્્પપો છે જનેો ઉપયોગ તમે તમારા એનિમશેનને એડજસ્ટ કરવા માટે 
કરી શકો છો.

ઇફેક્ટ ઓપ્શન્્સ ડાયલોગ બોક્સ ખોલવા માટે:

1	 એનિમશેન પનેમાાંથી, અસર પસંદ કરો. અસરની બાજુમાાં એક 
ડ્્ર રોપડાઉન એરો દેખાશે.

2	ડ્ ્ર રોપ ડાઉન એરો પર ક્્લલિક કરો, પછી અસર વિકલ્્પપો પસંદ કરો.
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3	 ઇફેક્ટ ઓપ્શન્્સ ડાયલોગ બોક્સ દેખાશે. ડ્્ર રોપ ડાઉન મેનુ પર ક્્લલિક 
કરો અને ઇચ્છિત ઉન્નતીકરણ પસંદ કરો. તમે એનિમશેનમાાં ધ્્વનિ 
ઉમેરી શકો છો, એનિમશેન સમાપ્્ત થયા પછી અસર ઉમેરી શકો છો 
અથવા અલગ ક્રમમાાં ટેક્સ્ટને એનિમેટ કરી શકો છો.

કેટલીક અસરોમાાં વધારાના વિકલ્્પપો હોય છે જનેે તમે બદલી શકો છો. તમે 
કઈ અસર પસંદ કરી છે તેના આધારે આ બદલાશે.

અસર સમય બદલવા માટે:

1	 ઇફેક્ટ ઓપ્શન્્સ ડાયલોગ બોક્સમાાંથી, ટાઇમિિંગ ટેબ પસંદ કરો.

2	અહી ીંથી, તમે અસર શરૂ થાય તે પહેલાાં વિલંબ ઉમેરી શકો છો, 
અસરની અવધિ બદલી શકો છો અને અસર પુનરાવર્તિત થાય છે કે 
કેમ તે નિયંત્રિત કરી શકો છો.

કાર્્ય 5 : એનિમશેન પાથ ગોઠવો 

મોશન પાથ

a	મ ોશન પાથ: આ એમ્ફેસિ સ ઇફેક્્ટ્્સ જવેી જ છે, સિવાય કે ઑબ્્જજેક્ટ 
વર્્તતુળની જમે પરૂ્્વનિર્ધારિત પાથ સાથે સ્્લલાઇડની અંદર ફરે છે.
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	 જો તમને પાવરપોઈન્ટના પ્રમાણભતૂ એનિમશેન પસંદ ન હોય, તો તમે 
તેના બદલે તમારો પોતાનો મોશન પાથ બનાવી અને કસ્ટમાઇઝ કરી 
શકો છો.

1	તમ  એનિમટ કરવા માાંગો છો તે ઑબ્્જજેક્ટ સાથેની સ્્લલાઇડ પસંદ કરો.

2	તમ ે એનિમેટ કરવા માાંગો છો તે ઑબ્્જજેક્ટ પસંદ કરો.

3	 એનિમશેન ટેબ પર એનિમશેન સ્ટાઇલ બટન પર ક્્લલિક કરો.

4	 ગતિનો માર્્ગ પસંદ કરો.

5	 ઇફેક્ટ ઓપ્શન્્સ બટન પર ક્્લલિક કરો.

6	અ સર વિકલ્્પ પસંદ કરો.

7	અ સરને જરૂર મુજબ કસ્ટમાઇઝ કરો.

કાર્્ય 6 : સ્્લલાઇડ પર એનિમશેનને ફરીથી ગોઠવો

એનિમશેનને ફરીથી ગોઠવો

જો તમે એનિમશેન ઇફેક્્ટ્્સ ચલાવવાના ક્રમને સમાયોજિત કરવા માાંગતા 
હો, તો તમે તેને ફક્્ત અનુક્રમ કરી શકો છો. તમે જોશો કે દરેક એનિમશેન 
ક્રમાાંકિત છે, બંને સ્્લલાઇડ પર અને એનિમશેન ફલકમાાં. આ તે ક્રમ છે જ ેતેઓ 
એનિમટ કરશે.

1	તમ ે પુનઃક્રમાાંકિત કરવા માાંગો છો તે એનિમશેન પસંદ કરો.

2	 સમય જૂથમાાં પહેલા ખસેડો અથવા પછી ખસેડો ક્્લલિક કરો.

	તમ ે એનિમશેન ફલકમાાં ક્્લલિક કરીને અને ખેેંચીને એનિમશેનને ફરીથી 
ગોઠવી શકો છો.

3	 પૂર્વાવલોકન પર ક્્લલિક કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.26.88
કોપા (COPA) - સહયોગ મેનેજ કરો	

ટિ�પ્પણીીઓ ઉમેેરોો અનેે મેેનેેજ કરોો (Add and manage comments)
ઉદ્દેશ્્યયો : આ એકસરસાઈઝ (Exercise) ના અતંે તમે શીખી શકશો:
•	ટિ પ્પણીઓ ઉમેરો
•	 સમીક્ષા કરો અને ટિપ્પણીઓનો જવાબ આપો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 Windows 10 OS એક કાર્્યરત પીસી	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ટિપ્પણીઓ ઉમેરો 

એક ટિપ્પણી દાખલ કરો

1	 જ્યયાં તમે તમારી ટિપ્પણી જોડવા માાંગો છો ત્યયાં ક્્લલિક કરો.

2	 સમીક્ષા ટેબ પર ક્્લલિક કરો.

3	 નવી ટિપ્પણી પર ક્્લલિક કરો.

	 ટિપ્પણીઓ ફલક જમણી બાજુએ એક નવી ખાલી ટિપ્પણી સાથે 
દેખાય છે જ ેતમારા માટે ટાઇપ કરવા માટે તૈયાર છે.

4	 તમારી ટિપ્પણી લખો.

5	 તેને સાચવવા માટે ટિપ્પણીની બહાર ક્્લલિક કરો.

•	 MS Office 2019 / નવીનતમ	          - 1 No.
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ટિપ્પણીને સંપાદિત કરવા માટે, ફક્્ત ટિપ્પણી બલૂનમાાં ક્્લલિક કરો અને 
ટેક્સ્ટને સંપાદિત કરો.

ટિપ્પણીઓ વચ્ચે કૂદકો મારવા માટે, રિબન પર અથવા ટિપ્પણીઓ ફલકમાાં 
ટિપ્પણી જૂથમાાં આગળ અને પહેલાનાાં બટનોનો ઉપયોગ કરો.

કાર્્ય 2 : સમીક્ષા કરો અને ટિપ્પણીઓનો જવાબ આપો

ટિપ્પણીનો જવાબ આપો

તમારી પોતાની ટિપ્પણીઓ કરવા ઉપરાાંત, તમે અન્ય લોકો દ્વારા કરવામાાં 
આવલેી ટિપ્પણીઓનો જવાબ આપીને વાતચીત કરી શકો છો.

1	 તમે જ ે ટિપ્પણીનો જવાબ આપી રહ્યા છો તેના માટે જવાબ ફીલ્્ડમાાં 
ક્્લલિક કરો.

2	 તમારો પ્રતિભાવ લખો.

3	 તેને સાચવવા માટે જવાબની બહાર ક્્લલિક કરો.

એક ટિપ્પણી કાઢી નાખો

જો તમને હવે ટિપ્પણીની જરૂર નથી, તો તેને પ્રસ્્તતુતિમાાંથી કાઢી નાખો.

1	 કાઢી નાખવા માટે ટિપ્પણી સાથે સ્્લલાઇડ પર નેવિગેટ કરો.

2	 ટિપ્પણી પસંદ કરો.

3	ડિલ ીટ બટન પર ક્્લલિક કરો.

4	 ટિપ્પણીઓ પેન પર બંધ કરો બટનને ક્્લલિક કરો.

બધી ટિપ્પણીઓ કાઢી નાખવા માટે, કાઢી નાાંખો બટન સૂચિ પર ક્્લલિક કરો

સમીક્ષા ટેબ પર તીર દબાવો અને આ પ્રસ્્તતુતિમાાં બધી ટિપ્પણીઓ અને 
શાહી કાઢી નાખો પસંદ કરો.
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IT & ITES	 	 એકસરસાાઈઝ 1.27.89
કોપા (COPA) - MySQL પર પ્રદર્્શન કરો	

MySQL ની સ્થાપના (Installation of MySQL)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ડેટાબેઝ બનાવવા અને ઉપયોગ કરવા માટે MySQL સર્્વર ઇન્સ્ટોલ કરો
•	 MySQL માાં ટેબલ બનાવો, ડિઝાઇન કરો અને સશંોધિત કરો પણ MySQL માાં ડેટા અખંડિતતા  નિયમો
•	 ડેટા બેઝ બનાવવો અને ડેટા બેઝનો ઉપયોગ કરો
•	 ટેબલ બનાવવું
•	 ટેબલ બદલવું 
•	 કોષ્્ટકમાાં મૂલ્ય ઉમેરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ટેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર,  
MySQL સર્્વર કનેક્શન     	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : MySQL ઇન્સ્ટોલ કરો

પગલું 1: બ્રાઉઝર અને google google.com ખોલો.

પગલું 2: તમારા Google એકાઉન્ટમાાં લૉગિન કરો.

પગલુંં� 3: dev.mysql પરથીી MySQL ઇન્સ્ટોોલર ડાાઉનલોોડ કરોો. કોોમ 
(ફિ�ગ 1). 

નોોંધ: બે ડાઉનલોડ વિકલ્્પપો વેબ કોમ્્યયુનિટી સંસ્કરણ 
અને સંપૂર્્ણ સંસ્કરણ છે. સંપૂર્્ણ ઇન્સ્ટોલર સર્્વર અને બધી 
ભલામણ કરેલ વધારાની એપ્્લલિકેશનો ડાઉનલોડ કરશે. (તેએ 
વપરાશકર્તા ખાતું બનાવવાનું કહ્્યુું હતું, પરંતુ અમે નીચેની તરફ 
સ્ક્રોલ કરીને અને “ના આભાર, ફક્્ત મારુું  ડાઉનલોડ શરૂ કરો” 
પર ક્્લલિક કરીને આ ભાગને છોડી દો.

Fig 1
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પગલુંં� 4: પછીી સાામાાન્ય રીીતેે ડબલ-ક્લિ�િક કરીીનેે, તમેે તમાારાા સર્વવર પર તેેનાા 
સ્થાાન પરથીી ડાાઉનલોોડ કરેેલ ઇન્સ્ટોોલરનેે ચલાાવોો. પછીી NEXT પર ક્લિ�િક 
કરોો (ફિ�ગ 3).

પગલુંં� 5: આગળ ડેેવલપર ડિ�ફોોલ્ટ પસંંદ કરોો અનેે પ્રક્રિ�યાાનેે આગળ 
વધાારવાા માાટેે આગળ ક્લિ�િક કરોો (ફિ�ગ 4). 

પગલુંં� 6: આગળ ઇન્સ્ટોોલેશેન પૂૂર્ણણ ટેેબ પર જાઓ અનેે FINISH પર ક્લિ�િક 
કરોો (ફિ�ગ 5).

અંતંેે, તેે કાામ કરવાા માાટેે તૈૈયાાર છેે (ફિ�ગ 6). 

MySQL કમાન્્ડ પ્રોમ્્પ્્ટ ખોલો 

પદ્ધતિ 1: સ્ટાર્્ટ  મેનૂ બટન પર ક્્લલિક કરો અને પછી MySQL કમાન્્ડ લાઇન 
ક્્લલાયંટ શોધો.

Fig 2

Fig 3 © NIMI 

NOT TO BE REPUBLISHED



341

Fig 4

Fig 5

Fig 6
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નોોંધ: તે સામાન્ય રીતે MySQL સર્્વર ઇન્સ્ટોલશેન પકે સાથે 
આવે છે. તે બે સંસ્કરણોમાાં ઇન્સ્ટોલ કરેલું છે - UTF-8 માટે 
સપોર્્ટ  સાથે અને તેના વિના. તમે START મેનૂમાાંથી જ કન્્સસોલ 
ક્્લલાયંટ ચલાવી શકો છો.

પગલુંં� 2: નવોો MySQL ડેેટાાબેેઝ બનાાવવાા માાટેે પ્રથમ ક્લાાયંંટ ચલાાવોો 
(ફિ�ગ 7). 

પગલુંં� 3: પછીી પાાસવર્ડડ  દાાખલ કરોો, જો કોોઈ પાાસવર્ડડ  ન હોોય તોો ફક્ત 
Enter કીી દબાાવોો.

પદ્ધતિ - 2: 

પગલુંં� 1: START મેેનૂૂ બટન પર ક્લિ�િક કરોો પછીી કમાાન્ડ પ્રોોમ્પ્ટ શોોધોો અનેે 
પછીી કમાાન્ડ પ્રોોમ્પ્ટ ખોોલોો (ફિ�ગ 8). 

પગલુંં� 2: ડિ�રેક્ટરીીનેે MySQL માંં બદલોો જ્યાંં MySQL ઇન્સ્ટોોલ કરેેલુંં� છેે. 
(ફિ�ગ 9) 

પગલુંં� 3: mysql –u <username> -p  <password> આદેેશ ચલાાવોો 
(ફિ�ગ 10). 

નોોંધ:અહીીં મૂળભતૂ વપરાશકર્તા નામ રૂટ છે અને જો પાસવર્્ડ             
ન હોય તો તેને ખાલી છોડી દો અને ફક્્ત Enter પર ક્્લલિક કરો.

Fig 7

Fig 8
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Fig 9

Fig 10
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IT & ITES	 	 એકસરસાાઈઝ 1.27.90
કોપા (COPA) - MySQL પર પ્રદર્્શન કરો

મુુશ્કેેલીીનિ�વાારણ: મૂૂળભૂતૂ ઇન્સ્ટોોલેશેન સમસ્યાાઓ (Troubleshooting basic installation issues)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	મુ શુ્કેેલીીનિ�વાારણ: મૂૂળભૂતૂ ઇન્સ્ટોોલેશેન સમસ્યાાઓ.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ટેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર,  
MySQL સર્્વર કનેક્શન     	 - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાાર્યય 1 :મુશુ્કેેલીીનિ�વાારણ: મૂૂળભૂૂત ઇન્સ્ટોોલેશેન સમસ્યાાઓ

MySQL ઇન્સ્ટોલશેન નિષ્ફળતા

1	 MySQL 5.6.20 માટે MySQL ઇન્સ્ટોલર હંમશેા Windows 
ઇન્સ્ટોલશેન પર કામ કરી શકતું નથી, સામાન્ય રીતે ઇન્સ્ટોલર દ્વારા 
ભૂલથી એપ્્લલિકેશનના અલગ સંસ્કરણને ઇન્સ્ટોલર હેન્્ડલ કરી શકે 
છે તેના કરતાાં અલગ કરવાનો પ્રયાસ કરે છે.

2	 આ કિસ્્સસામાાં, અમે સમસ્્યયાને ઉકેલવા અને કાર્્યકારી ઇન્સ્ટોલશેન 
મેળવવા માટે નીચનેી પ્રક્રિયાની ભલામણ કરીએ છીએ.

3	 જો તમને કોઈપણ સમયે આ પ્રક્રિયામાાં પ્રશ્નો અથવા મશુ્્કકેલી હોય, તો 
કૃપા કરીને સહાય માટે TechDeck દ્વારા નિઃસંકોચ રોકો.

MySQL ઘટકો દૂર કરો

1	 કંટ્્ર રોલ પેનલના પ્રોગ્રામ્્સ અને ફીચર્્સ મેનૂ દ્વારા સિસ્ટમ પરના તમામ 
હાજર MySQL ઘટકોને અનઇન્સ્ટોલ કરો.

2	 જો તમે Windows 10 પર છો, તો સ્ટાર્્ટ  મેનૂ પર જાઓ અને આ મેનુને 
ઍક્સેસ કરવા માટે “કંટ્્ર રોલ પેનલ” ટાઇપ કરવાનું શરૂ કરો.

MySQL નું બીજુ ંસંસ્કરણ ડાઉનલોડ કરો

1	 MySQL 5.6.20 ના નિષ્ફળ ઇન્સ્ટોલશેનને દૂર કર્યા પછી, કૃપા કરીને 
બીજુ ં સંસ્કરણ ડાઉનલોડ કરો - અમે 5.6.19 અથવા 5.6.21 ની 
ભલામણ કરીએ છીએ.

2	 ઓરેકલની વેબસાઈટ પરથી ડાઉનલોડ કરતી વખતે, તમે બેમાાંથી 
મોટી ફાઈલો પસંદ કરવા માાંગો છો, જનેું કદ 200MB થી વધુ હોવું 
જોઈએ.

ઇન્સ્ટોલર ચલાવો

1	તમ ારે ડાઉનલોડ કર્યા પછી ઇન્સ્ટોલર ચલાવવાની જરૂર પડશે. 
ઇન્સ્ટોલ કરતી વખતે, તમારા પ્રશિક્ષક દ્વારા આપવામાાં આવેલી 
સૂચનાઓને અનુસરો, જ ે ડેવલપર ડિફોલ્ટનો ઉપયોગ કરવાની 
ભલામણ કરે છે.

પ્રાારંંભિ�ક ઇન્સ્ટોોલેશેન કરતીી વખતેે તમેે અપડેેટ્્સ માાટેે તપાાસ 
કરવાાનુંં� છોોડીી શકોો છોો (ફિ�ગ 1).

Fig 1
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સ્ટાર્્ટ  મેનૂમાાંથી ઇન્સ્ટોલરને ફરીથી ચલાવો

1	 એકવાર ઇન્સ્ટોલર પૂર્્ણ થઈ જાય, જો MySQL ઇન્સ્ટોલ કરવાનો 
મૂળ પ્રયાસ નિષ્ફળ ગયો હોય, તો તમારા સ્ટાર્્ટ  મેનૂ પર જાઓ અને 
“MySQL ઇન્સ્ટોલર” નામની એપ્્લલિકેશન શોધો. (ફિગ 2)

	જ્યા રે તમે એપ્્લલિકેશન ચલાવો છો, ત્યારે તમે તમારુું  રૂપરેખાાંકન પસંદ 
કરી શકશો. જો નહિિં, તો ઇન્સ્ટોલરને રદ કરો અને આગલા પગલા પર 
આગળ વધો.

MySQL ફાઇલો મેળવો

1	તમ ે જ ેપણ MySQL નું વર્્ઝન ઇન્સ્ટોલ કર્્યુું હોય, તમારે ઓરેકલમાાંથી 
ઝિપ ફાઇલ મેળવવાની જરૂર પડશે.

2	ફ ાઇલોને અનઝિપ કરો, અને તેમને C:\Program Files\ MySQL\
MySQL પર કૉપિ કરો સર્્વર 5.6\

જો ડિરેક્ટરી અસ્્તતિત્્વમાાં છે, તો ફક્્ત હાલની ફાઇલોને ઝિપ 
ફાઇલમાાં જ ેછે તેની સાથે ઓવરરાઇટ કરો. જો તે અસ્્તતિત્્વમાાં 
નથી, તો “MySQL સર્્વર 5.6” નામનું ફોલ્્ડર બનાવો અને તેમાાં 
ફાઇલો મકૂો.

MySQL ને સેવા તરીકે રજીસ્ટર કરો

1	 એડમિનિસ્ટ્રેટર તરીકે કમાન્્ડ પ્રોમ્્પ્્ટ ખોલો. નીચેનો આદેશ ચલાવો 
(અવતરણ ચિહ્નો જરૂરી છે):

	 “C:\Program Files\MySQL\MySQL Server 5.6\bin\
mysqld.exe” --ઇન્સ્ટોલ કરો

	 આ સેવાને ઇન્સ્ટોલ કરવી જોઈએ, જ ેMySQL ને આપમેળે શરૂ થવા દે 
છે.

2	સ્ટાર્્ટ   મેનૂ પર જાઓ, service.msc ટાઈપ કરો અને એન્ટર દબાવો. જ ે
વિન્્ડડો સાથે આવે છે તે સેવાઓની  સૂચિ બતાવવી જોઈએ. MySQL56 
સેવા માટે જુઓ અને તેને શરૂ કરો.

3	 એકવાર તે શરૂ થઈ જાય, MySQL વર્્ક બેન્ચ ખોલો અને સ્થાનિક 
ડેટાબેઝ સર્્વર સાથે કનેક્ટ કરો. જો તે સેવાને ઑનલાઇન તરીકે બતાવે 
છે, તો તમે જવા માટે તૈયાર છો!

ODBC ઇન્સ્ટોલશેન નિષ્ફળતાઓ

પ્રસંગોપાત, ODBC ડ્્ર રાઇવર માટેનું સ્થાપન નિષ્ફળ જશે. જ્યારે 
સર્્વર ચલાવવા માટે આ જરૂરી નથી, ત્યારે MySQL દ્વારા 
Microsoft Office ના કેટલાક ઘટકો સાથે કનકે્ટ કરવું જરૂરી 
હોઈ શકે છે.

આને ઉકેલવા માટે, તમારે વિઝ્યુઅલ સ્ટુડિયો 2010 C++ 
રનટાઇમ તેમજ Oracle પરથી સીધા જ ODBC ડ્્ર રાઇવરને 
ડાઉનલોડ કરવાની જરૂર પડશે.

4	ડ ાઉનલોડ કર્યા પછી, તમે ઇન્સ્ટોલ કરી શકો છો. આ એડમિનિસ્ટ્રેટર 
ઓળખપત્રો માટે સંકેત આપી શકે છે. 

	 ઇન્સ્ટોલશેન પછી, કૃપા કરીને તમારા પીસીને રીબૂટ કરો.

5	 ODBC ડ્્ર રાઇવર : તમારી સિસ્ટમ માટે યોગ્્ય MSI ફાઇલ ડાઉનલોડ 
કરો. જો, કોઈ કારણસર, C++ પેકેજ ઇન્સ્ટોલ થઈ ગયા પછી આ 
ઇન્સ્ટોલ કરવામાાં નિષ્ફળ જાય, તો કૃપા કરીને સહાય માટે TechDeck 
દ્વારા રોકો.

Fig 2
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.નેટ ફ્રે મવર્્ક  4.0 ઇન્સ્ટોલશેન હેેંગ

1	 પ્રસંગોપાત .Net Framework પુનઃવિતરણયોગ્્ય સ્થાપન દરમ્્યયાન 
અટકી જાય છે.

2	 આ સમસ્્યયાને ઉકેલવા માટે તમારે Windows અપડેટ સર્વિસને અક્ષમ 
કરવાની અને WUSA.exe પ્રક્રિયાને સમાપ્્ત કરવાની જરૂર છે.

3	 “services.msc” ટાઈપ કરીને અને સ્ટાર્્ટ  મેનુ પર Enter દબાવીને 
સર્વિસ મેનેજરને શરૂ કરો.

4	વિ� ન્ડોોઝ અપડેેટ શોોધોો (ફિ�ગ 3).

5	 રાઇટ ક્્લલિક કરો અન પ્રોપર્ટીઝ પસંદ કરો

6	સ્ટાર્્ટઅ પ પ્રકારને અક્ષમ પર સેટ કરો અને સેવા બંધ કરો (ફિગ 4).

7	સ્ટાર્્ટઅ પ પ્રકાર સુયોજિત કરી રહ્યા છીએ

8	હવ  વિન્્ડડોઝ ટાસ્ક મેનેજર લોોંચ કરો

9	ખ ાતરી કરો કે તમે બધા વપરાશકર્તાઓ માટે પ્રક્રિયાઓ બતાવો છો 
(ફિગ 5)

10	વિ ન્્ડડોઝ ટાસ્ક મેનેજર પ્રક્રિયાઓ

11	 WUSA.exe પ્રક્રિયા પસંદ કરો અને પ્રક્રિયા સમાપ્્ત કરો

12	 .NET ફ્રેમવર્્ક  ઇન્સ્ટોલ કરો

13	જ્યા રે પૂર્્ણ થાય, ત્યારે વિન્્ડડોઝ અપડેટ સેવાને ફરીથી સક્ષમ કરો

Fig 3

Fig 4

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.27.90

© NIMI 

NOT TO BE REPUBLISHED



347

Fig 5
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IT & ITES	 	 એકસરસાાઈઝ 1.27.91
કોપા (COPA) - MySQL પર પ્રદર્્શન કરો	

MySQL ની રચના અને ઉપયોગો (Creation and uses of MySQL)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ડેટાબેઝ બનાવવું
•	 ડેટાબેઝનો ઉપયોગ કરીને.

જરૂરીયાતો (Requirements)

સાાધનોો/ઉપકરણોો/મશીીનોો (Tools/Equipment/Machines)

•	  ટેેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્ય�����������ય���������રત પીીસીી & બ્રાાઉઝર, MySQL સર્વવર કનેેક્શન     		  - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : MySQL નું નિર્માણ અને ઉપયોગ

પગલુંં� 1: create database <database-name>; ઉપયોોગ કરોો (ફિ�ગ 1);  પગલુંં� 2: બનાાવેેલ ડેેટાાબેેઝનોો ઉપયોોગ કરવાા માાટેે, giveuse 
<databasename>; આદેેશ ઉપયોોગ કરોો (ફિ�ગ 2).

  

Fig 1

Fig 2

© NIMI 

NOT TO BE REPUBLISHED



349

IT & ITES	 	 એકસરસાાઈઝ 1.27.92
કોપા (COPA) - MySQL પર પ્રદર્્શન કરો	

કોષ્્ટકોની ડિઝાઇન (Designing of tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 એક ટેબલ બનાવવું
•	 ટેબલ બદલવું
•	 કોષ્્ટકમાાં મૂલ્ય ઉમેરો.

જરૂરીયાતો (Requirements)
સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ટેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર,  MySQL સર્્વર કનેક્શન     		  - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : કોષ્્ટક બનાવવું, બદલવું અને મૂલ્ય ઉમેરવું

ટેબલ બનાવી રહ્યા છીએ

ટેેબલ બનાાવાા  માાટેે create table<table-name>; કમાાન્ડનોો  ઉપયોોગ 
કરોો (ફિ�ગ 1).

નોોંધ: અહીીં આપણે વિગતવાર તરીકે પ્રાથમિક કીનો ઉપયોગ 
કરી રહ્યા છીએ. જો આપણે બે અથવા વધુ કોષ્્ટકોને ઍક્સેસ 
કરવા માાંગતા હોઈએ તો આ પ્રાથમિક કીનો ઉપયોગ કરવામાાં 
આવે છે અને તે અન્ય કોષ્્ટકની વિદેશી કી તરીકે કાર્્ય કરે છે. 
પ્રાથમિક કી મૂલ્ય હંમશેા નલ હોતી નથી અને તે ઓટો ઇન્ક્રીમેન્ટ 
વેલ્યુ હોવી જોઈએ.

ટેબલ બદલો
વાક્યરચના: 
table_namecolumn_name; (ફિ�ગ 2).
કોષ્્ટકમાાં મૂલ્ય ઉમેરો
વાક્યરચના:
Insert into table_name(fieldname) values ( field_value)  
(ફિ�ગ  3)
જો ફીલ્્ડ વેલ્યુ સ્ટટ્રરિંગ  હોય તો તેનો અર્્થ છે  ‘ ” ’ અથવા અંકનો અર્્થ વાપરો 
વાપરવુ ‘ ‘ ‘;
ઉદાહરણ: “ટોમી” એ સ્ટટ્રરિંગ  વેલ્યુ છે તેથી અમે “ “ નો ઉપયોગ કર્યો અને ‘3’ 
એ અંક છે તેથી અમે ‘ ‘ નો ઉપયોગ કર્યો;

Fig 1

Fig 2

Fig 3
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IT & ITES	 	 એકસરસાાઈઝ 1.27.93
કોપા (COPA) - MySQL પર પ્રદર્્શન કરો

ડેટા અખંડિતતા નિયમો લાગુ કરી રહ્યા છીએ (Applying data integrity rules)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ડેટા અખંડિતતા નિયમો લાગુ કરવાનું શીખવું.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ટેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર,  MySQL સર્્વર કનેક્શન     		  - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : ડેટા અખંડિતતા નિયમો લાગુ કરવા

ડેટા અખંડિતતા નિયમો

•	 MySQL નિયંત્રણનો ઉપયોગ કૉલમમાાં કયા મૂલ્યોને સંગ્રહિત કરી 
શકાય તે માટે પરવાનગી આપવા અથવા પ્રતિબંધિત કરવા માટે 
નિયમોને વ્્યયાખ્યાયિત કરવા માટે થાય છે. અવરોધો પ્રેરિત કરવાનો 
હેતુ ડેટાબેઝની અખંડિતતાને લાગુ કરવાનો છે.

•	 MySQL નિયંત્રણોનો ઉપયોગ કોષ્્ટકમાાં દાખલ કરી શકાય તેવા 
ડેટાના પ્રકારને મર્યાદિત કરવા માટે થાય છે.

•	 MySQL નિયંત્રણોને બે પ્રકારમાાં વર્ગીકૃત કરી શકાય છે - કૉલમ સ્્તર 
અને કોષ્્ટક સ્્તર.

MySQL નિયતં્રણો છે:

•	 NOT NULL

•	 UNIQUE

•	 PRIMARY KEY

•	 FOREIGN KEY

•	 CHECK

•	 DEFAULT

MySQL NULL Constraint સાથે ટેબલ બનાવો

•	અહીં ં આપણેે એક ટેેબલ ‘newautor’ બનાાવવાા માંંગીીએ છીીએ જ્યાંં 
કોોઈપણ કૉૉલમનેે NULL VALUES  સ્ટોોર કરવાાનીી મંંજૂૂરીી નથીી, તેે 
કરવાા માાટેે અમેે નીીચેેનાા સે્ટેટમેેન્ટનોો ઉપયોોગ કરીી રહ્યાા છીીએ (ફિ�ગ 1). 

અહીીં ઉપરના વિધાનમાાં NULL VALUE ને બાકાત રાખવા માટે ‘NOT 
NULL’ નો ઉપયોગ કરવામાાં આવ્્યયો છે.

નીચેનું ચિત્ર બતાવે છે કે કૉલમ NULL મલૂ્યોને સ્્વવીકારશે નહીીં. (ફિગ 2)

MySQL અનન્ય અવરોધ

નીીચેે જણાાવેેલ MySQL સે્ટેટમેેન્ટ કોોલમ ‘aut_id’ સાાથેે ટેેબલ ‘newautor’ 
બનાાવશેે જે ેUNIQUE (aut_id) નોો ઉપયોોગ થાાય ત્યાારથીી જ અનન્ય મૂૂલ્યોો 
સંંગ્રહિ�ત કરશેે (ફિ�ગ 3). 

નીીચેેનુંં� ચિ�ત્ર ટેેબલનુંં� બંંધાારણ બતાાવેે છેે (ફિ�ગ 4).

Fig 1

Fig 2
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Fig 3

Fig 4
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IT & ITES	 	 એકસરસાાઈઝ 1.27.94
કોપા (COPA) - MySQL પર પ્રદર્્શન કરો

DDL, DCL અને DML સ્ટેટમેન્ટનો ઉપયોગ કરવો (Using DDL, DCL and DML statements)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 ડીડીએલ, ડીએમએલ અને ડીસીએલ સ્ટેટમેન્ટનો ઉપયોગ કરવાનું અને તફાવત કરવાનું શીખો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	  ટેેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્ય�����������ય���������રત પીીસીી & બ્રાાઉઝર, MySQL સર્વવર કનેેક્શન     		  - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : DDL, DCL અને DML સ્ટેટમેન્ટનો ઉપયોગ કરવો

DDL સ્ટેટમેન્્ટ્્સનો ઉપયોગ કરવો (બનાવો, છોડો, નામ બદલો વગેરે) 
(ફિગ્્સ 1 અને 2)
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ડ્્ર રોપ  ડેટાબેઝ

ડ્્ર રોપ ડેટાબેઝ માટે drop database <database-name>; નો ઉપયોગ 
કરો; (ફિગ 3)

ડ્્ર રોપ ટેબલ 
ડ્્ર રોપ ટેબલ  માટે drop table <table-name>; નો ઉપયોગ કરો
ટેબલનું નામ બદલો 
alter table <old-table-name> rename <new-table-name>; નોો 
ઉપયોોગ કરોો (ફિ�ગ 4).
DML સ્ટેટમેન્ટનો ઉપયોગ કરવો (પસંદ કરો, દાખલ કરો, કાઢી નાખો, 
અપડેટ કરો વગેરે)
સિલકે્ટ
•	 સિલેક્ટ કમાન્્ડનો ઉપયોગ MySQL ડેટાબેઝમાાંથી ડેટા મેળવવા માટે 

થાય છે.
•	 તેે કરવાા માાટેે select * from <table-name>;નોો ઉપયોોગ કરોો  

(ફિ�ગ 5). 
ઇન્્સર્્ટ
•	 INSERT INTO સ્ટેટમેન્ટનો ઉપયોગ ટેબલમાાં નવા રેકોર્્ડ  દાખલ કરવા 

માટે થાય છે.
•	અહીં ં કોોષ્ટકમાંં મૂૂલ્યોો દાાખલ કરવાા માાટેે અમેે આ  INSERT INTO 

<table-name> (column1, column2, column3, ...)VALUES 
(value1, value2, value3, ...); નોો ઉપયોોગ કરીીએ છીીએ (ફિ�ગ 6). 

DCL સ્ટેટમેન્્ટ્્સનો ઉપયોગ કરવો (ગ્રાન્ટ, રદબાતલ વગેરે)
ગ્રાન્ટ
વાક્યરચના: GRANT <privileges_names> ON <object> TO 
user; (ફિગ 7)

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.27.94
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IT & ITES	 	 એકસરસાાઈઝ 1.27.95
કોપા (COPA) - MySQL પર પ્રદર્્શન કરો

પ્રતિબંધો, પ્રાથમિક કી અને વિદેશી કી લાગુ કરવી (Enforcing constraints, primary key and 
foreign key)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 અમલીકરણ અવરોધોનો ઉપયોગ કરવાનું શીખવું, પ્રાથમિક કી અને વિદેશી કી.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ટેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર, MySQL સર્્વર કનેક્શન      - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પ્રતિબંધો લાગુ કરવા, પ્રાથમિક કી અને વિદેશી કી

પ્રતિબંધો લાગુ કરવા, પ્રાથમિક કી

•	મ ર્યાદાઓ એ ટેબલના ડેટા કોલમ પર લાગુ કરાયેલા નિયમો છે. 
આનો ઉપયોગ કોષ્્ટકમાાં જઈ શકે તેવા ડેટાના પ્રકારને મર્યાદિત કરવા 
માટે થાય છે. આ ડેટાબેઝમાાં ડેટાની ચોકસાઈ અને વિશ્વસનીયતાને 
સુનિશ્ચિત કરે છે.

•	મ ર્યાદાઓ કાાં તો કૉલમ સ્્તર અથવા ટેબલ સ્્તર પર હોઈ શકે છે. 
કૉલમ સ્્તરની મર્યાદાઓ માત્ર એક કૉલમ પર લાગુ થાય છે, જ્યારે 
કોષ્્ટક સ્્તરની મર્યાદાઓ સમગ્ર કોષ્્ટક પર લાગુ થાય છે.

•	જ્યા રે ટેબલ બનાવો ટેબલ સ્ટેટમેન્ટ સાથે બનાવવામાાં આવે ત્યારે 
મર્યાદાઓ સ્્પષ્્ટ કરી શકાય છે અથવા તમે ટેબલ બનાવ્્યયા પછી પણ 
અવરોધો બનાવવા માટે ALTER TABLE સ્ટેટમેન્ટનો ઉપયોગ કરી 
શકો છો.

•	 NOT NULL Constraint - ખાતરી કરે છે કે કૉલમમાાં NULL મૂલ્ય 
હોઈ શકતું નથી.

•	 DEFAULT Constraint − જ્યારે કોઈ ઉલ્્લલેખિત ન હોય ત્યારે કૉલમ 
માટે ડિફૉલ્ટ મલૂ્ય પ્રદાન કરે છે.

•	 UNIQUE Constraint − ખાતરી કરે છે કે કૉલમના તમામ મૂલ્યો 
અલગ છે.

•	 PRIMARY Key − ડેટાબેઝ કોષ્્ટકમાાં દરેક પંક્્તતિ/રેકોર્્ડન ે વિશિષ્્ટ 
રીતે ઓળખે છે.

•	 FOREIGN Key − આપેલ ડેટાબેઝ કોષ્્ટકમાાંની કોઈપણ પંક્્તતિ/
રેકોર્્ડન ે વિશિષ્્ટ રીતે ઓળખે છે.

•	 CHECK Constraint − CHECK કન્સસ્ટટ્રરેંટ એ સુનિશ્ચિત કરે છે કે 
કૉલમના તમામ મૂલ્યો અમુક શરતોને સતંોષે છે.

•	 INDEX − ખૂબ જ ઝડપથી ડેટાબેઝમાાંથી ડેટા બનાવવા અને પુનઃપ્રાપ્્ત 
કરવા માટે વપરાય છે.

કોોષ્ટક પ્રાાણીીઓમાંં id માાટેે NOT NULL અનેે PRIMARY Key અવરોોધોોનોો 
ઉપયોોગ કરોો, જે ેid અનન્ય બનાાવેે છેે અનેે તેે id કૉૉલમમાંં શૂૂન્ય મૂૂલ્ય હોોઈ 
શકતુંં� નથીી. નીીચેેનીી આકૃૃતિ� જુુઓ. (ફિ�ગ 1).

Fig 1
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Foreign key

FOREIGN KE નીી મર્યાાદાાનોો ઉપયોોગ એ ક્રિ�યાાઓનેે રોોકવાા માાટેે કરવાામાંં આવેે 
છેે જે ે કોોષ્ટકોો વચ્ચેેનીી લિં�ક્સનેે નષ્ટ કરેે છેે. વિ�દેશીી કીી એ એક 
કોોષ્ટકમાંંનુંં� ક્ષેતે્ર (અથવાા ક્ષેતે્રોોનોો સંગં્રહ) છેે, જે ેઅન્ય કોોષ્ટકમાંં પ્રાાથમિ�ક કીીનોો સંદંર્ભભ 
આપેે છેે (ફિ�ગ 2). 

નોોંધ લો કે “ઓર્્ડ ર” કોષ્્ટકમાાં “PersonID” કૉલમ “વ્્યક્્તતિ” કોષ્્ટકમાાં 
“PersonID” કૉલમ તરફ નિર્દેશ કરે છે. 

“વ્્યક્્તતિઓ” કોષ્્ટકમાાં “PersonID” કૉલમ એ “વ્્યક્્તતિઓ” કોષ્્ટકમાાં 
પ્રાથમિક કી છે.

“ઓર્્ડર્્સ ” કોષ્્ટકમાાં “PersonID” કૉલમ એ “ઓર્્ડર્્સ ” કોષ્્ટકમાાં વિદેશી કી 
છે.

•	 Iનીચેના ચિત્રમાાં, સૌપ્રથમ, ટેબલેબલ “વ્્યક્્તતિઓ” બનાવો, 
“PersonsID” કૉલમને પ્રાથમિક કી અવરોધ આપો

•	 આગળ, બીજુ ં ટેબલ “ઓર્્ડર્્સ ” બનાવો, ટેબલની “વ્્યક્્તતિઓ” કૉલમ 
“વ્્યક્્તતિઓ” ને ટેબલ “ઓર્્ડર્્સ ” માાં વિદેશી કી બનાવો

SYNTAX: (Fig 3)

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.27.95

Fig 2

Fig 3
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IT & ITES	 	 એકસરસાાઈઝ 1.27.96
કોપા (COPA) - MySQL પર પ્રદર્્શન કરો	

કોષ્્ટકોમાાં સૂચકાાંકો ઉમેરી રહ્યા છીએ (Adding indices to tables)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 કોષ્્ટકમાાં ઇન્્ડડેક્સ કેવી રીતે ઉમેરવું તે શીખો, SELECT સ્ટેટમેન્ટનો ઉપયોગ કરીને, કોષ્્ટકમાાં નવા મૂલ્યો ઉમેરો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ટેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર, MySQL સર્્વર કનેક્શન      - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : કોષ્્ટકોમાાં સૂચકાાંકો ઉમેરવા

કોષ્્ટકોમાાં સૂચકાાંકો ઉમેરી રહ્યા છીએ

ડેેટાાબેેઝમાંં ડેેટાા ક્યાંં સંંગ્રહિ�ત થાાય છેે તેેનાા નિ�ર્દેેશકોો બનાાવીીનેે ઈન્ડેેક્સીંંગ 
કોોલમને ઝડપીી બનાાવેે છેે (ફિ�ગ 1). 

ઇન્્ડડેક્સ બનાવવા માટે નીચેના આદેશનો ઉપયોગ કરો:-

CREATETABLE friends (id INTPRIMARYKEY, name 
VARCHAR, city VARCHAR);

નોોંધ: જ્યારે પ્રાથમિક કી વ્્યયાખ્યાયિત કરવામાાં આવે ત્યારે 
ક્્લસ્ટર્્ડ  ઇન્્ડડેક્સ આપમેળે બનાવવામાાં આવશે.

નોંંધ: બનાાવેેલ કોોષ્ટક, “મિ�ત્રોો”, આપોોઆપ બનાાવેેલ એક 
ક્લસ્ટર્ડડ  અનુકુ્રમણિ�કાા ધરાાવશેે, જે ે પ્રાાથમિ�ક કીી “id” નીી 
આસપાાસ ગોોઠવવાામાંં આવશેે જેનેેે “friends_pkay” કહેેવાાય 
છેે (ફિ�ગ 2). 

Fig 1

Fig 2
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IT & ITES	 	 એકસરસાાઈઝ 1.28.97
કોપા (COPA) - પ્રશ્નો પર પ્રદર્્શન	

સરળ પસંદગીના પ્રશ્નો (Simple select queries)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 સરળ પસંદગીના પ્રશ્નો વિશે સમજાવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ટેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર, MySQL સર્્વર કનેક્શન      - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સરળ પસંદગીના પ્રશ્નો

સરળ પસંદગીના પ્રશ્નો પર પ્રદર્્શન કરો

•   	 SELECT સ્ટેટમેન્ટનો ઉપયોગ ડેટાબેઝમાાંથી ડેટા પસંદ કરવા માટે થાય 
છે. પરત કરવામાાં આવેલ ડેટા પરિણામ કોષ્્ટકમાાં સંગ્રહિત થાય છે, 
જનેે પરિણામ-સેટ કહેવાય છે.

સિન્ટેક્સ:

		  SELECT column1, column2, ...

		  FROM table_name;

અહીીં, column1, column2, ... એ કોષ્્ટકના ફીલ્્ડ નામો છે જમેાાંથી તમે 
ડેટા પસંદ કરવા માાંગો છો. જો તમે કોષ્્ટકમાાં ઉપલબ્ધ તમામ ક્ષેત્રોને પસંદ 
કરવા માાંગતા હો, તો નીચેના વાક્યરચનાનો ઉપયોગ કરો:

SYNTAX :

		  SELECT * FROM table_name;

આ સમગ્ર ટેેબલ ડેેટાા બતાાવશેે (ફિ�ગ 1). 

અહીીં SELECT સ્ટેટમેન્ટની મદદથી અમે મેળવી રહ્યા છીએ “ગ્રાહક” 
કોષ્્ટકનો સંપૂર્્ણ ડેટા.

Fig 1
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IT & ITES	 	 એકસરસાાઈઝ 1.28.98
કોપા (COPA) - પ્રશ્નો પર પ્રદર્્શન	

ક્્વવેરીઝ અપડેટ ક્્વવેરીઝ દાખલ કરો અને કાઢી નાખો (Insert and delete queries update queries)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 દાખલ પ્રશ્નો વિશે સમજાવો
•	 ડિલીટ ક્્વવેરી વિશે સમજાવો
•	 અપડેટ પ્રશ્નો વિશે સમજાવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	 ટેક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર, MySQL સર્્વર કનેક્શન      - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : પ્રશ્નો દાખલ કરો

Insert queries

INSERT INTO સે્ટેટમેેન્ટનોો ઉપયોોગ કોોષ્ટકમાંં નવાા રેેકોોર્ડડ  દાાખલ કરવાા 
માાટેે થાાય છેે (ફિ�ગ 1).  

•	 ઉપરની ઇમેજ મુજબ, ઇન્્સર્્ટ  ક્્વવેરીનો ઉપયોગ કરવાની બે રીત છે. 
પ્રથમ, કોષ્્ટકની તમામ કૉલમ માટે મૂલ્યો ઉમેરશે, તેથી કૉલમના નામો 
સ્્પષ્્ટ કરવાની જરૂર નથી.

•	 બીજી રીતે, તે ક્્વવેરી ફક્્ત “નામ” અને “વ્્યવસાય” કૉલમ માટે મૂલ્ય 
ઉમેરશે.

Delete queries

1	ડે ટાાબેેઝનેે કાાઢીી નાાખવાા માાટેે, useDROP DATABSE <database-
name> નોો ઉપયોોગ કરોો (ફિ�ગ 2).

2	કો ોષ્ટક કાાઢીી નાાખવાા માાટેે, DROP TABLE <table-name> નોો 
ઉપયોોગ કરોો (ફિ�ગ 3).

Update queries

MySQL કોષ્્ટકમાાં હાલના ડેટાને સશંોધિત કરવાની જરૂર હોય ત્યયાં 
જરૂરિયાત હોઈ શકે છે. તમે SQL અપડેટ આદેશનો ઉપયોગ કરીને આમ 
કરી શકો છો. આ કોઈપણ MySQL કોષ્્ટકની કોઈપણ ફીલ્્ડ મૂલ્યમાાં 
ફેરફાર કરશે.

વાક્યરચના:

UPDATE table_name SET field1 = new-value1, field2 = new-
value2

[જ્યયાં કલમ]

•	તમ ે એક અથવા વધુ ફીલ્્ડને એકસાથે અપડેટ કરી શકો છો.

•	તમ ે WHERE કલમનો ઉપયોગ કરીને કોઈપણ શરતનો ઉલ્્લલેખ કરી 
શકો છો.

•	તમ ે એક સમયે એક ટેબલમાાં મૂલ્યોને અપડેટ કરી શકો છો.

•	 જ્યાારેે તમેે કોોષ્ટકમાંં પસંંદ કરેેલીી પંંક્તિ�િઓ અપડેેટ કરવાા માંંગતાા હોો 
ત્યાારેે WHERE કલમ ખૂૂબ જ ઉપયોોગીી છેે. (ફિ�ગ 4) 

Fig 1
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Fig 2

Fig 3

Fig 4
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IT & ITES	 	 એકસરસાાઈઝ 1.29.99
કોપા (COPA) - કાર્યો પર પ્રદર્્શન કરો 	

સખં્યા, તારીખ અને અક્ષરના કાર્યો, જોડાઓ અને કાર્યોનો ઉપયોગ કરીને (Using the Number, Date 
and Character functions, Joins and Functions)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	સં ખં્યાા, તાારીીખ અનેે અક્ષર કાાર્યોો વિ�શેે સમજાવોો.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : સખં્યા, તારીખ અને અક્ષરના કાર્યો, જોડાઓ અને કાર્યોનો ઉપયોગ કરીને

Number function

ABS(x)

સંંપૂૂર્ણણ મૂૂલ્ય તપાાસવાા માાટેે, આ કાાર્યયનોો ઉપયોોગ કરોો (ફિ�ગ 1). 

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	ટ ક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર, MySQL સર્્વર કનેક્શન      - 1 No.

Fig 1

ACOS(x)

આ ફંંક્શન X નુંં� આર્કોોસિ�ન પરત કરેે છેે. X નીી કિં�મત -1 અનેે 1 નીી વચ્ચેે હોોવીી 
જોઈએ અથવાા NULL પરત કરવાામાંં આવશે (ફિ�ગ 2).

Fig 2

કેટલાક અન્ય કાર્યો

SIN()
રેડિયનમાાં આપેલ સખં્યાત્મક અભિવ્્યક્્તતિની સાઈન પરત કરો.

SQRT()
સખં્યાત્મક અભિવ્્યક્્તતિનું બિન-નેગેટિવ વર્્ગમૂળ પરત કરે છે.

STD()
આંકડાકીય અભિવ્્યક્્તતિનું પ્રમાણભતૂ વિચલન પરત કરે છે.

STDDEV()
આંકડાકીય અભિવ્્યક્્તતિનું પ્રમાણભતૂ વિચલન પરત કરે છે.

TAN() 
રેડિયનમાાં દર્શાવેલ સખં્યાત્મક અભિવ્્યક્્તતિની સ્્પર્્શક પરત કરો.

TRUNCATE()
સખં્યાત્મક exp1 ને exp2 દશાાંશ સ્થાનો પર કાપીને પરત કરો. જો exp2 0 છે, તો પરિણામમાાં કોઈ દશાાંશ બિિંદુ હશે નહીીં.

DEGREES()
રેડિયન ડિગ્રીમાાંથી રૂપાાંતરિત આંકડાકીય અભિવ્્યક્્તતિ પરત કરે છે.

EXP()  
પ્રાકૃતિક લઘુગણક (e) નો આધાર પસાર કરેલ સાાંખ્યિક અભિવ્્યક્્તતિની શક્્તતિ સુધી પરત કરે છે.

FLOOR()
સૌથી મોટું  પૂર્ણણાંક મૂલ્ય પરત કરે છે જ ેપસાર કરેલ સખં્યાત્મક અભિવ્્યક્્તતિ કરતા વધારે નથી. 
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GREATEST()
ઇનપુટ સમીકરણોનું સૌથી મોટું  મૂલ્ય પરત કરે છે.

INTERVAL()
exp1,exp2,અને exp3 આ રીતે બહુવિધ સમીકરણો લો.. અને જો exp1 exp2 કરતા ઓછો હોય તો o પરત કરે છે, જો exp 1 હોય તો 1 આપે છેexp3 
કરતાાં ઓછુ ં  છે અને તેથી વધુ.

LEAST()
જ્યારે બે અથવા વધુ આપવામાાં આવે ત્યારે ન્યૂનતમ-મૂલ્યવાળું ઇનપુટ પરત કરે છે

LOG()
પસાર કરેલ સખં્યાત્મક અભિવ્્યક્્તતિનો કુદરતી લઘુગણક પરત કરે છે.

પાત્ર કાર્્ય

કાર્યો વર્્ણન

lower() SQUL LOWER() ફંક્શનનો ઉપયોગ સ્ટટ્રરિં ગના તમામ અક્ષરોને લોઅરકેસમાાં કન્્વર્્ટ  કરવા માટે થાય છે.

upper() SQL UPPER() ફંક્શનનો ઉપયોગ સ્ટટ્રરિં ગના તમામ અક્ષરોને અપરકેસમાાં છુ પાવવા માટે થાય છે.

trim() SQL TRIM() અક્ષર શબ્દમાળામાાંથી આગળના અને પાછળના અક્ષરો (અથવા બંને) દૂર કરે છે.

Translate() SQL TRANSLATE() ફંક્શન સ્ટટ્રરિં ગમાાં અક્ષરના ક્રમને બીજા સાથે બદલે છે
પાત્રનો ક્રમ. ફંક્શન એક સમયે એક અક્ષરને બદલે છે.

તારીખ કાર્્ય

તારીખ કાર્યો વર્્ણન વળતર મૂલ્ય ડેટા પ્રકાર કોઈ નહિ

Day (date or datetime) આપેલ તારીખ માટે અઠવાડિયાનો 
દિવસ પરત કરો

પૂર્ણણાંક જમે કે 1 -32

Month (date or datetime) આપેલ તારીખનો મહિનો પરત કરો 1 - 12 જવેો પૂર્ણણાંક

YEAR (date or datetime) આપેલ તારીખનું વર્્ષ પરત કરો 2021 જવેા વર્્ષ માટે પૂર્ણણાંક

DATEPART(date part, date or 
datetime)

પૂર્ણણાંક ફોર્મેટમાાં ઉલ્્લલેખિત તારીખનો 
ભાગ પરત કરો

પૂર્ણણાંક જમે કે મહિના માટે 1 -12, દિવસ 
માટે 1 - 31, અથવા વર્્ષ 2021 જવેું

DATENAME (Date part, date 
or date time

ઉલ્્લલેખિત તારીખનો ભાગ પરત કરો
અક્ષર ફોર્મેટ

પાત્ર જમે કે એપ્રિલ, મે,
‘1’, ‘2’, ‘2020’, 2021,

EOMONTH (date months to 
add)

મહિના (+ અથવા -) ઉમેરવા માટે 
વૈકલ્્પપિક પરિમાણ સાથે મહિનાનો 
છેલ્્લલો કાર્્ય પરત કરે છે

01/31/2021 SQL સર્્વર 2012 માાં રજૂ 
કરવામાાં આવ્્યયુું

DATEDIFF (date part, units, 
date or datetime)

તારીખ ગણિત પરિણામો પરત કરો તારીખ સમય  

DATEDIFF(date part, units, 
date or datetime)

તારીખના ભાગ દ્વારા ઉલ્્લલેખિત 
એકમોમાાં 2 તારીખો વચ્ચેનો તફાવત 
આપો

તારીખના ભાગના એકમોનું પૂર્ણણાંક

DATEDIFF-BIG તારીખના ભાગ દ્વારા ઉલ્્લલેખિત 
એકમોમાાં 2 તારીખો વચ્ચેનો તફાવત 
આપો

તારીખના ભાગના એકમોનું મોટું  પૂર્ણણાંક

CONVERT (date type, value, 
style

તારીખ આઉટપુટને નિર્દિષ્્ટ માસ્કમાાં 
કન્્વર્્ટ  કરવા માટે વપરાય છે

સામાન્ય રીતે, તારીખોને આવરી લતેી 
વખતે એક અક્ષર તારીખ પ્રકારનો ઉલ્્લલેખ 
કરવામાાં આવે

*માન્ય તારીખ ચાર 
શબ્દમાળાને તારીખમાાં 
રૂપાાંતરિત કરવા માટે કોઈ 
કાર્્યની જરૂર નથી! 

FORMAT (value,format, 
culture

તારીખ આઉટપુટન નિર્દિષ્્ટ માસ્કમાાં 
કન્્વર્્ટ  કરવા માટે વપરાય છે

ઉલ્્લલેખિત માસ્કના આધારે તારીખ ફોર્મેટ 
કરેલ સ્ટટ્રરિં ગ પરત કરે છે.
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IT & ITES	 	 એકસરસાાઈઝ 1.29.100
કોપા (COPA) - કાર્યો પર પ્રદર્્શન કરો 	

જોડાઓ, જૂથ દ્વારા, હોવા, સબ ક્્વવેરી (Joins, Group by, Having, Sub query)
ઉદે્દેશ્યોો : આ એકસરસાાઈઝ (Exercise) નાા અંતંેે તમેે શીીખીી શકશોો
•	 બે કોષ્્ટકને કેવી રીતે અલગ-અલગ રીતે જોડાવું તે શીખો, MySQL માાં ક્્લલોઝ હોવાના કારણે જૂથનો ઉપયોગ પણ કરી શકો છો
•	 કોષ્્ટક માટે અનકુ્રમણિકા અને તે પ્રશ્નોને ઑપ્્ટટિમાઇઝ કરો
•	 પ્રક્રિયા બનાવો અને સંગ્રહિત પ્રક્રિયાઓનો ઉપયોગ કેવી રીતે કરવો.

જરૂરીયાતો (Requirements)

સાધનો/ઉપકરણો/મશીનો (Tools/Equipment/Machines)

•	ટ ક્સ્ટ એડિટર (નોટપેડ) સાથે કાર્્યરત પીસી & બ્રાઉઝર, MySQL સર્્વર કનેક્શન      - 1 No.

કાર્્યપદ્ધતિ (PROCEDURE)

કાર્્ય 1 : જોડાવાનું શીખવું, જૂથબદ્ધ કરવું, સબ ક્્વવેરી કરવી

Joins   
•		 MySQL જોઇનનોો ઉપયોોગ SELECT સે્ટેટમેેન્ટ સાાથેે થાાય છેે. તેેનોો 

ઉપયોોગ બહુુવિ�ધ કોોષ્ટકોોમાંંથીી ડેેટાા પુુનઃઃપ્રાાપ્ત કરવાા માાટેે થાાય છેે. જ્યાારેે 
પણ તમાારેે બેે કેે તેેથીી વધુુ કોોષ્ટકોોમાંંથીી રેેકોોર્્ડ્� સ લાાવવાાનીી જરૂર હોોય  
ત્યાારેે તેે કરવાામાંં આવેે છેે. MySQL જોડવાાનાા ત્રણ પ્રકાાર છેે (ફિ�ગ 1):  

•	 MySQL INNER JOIN (અથવા કેટલીકવાર તેને સરળ જોડાઈ 
કહેવાય છે)

•	 MySQL લેફ્ટ આઉટર જોઇન (અથવા ક્યારેક લેફ્ટ જોઇન કહેવાય 
છે)

•	 MySQL રાઇટ આઉટર જોઇન (અથવા ક્યારેક રાઇટ જોઇન કહેવાય 
છે)

MySQL Inner JOIN (Simple Join)

Syntax:

SELECT columns  

FROM table1   

INNER JOIN table2  

ON table1.column = table2.column;

Fig 1
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બે કોષ્્ટકો “અધિકારીઓ” અને “વિદ્યાર્થીઓ” ને ધ્્યયાનમાાં લો, જમેાાં નીચનેા 
ડેટા. 

બેે કોોષ્ટકોો “અધિ�કાારીીઓ” અનેે “વિ�દ્યાાર્થીીઓ” નેે ધ્યાાનમાંં લોો, જેમેાંં નીીચેેનાા 
ડેેટાા (ફિ�ગ 2). 

Fig 2

MySQL Left Outer Join

• 	લે ફ્ટ આઉટર જોઇન ચાાલુુ શરતમાંં ઉલ્લેેખિ�ત ડાાબીી બાાજુુનાા 

ટેેબલમાંંથીી બધીી પંંક્તિ�િઓ પરત કરેે છેે અનેે અન્ય ટેેબલમાંંથીી ફક્ત તેે 
જ પંંક્તિ�િઓ આપેે છેે જ્યાંં જોડવાાનીી શરત પૂૂરીી થાાય છેે (ફિ�ગ 3). 

		 Syntax:

	 	SELECT columns  

		 FROM table1  

		 LEFT [OUTER] JOIN table2  

		 ON table1.column = table2.column; 

Fig 3

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.29.100
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MySQL Right Outer Join

• 		 TMySQL રાાઇટ આઉટર જોઇન માંંથીી બધીી પંંક્તિ�િઓ પરત કરેે છેે 

ચાાલુુ સ્થિ�તિ�માંં ઉલ્લેેખિ�ત જમણીી બાાજુુનુંં� ટેેબલ અનેે બીીજા ટેેબલમાંંથીી 
માાત્ર તેે પંંક્તિ�િઓ જ્યાંં તેે જોડાાવાાનીી શરત પૂૂરીી થાાય છેે (ફિ�ગ 4). 

	 Syntax:

		 SELECT columns  

	 	FROM table1  

		 RIGHT [OUTER] JOIN table2  

		 ON table1.column = table2.column; 

Group By

•	 MYSQL GROUP BY ક્લોોઝ એકત્રિ�ત કરવાા માાટેે વપરાાય છેે બહુુવિ�ધ 
રેેકોોર્ડડમાં ંથીી ડેેટાા અનેે પરિ�ણાામનુંં� જૂૂથ બનાાવોો એક અથવાા વધુુ કૉૉલમ 
દ્વાારાા. તેેનોો સાામાાન્ય રીીતેે ઉપયોોગ થાાય છેે સે્ટેટમેેન્ટ પસંંદ કરોો(ફિ�ગ 5).

•	અ મેે જૂૂથબદ્ધ કૉૉલમ પર COUNT, SUM, MIN, MAX, AVG વગેેરેે 
જેવેાા કેેટલાાક એકંંદર કાાર્યોોનોો પણ ઉપયોોગ કરીી શકીીએ છીીએ.

વાક્યરચના:

SELECT expression1, expression2, ... expression_n,   

aggregate_function (expression)  

FROM tables  

[WHERE conditions]  

GROUP BY expression1, expression2, ... expression_n; 

COUNT function સાથે કલમ દ્વારા MySQL ગ્રૂપ

“અધિ�કાારીીઓ” ટેેબલ નાામનાા ટેેબલનોો વિ�ચાાર કરોો, જેમેાંં નીીચેેનાા રેેકોોર્્ડ્� સ 
(ફિ�ગ 6). 

Having

MySQL HAVING ક્લોોઝનોો ઉપયોોગ GROUP BY કલમ સાાથેે થાાય છેે. તેે 
હંંમેશેાા પંંક્તિ�િઓ પરત કરેે છેે જ્યાંં શરત TRUE હોોય (ફિ�ગ 7). 

Fig 4

Fig 5

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.29.100
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		 Syntax:

		 SELECT expression1, expression2, ...expression_n,   

		 aggregate_function (expression)  

		 FROM tables  

		 [WHERE conditions]  

		 GROUP BY expression1, expression2, 		

	... expression_n; 

		 HAVING condition;

SUM ફંક્શન સાથે MySQL HAVING Clause

અહીંં, આપણેે HAVING ક્લોોઝ સાાથેે SUM ફંંક્શનનોો ઉપયોોગ કરીીએ 
છીીએ emp_name અને તેેમનાા કાામનાા કલાાકોોનોો સરવાાળોો પરત કરવાા 
માાટેે (ફિ�ગ 8).

Fig 6

Fig 7

Fig 8

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.29.100
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Subqueries

•	 સબક્્વવેરી એ SQL ક્્વવેરી છે જ ેમોટી ક્્વવેરી અંદર નેસ્ટેડ છે.

•	 સબક્્વવેરી આમાાં થઈ શકે છે:

- 	 એક SELECT કલમ

- 	 કલમમાાંથી એક

- 	 એક WHERE કલમ

•	 MySQL સબક્્વવેરી માાં SELECT, INSERT, UPDATE, DELETE, 
SET, અથવા DO સ્ટેટમેન્ટ અથવા અન્ય સબક્્વવેરી ની અંદર નેસ્ટ કરી 
શકાય છે.

•	 સબક્્વવેરી સામાન્ય રીતે અન્ય SQL સિલેક્ટ સ્ટેટમેન્ટના WHERE 
ક્્લલોઝમાાં ઉમેરવામાાં આવે છે.

•	તમ ે સરખામણી ઓપરેટરોનો ઉપયોગ કરી શકો છો, જમે કે >, <, or =. 
સરખામણી ઓપરેટર પણ હોઈ શકે છે બહુવિધ-પંક્્તતિ ઓપરેટર, જમે 
કે IN, ANY, SOME, અથવા બધા.

•	 સબક્્વવેરી ને આતંરિક ક્્વવેરી તરીકે ગણી શકાય, જ ેએક SQL ક્્વવેરી 
છે જ ે અન્ય ક્્વવેરીનાાં ભાગ રૂપે મૂકવામાાં આવે છે બાહ્ય ક્્વવેરી તરીકે 
ઓળખાય છે.

•	 આતંરિક ક્્વવેરી તેની પેરેન્ટ ક્્વવેરી પહેલા એક્્ઝઝિક્યુટ થાય છે જથેી 
આતંરિક ક્્વવેરીનાાં પરિણામો પાસ કરી શકાય બાહ્ય પ્રશ્ન માટે.

Subquery Syntax : 

	 સબક્્વવેરી (આતંરિક ક્્વવેરી) પહેલાાં એકવાર એક્્ઝઝિક્યુટ થાય છે 

મુખ્ય ક્્વવેરી (બાહ્ય ક્્વવેરી) એક્્ઝઝિક્યુટ કરે છે.

	મુખ્ય  ક્્વવેરી (આઉટર ક્્વવેરી) સબક્્વવેરીનો ઉપયોગ કરે છે

સબક્્વવેરી સિન્ટેક્સ એસક્યુએલ સ્ટાન્્ડર્્ડ  દ્વારા ઉલ્્લલેખિત અને MySQL 
માાં સપોર્ટેડ છે

DELETE FROM t1  
    WHERE s11 > ANY   
     (SELECT COUNT(*) /* no hint */ FROM t2    
       WHERE NOT EXISTS     
        (SELECT * FROM t3      
          WHERE ROW(5*t2.s1,77)=       
            (SELECT 50,11*s1 FROM t4 UNION SELECT   	

	     50,77 FROM  
              (SELECT * FROM t5) AS t5)));

	 સબક્્વવેરી એક સ્કેલર (એક એક મૂલ્ય), એક પંક્્તતિ, એક કૉલમ અથવા 
કોષ્્ટક (એક અથવા વધુ કૉલમ્્સની એક અથવા વધુ પંક્્તતિઓ) પરત 
કરી શકે છે. આને સ્કેલર, કૉલમ, પંક્્તતિ અને ટેબલ સબક્્વવેરીઝ 
કહેવામાાં આવે છે.

MySQL સબક્્વવેરી ઉદાહરણ:

સબક્વેરીીનોો ઉપયોોગ કરીીનેે, emp_details માંંથીી ‘એલેેક્ઝાાન્ડર’ કરતાંં 
વધુુ ચૂૂકવેેલ કર્મમચાારીીઓનાા નાામનીી સૂૂચિ� બનાાવોો (ફિ�ગ 9). 

Fig 9

IT અને ITES : કોપા (NSQF - સુધારેલ 2022) - એકસરસાઈ 1.29.100
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